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INTRODUCTION
Thank you for purchasing TireMaster. This guide includes information about daily TireMaster
operations and procedures for less frequently performed tasks, along with additional reference
information. This chapter includes the following sections:

UPDATES AND PATCHES
ASA recommends that you install regularly released updates and patches. You should keep
TireMaster up to date for a number of reasons:

Keeping up to date on updates and patches is a requirement of the TireMaster support contract,
and it helps ASA Support provide the best service to you.

Updates and patches resolve performance issues and often include additional features and
enhancements.

Staying up to date on updates and patches ensures that upgrading to future releases of
TireMaster requires less work.

When a new version of TireMaster or an interface for an add-on program becomes available to you, a
new installer will be placed in your TireMaster program folder during the nightly backup. When you’re
ready to update your server or workstations, you can access the installer from the apps directory.
Note: Typically the location is c:\TireMaster\apps, d:\TireMaster\apps, c:\QDSTM\apps,

d:\QDSTM\apps, c:\tmpos\apps, or d:\tmpos\apps.
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Installers are downloaded to the apps folder by default. To download installers to a different folder,
change the setting of the control TM Install - Auto download location (Other tab).

Figure 1-1: Auto Download Location Control

Note: By default, automatic downloads are enabled. For more information, see TM Install - Auto
download location on page 1217.

If you do not want to enable automatic downloads or do not have enough disk space to manage
automatic downloads, you can download installers from the TireMaster Support site
(http://support.tiremaster.com).

REGISTER TIREMASTER
After most TireMaster updates, you’ll need to register the program to continue using it. If you don’t
register TireMaster during the update process, you can access the registration program from within
TireMaster.

To register TireMaster
1. Select Help > Registration. The TireMaster - Registration Wizard opens.

2. Read the information on theWelcome tab, and click Next.
3. Read the end user license agreement (EULA). Then select the check box at the bottom of the

screen, and click Next.
4. Type the customer number and password provided by ASA, along with your contact information.

Then click Next. Required fields are labeled in red text.
5. Review the information on the Licensing tab, and click Register. A confirmation message

appears.

6. Close the confirmation message.

7. Click Finish.



TIREMASTER MESSAGE CENTER
The TireMaster message center is used to let you know when TireMaster updates are available and
provide you with troubleshooting and promotional information. To access the message center, you
need to be assigned all four of the following permissions:

Message Critical Notice
Message Support Notice
Message Update Notice
Message Marketing Notice

When a new notice is sent to you, the message indicator appears at the bottom of the TireMaster
screen. Messages remain in TireMaster until 30 days after they’re sent.

To view TireMaster messages
1. Do one of the following:

Double-click the message indicator on the status bar at the bottom of the screen.

From the Helpmenu, selectMessages.
The Messages from TireMaster screen opens.

2. Do one of the following:

To read a new message, select it and click View Message.
Note: If you want to wait until later to view a new message, select the message, and click

Mark Read. To retrieve the message, select the Viewed Messages check box.

To view an existing message, select the Viewed Messages check box. Then select the
message you want to read, and click View Message.

3. For a hard copy of the message, click Print.
4. Close the Display TireMaster Message screen.

5. Close the Messages from TireMaster screen.

DATA VALIDATION
After you run updates, validate TireMaster. The data validation checks to see that all required System
Controls settings have been completed and other necessary configuration has been performed. Until
you validate your database, you cannot create invoices or purchase orders. In TireMaster Plus and
TireMaster Corporate, you also cannot make payments or access the general ledger.

VALIDATE YOUR DATA
To verify that required TireMaster configuration has been done, validate your TireMaster database.
The data for both the live TireMaster and practice programs can be validated. Perform the validation
on the TireMaster server.

Note: If you are using a co-located database, validate all sites that use the shared database.

3
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To validate TireMaster
1. Select Help > Validate. The Data Validation screen opens.

2. Click Validate. The validation utility displays the status of various TireMaster settings.

3. For a copy of the validation log, click Print.

4. If errors (red) appear on the TM Data Validation screen, check the settings in the applicable
program areas and rerun the validation. Resolving warnings (green) is optional.

Note: Until validation errors are resolved, you won’t be able to create invoices, purchase orders,
and perform various transactions. For more information, see Validation Messages on page
1223.

5. When you can run the validation with no errors, click Exit.

VALIDATION MESSAGES
When the validation identifies program areas that are not set up, it generates errors or warnings
(Figure 1-2).



Figure 1-2: Validation Warning and Error Messages

VALIDATION ERRORS
Validation errors identify settings thatmust be completed before you can access various areas of
TireMaster. These errors appear when the validation program identifies required settings that do not
exist, are no longer valid, or are inactive.

Validation errors are displayed in red, indented text. These error messages describe settings that
must be corrected and direct you to the program area where you can make corrections.

If the validation process generates errors, you need to resolve the errors before you can create
invoices and perform other transactions. For detailed information about these messages, see
Resolve Validation Errors on page 1224

VALIDATION WARNINGS
Validation warnings are displayed in green, indented text. They identify settings that can be
corrected and where you can find those settings in the program.

Because validation warnings do not prevent you from accessing any program areas, correcting them
is optional. For detailed information about these messages, see Resolve Validation Warnings on
page 1226.

BACKUPS
Backups give you the ability to restore your data in the event of a system failure or other emergency.
To ensure the safety of your data and to protect your business, back up your database regularly. ASA
recommends that you back up your data to a storage device or removable media at least once a week
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if not more frequently. Ideally, you should back up your data to a storage device or removable media
daily.

When you begin setting up your system, start running daily backups. Once you go live, also run month
end and year end backups.

Note: If you are running a TireMaster Corporate system, contact TireMaster Support for information
about data backups.

REDUNDANT BACKUPS
TireMaster automatically backs up your data daily at 2:00 a.m. This automatic backup is called the
redundant backup. For redundant backups to occur, leave the main server turned on overnight.

On Monday through Saturday, the log file (enterprise.log) is copied from the data folder to the backup
folder. On Sunday, both the log file and the database file (enterprise.db) are saved to the backup
folder. These automatic backups are stored in subfolders named after the appropriate day of the week
and are overwritten each week.

Note: If you need to change the location for saving backup files, call TireMaster Support.

Redundant backups are not a suitable substitute for regular backups to removable media. With
removable media, you can store your backups off site and easily recover your data if your building or
computers are destroyed.

The redundant backup includes an automated database validation process that scans your data for
corruption. Results of the validation will be available for you to check on the TireMaster Support site. If
ASA's support representatives identify a problem with your data, they’ll contact you.

Note: If you do not want the automated database validation to run during the redundant backup, set
the System Control Validate Database to No. If the control is not set, the automated database
validation is enabled.

Tip: The automated database validation is a different process than running the validation. For more
information, see Data Validation on page 3.

MANUAL BACKUPS
TireMaster includes a manual backup program that you can run at any time. Performing a manual
backup places a copy of your TireMaster database (enterprise.db) and log (enterprise.log) in the dbak
folder (usually c:qdstm\dbak, d:qdstm\dbak , c:\dbak, d:\dbak, c:tmpos\dbak, or d:tmpos\dbak).
Note: The contents of the dbak folder can be copied to a storage device or removable media.

To perform a manual backup, double-click the TM Backup icon on the desktop of the TireMaster
server. To verify the backup was successful, view the contents of the dbak subfolder.

DAILY BACKUPS
In addition to the redundant backups that TireMaster runs, you also need to schedule daily backups. If
your TireMaster system goes down or is destroyed, you can restore your data from the daily backup.



You can use one of the following backup methods for your daily backups:

Option 1: Back up your data to an off-site computer.
This type of backup is performed over the internet. If you’re interested in using this type of backup,
contact your ASA sales representative.

Option 2: Back up your data to a storage device or removable media.
Examples of storage devices and removable media include, external hard drives, thumb drives,
DVDs, and CD-Rs. With this method, you should have a device or media for each day your store is
open. For example, if your store is open Monday through Saturday, you’d have six pieces of devices
or removable media.

Once you’ve performed the daily backup, store that day’s device or media in a secure, off-site
location.

Option 3: Combine Option 1 and Option 2.
Option 3 is the safest method, because you have two copies of your data. One copy is on an off-site
computer, and the other is on a storage device or removable media.

To ensure successful backups
Run backups on the servers at Corporate and at the stores (TireMaster Corporate only).

Back up all the files and subfolders in the backups folder (c:\QDSTM\backups,
d:\QDSTM\backups, c:\backups, d:\TireMaster\backups, c:\TMPOS\backups, or
d:\TMPOS\backups).
Assign a device or piece of media for each day your store is open.

Change the device or media every day.

Store the backup device or media in a secure location away from the place of business.

MONTH END BACKUPS
In addition to daily backups, you should back up your data to a storage device or removable media
following the month end lock to preserve month end reports, as well as to secure your data. For month
end backups, consider having devices or media for each month. Otherwise, you should have at least
two storage devices or pieces of media for month end backups. With two devices or pieces of media,
you can alternate each month to ensure that you always have a pair of month end backups on hand.

Month end backups are your primary archive and need to be stored off site. You can use month end
backups to restore your data if the daily backups are destroyed, lost, or unreadable. You might want to
keep your TireMaster month end backups for at least a year. For tax purposes, you should keep your
month end backup for the last period of the fiscal year for six years.

Month end backups are handled in the same way as daily backups. However, if you want to prevent
additional transactions from posting to the month you’re backing up, you should close and lock that
month.
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YEAR END BACKUPS
Before you close a fiscal year, you should perform a year end backup to a piece of removable media or
a recordable memory device. You can then store this backup as an archive for tax purposes. You
should save your TireMaster year end backups for your income tax records for at least six years. For
additional recommendations concerning data archives, consult your accountant.

Year end backups are handled in the same way as daily backups. As with all of your backup media,
you should store your year end backup off site.

LOG IN TO TIREMASTER
You can start TireMaster from the icon on the desktop or the Windows Startmenu.

To log in to TireMaster
1. Do one of the following:

Double-click on the computer’s desktop.

Click and scroll to the TireMaster folder. Then click the down arrow and select TireMaster
from the list of TireMaster applications.

The login screen opens.

2. Type your user name and password.

Tip: Passwords are case sensitive. If you can’t log in, make sure you’re using the correct case
for the letters in your password.

3. ClickOK.

HOT KEYS
Like manyWindows-based programs, TireMaster lets you select buttons, menus, and items by
pressing Alt and a designated letter. For menu items, the hot key appears after you press the Alt key.
For most buttons, the hot key is underlined.

TireMaster also has one unique hot key feature. Yellow fields indicate that a list or lookup screen is
available for a field. Pressing displays the list or lookup screen.

Tip: The hot keys for the Prev and Next buttons on the Customer Maintenance and Vendor
Maintenance screens do not require use of the Alt key. To move to the previous customer or
vendor, press PgUp. To move to the next customer or vendor, press PageDown.

FUNCTION KEYS
By pressing the function keys (Table 1-1), also known as the F keys, you can quickly access several
program areas in TireMaster.



Item Description

F1 Displays help system content that’s related to the screen that’s currently
open.

F2 Lets you edit the description of a noninventoriable item on a work order
without have to retype the entire line.

F6 Opens the Epicor®Integrated Service Estimator™ (ISE) without having to
start a quote or work order. This feature is available only if you subscribe to
the ISE.

F7 Opens the fitment guide without having to start a quote or work order. This
feature is available only if you subscribe to Tire Guide Pro Plus.

F8 Opens a screen that shows the selected customer’s sales history at point of
sale.

F9 Opens a screen that shows parts and labor sales, gross profit dollars, and
gross profit percentages for completed invoices and pending work orders.

F11 Opens the Quick Jobs menu for accessing the Epicor Integrated Service
Estimator. This feature is available only if you subscribe to the ISE.

F12 Opens the Quote Module regardless of whether any other screens are open.

Table 1-1: TireMaster’s Function Keys

DOWN ARROW LOOKUP METHOD
When you add items to a work order, purchase order, or receiving document, you can search for
inventory by pressing and typing a code (such as a quick look code) or scanning a bar code.

Here’s how the down arrow lookup method works. When you’re using the Purchase Order, Receiving
Documents, or Invoice Entry screen, press to add a line .

You can use either full or partial codes when searching for items with the down arrow lookup method.
In some instances, typing the full code results an in an exact match. For searches in which you use a
partial code, or when multiple items share a code, the Inventory List displays all items that match.

Note: The order in which TireMaster looks for items depends on how the Sort field is set up on the
first tab of the Custom Inventory Lookup screen. For example, when the codes R3B are
entered in the Sort field, TireMaster looks for items that match the rim size, followed by those
that match the quick look code, and those with the best price.

Tip: Because the order for the down arrow lookup method is determined by the settings on the first
tab on the Custom Inventory Lookup screen, you can customize the search order for each
workstation. For more information, see Configure the Custom Inventory Lookup Screen on
page 242.
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RESIZE SCREENS
The following TireMaster screens can be resized:

OpenWork Order List

Invoice Entry

Inventory List Editing

Appointment Calendar

To resize a screen, move the pointer to the edge or corner of the screen. When it becomes a
double-ended arrow ( ), drag the screen to a new size.

REARRANGE TABLE COLUMNS
Some screens have extensive tables for displaying data. Therefore, you might want to rearrange a
table’s columns so it's easier to see the information you need. To move a column, click its heading and
drag it to a different position. You can rearrange columns on the following screens:

OpenWork Order List

Inventory List

List Editing (Customer, Vendor, and Inventory)

Whether you're allowed to save the changes depends on which screen you’re using. For more
information, see Move and Resize OpenWork Order List Columns on page 465 and Move and Resize
Inventory List Columns on page 243. Layout changes to the List Editing screens cannot be saved.

ZIP CODE CLEAN UP
When there are multiple entries for a zip code, often due to spelling errors or missing information, you
can merge all of them into a single entry. The option to merge zip codes is available when adding or
editing customer or vendor records. This functionality is available in TireMaster 9.4.0 and newer.

Note: Merging zip codes is not for use in scenarios in which a single zip code is assigned to multiple
cities or towns. Example: The Saint Paul, MN zip code 55120 is also used for the suburbs
Eagan and Mendota Heights.

To merge zip codes
1. Type the zip code on the customer or vendor maintenance screen. The Zip Codes screen opens.



2. Select the zip code entry you want to keep, and clickMerge Zip Codes.

3. Do the following as needed:

Correct spelling errors.

Implement consistent use of capital and lowercase letters.

Add missing information.

4. Make sure the check box is selected for each data type you want to merge.

5. ClickOK. TireMaster combines the entries into a single zip code.
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6. ClickOK to assign the updated zip code to the customer or vendor you're working with.

TROUBLESHOOTING TIPS
Before you request support, you might be able to resolve some problems on your own. If you are
getting error messages fromWindows instead of TireMaster, you might simply need to reboot your
system. Rebooting can also help if you’re having network problems (that is, problems getting the
workstations and server to interact).

When you're troubleshooting, write down or take screen shots of all error messages and any strange
behavior by TireMaster. If you have to submit a support request, this information can help the support
analysts identify the source of the problem.

If you need to contact Support, having the remote desktop application installed on the server and each
workstation allows ASA's support analysts to quickly access your computer to diagnose and resolve
problems. For more information, see Remote Desktop Application on page 24.

INFORMATION TO INCLUDE IN SUPPORT REQUESTS
When you submit support requests, include the following information:

The version of TireMaster

TheWindows operating system version and service pack number

Whether the Remote Desktop Application is installed

Whether you’re experiencing the problem on the server or a workstation



Also describe the area of TireMaster that seems to be affected, and explain precisely what you were
doing when you encountered the problem. These extra details can help ASA Support isolate the
problemmore quickly.

IDENTIFY THE TIREMASTER VERSION
To identify the TireMaster version, select Help > About. When the About screen opens, write down
the EXE version information listed on the screen.

IDENTIFY THE WINDOWS VERSION AND SERVICE PACK
For the Windows version and service pack information, type winver in the search field (Figure 1-3)

and press Enter. If the search bar isn't visible, right-click and select Search.

Figure 1-3:Windows Version Search

When the About Windows screen opens, write down the operating system version and service pack
information.

REQUEST SUPPORT
When you need assistance from ASA Support, submit a support request by email or via the Autotask
client portal. The Autotask portal is available 24/7. With Autotask, you can do the following:

Submit electronic support requests

Track the status of your requests

Add information to your support requests

REGISTER FOR AN AUTOTASK ACCOUNT
To log a support request, you must be a registered Autotask user. Employees who will use Autotask
can register for their own accounts as long as they each register with different email addresses.

To register for an Autotask account
1. To access the Autotask registration form, go the TireMaster Support site support.tiremaster.com

and click the support account registration link.

2. Type your name and contact information.

Note: The fields marked with a red asterisk are required.

3. Click Submit.

13
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SUBMIT SUPPORT REQUESTS
With Autotask, you can submit support requests, also called tickets, via a web portal or by email. When
you submit a support request, include information about your TireMaster system and provide a
description of the problem you’re reporting, along with troubleshooting information, error messages,
and supporting documentation such as attachments of screenshots. For more information, see
Information to Include in Support Requests on page 12.

REQUEST SUPPORT VIA THE CLIENT PORTAL
When you log a support request via the Autotask client portal, you fill out a form that prompts you for
information about the issue you’re reporting.

Note: The following information describes basic steps for submitting a support request in Autotask.
For detailed Autotask information, click when you’re logged in to Autotask.

To log a support request via the client portal
1. To access the Autotask client portal, go to

https://ww14.autotask.net/ClientPortal/Login.aspx?ci=305582.

Note: You can also access the portal from the TireMaster Support site. Go to
support.tiremaster.com and click the link for submitting an online support request.

2. Type your user name and password. Then click Login.

https://ww14.autotask.net/ClientPortal/Login.aspx?ci=305582
http://support.tiremaster.com/


3. Click New Ticket.

4. When prompted for the Request Type, select TM Request from the drop-down. Then click
Continue.
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5. Type a title for your request.

Note: All fields marked with an asterisk are required.

6. Under Ticket Details, do the following.
a. Type a description of your issue.

b. Select the priority level for your request from the Service Provider Priority drop-down. If the
drop-down isn’t visible, scroll down. For more information, see Support Priority Levels on
page 21.



7. Answer the background questions. For more information, see Information to Include in Support
Requests on page 12.

8. Do one of the following:

If you have no attachments, click Save Ticket, and go to step 10.
If you need to attach one or more documents, click Save & Attach. The New Ticket
Attachments screen opens.
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Note: Attachments can also be added to the request after it’s saved.

9. For each attachment, do the following:

a. Type a name.

b. Click Browse and select the file you want to attach.
c. Click Attach File. The file name is added to a list of files to attach to the support request.

Note: If you decide to remove a file, click .

d. Click Save & Close.
10. When Autotask displays your request on the screen, review the information. Then click Close.
11. Log out of the Autotask portal.

REQUEST SUPPORT BY EMAIL
To submit a support request by email, send it to portal_tm@asaauto.com. When you request support
by email, the subject line becomes the ticket title and the email body is used as the ticket description.
When you submit a request in this manner, your original email is also attached to the ticket.

Tickets submitted by email are logged as P3 (normal) requests. Therefore, if you have a higher
priority issue, include words such as High or Critical in email subject line. This notation will help to
ensure that ASA Support can escalate the ticket, according to our priority guidelines. For more
information, see Support Priority Levels on page 21.

mailto:portal_tm@asaauto.com


REVIEW AND EDIT SUPPORT REQUESTS
After a support request has been created, you can check the status, read comments, add comments,
and add attachments.

Note: The following information describes basic steps for reviewing and editing a support request in
Autotask. For detailed Autotask information, click when you’re logged in to Autotask.

To review or edit an existing support request
1. To access the Autotask client portal, go to

https://ww14.autotask.net/ClientPortal/Login.aspx?ci=305582.

Note: You can also access the Autotask client portal from the TireMaster Support site. Go to
support.tiremaster.com and click the link for submitting an online support request.

2. Type your user name and password. Then click Login. Your Autotask dashboard opens.

19

https://ww14.autotask.net/ClientPortal/Login.aspx?ci=305582
http://support.tiremaster.com/


20

User Guide

3. Under Tickets, click the number for a ticket category. Typically, you’ll be looking for a new or open
ticket. A list of tickets in the selected category opens.



4. Click the ticket number for the request you want to review or edit.

Tip: You can use the filters to narrow down the number of tickets listed by ticket number, ticket
title, and date created.

5. Do the following as needed:

Type a quick note and click Submit.
Click Note and add a detailed note. Then click Save.
Click Attachment and look up a file to add to the ticket. Then click Save & Close.

6. To return to the open ticket list, click Close.
7. To return to your dashboard, click Home.
8. Log out of the Autotask portal.

SUPPORT PRIORITY LEVELS
ASA has established priority levels for various types of support requests, along with the response
times for each level.
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Note: Whether an item on this list affects your system depends on which ASA products are used by
your business.

PRIORITY LEVEL 1
Critical issues are classified as P1. The response time for P1 issues is one hour.

P1:Critical—1 Hour

System is down (server is down)

Glassfish server is down

eTireLink server is down

All printers are down

All users are unable to log in

SonicWALL is down

Outside technician is on site
ASA employee is on site

Unable to complete and print invoices (customers are waiting)

Unable to process credit card transactions (customers are waiting)

Remote store is down

Speed issues at all locations

First week of customer going live with new TireMaster or TireMaster Enterprise system

First week of customer going live after upgrading or moving to a new server

Table 1-2: P1 Issues

PRIORITY LEVEL 2
High priority issues are classified as P2. The response time for P2 issues is four hours.

P2:High—4 Hours

One terminal at a location is down or locked

Note: For TireMaster locations with a single terminal, this issue escalates to P1 status.

One printer at a location is down

Note: For TireMaster locations with a single printer, this issue escalates to P1 status.

Replication is down

Kill a print job

Table 1-3: P2 Issues



P2:High—4 Hours

One terminal out of many cannot print or complete invoices

Some users are unable to log on

Error messages have occurred and users cannot process transactions on one or more terminals

Weeks 2–4 of customer going live with new system

Speed issues at one location

Late charges (aging) are not being applied

Unable to print AP checks

Unable to print statements

Orders are locked or in use

Issues with integrated applications (interfaces such as Epicor, CARFAX, and retread) that prevent
daily processing

Cannot perform day-end close, if holding up statements

PRIORITY LEVEL 3
Normal priority issues are classified as P3, which is the default priority level. ASA Support makes its
best effort to respond to these issues.

P3—Normal: Best Effort (Default Priority Level)

Printer issues (TireMaster Enterprise only)

One of many terminals is down or locked (TireMaster Enterprise only)

ODBC connection is down, ODBC query is not working, or both

Other issues not considered critical or high

General ledger is out of balance to subledgers

Inventory issues, pricing issues, or both

Unable to complete day-end or month-end processing (unless holding up statements)

Batch is out of balance

Schedule an upgrade or update

Table 1-4: P3 Issues
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PRIORITY LEVEL 4
Issues that do not fall into the first three priority levels are classified as P4 issues. Priority level 4 issues
are responded to when possible.

P4—Other: When Possible

For each issues or for each queries are needed

Note: For each queries that take more than 15–20 minutes of work are billable.

Documentation

Training questions

Note: Calls expected to last more than 20 minutes are billable and must be scheduled.

Table 1-5: P4 Issues

REMOTE DESKTOP APPLICATION
ASA Support uses the remote desktop application FixMe.IT to establish a direct connection between
your computer and the computer of the support analyst who is helping you. The connection allows the
support analyst to see your system, making it easier to address your issues and answer your
questions.

You can access the FixMe.IT installer from the TireMaster Support web site. Log on to
http://support.tiremaster.com and click Support FixMe IT Connection Application on the login page
(Figure 1-4).

Figure 1-4: FixMe.IT Installer Link

http://support.tiremaster.com/login.php


Depending on your browser, you’ll be able to click the file name (FixMeitClient.exe) and begin the
installation right away or you’ll have to save the installer on your computer first. At the end of the
installation, the client ID screen will appear (Figure 1-5). Give the ID number to the support technician
who is assisting you, so he or she can complete the connection.

Figure 1-5: FixMe.IT Client ID

At the end of the installation, a FixMe.IT client icon is added to the computer’s desktop (Figure 1-6).
During subsequent contact with ASA Support, double-click that icon to retrieve client ID numbers for
your support calls.

Figure 1-6: FixMe.IT Client Icon

Note: Once the FixMe.IT installation is complete, you can delete the icon for the FixMe.IT installer
(FixMeitClient.exe).

ENHANCEMENT REQUESTS
ASA is always interested in improving TireMaster. Your enhancement requests can greatly assist us in
meeting your needs. You can share your enhancement requests with either a sales representative or a
support technician.

When you request an enhancement, do the following:

Describe the area in TireMaster (from your perspective) that the enhancement would affect.

Explain how the enhancement would help you do your work more efficiently or more
successfully.

Although we may not be able to fulfill all requests, we attempt to implement those requests that meet
the needs of the majority of our customers.
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MENU CONFIGURATION
You can customize the TireMaster menu to give different groups of employees easy access to the
program areas they use the most. This chapter includes the following sections:

Menu Options 28
Add a Menu 28
Manage Existing Menus 30
Menu Assignments 32
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MENU OPTIONS
The TireMaster menu includes a fixed bar along the top of the screen and customizable elements that
you can configure based on employee roles.

Example: Amenu for salespeople might include buttons to open the quote screen, OpenWork
Order List, and fitment guide, while the menu for an inventory manager would access the PO Sys-
tem, Inventory Maintenance, and the Qty Adjustment Wizard.

Creating a menu includes the following:

Choosing which buttons are available on the menu.

Note: To ensure all buttons are displayed when the screen is resized, a maximum of eight menu
buttons is recommended for the resolution of 1024 x 768.

Defining where to place the buttons.

Assigning the menu to a site, a security group, or specific employees.

The menu configuration also includes the option to put a clock on the screen. The clock can be placed
in the upper-right, bottom-left, or bottom-right corner of the screen.

Users who belong to security groups assigned the permission Setup Users/Permission are allowed
to work with the menu configuration.

ADD A MENU
Adding a menu includes defining which buttons it will have and which locations, employees, or both are
allowed to use it. You can add menus at both the corporate site and the stores.

To add a menu
1. Select Setup > Menu Configuration. The Menu Setup screen opens.

2. Click Add. TireMaster prompts you for the name of the new menu.

3. Type the menu’s name and clickOK.



Add a Menu

4. Select the name of the new menu (left side of screen) and assign buttons to it.

a. For each screen that should be opened with a button, select its name from theMenu Choices
list and click Add. The screen name is added to theMenu Item list.

b. Rearrange the screen names as needed. To move a screen, select the screen name and click
Move Up or Move Down repeatedly until the name is where you want it.

Note: To ensure all buttons are displayed when the screen is resized, a maximum of eight
menu buttons is recommended for the resolution of 1024 x 768.

5. If you accidentally added a screen to the menu, select the screen name and click Delete.
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6. To display the menu at the top of the screen, make sure Top is selected. To display it along the left
side, select Left instead.

7. To include a clock with the menu, select the Clock check box. Then define the clock position by
selecting Top Right, Bottom Left, or Bottom Right.

8. Assign the menu to locations, security groups, and groups as needed. For more information, see
Assign Menus on page 32.

9. To see the new menu, exit TireMaster. Then restart the program, and log in with the credentials for
a user who is assigned to the menu.

MANAGE EXISTING MENUS
Managing your menus includes making changes to them or removing them from TireMaster.

UPDATE A MENU
Occasionally, you might need to make changes to a menu. These changes can include updating the
name, changing the position or button assignments, and adding or removing the clock.

Note: You can make changes to menus created at your store and those added at other sites.

To update a menu
1. Select Setup > Menu Configuration. The Menu Setup screen opens.
2. Change the name if needed. Otherwise, disregard this step.
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a. Select the menu name you want to change, and click Edit. The Edit Menu screen appears.
b. Type the new menu name, and clickOK.

3. Assign additional buttons to the menu. Otherwise, disregard this step.

a. Select the menu you want to work with.

b. On theMenu Choices list, select the name of the screen you want to assign and click Add.
c. Repeat step 3b as needed to assign additional buttons.

4. Remove buttons from the menu. Otherwise, disregard this step.

a. Select the menu you want to work with.

b. Select the name of the screen whose button you want to remove, and click Delete. A
confirmation message appears.

c. Click Yes.
d. Repeat steps 4b and 4c as needed to remove additional buttons.

5. Change the position of the menu buttons. Otherwise, disregard this step.

a. Select the menu you want to work with.

b. Select Top or Left.
6. Add a clock. Otherwise, disregard this step.

a. Select the menu you want to work with.

b. Select the Clock check box.
c. To identify where to put the clock, select Top Right, Bottom Left, or Bottom Right.

7. Remove the clock. Otherwise, disregard this step.

a. Select the menu you want to work with.

b. Clear the Clock check box.
8. Close the Menus Setup screen.

9. To see the changes, exit TireMaster. Then restart the program, and log in with the credentials for a
user who is assigned to the menu.

DELETE A MENU
If there is a menu you no longer use, you can remove it.

Note: You can delete a menu regardless of which site created it.

To delete a menu
1. Select Setup > Menu Configuration. The Menu Setup screen opens.
2. On the list of menus, select the one you want to remove and click Delete. A confirmation message

appears.

3. Click Yes. The menu is removed from the menu list.

4. Close the Menu Setup screen.
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MENU ASSIGNMENTS
Menu assignments define which menu appears when users log in to TireMaster.

ASSIGN MENUS
You can assign a menu to an entire location, one or more security groups, one or more users, or a
combination of locations, groups, and users.

Note: Menu assignments can be made at the site that added the menu or any of the other sites. If a
user is assigned to multiple menus, the menu that the user was assigned to first will be used.

Tip: Set up a general default menu and assign it to your location to ensure that a set of buttons
appears for users who are not assigned a menu.

To assign menus
1. If the Menu Setup screen isn’t already open, select Setup > Menu Configuration.

2. Select the menu you want to work with, and click Assign. The Menu Assignments screen appears.

3. Do the following as needed:

To assign locations, make one or more selections from the Locations list and click Add
Location.



Menu Assignments

To assign security groups, make one or more selections from the Security Group list and click
Add Group.

To assign employees, make one or more selections from the list and click Add Employee.

4. Close the Menu Assignment screen.

DELETE MENU ASSIGNMENTS
When a menu should no longer be assigned to a location, security group, or one or more users, you
can undo the assignment.

Note: You can delete menu assignments, even if they were originally made at other locations.

To delete a menu assignment
1. If the Menu Setup screen isn’t already open, select Setup > Menu Configuration.
2. Select the menu you want to work with, and click Assign. The Menu Assignments screen appears.
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3. Select the name of the location, security group, employee whose assignment you want to remove,
and click Delete. A confirmation message appears.

4. Click Yes. The assignment is removed.
5. To remove additional assignments, repeat steps 2 through 4.



PRINTER AND DOCUMENT SETTINGS
You can generate a variety of documents with TireMaster. Before you generate these documents,
however, you need define how they will look and where they will print. If you use a cash drawer, you
also need to set it up. This chapter includes the following sections:

Printers 36
Configure Documents 38
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PRINTERS
Before you print documents, define which printer to use for each document type. For example, you
might print reports on a laser printer and invoices on a dot matrix printer. See Printer Guidelines on
page 37 for a list of which printers to use for various document types.

SET UP PRINTERS
Printers need to be set up for each workstation. However, before you can assign printers in TireMaster,
you need to set them up on your network and on the individual computers connected to your network.

Note: TireMaster Corporate’s reports can be generated with only specific printers and print drivers.
To ensure that you can consistently generate documents from TireMaster, use printing
hardware and software that has been tested by ASA Automotive Systems. If you need to
purchase printers, call ASA Support or your account manager for information about
recommended printers. ASA Support can also help you identify which print drivers you might
need.

To set up printers
1. Select Setup > Printers. The Printer Selection screen opens.

2. To select a printer for reports, click next to the Reports field. The Print screen opens.

Note: Some reports print using the default Windows printer regardless of the printer you select.

3. From the Name drop-down, select a printer and clickOK.
4. Do one of the following:

If you always use this printer for a document type, make sure the Selectable check box is
clear.



Printers

If you want to choose a printer when you print, make sure the Selectable check box for the
document type is selected.

Note: Because some documents disregard this setting, you’ll always be prompted to select a
printer when printing.

5. Repeat steps 2 through 4 for the remaining printers and cash drawer (if needed).

Note: The first time you access the Quote Module, TireMaster will prompt you to define the type
of printer to use for quotes.

6. Close the Printer Selection screen.

PRINTER GUIDELINES
TireMaster lets you set up a printer for each document type and the cash drawer. Table 3-1 lists the
printer guidelines for each document type.

Table 3-1: Printer Guidelines

Printers Guidelines

Reports Prints reports, financial statements, and checks. This printer should be a
laser jet printer.

Note: Some reports use the default Windows printer regardless of the
printer you select.

Invoices Prints invoices and ROAs. This printer can be either a laser printer or a
dot matrix printer.

Work Orders Prints work orders. This printer can be either a laser jet printer or a dot
matrix printer.

WO Vehicle
Specs

Prints vehicle specifications downloaded from Epicor. This printer can be
either a laser jet printer or a dot matrix printer.
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Printers Guidelines

Quotes Prints quotes. This printer can be either a laser jet printer or a dot matrix
printer.

Purchase Order Prints purchase orders. This printer needs to be a laser jet printer.

Checklist Prints a list of recommended services for a vehicle. This printer should
be a laser jet printer.

Drawer (open) Opens an electronic cash drawer.

Note: TireMaster is designed to work with APGModel 182 cash
drawers only.

CONFIGURE DOCUMENTS
You can control the appearance of several documents by completing various settings. For example,
you can define how much text should fill a page, which information is printed, how information is
organized, and whether to include global messages.

SET THE TEXT LENGTH FOR FORMS
You have the option to print text on the entire page for work orders, invoices, and ROAs, or you can
leave space for preprinted disclaimers or logos in the middle of a page instead.

To set the form text length
1. Select Setup > Printers. The Printer Selection screen opens.

2. Click Forms. The Form Selections opens.

3. Select one of the following:
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To print text on only part of the page, select Normal. Then select one of the Set Inch options to
define the amount of white space that will separate the text from the totals. With this setting,
preprinted areas are untouched and any remaining information is printed on subsequent
pages.

To print text on the entire page, select Filled .

4. If you want to print documents on dot matrix printers, select the Invoice,Work Order, and ROA
check boxes as needed. Otherwise, leave them clear.

Note: To include global comments on invoices that use OKI forms, the text length needs to be set
to Normal.

5. If you operate a business in Canada, select the Canadian check box.

Note: Disregard the Include Reference Number check box under Statement Format. As of
TireMaster 9.3.0, statement settings have been consolidated on a single setup screen. For
more information, see Statement Configuration on page 719.

6. When you’re finished, click Save Setup.

7. Close the Form Selection screen.
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DESIGN WORK ORDERS AND INVOICES
You can choose which information, such as salesperson number, comments, and customer terms,
prints on work orders and invoices.

Note: Additional settings for invoices are available in System Controls. For more information, see
Invoice - Print Header on page 1213 and Invoice - Print Signature Line on page 1213.

To design work orders and invoices
1. Select Setup > Printers. The Printer Selection screen opens.

2. Click Form Options. The Form Options screen opens.

3. Select the check boxes for the information types you want to include on work order and invoices.

Note: Disregard the settings under Statements. As of TireMaster 9.3.0, statement settings have
been consolidated on a single setup screen. For more information, see Statement
Configuration on page 719.

4. Click Save. A confirmation message appears.



Configure Documents

5. ClickOK.
6. Close the Form Options and Printer Selection screens.

DESIGN FINANCIAL STATEMENTS
You can organize information on income statements and balance sheets by setting up groups for each
account type The groups can be general or detailed.

With general groups, all of your asset, liability, equity, income, and expense accounts are displayed
under a single heading for each account type.

Figure 3-2: Balance Sheet with General Account Type Groups
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For detailed financials, set up a general group for each account type and one or more secondary
groups. These secondary groups enable you to see totals for specific general ledger accounts.

Figure 3-3: Balance Sheet with Detailed Account Type Groups

Tip: By creating secondary account groups, you can calculate account totals for different areas of
your business without setting up departments.

UPDATE FINANCIAL STATEMENT ACCOUNT GROUPS
When you need to reorganize information on your financial statements, you can change the account
groups. There is no limit to how often you can update the settings for financial statements.

To update a financial statement account groups
1. Select Setup > GL Financial Statement Design. The GL Financial Statement Design screen

opens.

2. Select the account group you want to change, and click Edit. The GL Report Description Edit
screen opens.



Configure Documents

3. Change the description, level, and account ranges as needed.

4. To save your changes, clickOK.
Print the income statement, balance sheet, or both to see whether the changes had the intended
effect.

DELETE FINANCIAL STATEMENT ACCOUNT GROUP
If you no longer want to include an account group on the financial statements, you can delete it. To
delete an account group, open the Financial Statement Design screen, select the group you want to
remove, and click Delete.

CREATE GLOBAL MESSAGES
You can create custommessages that print on all work orders, invoices, quotes, and statements (both
monthly and real-time). You can use these messages to thank customers for their business, wish them
a happy holiday, and encourage them to make payments on time. To create global messages, you
need to belong to a security group assigned

Note: When a document is reprinted, it displays the global comment currently set up in TireMaster
instead of the comment that printed on the original.

Note: Each store can have unique work order, invoice, and quote comments. Because statements
can only be generated at the corporate site, set up statement messages at that location only.

To create global messages
1. Select Setup > Edit Global Comments. The Global Comments and Messages screen opens.

2. Click the tab for the type of global message you want to create.
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3. Type the message. There is one text field for work orders, invoices, and quotes. For statements,
you can use the same or different messages for each aging breakdown. The due date for a
customer’s oldest aged balance determines which message to use. If the text field for a document
type is empty, there is no global message for that document type.

Note: To include global comments on invoices that use OKI forms, set the text length to normal.
For more information, see Set the Text Length for Forms on page 38.

4. To save your changes, clickOK.



USERS AND SECURITY
TireMaster protects your business information by securing your data from tampering and limiting who
is allowed to view documents. This chapter includes the following sections:

User Accounts 46
Security Groups 54
Override TireMaster Security 63
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USER ACCOUNTS
Each person who uses TireMaster or does any sales or mechanic work needs to have a user account.
User accounts allow you to capture the following information:

Who started or completed an invoice

Who worked on a vehicle

Who paid expenses with cash out of the till

Employees who need to use TireMaster are required to log in with a user ID and corresponding
password.

Note: To maintain privacy, only the system-generated employee number or a combination of the
User ID and the system-generated employee number appear on documents.

Once users are logged in, they can work in the program areas they're allowed to access. For more
information, see Security Groups on page 54.

If you’re running TireMaster in a multi-store environment, see User Accounts in TireMaster Corporate
on page 943 for additional information about working with passwords and handling site access.

USER ACCOUNT PROPERTIES
For tracking and access purposes, you need to define various properties for each user. You can set
these properties on the Employee/User Edit screen (Figure 4-1).



User Accounts

Figure 4-1: Employee/User Edit Screen

Item Description

Emp # Displays the system-generated number for the user. The first field
contains the number for the site where the user account was created.

Name Lets you type the user’s name.

ID Lets you define a code for logging in to TireMaster, such as the first
and last initials of the employee’s name. The ID can be up to five
characters long.

SQL User Lets you assign a unique ID for accessing the TireMaster database.
The SQL user can be up to 15 letters. It cannot begin with a space,
number, or symbol.

Note: ASA recommends that you set the SQL user only once. If you
change it at a later time, you will need to reset the password.
Otherwise the password will, by default, be blank.

E-mail Lets you store the user’s email address.

Payroll Displays a value that can be set through some third-party applications.
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Item Description

Active Lets you define whether the employee currently works for the
company.

Note: Clearing this check box removes employees from security
groups and deletes all of their permissions.

Time Clock Lets you define whether to track the employee’s time worked with the
time clock. This checkbox is typically selected for employees who are
paid hourly. Available in TireMaster 9.4.0 or newer.

Mechanic Lets you define whether the employee is a mechanic. Selecting this
check box enables you to assign the employee (mechanic) to
appointments created with the TireMaster Scheduler.

Local User Lets you define whether the employee is allowed to log in at a site. In
TireMaster Plus and TireMaster Point of Sale, this check box is always
selected.

Password Lets you set a password for the user. For more information, see
Create New Passwords on page 51.

Note: Passwords are case sensitive.

Confirm Lets you confirm the user’s password.

Commissions Lets you access the Commission Matrix screen to complete sales
commissions settings for the user. For more information, see Set Up
an Employee Commission Matrix on page 901.

ADD USER ACCOUNTS
You need to create user accounts for employees who use TireMaster and those whose work needs to
be tracked by TireMaster, such as mechanics. Depending on how you run your business, you might
want to set up a single user account that multiple employees can use to log in to the program. For more
information, see Group Users on page 50.

Note: For some employees, you should set up two user accounts. For more information, see Multiple
Accounts for Employees on page 50.

To add a user account
1. Select Setup > Users & Permissions. The User List opens.
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2. Click Add. The Employee/User Edit screen opens.

Note: TireMaster generates the employee number automatically. The system-generated
employee numbers 1 and 2 are reserved for use by the TireMaster system administrator
and ASA Support.

3. Type the name of the employee or group user.

4. Type an ID for the employee or group to use to log in to TireMaster.

Note: The ID can be up to five characters long. The user’s initials are often good choice for an ID.

5. In the SQL User field, type a password for logging in to the TireMaster database.
6. Type the user’s e-mail address (optional).

7. If the user is a technician, make sure theMechanic check box is selected. Otherwise, leave it
clear. When the check box is selected, the employee’s name will be added to the Scheduler’s
appointment calendar. For more information, see Define Mechanics on page 564.

8. If you want to track the employee’s time worked with the Time Clock, select the Time Clock check
box. (Available in TireMaster 9.4.0.)

9. Type a password for the user. For information about creating secure passwords, see Create New
Passwords on page 51.

10. Type the password again in the Confirm field.
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11. To save the new user, clickOK.
Note: New users are automatically saved as active employees and as local users.

MULTIPLE ACCOUNTS FOR EMPLOYEES
Some employees, such as the owner and system administrator, should have two user accounts. One
account should provide access to all program areas and the other should be for performing every
day, low-security functions.

Having two accounts for these employees reduces the chance that they will leave the system open
while logged in as the owner or system administrator, exposing high-security areas to unauthorized
employees.

Note: TireMaster comes with a default user account (Admin) for the system administrator. This user
is assigned to the administrator security group. When you begin the going-online process,
change the default password for the Admin account to ensures that your administrator
privileges are available only to you.

GROUP USERS

Example: If you don’t want employees to log in and out of TireMaster repeatedly, you can set up
a group user account (which is not the same as a security group). You could create a user
account called “Sales” for all of your salespeople.

MANAGE EXISTING USER ACCOUNTS
With regular maintenance, your data remains secure and your User List is easy to manage.



User Accounts

CREATE NEW PASSWORDS
To maintain the security of your system, each account in TireMaster needs to have a password.
Whenever users start TireMaster, they need to type the user IDs and passwords. If a user needs to
log in at multiple sites, assign a for each site.

When you create passwords, use caution and common sense:

Choose a password that is six to eight characters long. Short passwords are too easy to break,
and long passwords take too long to type.

Don’t use a word or phrase that would be easy for someone to guess, such as a birthday, a
family member’s name, or a pet’s name.

Change your password on a regular basis.

To create new passwords
1. Select Setup > Users & Permissions. The User List opens.

2. Select the name of the user whose password you want to change, and click Edit. The
Employee/User Edit screen appears.

3. Type the new password in both the Password and Confirm fields.

Note: Passwords are case sensitive.
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4. To save the new password, clickOK.

MAKE USER ACCOUNTS INACTIVE
When an employee no longer works for you, inactivate his or her user account. Inactivating a user
account results in the following:

It removes the user from security groups.

It removes any permissions and reports associated with that user.

Note: Inactivating user accounts helps you manage the number of names displayed on the
User List. To display the names of inactive users, clear the Active Users Only check
box.

To inactivate user accounts
1. Select Setup > Users & Permissions. The User List opens. The User List appears.

2. Select the name of the user who you want to make inactive.

3. Click Inactivate.

4. To confirm that you want to inactivate the user, click Yes.

MAKE USER ACCOUNTS ACTIVE
If you inactivate a user account by accident or if a former employee comes back to work for you, you
can activate his or her user account.

Note: Once you activate a user account, you need to reassign the user to one or more security
groups.
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To activate a user account
1. Select Setup > Users & Permissions. The User List opens.

2. Clear the Active Users Only check box to display the names of both inactive and active users.

3. Select the name of the user account you want to make active and click Edit. The Employee/User
Edit screen appears.

4. Select the Active Only check box. A confirmation message appears.

5. To verify that the user is now active, clickOK.
6. To save your changes, clickOK.

7. Close the User List.
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SECURITY GROUPS
Security groups define which program areas employees are allowed to access and which reports
they’re allowed to print. Security groups are set up based on the different roles of employees. Each
security group is assigned the following:

Permissions, which define the program areas users in that group are allowed to access. For a
list of permissions, see Permissions List on page 1185.

Reports, which define the documents users in that group are allowed to print.

DEFAULT SECURITY GROUPS
New TireMaster systems ship with the following security groups.

Administrator is for the person responsible for maintaining and supporting TireMaster. The
user account for the system administrator is automatically assigned to this security group.
Typically, all permissions are assigned to the administrator.

Owner is for the person who owns the store. Typically, all permissions and reports are assigned
to the owner security group.

Accountants is for your accountants or bookkeepers. Typically, the users in this security group
are assigned permissions for all accounting functions, along with reports for generating
accounts payable, accounts receivable, and financial information.

Sales is for users who work at point of sale. Typically, invoicing and some customer permissions
are assigned to the sales security group.

Once the permissions and reports for a security group are set, you can assign users to that group.

ADD OR RENAME SECURITY GROUPS
If the settings for an existing security group don’t meet your needs, you can rename it or create a new
one.

To add or rename a security group
1. Select Setup > Users & Permissions. The User List opens.

2. Click Security. The Security Assignments screen opens.
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3. ClickGroup Maintenance. The Security Group Maintenance screen opens.

4. Do one of the following:

For a new group, click Add.
To rename an existing group, select the group’s name and click Edit.

The Security Group Add/Edit screen opens.

5. Type a name for the group and clickOK. The name of the new group is added to the list of security
groups.

6. Close the Security Group Maintenance screen and the User List.

ASSIGNING PERMISSIONS TO A SECURITY GROUP
You can control which program areas users can access by assigning permissions to the security
groups.

To assign permissions to a security group
1. Select Setup > Users & Permissions. The User List opens.
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2. Click Security. The Security Assignments screen opens.

3. On theGroups list, select the security group you want to assign permissions to.

4. Under Assignments, select Permissions. The assigned permissions for the group, if any, appear
on the Assigned list.

5. To assign permissions to the group, do one of the following on the Unassigned list:
For an individual permission, double-click the permission’s name.

For an individual permission, select the permission’s name and click .

For multiple permissions, press Ctrl while you select each permission that you want to assign.
Then click .
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6. Close the Security Assignments screen and the User List.

ASSIGN REPORTS TO A SECURITY GROUP
You can control which documents users are allowed to print by assigning reports to security groups.

Note: Assigning reports to security groups affects only those documents that can be generated from
the Report List.

To assign reports to a security group
1. Select Setup > Users & Permissions. The User List opens.

2. Click Security. The Security Assignments screen opens.

3. On theGroups list, select the security group you want to assign reports to.
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4. Under Assignments, select Reports. The assigned reports for the group, if any, appear on the
Assigned list.

5. To assign reports to the group, do one of the following in the Unassigned list:
For an individual report, double-click the report’s name.

For an individual report, select the report’s name, and click .

For multiple reports, press Ctrl while you select each report that you want to assign. Then click
.

6. Close the Security Assignments screen and the User List.

ASSIGN USERS TO A SECURITY GROUP
Before you can give users access to program areas and reports, you need to assign them to one or
more security groups.

To assign users to a security group
1. Select Setup > Users & Permissions. The User List opens.
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2. Click Security. The Security Assignments screen opens.

3. On theGroups list, select the security group you want to assign users to.

4. Under Assignments, make sure Employees is selected. The names of the assigned users for the
group, if any, appear on the Assigned list.

5. To assign users to the security group, do one of the following in the Unassigned pane:
For an individual user, double-click the user’s name.

For an individual user, select the user’s name, and click .

For multiple users, press Ctrl while you select each user that you want to assign. Then click
.
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6. Close the Security Assignments screen and the User List.

REVIEW SECURITY ASSIGNMENTS
Occasionally, you might need to review the assignments for a security group or an employee, or you
might want to check the assignments for a report or a permission. TireMaster makes it easy to view
and generate a printout of this information.

Note: Permissions and reports are assigned only to active employees.

To review an employee’s permissions & reports
1. Select Setup > Users & Permissions. The User List opens.

2. Click Security. The Security Assignments screen appears.

3. Click View Security Assignments. The View Security Assignments screen appears.

4. Select one of the following from the View Assignments by drop-down:
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To see which permissions, users, and reports are assigned to a security group, select Security
Group.
To see which groups, permissions, and reports, are assigned to a user, select Employee.
To see the users and groups a permission is assigned to, select Permission.
To see the users and groups a report is assigned to, select Report.

5. Depending on your selection in step 4, select a group, employee, permission, or report.

6. To print the information displayed on the screen, click one of the following:

Print assignments for the selected group

Print assignments for the selected employee

Print assignments for the selected permission

Print assignments for the selected report
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The Report Window opens and displays the Security Assignments Report.

7. Print the report and then close the Report Window.

8. Close the open screens.

REMOVE SECURITY GROUP ASSIGNMENTS
If you decide that a permission, report, or user should no longer be assigned to a particular security
group, you can remove it from the group.

To remove security group assignments
1. Select Setup > Users & Permissions. The User List opens.

2. Click Security. The Security Assignments screen appears.

3. Select the name of the group whose assignments you want to change.

4. Do one or more of the following as needed:
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To remove a user from the group, select Employees in the Assignments area. Then select
the user’s name, and click .

To remove a permission from the group, select Permissions in the Assignments area. Then
select the permission name, and click .

To remove a report from the group, select Reports in the Assignments area. Then select the
report name, and click .

Note: To remove multiple users, permissions, or reports, press the Ctrl key while making each
selection.

5. Close the Security Assignments screen.

6. Close the User List.

OVERRIDE TIREMASTER SECURITY
If you are logged in as a regular user and come across a restricted area, TireMaster displays a warning
(Figure 4-2).

Figure 4-2: Restricted Feature Warning

The warning states that you aren’t assigned the permission needed to use the feature in question.
When the warning appears, you need to have a manager or another user with the required permission
override the restriction. This topic describes the buttons and options available on the Security
Assignments screen.
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Note: Any user who has the permission in question can also override the restriction. This override
lasts until the affected screen is closed.

To override a permission restriction
When the TireMaster Security Message screen appears, clickOverride. Then type the user name and
password for the user who has the appropriate permission on the override verification screen, and click
OK.



CUSTOMERS
With TireMaster, you can track sales and payment activity for walk-in customers and those who have
in-store charge accounts. This chapter includes the following sections:

Add and Manage Customers 66
Customer Maintenance Screen 81
Customer Searches 93
Customer Payment Terms 94
Customer Types 98
Customer Type Edit Screen 102
Customer Color Codes 104
Credit Color Codes 109
External History Viewer 111
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ADD AND MANAGE CUSTOMERS
Adding new customers and managing existing customer records are two of the most commonly
performed tasks in TireMaster. For information about adding and managing vendor accounts, see Add
and Manage Vendors on page 176.

ADD A CASH CUSTOMER
In TireMaster, cash customer is a classification for those clients who are required to pay upon
completion of a sale. Clients classified as cash customers can pay with cash, check, or payment cards.
Cash customers are typically those clients who walk into your store to inquire about products and
services.

Customers can be added at either the corporate site or the stores. The site where a customer is added
is included in the system-generated customer number.

To add a cash customer
1. Start a work order or a quote. TireMaster prompts you for the customer's name. For more

information, see Create a Regular Work Order on page 442 or Basic Tire Quotes on page 503.

2. To close the Name Lookup/Entry screen, click Cancel .

3. On the Customer Maintenance screen, click Add. TireMaster prompts you for the new customer’s
name.

4. Type the new customer’s last name or the customer’s business name and clickOK. One of the
following occurs:

The Customer Maintenance screen opens, with the customer's last name filled in.

If a customer with the same last name already exists, TireMaster asks if you want to continue.
To add the customer, click Yes . To see if the customer already exists in the database, click
No. The customer record will open for editing, or you'll be prompted to select the name from the
customer list.
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5. After the new customer’s last name, type a comma, a space, and the customer’s first name. (For
example. CARLSON, STUART.)

Note: For businesses, disregard the comma before the abbreviation Inc. Otherwise, Inc. will be
treated as a last name (Inc., My Company).

6. Type the new customer’s street or mailing address.

7. Type the customer’s zip code. If the zip code has already been used, the Zip Codes screen
appears.

8. ClickOK. The city and state are added to the customer’s contact information.

9. Add the phone numbers and e-mail address you want to have on record for the customer. For
more information, see Add Phone Numbers and Email Addresses on page 161.

10. To accept the remaining default settings for the customer, clickOK. For more information, see
General Tab on page 81.
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Note: Most walk-in customers will have the same tax level, customer type, price level, and
payment settings. To save time, the customer default settings in System Controls should
match the profile of your typical customer.

ADD AN AR CUSTOMER
When management agrees to extend in-store charges privileges to a business or individual, create a
customer record for the client that includes the credit limit and payment terms. Customers can be
added at either the corporate site or the stores. The site where a customer is added is included in the
system-generated customer number.

Note: If you need to create a record for a national account or government support customer, see Add
a National Account Customer on page 833 or Add a Government Support Customer on page
841.

To add an AR customer
1. Select Customers > Maintenance. TireMaster prompts you for the customer's name.

2. To close the Name Lookup/Entry screen, click Cancel .

3. On the Customer Maintenance screen, click Add. TireMaster prompts you for the new customer’s
name.
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4. Type the new customer’s name, using the following guidelines, and clickOK:
For individuals, type the last name, a comma, a space, and the first name. (For example,
CARLSON, STUART.)

For businesses, disregard the comma before the abbreviation Inc. Otherwise, Inc. will be
treated as a last name (Inc., My Company).

5. Add the customer's address and contact information:

a. Type the new customer’s street or mailing address.

b. Type the customer’s zip code. If the zip code has already been used in TireMaster, the Zip
Codes screen appears.

c. ClickOK. The city and state are added to the customer’s contact information.
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d. Add the phone numbers and e-mail address you want to have on record for the customer. For
more information, see . Add Phone Numbers and Email Addresses on page 161.

6. To classify the customer as an AR account, do the following:

Clear the Cash Only check box.
Select or clear the Statement and Finance Charge check boxes as needed.
Type the credit limit. For unlimited credit, type 0.00.

7. Update the remaining costumer settings (such as tax level, price level, customer type) as needed.
For more information about customer account settings, see General Tab on page 81.

8. ClickOK to save your changes.
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9. Set the customer's payment terms. For more information, see Set a Customer's Payment Terms
on page 97.

UPDATE CUSTOMER RECORDS
Occasionally you need to update customer information, such as address, phone number, or tax level.
You can modify the information for a single customer or you can update a range of customer records.

UPDATE ONE CUSTOMER RECORD
Most of the time, you’ll need to make changes to one customer record at a time. You can make these
changes on the Customer Maintenance screen. Customer information can be updated at either the
corporate site or the stores.

To update a customer record
1. Look up the customer whose settings you need to update. The Customer Maintenance screen

appears. For more information, see Customer Searches on page 93.

2. Make sure theGeneral tab is selected, and do one of the following:
If you have permission to update the entire customer record, click Edit.

If you’re allowed to update the contact information and notes only, click Edit Contact.
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3. Make the needed changes. For information about the settings on this screen, see Customer
Maintenance Screen on page 81.

4. To save your changes, clickOK.

UPDATE MULTIPLE CUSTOMER RECORDS
You can update the information for a range of customer records with Customer List Editing.
Customer information can be updated at either the corporate site or the stores. If you need to update
a range of vendor records instead, see Update Multiple Vendor Records.

To update multiple customer records
1. Select Customers > List Editing. The Customer Range Lookup screen opens.

2. To search for a range of records to edit, use one or more of the following:

Starting and ending name

Customer ID (starting and ending)

Area code (starting and ending), city, state, or zip code

Blank zip codes

Site (for the corporate site of TireMaster Corporate systems only)
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Salesperson, customer type, price level, commission type, or tax level

Active, inactive, or both

Cash, credit, or both

Customers who are assessed finance charges, those who aren’t, or both

Customers who receive statements, those who don’t, or both

Tip: To return to the screen’s original settings, click Reset.

3. ClickOK. The Customer List Editing screen opens.

Note: For a hard copy of the information listed on the screen, click Print to generate the List
Editing Report.

4. Select a column and update the records as needed. You can type your changes or make a
selection from a list. To select a setting from a list, click or press .

Tip: You can rearrange the columns on this screen. For more information, see Rearrange
Table Columns on page 10.

5. When you’re finished updating the records, click Close.
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ADD A SHIPPING ADDRESS
TireMaster lets you store additional shipping or billing addresses for each customer. When you create
new work orders, you can select one of the addresses.

To add a separate shipping address
1. Search for the customer whose shipping address you’re going to add. For more information, see

Customer Searches on page 93.

2. On the Customer Maintenance screen, click the ShipTo tab.

3. Click Add. The Ship-To Maintenance screen appears.

4. Type a unique name for the address and the address information.

5. To save the new address, clickOK.
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MANAGE ADDITIONAL CUSTOMER INFORMATION
If you need to store additional information in a customer’s record, you can add it to the Information
tab. Types of information that can be added to the tab include additional contact names and billing
instructions. This functionality is available in TireMaster 9.4.0 and newer.

Note: Content on the Information tab can be updated only by users assigned the permission
Customer Edit Information Tab.

Tip: The content on the Information tab can also be viewed at point of sale.

To add content to the Information tab
1. Search for the customer for whose information you want to add. For more information, see

Customer Searches on page 93.

2. Click the Information tab.

3. Click Edit.

4. Type the new information, and click Save.

COMBINE CUSTOMERS
In some cases, such as duplicate entries or marriage, you might need to combine two or more
customer records. When you combine customers, TireMaster makes one or more customer records
inactive and adds that information to an existing customer record which is maintained. This
functionality is available in TireMaster 9.4.0 and newer.
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Note: If the customer you want to combine with another customer has no history, such as invoices
and ROAs, make it inactive instead of combining it.

Note: If you want to combine one or more vendor records, see Combine Vendor Records on page
181.

To combine customers
1. Search for and select the customer whose record you want to keep. This customer will be referred

to as themaster customer. For more information, see Customer Searches on page 93.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected and click
Un/Combine. The Combine/Uncombine screen opens.
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3. Click Select Customers. TireMaster prompts you for a name.

4. Type all or part of the name of the customer whose record you want to combine with the master
customer you selected in step 1 and clickOK. The Customer List opens.
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5. Select the customer’s name, and clickOK. The selected customer is added to the list on the
Combine/Uncombine screen.

6. To combine additional customers with the master customer, repeat steps 3 through 5 as often as
needed.

7. Click Combine and Inactivate These Customers.

A message similar to the following appears:

“You are about to remove/combine these customers with the Master Customer ALVERSON, FRANK
(143-1). Continue?”

8. Click Yes. TireMaster inactivates the selected customer or customers and adds that customer
information to the record you selected in step 1. A note is also added to newly inactive customer
records, providing a paper trail for research purposes.

9. Close the open screens.

10. Update the customer record that you kept as needed.
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Example: If you combined the customer records for married couple Frank Alverson and Mary
Alverson, you could change the name from Alverson, Frank to Alverson, Frank
and Mary.

UNCOMBINE CUSTOMERS
If customer records are combined in error or you need to separate customer records for another
reason, you can uncombine them from the master customer. This functionality is available in
TireMaster 9.4.0 and newer.

To uncombine customers
1. Search for the customer you want to remove from the master customer record, making sure to

clear the Active Only check box on the name lookup screen. For more information, see Customer
Searches on page 93.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected and click
Un/Combine. The Combine/Uncombine screen opens.

3. Click Uncombine Master Customer. A confirmation message appears.
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Note: A customer record can be separated from the master customer only if it has history, such
as invoices and ROAs. If the Uncombine Master Customer button is disabled, the
customer you are trying to uncombine has no history. If the button is disabled and you
know the customer has history, check the date entered in the system control ARAP
Lookup Date (Other tab). You might need to temporarily change the date to one that's
further in the past to include the customer's older transactions.

4. ClickOK.
5. Close the Combine/Uncombine screen.

6. ClickOK to save your changes. A note is also added to newly uncombined customer record,
providing a paper trail for research purposes.

7. Close the Customer Maintenance screen.

MAKE A CUSTOMER INACTIVE
If a customer is no longer doing business at your store, you can inactivate corresponding the customer
record. Inactive customer records can be excluded from customer searches.

To make a customer inactive
1. Search for the customer whose record you want to make inactive, making sure to clear the Active

Only check box on the name lookup screen. For more information, see Customer Searches on
page 93.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected and click Edit.

3. Clear the Active Customer check box.
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4. ClickOK to save your changes, and close the Customer Maintenance screen.

DELETE A CUSTOMER
Customer records that have never been used can be deleted from the TireMaster database.

Note: If you want to delete a customer record but cannot due to transactional history, inactivate the
customer record instead. For more information, see Make a Customer Inactive on page 80.

To delete a customer record
1. Search for the customer whose record you want to delete. For more information, see Customer

Searches on page 93.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected and click Delete. A
confirmation messages appears.

3. Click Yes. The customer is removed from the database.

CUSTOMER MAINTENANCE SCREEN
You can store and track information about customers and their vehicles on the Customer Maintenance
screen. This screen appears when you add a customer and at point of sale.

GENERAL TAB
TheGeneral tab (Figure 5-1) includes contact and account information for the selected customer.
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Figure 5-1: Customer Maintenance Screen General Tab

Item Description

Prev
Next

Lets you move to the record for the previous or next customer on the
Customer List. The shortcut key for Prev is PageUp, and the shortcut
key for Next is PageDown. To move to the next or previous customer,
you need to be out of edit mode.

Note: Customer records for inactive customers are retrieved only by
clicking Prev or Next when they’re included in the initial
customer search. To include inactive customers in a search,
clear the Active Only check box on the Name Lookup/Entry
screen. For more information, see Customer Searches on page
93.

Cust # Lets you enter the customer number, if any, from your previous system.
The customer number generated by TireMaster is also listed here. The
second number identifies the site where the customer was added. The
third digit is a unique, system-generated number assigned to the
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Item Description

customer.

Name Lets you enter the name of the customer as you want it to appear in
your searches. When typing a customer’s name, do the following:

For people, type the last name followed by a comma and the first
name (Smith, John). The last name is displayed first on the
Customer List and reports. However, the first name appears
before the last name on documents such as invoices and
statements.

For businesses, disregard the comma before the abbreviation
Inc. Otherwise, Inc. will appear first on invoices and statements
(Inc., My Company).

Address Lets you enter the customer’s physical address.

Address 2 Lets you enter the customer’s P.O. box address, if any.

Note: If the customer only gives you a P.O. box number, put it in the
Address 1 field and leave this field blank.

City Lets you define the customer’s city.

Tip: Enter the customer’s zip code first to insert the city and state
automatically.

State Lets you define the customer’s state.

Zip Lets you enter the customer’s zip code.

Tip: Type the zip code first. If it is already in the database, the city
and state will be inserted automatically.

Color Lets you assign a color code to the customer. If a color code is
assigned to a customer, that customer’s name is highlighted with the
assigned color on the Customer Maintenance screen, the Customer
List, the OpenWork Order List, and the Invoice Entry screen.

Contact Type
Fields

Does the following:

Identifies the contact method assigned to the selected
customer’s phone numbers, email addresses, or both.

Lets you define the contact method for phone numbers, email
addresses, or both (in add and edit modes).

Number/E-Mail
Fields

Does the following:
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Item Description

Identifies the phone numbers, email addresses, or both
assigned to customers.

Lets you define the phone numbers, email addresses, or both
assigned to customers (in add and edit mode).

Name Fields Does the following:

Identifies the person to whom an email address or phone
number is assigned. This entry can also be a description, such
asMain Phone.

Lets you define the name or description that you want to assign
to phone numbers, email addresses, or both (in add and edit
mode).

Lets you move to the previous contact. Available in TireMaster 9.4.0
and newer.

Let’s you move to the next contact. Available in TireMaster 9.4.0 and
newer.

Phone & E-Mail Lets you access the customer’s contact list, which includes both phone
numbers and email addresses.

Text Lets you access the screen for sending text messages to the customer.

Edit Contact Lets you update the customer’s address, phone numbers, email
addresses, and notes.

Note: Users who are allowed to update contact information only can
click this button when they need to make changes to customer
records.

Taxable Defines whether the customer pays sales tax.

Note: Tax exempt or reseller customers should be set up with tax
levels that calculate no tax. This approach ensures that all
customers appear on tax reports, regardless of whether they
pay sales tax.

Cash Only Defines whether the customer must pay at the time of sale. If this check
box is cleared, the customer has an in-store charge account.

Statement Defines whether TireMaster will print statements for any balances that
the customer carries.

Print Lets you generate a hard copy of the customer’s statement .
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Item Description

Email Lets you email the statement to the customer.

Email & Invoices Lets you email the statement to the customer, along with copies of the
documents listed on the statement.

Emails Lets you define which email addresses the customer’s statements will
be sent to.

Finance Charges Defines whether the customer will be assessed a finance charge for
any balance that is past due.

Open Item AR Lets you apply payments toward specific invoices. All charge
customers are set up with open item AR accounts.

Note: This check box is always selected and cannot be cleared.

Tax Level - Parts Lets you assign a tax level for calculating the amount of sales tax
assessed on parts sold to the customer.

Tax Level - Labor Lets you assign a tax level for calculating the amount of sales tax
assessed on labor sold to the customer.

Price Level Lets you assign a price level code that will allow the customer to
receive special prices for any or all items.

AR/AP Defines whether the record is for a customer (accounts receivable) or a
vendor (accounts payable). For customers, this setting is always AR.

Type Lets you assign a customer type to the customer.

Commission Lets you assign a customer commission type to use for calculating
commissions. If no code is entered in this field, TireMaster uses the
default customer commission type set in System Controls.

Tax ID Lets you define a customer’s tax identification number, if that client is
exempt from paying sales tax.

Tax Expire Lets you define the expiration date for a customer’s tax exemption.

Credit Limit Lets you set the credit limit for charge customers. To give a customer
unlimited credit, type 0.00.

Note: This field is active when the Cash Only check box is clear. If
you change an in-store charge customer to a cash-only
customer, this field will become disabled but will continue to
display the credit limit amount.

Last Pay Displays the last date when a payment from the customer posted to the
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Item Description

general ledger. Displays the date of the last payment from the
customer.

Salesperson Lets you assign a salesperson to the customer’s account. That
employee is then used as the default salesperson for any work orders
created for the customer.

Customer Since Lets you define the date when the customer started doing business
with you.

Notes Lets you enter information about the customer or account. This
information does not print on statements.

Note: This information can be viewed at point of sale by clicking the
Customer Notes tab on the Invoice Entry screen.

Active Customer Defines whether the customer is active. Clearing the check box
removes the customer from reports and lookup lists but preserves the
customer’s history.

Require PO Lets you define whether a PO number is required to complete an
invoice for the customer.

No Shop Supplies Defines whether the customer is charged shop supplies. Available in
TireMaster 9.4.0 and newer.

No FET Defines whether the customer is charged federal excise tax. Available
in TireMaster 9.4.0 and newer.

Default Recon Displays the default reconciliation code for the customer (if any).

Recon Codes Lets you enter one or more reconciliation codes for customers who
have national account or government support agreements with your
vendors.

Fleet Contracts Not used.

Inventory Lets you look up inventory items to see the customer’s best price for
those items. The best price is the everyday low price or the sale price,
whichever is lower.

Find Lets you look up a customer or a list of matches using full or partial
entries.

Add Lets you add a new customer.
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Item Description

Edit Lets you change the customer’s contact and account information.

Delete Lets you delete a customer record that has never been associated with
an invoice, work order, or quote.

Terms Displays the screen for assigning payment terms to the customer.

Un/Combine Lets you do the following:

Select one or more other customers to inactivate and combine
with the current customer. This option combines the history,
vehicles, and ledgers of the selected customer with those of the
current customer (which is referred to as the master customer).

Separate the selected customer from the master customer
record that it was previously combined with.

This functionality is available in TireMaster 9.4.0 and newer.

Cancel Lets you exit the screen in add or edit mode without saving any
changes.

OK Lets you save changes in add or edit mode and exit the screen.

Close Lets you exit the screen.

VEHICLE TAB
The Vehicle tab (Figure 5-2) lists a customer’s vehicles. From this tab, you can also initiate vehicle
transfers and access service history.
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Figure 5-2: Customer Maintenance Screen Vehicle Tab

Item Description

Retail Displays a list of the customer’s retail vehicles (such as cars, pickup
trucks, and minivans).

Commercial Displays a list of the customer’s commercial vehicles (such as dump
trucks, buses, and fork lifts).

Year Displays the model year for the vehicle.

Make Displays the make for the vehicle.

Model Displays the model for the vehicle.

Unit # Displays the unit number the customer has assigned to the vehicle.

License Displays the license plate number for the vehicle.

Mileage Displays the last ending mileage entered for the vehicle.

Site Displays the site number for the location where the vehicle was added.

VIN Displays the vehicle’s identification number.

Find Vehicle Lets you look for a vehicle on the list by make, model, or license plate
number.



Customer Maintenance Screen

Item Description

Search Lets you activate the search for a vehicle.

Active Only Displays only the active vehicles on the customer’s vehicle list.

Checklist Lets you access the recommended service checklist for the selected
vehicle.

CARFAX History Lets you access service and repair history that CARFAX has collected
for the selected vehicle.

Other Checklist For future use.

Add Lets you add a new vehicle for the customer.

Edit Lets you change information for the selected vehicle.

Delete Lets you delete a vehicle from the list that is not already associated with
an invoice, work order, or quote.

Transfer Lets you move the history for a vehicle from the selected customer to
another customer. After a transfer, the sales history for the transferred
vehicle still appears in the original customer’s historical ledger.

Combine Lets you combine the history for two vehicles when there are multiple
listings for the same vehicle.

History Displays a list of all the items sold to the customer and the
corresponding invoices for the selected vehicle.

Expense Lets you generate a vehicle expense report for the selected vehicle.

SHIPTO TAB
The ShipTo tab list separate shipping or billing addresses for the selected customer. When you create
new work orders, you can select one of the addresses.

Tip: To quickly find the address you need from a list of multiple addresses, type all or part of the
address name in the Find ShipTo field. Then click Search.

CUSTOMER LEDGER/HISTORY TAB
The Ledger/History tab (Figure 5-3) displays a customer’s subledger account activity.
Tip: You can limit the number of documents retrieved when looking up a customer’s history by

setting a system control. For more information, see AR/AP Lookup Date on page 1209.
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Figure 5-3: Customer Maintenance Screen Ledger/History Tab

Item Description

Search Lets you narrow down the documents displayed by invoice number,
reference number, PO number, check number, or amount.

Sort By: Lets you display documents by the transaction date, transaction
reference number, or invoice number.

Note: When Invoice # is selected, additional sorting by site number
also occurs.

(first blank field) Displays the customer’s name.

(second and third
blank fields)

Displays the system-assigned customer number. The first digit identifies
the site where the customer was added.

Date Displays transaction dates.

Site Displays the sites where transactions occurred.

Mod Defines the type of transactions.

Invoice Displays the document numbers for the transactions.

Ref Displays any reference information entered when the transactions
occurred.

Total Amt Displays the total amount for transactions (in historical view only).



Customer Maintenance Screen

Item Description

Charge Amt Functions in one of the following ways:

In historical view, shows only the amount charged. For example, a
$100 charge made toward a $120 purchase would show as 100.
ROAs and discounts do not show an amount.

In AR view, shows the original amount. For charges and late fees,
this amount is positive. For ROAs and discounts, this amount is
negative.

Paid Amt Shows the amount applied to an item (in AR ledger view only). For
charges and late fees, the amount is displayed as a positive number. For
ROAs and discounts, the amount is displayed as a negative number.

PO Displays the document number for a PO charge.

Check# Displays the check numbers for AR easy checks and the checks that the
customer used to pay you (in historical view only). Displays the check
numbers for the checks that the customer used to pay you (in historical
view only).

AR Ledger Displays all account activity (charges, payments received on account,
discounts, or other) for the current period, as well as all unpaid or
unapplied amounts from previous periods.

Note: ROAs are displayed as negative amounts, because they
decrease the customer’s balance.

History Displays all invoices, ROAs, finance charges, and discounts generated
since the customer’s account was started.

Note: Because the historical ledger is not used to calculate the
customer’s balance, ROAs are displayed as positive amounts.

Ext. Hist Lets you access the External History Viewer (if it’s installed). For more
information, see External History Viewer on page 111.

Emails Lets you email one or more selected documents to the customer.

Credit Memo Lets you create a credit memo for the customer.

Open Item Displays the open item ledger, where you can view or apply payments to
outstanding invoices.

Print Lets you reprint the selected historical invoice or other document.
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Item Description

Tax Lets you change the amount of sales tax charged for a completed
invoice.

Research Lets you view journal entries related to a selected item in the customer’s
subledger in TireMaster Plus and TireMaster Corporate systems.

CUSTOMER AGING TAB
The Aging tab (Figure 5-4) displays a customer’s balances and information about unapplied credits or
unpaid finance charges.

Figure 5-4: Customer Maintenance Screen Aging Tab

Item Description

Balance Displays the total amount owed to you.

Unapplied Credits Displays the total of any amounts received on account (ROAs) that have
not been applied to a specific invoice. Unapplied amounts affect the
customer’s balance but remain in the open item ledger until you apply
them.

Unapplied Itm Cnt Displays the number of payment and credit items in the customer’s
ledger that have not been applied.

Unpaid Fin Chrgs Displays any finance charges that have not been paid.
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Item Description

Current Displays the balance resulting from in-store charge and finance charge
activity that occurred since the last statement cutoff.

Note: Any ROAs that have never been applied to the customer’s
account are included in the current balance.

YTD Displays the total amount of sales to the customer for the current year.
On January 1, the amount in this field is reset to $0.00.

Note: Year-to-date totals are not calculated for the credit card customer
accounts (such as ZZ-Visa/MasterCard), because those
customer accounts are used for tracking payments received from
credit card companies.

1-30 Displays the balance due as of the last statement.

31-60 Displays the balance due as of the second-to-last statement.

61-90 Displays the balance due as of the third-to-last statement.

Over Displays any balances due for more than 90 days.

Future Displays any balance that will appear as current on the next statement.

Last Statement Lets you view account information for the selected customer as of the
last statement cutoff date.

Current Date Lets you view account information for the selected customer as of
today’s date.

INFORMATION TAB
The Information tab for storing further details about a customer’s account. For example, you could
post additional contacts or billing instructions on it.

Note: Users who are responsible for managing the content on the Information tab need to be
assigned a permission. For more information, see Customer Edit Information Tab on page
1187.

CUSTOMER SEARCHES
Searching for customers is one of most commonly performed tasks in TireMaster. Customer searches
typically occur when starting various transactions and when you need to review information such as a
customer's account balance or history.

To search for a customer
1. Start a task that requires you to search for a customer or select Customers > Maintenance.

TireMaster prompts you for the customer's name.

2. Type one of the following, or leave the Enter Name field blank to retrieve all customers.
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Name

Tip: You can use the percent sign (%) to replace an unknown portion of the customer's
name.

License plate number

System-generated customer number (disregard the site)

Phone number (last four digits of home, business, fax, or cell numbers)

Unit number

Vehicle identification number

Note: Partial entries are allowed for names, license plate numbers, unit numbers, and VINs.

3. To include inactive customers in the search, clear the Active Only check box.
4. Clear the Search All Site check box to limit the search to customers added at your site.

5. ClickOK. One of the following occurs:
If the search finds an exact match, the Customer Maintenance screen opens to the customer's
record.

If more than one customer matches the lookup, the Customer List appears. In this scenario,
select the appropriate customer’s name, and clickOK.

Tip: If you selected the wrong customer, click the Prev or Next button on the Customer
Maintenance screen move to the correct customer record.

CUSTOMER PAYMENT TERMS
If you offer in-store charge accounts, you need to assign payment terms to your customers. Payment
terms include due dates, discounts for early payments, and the number of installments.

SET DEFAULT CUSTOMER TERMS
Default payment terms are those terms which you extend to the majority of your customers who have
in-store charge accounts. To define your default payment terms, you need to set a variety of system
controls.

To set default customer payment terms
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Customer tab.



Customer Payment Terms

3. Make sure Corporate Controls is selected.
4. Set the requirements for the default due date:

a. Select Default AR Due (D=#Days or T=Date) and press Enter.

b. If the payment is due by a specific number of days after the purchase, select Days. If the
payment is due by a specific day of the month instead, select Th. Then clickOK.

c. Select Default AR Due #Days/Date and press Enter.

d. Type the number that represents the number of days after the purchase or the day of the
month. Then clickOK.

5. Set the default number of payments for an invoice:

a. Select Default AR Terms (#Payments) and press Enter.

b. Type the number of installments and clickOK.
6. Set the default early pay discount percentage:
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a. Select Default AR Discount Percentage (%) and press Enter.

b. Type the percentage amount and clickOK.
7. Set the requirements for receiving the early pay discount:

a. Select Default AR Discount (D=#Days or T=Date) and press Enter.

b. If you need to receive the payment by a specific number of days after the purchase, select
Days. If you need to receive the payment by a specific day of the month instead, select Th.
Then clickOK.

c. Select Default AR Discount #Days/Date and press Enter.

d. Type the number that represents the number of days after the purchase or the day of the
month. Then clickOK.

8. Close the System Controls screen.



Customer Payment Terms

SET A CUSTOMER'S PAYMENT TERMS
When you add a customer, the default payment terms are assigned automatically. If you want to offer
different terms to a customer instead, you can set custom payment terms for that client.

To set custom payment terms
1. Look up the customer for whom you want to set custom terms. For more information, see

Customer Searches on page 93.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected.

3. Click Terms. The Terms screen opens.

4. To enable early pay discounts, select theGive Early Pay Discounts check box.
5. To set a unique early pay discount, due date, or both, clear the Use Above Defaults check box.

TireMaster disables the default terms.

6. If you selected theGive Early Pay Discount check box in step 4, do the following:
a. Type the discount percentage in the Discount % field.

Example: To subtract 2% from invoices for which you receive early payment, type 2 in the
Discount field.

b. If the payment must be received a specific number of days after the purchase to give the
discount, type the number of days in the Discount Days field and select Days Later. If the
payment must be received by a specific day of the month instead, type the day of the month
and select Day of Month.
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7. If the payment is due a specific number of days after the purchase, type the number of days in the
Due Date field and select Days Later. If the payment is due by a specific day of the month instead,
type the day of the month and select Day of Month.

Note: If payments are due on the last day of the month, type 31. TireMaster adjusts due dates for
months with fewer than 31 days.

8. Under Invoice Terms, select the maximum number of payments the customer can make on an
invoice.

9. Under Future Due, define whether to include future due invoices and balance adjustments on the
customer’s statements.

To use the future due setting defined on the Statement Setup screen, select Default. For more
information, see Define Statement Print Options on page 722.

To always include future due items on the customer’s statements, selectOn.
To always exclude future due items from the customer’s statement, selectOff.

10. To save your changes, clickOK.

CUSTOMER TYPES
Customer types classify customers and ensure that special handling occurs at point of sale. You can
also use customer types to organize information on several reports.

When you start a work order, TireMaster looks at the customer’s type code to determine the following:

Whether you’ll be prompted to select a vehicle

Whether you’ll be prompted to select a tax level

Whether to include add-on items on the work order



Customer Types

Which general ledger accounts the completed sale will post to

TireMaster comes with several customer types that you can customize and you can add your own. If
you’re looking for information about vendor types, see Vendor Types on page 194

ADD A CUSTOMER TYPE
Although TireMaster comes with several customer types, you can create additional types to further
classify your clients. Before you set up your customer types, talk to your accountant about which
general ledger accounts any new types should post to.

To add a customer type
1. Select Customers > Types. The Customer/Vendor Type List opens.

2. Click Add. The Customer/Vendor Type Edit screen opens.

3. Define a unique code for the customer type in the Type field.
Note: For ease of use, use only letters or numbers.

4. In the AP or AR field, type AR.

5. Type a description for the customer type.

6. Assign the general ledger accounts for posting sales for the new customer type. To assign an
account, click the account field, press , and select an account from the list that appears.
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7. Select any options that you want to enable for the customer type. For more information, see
Customer Type Edit Screen on page 102.

8. To assign a department to the type, click the Department field, press , and select an account
from the list that appears (optional).

9. To save the customer type, clickOK.

SET THE DEFAULT CUSTOMER TYPE
The default customer type is the setting that identifies your typical customer. For example, if most of
your customers buy tires and services for their personal vehicles, you would define the retail customer
type as the default. The default customer type is automatically assigned each time you add a new
customer. The default customer type is defined with a system control.

To set the default customer type
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Customer tab.
3. Select Customer Default Type and press Enter. The Customer/Vendor Type List opens.

4. Select the type you want to use as the default, and clickOK.
5. Close the System Controls screen.



Customer Types

ASSIGN A CUSTOMER TYPE
When you create a customer record, the default customer type is automatically assigned to the new
customer. You can leave this setting alone or change it. You can also change the type assigned to
existing customers.

To assign a customer type
1. Add a customer or look up the customer whose type you want to change. For more information,

see Add a Cash Customer on page 66, Add an AR Customer on page 68, or Customer Searches
on page 93

2. When the Customer Maintenance screen opens, make sure theGeneral tab is selected.

3. Click Edit.

4. Click the Type field and press . Then select a type from the list that appears.

5. To save the change, clickOK.

UPDATE A CUSTOMER TYPE
If you need to update customer types, you can easily adjust the options for handling point of sale and
received on account activity. In TireMaster Plus and TireMaster Corporate, you can also choose to
post sales activity to different GL accounts.

To update a customer type
1. Select Customers > Types. The Customer/Vendor Type List opens.
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2. Select the type you want to updated and click Edit. The Customer/Vendor Type Edit screen opens.

3. Do the following as needed:

Change the GL accounts.

Select different options.

Change the department.

To update the GL accounts or department, click the field that needs to be changed. Then press and
make a selection from the list that appears.

4. To save your changes, clickOK.

DELETE A CUSTOMER TYPE
If a customer type is not assigned to any customers, it can be deleted.

To delete a customer type
1. Select Customers > Types. The Customer/Vendor Type List opens.
2. Select the type you want to remove and click Delete. A confirmation message appears.

3. Click Yes.

CUSTOMER TYPE EDIT SCREEN
The settings for customer types are defined on the Customer/Vendor Type Edit screen (Figure 5-5).
Vendor types are also set up and maintained with this screen. For more information, see Vendor Types
on page 194.



Customer Type Edit Screen

Figure 5-5: Customer Type Edit Screen

Item Description

Type Lets you define a number or letter for identifying the customer or vendor
type. (In add mode only.)

Note: Vendor types are used only in TireMaster Plus and TireMaster
Corporate.

AP or AR Defines whether the type is for accounts payable (vendors) or accounts
receivable (customers).

Note: Vendor types are used only in TireMaster Plus and TireMaster
Corporate.

Description Lets you enter a description for the type.

Accounts: Lists the major and minor general ledger accounts to post to for
transactions involving the type.

Note: In TireMaster, use the preset accounts listed in Add a
Customer Type on page 99.

AR Acct Lets you define the general ledger account for posting accounts
receivable amounts.

AP Acct Lets you define the general ledger account for posting accounts
payable amounts.

AR Dis Acct Lets you define the general ledger account for posting accounts
receivable discounts.
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Item Description

AP Dis Acct Lets you define the general ledger account for posting accounts
payable discounts.

Exp Acct Lets you define the general ledger account for posting any expenses.

Charge Not used.

Ship-To Not used.

Addons Defines whether add-on items are included on work orders and quotes
for customers assigned the type.

Vehicle Defines whether the vehicle list is displayed when starting work orders
for customers assigned the type.

Tax Select Defines whether users are prompted to choose a tax level when
starting work orders for customers assigned the type.

Wholesale Not used.

FET Exempt Defines whether customers assigned the type are exempt from paying
federal excise tax. When a customer type is FET exempt, TireMaster
automatically removes the federal excise tax from work orders for
customers assigned that type.

Direct Deposit Defines whether ROAs from customers assigned the type should be
processed as direct deposits. When this setting is enabled, the Direct
Deposit check box is automatically selected on the ROA completion
screen.

Price Levels for
National/GS

Defines whether price levels can be used for national account and
government support customers.

Department Lets you define the department (if any) for transactions involving the
type.

CUSTOMER COLOR CODES
You can use color codes to easily identify customers who meet certain characteristics, such as those
for whom you’ve written off bad debt. Color codes are displayed in customer records, on the Customer
List, on the OpenWork Order List, and on the Invoice Entry screen.

Note: TireMaster also includes the means to set up color codes that are automatically assigned to
customers who have past due account balances. For more information, see Credit Color
Codes on page 109.



Customer Color Codes

CREATE A COLOR CODE
Before you can assign color codes to customers, you need to create them. Customer color codes can
be created at the Corporate site only.

To create a color code
1. Select Setup > Customer Color Coding. The Customer Color Codes screen opens.

2. Click Add. The Add/Edit Color Codes screen opens.

3. Type a description for the color code.

4. Assign a color to the code.

a. Click Select. The Color screen opens

b. Select the color you want to use and clickOK.

Note: To ensure name text is clearly displayed on various customer screens, avoid dark
blues, dark greens, and dark purples for color codes. Black, however, can be used.
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c. To save the new color code, clickOK (again). The new color code is added to the list of color
codes.

5. Close the Customer Color Codes screen.

UPDATE A COLOR CODE
In some instances, you might want to change the description or color for an existing code.

In TireMaster Corporate, customer color codes can be updated at the Corporate site only.

To edit a color code
1. Select Setup > Customer Color Coding. The Customer Color Codes screen opens.

2. Select the code that you want to update, and click Edit. The Add/Edit Color Codes screen opens.

3. Type a new description if needed.

4. To change the color, click Select. Then choose a new color and clickOK.



Customer Color Codes

Note: To ensure name text is clearly displayed on various customer screens, avoid dark blues,
dark greens, and dark purples for color codes. Black, however, can be used.

5. ClickOK (again).

6. Close the Customer Color Codes screen.

DELETE A COLOR CODE
If you no longer use a color code, you can delete it.

In TireMaster Corporate, customer color codes can be deleted at the Corporate site only.

To delete a color code
1. Select Setup > Customer Color Coding.
2. Select the color you want to remove and click Delete. A confirmation message appears.

Note: If a color code has been assigned to customers, it will be removed from those customer
records when it is deleted.

3. Click Yes. The color code is deleted.

ASSIGN COLOR CODES TO CUSTOMERS
When you assign a color code to a customer, the customer’s name is highlighted with the assigned
color on the Customer Maintenance screen, the Customer List, the OpenWork Order List on page
462, and the Invoice Entry screen.

In TireMaster Corporate, customer color codes can be assigned to customers at the Cor-
porate site only.
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To assign a customer color code
1. Add a customer or look up the customer whose type you want to change. For more information,

see Add a Cash Customer on page 66, Add an AR Customer on page 68, or Customer Searches
on page 93.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected and click Color.
The Customer Color Codes screen opens.

3. Select the code you want to assign to the customer, and clickOK. The selected color is added to
the name field and is displayed in a swatch next to the Color button.

4. Close the Customer Maintenance screen.

REMOVE COLOR CODES FROM CUSTOMER RECORDS
If a color code should no longer be associated with a customer, remove the code from the customer’s
record.

In TireMaster Corporate, customer color codes can be removed at the Corporate site only.

To remove a customer color code
1. Look up customer whose color code you want to remove. For more information, see Customer

Searches on page 93.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected and click Color.
The Customer Color Codes screen opens.



Credit Color Codes

3. Click Cancel. A confirmation message appears.

4. Click Yes. The color is removed from the Name field and the swatch.
5. Close the Customer Maintenance screen.

CREDIT COLOR CODES
Credit color codes identify customers who have past due account balances. When credit color codes
are enabled, TireMaster assigns a user-defined color code to customer records during an automated
process that occurs overnight.

Credit colors are displayed on the Customer List, the Customer Maintenance screen, the OpenWork
Order List, and the Invoice Entry screen. The color that's displayed for a customer depends on whether
the account balance is 30, 60, or 90 days overdue. This functionality is available in TireMaster 9.4.0.

Note: TireMaster also includes the means to assign colors to customers for other reasons. (For
example, to draw attention to those who must pay with cash only and those from whom you’ve
written off bad debt.) For more information, see Customer Color Codes on page 104.

PREPARE TO USE CREDIT COLOR CODES
Before you can use credit color codes in TireMaster, you need to perform the following tasks.

DEFINE THE CREDIT COLORS
You need to choose which colors will be used to identify your customers with past due balances. The
setup screen for defining credit colors is part of the Customer Color Codes module.

Note: In TireMaster Corporate, credit colors are defined at the corporate site and then replicated to
the stores.
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To define credit colors
1. Select Setup > Customer Color Coding. The Customer Color Codes screen opens.

2. Click Credit. The Credit Color Codes screen opens.

3. For each number of days past due, click Select, and choose a color from the pallet.

Note: To ensure name text is clearly displayed on various customer screens, avoid dark blues,
dark greens, and dark purples for color codes. Black, however, can be used.

4. To save your credit colors, clickOK.

5. Close the Customer Color Codes screen.

ENABLE CREDIT COLOR CODES
When the credit color code functionality is enabled, TireMaster will run the automated process that
assigns credit colors to customers with 30, 60, or 90 day overdue balances. This functionality is
enabled by setting a system control.

Note: In TireMaster Corporate, this setting is a corporate control. Therefore, it will affect all sites.



External History Viewer

To enable credit color codes
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Customer tab.
3. Select Corporate Controls (TireMaster Corporate systems only).
4. Select Set Credit Color Code, and press Enter.
5. SelectOn, and clickOK.

APPLY CREDIT COLOR CODES
To ensure credit colors can be assigned to customers, leave your TireMaster server powered on
overnight. When TireMaster's automated processes run at 2:00 a.m., credit colors will be automatically
assigned to customer records that have become overdue. In instances when customers are already
assigned regular color codes, credit color codes will replace the regular colors.

Note: When a credit color code has been assigned, you can manually change it to a regular color
code. However, the credit color will be restored the next time the automated process runs.

CREDIT COLOR DURATION
The credit color assigned to a customer will remain until the customer catches up on payments. Once
you've applied the ROAs to eliminate the overdue balance, the credit color will be removed the next
time the 2:00 a.m. automated process runs. If you want the credit color to be removed immediately,
manually remove or change the color. For more information, see Remove Color Codes from Customer
Records on page 108 or Assign Color Codes to Customers on page 107.

Note: In TireMaster Corporate environments, the credit color code will continue to be assigned to the
customer until the ROA is applied at the corporate site.

EXTERNAL HISTORY VIEWER
With the External History Viewer, you can look up and print copies of invoices from sales that occurred
in TireMasterDOS or TireMaster Lite. You can access the viewer from a customer’s ledger history and
vehicle history.

Note: The External History Viewer displays invoices only if you’ve had ASA Client Services load
TireMaster DOS or TireMaster Lite data into your current TireMaster system.

VIEW DOS AND LITE CUSTOMER HISTORY
You can access the External History Viewer from the Ledger/History tab on the Customer
Maintenance screen. This function lets you view invoices for all sales to the selected customer that
occurred in TireMaster DOS or TireMaster Lite.

To view DOS and Lite customer history
1. Look up the customer whose history you want to view. For more information, see Customer

Searches on page 93.
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2. When the Customer Maintenance screen opens, click the Ledger/History tab.
3. Click Ext. Hist. The General External History Viewer opens.
4. Select an invoice in the top pane. TireMaster lists the items sold on that invoice in the bottom pane.

5. To print invoice history, do one of the following:

For a copy of the selected invoice only, click Print.
For a copy of all previous-system invoices, select the Print external history for this cus
check box, and click Print.

The Report Window opens.

6. Click Print and then close the Report Window.

VIEW DOS AND LITE VEHICLE HISTORY
You can use the External History Viewer to look up invoices associated with a particular vehicle. This
function lets you see which parts and services were sold for the selected vehicle in transactions
performed in TireMaster DOS or TireMaster Lite.

To view DOS and Lite vehicle history
1. Look up the customer whose vehicle history you want to view. For more information, see Customer

Searches on page 93.

2. When the Customer Maintenance screen opens, click the Vehicle tab.
3. Select the vehicle whose history you want to view and click History. The Vehicle History screen

opens.

4. Click Ext. Hist. The General External History Viewer screen opens.
5. Select an invoice in the top pane. TireMaster lists the items sold on that invoice in the bottom pane.

6. To print a list of all invoices associated with the selected vehicle, click Print. The Report Window
opens.

7. Click Print and then close the Report Window.



VEHICLES
TireMaster includes a variety of tools for managing your customers’ vehicles. Along with adding new
vehicles and updating existing vehicles, you can also retrieve vehicle service history. This chapter
includes the following sections:

Add a Customer’s Vehicle 114
Manage Existing Vehicles 115
Retrieve a Vehicle’s History 121
CARFAXApplications 122
Commercial Vehicles 125
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ADD A CUSTOMER’S VEHICLE
You can add a customer’s vehicle as a standalone task or at point of sale when starting a quote or a
work order.

To add a customer’s vehicle
1. Look up the customer or start a work order or a quote. For more information, see Customer

Searches on page 93, Create a Regular Work Order on page 442 or Basic Tire Quotes on page
503.

2. Do one of the following:

If the Customer Maintenance screen is open, click the Vehicle tab. Then click Add.
If the Vehicle List is open, click Add.

The Retail Vehicle screen opens.

3. Click Choose. The Standard Vehicle Selection screen opens.

Note: Depending on a system control setting, the year for the vehicle will be added as a two digit
(such as 16) or four digit (such as 2016) number. For more information, see Vehicle Year
Format on page 1201.

Tip: If you know the vehicle’s VIN or license plate number and state, you can skip this step. VIN
and plate numbers can be used to retrieve year, make, and model information from
CARFAX. For more information, see CARFAXApplications on page 122.

4. Select the vehicle’s year, make, model and option/engine. Then clickOK.



Manage Existing Vehicles

Note: If the vehicle isn’t on the list, click Cancel and type the vehicle information on the Retail
Vehicle screen.

5. Type the vehicle’s license number, VIN, and unit number (when applicable).

6. To save the new vehicle, clickOK.

MANAGE EXISTING VEHICLES
Occasionally, you might need to correct an error, such as a typo in the license plate number, or remove
a duplicate vehicle entry. If one customer sells a vehicle to another customer, you can also update
your records to reflect the change in ownership.
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UPDATE VEHICLE INFORMATION
If the information about a customer’s vehicle contains errors, you can correct the inaccuracies by
editing the customer’s record.

To update vehicle information
1. Do one of the following:

Look up the customer whose vehicle information you want to edit. When the Customer
Maintenance screen opens, click the Vehicle tab. For more information, see Customer
Searches on page 93.

Retrieve a customer's work order. Then click Vehicle on the Invoice Entry screen. For more
information, see Retrieve a Customer's Work Order on page 451.

2. Select the vehicle and click Edit. The Retail Vehicle screen opens.
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3. Do one of the following:

Type the needed changes.

Click Choose to select a different vehicle.
Type the VIN or license plate number and state, and click CARFAX Search (on TireMaster
systems integrated with CARFAX).

4. To save your changes, clickOK.

COMBINE A CUSTOMER’S VEHICLES
If the same vehicle is listed in a customer’s record two or more times, you can remove the entries by
combining the vehicles. When vehicles are combined, history from the deleted vehicle is added to the
history for the vehicle that you keep.

To combine vehicles
1. Look up the customer whose vehicles you want to combine. The Customer Maintenance screen

appears. For more information, see Customer Searches on page 93.

2. Click the Vehicle tab.

3. Select the vehicle you want to keep and click Combine. The Customer Vehicle Selection screen
opens.
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4. Select the vehicle that you want to remove from the customer’s record, and clickOK. A
confirmation message appears.

5. Click Yes. The extra vehicle is inactivated.

TRANSFERRING A VEHICLE TO ANOTHER CUSTOMER
In some cases, such as a vehicle sale, you might need to transfer a vehicle from one customer to
another.

To transfer a vehicle to another customer
1. Look up the customer who sold the vehicle. For more information, see Customer Searches on

page 93.

2. When the Customer Maintenance screen opens. click the Vehicle tab.
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3. Select the vehicle you need to transfer and click Transfer. TireMaster prompts you for the
customer's name.

4. Look up the name of the customer who purchased the vehicle. TireMaster prompts you to confirm
the transfer.

5. Click Yes. The vehicle is removed from the customer record for the seller and is added to the
customer record for the buyer.

DELETING VEHICLES
You can delete a vehicle from a customer’s record, regardless of whether any history is associated
with that vehicle. First, look up the customer whose vehicle you want to delete. Then click the Vehicle
tab on the Customer Maintenance screen, select the vehicle you want to remove, and click Delete.
Note: If a vehicle has history and you no longer want to display it on the Vehicle List, you can

inactivate it instead. For more information, see Make Vehicles Inactive on page 119.

MAKE VEHICLES INACTIVE
In some cases, you might need to remove a customer’s vehicle from the list of active vehicles but
maintain the vehicle’s history. On such occasions, you can inactivate a vehicle, which lets you save the
historical information while hiding the inactive vehicle on the Vehicle List.

119



120

User Guide

To inactivate a customer’s vehicle
1. Do one of the following:

Look up the customer whose vehicle you want to inactivate. Then click the Vehicle tab on the
Customer Maintenance screen. For more information, see Customer Searches on page 93.

At point of sale, click the Vehicle button on the Invoice Entry screen.

2. Select the vehicle you want to make inactive and click Edit. The Retail Vehicle history screen
appears.

3. Clear the Active check box.
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4. To save your changes, clickOK.
When you need to display the inactive vehicle on the Vehicle tab or the Vehicle List, clear the Active
Only check box.

RETRIEVE A VEHICLE’S HISTORY
You can view a vehicle’s service history at point of sale or by looking up the customer record for the
vehicle’s owner.

To retrieve a vehicle’s history
1. Do one of the following:

At point of sale, click the Vehicle button on the Invoice Entry screen.

Look up the customer record for the vehicle’s owner. When the Customer Maintenance screen
opens, click the Vehicle tab. For more information, see Customer Searches on page 93.

2. Select the vehicle whose history you want to view and click History. The Vehicle History screen
appears. It lists the parts and services that were previously sold for the vehicle, along with the
ending mileage at the time the items were sold.
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3. To print a duplicate invoice for a previous visit, select a line for that visit and click Reprint.

4. To close the Vehicle History screen, click Cancel.

CARFAXAPPLICATIONS
TireMaster is integrated with various CARFAX® Service Network applications. If you’re a CARFAX
subscriber, you can use TireMaster’s CARFAX Interface to easily retrieve a vehicle’s year, make, and
model information and its service history. The CARFAX Interface also gives you the ability to submit
repair information from your shop to CARFAX, along with the means to register customers for the
myCARFAX service reminder mobile app.

RETRIEVE VEHICLE INFORMATION WITH CARFAX
With TireMaster’s integration to the CARFAX®QuickVIN™ application, you can look up a vehicle’s
year, make, and model based on its VIN or license plate number. You can retrieve vehicle information
in this manner when adding new vehicles or updating existing vehicle records in TireMaster.
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To look up vehicle information
1. Begin the process of adding a new vehicle or updating an existing vehicle record. FFor more

information, see or .

2. On the Retail Vehicle screen, type one of the following:

The license plate number and state

The VIN

3. Click CARFAX Search. One of the following happens:
If you filled in the license plate number and state, the VIN, year, make, model, and submodel
information appears.

If you filled in the VIN, the year, make, model, and submodel information appears.

4. To save the vehicle information, clickOK.

SUBMIT SERVICE INFORMATION TO CARFAX
The CARFAX Interface is used to submit repair data to CARFAX. That data is used on reports for
consumers and the CARFAX Service History Check for service shop technicians. Vehicle data from
TireMaster is electronically submitted to CARFAX daily at 2:00 AM.

RETRIEVE CARFAX SERVICE HISTORY
With TireMaster’s integration to the CARFAX® Service History Check™, you can retrieve service and
repair history that CARFAX has collected for a customer’s vehicle. With this information, you can learn
about services performed on the vehicle at other shops that also submit repair data to CARFAX.

To look up a vehicle’s CARFAX history
1. Do one of the following:

Look up the customer whose CARFAX vehicle history you want to retrieve. When the
Customer Maintenance screen opens, click the Vehicle tab. For more information, see
Customer Searches on page 93.

Open the work order for the customer whose CARFAX vehicle history you want to retrieve.
Then click Vehicle on the Invoice Entry screen.

2. Select the vehicle.

3. Click CARFAX History. The service history opens in another screen.
4. For a hard copy of the CARFAX history, click Print.
5. When you’re done reviewing the CARFAX service history, close all of the open screens.

REGISTER CUSTOMERS FOR MYCARFAX
You can offer to register both new and existing customers for myCARFAX®. This tool is a mobile app
that helps you increase customer loyalty and return visits to your shop. Customers who sign up for
myCARFAX will receive service reminders and a list of shops they’ve previously visited, including
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yours. A perk of signing up customers for myCARFAX is that your store is listed as their favorite shop
on those service reminders. You must receive verbal authorization from customers to register them for
a myCARFAX account.

To register customers for myCARFAX
1. Add a new customer or look up an existing customer. For more information, see Add a Cash

Customer on page 66, Add an AR Customer on page 68, or Customer Searches on page 93.

2. On the Customer Maintenance screen, click the Vehicle tab.
3. Do one of the following:

For new vehicles, click Add and retrieve the vehicle information with CARFAX. For more
information, see and Retrieve Vehicle Information with CARFAX on page 122.

For existing vehicles, select the vehicle you want to register.

4. Click myCARFAX Customer Signup. The myCARFAX Signup screen opens.

5. Type the customer’s email address. If the customer’s contact information includes an email
address, it’s already entered for you.

6. To indicate that the customer has given you verbal authorization to sign up for myCARFAX, make
sure the check box is selected.

7. Click the myCARFAX Customer Signup icon. A field with a confirmation message appears.

8. Close the myCARFAX Signup screen. If you just added a vehicle, close the Retail Vehicle screen
too.

SET UP THE CARFAX INTERFACE
Before you can use the CARFAX Interface, you need to complete a variety of settings that will connect
your TireMaster system to CARFAX. If you plan to offer myCARFAX registration to customers, review
the end user license agreement for myCARFAX at https://service.carfax.com/csn/csnTerms.

To set up the CARFAX Interface
1. Select Interfaces > Interface Setups. The Interface Setup screen opens.
2. Click CARFAX Interface. The CARFAX Settings screen opens.

3. Enter the following information:

The address for the store web site in the URL field.
The name of the business contact for your store. By default, this field displays the name of the
store contact that was entered on the site setup screen. You can change the name, if needed.

The name of the technical contact for your store.

The email address to which correspondence from CARFAX should be sent.

4. Update the location name and contact information if needed.

5. Click Authorize.

https://service.carfax.com/csn/csnTerms
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Note: The information you entered can be authorized only once. If you need to change the
information, contact the CARFAX Service Network Support Team at 888-655-5362 and
select option2.

6. If you want to offer myCARFAX registration to customers, accept the myCARFAX end user license
agreement. Otherwise, skip this step.

a. ClickmyCARFAX Authorization. The myCARFAX Signup EULA screen opens.

Note: For the full end user license agreement, visit https://service.carfax.com/csn/csnTerms.

b. Click Accept.
c. Close the myCARFAX sign up screen.

7. ClickOK.
8. Close the Interface Setup screen.

COMMERCIAL VEHICLES
Commercial vehicles are those vehicles which are designed to perform a specific task. Examples of
commercial vehicles include buses, forklifts, and dump trucks.

While information about retail vehicles is listed by model, vehicle subclass, and engine size,
commercial vehicle information is based on function. Commercial vehicle settings include the
following:

Type: Identifies the kind of vehicle (cement mixer or a refrigerated van)
Application: Identifies how or where the vehicle is used (Light commercial, over the road, or
pick up and delivery)

Miles/Hours: Identifies the last recorded mileage or last recorded hours of use

ADD A COMMERCIAL VEHICLE
The manner in which commercial vehicles are added to a customer’s record is similar to that for adding
retail vehicles.

To add a commercial vehicle
1. Look up the customer start a work order or a quote. For more information, see Customer Searches

on page 93, Create a Regular Work Order on page 442, or Basic Tire Quotes on page 503.

2. Do one of the following:

If the Customer Maintenance screen is open, click the Vehicle tab. Then select Commercial.
If the Vehicle List is already open, select Commercial.
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3. Click Add. The Commercial Vehicle screen opens.

4. Type the vehicle’s information.

5. To save the new vehicle, clickOK.



TEXT AND EMAIL
With TireMaster‘s text and email applications, you can send messages and various documents to
customers and vendors. This chapter includes the following sections:

TMText 128
Prepare to Email Documents 148
Email Documents 151
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TMTEXT
With the TMText application, you can send text messages to customers and vendors. If you use
TireMaster‘s Scheduler, you can also use TMText to send appointment reminders to customers.

PREPARE TO USE TMTEXT
Before you can use TMText, you need to complete settings that make texting available at point of sale
and define whether to send automated appointment reminders to customers. You can also create
predefined messages (such as thank you notes and reminders) that can be reused.

DEFINE THE SOURCE NUMBER
With the source number for TMText, you define the phone number from which text messages are
sent. This setting allows you to display a ten digit phone number (such as 111-222-3333) on devices
receiving text messages instead of SMS (short message service) short codes (such as 111-00). To
define the source number, you must belong to a security group that’s assigned the Setup
permission.

To define the source number
1. Access the TireMaster - Texting screen.

a. If the OpenWork Order List isn’t already open, click Invoicing.
b. Click Text. The TireMaster - Texting screen opens.

2. Click Text Setup. The Text Message Setup screen opens.

3. Click Source Num.
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4. Type the ten digit phone number for sending text messages in the Source Number field, and
clickOK.

Note: To ensure text messages send, exclude hyphens from the entry for the source number.
(Example: 2085550000.)

5. Close the Text Message Setup screen.

Note: Since you’re already working in the texting screen, you can create predefined messages
(such as thank you notes, service reminders, and an appointment notification) now or
you can wait until later. For more information, see Add Predefined Messages on page
131.

ENABLE TEXTING FOR WORK ORDER STATUS CHANGES
You can send text messages to customers when there are status changes for their work orders (such
as when the status is changed from In Progress to Done). You can indicate whether texting is
available for each work order status. For more information, see Send Text Messages for Work Order
Status Changes on page 143.

To enable texting for work order status changes
1. Select Setup > WO Status. The Work Order Status Options screen opens.

2. Select a status for which you want to enable texting, and click Edit. The WO Status screen
opens.

3. Select the Send Text check box.
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4. To save your changes, clickOK.
5. Repeat steps 2 through 4 to enable texting for another status, or close the Work Order Status

Options screen.

ENABLE TEXTING FOR COMPLETED INVOICES
You have the option to send text messages to customers when you complete their sale invoices. By
setting a system control, you can define whether the texting screen opens as part of the invoice
completion process.

To enable text messaging for completed invoices
1. Select Setup > System Controls.

2. Click theOther tab.
3. Select Texting - Send Thank You Text at Completion and press Enter.

4. For the option to send text messages, select Yes and clickOK. Otherwise, select No and click
OK.

5. Close the System Controls screen.
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ENABLE AUTOMATED APPOINTMENT REMINDERS
When automated appointment reminders are enabled, TireMaster sends notifications to customers
every afternoon. Automated appointment reminders are enabled by setting a system control. For
more information, see Send Automated Appointment Reminders on page 146.

To enable automated appointment reminders
1. Select Setup > System Controls.

2. Click theOther tab.
3. Select Texting - Send Automated Appointment Reminders and press Enter.

4. Select Yes, and clickOK.
5. Close the System Controls screen.

PREDEFINED MESSAGES
Predefined messages simplify texting, because they require you to do little or no typing when sending
a text. Examples of predefined messages include thank you notes, oil change reminders, and the
appointment notification.

Note: You can have only one appointment notification, because that message type is sent via an
automated process.

To add and update predefined messages, you must belong to a security group that’s assigned the
Setup permission.

ADD PREDEFINED MESSAGES
You can set up predefined messages that can be used in various scenarios. Predefined messages
are classified as Text or Reminder. Text is for messages that are sent immediately, and Reminders is
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for messages that are sent on a specific date. You can set up a maximum of five reminder messages.

Note: In TireMaster Corporate, messages need to be set up at each site. Also, messages for one
site are not available at the other sites.

To add a predefined message
1. Access the TireMaster - Texting screen.

a. If the OpenWork Order List isn’t already open, click Invoicing.
b. Click Text. The TireMaster - Texting screen opens.

2. Click Text Setup. The Text Message Setup screen opens.

3. Click Add.

4. Type the name of the message. (If there is an existing name, type over it.)

5. Type the message in the Text Body field. To personalize the message, click the applicable
button under System Words to insert placeholders for name and vehicle information.
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Example: Hi [Name]. Your [VMake] [VModel] vehicle is ready to be picked up.

Note: Web site URLs can be used in the body of text messages. However, ASA recommends
that you avoid using quotation marks.

6. Define the message type.

For unscheduled text messages, selectMessages.

For scheduled text messages, select Reminder. Then type the number of days in which the
message will be sent.

Example: If you want to send oil change reminders to customers in three months, you’d
type 90 in the Days field.

For the appointment notification (you can have only one), selectMessage and the
Appointment check box. If you don’t use the Scheduler, disregard adding this type of text
message.

133



134

User Guide

7. Define which work order status change and invoice completion messages will be selected by
default.

Tip: If you have a predefined message that you always use or typically use when changing a
status or completing an invoice, defining the default messages for these scenarios will
help you save time, because you won’t have to select it from the message list at point of
sale.

For the message that should be selected by default when the status of a work order changes,
selectWO Option.

Note: You can have multiple predefined messages for work order status changes.
However, the settingWO Option can be assigned to only one predefined message.

For the message that should be selected by default when completing an invoice, select
Thank You (complete).

Note: You can have multiple predefined messages that can be sent when an invoice is
completed. However, the setting Thank You (complete) can be assigned to only
one predefined message.
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8. ClickOK. The name of the new message is added to the list on the left side of the screen.

9. Repeat steps 3 through 8 to create additional messages if needed. Otherwise, close the open
screens.

UPDATE PREDEFINED MESSAGES
Predefined messages are typically updated when you want to vary the text or correct mistakes.

To update predefined messages
1. Access the TireMaster - Texting screen.

a. If the OpenWork Order List isn’t already open, click Invoicing.
b. Click Text. The TireMaster - Texting screen opens.

2. Click Text Setup. The Text Message Setup screen opens.

3. Select the name of the message you want to update, and click Edit.
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4. Do the following as needed:

Change the name (by typing over the existing name).

Add, change, and delete body text and customer name and vehicle placeholders as needed.
To remove text and placeholders, select them and press Delete on the keyboard.
Change the number of days (for sending reminders).

If the message should be selected by default when the status of a work order changes, select
WO Option.
Note: You can have multiple predefined messages for work order status changes.

However, the settingWO Option can be assigned to only one predefined message.

If the message should be selected by default when completing an invoice, select Thank You
(complete).
Note: You can have multiple predefined messages that can be sent when an invoice is

completed. However, the setting Thank You (complete) can be assigned to only
one predefined message.

5. ClickOK.

6. Repeat steps 3 to 5 to update additional messages if needed. Otherwise, close the open screens.

MAKE PREDEFINED MESSAGES INACTIVE
If you no longer use a predefined message, you can make it inactive. When a message is inactive, it
is no longer listed on the screen for texting customers and vendors.
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To make a message inactive
1. Access the TireMaster - Texting screen.

a. If the OpenWork Order List isn’t already open, click Invoicing.
b. Click Text. The TireMaster - Texting screen opens.

2. Click Text Setup. The Text Message Setup screen opens.

3. Select the name of the message you want to make inactive, and click Edit.

4. Clear the Active check box.

5. ClickOK.
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6. To remove the inactive message from list on the Text Message Setup screen, select the Show
Active Only check box.

7. Close the Text Message Setup screen

MAKE PREDEFINED MESSAGES ACTIVE
You can resume using a predefined message by making it active once again.

To make a predefined message active

1. Access the TireMaster - Texting screen.

a. If the OpenWork Order List isn’t already open, click Invoicing.
b. Click Text. The TireMaster - Texting screen opens.

2. Click Text Setup. The Text Message Setup screen opens.

3. Clear the Show Active Only check box.



TMText

4. Select the name of the message you want to make active, and click Edit.

5. Select the Active check box.

6. ClickOK.

7. Close the open screens.

SEND TEXT MESSAGES
TireMaster’s texting functionality is available for individual customer and vendor records, at point of
sale, and in the Appointment Scheduler.
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TEXT CUSTOMERS
You can send text messages directly from a client’s customer record or the OpenWork Order List.

To send a text message to a customer
1. Do one of the following:

Look up the customer to whom you want to send a text message. When the Customer
Maintenance screen (General tab) opens, click Text.

If the OpenWork Order List isn’t already open, click Invoicing. Then select the customer’s
name and click Text.

The TireMaster - Texting screen opens.

2. Do one of the following if needed:

If you want to change the entry in the Number field, type the phone number you want to use
instead.

Note: Cell phone numbers that allow texting are automatically entered in the Number field.
If the customer has multiple cell phone numbers, the entry is the cell phone number
that’s closest to the top of the Contact List.

If the Number field is empty, type the customer’s cell phone number.
If you change your mind about sending a text, click Close and disregard the remaining steps.

3. Do the following as needed:

If you want to send a predefined message, make sure it’s selected.
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If you want to compose a message instead of using a predefined message, select the
Custom Message check box.
If you want to send one or more reminders, select each reminder you want to send.

Note: If the customer has multiple vehicles, make sure the correct vehicle is selected.

4. Select the time when the message(s) will be sent.

5. Click Send Text. If you selected the custommessage type, compose the message and clickOK.

6. Close the open screens.

TEXT VENDORS
When you need to text a vendor, you can send the message directly from that supplier’s vendor
record.

To send a text message to a vendor
1. Look up the vendor to whom you want to send a text.

2. On the Vendor Maintenance screen (General tab), click Text. The TireMaster - Texting screen
opens.
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3. Do one of the following if needed:

If you want to change the entry in the Number field, type the phone number you want to use
instead.

Note: Cell phone numbers that allow texting are automatically entered in the Number field.
If the vendor has multiple cell phone numbers, the entry is the cell phone number
that’s closest to the top of the Contact List.

If the Number field is empty, type the vendor’s cell phone number.
If you change your mind about sending a text, click Close and disregard the remaining steps.

4. Select the Custom Message check box.
Note: Predefined messages and reminders are available for vendors. However, for vendors,

you’ll typically send custommessages.

5. Select the time when the message(s) will be sent.

6. Click Send Text.
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7. Compose the message, and clickOK.

SEND TEXT MESSAGES FOR WORK ORDER STATUS CHANGES
If texting is enabled for a work order status, you can text customers when that status is selected at
point of sale. For example, if texting is enabled for the status Done, you can send a text message
when the status of a work order changes from In Progress to Done. In this scenario, you’d text
customers to let them know that their vehicles are ready for pickup.

To send text messages for work order status changes
1. If the work order isn’t already open, complete the following steps.

a. Click Invoicing.
b. Select the work order whose status you want to change and click Select. The Invoice Entry

screen opens.

2. Select a status on the lower-left corner of the screen. The TireMaster - Texting screen opens.

Note: If the TireMaster - Texting screen does not appear, texting is not enabled for the status
you selected.

3. Do one of the following if needed:

If you want to change the entry in the Number field, type the phone number you want to use
instead.

Note: Cell phone numbers that allow texting are automatically entered in the Number field.
If the customer has multiple cell phone numbers, the entry is the cell phone number
that’s closest to the top of the Contact List.

If the Number field is empty, type the customer’s cell phone number.
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If you change your mind about sending a text, click Close and disregard the remaining steps.
4. Do one of the following:

Make sure the predefined message that corresponds to the status change is selected. For
example, if you just changed the work order status to Done, make sure the vehicle-pickup
message is selected.

If you want to compose your own message instead, select the Custom Message check box.
Note: If the customer has multiple vehicles, make sure the correct vehicle is selected.

5. Define when to send the message.

6. Click Send Text. If you selected the custommessage type, compose the message and clickOK.

7. Close the open screens.

SEND TEXT MESSAGES FOR COMPLETED INVOICES
You have the option to send customers messages during the invoice completion process. When text
messaging is enabled for completed invoices and texting is enabled for a customer’s cell phone
number, you’ll be prompted to send a text message after entering the customer’s payment. You can
then send a thank you message, service reminder, or both.

To send text messages for completed invoices
1. Begin the invoice completion process as usual.

2. On the Invoice Completion screen, enter the payment information and clickOK. The TireMaster -
Texting screen opens.

Note: If the texting screen does not open although the customer has a cell phone number,
texting has not been enabled for the phone number. If you still want to send a text, click
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No when you’re prompted to complete the invoice and close the Invoice Completion
screen. Then click Contact, select the cell phone number, click Edit, make sure Send
Text is selected, and save your changes. You will then be able to send a text message
when you resume completing the invoice.

3. Do one of the following if needed:

If you want to change the entry in the Number field, type the phone number you want to use
instead.

Note: Cell phone numbers that allow texting are automatically entered in the Number field.
If the customer has multiple cell phone numbers, the entry is the cell phone number
that’s closest to the top of the Contact List.

If you change your mind about sending a text, click Close and disregard the remaining steps.
4. Do the following as needed:

If you want to send a predefined thank youmessage, make sure it’s selected.

If you want to compose a message instead of using a predefined message, select the
Custom Message check box.
If you want to send one or more reminders, select each reminder you want to send.

Note: If the customer has multiple vehicles, make sure the correct vehicle is selected.

5. Select the time when the message(s) will be sent.

6. Click Send Text. If you selected the custommessage type, compose the message and clickOK.

7. Complete and print the invoice as usual.
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SEND AUTOMATED APPOINTMENT REMINDERS
TireMaster can be set up to automatically send appointment reminders to customers at 4:05 p.m.
daily. Messages are sent one day before appointments are scheduled.

Example: Reminders for Wednesday appointments are sent on Tuesday afternoons.

Note: To ensure that reminders for Monday appointments are sent, the server needs to be running
on Sunday afternoon.

On the Appointment List, the entries in the Text column indicate the following:
Text messages are ready to be sent for appointments.

Text messages have been sent for appointments.

Texting for appointments has been turned off.

Note: To disable texting for an appointment select the Do not send Text check box on the
Appointment Maintenance screen when you’re scheduling the appointment.

Texting for appointments is not available. (The customer doesn’t have a cell phone.)

Before automated appointment reminders can be sent to customers, texting of this information needs
to be enabled. For more information, see Enable Automated Appointment Reminders on page 131.

TEXT MESSAGE STATUS
When TMText is installed, the OpenWork Order List has an additional column labeled Text. It displays
codes that identify the most recent type of activity that occurred in the texting history for customers who
have open work orders.

Note: If you cannot see the Text column, scroll to the far right of the Work Order List. If you want to
move the Text column, click the column heading and drag it to a different position. Then click
Save Layout.

The following status codes are used for text messages:

Sent indicates that a text message has been sent to the customer

Rcvd indicates that a reply has been received from the customer.

Read indicates that a reply from the customer has been read.

The text message status updates every two minutes. For more information, see Text Message History
on page 146.

Tip: To manually update the status, select Name and type all or part of a customer’s name in the
Find field. Then clear the entry in the Find field to display to the full list of open work orders.

TEXT MESSAGE HISTORY
Text message history is available on the Text Message Tracking screen.
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To view text message history

1. Open the TireMaster - Texting screen using one of the following methods:

Select the customer’s name on the OpenWork Order List, and click Text.
Look up the customer or vendor. When the Customer Maintenance or Vendor Maintenance
screen opens (General tab), click Text.
Change the status of a work order. The texting screen opens automatically when texting is
enabled for the status you just selected.

Begin the invoice completion process. The texting screen opens automatically when texting is
enabled for completed invoices and texting is allowed for the customer’s cell phone number.

2. Click History. The Text Message Tracking screen opens. A list of sent and received messages
appears on the left side of the screen.

Note: A new entry is created on the list each time a text message is sent from TireMaster.

3. To see threads for a message, select the message. The threads are displayed on the right side of
the screen.

4. Do the following as needed:

To list all text messages (instead of those for the selected customer), select the All Messages
check box.

For a hard copy of the messages listed, click Print Texts.
Note: When the messages for multiple customers and vendors are listed, they’re grouped by

recipient on the Text Log Report.

To indicate you’ve read a message, select it and clickMark Read. The status of the message
will change to Read on the OpenWork Order List.

147



148

User Guide

Note: Because the text message status updates every two minutes, you might not see the
status change right away.

5. Close the open screens.

PREPARE TO EMAIL DOCUMENTS
Before you can email documents from TireMaster, you need to do the following:

Connect TireMaster with your email provider, which includes defining the host and port for your
outgoing mail server and your account credentials.

Note: For this information, contact your internet service provider or the company that provides
your email service. For free email services, information about outgoing mail server settings
is available on the internet. However, your ability to email documents from TireMaster via a
free email service may be limited. Other factors, such as network configurations, firewalls,
and virus protection programs, can affect whether documents can be emailed from
TireMaster. If you use Gmail™, you might need to change your Google® account settings
to allow TireMaster to access your Gmail account.

Define the email address for each employee who will be emailing documents from TireMaster.

Create a predefined subject line and email address for the documents that you’ll send from
TireMaster.

Before you can send emails from TireMaster, you also need to include valid email addresses in the
customer and vendor records for your clients. For more information, see .

To set up email
1. Select Setup > Printers. The Printer Selection screen opens.

2. Click E-Mail Options.
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3. Click Add.

4. Define the outgoing server settings:

Type the address of the SMTPmail server in the Host field.
Type the port for the SMTPmail server.

If you’re using an email server that is not inside your domain, select the Secure Host check
box.

5. Enter the login information that you use to access your email account.

Type the user name for your email account.

Type the password that you use to log in to your email account.

Example: If your email account is roundystire@gmail.com, and the password to log in is
cooltires1, you would type roundystire@gmail.com in the User field and
cooltires1 in the Password field.

Note: The Statements check box visible in the image above is used in the configuration for
statement email. For more information, see Configure Statement Email on page 724.
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6. To save the outgoing server and email account settings, click Save/Add.
7. Add each employee who will be sending emails from TireMaster

a. Type the employee’s email address in the From E-Mail field.
b. Type the employee’s name in the From Name field.
c. To assign the email addresses to a specific user, click Employee and select a name from the

User List (optional).

Note: When an email address is assigned to a specific user, TireMaster will know which
account to send the message from when that employee is logged in to the program.

d. Click Save. The employee’s name and email address are added to the list on the left side of the
screen.

8. Define the subject line and body text for each of the documents emailed from TireMaster.

a. Click Verbiage. The Email Verbiage Setup screen appears.

b. Select a document name.

c. If you want to use a different subject line when the document is emailed, type your changes in
the Subject field.

d. If you want to modify the email body text that’s listed, type your changes in the Body field.
e. Click Save.
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f. To define the subject line and body text for additional documents, repeat steps 8b through 8e.

9. Close the open screens.

EMAIL DOCUMENTS
Various documents can be emailed to customers or vendors as soon as they’re created, or you can
retrieve duplicates to send. The ability to email a group of historical sale invoices is also available.
Work orders, invoices, quotes/estimates, ROAs, purchase orders, receiving documents, and vendor
invoice documents can be distributed by email. Documents that are emailed to customers are
converted into the portable document format (PDF).

Note: When you prepare customer account statements, you have the option to deliver them by
email. For more information, see Statements on page 714.

EMAIL DOCUMENTS UPON COMPLETION
A variety of documents can be sent to customers or vendors by email when you complete the related
transactions.

To email documents when transactions are completed
1. Begin to print the document as usual. This process varies, depending on the document. The report

screen opens.

Note: For work orders, invoices, deposits, and ROAs make sure the entry in the # Copies field
(upper-right corner) is set to 0.

2. Click E-mail. Depending on the document, the button is either along the top or the bottom of the
screen. The Select Email screen opens.
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Note: The E-Mail button is active only when an email address has been set up for the customer
or vendor to whom you want to send the document.

3. At the top of the screen, select the email address that the document will be sent from.

Note: If an email address is associated with the user who is logged into TireMaster, that email
address will be selected by default. This functionality is available in TireMaster 9.4.0.

4. Select one or more email addresses to send the document to. For multiple addresses, press Ctrl
while making your selections.

5. If you need to send the document to additional email addresses, type them at the bottom of the
screen, separating them with commas.

6. For documents that include the option to edit subject and body text, make changes as needed.
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Note: Subject and body text editing is available for work orders, invoices, deposits, and ROAs.

7. ClickOK, and wait until the system busy indicator disappears.

8. Print a hard copy of the document, if needed.

9. Close the report screen.

EMAIL MULTIPLE HISTORICAL INVOICES
When a customer needs copies of previously completed sale invoices, you can retrieve and send a
group of these documents from the customer’s subledger. Documents that can be emailed as a group
from a customer’s subledger include normal sale invoices (document type code is blank), national-
account invoices (document type code NA), and government-support invoices (document type code
GS).

Note: If a vendor record includes sale invoices, those documents can be emailed as a group as well.
In this scenario, you need to access the vendor’s AR subledger to retrieve and email the
documents.

To email multiple historical documents
1. Look up the customer. For more information, see Customer Searches on page 93.

2. On the Customer Maintenance screen, click the Ledger/History tab.

3. Select History (lower left of screen). TireMaster lists the customer or vendor’s historical
documents.

4. Click E-Mails. Various buttons on the screen become inactive.
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5. Press the Ctrl key and select each invoice you want to include in the email.

6. Click E-Mails again. The Select E-Mail screen appears.
7. At the top of the screen, select the email address that the documents will be sent from.

Note: If an email address is associated with the user who is logged into TireMaster, that email
address will be selected by default. This functionality is available in TireMaster 9.4.0.

8. Select one or more email addresses to send the documents to. For multiple addresses, press Ctrl
while making your selections.

9. If you need to send the documents to additional email addresses, type them at the bottom of the
screen, separating them with commas.

10. Update the subject and body text as needed.
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11. ClickOK, and wait until the system busy indicator disappears.

12. Close the open screens.

GENERATE A LIST OF SENT EMAILS
The sent box for your email account doesn’t include entries for invoices emailed from TireMaster.
Therefore, you need to generate a report to verify which customers and vendors received emailed
documents. For more information, see Sent Email/Text List on page 1093.
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CONTACT INFORMATION
In TireMaster, you can assign multiple phone numbers and email addresses to customer and vendor
records and classify contact information with a setting called contact types. This chapter includes the
following sections:

Contact Types 158
Phone Numbers and Email Addresses 161
Organize Contact Information 169
Primary Contact Method 172
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CONTACT TYPES
Phone numbers and email addresses are classified with settings called contact types. In other words,
a contact type is a means of describing a contact method. Examples of contact types include cell
phone and email. Contact types are used for both customers and vendors.

ADD CONTACT TYPES
TireMaster includes five default contact types: business phone, cell phone, email, fax number, and
home phone. You can use these contact types as is, modify them, or remove them. If you need contact
types that aren’t available, you can add your own.

Note: When you set up contact types, you can define whether they’re shown in the same spot on the
maintenance screens for all customers and vendors, or you can vary the order in which they’re
displayed for individual customers and vendors. For more information, see Organize Contact
Information on page 169.

To add a contact type
1. Select Customers > Contact Types. The Contact Type screen opens.

Note: Although the setup screens for contact types are accessed from the Customersmenu,
contact types are used for both customers and vendors.

2. Click Add. The Add/Edit Contact Type screen opens.

3. For a new contact type, enter a name. For an existing type, change the name if needed.

4. To define the type of contact method you’re adding, select Fax, E-mail, Cell, or Phone (for land
lines).

5. Define the position in which the contact type is shown on the Customer Maintenance screen.

To list contact types in the same order for all customers, type the position 1, 2, 3, 4, or 5 in the
Cust Order field. For more information, see Organize Contact Information Globally on page
169.

To vary the order of contact types from customer to customer, type 0 in the Cust Order field.
For more information, see Organize an Individual’s Contact Information on page 170.
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6. Define the position in which the contact type is shown on the Vendor Maintenance Screen on page
186.

To list contact types in the same order for all vendors, type the position 1, 2, 3, 4, or 5 in the
Vend Order field. For more information, see Organize Contact Information Globally on page
169.

Note: If you have more than five contact types, leave the rest set to 0.

To vary the order of contact types from vendor to vendor, type 0 in the Cust Order field. For
more information, see Organize an Individual’s Contact Information on page 170.

7. To save the new contact type, clickOK.

8. Close the Contact Type screen.

MANAGE EXISTING CONTACT TYPES
You can manage existing contact types by updating them and removing those that are no longer
needed.

UPDATE A CONTACT TYPE
TireMaster includes five default contact types: business phone, cell phone, email, fax number, and
home phone. You can use these contact types as is, modify them, or remove them. If you need
contact types that aren’t available, you can add your own.

Note: When you set up contact types, you can define whether they’re shown in the same spot on
the maintenance screens for all customers and vendors, or you can vary the order in which
they’re displayed for individual customers and vendors. For more information, see Organize
Contact Information on page 169.

To update a contact type
1. Select Customers > Contact Types. The Contact Type screen opens.

Note: Although the setup screens for contact types are accessed from the Customersmenu,
contact types are used for both customers and vendors.
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2. Select the contact type you want to update and click Edit. The Add/Edit Contact Type screen
opens.

3. Do the following as needed:

Change the name of the contact type.

Select a different contact method type.

4. Change the position in which the contact type is shown on the Customer Maintenance screen if
needed.

To list contact types in the same order for all customers, type the position 1, 2, 3, 4, or 5 in
the Cust Order field. For more information, see Organize Contact Information Globally on
page 169.

To vary the order of contact types from customer to customer, type 0 in the Cust Order field.
For more information, see Organize an Individual’s Contact Information on page 170.

5. Change the position in which the contact type is shown on the Vendor Maintenance screen if
needed.

To list contact types in the same order for all vendors, type the position 1, 2, 3, 4, or 5 in the
Vend Order field. For more information, see Organize Contact Information Globally on page
169.

Note: If you have more than five contact types, leave the rest set to 0.

To vary the order of contact types from vendor to vendor, type 0 in the Cust Order field. For
more information, see Organize an Individual’s Contact Information on page 170.

6. To save your changes, clickOK.

7. Close the Contact Type screen.

DELETE A CONTACT TYPE
If there is a contact type you don’t use, you can remove it from TireMaster.
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Note: Removing a contact type makes it unavailable for both customers and vendors.

To remove a contact type
1. Select Customers > Contact Types. The Contact Type screen opens.

Note: Although the screens for working with contact types are accessed from the Customers
menu, contact types are used for both customers and vendors.

2. Select the type you no longer want to use and click Remove. A confirmation message appears.

3. Click Yes.
4. Close the Contact Type screen.

PHONE NUMBERS AND EMAIL ADDRESSES
Phone numbers and email addresses can be classified by assigning contact types.

ADD PHONE NUMBERS AND EMAIL ADDRESSES
You can add multiple phone numbers and email addresses to customer and vendor records.

Note: When you add a phone number or email address, you can associate a name with it. For
example, the customer record for Rex and Mary Jones could have one phone number
associated with the name Rex and another associated with the name Mary. In this scenario,
you could also include phone numbers for the couple’s teenage children. At point of sale, both
the phone number (or email address) and the associated name are displayed on the Invoice
Entry screen.

To add phone numbers and email addresses
1. If you haven’t already done so, add a new customer or vendor or look up an existing customer or

vendor. For more information, see Add a Cash Customer on page 66, Add an AR Customer on
page 68, Customer Searches on page 93, Add a Vendor on page 176, or Vendor Searches on
page 193.

2. To add up to five contact methods, complete the following steps. If you want to enable texting for
cell phone numbers, add those phone numbers using the method described in step 3.

a. If the phone number and email fields are not active, click Edit Contact on the Customer
Maintenance screen or click Edit on the Vendor Maintenance screen.

b. If you need to change the contact type, select it from the drop-down.
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Note: If your TireMaster system is set up to display contact information in the same order for
all customers and vendors, the phone numbers and email addresses will be arranged
in that order once you clickOK, regardless of how you enter them here. For more
information, see Organize Contact Information on page 169.

Tip: If the drop-down doesn’t include the contact type you want to assign, you can add your
own. For more information, see Add Contact Types on page 158

c. Type the phone number or email address.

Note: When you initially add contact information, the phone number or email address at the
top of the list is designated as the primary contact method, and the second one is
designated as the alternate contact method. For customers, the primary contact
method is assigned to work orders by default. If you want to use a different phone
number or email address as the primary contact method, you can change it. For more
information, see Update the Primary Contact Method on page 172.

Tip: Hyphens are automatically inserted in phone numbers. If a phone number includes an
extension, type it as well. For example, 208-333-6000 ext. 102.

d. Type a description or the name of the person or business to whom the phone number or email
address belongs.
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3. For each additional phone number and email address you need, complete the following steps.

a. Click Phone & E-mail. The Contact List appears.

b. Click Add. The Add/Edit Phone Number screen appears.

c. Do the following as needed:

Select a different method of defining the contact type from the drop-down.

Type the phone number or email address in the Number/E-Mail field.
Type a description or the name of the person or business to whom the phone number or
email address belongs.

For cell phone numbers that are allowed to receive text messages, select the Send Text
check box. This check box is available only when a contact type for cell phones is selected.
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Note: If you’re using the Text to Pay application with TireMaster, selecting Send Text
allows you to indicate that the customer has given you verbal authorization to send
him/her text messages.

For the email address you want to set as the customer’s default, select the Default E-mail
check box. This check box is available only when a contact type for emails is selected.

Note: If you use third party marketing applications, the default email address is the one to
which promotional messages for customers will be sent.

d. To save the new number or email address, clickOK.

e. Change the position for the phone number or email address if needed. To change the position,
select the number or email address and clickMove Up orMove Down as needed.

4. Make any other needed changes to the customer or vendor record. Otherwise, close the Customer
Maintenance or Vendor Maintenance screen.

MANAGE EXISTING CONTACT INFORMATION
When the contact information for customers or vendors changes or is no longer relevant, you can
ensure that those details are up-to-date in TireMaster.

UPDATE PHONE NUMBERS AND EMAIL ADDRESSES
When a customer’s or vendor’s phone number or email address changes, you can update the
contact information in TireMaster.



Phone Numbers and Email Addresses

Note: Depending on how your customer types are set up, contact information is ordered the same
for all customers and vendors or its organized on an individual basis. For more information,
see Organize Contact Information on page 169.

Updating a phone number or email address
1. If you haven’t already done so, look up the customer or vendor whose phone number needs to be

updated. For more information, see Customer Searches on page 93 or Vendor Searches on
page 193.

2. To update a phone number or email address on theGeneral tab, complete following steps. If you
need to move the contact to a different position on the Contact List or work with its text or default
email settings, use the update method described in step 3.

a. For customers, click Edit Contact. For vendors, click Edit instead.
Note: Depending on your security settings, you can also click the Edit button on the

Customer Maintenance screen.

b. If you don’t see the number or email you want to update, click to move down the list. This
functionality is available in TireMaster 9.4.0.

c. Do the following as needed.

Select a different contact type from the drop-down.

Note: If your TireMaster system is set up to display contact information in the same
order for all customers and vendors, the phone numbers and email addresses
will be arranged in that order once you clickOK, regardless of how you enter
them here. For more information, see Organize Contact Information on page
169.

Type a different phone number or email address.
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Note: If you’re updating a customer email address that’s used to deliver statements,
TireMaster will prompt you to also update the email address in customer’s
statement settings when you save your changes. This functionality is available in
TireMaster 9.4.0.

Type a different name or description for the phone number or email address.

3. To update a phone number or email address from the Contact List, complete the following steps.
Use this method if you need to reposition the contact on the Contact List, enable texting, or
update the default email setting.

a. Click Phone & E-mail. The Contact List opens.
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b. If you need to move a phone number or email address, select it and clickMove Up orMove
Down.

c. If you need to change the type, texting, or email settings for a phone number or email
address, select it and click Edit. The Add/Edit Phone Number screen opens.
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d. Do the following as needed:

For a different contact type, select it from the drop-down

For a different number, email address, or name, type your changes.

To enable or disable texting for cell phone numbers, select or clear the Send Text check
box. This check box is available only when the cell phone contact type is selected.

To change the default status for an email address, select or clear the Default E-Mail
address. This check box is available only when the email contact type is selected.

e. ClickOK to save your changes.

4. Close the Contact List.

DELETE PHONE NUMBERS AND EMAIL ADDRESSES
When a customer or vendor no longer uses a phone number or an email address, you can delete it.

To delete a phone number or email address
1. If you haven’t already done so, look up the customer or vendor whose phone number or email

address needs to be deleted. For more information, see Customer Searches on page 93 or
Vendor Searches on page 193.

2. On the Customer Maintenance or Vendor Maintenance screen, make sure theGeneral tab is
selected. Then click Phone & E-mail. The Contact List opens.

3. Select the phone number or email address you need to remove and click Delete. A confirmation
message appears.
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4. Click Yes. The phone number or email address is removed from the list.

5. If the deleted phone number or email address was the main or secondary contact method, define
a new primary or alternate contact number. For more information, see Organize Contact
Information on page 169.

6. Close the Contact List.

ORGANIZE CONTACT INFORMATION
Contact information can be organized on the Customer Maintenance and Vendor Maintenance
screens in one of the following ways:

The order can differ for each customer and vendor. For example, for some vendors you might
list the business number first and for others the cell phone would be first.

A global order for displaying phone numbers and email addresses can be used for all
customers, and another global order can be used for all vendors. For example, for customers,
you could always list the cell phone first, followed by home phone, email address, business
phone, and fax number.

Note: When global ordering is used, each contact type is displayed on the Customer
Maintenance or Vendor Maintenance screen once. For example, if two or more cell phone
numbers are associated with a single customer record (such as one for a married couple
who has teenage children) one of the cell numbers is on the Customer Maintenance
screen and the rest are on the customer’s Contact List.

The way in which you define the order depends on which method you use:

To use the same order for everyone, define a position (1 through 5) in the settings for up to five
contact types. For instructions, see Organize Contact Information Globally on page 169.

To set the order on an individual basis, make sure the position is 0 for all contact types. Then
arrange the contact information on the customer’s or vendor’s Contact List. For instructions, see
Organize an Individual’s Contact Information on page 170.

ORGANIZE CONTACT INFORMATION GLOBALLY
With global ordering, contact information for all of your customers is listed in the same order on the
Customer Maintenance screen and contact information for all of your vendors is listed in the same
order on the Vendor Maintenance screen. Global ordering is defined in the settings for contact types.
Therefore, when the customer order or vendor order for a type is assigned to position 1, 2, 3, 4, or 5,
it’s put in the corresponding spot on the applicable maintenance screen. If a contact type is not
assigned a position, it’s set to 0 and is displayed on the maintenance screens wherever a spot is
available.

Note: When the position is set to 0 for all contact types, the order of phone numbers and email
addresses can differ for each customer or vendor. For more information, see Organize an
Individual’s Contact Information on page 170.
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To globally organize contact information
1. Select Customers > Contact Types. The Contact Type screen appears.

2. For each contact type, do the following:

a. Select the type and click Edit. The Add/Edit Contact Type screen appears.

b. For customers, type the number that corresponds with the position you want to assign in the
Cust Order field. For example, type 1 to list the contact type first on the Customer
Maintenance screen.

c. For vendors, type the number that corresponds with the position you want to assign in the
Vend Order field. The position can be the same as the one used for customers or it can be
different.

d. ClickOK.

3. When you’re done assigning positions, close the open screens.

ORGANIZE AN INDIVIDUAL’S CONTACT INFORMATION
Contact information can be organized on a customer-by-customer or vendor-by-vendor basis, instead
of using the same order for everyone. With this method, you define how phone numbers and email
addresses for individual customers or vendors are ordered on the maintenance screens by changing
their placement on the Contact List. Therefore, if you move up a phone number down on a customer’s
Contact List, it also moves to the corresponding spot on the customer’s maintenance screen.

When you organize phone numbers and email addresses on an individual basis, the following occurs:

The contact method designated as primary moves to the top of the list. For customers, the
primary contact method is used by default on work orders.
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The alternate contact method is shown beneath the primary contact method. Therefore, it’s the
second phone number or email address listed.

The remaining numbers and email addresses, if any, are below the primary and alternate
contact information.

When customers and vendors have more than five phone numbers and email addresses, the
additional contact information is available only on the Contact List.

To organize contact information differently for each customer and vendor, the position needs to be set
to 0 in the settings for all contact types. To verify that the position is 0 for all contact types go to
Customers > Contact Types and review the entries in the Position column.

To organize an individual’s contact information
1. Look up the customer or vendor whose contact information you want to organize. For more

information, see Customer Searches on page 93 or Vendor Searches on page 193.

2. On the Customer Maintenance or Vendor Maintenance screen, make sure theGeneral tab is
selected. Then click Phone & E-Mail. The Contact List opens.

3. Define the primary contact method. If you don’t need to change the primary contact method,
disregard this step.

a. Select the row for the phone number or email address you want to designate as the primary
contact method.

b. ClickMove Up repeatedly, until the phone number or email address is at the top of the list and
the word Primary is shown next to it.

4. Define the alternate contact method. If you don’t need to change the alternate contact method,
disregard this step.
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a. Select the row for the phone number or email address you want to designate as the alternate
contact method.

b. ClickMove Up repeatedly, until the phone number or email address is on the second row of
the list and the word Alternate is shown next to it.

5. Define the position for the customer’s remaining phone numbers and email addresses.

a. Select the row for the contact method you want to move.

b. ClickMove Up orMove Down repeatedly, until the phone number or email address is where
you need it to be.

6. Close the Contact List.

PRIMARY CONTACT METHOD
When you initially add contact information, the phone number or email address at the top of the list is
designated as the primary contact method, and the second one is designated as the alternate contact
method. For customers, the primary contact method is assigned to work orders by default. If you want
to use a different phone number or email address as the primary contact method, you can change it.

UPDATE THE PRIMARY CONTACT METHOD
If contact information is ordered in the same manner for all customers and vendors, you don’t have to
use the phone number or email address in the first position (on the maintenance screens) as the
primary contact method. In this scenario, you can choose the primary contact method from the Contact
List.

Note: For customers, the primary contact method is assigned to work orders by default.
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To update the primary contact method
1. Search for the customer or vendor to whom you want to assign a primary contact method. For

more information, see Customer Searches on page 93 or Vendor Searches on page 193.

2. On the Customer Maintenance or Vendor Maintenance screen, click Phone & E-Mail. The
Contact List appears.

3. Select the phone number or email address that you want to use as the primary contact method,
and repeatedly clickMove Up until it is at the top of the list.

4. If you also need to update the alternate contact method, select the phone number or email address
you want to use and repeatedly clickMove Up orMove Down until it is second on the list.
Otherwise, disregard this step.

5. Close the open screens.
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VENDORS
TireMaster’s vendor management tools help to you track purchases from your suppliers, and you can
track the balances you carry with your vendors. This chapter includes the following sections:

Add and Manage Vendors 176
Vendor Maintenance Screen 186
Vendor Searches 193
Vendor Types 194
Vendor Payment Terms 197
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ADD AND MANAGE VENDORS
With vendor records, you can track the purchases of tires and service parts from your suppliers.

ADD A VENDOR
Before you can order items from a vendor, a vendor record must exist in TireMaster

Note: Users can add and update vendor records at both the corporate site and the stores.

To add a vendor
1. Select Vendors > Maintenance. TireMaster prompts you for the vendor's name.

2. Click Cancel to close the Name Lookup/Entry screen.

3. When the Vendor Maintenance screen opens, click Add. TireMaster prompts you for the vendor’s
name.

4. Type the vendor’s name and clickOK. The new vendor record is created.
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5. Enter the vendor’s contact information.

a. Type the vendor’s street or mailing address.

b. Type the vendor’s zip code. If the zip code has already been used in TireMaster, the Zip Codes
screen appears.

c. ClickOK. The city and state are added to the vendor’s contact information.
d. Add the phone numbers that you want to have on record for the vendor. For more information,

see Add Phone Numbers and Email Addresses on page 161.

6. If you need to assign a different type to the vendor, click the Acct Type field, press , and select a
type from the list. Otherwise, leave the vendor type set to V.

7. If the vendor has given you a credit limit, type it in the Credit Limit field.
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8. To assign a default expense account to the vendor, click the Exp Acct field. Then press and
select an account from the list that appears.

Note: This setting is used to automatically add offsetting journal entry lines for the selected
account to vendor charges created for this vendor.

9. Enter the vendor’s tax reporting information if needed.

a. Type the vendor’s Tax Identification number or Social Security number in the TIN# field. The
1099 Vendor andW-9 on file check boxes become active.

b. If you need to complete a 1099-Misc form for the vendor, select the 1099 Vendor check box.
c. If you have IRS formW-9 in your possession for the vendor, select theW-9 on file check box.

10. Type the account number the vendor has assigned to you in the Account# field if needed.
11. Add the name of the vendor’s bank, the bank’s routing number, and the account number if needed.
12. If you have any notes about the vendor that you want to save, type them in the Notes field.

13. To save the new vendor’s record, clickOK.

MANAGE EXISTING VENDOR INFORMATION
Occasionally, you might need to make changes to vendor records because their account information
has changed or you're no longer business partners.

UPDATE A VENDOR RECORD
You can change details for a vendor record, such as the address or a phone number.



Add and Manage Vendors

Note: If you need to update the information for several vendors, you can use list editing for
customers and vendors. For more information, see Update Multiple Customer Records on
page 72.

To change a vendor record
1. Search for the vendor whose information you want to update. For more information, see Vendor

Searches on page 193.

2. When the Vendor Maintenance screen opens, make sure theGeneral tab is selected. Then click
Edit.

3. Make the needed changes. For information about settings on this screen, see Vendor
Maintenance Screen on page 186.

4. To save your changes, clickOK.

UPDATE MULTIPLE VENDOR RECORDS
When you need to update settings for more than one vendor, you can update the information for a
range of vendor records.

Note: Vendor information can be updated at either the corporate site or the stores.

To update multiple vendor records
1. Select Vendors > List Editing. The Vendor Range screen opens.

2. To search for a range of records to edit, use one or more of the following:

Staring and ending name

Area code (starting and ending), city, state, or zip code

Blank zip codes
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Site (for the corporate site of TireMaster Corporate systems only)

Account type

Active, inactive, or both

Tip: To return to the screen’s original settings, click Reset.

3. ClickOK. The Vendor List Editing screen opens.

Note: For a hard copy of the information listed on the screen, click Print to generate the List
Editing Report.

4. Select a column and update the records as needed. You can type your changes or make a
selection from a list. To select a setting from a list, click or press .

Tip: You can rearrange the columns on this screen. For more information, see Rearrange
Table Columns on page 10.

5. When you’re finished updating the records, click Close.
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COMBINE VENDOR RECORDS
In the event of business mergers or if duplicates exist, you can combine two or more vendor records.
When you combine vendors, TireMaster makes one or more vendor records inactive and adds that
information to an existing vendor record which is maintained. This functionality is available in
TireMaster 9.4.0 and newer.

Note: If the vendor you want to combine with another vendor has no history, such as purchases
and vendor charges, make it inactive instead of combining it.

Note: If you want to combine one or more customer records, see Combine Customers on page 75.

To combine vendors
1. Search for and select the vendor whose record you want to keep. This vendor will be referred to

as themaster vendor. For more information, see Vendor Searches on page 193.

2. On the Vendor Maintenance screen, make sure theGeneral tab is selected and click
Un/Combine. The Combine/Uncombine screen opens.
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3. Click Select Vendors. TireMaster prompts you for a name.

4. Type all or part of the name of the vendor whose record you want to combine with the master
vendor you selected in step 1 and clickOK. The Vendor List opens.
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5. Select the vendor’s name, and clickOK. The selected vendor is added to the list on the
Combine/Uncombine screen.

6. To combine additional vendors with the master vendor, repeat steps 3 through 5 as often as
needed.

7. Click Combine and Inactivate These.

A message similar to the following appears:

“You are about to remove/combine these vendors with the Master Vendor AMIDON TIRE SUPPLY
(109664-1). Continue?”
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8. Click Yes. TireMaster inactivates the selected vendor or vendors and adds that vendor
information to the record you selected in step 1. A note is also added to newly inactive vendor
records, providing a paper trail for research purposes.

9. Close the open screens.

10. Update the vendor record that you kept as needed.

UNCOMBINE VENDORS
If vendor records are combined in error or you need to separate vendor records for another reason,
you can uncombine them from the master vendor.

To uncombine vendors
1. Search for the vendor you want to remove from the master vendor record, making sure to clear

the Active Only check box on the name lookup screen. For more information, see Vendor
Searches on page 193.

2. On the Vendor Maintenance screen, make sure theGeneral tab is selected and click
Un/Combine. The Combine/Uncombine screen opens.

3. Click Uncombine Master Vendor. A confirmation message appears.
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Note: A vendor record can be separated (uncombined) from the master vendor only if it has
history, such as purchases and vendor charges. If the Uncombine Master Vendor
button is disabled, it's because the vendor you are trying to uncombine has no history.

4. ClickOK.
5. Close the Combine/Uncombine screen. A note is also added to newly uncombined vendor

record, providing a paper trail for research purposes.

6. ClickOK to save your changes.
7. Close the Vendor Maintenance screen.

MAKE A VENDOR RECORD INACTIVE
If you have vendors with whom you no longer do business, you can remove them from the list of
active vendors. Doing so makes your vendor list easier to manage and use.

To make a vendor record inactive
1. Search for the vendor you want to make inactive. For more information, see Vendor Searches on

page 193.

2. When the Vendor Maintenance screen opens, make sure theGeneral tab is selected. Then click
Edit.

3. Clear the Active check box.
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4. To save your changes, clickOK.

DELETE A VENDOR RECORD
If you've never used a vendor record for purchasing products, you can delete it.

Note: Vendor records only be deleted at the corporate site.

To delete a vendor
1. Search for the vendor whose record you want to delete. For more information, see Vendor

Searches on page 193.

2. When the Vendor Maintenance screen opens, make sure theGeneral tab is selected and click
Delete. A confirmation messages appears.

3. Click Yes. The vendor is removed from the database.

VENDOR MAINTENANCE SCREEN
The Vendor Maintenance screen is used for adding vendors and storing vendor account information.

VENDOR GENERAL TAB
TheGeneral tab (Figure 9-1) contains basic information about the selected vendor. This is where you
can add, edit, and delete vendor records, and access the selected vendor's payment terms.
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Figure 9-1: Vendor Maintenance Screen General Tab

Item Description

Prev Lets you move to the record for the previous vendor on the Vendor List.

Note: This button is available for theGeneral tab only. The shortcut
key for this button is PageUp.

Next Lets you move to the record for the next vendor on the Vendor List.

Note: This button is available for theGeneral tab only. The shortcut
key for this button is PageDown.

Name Displays the vendor’s name.

Address Displays the vendor’s street address or P.O. box (if the vendor only has
a P.O. box number).

Address2 Displays the vendor’s P.O. box number.

City Displays the vendor’s city.
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Item Description

State Displays the vendor’s state.

Zip Displays the vendor’s zip code.

(blank) Displays the system-assigned vendor number. The prefix identifies the
site where the vendor was added.

Primary Phone Displays the vendor’s preferred phone number.

Alternate Phone Displays an alternate number for contacting the vendor.

Phone Numbers Lets you enter one or more phone numbers for the vendor. For more
information, see .

Contact Type
Fields

Does the following:

Identifies the contact method assigned to the selected vendor’s
phone numbers, email addresses, or both.

Lets you define the contact method for phone numbers, email
addresses, or both (in add and edit modes).

Number/E-Mail
Fields

Does the following:

Identifies the phone numbers, email addresses, or both
assigned to vendors.

Lets you define the phone numbers, email addresses, or both
assigned to vendors (in add and edit mode).

Name Fields Does the following:

Identifies the person to whom an email address or phone
number is assigned. This entry can also be a description, such
asMain Phone.

Lets you define the name or description that you want to assign
to phone numbers, email addresses, or both (in add and edit
mode).

Lets you move to the previous contact. Available in TireMaster 9.4.0
and newer.

Let’s you move to the next contact. Available in TireMaster 9.4.0 and
newer.

Phone & E-Mail Lets you access the vendor’s contact list, which includes both phone
numbers and email addresses.
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Item Description

Text Lets you access the screen for sending text messages to the vendor.

Acct Type Lets you specify the vendor type for the vendor.

MFG Code Not used.

AP/AR Defines whether this is an AP (vendor) or AR (customer) account.

Credit Limit Lets you enter the maximum amount you can charge from the vendor.

Note: This value is only a visual reminder for you. It does not affect
the amounts you charge to a vendor.

Exp Acct Lets you assign a default expense account to the vendor. This expense
account is automatically entered as the offset account when creating
vendor charges for the vendor.

Note: If you need to remove this setting, click the Exp Acct field and
press . When the Chart of Accounts appears, click Cancel.
Then, click Yes to verify that you want to remove the account
from the vendor’s record.

1099 Vendor Lets you indicate whether the vendor is a 1099 vendor.

W-9 On File Lets you indicate whether you have IRS formW-9 on file for the vendor.

TIN# Lets you define a vendor’s tax identification number. For individuals,
you can enter a social security number instead.

Account # Lets you record the account number a vendor has assigned to you.
When you pay the vendor with checks, this number prints on the check
stubs.

Bank Name Lets you record the name of the vendor’s bank.

Routing # Lets you record the routing number for the vendor’s bank.

Bank Acct # Lets you record the account number for the vendor’s bank.

Notes Lets you include additional information about the vendor account.

Find Lets you look up a vendor.

Add Lets you add a new vendor.

Edit Lets you update a vendor’s information.

Delete Lets you remove a vendor from the database if that vendor has never
been used on a purchase order or receiving document.
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Item Description

Terms Displays the payment terms the vendor has given you.

Un/Combine Lets you do the following:

Select one or more other vendors to inactivate and combine with
the current vendor. This option combines the history and ledgers
of the selected vendor with those of the current vendor (which is
referred to as the master vendor).

Separate the selected vendor from the master vendor record
that it was previously combined with.

This functionality is available in TireMaster 9.4.0 and newer.

OK Lets you save changes and exit the screen. This button only appears in
add and edit mode.

Cancel Lets you exit the screen without saving any changes. This button only
appears in add and edit mode.

VENDOR LEDGER/HISTORY TAB
The Ledger/History tab (Figure 9-2) lists the vendor’s transactional activity, which includes
purchases, returns, payments, and vendor charges.

Figure 9-2: Vendor Maintenance Screen Ledger/History Tab
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Tip: You can limit the number of documents retrieved when looking up a vendor’s history by setting
a system control. For more information, see AR/AP Lookup Date on page 1209.

Item Description

Search Lets you narrow down the documents displayed by invoice number,
reference number, PO number, check number, or amount.

Sort By: Lets you display documents by the transaction date, transaction
reference number, or invoice number.

Note: When Invoice# is selected, sorting by site number also occurs.

(first blank field) Displays the vendor name.

(second and third
blank fields)

Displays the system-assigned vendor number.

Date Displays the transaction date.

Site Displays the site where the transaction took place.

Mod Displays the type of document produced by the transaction.

Invoice Displays the document number for the transaction.

Ref Displays the reference number or code entered at the time of the
transaction.

Note: When the selected transaction is a vendor credit resulting from a
national account or government support sale, this column
displays a memo number.

Total Amt Displays the total amount of the transaction (only when History is
selected).

Charge Amt Displays the portion of the transaction that you charged to the vendor.

Note: In most cases, this amount is equal to the value in the Total Amt
field. If you pay part of a vendor invoice with cash or check and
charge the remainder, this field displays the amount charged
instead.

Paid Amt Displays the amount applied to a vendor charge or the amount paid on a
vendor charge (when AP Ledger is selected).

PO Displays the vendor invoice document number for a purchase.

Check# Displays the check numbers for AP payment checks and easy checks
used to pay the vendor (when History is selected).
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Item Description

AP Ledger Displays each charge and payment posted to a vendor’s account.

History Displays all transactions that have affected this vendor’s account.

E-Mails Lets you email one or more selected documents to the vendor.

Open Item Displays the open item ledger, which is used for viewing and applying
payments to outstanding invoices.

Print Lets you reprint the selected documents or a report listing the vendor’s
history.

Research Lets you view journal entries related to the selected transaction line.

VENDOR AGING TAB
The Aging tab (Figure 9-3) displays the balance you owe to the vendor, along with any past-due
balances.

Figure 9-3: Vendor Maintenance Screen Aging Tab

Note: The vendor’s total balance for all sites is displayed at the corporate site and any stores that
share a database with the corporate site. At a remote store, however, the balances for only that
site are available.
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Item Description

Balance Displays the total amount you owe the vendor.

Current Displays the amount you owe the vendor now.

YTD Displays the total amount of purchases from and charges to the vendor’s
account for the current year.

1-30 Displays the amount due to the vendor from tomorrow to 30 days from
now.

31-60 Displays the amount due to the vendor in 31 to 60 days.

61-90 Displays the balance due to the vendor in 61 to 90 days.

Over Displays any balances due to the vendor after 90 days.

Past Displays any balance that is past due.

VENDOR SEARCHES
Searching for vendors is one of most-commonly performed tasks in TireMaster. Vendor searches
typically occur when starting various transactions and when you need to look at the vendor's account
balance or history.

To search for a vendor
1. Start a task that requires you to search for a vendor or select Vendors > Maintenance. TireMaster

prompts you for the vendor's name.

2. Type all or part of the vendor's name. If you want to retrieve all vendors instead, leave the Enter
Name field blank.
Tip: You can use the percent sign (%) to replace an unknown portion of the vendor's name.

3. To include inactive vendors in the search, clear the Active Only check box.
4. Clear the Search All Sites check box if you want to limit the search to vendors added at your site.
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5. ClickOK. One of the following occurs:
If the search finds an exact match, the Vendor Maintenance screen opens to the vendor's
record.

If more than one vendor matches the lookup, the Vendor List appears. In this scenario, select
the appropriate vendor’s name, and clickOK.

Tip: If you selected the wrong vendor, click the Prev or Next button on the Vendor
Maintenance screen move to the correct vendor record.

VENDOR TYPES
Vendor types are used to classify vendors. Vendor types are set up and managed on the same screen
as customer types. For more information, see Customer Type Edit Screen on page 102.

ADD A VENDOR TYPE
TireMaster comes with several vendor types ready for you to use as is. However, you might want to
create your own vendor types for reporting purposes or for tracking sales differently.

To add a vendor type
1. Select Vendors > Types. The Customer/Vendor Type List opens.

2. Click Add. The Customer/Vendor Type Edit screen opens.
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3. Define a unique code for the vendor type in the Type field.
Note: For ease of use, use only letters or numbers.

4. In the AP or AR field, type AP.
5. Type a description for the vendor type.

6. Assign GL accounts to the vendor type. To assign an account, click the account field, press , and
select an account from the list that appears.

Example: Using the TireMaster’s default accounts, the AP Account would be 2000-100.

7. To save the vendor type, clickOK.
Note: For vendor types, disregard the settings listed underOptions.

SET THE DEFAULT VENDOR TYPE
The default vendor type is automatically assigned each time you add a new vendor to TireMaster.
When you set the default vendor type, select one that best represents the vendors from whom you buy
products and services.

To set the default vendor type
1. Select Setup > System Controls. The System Controls screen opens.
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2. Click the Vendor tab.
3. Select Vendor Default Type and press Enter.

4. Select the type that you want to use as the default vendor type, and clickOK.
5. Close the System Controls screen.

UPDATE A VENDOR TYPE
At some point, you might need to change one or more of the GL accounts assigned to a vendor type or
you might want to change its description.

To update a vendor type
1. Select Vendors > Types. The Customer/Vendor Type List opens.

2. Click Edit. The Customer/Vendor Type Edit screen opens.
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3. Select different GL accounts or change the description.

4. To save your changes, clickOK.

DELETE A VENDOR TYPE
If a vendor type is not assigned to any suppliers, it can be deleted.

To delete a vendor type
1. Select Vendors > Types. The Customer/Vendor Type List opens.
2. Select the type you want to remove, and click Delete. A confirmation message appears.

3. Click Yes.

VENDOR PAYMENT TERMS
Vendor terms define when payments are due and they affect purchase order processing.

SET DEFAULT VENDOR PAYMENT TERMS
Default terms are automatically applied to all new vendor accounts. If a vendor’s terms do not match
the default terms, you change the vendor record for that supplier as needed. Default vendor payment
terms are set in System Controls.

To set default vendor payment terms
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Vendor tab.
3. Set the requirements for the default due date:

a. Select Default AP Due (D=#Days or T=Date) and press Enter
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b. If the payment is due by a specific number of days after the purchase, select Days. If the
payment is due by a specific day of the month instead, select Th. Then clickOK.

c. Select Default AP Due #Days/Date and press Enter.

d. Type the number that represents the number of days after the purchase or the day of the
month. Then clickOK.

4. Set the early pay discount percentage:

a. Select Default AP Discount Percentage (%) and press Enter.

b. Type the percentage amount and clickOK.
5. Set the requirements for receiving the early pay discount:

a. Select Default AP Discount (D=#Days or T=Date) and press Enter.
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b. If the vendor needs to receive the payment by a specific number of days after the purchase to
offer the early pay discount, select Days. If the vendor needs to receive the payment by a
specific day of the month instead, select Th. Then clickOK.

c. Select Default AP Discount #Days/Date and press Enter.

d. Type the number that represents the number of days after the purchase or the day of the
month. Then clickOK.

6. Set the default number of payments made to your vendors.

a. Select Vendor Default Terms and press Enter.

b. Select the number of payments (installments) vendors typically allow per invoice, and click
OK.

7. Close the System Controls screen.

SET A VENDOR'S PAYMENT TERMS
If a vendor’s payment terms are not the same as the default terms, you can set individual terms for that
vendor.
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To set a vendor's payment terms
1. Look up the vendor whose terms you want to set. For more information, see Vendor Searches on

page 193.

2. On the Vendor Maintenance screen, make sure theGeneral tab is selected.
3. Click Terms. The Terms screen opens.

4. To enable early pay discounts, make sure theGive Early Pay Discounts check box is selected.
5. To set up a unique early pay discount, due date, or both, clear the Use Above Defaults check

box. TireMaster disables the default terms.

6. If you selected theGive Early Pay Discount check box in step 4, do the following:
a. Type the discount percentage in the Discount % field.

Example: To subtract 5% from an invoice for which you receive early payment, type 5 in
the Discount field.

b. If the payment must be received a specific number of days after the purchase to give the
discount, type the number of days in the Discount Days field and select Days Later. If the
payment must be received by a specific day of the month instead, type the day of the month
and select Day of Month.

7. If the payment is due a specific number of days after the purchase, type the number of days in the
Due Date field and select Days Later. If the payment is due by a specific day of the month instead,
type the day of the month and select Day of Month.
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Note: If payments are due on the last day of the month, type 31. TireMaster will adjust due dates
for months with fewer than 31 days.

8. Under Invoice Terms, select the maximum number of payments the vendor allows you to make
on an invoice.

9. To save your changes, clickOK.
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INVENTORY CONTROL
TireMaster includes a variety of tools for managing your inventory. This chapter includes the following
sections:

Track Inventory Costs and Quantities 204
Add and Manage Items 205
Inventory Maintenance Screen 219
Inventory Searches 230
Custom Inventory Lookup Screen 239
The Inventory List 243
Inventory History 244
Physical Counts 247
Add-On Packages 252
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TRACK INVENTORY COSTS AND QUANTITIES
Before you add an item to the inventory, you need to decide whether you want to track its cost and
quantities. Depending on the choice you make, you’ll classify the item as either inventoriable or
noninventoriable.

Note: Inventoriable and noninventoriable items are not the same as stock and nonstock items. The
term stockmeans an item is carried in inventory. Nonstock refers to items that are purchased
for specific jobs. Inventoriable and noninventoriable define whether you track an item’s
quantities and cost.

INVENTORIABLE ITEMS
If you need to keep track of an item’s cost and quantities, set it up as an inventoriable item.
Inventoriable items include the items that you typically keep in stock and include in your physical
inventory counts. If you want your sales reports to show the profit or loss for an item, set it up as
inventoriable.

To classify an item as inventoriable, type the letter Y in the Inventory (Y/N) field on the Inventory
Maintenance screen. To track changes in an inventoriable item’s cost, you need to select one of three
inventoriable costing methods. For more information, see Inventoriable Costing Methods on page 374.

Figure 10-1: Classifying an Item as Inventoriable

NONINVENTORIABLE ITEMS
If you need to track an item’s cost but not its quantities, set it up a noninventoriable item.
Noninventoriable items typically include labor, nonstock items such as service parts, and hard-to-track
items such as valve stems.

To classify an item as inventoriable, type the letter N in the Inventory (Y/N) field on the Inventory
Maintenance screen. When you set up a noninventoriable item, you also need to decide the following:

If you want to post the item’s cost to general ledger at point of sale (Option Cost Method).

If you want to post the item’s cost to the general ledger when you buy it from a vendor (Expense
Method).
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If you want to post the item’s cost to the general ledger when it’s sold (Relief Percent Method).

For more information, see Noninventoriable Costing Methods on page 375.

Figure 10-2: Classifying an Item as Noninventoriable

ADD AND MANAGE ITEMS
Because tracking inventory activity is an ongoing task, TireMaster includes tools for gathering
information about the products and services you sell.

ADD AN INVENTORY ITEM
When you add an item to the inventory, you need to complete settings that will help you distinguish it
from the other products and services you sell. Completing all of the available inventory settings is not
necessary, however, each item must be assigned the following:

A unique product code

An inventory category

A GL code

You also need to define whether an item is inventoriable or noninventoriable.

Note: Most items should be added at the corporate site. Stores, however, can add and manage
items that won't be sold by other locations. An item added by a store cannot be viewed or
changed by another store.

To add an item
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

2. Do one of the following:
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Search for an item that’s similar to the one you’re adding. For more information, see Inventory
Searches on page 230.

Tip: By looking up a similar item, you can reuse many of its settings for the new item.

Click Cancel.
3. When the Inventory Maintenance screen opens, click Add. TireMaster prompts you for a product

code.

4. Type a unique product code for the new item and clickOK.

5. Enter the item’s basic information:

a. Type the size, description, and quick-look code. For tires, also type the rim size.

Note: For items that do not have a size, type a period (.) in the Size field. The period ensures
that the item’s information prints properly on work orders and invoices.

b. Click theGroup field, press . Then select a group from the list that appears, and clickOK.
c. Make sure the Active check box is selected.

6. Define whether to assess shop charges for the item.

For shop charges based on the sum of the item’s parts price and FET, select the Charge
ShopParts check box.
For shop charges based on the item’s labor price, select the Charge Shop Labor check box.
For shop charges based on both the item’s parts price and labor price, select both of the
Charge Shop check boxes.
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Note: To assess shop supplies, other settings also need to be completed. For more information,
see Shop Supplies on page 366.

7. Define how the item should be handled.

a. If the item is inventoriable, type the letter Y in the Inventory (Y/N) field. For noninventoriable
items, type the letter N instead. For more information, see Inventoriable Items on page 204 and
Noninventoriable Items on page 204.

b. Define the item’s type in the Type (G, C, F, D) field:
For normal items, leave the field blank.

For gasoline, type the letter G. For more information, see Add Gasoline to the Inventory on
page 361.

For consignments, type the letter C. For more information, see Set Up Consignment Items
on page 360.

For fees, type the letter F. For more information, see Set Up Fees on page 366

For discounts, type the letter D. For more information, see Set Up Discounts on page 365.

c. If you’ll record the cost of the item at point of sale, select the Force Option Cost check box.
Note: This setting is only for noninventoriable items obtained through outside purchases. For

more information, see Noninventoriable Costing Methods on page 375

d. If the item is noninventoriable and you want to track it, select the Track check box. For more
information, see Item Tracking on page 297.

8. Enter employee incentive information (optional).

a. To assign a spiff color to the item, click the Color/Spiff field and press . Then select a color
from the list that appears and clickOK.

b. If you pay sales commission for the item, click the Commission field and press . Then select
the inventory commission type and clickOK.
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9. Enter up to three bar codes (optional). For more information, see Prepare to Use Bar Codes on
page 348.

10. Enter the vendor part number and reconciliation code for the item’smain vendor or manufacturer.
a. Type the part number in the Vendor Part Number 1 field.
b. Click the Recon Code 1 field and press . Then select the reconciliation code for the item’s

main vendor or manufacturer and clickOK.

Note: The Vendor Part Number 1 and Recon Code 1 fields are used together. Therefore, if
the vendor part number is for Goodyear, the reconciliation code needs to be the one for
Goodyear.

11. Enter up to three additional vendor part numbers and reconciliation codes for other vendors who
distribute the item.

Note: The additional vendor part numbers and reconciliation codes are used together as well.
For example, if the Michelin vendor part number is entered in the Vendor Part Number 2
field, the Michelin reconciliation code needs to be entered in Recon Code 2 field.

Tip: To see which vendor part numbers and reconciliation codes are assigned to items,
generate a Vendor Part Number List. This report is on the Inventory tab on the Report List.

12. Enter the following tire and wheel details as needed.
a. For tires, enter the load index/speed rating, UTQG rating, load range, sidewall style, and

treadlife warranty. For information on using the Core Item field, see Prepare to Track Core
Items on page 930.
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b. For wheels, enter the number of lugs, the bolt pattern, the rim width, and the rim offset.

c. Type a minimum weight requirement (optional).

13. Assign the following codes and tax settings:
a. Click the Add On/Kit Code field and press . Then select an add-on code and clickOK.
b. Click theMfg Code field and press . Then select the code for the item’s manufacturer and

clickOK.
c. If the item’s price excluding labor is taxable, make sure the Parts check box is selected.

Otherwise, clear the check box.

d. If the item’s labor price is taxable, make sure the Labor check box is selected. Otherwise,
clear the check box.

e. Click the Category field and press . Then select a category code and clickOK.
f. Click theGL field and press . Then select a GL code and clickOK. or one of the three preset

GL codes and clickOK.

14. To save the new item, clickOK. TireMaster prompts you to edit the prices for the new item.

15. To add prices for the item, click Yes. For instructions, see Fixed Prices on page 386. Otherwise,
click No and close the Inventory Maintenance screen.

UPDATE INVENTORY INFORMATION
When you need to update information for items, you have two options. You can update items one at a
time or in bulk by with Inventory List Editing.
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UPDATE INFORMATION FOR A SINGLE ITEM
When you need to update the information for a single item, you can make the needed changes in the
record for that item.

To update an item’s settings
1. Look up the item you need to update. For more information, see Inventory Searches on page

230.

2. Do one of the following on the Inventory Maintenance screen:

To change codes assigned to the item, make sure theGeneral tab is selected. Then click
Edit.

To change price, cost, and stocking-level settings, click theQty/Pricing tab. Then click
Detail/Edit to open the Site Prices and Quantity screen.

To change the item’s notes or link to a web site, specifications sheet, or product photo click
the Notes tab. Then click Edit Note.

3. Update the settings that need to be changed.

4. To save the changes, clickOK.
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UPDATE INFORMATION FOR MULTIPLE ITEMS
With Inventory List Editing, you can update the settings for a group of items. The Inventory List
Editing screen is similar to a spreadsheet and is split into two panes. The top pane lists basic
properties for items, such as size, product code, and group. The bottom pane is for price, cost, and
stocking-level settings. List Editing is available only that the corporate site.

To update information for multiple items
1. Select Inventory > List Editing. TireMaster The Custom Inventory Lookup screen appears.

2. Search for a group of items to update. For more information, see Inventory Searches on page
230.

3. Resize screen and rearrange the columns (one on or both of the panes) if needed. For more
information, see Resize Screens on page 10 and Rearrange Table Columns on page 10.

Note: If you belong to a security group that’s assigned the permission Save Screen Layout,
you can save your changes by clicking Save Layout.

4. In the top pane, select the row for the item you want to update. The corresponding row for that
item is automatically selected in the bottom pane.

Note: For a hard copy of the information listed on the screen, click Print.

5. In the top pane, make changes by typing them, selecting or clearing check boxes, and selecting
codes from a list. To access the various code lists, click the cells colors yellow. Then press or
click . Your changes are saved instantly.

Note: Because an item’s product code cannot be blank, TireMaster will re-enter it if it has been
deleted.

Tip: Press the arrow keys to move from cell to cell and press Tab to move between panes.
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6. In the bottom pane, click the row for the selected item and make changes as needed. In the Price
By andOperator columns, press repeatedly to see your choices.

Tip: To copy and paste settings, click the cell with the number or code you want to copy. Then
click the cell again and press Ctrl+C. Next, click the cell where you want to paste the
data. Click the cell again and press Ctrl+V.

7. To change additional items, repeat steps 4 through 6.

8. If you want to edit another group of items, click Select Inventory.

9. Close Inventory List Editing screen.

UPDATE ITEMS WITH SPREADSHEETS
You can update price, cost, and bar code settings for existing items by importing data from an XML
spreadsheet into TireMaster. Updating items in this manner helps you save time, because information
for multiple items can be updated at once.

Note: To ensure items can be updated, the spreadsheet needs to meet certain requirements. For
information on creating spreadsheets for inventory updates, see Spreadsheet Requirements
on page 214.

To update items with an XML spreadsheet
1. Select Inventory > Spreadsheet Updates. TireMaster prompts you to update items with an

XML spreadsheet.
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2. Depending on how your spreadsheet is set up, select Vendor Part Number or Product Code.
TireMaster checks your inventory for any items that have been assigned duplicate part numbers or
product codes.

Note: Items with duplicate part numbers or product codes will not be updated. Therefore, you
might want to verify that unique part numbers and product codes are assigned to items
before updating the prices.

Tip: To generate a hard copy of the notes at any time, click Print Notes.

3. Look up the spreadsheet with the price information:

a. Click Select Inventory Update File. The Load Inventory Update File screen appears.

b. Select the file that you want to use for the update and clickOpen.
Note: If you don’t see the file you want to use, select it from the Look in drop-down.

4. To view the pending changes, click Preview. If TireMaster cannot access the data file, make sure
the spreadsheet is no longer open in Excel.

Note: Although prices on the update screen might extend to more than four decimal points in
some instances (such as BASE=.047399999999999998), those values will be displayed
properly on TireMaster’s setup screens for the updated items (such as 0.474).
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5. To complete the update, click Process Inventory Update. The following message appears:
“Inventory update is complete.”

Note: Although prices on the update screen might extend to more than four decimal points in
some instances (such as BASE=.047399999999999998), those values will be displayed
properly on TireMaster’s setup screens for the updated items (such as 0.474).

6. ClickOK to close the message.

7. Close the Inventory Update from Spreadsheet XML File screen.

8. Verify that the price, cost, or bar code fields were updated by looking up a sample of individual
items or by looking up multiple items in Inventory List Editing.

SPREADSHEET REQUIREMENTS
XML spreadsheets (Figure 10-3) used for updating inventory need to meet the following
requirements:

It must be saved in the XML spreadsheet format.

Tip: In Microsoft® Excel®, select Save As from the Filemenu. Then select XML
Spreadsheet from the Save as Type drop-down list.

Each column heading must include the TireMaster database column name in parenthesis. (For
example, INVPRICE.DBILL.)

It must have a column for vendor part numbers, product codes, or both.

If an amount is 0.00, type 0.00. Cells cannot be blank.

Figure 10-3: XML Spreadsheet Example
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The Pricing folder in the TireMaster program directory (c:\TireMaster\Pricing or
d:\TireMaster\Pricing) includes two spreadsheets that you can modify, or you can create your own.
Table 10-1 lists the fields in TireMaster that can be updated with an XML spreadsheet, along with the
corresponding database column names.

TireMaster Field Name Database Column Name

Vendor Part # INV.VENDPARTNO Spreadsheets must
have a column for
vendor part numbers,
product codes, or both.

Product Code INV.INVNO

Bar Code 1 INV.BARCODE1

Bar Code 2 INV.BARCODE2

Bar Code 3 INV.BARCODE3

Base Price INVPRICE.DBILL

Last Cost INVPRICE.LASTCOST

Labor Price INVPRICE.LABOR

Everyday Low INVPRICE.EDL

Price By INVPRICE.PRICEBY

Factor INVPRICE.FACTOR

Sale Labor INVPRICE.SALE_LABOR

Sale Price INVPRICE.SALE_PRICE

Sale Begin (date) INVPRICE.SALE_BEGIN

Sale End (date) INVPRICE.SALE_END

Last FET INVPRICE.LASTFETAX

Next FET INVPRICE.FETAX

Standard Cost INVPRICE.STANDARDCOST

Table 10-1: XML Requirements

ASSIGN STOCKING LEVELS TO A GROUP OF ITEMS
With the Pricing Wizard, you can assign the sameminimum stocking level, the samemaximum
stocking level, or both to a group of items. You’ll most likely use the Pricing Wizard to assign stocking
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levels in conjunction with another task. For example, in one session of using the Pricing Wizard, you
could do the following to the tires in a specific product line:1) set the minimum stocking level, 2) set the
maximum stocking level, and 3) update the cost.

Note: Stocking levels can also be defined in the settings for individual items and for groups of items
with Inventory List Editing. With Inventory List Editing, you can vary the minimum and
maximum stocking levels assigned. For more information, see Update Information for Multiple
Items on page 211

To assign stocking levels with the Pricing Wizard
1. Select Inventory > Pricing Wizard.

2. Make sure Price Change is selected.

3. Update the minimum stocking level if needed. Otherwise, skip this step.

a. Select Min Stock from the Field to Update drop-down for the operation being used to update
the minimum stocking level. The Value field appears and replaces the price change fields.

b. Type the number you want to assign as the minimum stocking level in the Value field.



Add and Manage Items

4. Update the maximum stocking level if needed. Otherwise, skip this step.

a. Select Max Stock from the Field to Update drop-down for the operation being used to update
the maximum stocking level. The Value field appears and replaces the price change fields.

b. Type the number you want to assign as the maximum stocking level in the Value field.

5. Click Inventory, and look up the item or items to which you want to assign stocking levels. For
more information, see Inventory Searches on page 230.

6. Review the pending changes.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.
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b. Verify that the changes you want will be made.

c. Print the report if needed, and close the Report Window.

7. Click Apply. A confirmation message appears.

8. Click Yes. A second message verifies the update has been completed.

9. ClickOK to close the confirmation message.

To view the changed stocking level for a single item, look at either theMin Stock orMax Stock field
on the Site Prices and Quantity screen. For multiple items, select List Editing from the Inventory
menu, and look up the same items you just updated. Stocking levels are listed in the lower-right half of
the Inventory List Editing screen. If you can’t see them, scroll to the right.

DISCONTINUE AN ITEM
When you stop selling a particular item or when a manufacturer no longer makes an item, you can
classify that item as discontinued. Once a discontinued item reaches a quantity of zero, TireMaster
changes the item’s status to inactive when you cut off the month.

To discontinue an item
1. Search for the item you want to discontinue. For more information, see Inventory Searches on

page 230.

2. On the Inventory Maintenance screen, make sure theGeneral tab is selected and click Edit.
3. Select the Discontinued check box.
4. To save you changes, clickOK.

MAKE AN ITEM INACTIVE
By making an item inactive, you can exclude it from inventory searches and reports.

Note: When you close the month, TireMaster changes the status of any discontinued items with a
quantity of zero to inactive. To determine whether an item’s quantity is zero, TireMaster adds
the item’s quantity on-hand to the item’s quantity on order.
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To make an item inactive
1. Search for the item you want to discontinue. For more information, see Inventory Searches on

page 230.

2. On the Inventory Maintenance screen, make sure theGeneral tab is selected and click Edit.

3. Clear the Active check box.

4. To save you changes, clickOK.

DELETE AN ITEM
Inventory items cannot be deleted. You can make them inactive instead. For more information, see
Make an Item Inactive on page 218.

INVENTORY MAINTENANCE SCREEN
The Inventory Maintenance screen is used to store and track information about the products and
services you sell. Tasks commonly performed with this screen include adding items

and viewing an item’s history.

GENERAL TAB
TheGeneral Tab (Figure 10-4) stores an item’s basic information, as well as several codes that are
part of its settings.
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Figure 10-4: Inventory Maintenance Screen General Tab

Item Description

Prev
Next

Lets you move to the record for the previous or next item on the
Inventory List. The items displayed when clicking the buttons depends
on the search options and sort order used for the inventory lookup.

Note: If you click Next on the screen for the last item retrieved,
TireMaster will beep. At that point, you can only move
backward. TireMaster also beeps if you click Prev on the
screen for the first item retrieved. In that scenario, you can only
move forward.

Product Code Lets you enter the number assigned to an item by the manufacturer.
This number must be a unique.

Size Lets you enter an item’s size.

Note: To ensure that various documents are formatted properly, use
a code of your choice or a period for items that don’t have a
size.

Rim Size Lets enter the size for rims.
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Item Description

Description Lets you create a description for the item.

Quick Look Lets you assign an easy-to-remember code of your choice that you
can use to look up the item.

Group Lets you assign an inventory group to the item. For more information,
see Inventory Categories and Groups on page 340.

Active Lets you define that the item is currently being produced or is currently
being sold.

Discontinued Lets you define that the item is no longer being produced or is no
longer being sold.

Charge Shop: Parts Lets you define whether to assess a shop charge based on the sum of
the item’s parts price and FET.

Charge Shop:
Labor

Lets you define whether to assess a shop charge based on the item’s
labor price.

Part# Displays the site number and the system-assigned number for the
item.

Inventory
(Y/N)

Lets you state one of the following:

Y identifies inventoriable items

N identifies noninventoriable items

Type
(G, C, F, D)

Lets you classify the item:

No entry identifies a normal item.

G identifies the item is gasoline.

C identifies a consignment item.

F identifies the item is a fee.

D identifies the item is a discount.

Color/Spiff Lets you assign a color code, sales spiff, or both to the item.

Commission Lets you assign an inventory commission type to the item.

Note: If this code is not entered manually, TireMaster uses the
default inventory commission type set in System Controls for
calculating commission.

Force Option Cost Lets you remind users to enter the exact cost, including FET, of
noninventoriable items at point of sale.
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Item Description

Note: If the System Control Force Option Cost is set to Yes, users
are required to enter the cost.

Bar Code 1 Lets you assign a primary bar code to the item.

Bar Code 2 Lets you assign a secondary bar code to the item.

Bar Code 3 Lets you assign a third bar code to the item.

Vendor Part
Number 1

Lets you enter the vendor part number for the item’smain vendor or
manufacturer. Some vendors and manufacturers refer to vendor part
numbers as article numbers or product IDs.

Tip: Because the entry in this field is the only vendor part number
displayed on the Inventory List and the Inventory List Editing
screen, you should enter the most frequently used vendor part
number here.

Note: This vendor part number is used in conjunction with
reconciliation code 1. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Goodyear vendor part number, the
Goodyear reconciliation code needs to be entered in the
Recon Code 1 field.

Recon Code 1 Lets you assign the reconciliation code for the item’smain vendor or
manufacturer. This code is used for tracking national account,
government support, and defect adjustment sales.

Note: This reconciliation code is used in conjunction with vendor part
number 1. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
example, if this is the Goodyear reconciliation code, the
Goodyear vendor part number needs to be entered in the
Vendor Part Number 1 field.

Vendor Part
Number 2

Lets you enter a second vendor part number for another vendor who
distributes the item. Some vendors refer to vendor part numbers as
article numbers or product IDs.

Note: This vendor part number is used in conjunction with
reconciliation code 2. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Michelin vendor part number, the Michelin
reconciliation code needs to be entered in the Recon Code 2
field.
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Item Description

Recon Code 2 Lets you assign a second reconciliation code for another vendor. This
code is used for tracking national account, government support, and
defect adjustment sales.

Note: This reconciliation code is used in conjunction with vendor part
number 2. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
example, if this is the Michelin reconciliation code, the Michelin
vendor part number needs to be entered in the Vendor Part
Number 2 field.

Vendor Part
Number 3

Lets you enter a third vendor part number for another vendor who
distributes the item. Some vendors refer to vendor part numbers as
article numbers or product IDs.

Note: This vendor part number is used in conjunction with
reconciliation code 3. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Bridgestone vendor part number, the
Bridgestone reconciliation code needs to be entered in the
Recon Code 3 field.

Recon Code 3 Lets you assign a third reconciliation code for another vendor. This
code is used for tracking national account, government support, and
defect adjustment sales.

Note: This reconciliation code is used in conjunction with vendor part
number 3. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
example, if this is the Bridgestone reconciliation code, the
Bridgestone vendor part number needs to be entered in the
Vendor Part Number 3 field.

Vendor Part
Number 4

Lets you enter a fourth vendor part number for another vendor who
distributes the item. Some vendors refer to vendor part numbers as
article numbers or product IDs.

Note: This vendor part number is used in conjunction with
reconciliation code 4. Therefore, both the part number and
reconciliation code need to be for the same vendor. For
example, if this is a Cooper vendor part number, the Cooper
reconciliation code needs to be entered in the Recon Code 4
field.

Recon Code 4 Lets you assign a fourth reconciliation code for another vendor. The
reconciliation code is used for tracking national account, government
support, and defect adjustment sales.
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Item Description

Note: This reconciliation code is used in conjunction with vendor part
number 4. Therefore, both the part number and this
reconciliation code need to be for the same vendor. For
example, if this is the Ccooper reconciliation code, the Cooper
vendor part number needs to be entered in the Vendor Part
Number 4 field.

Load/Speed Lets you define the load index and speed rating for a tire.

UTQG Lets you define a tire’s Uniform Tire Quality Grade rating.

Note: For TireMaster systems that are not integrated with Tire
Brands, the values in this field are displayed with product
information at the top of the page on good, better, best
(comparison) quotes after the labelWear. For more
information, see Good, Better, Best Quotes on page 506.

Load Range Lets you define the load range for a tire.

Sidewall Lets you define the sidewall style for a tire.

Warranty Lets you define the treadlife warranty for a tire.

Note: For TireMaster systems that are not integrated with Tire
Brands, the value in this field is displayed with product
information at the top of the page on good, better, best
(comparison) quotes after the labelMiles. For more
information, see Good, Better, Best Quotes on page 506.

Core Item Lets you enter a core inventory item you want to associate to the item.

Bolt1 Lets you enter the primary bolt pattern for a wheel in either metric or
US standard measurements.

Bolt2 Lets you show an alternative measurement or a secondary bolt pattern
for a wheel.

Lugs Lets you enter the number of lug nuts for a wheel.

Width Lets you enter the width of a wheel.

Offset Lets you enter the offset for a wheel.

Weight Lets you set a minimum weight requirement for the item.

Add-On/Kit Code Lets you assign a group of add-on items that will be included on
invoices when the item is sold.
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Item Description

Mfg Code Lets you enter the item’s manufacturer.

Taxable: Parts Lets you define whether to collect sales tax for the item’s parts price,
except for tax-exempt customers.

Taxable: Labor Lets you define whether to collect sales tax for the item’s labor price,
except for tax-exempt customers.

Category Lets you assign an inventory category to the item.

GL Lets you assign a general ledger code to the item. If you're running a
TireMaster Point of Sale system, use one of the preset GL codes.

Find Lets you search for an item.

Add Lets you add a new item to the inventory.

Edit Lets you change the selected item’s settings.

Delete Lets you delete the selected item if it has never been used in a
transaction.

Cancel Lets you exit the screen without saving changes in add or edit mode.

OK Lets you save changes and exit the screen in add or edit mode.

Close Lets you exit the screen when you are not in add or edit mode.

QTY/PRICING TAB
TheQty/Pricing tab (Figure 10-5) displays information about an item’s quantities and prices. To
update an item’s stocking quantities, prices, and cost settings, click Detail/Edit.
Note: The available quantity is the total of the item’s quantity on hand and the quantity not priced.

Tip: To view addition information about an item, press  repeatedly.

225



226

User Guide

Figure 10-5: Inventory Maintenance Screen Qty/Pricing Tab

HISTORY TAB
The History tab (Figure 10-6) shows an item’s sales and receiving history. It also shows whether an
item is currently on any work orders:

Select Sales History for a list of both sale and return invoices. The sales history shows how
much you previously charged customers for the item.

Select Receiving History for a list of vendor invoice documents (VIDs) created when the item
was priced. The receiving history shows what you paid a vendor when you previously bought the
item.

SelectWork Orders to see whether the item is currently on any work orders.

You can control how many historical documents (also referred to as records) are displayed on the
screen by selecting one of the radio buttons in the lower-right corner of the screen. For a duplicate
copy of a document, select the line for it and click Reprint. To see how a transaction posted to the
general ledger, select the line for it and click Research.
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Figure 10-6: Inventory Maintenance Screen History Tab

Item Description

Site# Displays the number for the site where the item was added to the
inventory. In TireMaster Point of Sale and TireMaster Plus, this number
is always 1.

Part# Displays the item’s system-assigned part number.

Description Displays the item’s description, product code, and size.

Search Lets you search for historical documents by document number,
customer or vendor name, and price. Available in TireMaster 9.4.0.

Date Displays one of the following:

The date the invoice was completed (sales history view)

The date the vendor invoice document (VID) was completed
(receiving history view)

The date the item was added to a work order (work order history
view)

Site Displays one of the following:

The number for the site where the invoice was completed (sales
history view)

The number for the site where the vendor invoice document was
completed (receiving history view)
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Item Description

The number for the site where the item was added to a work
order (work order history view)

In TireMaster Point of Sale and TireMaster Plus, this number is always
1.

Mod Displays the code that identifies the document type. For normal sales,
returns, and trade-ins, this field is blank (sales and work order history
views). For more information, see Document Type Codes on page
1229.

Invoice Displays the invoice number or work order number (when viewing sales
and work order history).

VID# Displays the document number for the vendor invoice document (when
viewing receiving history).

Customer Displays the name of the customer who purchased or is going to
purchase the item (when viewing sales and work order history).

Vendor Displays the name of the vendor who sold you the item (when viewing
receiving history).

Qty Displays the quantity sold, received, or placed on work order.

Parts Displays the parts price for each item sold or placed on work order
(when viewing sales and work order history).

Price Displays your cost for each item (when viewing receiving history).

Labor Displays the labor price for each item sold or placed on work order
(when viewing sales and work order history).

FET Displays one of the following:

The federal excise tax for each item sold (sales history view)

The federal excise tax charged to you when the item was
received (when viewing receiving history)

The federal excise tax for each item on work order (when viewing
work order history)

Line Identifies the line where the item appears on the invoice, vendor
invoice document, or work order.

Document Type:
Sales History

Lets you view the item’s sales history.
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Item Description

Document Type:
Receiving History

Lets you view the item’s receiving history.

Document Type:
On Work Order

Lets you see a list of work orders that the item is assigned to.

Number of
Documents: First
radio button (lower-
right corner)

Lets you limit the number of historical documents or work orders
displayed to the number shown.

Note: To define the number of documents displayed when selecting
this radio button, set the System ControlGrid Control - Limit
1. For more information, see Grid Control - Limit 1 on page
1212.

Number of
Documents:
Second radio
button (lower-right
corner)

Lets you limit the number of historical documents or work orders
displayed to the number shown.

Note: To define the number of documents displayed when selecting
this radio button, set the System ControlGrid Control - Limit
2. For more information, see Grid Control - Limit 2 on page
1213.

Number of
Documents: All

Let you display all historical documents or work orders.

Reprint Lets you reprint the selected invoice or vendor invoice document (when
viewing sales and receiving history)

Research Lets you view journal entries generated when the selected item was
sold or received (when viewing sales and receiving history).

Note: Journal entries can be researched only in the TireMaster Plus
and TireMaster Corporate systems.

NOTES TAB
The Notes tab provides a space for including information, such as warranty disclaimers, in an item’s
inventory record. Notes entered on this screen print on work orders and invoices.

You can also use the Notes tab to link an item to a web site or a file, such as a product specifications
sheet or a photo, that’s stored on your computer or network.

To add a note to an item, click Edit Note and type the text for your note. To save the note, click
OK.
To link an item to a Web site, click Edit Note and type the web site’s URL in the External
Specifications field. Then clickOK.
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To link an item to a file on your computer or network, click Edit Note and type the path and file
name (such as c:\tirephotos\Cooper\trendsetter or
\\mynetwork\specsheets\Goodyear\Wrangler.

INVENTORY SEARCHES
When looking up items, you can use various search options—referred to as prompts in TireMaster—to
narrow your search and control how the items you find are displayed on the Inventory List.

SEARCH WITH QUICK LOOK CODES
A quick look code can be any combination of numbers or letters that’s easy to remember. Many
dealers use quick look codes as a way to look up tire sizes without having to type slashes or letters.
Searching with quick look codes is helpful at point of sale.

To search with quick look codes
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Tip: To reuse the codes from a previous search, click Past Lookups and make a selection
from the drop-down list.

2. Click the tab you want to use for the search.

3. In the 3-Quick Look row, click the Start field and type a full or partial quick look code.

Tip: Clicking Clear removes the quick look code from the screen.

4. To use different sort codes for the search, type the letters or numbers for the codes in the Sort
field.
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Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a sort
code cannot be used to perform a task or organize information on a report, it’s disabled.

5. Select or the following check boxes as needed:

To include active items in the search, make sure the Active Items Only check box is selected.
To include discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

To display the items from the highest to lowest order on the Inventory List, select the
Descending check box.

Note: Because TireMaster is designed to always display quantities from highest to lowest,
the Descending check box is disabled when the letterQ is the only code entered in
the Sort field.

6. ClickOK. The Inventory List opens.

7. Select an item and clickOK.
Note: To see available and on-order quantities for another site, clickOther Site.

SEARCH BY MANUFACTURER
You can narrow your search to items that are made by a particular manufacturer. This method of
searching for items is helpful when you create purchase orders.

To search for items by manufacturer
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.
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Tip: To reuse the codes from a previous search, click Past Lookups and make a selection
from the drop-down.

2. Click the tab you want to use for the search.

3. In theManufacturer row, click in the Start field and press . Then select the manufacturer code
from the list that appears and clickOK.

Tip: Clicking Clear removes the manufacturer code from the screen.

4. If you want to use different sort codes for the search, type the letters or numbers for the codes in
the Sort field.

Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a sort
code cannot be used to perform a task or organize information on a report, it’s disabled.

5. Do one or more of the following as needed:

To include active items in the search, make sure the Active Items Only check box is selected.
To include discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

To display the items from the highest to lowest order on the Inventory List, select the
Descending check box.
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Note: Because TireMaster is designed to always display quantities from highest to lowest,
the Descending check box is disabled when the letterQ is the only code entered in the
Sort field.

6. ClickOK. The Inventory List opens.

7. Select an item, and clickOK.
Note: To see available and on-order quantities for another site, clickOther Site.

SEARCH FOR A RANGE OF ITEMS
With some prompts, you can look for a range of items. For example, you can search for all of the items
that fall within a particular product code range. Using a range lets you narrow your search. The
prompts that you can use to search for a range of items have active (white or yellow) fields in the End
column of the Custom Inventory Lookup screen.

To search for a range of items
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

Tip: To reuse the codes from a previous search, click Past Lookups and make a selection
from the drop-down.

2. Click the tab you want to use for the search.

3. Define the beginning and end of the range:

a. Click the Start field for the row you’re using and type a code, number, letter, or description. For
group and category ranges, click and make a selection from the list that appears.

Note: You can use both full and partial entries for the following search options to look up a
range of items: quick look code, product code, group, category range, size range,
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vendor part number range, bolt pattern, wheel width, wheel offset, and the number of
lug nuts.

b. Click the End field for the same row and type a code, number, letter, or description. For
category and size ranges, click and make a selection from the list that appears.

Tip: Clicking Clear removes the codes from the screen.

4. If you want to use different sort codes for the search, type the letters or numbers for the codes in
the Sort field.

Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a sort
code cannot be used to perform a task or organize information on a report, it’s disabled.

5. Select or clear the following check boxes as needed:

To include active items in the search, make sure the Active Items Only check box is selected.
To include discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

To display the items from the highest to lowest order on the Inventory List, select the
Descending check box.

Note: Because TireMaster is designed to always display quantities from highest to lowest,
the Descending check box is disabled when the letterQ is the only code entered in the
Sort field.

6. ClickOK. The Inventory List opens.
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7. Select an item, and clickOK.
Note: To see available and on-order quantities for another site, clickOther Site.

SEARCH WITH BAR CODES
You can look up an item by scanning its bar code or typing its bar code on the Custom Inventory
Lookup screen.

Note: Up to three different bar codes can be assigned to a single item.

To search for items with bar codes
1. SelectMaintenance from the Inventorymenu. The Custom Inventory Lookup screen appears.

2. Click the tab you want to use for the search.

3. In the 6-Bar Code row, click the Start field. Then scan the item’s bar code or type the numbers in
the item’s bar code.

Note: You can also type a partial bar code. In this scenario, TireMaster retrieves all items whose
bar codes include the sequence of numbers you typed.

4. ClickOK. The Inventory List appears.

5. To open the item’s record, clickOK.
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Note: To see available and on-order quantities for another site, clickOther Site.

SEARCH FOR STAGGERED FITMENT TIRES
When you need to look up tires for a vehicle that accepts staggered fitments, use the Split Look option
to define the differing front and rear tire sizes. The Split Look option allows you to search with two
different quick look codes.

To search for staggered fitment tires
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

2. Click the tab you want to use for the search.

3. In the Split Look row, click the Start field and type the quick look code (typically the size without
letters or slashes) for the first size you need to find.

Note: It doesn’t matter if the front or rear size is used first.

4. In the Split Look row, click the End field and type the quick look code for the second size you need
to find.

5. To narrow down the search, do the following as needed:

Click in the Start field for the Description row and type a full or partial description.
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Click in the Start field for theManufacturer row and press . Then select the manufacturer code
from the list that appears and clickOK.

6. ClickOK. The Inventory List appears.

Note: If you don’t define the description, manufacturer, or both, sort the Inventory List by
description or manufacturer to simplify finding the same kind of tire in both sizes.

7. Select an item, and clickOK.
Note: To see available and on-order quantities for another site, clickOther Site.

8. To access the information about the other tire for the staggered fitment, click the Prev or Next
buttons as needed.

SEARCH WITH MULTIPLE CODES
For some searches, you can use more than one code to look for items. For example, you can search
for all Goodyear tires that fall within a particular size range.

To search for items using multiple codes
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.
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Tip: To reuse the codes from a previous search, click Past Lookups and make a selection
from the drop-down.

2. Click the tab you want to use for the search.

3. Click the Start field for the first row you’re using, and type a code. For manufacturers, groups, and
categories, you can click and select a code from a list. If the row can be used to search by range,
you can also enter a code in the End field.

4. Repeat step 3 for the additional codes that you’re using for the search.

Tip: Clicking Clear removes the codes from the screen.

5. If you want to use different sort codes for the search, type the letter or number for the codes in the
Sort field.

Note: You can use up to four of the sort codes displayed to the right of the Sort field. When a sort
code cannot be used to perform a task or organize information on a report, it’s disabled.

6. Select or clear the following check boxes as needed:

To include active items in the search, make sure the Active Items Only check box is selected.
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To include discontinued items in the search, make sure the Include Discontinued Items
check box is selected.

To display the items from the highest to lowest order on the Inventory List, select the
Descending check box.

Note: Because TireMaster is designed to always display quantities from highest to lowest,
the Descending check box is disabled when the letterQ is the only code entered in the
Sort field.

7. ClickOK. The Inventory List appears.

8. Select an item, and clickOK.
Note: To see available and on-order quantities for another site, clickOther Site.

CUSTOM INVENTORY LOOKUP SCREEN
The Custom Inventory Lookup screen is used to find inventory items in the TireMaster database. You
define the requirements for inventory searches by entering one or more codes in the fields on the
Custom Inventory Lookup screen. The screen also has five tabs that you can customize for various
circumstances in which you look up items.

CUSTOM INVENTORY LOOKUP SCREEN PROPERTIES
The Custom Inventory Lookup screen (Figure 10-7) includes a set of customizable tabs and settings
that affect the way in which items retrieved by a search are displayed. For information about the tabs,
see Configure the Custom Inventory Lookup Screen on page 242.
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Figure 10-7: Custom Inventory Lookup Screen

Item Description

Past Lookups Lets you select the codes used for a previous search from a drop-
down and reuse them in a new search.

Prompt Displays the names of the search options for the selected tab. The
search options are actually various settings assigned to items,
including size, product code, and bar code.

Start Lets you type a code, number, letter, or description to use for
searches:

When searching for a range of items, set the beginning of the
range in this column.

When searching by manufacturer, group, and category, click
and make a selection from a list.

When using the Split Look option to search for staggered
fitments, type one size in this column and the other size in the
End column.

End Lets you type the code, number, letter, or description for the end of a
range of items:

When searching for a range of items, set the end of the range in
this column (for search options that can be used to look up a
range of items).
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Item Description

When searching by group and category, click and make a
selection from a list.

When using the Split Look search option to find staggered
fitments, type one size in the Start column and the other size in
this column.

Sort Lets you set the order for displaying items retrieved by a search on the
Inventory List. The first code is the primary sorting method, the second
code is the secondary sorting method, and so on. For example, if the
primary sort order is rim size, all items with the same rim size will be
sorted by the secondary sort order instead.

Note: You can enter up to four sort codes. When a sort code cannot
be used to perform a task or organize information on a report,
it’s disabled.

Active Items Only Lets you include active items in the search.

Include
Discontinued Items

Lets you include discontinued items in the search.

Descending Lets you display the items retrieved by the search from the highest to
lowest. The items that match the primary sort order will be displayed in
descending order first followed by those matching the secondary sort
order, and so on.

Note: Because TireMaster is designed to always display quantities
on the Inventory List from highest to lowest, this check box is
disabled when the letterQ is the only code entered in the Sort
field.

Name Lets you change the name of the selected tab.

Note: This button is visible only when accessing the Custom
Inventory Lookup screen from the Setupmenu.

Clear Removes codes that have been entered in the Start and End
columns.

OK Functions in one of the following ways:

From the Inventorymenu, begins the search for items.
From the Setupmenu, saves changes to the screen.

Cancel Functions in one of the following ways:

From the Inventorymenu, lets you stop the search for items.
From the Setupmenu, lets you cancel changes to the screen.

241



242

User Guide

CONFIGURE THE CUSTOM INVENTORY LOOKUP SCREEN
The TireMaster startup database includes the following tabs: Standard, Receiving, Pricing, Editing,
andOther. You can tailor each tab for the various tasks in which you search for items. For example,
you can set up one tab for point of sale and another for ordering from vendors. The settings for the
Custom Inventory Lookup screen can differ for each workstation.

Note: The settings on the first tab determine how items are retrieved when searching with the down-
arrow lookup method. For more information, see Down Arrow Lookup Method on page 9.

To configure the Custom Inventory Lookup Screen
1. Select Setup > Inventory Lookup. The Custom Inventory Lookup screen opens.

2. To rename a tab, click the tab and then click Name. TireMaster prompts you to name for a name.
3. Type the new name for the tab and clickOK.

Tip: To avoid having to scroll right to see the name of tab 5, use short names for all of the tabs.

4. To modify the rows on a tab, click the row you want to change. Then click , and select a search
option from the drop-down.

5. Repeat step 4 until the search options you want to use are listed.

Tip: To save time at the counter, set up the Custom Inventory Lookup screen so the prompts
are listed in order of importance for each task. For example, you could list the Size Range
prompt first for a point of sale tab, while Product Code Range could be used first a tab for
receiving inventory.

6. Using the codes to the right of the Sort field, type the sort order. For example, to sort by rim size,
quick look code, and best price, type R3B.

7. Select or clear the following check boxes as needed:

To include active items in searches by default, select the Active Only check box.
To include discontinued items in searches by default, select the Include Discontinued Items
check box.

To display items from the highest to lowest order by default, select the Descending check box.
Note: Descending order is associated with the first code typed in the Sort field (step 6). For

example, if you type in the code BR3, best price will be displayed in descending order.

8. To set up the remaining tabs, repeat steps 2 through 6.

9. To save the screen configuration, clickOK.

ENABLE THE CUSTOM INVENTORY LOOKUP SCREEN
Before you can use the Custom Inventory Lookup screen, you need to enable it in System Controls.

To enable the Custom Inventory Lookup Screen
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Inventory tab.
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3. Scroll down to the Custom Inventory Lookup setting and see if it is set to Yes. If it is not, press
Enter and select Yes.

4. Close the System Controls screen.

THE INVENTORY LIST
The Inventory List displays the items retrieved by inventory searches. This screen includes several
details about retrieved items, including size, description, quantities, and price and cost information.
Because there is much information on the screen, you can make it easier to work with by adjusting the
layout and sorting the columns.

MOVE AND RESIZE INVENTORY LIST COLUMNS
Although you can view various columns on the Inventory List by scrolling, you might prefer to change
the layout by moving and resizing some columns. When you’re done changing column size, position,
or both, you can save the updated layout.

Note: The new layout affects only the workstation on which changes were made. Therefore, the
columns on the Inventory List can be moved and resized differently for each computer.

To move and resize Inventory List columns
1. Search for an item. The Inventory List opens. For more information, see Inventory Searches on

page 230.

2. To move a column, click the column heading. When the thick, black line appears, drag the column
to a different position.

3. To resize a column, move the pointer ( ) to the boundary line for the column heading. When the
pointer turns into drag the boundary to the new width.

4. When you’re done moving and resizing the columns, click Save Layout. The Inventory List
columns will be displayed in the new arrangement until the layout is changed.

Note: The Save Layout button is available only to users who belong to security groups that are
assigned the Save Screen Layout permission.

SORT THE INVENTORY LIST
When you look up items, you can use sort codes to define how they should be organized on the
Inventory List. Once the items have been retrieved, however, you might want to sort the items again.
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To sort items retrieved in a search, click one of the column headings on the Inventory List (Figure 10-
8). To change the order from highest to lowest or the other way around, click the heading again.

Figure 10-8: Sorting Inventory List Columns

INVENTORY HISTORY
Sales and receiving history is available for inventory items in TireMaster. Sales history lists invoices
created when items were sold or returned, and receiving history includes vendor invoice documents
created when items were priced. When looking at an item’s history, you can also see if the item is
currently on work orders or set aside for upcoming appointments. Item history is can be viewed on the
Inventory Maintenance screen and the Inventory List.

VIEW HISTORY IN AN ITEM'S INVENTORY RECORD
One way to view an item’s history is to retrieve the inventory record for that item. Looking up history in
this manner offers the following advantages:

You can reprint each of the sale and vendor invoices associated with the item.

You can view journal entries generated when the item was sold or received.

You can see the description included on each of the sale and vendor invoices associated with
the item.

Note: For noninventoriable items, these descriptions can vary.

To view an item’s history in its inventory record
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

2. Search for the item whose history you want to view. For more information, see Inventory Searches
on page 230.

3. On the Inventory Maintenance screen, click the History tab.
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4. Select Sales History, Receiving History, orWork Orders.

Note: Work order history includes items that have been set aside for scheduled appointments.
The document type code SA is assigned to those items. If an appointment expires without
becoming a completed invoice, the item’s appointment quantity will continue to affect the
quantity on work order until the appointment is deleted.

5. To define the maximum number of documents displayed, select one of the radio buttons in the
lower-right corner of the screen.

Note: The numbers assigned to the first two buttons are defined by a pair of system controls. For
more information, see Grid Control - Limit 1 on page 1212 and Grid Control - Limit 2 on
page 1213.

6. Select a document.

7. To view and reprint the selected document (for sales history and receiving history only), click
Reprint.
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In some instances, the following occurs:
If both a purchase order and a vendor invoice document were created for the item, TireMaster
prompts you to select which document to print (receiving history only).

If the item was returned to a vendor, TireMaster prompts you to define whether you want to
print the vendor invoice document or inventory return document (receiving history only).

8. To view journal entries generated when the item was sold or received, click Research.

VIEW HISTORY FROM THE INVENTORY LIST
You can access an item’s history from the Inventory List. Therefore, you can look at the item's
historical details as you’re placing it on a work order, quote, purchase order, or receiving document.
With this method of viewing an item's history, you can see the following:

How much you previously charged customers for the item

What you paid a vendor when you bought the item

The work orders and appointments to which the item is assigned

Note: To view the cost and federal excise tax in an item’s receiving history, you need to be assigned
the Inventory View/Edit Cost permission.

To view an item’s history from the Inventory List
1. Search for an item as a standalone operation or as part of a another task. For more information,

see Inventory Searches on page 230.

2. When the Inventory List opens, select the item and click History. The Inventory History screen
opens.
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3. Select Sales History, Receiving History, orWork Orders.

Note: Work order history includes items that have been set aside for scheduled appointments.
The document type code SA is assigned to those items. If an appointment expires without
becoming a completed invoice, the item’s appointment quantity will continue to affect the
quantity on work order until the appointment is deleted.

4. To define the maximum number of historical documents or work orders displayed, select one of the
radio buttons (bottom left).

5. Close the Inventory History screen.

6. On the Inventory List, select an item and continue the task you initially started.

PHYSICAL COUNTS
Taking a physical count is a multi-step process. It includes generating a list of items, counting the
items, and making adjustments when there are discrepancies between the number of items counted
and the number of items in TireMaster.

PRINT AN INVENTORY COUNTING DECK
A counting deck is a list of items from your TireMaster system. When you take inventory, you can print
one large counting deck or you might find it easier to generate separate lists for groups of items, such
as those from a specific manufacturer or product line.

Whether you include quantities on your counting deck depends on who will use it. For control clerks,
you might want to include on-hand quantities so they can compare the physical count to the system
count. For counters, ASA recommends excluding on-hand quantities.

Note: The following instructions describe printing a counting deck from the Quantity Adjustment
Wizard. For instructions on printing it from the Report List, see Inventory Counting Deck on
page 999 or Inventory Counting Deck w/ QTY on page 999.

To print a counting deck
1. Select Inventory > Qty Adjustment Wizard. The Qty Adjustment Wizard opens.
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2. Make sure the Select Items tab is selected.
3. Click Select Items and look up the items you want to count. TireMaster displays the number of

items retrieved by the search in the Number of Items Selected field. For more information, see
Inventory Searches on page 230.

Note: Look up only the items that you can count before the store opens for business. Otherwise,
the count will be off for any items that are sold or put on work orders.

Tip: Write down the range and sort order used for the counting deck. If you need to adjust
inventory quantities, you'll be able to list items on the screen in the same order as the
printed report.

4. Click Inventory Counting Deck. TireMaster prompts you to print on-hand quantities.

5. Depending on whether you want to include on-hand quantities, click Yes or No. The Report
Window opens.

6. Print the counting deck and close the Report Window.

7. To print a counting deck for an additional group of items, repeat steps 3 through 6.

8. To exit the Qty Adjustment Wizard screen, click Cancel.
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9. When the confirmation message appears, click Yes to cancel the wizard.

COUNT THE ITEMS
The second part of taking inventory is the physical count, the step in which you count items to see how
many you actually have. An item’s actual count includes the following:

The number of items received into inventory (both priced or not priced)

The number of items on work orders and in the shop

The number of the items on work orders but not in the shop (for example, items that have been
loaded on a service truck)

Note: If an item is still in the shop, but it has already been paid for, do not include it in the physical
count.

To count the items
1. Starting with the first item on the counting deck, count the number of units, and write down the

actual quantity.

Note: The actual count includes items on work order (both mounted and not mounted) and items
not on work order. These items can be either in the shop or at another location. If an item is
still in the shop but has already been paid for, do not include it in the physical count.

Tip: If you included quantities on the counting deck, remember that the number in theOn W/O
column is included in theQuantity column.

2. Repeat step 1 for each remaining item.

3. Go through the counting deck and circle any items whose system quantity does not match your
count. You need to make a quantity adjustment for these items before you resume business.

ADJUST INVENTORY QUANTITIES
If the number of items from the physical count don’t match the system generated count in TireMaster,
adjust the quantities with the Inventory Quantity Adjustment Wizard. When an adjustment is
performed, the updated on-hand quantity is difference between the physical count and the quantity on
work order.

Note: ASA recommends printing an Inventory Checkup Report before making quantity adjustments.
If the report identifies discrepancies between the system-generated inventory quantities and
the sales, receiving, and adjustment activity for items, contact TireMaster Support.
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Warning: The Inventory Quantity Adjustment Wizard is only to be used during the process of taking
inventory or on other occasions when an item’s quantities need to be changed. Do not use
it to enter start-up quantities, return items to vendors, correct purchase orders, or set up
consignment items. Doing so permanently invalidates the system-calculated cost for each
item.

To adjust inventory quantities
1. Select Inventory > Qty Adjustment Wizard. The Qty Adjustment Wizard opens.

Note: Inventory quantities must be adjusted after taking the physical count, but before you
receive items and sell items. Otherwise the adjustment will not correct the item’s on-hand
quantity.

2. Make sure the Select Items tab is selected.
3. Click Select Items and look up the items or a group of items that were counted. For more

information, see Inventory Searches on page 230.

Tip: Look up the items with the range and sort order that were used for printing the counting
deck. Using the same search parameters helps to ensure that product codes and
descriptions will be listed on the screen in the same order as the counting deck.

4. Click Next to move to the Update Quantities tab.

5. If an item’s system-generated count differs from the actual count, type its actual count and press
Enter. The item’s row turns blue.
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Note: Do not type the difference between the system-generated count and the actual count. If an
item’s actual count needs to be adjusted to zero, type a 0.

6. If you need to undo an adjustment, select the item and click Cancel Line. The blue highlighting
disappears.

7. Compare the numbers entered on the screen to the counting deck to ensure you’ve entered the
correct quantities for the items that needed to be adjusted.

8. Adjust quantities for another group of items if needed.

a. Click Back to return to the Select Items tab.

b. Repeat steps 3 through 7.

9. Once you’ve entered all of the necessary adjustments, click Finish. The Report Window opens.

10. Print and review the Physical Count Edit report.
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11. Close the Report Window. A confirmation message appears.

12. Do one of the following:
To complete the adjustment, click Yes. Clicking Yes will update the system-generated on-hand
quantities and adjust the item’s value in the general ledger.

Note: Once an adjustment is completed, you can view adjustment details in the subledger for
the Inventory Quantity Adjustment vendor.

To complete the adjustment, click Yes. Clicking Yes will update the system’s on-hand
quantities.

If you don’t want to adjust the quantities, click No.

ADD-ON PACKAGES
With add-on packages (referred to as add-ons), you can automatically include additional items and
services such as alignments, warranties, and disposal fees on a customer's work order. Using add-on
packages includes the following benefits:

It reduces the amount of time needed to create work orders, because you don’t have to add
each item one at a time.

It can help you increase sales, because add-on packages remind you to suggest additional
items and services to customers.

It can help to prevent liability by prompting you to recommend services that, if declined, might
compromise a customer’s safety.

Note: Whether add-ons are included on a work order depends on the customer type assigned to the
customer. For some customer types, add-ons are disabled. For more information, see
Customer Types on page 98 and Customer Type Edit Screen on page 102.

ANATOMY OF AN ADD-ON PACKAGE
An add-on is made up of an add-on code and one or more items. Add-on codes are displayed at the
top of the Add-On Code List, and the items assigned to each of the add-on codes are listed toward the
bottom (Figure 10-9). The items assigned to an add-on code are called add-on items.
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Figure 10-9: The Add-On Code List

Add-on codes can be assigned to one or more items in your inventory. In the following image (Figure
10-10), the add-on code LT is assigned to a tire.

Figure 10-10: The Add-On Code Assigned to a Tire

The items that add-on codes are assigned to are referred to as parent items, and they are the main
items put on work orders. Tires and oil changes are two examples of parent items. When you put a
parent item on a work order, the items linked to its add-on code (the add-on items) are also added to
the work order automatically. If a customer doesn’t want to purchase an add-on item, you can delete it
from the work order. On the Invoice Entry screen, the lines for parent items are green and lines for
add-on items are white (Figure 10-11).
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Figure 10-11: A Parent Item and It's Add-On Items

CREATE ADD-ON CODES
The first step in setting up add-ons is creating the add-on codes that can be assigned to (parent) items.
The items that add-on codes are assigned to are called parent items. When parent items are sold, the
add-on codes prompt TireMaster to automatically include additional items on work orders.

To create an add-on code
1. Select Inventory > Add-On Codes. The Add-On Code List opens.

2. Click New Code. The Add-On Header Edit screen opens.

3. Type a two-character code in the Add-On Code field.
Note: Once you clickOK, this code cannot be changed.

Tip: Name add-on codes based on the type of parent items they’ll be assigned to, such as light-
truck tires. This naming method helps others understand which add-on codes to assign to
parent items.

4. Type a description for the add-on code.
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5. ClickOK. Now you can assign items to the new add-on code. For more information, see Assign
Items to Add-On Codes on page 256.

MANAGE EXISTING ADD-ON CODES
You can change the description of existing add-on codes and delete add-on codes that are unused.

CHANGE AN ADD-ON CODE'S DESCRIPTION
If you don’t like the description for an add-on code, you can change it. However, the add-on code
itself cannot be edited.

To change an add-on code's description
1. Select Inventory > Add-On Codes. The Add-On Code List opens.

2. Select the code whose description you want to change, and click Edit This Code.

3. Type the new description, and clickOK.
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DELETE AN ADD-ON CODE
Add-on codes that are not assigned to any items can be deleted.

To delete an add-on code
1. Select Inventory > Add-On Codes. The Add-On Code List opens.
2. Select the code you want to delete, and click Delete.
3. When the confirmation message appears, click Yes. The code is removed from the database.

4. Close the Add-On Code List.

ASSIGN ITEMS TO ADD-ON CODES
The second step in creating add-on packages is assigning items to the add-on codes. When you
assign items to an add-on code, you need to define whether they'll be sold at the same quantity as the
parent item or at a fixed quantity. For example, although you sell a set of four tires, you perform only
one alignment check.

You also need to decide whether to sell add-on items at their regular prices or a percentage of the
parent item’s price. The prices and quantities of add-on items can be overridden at point of sale if
needed.

Note: You can assign items to an add-on code as soon as the code is created. However, if you are in
the process of going online, you need to wait until all your items are set up before you can
assign items to add-on codes.

To assign items to an add-on code
1. Select Inventory > Add-On Codes. The Add-On Code List opens.

2. Select the code to which you'll assign items (top of screen), and click Add Item to Code (lower
left). The Add-On Item Edit screen opens.
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3. Click Lookup, and search for the item you want to assign to the add-on code. For more
information, see Inventory Searches on page 230.

4. Define whether the settings for an add-on item are only applicable for a particular site, if needed.
Click the Site # field, press , and select the site from the Site List. Otherwise disregard this step.

5. Set a price percentage and fixed quantity as needed:

To sell the add-on item at a percentage of the parent item’s price, type the percentage in
decimal form (such as 5.5) in the Percent field. Otherwise, leave the percentage set to 0.00.

To sell the add-on item at a fixed quantity, type the quantity in the Fixed Qty field. Otherwise,
leave the quantity set to 0.

6. To exclude the add-on item from tax-exempt invoices, select the Add only if parent item is
taxable check box. Otherwise, leave the check box alone.

7. To include the add-on item in quoted prices, select the Appear selected when added to quotes
check box. Otherwise, leave the check box alone.

8. ClickOK.
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9. To assign additional items to the add-on code, repeat steps 2 through 8.

10. Close the Add-On Code List.

UPDATE AN ADD-ON ITEM
If you need to change the percentage, quantity, or tax settings for an add-on item, update its settings.

To update an add-on item
1. From the Inventorymenu, select Add-On Codes. The Add-On Code List appears.

2. Select the code that’s assigned the add-on item you want to update (top list).

3. Select the item (lower list), and click Edit This Item. The Add-On Item Edit screen opens.

4. Make the needed changes to the percentage, quantity, and tax settings.

5. ClickOK.

REMOVE AN ADD-ON ITEM FROM AN ADD-ON CODE
If an item should no longer be assigned to an add-on code, you can remove the add-on item from the
add-on code.
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To remove an add-on item from an add-on code
1. Select Inventory > Add-On Codes. The Add-On Code List opens.

2. Select the code that is assigned the add-on item you want to remove (top list).

3. Select the add-on item (lower list), and click Delete This Item A confirmation message appears.

4. Click Yes. The add-on item is removed from the add-on code.

ASSIGN ADD-ONS TO PARENT ITEMS
An add-on code defines which additional items to sell when an item is sold. The add-on code is one of
many settings that you can assign to an item on the Inventory Maintenance screen.

Note: Although an add-on code may be assigned to an item, the add-on items might excluded from
the work orders for some customers. This happens when the add-ons are disabled for a
customer type. For more information, see Customer Types on page 98 and Customer Type
Edit Screen on page 102.

To assign an add-on code to an item
1. Look up the item you want to assign the add-on code to. For more information, see Inventory

Searches on page 230.

2. On the Inventory Maintenance screen, make sure theGeneral tab is selected and click Edit.
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3. Click the Add-On/Kit Code field, press , and select an add-on code from the list.

4. To save your changes, clickOK.
5. Close the Inventory Maintenance screen.



INVENTORY REPLENISHMENT
In TireMaster, items are ordered and received into inventory with the PO system. This chapter includes
the following sections:

Purchase Orders 262
Inventory Receipts 274
PO System Screen 292
Item Tracking 297
Item Tracking Screen 317
Outside Purchases 322
FET Handling for POs and Receivings 327
Inventory Returns 328
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PURCHASE ORDERS
To order items, you need to create a purchase order and add items to it. For the purposes of
replenishing inventory, the corporate site and the stores can each have different levels of control.

Example: The corporate site could be authorized to create purchase orders for all stores, while a
store would only be allowed to create purchase orders for itself. For more information, see Purchas-
ing in TireMaster Corporate on page 959.

CREATE A PURCHASE ORDER
The first step in the inventory replenishment process is creating a purchase order. The information on
a purchase order defines which items you want to buy from a vendor and is used to produce receiving
documents when your vendors deliver items.

To create a purchase order
1. Select Inventory > PO & Receiving. The PO System opens.

2. Make sure the Purchase Orders tab is selected.

3. Click Add. TireMaster prompts you for the vendor's name.

4. Search for the vendor you want to order from and clickOK. The Purchase Order screen opens. For
more information, see Vendor Searches on page 193.

5. If you have it, type the reference number for the purchase order.



Purchase Orders

6. For each item you want to order, click Add and look up the item or scan its bar code. For more
information, see Inventory Searches on page 230 or Enter Bar Codes on Purchase Orders and
Receiving Documents on page 350.

Tip: You can also use the down-arrow lookup method to add items to purchase orders. For
more information, see Down Arrow Lookup Method on page 9.

7. For each item added to the purchase order, do the following:

a. Type the quantity.

b. Change the price (your cost) if needed.

Note: If you’re ordering items in bulk, such as valve stems, TireMaster can calculate the cost
for each item. For more information, see Calculate an Item’s Per-Unit Cost on page
267.

c. Change the federal excise tax if needed.

Note: A system control defines whether the FETax column displays the average cost of an
item’s federal excise tax or the FET used the last time the item was received. For more
information, see Use Next FET for POS/Receivings on page 1209.

8. Add shipping and handling information as needed:

a. Type the shipping method or courier’s name, along with the tracking number.

b. Under FOB, select Source if you will pay for the freight or Destination if the vendor will pay for
the freight.

c. Type the contact person’s name.
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9. When you’re done adding items to the order, do one of the following:

To complete the order, clickOrder.
To close the order and complete it later, click Close.

Note: An order that will be completed later is called an open order.

ADD AND ORDER NEW ITEMS AT THE SAME TIME
If you need to order an item that isn’t in your inventory, you can add it to TireMaster and the purchase
order at the same time. Because this process is the almost the same as adding items to TireMaster
and a receiving document, see Add and Receive New Items at the Same Time on page 286 for
instructions.

REMOVE AN ITEM FROM A PURCHASE ORDER
If you decide that you don't want to order an item on a PO, you can remove the item.

To remove an item from a purchase order
1. If the purchase order isn’t already open, do the following.

a. Select Inventory > PO & Receiving. The PO System opens.

b. Make sure the Purchase Orders tab is selected.
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c. To display all orders that haven’t been placed, select the statusOpen.

d. Select the purchase order with the item you want to delete, and click Edit.

2. Select the item you want to remove and click Delete.

3. When the confirmation message appears, click Yes.
4. Add new items to the purchase order if needed or close the Purchase Order screen.
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UPDATE AN OPEN PO
If an order hasn't been placed, you can update the vendor, items, and other information on the open
PO.

To update an open PO
1. Select Inventory > PO & Receiving. The PO System opens.

2. Make sure the Purchase Orders tab is selected.

3. To display all open purchase orders, select the statusOpen.

4. Select the purchase order you want to update and click Edit.

5. Do the following as needed:

Click and look up a different vendor.

Change the quantity for an item on the order. If you want to use the per-unit cost for bulk items,
see Calculate an Item’s Per-Unit Cost on page 267.
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Click Add and search for an additional item to put on the order.

Select an item you want to remove from the order and click Delete.
Change the reference number, contact name, and shipping information.

6. If you want to place the order, clickOrder and print a copy of the PO. Otherwise, click Close.

CALCULATE AN ITEM’S PER-UNIT COST
When you buy items in bulk, such as valve stems, TireMaster can calculate the per-unit cost for each
item.

To calculate an item’s per-unit cost
1. Start a purchase order or receiving document. For more information, see Create a Purchase Order

on page 262 or Create a Receiving Document on page 284.

2. Select the item whose per-unit cost you want to calculate, and click Unit Price. The Per Unit Price
screen opens.

3. Type your cost for a case of the item in the Parts Price field.
4. Type the number of items in the case in theQuantity field. TireMaster displays the cost of each

item in the Per Unit Price field.
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5. ClickOK. The per-unit quantity and cost information is added to the purchase order.

CANCEL AN ITEM ON A PURCHASE ORDER
If you’ve placed an order and then find out that an item won’t be shipped, you can cancel the item on
the order.

To cancel an item on a PO
1. Select Inventory > PO & Receiving. The PO System opens.

2. Make sure the Purchase Orders tab is selected.

3. To display the POs for orders that have been placed, select the statusOrdered.

4. Select the order with the item that won’t be shipped, and click Edit. The Purchase Order screen
opens.
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Note: Items can be canceled only from purchase orders with the status color yellow (for ordered).

5. Select the item that won’t be shipped, and click Cancel. A confirmation message appears.

6. Click Yes. The status of the item changes to Canceled ( ).

7. Close the Purchase Order screen. When you create a receiving document for this order, the
canceled item will no longer be on the order.

REOPEN AND UPDATE ORDERS
If your TireMaster system is set up to allow purchase orders to be reopened and edited, you can make
changes to an order that has already been placed. By reopening and updating an order, you can
ensure that the purchase order data in TireMaster matches any changes the vendor has made to a
pending shipment. Reopening a PO reduces the amount of time it takes to receive an order, because
you won’t need to back order items or add items to the receiving document.

Note: The ability to reopen and update orders is defined by a system control. For more information,
see PO System - Re-Open Ordered POs on page 1207 .

To reopen and update an order
1. Select Inventory > PO & Receiving. The PO System opens.
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2. Select the statusOrdered.

3. Select the purchase order you want to update, and click Edit. The Purchase Order screen opens.

4. Click Re-Open. TireMaster closes the Purchase Order screen and returns to the main PO System
screen.

5. Make sure the purchase order you want to update is selected, and click Edit (again).
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Note: The status of the PO changed from ordered (yellow) to open (green) when you re-opened
it.

6. Do the following as needed:

Add items to the reopened order.

Delete items from the reopened order.

Update the prices of items on the order.

7. ClickOrder. The Report Window opens and displays a copy of the purchase order.

8. Print the purchase order and close the Report Window.

REORDER INVENTORY
You can simplify the reordering process by creating a suggested purchase order. Creating a
suggested purchase order includes generating a report that shows the difference between the
minimum quantities you’ve set for your items and the actual quantities you have on hand. Once you’ve
generated the report, you can create a purchase order based on its results.

To generate a suggested reorder
1. Select Inventory > Suggested Reorder & PO. TireMaster prompts you to search for items.
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2. Look up a group of items that you to include on the report. For more information, see Inventory
Searches on page 230. The Suggested Reorder Report appears in the Report Window.

3. Print the report.

4. Write the quantities you want to order on the report.

5. Close the Report Window. A confirmation message appears.

6. Do one of the following:

To create a purchase order based on the Suggested Reorder Report, click Yes. TireMaster
prompts you to look up a vendor.

If you do not want to create a PO yet, click No and disregard the rest of this procedure.
7. Search for the vendor you want to order from. For more information, see Vendor Searches on page

193. The Purchase Order screen opens. All of the items from the Suggested Reorder Report are
included on the order at the recommended reorder quantities.

8. Make the following changes as needed:

Add items to the PO.

Delete items from the PO.
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Change quantities and prices.

Fill in the shipping information, contact name, and reference number.

9. When you’re finished making changes to the purchase order, do one of the following:

To complete the order, clickOrder. The purchase order appears in the Report Window so you
can print it.

To save the purchase order without completing it, click Close.

CANCEL A PURCHASE ORDER
In some cases, you might start an order only to find that it is unnecessary later. You can cancel
purchase orders if the items on it have not been ordered or received.

To cancel a purchase order
1. Select Inventory > PO & Receiving. The PO System opens.

2. Make sure the Purchase Orders tab is selected.

273



274

User Guide

3. Select the statusOpen. All open purchase orders appear on the screen.

4. Select the purchase order you want to cancel and click Delete. A confirmation message appears.

5. Click Yes.
6. Close the PO System screen.

INVENTORY RECEIPTS
When an order is delivered, you need to receive the items in TireMaster's PO System. Deliveries
typically have a corresponding purchase order. Sometimes, however, you might need to receive items
that were not put on a purchase order. In that scenario, you can create a receiving document.

Note: Your system control settings define whether you're allowed to create a receiving document
without a corresponding purchase order. For more information, see Force PO System to
Create New PO on page 1212.

RECEIVE ITEMS ON A PURCHASE ORDER
When you receive an order, TireMaster creates a receiving document that duplicates the items and
quantities on the original PO. You can create a receiving document regardless of whether the order
was delivered with a packing slip or a vendor invoice.
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Note: When you do not have a purchase order for a shipment, you need to create a receiving
document from scratch. For more information, see Create a Receiving Document on page
284.

To receive items on a purchase order
1. Select Inventory > PO & Receiving. The PO System opens.

2. Make sure the Purchase Orders tab is selected.

3. Select the statusOrdered. TireMaster displays the purchase orders for items that have not been
received.

4. Select the PO with the items you want to receive and click Receive. The Receiving Document
screen opens.

Note: If a receiving document already exists for an order, TireMaster asks if you want to create
another receiving document. Write down the RD number on the message and click No.
Then click the Receiving Documents tab and select the receiving document that was
referenced on the message.
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5. Update the reference number and the shipping and contact information if needed.

6. Update the quantities, cost, and federal excise tax for the items if needed.

Note: If you’ve ordered items in bulk, such as valve stems, TireMaster can calculate the cost for
each item. For more information, see Calculate an Item’s Per-Unit Cost on page 267.

Tip: To view the quantity and cost used for an item on the original purchase order, select the
item and clickOrder Info.

7. If you want to receive items (from the selected vendor) that are on a different purchase order, click
Add PO. Then select the purchase order that includes those items and clickOK.

8. Enter shipping charges if needed, using one of the following methods:

If there is shipping charge for individual items, type the amount in the Freight column for each
line item. The value entered here is included in the item’s cost when it posts to the general
ledger.

If there is a shipping charge for the entire order, type the amount in the Freight field (lower-right
corner of the screen). The value entered here posts to the general ledger’s freight account).
You can select the freight vendor when you enter the vendor invoice.
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9. Click Receive. The following message appears: Do you want to price this RD now?”

Note: Depending on your system control settings, you might be required to add a reference
number if you haven’t already.

10. Do one of the following:
If you have an invoice from the vendor, click Yes to price the items. For further instructions, see
Price Items on a Receiving Document on page 277.

If the shipment included a packing slip but no vendor invoice, click No. When the receiving
document appears in the Report Window, print a copy of it. The items that you just received will
not be added to the inventory until you price them.

PRICE ITEMS ON A RECEIVING DOCUMENT
When a vendor sends you an invoice, you can enter the prices (your cost) for the items on a receiving
document. This process, referred to as pricing items, updates the last cost and next cost tracked by
TireMaster. Items should be priced before you sell them.

Note: Users at a store can price items for their store only, as long as settings in System Controls
allow it.

To price items on a receiving document
1. Select Inventory > PO & Receiving. The PO System opens.

2. Select the Receiving Documents tab.
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3. Select the status Received (Un-Priced). TireMaster displays the receiving documents with items
that have not been priced.

4. Select the receiving document for the items you want to price and click Price. The Vendor Invoice
screen appears.

5. Update the receiving date, default due date, discount date, discount amount, and reference
number if needed.

Note: Discount terms are used only in TireMaster Plus and TireMaster Corporate. Depending on
how the system controls are set, you might be required to add a reference number if you
haven’t already.

6. If you need to update the prices (your cost) for any of the items, click Edit Prices. Then type the
new amounts on the Vendor Invoice Price Editing screen. TireMaster automatically recalculates
the extended prices along with the total and discount amount.
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7. Define the payment method:

To pay with cash, type the amount of the cash payment in the Cash field. TireMaster
recalculates the amount in the Charge field.
To charge the total amount of the vendor invoice, leave the amount in the Charge field alone
and disregard any system-calculated discounts.

8. If you need to change the number of payments, select 1, 2, 3, 4, or select Define and type the
number of payments.

9. If you entered a shipping charge when receiving the items, click and look up the freight
vendor. For more information, see Vendor Searches on page 193.

Note: A vendor charge (for the amount entered when you received the order) posts to the freight
vendor’s subledger and the freight account in the general ledger.

10. Click Complete.
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One of the following happens:

If you must pay the entire amount at one time, the vendor invoice document (VID) appears in
the Report Window.

If you'll make multiple payments, the Vendor Payment Schedule screen opens. Change the
payment amounts and dates if needed and clickOK.The vendor invoice document (VID)
appears in the Report Window.

Note: The totals of the Payment Amt and Discount Amt columns must equal the payment
and discount amounts on the vendor invoice document before the order can be priced.

11. Print the vendor invoice document (VID). TireMaster adds the VID to the Historical Vendor
Invoices tab, and the receiving document's status color changes to gray (S column of the
Receiving Documents tab) to indicate the items have been priced.

BACK ORDER ITEMS
When the number of items delivered doesn’t match the number of items ordered, you can receive the
portion of the order that was shipped and place the unreceived quantities on back order.

PUT PARTIAL QUANTITIES ON BACK ORDER
When you receive a partial order, you can receive the quantities that were delivered and place the
remaining quantities on back order.

To put partial quantities on back order
1. Select Inventory > PO & Receiving. The PO System opens.

2. Select the Purchase Orders tab.
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3. Select the statusOrdered.

4. Select the purchase order with the back ordered items and click Receive. The Receiving
Document screen opens.

5. For each item that you need to put on back order, enter the quantity that was actually received.

Tip: To see the quantity and cost used for an item on the original purchase order, select the
item and clickOrder Info.

6. Click Receive. TireMaster prompts you to price the receiving document.

Note: Depending on how the system controls are set, you might be required to add a reference
number if you haven’t already.
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7. Do one of the following:

If you have an invoice from the vendor, click Yes. The Vendor Invoice screen opens, and you
can price the items. For more information, see Price Items on a Receiving Document on page
277.

If you only have a packing slip, click No and print the receiving document. When TireMaster
prompts you to cancel the remaining quantities, click No to back order (instead of canceling)
the items.

8. Close the PO System screen.

PUT ALL QUANTITIES ON BACK ORDER
When one of the items on a purchase order is not delivered, you can place all quantities of that item
on back order.

To place all quantities of an item on back order
1. Select Inventory > PO & Receiving. The PO System opens.

2. Select the Purchase Orders tab.

3. Select the statusOrdered.

4. Select a purchase order and click Receive. The Receiving Document screen appears.
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5. Select the item you need to put on back order and click Delete. A confirmation message
appears.

Tip: To view the quantity and cost used for an item on the original purchase order, select the
item, and clickOrder Info.

6. Click Yes. TireMaster prompts you to cancel the item.
7. To place the item on back order (instead of canceling it), click No. The item is removed from the

receiving document.

8. To receive the remaining items on the receiving document, click Receive. TireMaster prompts
you to price the receiving document.
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Note: Depending on how the system controls are set, you might be required to add a reference
number if you haven’t already.

9. Do one of the following:

If you have an invoice from the vendor, click Yes. The Vendor Invoice screen opens, and you
can price the items. For more information, see Price Items on a Receiving Document on page
277.

If you only have a packing slip, click No and print the receiving document. The receiving
document is added to the Receiving Documents tab.

CREATE A RECEIVING DOCUMENT
When a delivery is comprised of items you didn't order, you can skip the ordering stage and create a
receiving document from scratch.

Note: Your system control settings define whether you're allowed to create a receiving document
without a corresponding purchase order. For more information, see Force PO System to
Create New PO on page 1212 .

To create a receiving document
1. Select Inventory > PO & Receiving. The PO System opens.

2. Select the Receiving Documents tab.

3. Click Add. TireMaster prompts you to search for a vendor.
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4. Look up the vendor who sent you the shipment. The Receiving Document screen opens. For more
information, see Vendor Searches on page 193.

Note: You can change the vendor for a receiving document until you complete the receiving.

5. If it's available, type the reference number for the delivery.

6. For each item delivered, click Add and search for the item or scan its bar code. For more
information, see Inventory Searches on page 230 or Enter Bar Codes on Purchase Orders and
Receiving Documents on page 350.

7. For each item added to the receiving document, do the following:

Update the description (noninventoriable items)

Type the quantity.

Update the price (your cost)

Note: If you’re receiving items in bulk, such as valve stems, TireMaster can calculate the cost
for each item. For more information, see Calculate an Item’s Per-Unit Cost on page
267.

Update the federal excise tax (FET)

Note: A system control setting defines whether the FETax column displays either the
average cost of an item’s federal excise tax or the FET used the last time the item was
received. For more information, see Use Next FET for POS/Receivings on page 1209.

8. Complete the following shipping and handling information:
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a. Under FOB, select Source if you will pay for freight or Destination if the vendor will pay for
freight.

b. If it's available, type the contact person’s name.

9. Click Receive. TireMaster prompts you to price the receiving document.

Note: Depending on how the system controls are set, you might be required to add a reference
number if you haven’t already.

10. Do one of the following:
If you have an invoice from the vendor click Yes. The Vendor Invoice screen appears, and you
can price the items. For more information, see Price Items on a Receiving Document on page
277.

If you only have a packing slip, click No and print the receiving document. The receiving
document is added to the Receiving Documents tab.

11. Close the PO System screen.

ADD AND RECEIVE NEW ITEMS AT THE SAME TIME
If you need to receive an item that isn’t in your inventory, you can add it to TireMaster and an open
receiving document at the same time.

Note: You can also add items to TireMaster when creating a purchase order by following steps 2
through 9 of this process.

To add items while creating a receiving document
1. Create a receiving document for the vendor if one hasn’t already been created. For more

information, see Receive Items on a Purchase Order on page 274 or Create a Receiving
Document on page 284.

2. Click Add Inventory. TireMaster prompts you to search for items.
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3. Do one of the following:

Look up an item with settings similar to the item you need to add. For more information, see
Inventory Searches on page 230.

Tip: Looking up a similar item saves time, because you can reuse many of its settings for
the new item.

Click Cancel, and then click Add on the Inventory Maintenance screen.
4. Type the product code for the new item and clickOK.

5. On the Inventory Maintenance screen, complete the settings for the new item. Then clickOK.
TireMaster prompts you to view and edit the prices for the new item. For more information, see
Add an Inventory Item on page 205.

6. Click Yes. The Site Prices and Quantity screen opens.
7. Complete the price settings for the item. Then clickOK. For more information, see Fixed Prices on

page 386 or Factor Based Price Calculations on page 387.
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8. To exit the Inventory Maintenance screen, click theGeneral tab. Then click Close. The new item is
added to the receiving document.

9. Type the quantity for the new item.

10. Update items previously added to the receiving document, along with the shipping and handling
information, if needed.

11. Receive the items and price the receiving document. For more information, see Receive Items on a
Purchase Order on page 274 and Price Items on a Receiving Document on page 277.

REVERSE A RECEIVING DOCUMENT
If a shipment was incorrectly received, you can reverse the receiving document for it as long as the
items have not been priced.

Note: Negative receiving documents that have been created to return items to vendors can also be
reversed as long as they haven’t been priced.

To reverse a receiving document
1. Select Inventory > PO & Receiving. The PO System opens.
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2. Click the Receiving Documents tab.

3. To display receiving documents that haven’t been priced, select Received (Un-priced). The Rev.
RD button appears in the upper-right corner of the screen.

4. Select the receiving document you want to reverse and click Rev. RD. A confirmation message
appears.

Tip: If you cannot see the Rev. RD button, make sure (Received Un-priced is selected.

Note: Receiving documents that include tracked items cannot be reversed. In this scenario,
retrieve the receiving document and complete the vendor invoice (VID). Next, create a new
receiving document, add the tracked item with a negative quantity, and enter its cost. If you
need a corrected receiving for the tracked item, add it to the receiving document as well,
with a positive quantity and cost. Then complete the vendor invoice document. If the
tracked item uses the option cost method and has been sold to a customer, include the
original invoice number in the receiving document’s reference number and item
descriptions. This will help you identify the original sale invoice on the item tracking screen.

5. Click Yes.
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Note: No vendor invoice documents are created for the original receiving or the reversal. To view
the original and reversed receiving documents, click the Receiving Documents tab. Then
select the status All. The reference number for the reversal includes the letters REV and
the reference number for the original receiving.

SEARCH FOR HISTORICAL VENDOR INVOICES
If you want to research your purchase history, you can view all historical invoices on the Historical
Vendor Invoices tab. You can search for invoices by vendor name, reference number, or document
number.

To look up a historical vendor invoice
1. Select Inventory > PO & Receiving. The PO System opens.

2. Click the Historical Vendor Invoices tab.

3. To look up the document by vendor, do the following.

a. Click and look up the vendor. For more information, see Vendor Searches on page 193.

b. Select the vendor invoice that you want to view and click Print. The Report Window opens.
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c. Print a copy of the vendor invoice document, if needed, and close the Report Window.

4. To look up a document by document number or reference number, do the following.

a. Click Find Doc.

b. Type the document number or a reference number when prompted for that information, and
clickOK.

c. Click Print. The Report Window opens.

d. Print a copy of the vendor invoice, if needed, and close the Report Window.

5. To display historical invoices for all vendors again, click Reset Vendor.
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PO SYSTEM SCREEN
In TireMaster, you manage the inventory replenishment process with the PO System screen.

PURCHASE ORDERS TAB
The Purchase Orders tab (Figure 11-1) lists the POs created when orders were placed. Purchase
orders include the items you want to buy from vendors, along with the quantities needed and the prices
(your cost) for the items. The inventory replenishment process often begins by creating a purchase
order. Users at the corporate site can view all purchase orders and users at a store can view only the
POs created at that store.

Figure 11-1: PO System Screen Purchase Orders Tab

Item Description

Vendor Displays only the purchase orders for the selected vendor.

Clicking this button lets you display only the purchase orders for a specific
vendor.

Find Doc Lets you search for a purchase order by entering its reference number or
its system-generated document number.

Reset Vendor Lets you remove the name entered in the Vendor field, so you can view
purchase orders for all vendors.

Filter Off Disregards the setting for the maximum number of documents displayed
on the screen. The maximum number of documents is defined by a
system control. For more information, see Grid Control - Limit 2 on page
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Item Description

1213.

Note: When you close and re-open the screen, the filter that limits the
number of documents is turned back on.

Open (green) Means items on the purchase order have not yet been ordered.

Ordered (yellow) Means items on the purchase order have been ordered but not received.

Partial (light
blue)

Means some items on the purchase order have been received.

Fulfilled (dark
blue)

Means all items on the purchase order have been received.

S Shows the status of the purchase order.

Site Displays the site where the purchase order was created. In TireMaster
Plusand TireMaster Point of Sale, this number is always 1.

PONum Displays a purchase order’s system-assigned document number.

PODate Displays the date a purchase order was created.

Ref Displays purchase order’s reference number.

Name Displays the vendor’s name.

Open Displays only purchase orders whose status is open (for the selected
vendor or all vendors).

Ordered Displays only purchase orders whose status is ordered or partially-
received (for the selected vendor or all vendors).

All (option) Displays all purchase orders regardless of their status (for the selected
vendor or all vendors).

Add Lets you create a new purchase order.

Edit Lets you do one of the following:

View and update the item’s on an open purchase orders

View the items on ordered purchase orders

Delete Lets you delete open purchase orders.

Receive Lets you receive items on a purchase order.

293



294

User Guide

Item Description

Print Displays the purchase order in the Report Window so you can print it.

Close Exits the screen.

RECEIVING DOCUMENTS TAB
Receiving documents (RDs), are displayed on the Receiving Documents tab (Figure 11-2). A
receiving document is a list of items that have been delivered. When the inventory replenishment
process begins with a PO, a receiving document is created with the information from the PO. When
items are delivered without a corresponding purchase order, you can create a receiving document
from scratch.

Figure 11-2: PO System Screen Receiving Documents Tab

Note: Users at the corporate site can view all receiving documents and users at a store can view only
the receiving documents created at that store.

Item Description

Vendor Displays only the receiving documents for the selected vendor.

Clicking this button lets you display only the purchase orders for a
specific vendor.

Find Doc Lets you search for a receiving document by entering its reference
number or its system-generated document number.
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Item Description

Reset Vendor Lets you remove the name entered in the Vendor field, so you can view
receiving documents for all vendors.

Filter Off Disregards the setting for the maximum number of documents displayed
on the screen. The maximum number of documents is defined by a
system control. For more information, see Grid Control - Limit 2 on page
1213.

Note: When you close and re-open the screen, the filter that limits the
number of documents is turned back on.

Rev. RD Lets you reverse receiving documents for orders that haven’t been
priced. This button is visible only when the status Received (Un-priced)
is selected.

Open (magenta) Means items on a receiving document have been ordered but not
received.

Received (dark
blue)

Means items on a receiving document have been received but not
priced.

Priced (gray) Means items on a receiving document have been received and priced.

S Shows the status of a receiving document.

Site Identifies the site at which a receiving document was created. In
TireMaster Plus and TireMaster Point of Sale systems, this number is
always 1.

RDNum Displays the system-assigned number for a receiving document.

RDDate Displays the date a receiving document was created.

Ref Displays the reference number for a receiving document.

Name Displays the vendor’s name.

Open Displays receiving documents with items that have not been received
(for the selected vendor or all vendors).

Received
(Un-Priced)

Displays receiving documents for items that have been received but
have not been priced (for the selected vendor or all vendors).

All (option) Displays all receiving documents (for the selected vendor or all vendors).

Add Lets you create a new receiving document.
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Item Description

Edit Lets you view a receiving document.

Delete Lets you delete open receiving documents. Once items on a receiving
document have been received, this button is disabled.

Price Lets you price items on a receiving document.

Print Displays the selected receiving document in the Report Window so you
can print it.

Close Exits the screen.

HISTORICAL VENDOR INVOICES TAB
The Historical Vendor Invoices tab (Figure 11-3) lists the vendor invoices, called vendor invoice
documents (VIDs) in TireMaster, for completed orders. You create VIDs when bills from your vendors
arrive. Creating VIDs is usually referred to as pricing orders, because you record the prices charged by
vendors and generate payables. Users at the corporate site can view all vendor invoices and users at a
store can view only the vendor invoices created at that store.

Figure 11-3: PO System Screen Historical Vendor Invoices

Item Description

Vendor Displays only the historical vendor invoices for the selected vendor.

Clicking this button lets you display only the vendor invoices for a specific
vendor.

Find Doc Lets you search for a vendor invoice by entering its reference number or
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Item Description

its system-generated document number.

Reset Vendor Lets you remove the name entered in the Vendor field, so you can view
historical vendor invoices for all vendors.

Filter Off Disregards the setting for the maximum number of documents displayed
on the screen. The maximum number of documents is defined by a
system control. For more information, see Grid Control - Limit 2 on page
1213.

Note: When you close and re-open the screen, the filter that limits the
number of documents is turned back on.

SiteNo Identifies the site at which a vendor invoice was finalized. In TireMaster
Plus and TireMaster Point of Sale systems, this number is always 1.

VIDNum Displays the document number for the vendor invoice.

VIDDate Displays the date that a vendor invoice was finalized.

Ref Displays the reference number for a vendor invoice.

Name Displays the vendor’s name.

Print Displays the selected vendor invoice in the Report Window so you can
print it. .

Close Exits the screen.

ITEM TRACKING
With item tracking, you can match noninventoriable items on customer work orders to the receiving
documents for those same items.

The purpose of item tracking is to prevent fraud. Item tracking helps to ensure that when a
noninventoriable item is returned, it’s an item you actually sold to a customer. Item tracking also allows
you to verify that an outside purchase was not stolen by an employee.

Items can be tracked regardless of whether they’re assigned the option cost, expense, or relief percent
costing methods. However, the items you’ll mostly likely track are those assigned the option cost
costing method.

HOW TRACKING WORKS
Item tracking is initiated at point of sale. When you add a tracked item to a work order, you also identify
which receiving document is for the item. The method for linking an item on a customer’s work order
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and a receiving document depends on the item’s costing method:

Option Cost Items:When you add a tracked option cost item to a work order, you are required
to define the item’s cost and identify the vendor who delivered the item. When you do this,
TireMaster generates the receiving document for the item. Items assigned the option cost
method are typically obtained via outside purchases and then sold to customers. For more
information, see Track Option Cost Items on page 300 and Outside Purchases for Tracked
Items on page 323.

Expense Method and Relief Percent Items:When you add a tracked item assigned the
expense or relief percent costing method to a work order, a list of receiving documents appears.
Then you select the corresponding receiving document on the list. For more information, see
Track Expense Method and Relief Percent Items on page 299.

Note: If you enable tracking for an expense or relief percent item with available quantities, any
receiving documents created before the start of tracking will be excluded from the list of
receiving documents. Therefore, in this scenario, you’ll assign the item to unknown
receiving documents until you’ve depleted the quantities received before tracking began.
These unknown receiving documents can be removed from the Item Tracking screen,
which is used for researching the purchases and sales of noninventoriable items.

Once an item’s work order and a receiving document are linked, you can use the Item Tracking screen
to do the following when a customer returns a noninventoriable item:

Identify the vendor who sold you the item

Identify the receiving document that was processed when the item was delivered

This information helps you verify that the noninventoriable item being returned is an item you actually
purchased from a vendor and then sold to the customer, because you can easily find the supporting
documentation.

PREPARE FOR ITEM TRACKING
Before you can track a noninventoriable item, you need to enable tracking for it. The track item setting
is on the Inventory Maintenance screen (General tab).
Note: Tracking is intended for specific noninventoriable items, such as Nonstock Brake Pads,

Nonstock Starter, and Nonstock Water Pump. Avoid using tracking for multipurpose
noninventoriable items such as Nonstock Parts.

To enable item tracking
1. Add or look up the item for which you want to enable tracking. For more information, see Add an

Inventory Item on page 205 or Inventory Searches on page 230.

2. On the Inventory Maintenance screen (General tab), click Edit.
3. Select the Track check box. If the check box is disabled, the item is inventoriable and cannot be

tracked.



Item Tracking

4. ClickOK.
5. To enable tracking for additional items, repeat steps 1 through 4.

Tip: If you’re enabling tracking for multiple items that are organized sequentially on the
Inventory List (for example, the items are organized by their descriptions, which all begin
with the prefix non), don’t close the Inventory Maintenance screen and search for another
item. Click Next repeatedly until you locate the next item for which you need to enable
tracking, and then click Edit.

TRACK EXPENSE METHOD AND RELIEF PERCENT ITEMS
To track an item that’s assigned the expense costing method or the relief percent costing method, you
need to identify the receiving document that includes the item when you add it to a work order.

To track expense method and relief percent items
1. Start a work order. For more information, see Create a Regular Work Order on page 442.

2. Add the item to the work order. Then type the quantity and press Enter. The Track Parts screen
opens. It lists receiving documents that include the item that was just added to the work order.

Note: When you receive multiple quantities of an item on a receiving document, the same item
and the same receiving document are listed multiple times on the Track Parts screen.

3. Do one of the following:

Select the receiving document that includes the item you put on the work order, and clickOK. If
there are multiple lines for a receiving document, press Ctrl and select a line for each item.
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If there is no receiving document for the item on list, click Close. When TireMaster prompts you
to assign the item to an unknown receiving document, click Yes.
Note: The lack of a receiving document occurs when an item already had available quantities

when tracking was enabled. (In other words, the item was received before tracking
began.)

4. Do one of the following as needed:

Put additional items on the work order.

Update items that were already on the work order (for example, change prices, edit
descriptions, assign technicians).

ClickQuit to close the work order.
Complete the invoice. For more information, see Complete an Invoice on page 456.

TRACK OPTION COST ITEMS
To track an item that’s assigned the option cost costing method, you create the receiving document for
the item when you define its cost at point of sale. Option cost items cannot be linked to receiving
documents that were already created in the PO System. The option cost method is used for recording
the cost of nonstock parts and tires obtained through outside purchases. For more information, see
Outside Purchases on page 322.

To track option cost items
1. Start a work order. For more information, see Create a Regular Work Order on page 442.

2. Add one or more items to the work order. When an option cost item is added to a work order, the
item’s line turns pink. The line remains pink until the item’s cost is entered.
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3. For each option cost item, update the description on the work order so it matches the description of
the item you’re getting from the vendor. You can also update the description of other
noninventoriable items if needed.

Note: Using detailed descriptions for option cost items makes the purchase of those items easier
to track, because the work order descriptions are used on receiving documents and
vendor invoice documents.

4. Update selling prices for the items as needed.

5. Define an item’s cost and put it on a receiving document.

a. Select an item and clickOption Cost. The Option Cost screen opens.

b. Type your cost for the item in theOption Cost field.
c. To put the item on a receiving document, click Vendor and look up the vendor who sold you

the item.
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Note: If there is already an open receiving document for the vendor, you have the option to
add the item to it or you can create a new receiving document.

d. Do one of the following:

If the shipment included only a packing slip, leave the Receive and Price check box clear
and clickOK. The item or items in the shipment will be received now and can be priced later,
when the vendor sends you an invoice.

If there is one option cost item on the work order and the vendor sent you an invoice, select
the Receive and Price check box and clickOK. TireMaster prompts you to receive and
price the item before returning to work order.

If there are multiple option cost items on the work order and the vendor sent you an invoice,
leave the Receive and Price check box alone until you’ve entered the cost for the last item.
Then clickOK. When you enter the price for the last item and select the check box,
TireMaster prompts you to receive and price the items before returning to work order.

6. Do one of the following as needed:

Put additional items on the work order.

Update items that were already on the work order (for example, change prices, edit
descriptions, assign technicians).

ClickQuit to close the work order.
Complete the invoice. For more information, see Complete an Invoice on page 456.

PREVIOUSLY-RECEIVED TRACKED, OPTION COST ITEMS
When you add a tracked, option cost item to a work order, you are typically required to add the item to
a receiving document. This happens because the Put item on a receiving document check box
(Figure 11-4) is automatically selected on the Option Cost screen and cannot be changed.
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Figure 11-4: Automatically Selected Receiving Document Check Box

There is, however, an instance which you can clear the check box for a tracked, option cost item. This
occurs when the item is already in your inventory, because it was not sold or it was returned by a
customer.

In this scenario, you have the following options:

If the available item can be sold on the new work order, enter its cost and clear the check box.
Then clickOK. Because the item was previously received, there is no need to create a receiving
document.

If the available item cannot be sold on the new work enter, enter its cost and leave the check box
selected. Then define the vendor and create the receiving document.

TRACKING ITEMS ORDERED WITH THE EPICOR INTEGRATED
SERVICE ESTIMATOR
If you use the Epicor® Integrated Service Estimator (ISE) with your TireMaster system, you can track
the parts you order via Epicor.

CONFIGURATION
Items from Epicor are tracked by linking them to unique, noninventoriable items in TireMaster,
instead of the miscellaneous parts item which is normally used for placing orders with Epicor. For
example, TireMaster items used for tracking products retrieved from Epicor could include Nonstock
Brake Pads, Nonstock Water Pump, and Nonstock Shocks/Struts.
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Figure 11-5: Examples of Noninventoriable Items for Tracking Epicor Parts

To ensure items from Epicor can be tracked, the Item Tracking check box must be selected in
Inventory Maintenance for the TireMaster items to which they’ll be linked. If you also want to track the
cost of items ordered with Epicor, select Force Option Cost (recommended).

Figure 11-6: A Noninventoriable Item for Tracking Epicor Parts

ADDING TRACKED ITEMS TO WORK ORDERS WITH THE EPICOR
ISE
When you add tracked items to work orders with the Epicor ISE, you need to associate the Epicor
items to corresponding noninventoriable items in TireMaster (on the Epicor ordering screen). Then
you can link the TireMaster work order and the receiving document created for the order placed via
Epicor.

To add tracked items to work orders with the ISE
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1. Access the Epicor ISE as usual.

2. Search for and select the items in the ISE. Then click Transfer & Exit. The Epicor ordering
screen opens.

3. Associate each Epicor item with the corresponding noninventoriable item in TireMaster.

a. Click an item’s TM Part# field and press . The Custom Inventory Lookup screen opens.

b. Look up the TireMaster item. The miscellaneous interface part number is replaced with the
part number from TireMaster.

4. Make sure the check box is selected for each of the items you want to order. Then clickOrder.
The Track Parts screen opens.

Note: If there is an existing receiving document for the vendor, you'll be prompted to add the
items to that document or you can create a new receiving document. To continue, click
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Selected or Create New.

5. Link the work order and the receiving document for each of the items. To do this, select an item
and clickOK. Then repeat this process for the remaining items.

Note: If an item is listed on the Track Parts screen multiple times, the work order quantity for
that item is two or more. In this scenario, press the Ctrl key and select each item. Then
clickOK.

Example: If two front brake rotors were added to the work order, you need to select both of
them before clickingOK.

ADDING TRACKED ITEMS TO ESTIMATES WITH THE EPICOR ISE
The process of adding tracked items to an estimate from the Epicor ISE is the same as using the
ISE to add non-tracked items. However, when you turn the estimate into a work order, you need to
associate the Epicor items with the corresponding items in TireMaster. Then you can link the new
work order to the receiving document that was created when the items were ordered electronically.

To add tracked items to estimates with the Epicor ISE
1. Access the Epicor ISE as usual.

2. Search for and select the items in the ISE. Then click Transfer & Exit.
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3. When you've added all of the items to the estimate, save it.

4. When the customer decides to purchase the items, open the customer’s estimate. For more
information, see  Retrieve Quotes and Estimates on page 526.

5. Make sure the items that you want to move to a work order are selected, and click
Create/Update WO. The Epicor ordering screen opens.

6. Associate each Epicor item with the corresponding noninventoriable item in TireMaster.

a. Click an item’s TM Part# field and press . The Custom Inventory Lookup screen opens.

b. Look up the TireMaster item. The miscellaneous interface part number is replaced with the
part number from TireMaster.
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7. Make sure the check box is selected for each of the items you want to order. Then clickOrder.
The Track Parts screen opens.

Note: If there is an existing receiving document for the vendor, you'll be prompted to add the
items to that document or you can create a new receiving document. To continue, click
Selected or Create New.

8. When the work order confirmation message appears, clickOK.
9. Close the Quote and Estimate Writer screen.

10. To retrieve the new work order, click Invoicing. Then select the work order and click Select. The
Track Parts screen opens.

11. Link the work order and the receiving document for each of the items. To do this, select an item
and clickOK. Then repeat this process for the remaining items.
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Note: If an item is listed on the Track Parts screen multiple times, the work order quantity for
that item is two or more. In this scenario, press the Ctrl key and select each item. Then
clickOK.

Example: If two front brake rotors were added to the work order, you need to select both of
them before clickingOK.

VERIFY NONINVENTORIABLE ITEM RETURNS
When a customer wants to return a tracked noninventoriable item, you can use the Item Tracking
screen to identify the receiving document for the item being returned. With this information, you can do
the following:

Verify that you actually purchased the item from a vendor and then sold it to the customer

Determine how much you paid the vendor for the item (You need to know your cost for the item
to process the return to the vendor.)

To verify a noninventoriable item return
1. Select Inventory > Item Tracking. The Item Tracking screen opens.

2. Do one of the following:
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If the customer provides the original sale invoice, type the document number in the Invoice#
field and clickQuery.

If the customer does not have the original sale invoice, click the Customer field and press .
Then search for the customer. For more information, see Customer Searches on page 93.

Depending on the search method, TireMaster retrieves the item sold on the specified invoice or a list
of the items sold to the customer.

Note: By default, 40 lines are displayed on the Item Tracking screen. If you believe there should
be more entries for the customer, change the number of lines to 120 or All (lower-right
corner).

3. Take note of the entries in the RD#, RD Date, and Vendor columns. You will use this information
to find the item’s receiving document.

4. For a hard copy of the entries on the screen, click Print. When the Report Window opens, print the
report. Then close the Report Window.

5. Close the Item Tracking screen.

6. Locate the receiving document for the item being returned.

a. Click PO List or select Inventory > PO & Receiving.
b. Click the Receiving Documents tab.
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c. Do one of the following:

Click Find Doc. Then type the receiving document number and clickOK.

Select the status All. Then click and look up the vendor. For more information, see
Vendor Searches on page 193.

7. Select the receiving document and click Print. The Report Window opens and displays the
receiving document.
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Tip: If you searched by vendor and there are multiple receiving documents, refer to the
receiving document date or reference number. When a receiving document is created for
an option cost item at point of sale, TireMaster uses the sale invoice number as the
reference number.

8. Take note of the item’s price. You need that amount for the negative receiving document that will
be used to return the item to the vendor.

ITEM TRACKING SCREEN CLEANUP
You can reduce the number of entries on the Item Tracking screen by removing the items that were
assigned to unknown receiving documents. Items assigned to unknown receiving documents are
those items that already had available quantities when tracking was enabled. (In other words, those
items were received before tracking began.)

Note: To delete items from the Item Tracking screen, you must belong to a security group assigned
the permission Invoicing WO Delete.
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To delete items from the tracking screen
1. If the Item Tracking screen isn’t already open, select Inventory > Item Tracking.
2. Select the item you want to remove and click Delete. The item is removed. When there are

multiple lines for an item (because the item’s quantity on the RD was higher than 1), all of the lines
are removed.

Note: If the Delete button is inactive, the selected item was not assigned to an unknown
receiving document.

TRACKED OUTSIDE PURCHASE ITEM RETURNS
When a customer returns tracked parts or tires that you obtained through an outside purchase,
process the return and create a negative receiving document at point of sale. The return invoice is for
refunding the customer and the negative receiving document is for sending the returned item back to
the vendor. Because outside purchase items are assigned the option cost costing method, TireMaster
requires you to record item costs prior to creating the negative receiving documents. For more
information, see Option Cost Method on page 378 and Outside Purchases for Tracked Items on page
323

To process tracked outside purchase returns
1. Review the customer’s original sale invoice and the item’s receiving document. With this

information, you can:

Confirm the item was sold to the customer.

Identify the vendor who sold you the item and the price you paid for it.

For more information, see Verify Noninventoriable Item Returns on page 309.

2. Start a work order for the customer who is returning the outside purchase item.

3. Add the returned item to the work order.

a. Click Add and look up the item.

b. Type the quantity as a negative number (-) and press Enter.

Example: If one item is being returned, type -1.)

The Customer Sales History screen opens. It lists the items the customer previously bought,
returned, or traded-in. Items highlighted in yellow were flagged during previous returns.
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c. Select the item being returned and click Return.

Note: If you do not see the item being returned, select theMatch Inventory check box
(upper-right corner).

d. Type the returned item’s description and original selling price.

4. Enter the returned item’s cost.

a. ClickOption Cost. The Option Cost screen opens.

b. Type the item’s cost.
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5. Create the negative receiving document

a. Click Vendor and search for the vendor who sold you the item.
b. Select the Receive and Price check box.
c. ClickOK. The Receiving Document screen opens.

d. Click Receive. TireMaster prompts you to price the receiving.

e. Do one of the following:

If the vendor has issued a return invoice to you, click Yes. The Vendor Invoice screen
opens.

If you do not have a return invoice from the vendor, click No. The Report Window opens and
displays the receiving document. Print it if needed and close the Report Window. Then go to
step 7. You can price the item and create the negative charge later.

6. To price the negative receiving document, click Complete. The Correcting VC screen opens.

315



316

User Guide

7. Complete the return invoice.

a. Click Complete.
b. Process the customer’s reimbursement with the same payment method used for the original

invoice.

TRACKED EXPENSE METHOD AND RELIEF PERCENT ITEM
RETURNS
When a customer returns a tracked item that’s assigned the expense or relief percent costing method,
the item is put on an unknown receiving document. Depending on what the item is, you could sell it to
another customer or return it to the vendor.

To process tracked expense and relief percent item returns
1. Review the customer’s original sale invoice and the item’s receiving document. With this

information, you can:

Confirm the item was sold to the customer.

Identify the vendor who sold you the item and the price you paid for it.

For more information, see Verify Noninventoriable Item Returns on page 309.

2. Start a work order for the customer who is returning the outside purchase item.

3. Click Add and look up the item being returned.

4. Type the quantity as a negative number (-) and press Enter.

Example: If one item is being returned, type -1.)

The Customer Sales History screen opens. It lists the items the customer previously bought, returned,
or traded-in. Items highlighted in yellow were flagged during previous returns.
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Note: If you do not see the item being returned, select theMatch Inventory check box.

5. Select the item being returned and click Return.

6. ClickOK. A message tells you that the item will be assigned to an unknown receiving document.

7. ClickOK to close the message.

8. Complete the return invoice.

a. Click Complete.
b. Process the reimbursement with the same payment method used for the original invoice.

ITEM TRACKING SCREEN
The Item Tracking screen includes the following information for noninventoriable items that are being
tracked:

The receiving document created when an item was received

The name of the vendor who sold you an item

The invoice on which an item was sold

The name of the customer who purchased an item
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Item tracking helps to ensure that when customers return noninventoriable items, you’re handling parts
or tires that your store actually bought from vendors and then sold to those customers. For more
information, see Item Tracking on page 297.

Figure 11-7: Item Tracking Screen Left Half



Item Tracking Screen

Figure 11-8: Item Tracking Screen Right Half

Item Description

Not Rcvd - Not on WO
or Invoice

Limits the items displayed to those that are currently on open
receiving documents and are not on work orders or invoices.

Not Rcvd - On WO or
Invoice

Limits the items displayed to those that currently on both open
receiving documents and work orders or invoices.

Rcvd - Not on WO or
Invoice

Limits the items displayed to that have been received but have not
been added to work orders or invoices.

Rcvd - On WO or
Invoice

Limits the items displayed to those that been received and are on
work orders or invoices.
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Item Description

On WO or Invoice -
Not on RD

Limits the items displayed to those that have been added to work
orders or sold to customers and were assigned to unknown
receiving documents.

Note: When an item is added to a work order and cannot be
matched to a receiving document, the item is placed on an
unknown RD. This affects items that already had available
quantities when tracking was enabled. (In other words,
those items were received before tracking began.)

All Displays all tracked items that have been put on work orders, sold
on invoices, or received.

Site# Lets you display items for all sites or only a specific site.

WO/Inv Date Limits the items displayed to those whose work orders were created
on the selected date and those whose invoices were completed on
the selected date.

RD Date Limits the items displayed to those whose receiving documents
were created on the selected date.

Vendor Lets you search for items received from a specific vendor.

Customer Lets you search for items that will be sold to or have already been
sold to a specific customer.

Product Code Lets you search for items with a specific product code.

RD# (field) Lets you search for items that have been added to a specific
receiving document.

Note: When you search for a receiving document, and the items
on that RD have been priced, the corresponding vendor
invoice document number (VID#) appears under this field.
When the items have not been priced, the message “no
VID# found” appears instead.

Invoice# Lets you search for items that have been added to a specific work
order or sold on a specific invoice.

Query Displays items that match the user-defined filtering parameters.

RD Site Lists the site where an item’s receiving document was created.

RD# (column) Lists the document number for an item’s receiving document. When
an item is placed on an unknown RD, the document number is 0.
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Item Description

RD Line Lists an item’s line number (placement) on the receiving document.
When an item is added to an unknown RD, the document number is
blank.

RD Date Lists the date on which an item’s receiving document was created.

EffSite Lists the site at which an item’s receiving document was created.

Product Code Lists an item’s product code.

Size/Description Lists an item’s size or description.

Invoice# Lists the document number for the work order that an item has been
added to or the invoice number on which an item was sold.

Line# Lists an item’s line number (placement) on a work order or invoice.
When an item has not been yet been added to a work order or sold,
the line number is 0.

Invoice Date Lists the date on which an item was added to a work order or sold.

Vendor Lists the vendor from whom you purchased an item. When an item is
assigned to an unknown receiving document, this field is blank. This
typically occurs when an item is received before tracking is enabled
for that item.

Customer Lists the customer to whom you will be selling or have sold an item.
If an item hasn’t been added to a work order or sold, this field is
blank.

Emp Name Lists the name of the user who created the item’s receiving
document (regardless of whether another user prices the item).

Print Lets you generate a hard copy of the items listed on the screen.

Number of Lines - 40 Limits the number of items displayed to 40 lines. This option is
selected by default.

Number of Lines - 120 Limits the number of items displayed to 120 lines.

Number of Lines - All Displays lines for all items.

Delete Lets you remove items that were assigned to unknown receiving
documents. When an item is assigned to an unknown receiving
document, the entry in the RD# column is 0. For more information,
see Item Tracking Screen Cleanup on page 312.
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Item Description

Note: When an item is added to a work order and cannot be
matched to a receiving document, the item is placed on an
unknown RD. This affects items that already had available
quantities when tracking was enabled. (In other words,
those items were received before tracking began.)

Reset Removes the data-filtering entries at the top of the screen and
displays all items being tracked.

Close Lets you close the Item Tracking screen.

OUTSIDE PURCHASES
If you don’t stock the parts needed to perform services or repairs, you can obtain them by making
outside purchases. That is, you buy the items you need on a job-by-job basis. Special order tires are
also secured through outside purchases.

OUTSIDE PURCHASE REQUIREMENTS
Before you perform outside purchases, one or more generic nonstock items need to be set up in
TireMaster.

Example: Nonstock Water Pump, Nonstock Brake Pads, Nonstock Special Order Passenger Tire.

Generic nonstock items for outside purchases must include the following settings (Figure 11-9):

Classify the item as noninventoriable (Type N in the Inventory Y/N field.)

Assign the option cost costing method (Select the Force Option Cost check box.) With the
option cost method, you enter an item’s actual cost, including federal excise tax, at point of sale.

Figure 11-9: Outside Purchase Item Settings

Note: Items assigned the option cost method are sometimes referred to as option cost items.
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PERFORM OUTSIDE PURCHASES
The process that you use for performing outside purchases depends on whether you have item
tracking enabled for the items being sold. For more information, see Item Tracking on page 297. When
an option cost item is tracked, you are required to put it on a receiving document when you record its
cost. For an option cost item that is not tracked, you have the option to put it on a receiving document
when entering its cost.

OUTSIDE PURCHASES FOR TRACKED ITEMS
For outside purchases of option cost items that are tracked, you create the receiving document at
point of sale when you enter the item’s cost (instead of in the PO System).

1. Start a work order for the customer, taking note of any issues the customer is experiencing with
the vehicle.

2. When the technician identifies the needed service or repairs, add the applicable nonstock item
and associated labor item to the work order. Because it’s an option cost item, the line for the item
will turn pink. The line will remain pink until you enter the item’s cost.

3. Locate a vendor who has the needed items on hand and order them.

4. Retrieve the customer’s work order, and do the following:

Change the item’s generic description to the description of the item you ordered.

Example: If you ordered a Murray water pump, you could change the description to from
Nonstock Water Pump toMurray Water Pump #CP5077. Detailed descriptions of outside
purchase items are used on receiving documents and vendor invoice documents, making
the purchase of specific items easier to track.

Update the selling price.

5. When an item arrives, retrieve the customer’s work order and record the nonstock item’s cost.
Then add the item to a receiving document. For more information, see Retrieve a Customer's
Work Order on page 451.

a. Select an item and clickOption Cost. The Option Cost screen opens.
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b. Type your cost for the item in theOption Cost field.
c. To put the item on a receiving document, click Vendor and look up the vendor who sold you

the item.

Note: If there is already an open receiving document for the vendor, you have the option to
add the item to it or you can create a new receiving document.

d. Do one of the following:

If the shipment included only a packing slip, leave the Receive and Price check box clear
and clickOK. The item or items in the shipment will be received now and can be priced
later, when the vendor sends you an invoice.

If there is one option cost item on the work order and the vendor sent you an invoice,
select the Receive and Price check box and clickOK. TireMaster prompts you to receive
and price the item before returning to work order.

If there are multiple option cost items on the work order and the vendor sent you an
invoice, leave the Receive and Price check box alone until you’ve entered the cost for the
last item. Then clickOK. When you enter the price for the last item and select the check
box,TireMaster prompts you to receive and price the items before returning to work order.

6. If there are multiple nonstock items on the work order, repeat steps 5a through 5d.

7. Do one of the following:

If work on the vehicle is still in progress, clickQuit to exit the work order.
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If work on the vehicle is done and customer is ready to pay, complete the invoice. For more
information, see Complete an Invoice on page 456.

OUTSIDE PURCHASES FOR UNTRACKED ITEMS
For outside purchases of an option cost item that is not tracked, you can choose whether to put it on
a receiving document when you enter the item’s cost at point of sale, or you can create a receiving
document for the item in the PO System.

To perform an outside purchase for untracked items
1. Start a work order for the customer, taking note of any issues the customer is experiencing with

the vehicle.

2. When the technician identifies the needed service or repairs, add the applicable nonstock item
and associated labor item to the work order. Because it’s an option cost item, the line for the item
will turn pink. The line will remain pink until you enter the item’s cost.

3. Locate a vendor who has the needed items on hand and order them.

4. Retrieve the customer’s work order, and do the following:

Change the item’s generic description to the description of the item you ordered.

Example: If you ordered a Murray water pump, you could change the description to from
Nonstock Water Pump toMurray Water Pump #CP5077. Detailed descriptions of outside
purchase items are used on receiving documents and vendor invoice documents, making
the purchase of specific items easier to track.

Update the selling price.

5. When an item arrives, retrieve the customer’s work order and record the nonstock item’s cost.
Then, if you want, add the item to a receiving document. For more information, see Retrieve a
Customer's Work Order on page 451.

a. On the Invoice Entry screen, select the nonstock item and clickOption Cost.

b. Type your cost for the item in theOption Cost field.
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c. Do one of the following:

To put the item on a receiving document now, make sure the Put item on a receiving
document check box is selected. Then click Vendor and look up the vendor who sold you
the item.

If the item is already on a receiving document, or if you’ll add it to a receiving document
later, clear the Put item on a receiving document check box. Then clickOK and go to
step 6.

d. Do one of the following:

If the shipment included only a packing slip, leave the Receive and Price check box clear
and clickOK. The item or items in the shipment will be received now and can be priced
later, when the vendor sends you an invoice.

If there is one option cost item on the work order and the vendor sent you an invoice,
select the Receive and Price check box and clickOK. TireMaster prompts you to receive
and price the item before returning to work order.
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If there are multiple option cost items on the work order and the vendor sent you an
invoice, leave the Receive and Price check box alone until you’ve entered the cost for
the last item. Then clickOK. When you enter the price for the last item and select the
check box, TireMaster prompts you to receive and price the items before returning to work
order.

6. If there are multiple nonstock items on the work order, repeat steps 5a through 5d

7. Do one of the following:

If work on the vehicle is still in progress, clickQuit to exit the work order.
If work on the vehicle is done and customer is ready to pay, complete the invoice. For more
information, see Complete an Invoice on page 456.

FET HANDLING FOR POS AND RECEIVINGS
If federal excise tax is assessed for an item, you need to track the cost of FET each time the item is
received. When you place an item on a purchase order or receiving document, TireMaster uses one of
the following values as the FET:

The average of the item’s federal excise tax

The FET from the item’s last receiving

To define which value to use, you need to set the system control Use Next FET for POS/Receivings.
In addition to defining how FET is handled on purchase orders and receivings, this setting also
determines which value to use as the FET for items added to quotes or work orders.

Note: By default, TireMaster uses the average cost of an item’s federal excise tax as its FET.

To set FET handling
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Inventory tab.
3. Select Use Next FET for POS/Receivings and press Enter.
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4. Select one of the following:

To use the average cost of an item’s federal excise tax, select YES.
To use the FET from an item’s last receiving, select NO.

5. ClickOK.
6. Close the System Controls screen.

Note: You can view both the average cost of an item’s FET and the last FET in an item’s inventory
record (on the Site Prices and Quantity screen). The last FET is the amount of federal excise
tax you paid for the item the last time it was received, and the next FET is the average cost of
the item’s federal excise tax.

INVENTORY RETURNS
When you need to send items back to a vendor, perform an inventory return. The inventory return
process includes slight differences depending on whether items being returned are inventoriable or
noninventoriable. You also have the option to return items and receive new items at the same time.

THE INVENTORY RETURN PROCESS
Returning items to a vendor includes the following tasks.

Create a negative receiving document, which removes the item from the inventory and
records the cost and federal excise tax of the returned item. When you create the negative
receiving document, you can use the item’s system-generated next cost and federal excise tax,
or you can use the cost and FET or your choice.

Note: If you change the cost, FET, or both, the total of the inventory subledgers might not match
the balance of the general ledger’s inventory account. In such instances, you need to
create adjusting entries.

Create a negative vendor charge (VC), which records the credit or reimbursement that will
reduce the vendor’s balance. TireMaster can create the charge automatically or you can create
it manually.

Note: When the negative vendor charge is created automatically, it posts to the vendor’s
subledger and includes a reference number such as VID:1-13.
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Once the negative vendor charge is created, either automatically or manually, you need to apply it to
one or more invoices in the vendor’s subledger. Before you can return items to a vendor, you need to
define an inventory clearing account.

DEFINE AN INVENTORY CLEARING ACCOUNT
To perform inventory returns, you need to include an inventory clearing account in your chart of
accounts. This account can be an existing liability account (such as Accounts Payable – Expected
Credits), or you can create an account solely for the purpose of tracking inventory returns. Once you
decide which account to use, you need to define the inventory clearing account.

Note: Defining the inventory clearing account is required to successfully validate the database.

To define the inventory clearing account
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theGeneral Ledger tab.
3. Select Inventory Clearing Acct and press Enter.

4. Select the account you want to use for tracking inventory returns from the chart of accounts and
clickOK.

5. Close the System Controls screen.

RETURN INVENTORIABLE ITEMS
When you return an inventoriable item to a vendor, you can post one of the following to the general
ledger:

The item’s next cost and next FET
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The cost and FET of your choice

Tip: You can return both inventoriable and noninventoriable items on the same receiving
document. For more information, see Return Noninventoriable Items on page 332.

To an return inventoriable item
1. Create a receiving document for the vendor who sold you the item. For more information, see

Create a Receiving Document on page 284.

2. Enter a reference number for the return if needed.

3. Click Add and look up the item you want to return or scan the item’s bar code. For more
information, see Inventory Searches on page 230 or Enter Bar Codes on Purchase Orders and
Receiving Documents on page 350.

4. Type the returned item’s quantity as a negative number and press Enter. The Price and FETax
fields turn green.

5. Define how to post the cost and FET of the returned item to the general ledger:

To post the next cost and next FET (if any) make sure the Price and FETax fields are green
and the amount in both is $0.00.

Note: Because an item’s next cost and next FET are generated by TireMaster, posting these
amounts reduces the potential for discrepancies between the inventory subledgers
and the inventory accounts in the general ledger.
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To post the cost and FET of your choice, change the values in the Price and FETax fields.
Those fields turn pink to indicate you’re no longer performing a standard return.

Note: If you override the cost, federal excise tax, or both, you might need to make adjusting
journal entries to ensure that the total of the inventory subledger accounts matches the
value of the inventory accounts in the general ledger..

6. To return additional items, repeat steps 3 through 5.

7. Click Receive. TireMaster prompts you to price the RD.

8. Click Yes. The Vendor Invoice screen opens.
9. Click Complete. The Create Correct VC screen opens.

Note: Depending on the system control settings, you might be required to add a reference
number if you haven’t already.

10. Define whether the vendor charge will be a system-generated amount or an amount of your
choice:

To base the vendor charge on the next cost and next FET calculated by TireMaster, select
Create VC with system generated amount.
Note: The vendor charge number and amount listed are subject to change if other

transactions involving returned items are completed before you finish the inventory
return.

To use the amount of your choice, select Create VC with User defined amount and type the
charge amount.

11. Select a method for processing the vendor charge:
To automatically create the vendor charge and post it to the vendor’s subledger, select Create
and process a negative Vendor Charge when the VID is processed.
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To create the vendor charge yourself, select Create a negative Vendor Charge manually.
For more information, see Enter a Vendor Charge on page 744.

To automatically create the charge and add it to an open batch of charges for the vendor, select
Create a negative Vendor Charge as part of an open batch. When the AP Batch Charge
screen appears, choose a batch or create a new batch.

Note: This option is not available when a user at the corporate site is pricing a receiving
document for a store.

12. ClickOK. The Report Window opens and displays the Vendor Invoice Document.

Note: If you click Cancel instead, you’ll need to create the negative vendor charge manually.

13. Print the VID and close the Report Window.

Note: On this copy of the VID, the returned item’s cost is $0.00. Once the transaction is
completed, reprinted copies of the VID will display the cost that posted to the general
ledger.

After the negative charge is created, apply it to the vendor’s subledger to reduce the vendor’s balance.
For more information, see Apply Payments and Credits to Vendor Balances on page 756.

RETURN NONINVENTORIABLE ITEMS
When you return a noninventoriable item to a vendor, you need to enter your cost or an estimated cost
for the item on the negative receiving document.

Note: If the item being sent back to a vendor is assigned the option cost costing method, performing
the following steps might not be necessary because the negative receiving document and
possibly a negative charge might already exist. This is always true for tracked option cost items
that customers purchase and then return, because creating the negative receiving document
during the return is required. It can also occur when a customer purchases and returns an
untracked option cost item. In this scenario, you have the option to create the negative
receiving document and negative vendor charge during the return. For more information, see
Return Tracked Option Cost Items on page 476 and Return Untracked Option Cost Items on
page 479.
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Tip: You can return inventoriable items on the same receiving document as noninventoriable items.
For more information, see Return Inventoriable Items on page 329.

To return noninventoriable items
1. Start a receiving document for the vendor who sold you the item. For more information, see Create

a Receiving Document on page 284.

2. Enter a reference number for the return, if needed.

3. Click Add and look up the item you want to return or scan the item’s bar code. For more
information, see Inventory Searches on page 230 or Enter Bar Codes on Purchase Orders and
Receiving Documents on page 350.

4. Change the item’s description if needed.

5. Type the returned item’s quantity as a negative number.

6. Enter the item’s cost using one of the following methods:

For relief percent items, type the estimated cost (Parts Price x Relief Percent) in the Price field.
For example, If an item’s parts price is $50 and its relief percent is 10%, type $5 in the Price
field.

For option cost and expense method items, type your cost in the Price field.

Note: The cost or estimated cost of a returned item is not included in the receiving
document’s total.
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7. To return additional items, repeat steps 3 through 6.

8. Click Receive. TireMaster prompts you to price the RD.

Note: Depending on how the system controls are set, you might be required to add a reference
number if you haven’t already.

9. Click Yes. The Vendor Invoice screen appears.
10. Click Complete. The Create Correcting VC screen appears.

Note: Depending on how the system controls are set, you might be required to add a reference
number if you haven’t already.

11. Define whether the vendor charge will be a system-generated amount or an amount of your
choice:

For a vendor charge based on the next cost and next FET calculated by TireMaster, select
Create VC with system generated amount.
Note: The vendor charge number and amount listed are subject to change if other

transactions involving returned items are completed before you finish the inventory
return.

For a vendor charge amount of your choice, select Create VC with User defined amount and
type the charge amount.

12. Select a method for processing the vendor charge:
To automatically create the vendor charge and post it to the vendor’s subledger, select Create
and process a negative Vendor Charge when the VID is processed.
To create the vendor charge yourself, select Create a negative Vendor Charge manually.
For more information, see Enter a Vendor Charge on page 744.

To automatically create the charge and put it in an open batch of charges for the vendor, select
Create a negative Vendor Charge as part of an open batch. When the AP Batch Charge
screen appears, choose a batch or create a new batch.

Note: This option is not available when a user at the corporate site is pricing a receiving
document for a store.

13. ClickOK. The Report Window opens and displays the Vendor Invoice Document.
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Note: If you click Cancel instead, you’ll need to create the negative vendor charge manually.

14. Print the VID and close the Report Window.

Once the negative charge is created, apply it to the vendor’s subledger to reduce the vendor’s
balance. For more information, see Apply Payments and Credits to Vendor Balances on page 756.

COMBINE INVENTORY RETURNS AND RECEIVINGS
You can perform an inventory return when you're receiving items from a vendor. The receiving
document created in this scenario, includes items with both negative and positive quantities.

To combine inventory returns and receivings
1. Start a receiving document for the vendor. For more information, see Create a Receiving

Document on page 284.

2. Type a reference number for the receiving.

3. Add each item you’re receiving from the vendor, along with its quantity, price (your cost), and FET.

4. Add each item you want to return to the vendor and its quantity entered as a negative number.
Then enter the price (your cost) and FET using one of the following methods:
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For an inventoriable item, leave $0.00 in the Price and FETax fields or change the cost and
federal excise tax to amounts of your choice. For more information, see Return Inventoriable
Items on page 329.

For noninventoriable items, type your cost (expense or option cost method) or the estimated
cost (relief percent method) in the Price field. For more information, see Return
Noninventoriable Items on page 332.

5. Click Receive. TireMaster prompts you to price the RD.

Note: Depending on how the system controls are set, you might be required to add a reference
number if you haven’t already.

6. Click Yes. The Vendor Invoice screen appears.
7. Click Complete.

8. The Combine PO & VC Documents screen appears. It lists the following:

The total of the newly received items

The total cost of the returned items

The difference between those two amounts

Note: The amounts are subject to change if other transactions involving returned items are
completed before you finish the combined receiving and return.

9. Define whether you want to combine the payable entries:

To post the listed amounts to the GL and skip creating a vendor charge for the cost of the
returned items, click Yes. Then print the vendor invoice document. The receiving is completed
and you can disregard steps 10 through 12.

Note: When payables are combined in this manner, no inventory return (IR) entry is created
in the general ledger.
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To create a vendor charge for the returned items instead, click No. The Create Correcting VC
screen appears.

10. Define whether the vendor charge will be a system-generated amount or an amount of your
choice:

For a vendor charge based on the next cost and next FET of the returned items, select Create
VC with system generated amount.
Note: The vendor charge number and amount listed are subject to change if other transactions

involving returned items are completed before you finish the inventory return.

For a vendor charge amount of your choice, select Create VC with User defined amount and
type the charge amount.

11. Select a method for processing the vendor charge:
To automatically create the vendor charge and post it to the vendor’s subledger, select Create
and process a negative Vendor Charge when the VID is processed.
To create the vendor charge yourself, select Create a negative Vendor Charge manually.
For more information, see Enter a Vendor Charge on page 744.

To have TireMaster automatically create the charge and add it to an open batch of charges for
the vendor, select Create a negative Vendor Charge as part of an open batch. When the
AP Batch Charge screen appears, choose a batch or create a new batch.

Note: This option is not available when a user at the corporate site is pricing a receiving
document for a store.

12. ClickOK. The Report Window opens and displays the Vendor Invoice document.
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Note: If you clicked Cancel instead, you’ll need to create the negative vendor charge manually.

13. Print the VID and close the Report Window.

After the negative charge is created, apply it to the vendor’s subledger to reduce the vendor’s balance.
For more information, see Apply Payments and Credits to Vendor Balances on page 756.



INVENTORY CODES AND SETTINGS
You can assign a variety of codes to and enable various settings for each inventory item. You can use
these codes and settings to classify items, search for items, and organize information on your
inventory reports. This chapter includes the following sections:

Inventory Categories and Groups 340
Manufacturer Codes 346
Bar Codes 348
GL Codes 350
Inventory GL Code Maintenance Screen 356
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INVENTORY CATEGORIES AND GROUPS
Inventory categories and groups are used for organizing information on sales and inventory reports.
Categories are the primary report organization method, and groups are the secondary method. The
following image shows the difference between a report that’s been organized by category and then by
group. Categories and groups can also be used for looking up items.

Figure 12-1: Historical Sales Reports Organized by Categories and Groups

ADD INVENTORY CATEGORIES
If you want to change the primary method for organizing information on your reports, you can add new
categories.
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Note: If you change the category assigned to an item after going live, the item will then have multiple
histories. For example, if you change a tire’s category from LTZZ to LTMS, tires sold before the
change will fall under the category TLZZ, while tires sold after the change will fall under the
category LTMS.

To add an inventory category
1. Select Inventory > Categories & Groups. The Inventory Category/Group List opens.

2. Make sure Categories is selected.

3. Click Add. The Inventory Category Edit screen opens.

4. Type a code for it in the Category field.
Note: The category code can be up to four characters long.

5. Type a description for the category.

Note: You can disregard the labor cost percentage. This setting is no longer used.

6. Make sure the Active check box is selected.
7. If the category is for classifying tires, select the Tire check box.
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Note: To use some integrated products, including the DOT Interface and the Goodyear Point of
Sale Interface (POSI), you need to define whether a category is used for tires.

8. To save the category, clickOK.
9. Close the Inventory Category/Group List.

SET THE DEFAULT INVENTORY CATEGORY
The default inventory category is automatically assigned to new items that are added to TireMaster.
Depending on the item, you can use the default category or assign a different one.

To set the default inventory category
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Inventory tab.
3. Select Inventory Default Category and press Enter. The Inventory Category/Group List appears.

4. Select the category you want to use as the default and clickOK.
5. Close the System Controls screen.

MANAGE EXISTING INVENTORY CATEGORIES
Managing categories includes changing settings as needed and eliminating unused categories.

UPDATE AN INVENTORY CATEGORY
If you want to change a category's description or make a category inactive, you can update it.
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To update an inventory category
1. Select Inventory > Categories & Groups. The Inventory Category/Group List opens.

2. Make sure Categories is selected.

3. Select the category you want to change, and click Edit. The Inventory Category Edit screen
opens.

4. Do the following as needed:

Change the category's description.

Select or clear the Active check box.
Select or clear the Tire check box.

5. To save your changes, clickOK.
6. Close the Inventory Category/Group List.

DELETE AN INVENTORY CATEGORY
If there is no transaction history associated with an inventory category, it can be deleted.

Note: If there is a category that you once used but no longer need, you can inactivate it instead. For
more information, see Update an Inventory Category on page 342.

To delete a category
1. Select Inventory > Categories & Groups. The Inventory Category/Group List opens.
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2. Make sure Categories is selected.
3. Select the category you want to delete and click Delete. A confirmation message appears.

4. Click Yes. The category is removed.

ADD AN INVENTORY GROUP
Inventory groups provide an alternative means of organizing information on your reports. Tires,
services, warranties, disposals, and batteries are all examples of inventory groups.

To add an inventory group
1. Select Inventory > Categories & Groups. The Inventory Category/Group List opens.

2. SelectGroups.

3. Click Add. The Inventory Group Edit screen opens.

4. Type a name for the group and make sure the Active check box is selected.

5. To save the new group, clickOK.
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6. Close the Inventory Category/Group List.

MANAGE EXISTING GROUPS
Occasionally, you might need to change a group's settings and you can delete unused groups.

MAKE AN INVENTORY GROUP INACTIVE
If you no longer use an inventory group, you can make it inactive.

To update an inventory group
1. Select Inventory > Categories & Groups. The Inventory Category/Group List opens.

2. SelectGroups.

3. Select the group you want to make inactive, and click Edit. The Inventory Group Edit screen
appears.

4. Clear the Active check box.

5. To save your changes, clickOK.
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6. Close the Inventory Category/Group List.

DELETE INVENTORY GROUPS
If you have an unused inventory group.

Note: If there is a group that you once used but no longer need, you can inactivate it instead. For
more information, see Make an Inventory Group Inactive on page 345.

To delete an inventory group
1. Select Inventory > Categories & Groups. The Inventory Category/Group List opens.
2. SelectGroups.
3. Select the group you want to delete, and click Delete. A confirmation message appears.

4. Click Yes. The group is removed.

MANUFACTURER CODES
Manufacturer codes identify which manufacturer produced an item. They can be used to look up items
and organize information on reports.

ADD A MANUFACTURER CODE
Your available manufacturer codes are displayed on the Manufacturer List. You should set up
manufacturer codes for all of the different product lines you sell.

To add or update an existing manufacturer code
1. Select Setup > Manufacturer Codes. The Manufacturer List opens.

2. Click Add. The Manufacturer Detail Edit screen opens.

3. Type a code for the manufacturer. It can be up to five characters long.

4. Type a description or the manufacturer's name.
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5. To save the new code clickOK.
6. Close the Manufacturer List.

UPDATE AN EXISTING MANUFACTURER CODE
If you need to change the description of a manufacturer code, you can update it.

To update an existing manufacturer code
1. Select Setup > Manufacturer Codes. The Manufacturer List opens.

2. Select the code you want to update and click Edit. The Manufacturer Detail Edit screen opens.

3. Type a new description for the code.

4. To save your changes, clickOK.
5. Close the Manufacturer List.

DELETE A MANUFACTURER CODE
If a manufacturer code has never been assigned to any items, you can delete it.

To delete a manufacturer code
1. Select Setup > Manufacturer Codes. The Manufacturer List opens.
2. Select the code you want to update and click Delete. A confirmation message appears.

3. Click Yes. The code is removed from the database.
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BAR CODES
Up to three bar codes can be assigned to each item. You can use these bar codes to search for items
at point of sale, when ordering and receiving inventory, and when making quantity adjustments. When
you need to look up an item using a bar code, you can scan the bar code with a handheld device or
type the bar code number. Scanners with USB connectors are compatible with TireMaster. For
additional system requirement information, contact your TireMaster sales representative.

PREPARE TO USE BAR CODES
Before you can assign bar codes to items or search for items by scanning bar codes, you need to set
up your scanner and add the bar code search option (prompt) to the first tab on the Custom Inventory
Lookup screen.

Note: Assigning the bar code search option to the first tab enables you to put items on work orders,
quotes, purchase orders, and receiving documents by pressing (for quotes, it’s Shift + ) and
scanning the bar code.

To prepare to use bar codes
1. Set up your scanner.

Note: The setup process varies from device to device. Some scanners require installing and
configuring software, while others need minimal setup. For more information, see the
documentation that shipped with your scanner.

2. Add the bar code search option to the first tab on the Custom Inventory Lookup screen:

a. Select Setup > Inventory Lookup.

b. Click the tab to which you want to assign the bar code search option.

c. In the Prompt column, select the row you want to use for the bar code search option and select
6 - Bar Code from the drop-down. Then update the search options for the other rows if
needed.
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d. To add the bar code search option to other tabs, repeat steps 2b and 2c.

e. To save the changes, clickOK.

3. Assign up to three bar codes to your items:

For a single item, open the Inventory Maintenance screen, put the cursor in one of the bar code
fields, and type or scan the bar code. For more information, see Update Information for a
Single Item on page 210

For a group of items, open the Inventory List Editing screen, select one of the bar code
columns, and type or scan the bar codes. For more information, see Update Information for
Multiple Items on page 211.

Tip: To simplify this task, move the bar code column(s) next to the product code and
description columns.

For a group of items, import the bar codes from an XML spreadsheet. For more information,
see Update Items with Spreadsheets on page 212.
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BAR CODE ENTRY
You can use bar codes to search for items when creating work orders, quotes, purchase orders,
receiving documents, and quantity adjustments. You can enter bar codes by scanning them or typing
the bar code number.

Typing partial bar code numbers is allowed. In this scenario, TireMaster retrieves all of the items
whose bar codes include the sequence of numbers used for the search. You can then select the item
you need from the Inventory List.

ENTER BAR CODES ON WORK ORDERS
There are two ways to add an item to a work order with a bar code:

Press to add a line to the Invoice Entry screen. Then type or scan the bar code.

Click Add on the Invoice Entry screen. Then type or scan the bar code in the 6 - Bar Code
field on the Custom Inventory Lookup screen.

ENTER BAR CODES ON QUOTES
There are two ways to add an item to a quote with a bar code:

Click the Size field and type or scan the item’s bar code.
Click Inventory. Then type or scan the bar code in the 6 - Bar Code field on the Custom
Inventory Lookup screen.

ENTER BAR CODES ON PURCHASE ORDERS AND RECEIVING
DOCUMENTS
There are two ways to add an item to a purchase order or a receiving document with a bar code:

Press to add a line to the Purchase Order or Receiving Document screen. Then scan or type
the bar code in the InvNo field (purchase orders) or Product Code field (receiving
documents).

Click Add on the Purchase Order or Receiving Document screen. Then type or scan the bar
code in the 6 - Bar Code field on the Custom Inventory Lookup screen.

GL CODES
GL codes connect your inventory items to TireMaster’s accounting system. GL codes specify which
departments and GL accounts to post to when items are bought, sold, and included in other
transactions.

Example:When an item assigned the GL code BATI is sold or received, an entry posts to the
inventory account 1270–0. This posting occurs because the account 1270–0 is defined as the asset
account in the GL code.
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GL CODE DESIGN
The manner in which you design your GL codes depends on a variety factors. If you’re required to
follow corporate accounting standards, refer to those guidelines to determine how many and what
types of GL codes you need.

You also need to decide whether you want nonstock parts to post to the same sales and cost accounts
as other similar items. Table 12-1 shows you can post the inventory value of nonstock light truck tires
to a general ledger account specifically for noninventoriable items, while the sales and cost amounts
post to the same general ledger accounts as your inventoriable light truck tires.

GL Code: TLTI (Tires Light Truck Inv.) GL Code TLTN (Tires Light Truck Non-Inv.)

Inventory Account 1200–200 Inventory Account 1300–100

Sales Account 4200–200 Sales Account 4200–200

Expense Account 5200–200 Expense Account 5200–200

Table 12-1: Posting to the Same Sales and Cost Accounts

If you want noninventoriable items to post to different general ledger accounts than inventoriable
items, create a GL code that uses different general ledger accounts for inventory, sales, and costs as
shown in Table 12-2.

GL Code: TLTI (Tires Light Truck Inv.) GL Code TLTN (Tires Light Truck Non-Inv.)

Inventory Account 1200–200 Inventory Account 1300–100

Sales Account 4200–200 Sales Account 4300–100

Expense Account 5200–200 Expense Account 5300–100

Table 12-2: Posting to Different Sales and Cost Accounts

When designing GL codes, keep in mind you need to specify which account federal excise tax posts to
for some items. If your state collects a tire fee, you might need to post it to a liability account instead of
a sales account. For inventory and cost accounts, the fee posts as usual.
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INVENTORY GL CODE MAINTENANCE SCREEN

Figure 12-2: GL Code Maintenance Screen

Item Description

GL Code Lets you type a new GL code (up to four letters). Once you save a GL
Code, you cannot modify it (although you can change its other settings).

Description Lets you type a description for the GL code.

Department Lets you specify the department for the items that a GL code will be
assigned to.

Inventory Defines whether the GL code is for inventoriable items.

Std. Cost Defines whether to post items to the general ledger at a standard cost.
Clearing the check box prevents items from posting to the GL at a
standard cost.

Note: Standard cost is a method of forcing TireMaster to maintain a
steady cost for an item because its true cost often fluctuates.

Inv. Acct – Parts Lets you specify which asset account to post to when an item is bought,
sold, or included in other transactions.

Inv. Acct – FET Lets you specify which asset account to use for posting federal excise
tax.

Sales Acct – Parts Lets you specify which income account to use for posting the parts price
when an item is bought, sold, or included in other transactions.

Sales Acct – FET Lets you specify which sales account to use for posting federal excise
tax.
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Item Description

Sales Acct – Labor Lets you specify which income account to use for posting the labor price
when an item is bought, sold, or included in other transactions.

Expense
Acct – Parts

Lets you specify which account the item's cost will post to when an item
is bought, sold, or included in other transactions.

Expense
Acct – FET

Lets you specify which expense account to use for posting federal
excise tax.

OK Saves changes and closes the screen.

Cancel Closes the screen without saving changes.

ADD GL CODES
GL codes are typically created during the going online process. However, if you start selling different
types of items and services, you might need to create additional GL codes. You can also change most
settings for GL codes and delete them if they’ve never been used. Before you can create new GL
codes, make sure the chart of accounts is set up.

Note: The TireMaster startup database includes more than two dozen GL codes. You can use these
codes as is, modify them, or delete them and create your own codes.

To add a GL code
1. Select Inventory > Inventory GL Codes. The Inventory GL Code List opens.

Tip: You can also access the Inventory GL Code List from the Setupmenu.

2. Click Add. The Inventory GL Code Maintenance screen opens.

3. Type a unique code in theGL code field.
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Note: GL codes can be up to four characters long. Once you save the code, it cannot be
changed.

4. Type a description for the GL code.

5. If you have only one department, leave the department number alone. Otherwise, click the
Department field and press . Then select a department from the list that appears.

6. If the GL code is for inventoriable items, leave the Inventory check box selected. If it’s for
noninventoriable items, clear the check box. For more information, see Inventoriable Items on
page 204 and Noninventoriable Items on page 204

7. To post items assigned the GL code to the general ledger at a standard cost, select the Std Cost
check box. Otherwise, leave it alone.

Note: Standard cost is a method of forcing TireMaster to maintain a steady cost for an item
because the true cost fluctuates often.

8. Assign general ledger accounts to the GL code. For each account, click the account field and press 
. Then select an account from the chart of accounts.

Note: If the code will be assigned to a tax or a fee, assign a liability account in the Sales Acct -
FET and Sales Acct - Labor fields.

Tip: In the FET account fields, enter the same GL account that you used for the parts account
entries. For example, if you entered GL account 5270-0 in the Expense Acct - Parts
field, also enter GL account 5270-0 in the Expense Acct - FET field.

9. To save the GL code, clickOK.

SET THE DEFAULT GL CODE
The default GL code is automatically assigned to new items as they’re added to TireMaster.
Depending on the item, you can use the default GL code or assign a different one.
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To set the default GL code
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theGeneral Ledger tab.
3. Select Default Inventory GL Code and press Enter. The Inventory GL Code List appears.

4. Select the code that you want to use as the default GL code and clickOK.
5. Close the System Controls screen.

UPDATE A GL CODE
If you change your chart of accounts, you might need to update the settings for some GL codes. You
can change all of the settings for a GL code except the four-character code itself.

Note: If you update the accounts assigned to a GL code, you might need to make adjusting journal
entries.

To edit a GL Code
1. Select Inventory> Inventory GL Codes. The Inventory GL Code List opens.

Tip: You can also access the Inventory GL Code List from the Setupmenu.

2. Select the GL code you want to update and click Edit. The Inventory GL Code Maintenance
screen opens.

355



356

User Guide

3. Change the description, general ledger accounts, department, and inventory and standard cost
check boxes as needed.

4. To save your changes, clickOK.

DELETE A GL CODE
GL codes that have never been assigned to items can be deleted.

To delete a GL code
1. Select Inventory > Inventory GL Codes. The Inventory GL Code List opens.

Tip: You can also access the Inventory GL Code List from the Setupmenu.

2. Select the code you want to delete, and click Delete. A confirmation message appears.

3. Click Yes. The GL code is removed from the database.

INVENTORY GL CODE MAINTENANCE SCREEN
The Inventory GL Code Maintenance screen (Figure 12-3) is used for setting up and managing
GL codes.

Figure 12-3: GL Code Maintenance Screen
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Item Description

GL Code Lets you type a new GL code (up to four letters). Once you save a GL
Code, you cannot modify it (although you can change its other
settings).

Description Lets you type a description for the GL code.

Department Lets you specify the department for the items that a GL code will be
assigned to.

Inventory Defines whether the GL code is for inventoriable items.

Std. Cost Defines whether to post items to the general ledger at a standard cost.
Clearing the check box prevents items from posting to the GL at a
standard cost.

Note: Standard cost is a method of forcing TireMaster to maintain a
steady cost for an item because its true cost often fluctuates.

Inv. Acct – Parts Lets you specify which asset account to post to when an item is bought,
sold, or included in other transactions.

Inv. Acct – FET Lets you specify which asset account to use for posting federal excise
tax.

Sales Acct – Parts Lets you specify which income account to use for posting the parts
price when an item is bought, sold, or included in other transactions.

Sales Acct – FET Lets you specify which sales account to use for posting federal excise
tax.

Sales Acct – Labor Lets you specify which income account to use for posting the labor
price when an item is bought, sold, or included in other transactions.

Expense
Acct – Parts

Lets you specify which account the item's cost will post to when an item
is bought, sold, or included in other transactions.

Expense
Acct – FET

Lets you specify which expense account to use for posting federal
excise tax.

OK Saves changes and closes the screen.

Cancel Closes the screen without saving changes.
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SPECIAL ITEMS
Some items require special configuation so they can be distinguished from other types of items or to
ensure they’re handled properly at point of sale. This chapter includes the following sections.

Consignment Items 360
Gasoline 361
Discounts 365
Fees 366
Shop Supplies 366
Oil Change Items 371
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CONSIGNMENT ITEMS
A consignment is an item that you purchase from a vendor after you sell it.

SET UP CONSIGNMENT ITEMS
Consignments need to be set up as inventoriable items. To define that an item is a consignment, type
the letter C in the Type (G, C, F, D) field on the Inventory Maintenance screen (Figure 13-1).

Figure 13-1: Classify an Item as a Consignment

To establish a stocking level for a consignment item, create a receiving document for the vendor who
supplies the item and define the quantity you have to sell. Then receive the item but do not price it.
Establishing the stocking level in this manner ensures that the item’s available quantity is shown on the
Inventory List. For more information, see Create a Receiving Document on page 284.

Because the item is unpriced (you haven't bought it from the vendor), it will not affect the sales reports
or post to the general ledger (in TireMaster Plus and TireMaster Corporate). The receiving document
for establishing a consignment item’s stocking level will never be priced. If the vendor discontinues the
item, reverse the receiving document.

Warning: Do not use the Quantity Adjustment Wizard to manage quantities for consignment items.

BUY AND SELL CONSIGNMENT ITEMS
When a customer buys a consignment item, put it on a work order and complete the invoice as usual.
The sale will reduce the item’s available quantity.

Note: The available quantity is established by putting the consignment item on a receiving document
that is never priced. For more information, see Set Up Consignment Items on page 360.

When the vendor comes back to your store to replenish the item, put it on a new receiving document,
change the quantity to the number sold, and price the receiving. This process increases the item’s
available quantity and creates a payable for the vendor. Once a consigned item is purchased from the
vendor, its cost posts to the general ledger and is included on sales reports. For more information, see
Create a Receiving Document on page 284.
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GASOLINE
TireMaster includes the means to stock and sell gasoline.

ADD GASOLINE TO THE INVENTORY
You can track the amount of gasoline you sell by setting it up as an inventoriable item. To classify an
item as gasoline, type the letter G in the Type (G, C, F, D) field on the Inventory Maintenance screen
(Figure 13-2). If you sell both full-serve and self-serve gasoline from the same reserve, you might want
to set up a gas link.

Figure 13-2: Assign the Letter G to Gas Items

GAS LINKS
By linking two different gasoline items, such as self-serve and full-serve, you can maintain separate
prices and sale data for each product when both come from the same tank.

GAS LINK MAINTENANCE SCREEN
You can manage your gas links with the Gas Link Maintenance Screen.

Figure 13-3: Gas Link Maintenance Screen
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Item Description

Gas Item To Link
From

Displays the following:

The site where the link-from item was set up

The system-assigned number for the link-from item

The link-from item’s description

Note: The Inventory List shows no quantities for this item.

1. Lookup Lets you look up the item that will be linked to another item.

Gas Item To Link
To

Displays the following:

The site where the link-to item was set up

The system-assigned number for the link-to item

The link-to item’s description

2. Lookup Lets you look up an item that you can link the first item to.

OK Saves changes and exits the screen.

Cancel Exits the screen without saving changes.

LINK GAS ITEMS
Linking gas items lets you maintain separate prices and sales data for full-serve and self-serve gas
when it comes from the same tank. When one kind of gas item is linked to another, the total gallons
available are displayed in the record for the item that one gas item is linked to. For example, if you
link full-serve gas to self-serve gas, the number of gallons sold for both kinds of gas is displayed in
the record for self-serve (Figure 13-4).

Figure 13-4: Linked Gas Items

Note: If you set up a gas link before any gas is sold, the number of gallons for the item that’s linked
to another item will be zero. If the Available column displays a quantity other than 0, the gas
link was set up after some gas was already sold.

To link gas items
1. Set up at least two gas items. Make sure the letter G is entered in the Type (G, C, F, D) field on

the Inventory Maintenance screen for each gas item. For more information, see Add an Inventory
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Item on page 205.

2. Select Inventory > Gasoline Combine. The Gas Link Maintenance screen opens.

3. Select the gas item that you want to link to another gas item.

a. Click 1. Lookup, and search for the gas item. For more information, see Inventory Searches
on page 230.

b. When the Inventory List appears, select the item and clickOK. The item's information is
displayed in theGas Item to Link From fields.

4. Select an item for the first gas item to link to.

a. Click 2. Lookup. TireMaster prompts you to search for an item.

b. Type the gas item’s product code and clickOK.
Note: On the Inventory List, this item displays the number of gallons available.

c. When the Inventory List appears, select the item and clickOK. The item's information is
displayed in theGas Item to Link To fields.

5. To save the gas link clickOK.
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Note: Because TireMaster does not include a list of all gas links, you might want to keep a
record of which gas items are linked or name the items in a way that will help you identify
which ones are linked.

VIEW GAS LINKS
If you need to look at a gas link, search for the gas item that is linked to another gas item. Because
TireMaster does not include a list of all gas links, you might want to keep a record of which gas items
are linked or name the items in a way that will help you identify which ones are linked.

To view a gas link
1. Select Inventory > Gasoline Combine. The Gas Link Maintenance screen opens.
2. To find a gas item that is linked to another gas item, click 1. Lookup. TireMaster prompts you to

search for an item.

3. Type the gas item’s product code and click Product Code.
Tip: You can use partial size or product codes for the search.

4. Select the item that’s linked to another gas item, and clickOK. TireMaster displays the
descriptions for both the link-from and link-to items on the Gas Link Maintenance screen.

BREAK GAS LINKS
If you stop selling a particular type of gas (such as full serve) that is linked to another gas item, you
can break the gas link. To break a gas link, make the item you no longer want to use for the gas link
inactive. For more information, see Make an Item Inactive on page 218.

SELL GASOLINE
When selling gasoline, you don’t need to know howmany gallons customers have used to fill their
tanks. TireMaster automatically calculates the number of gallons sold when you enter the price of the
gas on the work order.
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To sell gasoline
1. Start a work order and add a gas item to it. For more information, see Create a Regular Work

Order on page 442.

2. In the row for the gas item, type total amount of gas sold in the Extendfield and press Enter. The
number of gallons used appears in theQuantity field.

3. Add additional items to the work order if needed, and complete it as usual. For more information,
see Complete an Invoice on page 456.

DISCOUNTS
With discounts, you can sell items at reduced prices without having to set up a sale. On invoices,
discounts have a positive quantity and a negative dollar amount. Sometimes, you might want to
include discounts in add-on packages.

The price of a discount is the actually the discount amount.

Example: If a customer hands you a $5 coupon, you would enter $5 as the price of the discount.
TireMaster then turns the $5 into a negative amount.

Discounts can be useful in the following ways:

You can show the discount separately on reports (in a different category or group).

You can ensure that your employees collect a coupon for every discount given.

You can show both the original selling price and the amount discounted on the invoice.

You can track coupon discounts separately from advertisement discounts, which helps you
compare these two types of advertising.

SET UP DISCOUNTS
Discounts are usually set up as noninventoriable items. To classify an item as a discount, type the
letter D in the Type (G, C, F, D) field on the Inventory Maintenance screen (Figure 13-5).
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Figure 13-5: Classifying an Item as a Discount

FEES
With fees, you can track money that isn't a tax that's owed to a government entity. Examples of fees
include state tire fees and state tire tax. Fees require special handling to ensure the money collected is
not included in your income. Like sales tax, fees need to be treated as a payable.

Note: Fee are not same as charges. A charge is an amount you collect from your customers for
services, such as tire disposals, to cover your own costs. Charges are income.

SET UP FEES
Fees are usually set up as noninventoriable items. To classify an item as a fee, type the letter F in the
Type (G, C, F, D) field on the Inventory Maintenance screen (Figure 13-6).

Figure 13-6: Classifying an Item as a Fee

SHOP SUPPLIES
You can automatically include shop charges on invoices. These fees, referred to as shop supplies in
TireMaster, are used to cover expenses for items such as towels and grease.

You can assess shop charges for all of your inventory items, some of your inventory items, or you
might not assess shop charges at all. If you do collect shop charges, the overall shop charge for an
invoice is the total of the smaller fees calculated for individual items on the ticket. In TireMaster, those
per-item fees are one of the following:
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A percentage of the parts price + FET (if any)

A percentage of the labor price

Both of the above

You can define separate parts and labor percentages for calculating shop charges, or the percentage
can be the same for both parts and labor. To ensure that your shop charges aren’t too low or too
excessive, you can set minimum and maximum amounts for them.

SET UP SHOP SUPPLIES
Setting up shop supplies is a three-step process that includes adding a shop supplies item to your
inventory, configuring shop charge calculations, and identifying the items for which you’ll assess shop
charges.

ADD A SHOP SUPPLIES ITEM
The shop supplies item is used for tracking the sales of shop charges.

To add a shop supplies item
The shop supplies item is added to the inventory in the same manner as any other item. Once the
producT code for the shop supplies item is defined and the Inventory Maintenance screen opens,
complete the settings listed below. For more information, see Add an Inventory Item on page 205.

Define basic settings, including product code, description, and group.

Note: The entry in the Description field prints in the lower-right corner of invoices. For
example, if you call the item Shop Charge, the label Shop Charge will appear on your
invoices.

Type N, for noninventoriable, in the Inventory (Y/N) field.

Make sure the Charge ShopParts and Labor check boxes are clear. (Otherwise, you’ll
assess a shop charge for your shop charge item.)

Assign an inventory category and GL code.
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Leave the parts and labor prices set to $0.00.

SET THE SHOP SUPPLIES CONTROLS
Most of the system controls for the shop supplies item define how shop charges are calculated.

To set the shop supplies controls
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Inventory tab.
3. Enable shop charges.

a. Select Shop Supplies (Yes or No) and press Enter.
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b. Select Yes and clickOK.
4. Set the maximum and minimum amounts for shop charges.

a. Select Shop Supplies Amount - Maximum and press Enter.
b. Type the highest amount to charge and clickOK.
c. Select Shop Supplies Amount - Minimum and press Enter.
d. Type the lowest amount to charge and clickOK.

5. Define the shop supplies item.

a. Select Shop Supplies Item - Part# and press Enter.
b. Look up the shop supplies item. For more information, see Inventory Searches on page 230.

6. Define the labor price percentage for calculating shop charges.

a. Select Shop Supplies Labor Amount - Percentage (%) and press Enter.
b. Type the percentage and clickOK.

7. Define the parts price percentage for calculating shop charges.
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a. Select Shop Supplies Parts Amount - Percentage (%) and press Enter.
b. Type the percentage and clickOK.

8. Close the System Controls screen.

ADD THE SHOP CHARGE TO ITEMS
Once the shop supplies item has been added and the calculation defaults have been set, you can
define whether to assess shop charges for inventory items. You can add shop supplies to individual
items or a group of items:

For a single item, look up the item. When the Inventory Maintenance screen opens, click Edit
and select the Shop Charge Parts check box, the Shop Charge Labor check box, or both.
For more information, see Update Information for a Single Item on page 210.

For multiple items, select Inventory > List Editing and look up a group of items. When the list
editing screen opens, select the Shop Parts check box, the Shop Labor check box, or both
for as many items as needed. For more information, see Update Information for Multiple Items
on page 211.
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Tip: You can rearrange the columns on the Inventory List Editing screen so the Shop Parts
and Shop Labor columns are closer to the columns for the items’ descriptions.

OIL CHANGE ITEMS
When you add oil change items to the inventory, include the word oil in their product codes,
descriptions, or both (Figure 13-7). Setting up oil change items in this manner simplifies the process of
creating oil change work orders, and it helps you to consistently use the same filter and engine oil
every time customers come in for oil changes.

Figure 13-7: Items with the Word Oil

Here’s how it works. When you need to add an oil change to a work order, you can retrieve a list of oil-
change items previously sold to the customer (Figure 13-8). Then you can select items on the list that
you want to reuse, and copy them onto the new work order. For more information, see Oil Change
Work Orders on page 446.
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Figure 13-8: List of Oil Change Items Previously Sold to a Customer

When populating the list, TireMaster looks at the customer’s prior sale invoices to see if any of them
include items with the word oil in their product codes or descriptions. If the word oil exists, the items
from those invoices are included on the list and they can be reused for new work orders.

OIL CHANGE ITEM EXAMPLES
To be included on the Oil History Invoices screen, an item’s product code, description, or both must
include the word oil. Here are some examples of oil-change items that would be available for reuse:

Product Code LOFSRV and Description Lube, Oil & Filter Service

Product Code LOFOIL and Description 0W-20 Engine Oil

Product Code LOFILT and DescriptionWix Oil Filter



COSTING METHODS
TireMaster includes a variety of options for tracking the cost of the items you sell. The costing method
used depends on whether an item is classified as inventoriable or noninventoriable. This chapter
includes the following sections:

Inventoriable Costing Methods 374
Noninventoriable Costing Methods 375
Standard Cost 383
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INVENTORIABLE COSTING METHODS
Inventoriable costing methods calculate changes in an item’s value when it’s sold and received. To
determine an item’s next cost, you need to use one of three inventoriable costing methods.

FIRST IN, FIRST OUT
With the first in, first out (FIFO) costing method, TireMaster uses the cost of the first item received as
the next cost of the item.

Example: If you receive a tire in January at a cost of $50 and tire in February at a cost of $60, the
next cost of the item will be $50—the cost of the tire that was received first. The next time you sell
one of the tires, a $50 cost is used to calculate the value of the tire and a $50 cost posts to the gen-
eral ledger.

LAST IN, FIRST OUT
With the last in, first out (LIFO) costing method, TireMaster uses the cost of the last item received as
the item’s next cost.

Example: If you receive a tire in January at a cost of $50 and a tire in February at a cost of $60, the
next cost of the item will be $60—the cost of the tire that was received last. The next time you sell
one of those tires, a $60 cost is used to calculate the value of the tire and a $60 cost also posts to
the general ledger.

AVERAGE
With the average (AVG) costing method,TireMaster averages the various costs at which an item is
received and then uses that average as the item’s next cost.

Example: If you receive a tire in January at a cost of $50 and a tire in February at a cost of $60, the
next cost of the item will be $55—the average of the two costs. The next time you sell one of those
tires, a $55 cost is used to calculate the value of the tire and a $55 cost also posts to the general
ledger.

DEFINE THE INVENTORIABLE COSTING METHOD
To define the inventoriable costing method, you need to set a system control. The costing method that
you choose is used to track the cost of all inventoriable items.

To set the inventoriable costing method
1. Select Setup > System Controls. The System Controls screen opens.
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2. Click the Inventory tab.
3. Select Inventory Cost Method (FIFO, AVG, LIFO) and press Enter.

4. Select one of the following:

FIFO

AVG

LIFO

Note: Once you set the inventoriable costing method, it cannot be changed.

5. ClickOK.
6. Close the System Controls screen.

NONINVENTORIABLE COSTING METHODS
With noninventoriable costing methods, you define the amount to use as an item’s cost. The costing
method for noninventoriable items is defined in the inventory records for those items. Three
noninventoriable costing methods are available, and you can use one, two, or all of them.

EXPENSE METHOD
The expense method is often used for low cost items and labor items.

To set up an expense method item
1. Add the item to the inventory. For more information, see Add an Inventory Item on page 205.

2. On the Inventory Maintenance screen, do the following.

a. Type the letter N in the Inventory(Y/N) field.

b. Make sure the Force Option Cost check box is clear.
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c. If you want to track the item, select the Track check box. Otherwise, leave it alone. For more
information, see Item Tracking on page 297.

3. Open the pricing screen.

a. Click theQty/Pricing tab.

b. Click Detail/Edit.

4. Make sure the entry in the Relief % field is set to 0.00.

5. To save your changes, clickOK.
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6. Close the open screens.

RELIEF PERCENT METHOD
With the relief percent method, TireMaster calculates an estimated cost using the following formula:
Estimated Cost = Parts Price x Relief Percent. The relief percent method is often used to handle
the cost of small parts that you usually keep in stock but for which you don’t track quantities.

To set up a relief percent item
1. Add the item to the inventory. For more information, see Add an Inventory Item on page 205.

2. On the Inventory Maintenance screen, do the following.

a. Type the letter N in the Inventory(Y/N) field.

b. Make sure the Force Option Cost check box is clear.

c. If you want to track the item, select the Track check box. Otherwise, leave it alone. For more
information, see Item Tracking on page 297.

3. Open the pricing screen.

a. Click theQty/Pricing tab.

b. Click Detail/Edit.
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4. Type the percentage of the parts price that you want to use as the item’s cost in the Relief % field.

Note: This value needs to be as a whole number (for example, 80.00).

5. To save your changes, clickOK.

6. Close the open screens.

OPTION COST METHOD
With the option cost method, you enter an item’s actual cost, including federal excise tax, at point of
sale. The option cost method should be used when you perform outside purchases. That is, when you
buy items you normally don’t stock, such as service parts and special order tires.

Note: If you've set up a cost replacement code, you can enter an item's cost at point of sale by typing
the item’s cost (numbers) or you can use letters from the cost replacement code. For more
information, see Cost Replacement Codes on page 381.

To set up an option cost item
1. Add the item to the inventory. For more information, see Add an Inventory Item on page 205.

2. On the Inventory Maintenance screen, do the following.

a. Type the letter N in the Inventory(Y/N) field.

b. Select the Force Option Cost check box.
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c. If you want to track the item, select the Track check box. Otherwise, leave it alone. For more
information, see Item Tracking on page 297.

3. Open the pricing screen.

a. Click theQty/Pricing tab.

b. Click Detail/Edit.

4. Do one of the following:

Leave the Relief % set to 0.0000.

Type a relief percent for the item. This value will be used to calculate the item’s cost when its
cost is not entered at point of sale.
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Note: You can define whether entering an item’s cost is mandatory by setting a system
control. For more information, see Force Option Cost Control on page 380.

FORCE OPTION COST CONTROL
With a system control, you can force users to enter the cost of items for outside purchases at point of
sale.

To set the Force Option Cost control
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theOther tab.
3. Select Force Option Cost Required and press Enter.

4. Select one of the following:

To require users to enter an item’s cost at point of sale, select Yes. This setting prevents
users from entering a cost of $0.00.

To allow users complete an invoice without entering an item’s cost, select No. With this
setting, users will receive a reminder about entering the item’s cost.

5. Close the System Controls screen.

ENTER AN ITEM’S COST AT POINT OF SALE
If an item is assigned the option cost costing method, you need to enter its cost, including federal
excise tax, at point of sale. The option cost method is typically assigned to service parts and special
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order tires obtained through outside purchases.

When you add an option cost item to a work order, TireMaster prompts you for the cost by turning the
item’s line pink. To enter the cost, select the item and clickOption Cost (Figure 14-1).

Figure 14-1: Option Cost Entry Prompt

When the Option Cost screen opens, type the item’s cost or its corresponding cost replacement code
in theOption Cost field (Figure 14-2). If entering the item's cost is required, the amount must be
greater than $0.00. For more information, see and Force Option Cost Control on page 380.

Figure 14-2: Entering an Item’s Option Cost

Note: If the item included FET when it was received, include the FET in the item's cost.

Note: Cost replacement codes are case sensitive.

Once the item’s cost is entered, you can put the item on a receiving document. For items with
tracking enabled, putting the item on a receiving document is required. For more information, see
Perform Outside Purchases on page 323 and Outside Purchases for Tracked Items on page 323.

COST REPLACEMENT CODES
A cost replacement code lets you print a noninventoriable item’s cost on an invoice without revealing
the cost to the customer. If the customer returns the item, the code makes it easy for you to record the
item’s actual cost. Cost replacement codes can be used for items assigned the option cost and relief
percent costing methods. For option cost items, you enter the cost replacement code at point of sale.

A cost replacement code is comprised of a series of ten letters that represent numbers. Each letter in
the code must be unique. The same cost replacement code is used for all sites.

381



382

User Guide

Example: For the code HEAVYSTOCK, the letter H is 0, the letter E is 1, the letter A is 2, and so on.

Set Up a Cost Replacement Code
The cost replacement code is configured in System Controls. First, create the code. Then define
whether to print it on invoices and display it on the Option Cost screen at point of sale.

To set up a cost replacement code
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Inventory tab.
3. Define the cost replacement code.

a. Select Cost Replacement Code and press Enter.

b. Type a ten letter code. Each letter in the code must be unique. (Example: HEAVYSTOCK.)

Note: Cost replacement codes are case sensitive, so whether you type uppercase or
lowercase letters here affects how you enter the code at point of sale.

c. ClickOK.
4. Define whether to print the code on invoices.

a. Select Cost Replacement Code - Show on Invoices and press Enter.

b. Select Yes or No, and clickOK.
5. Close the System Controls screen.
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STANDARD COST
Standard cost is a method of forcing TireMaster to maintain a steady cost for an item because the
item’s true cost often fluctuates. When an item is sold, its standard cost posts to the general ledger.

TireMaster can also use an item’s standard cost as the ordering price for purchase orders and
receiving documents. This happens when Base Price - Use Instead of Last Cost in PO/RD Line is
set to No in System Controls (Inventory tab). Unless the cost is changed on a receiving document or
vendor invoice document, the standard cost posts to the general ledger when an item is received.

SET UP STANDARD COST ITEMS
To maintain a standard cost for items, do the following:

Define which GL codes can be used for tracking a standard cost.

Assign those GL codes to the items for which you want to track a standard cost.

Define the standard cost amount for items that are assigned the GL codes for standard cost.

To set up standard cost items
1. Select the Std. Cost check box (on the Inventory GL Code Maintenance screen) for each GL code

that will be assigned to standard cost items. For more information, see Add GL Codes on page 353
and Inventory GL Code Maintenance Screen on page 356.

2. Assign a standard cost GL code to each item for which you want to maintain a standard cost. For
more information, see Add and Manage Items on page 205 and Inventory Maintenance Screen on
page 219.

3. On the Site Prices and Quantity screen, type the standard cost in the Std. Cost field.
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PRICING
TireMaster includes a variety of options for pricing items and offering special prices to individual
customers. This chapter includes the following sections:

Fixed Prices 386
Factor Based Price Calculations 387
Site Prices and Quantity Screen 395
Pricing Wizard 398
Pricing Wizard Screen 409
Price Levels 413
A–E Price Levels 422
Price Level Discount Edit Screen 430
Price Matrices 432
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FIXED PRICES
When you add or update an item, you can set a fixed price for the it. A fixed price is an amount you type
in a price field. The steps for setting fixed prices are the same for both inventoriable and
noninventoriable items.

To set a fixed price an item
1. Look up the item whose price you want to set. For more information, see Inventory Searches on

page 230.

2. On the Inventory Maintenance screen, click theQty/Pricing tab.

3. Click Detail/Edit. The Site Prices and Quantity screen opens.

4. Type the item’s price, excluding labor, in the Parts field.
5. Type the item’s labor price, if any, in the Labor field. TireMaster displays the sum of the parts price

and the labor price in the EDL field.

Note: EDL stands for everyday low.

6. To save the updated prices, clickOK.

7. Close the Inventory Maintenance screen.
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FACTOR BASED PRICE CALCULATIONS
You can calculate an item's parts price with a markup or a margin. For these types of price
calculations, you need to specify a factor, which is the number that’s used to compute the markup or
margin. Depending on the pricing method, the factor is either multiplied or divided by an item’s base
price or last cost. Once a factor and an operator have been assigned to an item or a group of items,
you need to recalculate the parts price.

MARKUPS
Amarkup is an amount that’s added to your cost for an item. To calculate an item’s price with a
markup, TireMaster uses the following formula: Item Cost x Factor = Parts Price.
For markups, enter the following in the item's price configuration on the Site Prices and Quantity
screen (Figure 15-1):

In theOp (operator) field, type the letter M.

In the Factor field, type the factor as a decimal.

Figure 15-1: An Item’s Markup Settings

In Figure 15-1, TireMaster calculates a 30%markup for an item. The Min theOp field tells TireMaster
to multiply the item’s cost of $32.00 (the base price) by the factor of 1.30. The result is the new
parts price of $41.60.

To determine which number to type in the Factor field for markups, add 100% to the markup percent
you want to use. The sum is the factor.

Example: If you want a 21%markup, use the following calculation: 100% + 21% Markup = 121%
Factor. Then change the factor to a decimal. In this instance, you’d type 1.21 in the Factor field
for the item's price settings.

Table 15-1 shows you the amount to type in the Factor field to calculate various markups:
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Markup Amount to type in the Factor field

10% 1.10

15% 1.15

20% 1.20

25% 1.25

30% 1.30

Table 15-1: Markup Factors

Once you have defined the operator and factor in an item's price settings, recalculate the item’s parts
price. For more information, see Recalculate Factor Based Prices on page 391.

Note: For a group of similar items (such as those from the same product line), use Inventory List
Editing to define the operator and factor. For more information, see Update Information for
Multiple Items on page 211. If you have a group of items for which only the factors need to be
updated, use the Pricing Wizard instead. For more information, see Assign a Factor to a Group
of Items on page 389.

MARGINS
Amargin is the difference between your cost for an item and its selling price. In other words, it's the
profit you want to make. To calculate an item’s parts price with a margin, TireMaster uses the following
formula: Item Cost ÷ Factor = Parts Price.
For margins, enter the following in the item's price configuration on the Site Prices and Quantity screen
(Figure 15-2):

In theOp (operator) field, type D.

In the Factor field, type the factor as a decimal.

Figure 15-2: An Item’s Margin Settings
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In Figure 15-2, TireMaster calculates a 20%margin for an item. The Din theOp field tells TireMaster to
divide the item’s cost of $38.00 (the base price) by the factor of .80. The result is the new parts
price of $47.50.

Example: To determine which number to type in the Factor field for margins, subtract the margin
percent from 100%. The difference is the factor. Therefore, if you want a 40%margin, use the fol-
lowing calculation: 100% - 40% Markup = 60% Factor. Then change the factor to a decimal. In
this scenario, you’d type .60 in the Factor field.

Table 15-2 shows the amount to type in the Factor field to calculate various margins:

Margin Amount to type in the Factor field

10% .90

15% .85

20% .80

25% .75

30% .70

Table 15-2: Margin Factors

Once you have defined the operator and factor, recalculate the item’s parts price. For more
information, see Recalculate Factor Based Prices on page 391.

Note: For a group of similar items (such as those from the same product line), use Inventory List
Editing to define the operator and factor. For more information, see , Update Information for
Multiple Items on page 211. If you have a group of items for which only the factors need to be
updated, use the Pricing Wizard instead. For more information, see Assign a Factor to a Group
of Items on page 389.

ASSIGN A FACTOR TO A GROUP OF ITEMS
If you want to assign the same factor to a group of items, you can reduce the amount of time this task
requires by using the Pricing Wizard.

Note: If you need to change both the factor and operator for a group of items, use Inventory List
Editing instead. Only the factor can be updated with the Pricing Wizard.

To assign a factor to a group of items
1. Select Inventory > Pricing Wizard.
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2. When the Pricing Wizard opens, make sure Price Change is selected.

3. Leave the Source Field field alone for the operation being used to update factors.

4. From the Field to Update drop-down, select Factor. The Value field appears and replaces the
price change fields.

5. Type the factor you want to assign in the Value field. (Example: For a 30%margin, type 70.)

6. If you want to recalculate the selling price now, select the Item Factor check box for the next
operation. Otherwise, disregard this step. For more information, see Recalculate Prices for a
Group of Items on page 393.

7. Click Inventory, and search for the item or items to which you want to assign the factor. For more
information, see Inventory Searches on page 230.
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8. Review the pending changes.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.

b. Verify that the changes you want will be made.

c. Print the report if needed, and close the Report Window.

d. Make adjustments to the update criteria and the selected items if needed, and print the report
again.

9. Click Apply. A confirmation message appears.

10. Click Yes. A second message verifies the update has been completed.

11. ClickOK.
To view the factor for a single item, look at the Factor field on the Site Prices and Quantity screen. For
multiple items, select Inventory > List Editing, and look up the same items you just updated. The
factor is listed in the lower-right half of the Inventory List Editing screen. If you can’t see it, scroll to the
right.

RECALCULATE FACTOR BASED PRICES
Once an item’s factor is assigned or updated, you need to recalculate the item’s price. You can
recalculate factor based prices for an individual item or a group of items.

RECALCULATE PRICES FOR INDIVIDUAL ITEMS
When the factor for a single item is changed, you can recalculate its selling price right away.
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To recalculate an item’s factor based price
1. Search for the item whose price you want to update. For more information, see Inventory

Searches on page 230.

2. On the Inventory Maintenance screen, click theQty/Pricing tab.

3. Click Detail/Edit. The Site Prices and Quantity screen opens.

4. Change the base price, last cost, price by method, and operator if needed. For more information,
see Site Prices and Quantity Screen on page 395.

5. Change the item’s factor.

6. Click Recalculate. Depending on a system control setting, a confirmation message appears or
the item’s parts price updates immediately. For more information, see Show Recalculate/Update
EDL Message on page 1208.
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7. To save your changes, clickOK .

8. If you want to implement the changes at all of the other sites, click Update All Sites (in
TireMaster Corporate). The changes will take effect at the stores after a replication cycle occurs

Note: If you updated the item’s factor, base price, or both, those changes can also be sent to
the stores depending on a system controls setting. For more information, see Update
Factor and Base Price at All Sites on page 1203.

9. Close the Inventory Maintenance screen.

RECALCULATE PRICES FOR A GROUP OF ITEMS
Once the factors have been updated for a group of items, you can use the Pricing Wizard to
recalculate the parts prices for the items in that group.

To recalculate factor based prices for a group of items
1. If you haven’t already done so, define the operator, factor, or both for the items. For more

information, see Site Prices and Quantity Screen on page 395

2. Select Inventory > Pricing Wizard.

3. When the Pricing Wizard opens, make sure Price Change is selected.
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4. Select the Item factor check box for the operation being used to recalculate prices.

5. If you want to end the prices for all updated items with the same amount after the decimal, select
the Ending in Cents check box. Then type the cents amount as a whole number. For example, if
you type 99, the prices of all updated items would end in 99 cents ($5.99, $34.99, and $199.99).

6. Click Inventory. TireMaster prompts you to search for items.

7. Look up the items whose factor based prices you want to recalculate. For more information, see
Inventory Searches on page 230.

8. Review the pending changes.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.



Site Prices and Quantity Screen

b. Verify that the changes you want will be made.

c. Print the report if needed, and close the Report Window.

9. To change the prices, click Apply. A confirmation message appears.

10. Click Yes. A second message verifies the update has been completed.

11. ClickOK.
You can view the updated prices on the Inventory List or by printing an Inventory Master List.

SITE PRICES AND QUANTITY SCREEN
With the Site Prices and Quantity screen (Figure 15-3), you can manage stocking levels and set prices
for items.

Figure 15-3: Site Prices and Quantity Screen
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Item Description

OnHand Displays the system-generated quantity that has been received and
priced, minus any on work orders.

NotPriced Displays the system-generated quantity that has been received, but not
priced.

Workorder Displays the system-generated quantity that has been added to one or
more open work orders.

OnOrder Displays the system-generated quantity that has been ordered, but not
delivered.

Note: This value can also include items on consignment.

AtRecap Not used.

Min Stk Lets you set a minimum stocking level for an inventoriable item.

Max Stk Lets you set a maximum stocking level for an inventoriable item.

Location Lets you define where the item is kept.

Misc. Sort Lets you define an alternative sort order for the Inventory List.

Tip: To list items with the highest profit margins first, you could rank
them with a 1 to represent the highest profit margin.

Last FET Lets you enter the federal excise tax you paid for the item the last time it
was received. TireMaster updates this amount after you price each new
receiving.

Note: To use this amount on receivings and work orders, the system
control Use Next FET for POS/Receivings (Inventory tab)
needs to be set to No.

Next FET Displays the system-generated average cost of the item’s federal excise
tax.

Note: To use this amount on receivings and work orders, the system
control Use Next FET for POS/Receivings (Inventory tab)
needs to be set to Yes.

Price Matrix Lets you assign a price matrix to the item. For more information, see
Price Matrices on page 432.

Parts Lets you set the price, excluding labor, for the item.

Labor Lets you set a labor price for the item.
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Item Description

EDL Displays the item’s everyday low price, which is the sum of the parts
price and the labor price.

Relief % Lets you define a percentage (as a decimal) that is used to estimate the
cost of noninventoriable items. This entry enables the item’s cost to post
to the GL once the invoice is completed.

Flat Rate Lets you define the amount of time it takes an average mechanic to
perform a service or repair. Flat rates are used for labor items only.

Note: This entry enables you to calculate the number of hours
mechanics spend completing services and repairs.

Price By Lets calculate a markup or margin for the item based on either its base
price or last cost.

Note: The price change using the specified margin or markup takes
effect once you recalculate the item’s price. For more
information, see Recalculate Factor Based Prices on page 391.

Op Lets you define which factor to use when recalculating the item’s price:

M for markup (multiplies the item’s cost by the factor)

D for margins (divides the item’s cost by the factor)

Note: Op stands for operator.

Base Price Lets you enter an amount that parts price calculations are based on.
Using a base price instead of last cost prevents prices from fluctuating
with each receiving.

Note: To use the base price as the ordering price for purchase orders
and receiving documents, set the system control Base Price -
Use Instead of Last Cost for POs/RDs (Inventory tab) to
Yes.

Last Cost Displays the amount that the item last cost you. You can manually
update this amount if needed.

Note: If the last cost is $0.00, the amount of the base price will be
copied into this field.

Core Cost Lets you assign a core cost to an item. For more information, see
Maintain Core Cost Information on page 937.

Factor Lets you define a percentage (as a decimal) to use for updating the
item’s price with factor based price calculations.

Note: Depending on which operator you use, the item’s cost is either
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Item Description

multiplied or divided by the number in this field.

Std. Cost Lets you set a standard cost for the item.

Note: Standard cost is available in TireMaster Plus and TireMaster
Corporate systems. Standard cost forces TireMaster to
maintain a steady cost for an item because its true cost often
fluctuates.

Next Cost Displays the amount that will be the item’s cost the next time it’s sold.
The item's costing method defines how the item's next cost is
calculated.

Sale Begin Lets you set the date when a sale price for the item will go into effect.

Sale End Lets you set the date when the item’s sale price ends. Normal pricing
resumes the next days.

Sale Parts Lets you set a temporary price for an item, excluding labor.

Sale Labor Lets you set a temporary price for labor.

Sale Price Displays the sale price for the item, which is the sum of the sale parts
and sale labor prices.

Levels Lets you offer special pricing for an item by setting up to five, arbitrary
prices. These prices are known as A–E price levels. For more
information, see A–E Price Levels on page 422.

Recalculate Lets you recalculate an item’s parts price when the factor, cost, or both
are changed.

Update All Sites Lets you implement the changes you’ve made (such typing a different
amount or recalculating the item’s parts price) at the other sites.

OK Saves your changes and exits the screen.

Cancel Exits the screen without saving any changes.

PRICING WIZARD
With the Pricing Wizard, you can update price and cost information for a single item or a group of
items. The types of changes you can make include updating selling prices and vendor prices (your
cost), assigning factors for calculating margins and markups, recalculating factor based prices, and
putting items on sale.

In addition to price changes, the Pricing Wizard can be used to assign price matrices, set stocking
levels, and assign color/spiff codes.
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The Pricing Wizard allows you to make up to three changes, known as operations, at one time. For
example, you could update cost information, assign a factor, and recalculate the selling prices for a
group of items.

Note: The Pricing Wizard is available only at the corporate site.

CHANGE PRICES FOR A GROUP OF ITEMS
When you need to update selling prices, costs, or A–E price levels for a group of items, you can make
the changes with the Pricing Wizard.

Note: If you need to update A–E price levels for a group of items in a TireMaster Corporate
environment, see Update Multi-Store A–E Price Levels with the Pricing Wizard on page 426.

To make price changes to a group of items
1. Select Inventory > Pricing Wizard.

2. When the Pricing Wizard screen opens, make sure Price Change is selected.

3. From the Source Field drop-down for the first operation, select the field that the changes will be
based on.

Note: If you select Price Level, you'll be prompted to define which price level and whether to
update the parts or labor price for that level.

4. From the Field to Update drop-down, select the field that will be updated.
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Note: If you select Price Level, you'll be prompted to define which price level and whether to
update the parts or labor price for that level.

5. Define whether the change will be a percentage or a fixed dollar amount:

For a percentage, select Percentage Change and type the percentage (with no decimals).

For a fixed dollar amount, select $ Amount Change and type the amount.

Note: For increases, use positive numbers. For decreases, use negative numbers (such as -2).

6. To end the prices of all updated items with the same amount after the decimal, select the Ending
in Cents check box. Then type the cents amount as a whole number.
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Example: By typing 99, the prices of all updated items would end in 99 cents ($5.99, $34.99, and
$199.99).

7. Click Inventory, and look up the item or items you want to update. For more information, see
Inventory Searches on page 230.

Warning: Search only for the items you want to update. Retrieving a set of items that’s too broad
can result in unwanted changes.

8. Review the pending changes.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.

b. Verify that the changes you want will be made.

c. Print the report if needed, and close the Report Window.

d. Make changes to the update criteria and look up different items if needed. Then print the report
again.

9. Implement the update.

a. Click Apply. A confirmation message appears.

b. Click Yes. A second message verifies the update has been completed.

401



402

User Guide

c. ClickOK.
You can view the new prices on the Inventory List or by printing an Inventory Master List.

MAKE MULTIPLE CHANGES TO A GROUP OF ITEMS
With the Pricing Wizard, you can make up to three changes to a group of items. Each change is called
an operation. Because TireMaster processes operations sequentially, define them in a logical order.

Example: You would update the cost of items before recalculating their parts prices.

To make multiple changes to a group of items
1. Select Inventory > Pricing Wizard.

2. Make sure Price Change is selected.

3. Define the criteria for two or three operations. Depending on the types of changes you want to
make, refer to the following:

Change Prices for a Group of Items on page 399

Factor Based Price Calculations on page 387

Assign a Price Matrix on page 437

Update Stocking Levels for a Group of Items on page 404

Update the Color/Spiff Code for a Group of Items on page 404
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4. Click Inventory and look up the items you want to update. For more information, see Inventory
Searches on page 230.

5. Review the pending changes.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.

b. Verify that the changes you want will be made.

c. Print the report if needed, and close the Report Window.

d. Make adjustments to the update criteria and the selected items if needed, and print the report
again.

6. Implement the changes.

a. Click Apply. A confirmation message appears.
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b. Click Yes. A second message verifies the update has been completed.

c. ClickOK.

UPDATE THE FACTOR FOR A GROUP OF ITEMS
The Pricing Wizard can be used to assign a factor (for a margin or markup) to a group of items and
recalculate the selling prices of those items. For more information, see Assign a Factor to a Group of
Items on page 389 and Recalculate Prices for a Group of Items on page 393.

UPDATE THE PRICE MATRIX FOR A GROUP OF ITEMS
The Pricing Wizard can be used to assign a price matrix to a group of items. For more information,
see Assign a Matrix to a Group of Items on page 438.

UPDATE STOCKING LEVELS FOR A GROUP OF ITEMS
The Pricing Wizard can be used to set minimum stocking levels, maximum stocking levels, or both for
a group of items. For more information, see Assign Stocking Levels to a Group of Items on page 215.

UPDATE THE COLOR/SPIFF CODE FOR A GROUP OF ITEMS
The Pricing Wizard can be used to assign a color/spiff code to a group of items. For more information,
see Assign the Same Color/Spiff Code to a Group of Items on page 890.

PUT ITEMS ON SALE
You can use the Pricing Wizard to set temporary selling prices for a group of items.

To set up a sale with the Pricing Wizard
1. Select Inventory > Pricing Wizard.

2. When the Pricing Wizard opens, select Sale. The Begin Date and End Date fields become active.
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3. Enter the dates when the sale will start and end.

4. From the Source Field drop-down for the first operation, select the field that the sale prices will be
based on.

Note: If you select Price Level, you'll be prompted to define which price level and whether to
update the parts or labor price for that level

5. From the Field to Update drop-down, select Sale Parts or Sale Labor.

6. Define whether the sale price will be calculated with a percentage or a fixed dollar amount:

For a percentage, select Percentage Change and type the percentage (with no decimals).

For a fixed dollar amount, select $ Amount Change and type the amount.
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Note: For increases, use positive numbers. For decreases, use negative numbers (such as -2).

7. To end the prices of all sale items with the same amount after the decimal, select the Ending in
Cents check box. Then type the cents amount as a whole number. For example, by typing 79, the
prices of all sale items would end in 99 cents ($5.79, $34.79, and $199.79).

8. If you’re putting both parts and labor on sale, repeat steps 4 through 7 for the second operation.

9. Click Inventory and look up the item or items you want to put on sale. For more information, see
Inventory Searches on page 230.

10. Review the pending sale prices.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.
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b. Verify that the changes you want will be made.

c. Print the report if needed, and close the Report Window.

d. Make adjustments to the sale criteria and the selected items if needed, and print the report
again.

11. Implement the sale prices.
a. Click Apply. A confirmation message appears.

b. Click Yes. A second message verifies the update has been completed.

c. ClickOK.
When the sale goes into effect, the sale items will be highlighted in cyan on the Inventory List and
they’ll be included on the Items on Sale Report.

PRICING WIZARD CONFIGURATIONS
If you frequently use the same parameters to update a group of items, you can simplify future Pricing
Wizard updates by saving and reusing the settings selected for the current update.

SAVE PRICING WIZARD CONFIGURATIONS
When you define the criteria for updating items with the Pricing Wizard, you can save those settings
and the list of items updated by those settings for future use.

To save Pricing Wizard configurations
1. On the Pricing Wizard screen, define the parameters you want to use and the items you want to

update.

Note: If you don’t look up any items, the Pricing Wizard retrieves all items from your inventory.

2. Click Save Configuration. TireMaster The Save/Load Configuration screen opens.
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3. Type a name for the configuration.

4. Click Save. The Save/Load Configuration screen closes.

5. Finish updating the items as usual. The saved configuration is available for future updates.

REUSE PRICING WIZARD CONFIGURATIONS
When you save Pricing Wizard configurations, you can easily retrieve and reuse them for updates
that are the same or similar to past updates.

To reuse pricing wizard configurations
1. If the Pricing Wizard isn’t already open, select Inventory > Pricing Wizard.
2. Click Load Configuration. The Save/Load Configuration screen opens.

3. Select the configuration you want to reuse, and click Load. The Pricing Wizard is populated with
the settings from the saved configuration.

4. Make adjustments to the update criteria or items if needed.

5. To review the pending changes, click Print for Review and look at the report that’s generated.
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6. Click Apply and finish updating the items as usual.

DELETE PRICING WIZARD CONFIGURATIONS
If you no longer need a Pricing Wizard configuration, you can delete it.

To delete a pricing wizard configuration
1. If the Pricing Wizard isn’t already open, select Inventory > Pricing Wizard.
2. Click Load Configuration. The Save/Load Configuration screen opens.
3. Select the configuration you want to remove, and click Delete. A confirmation message appears.

4. Click Yes. The configuration is deleted.
5. Close the Save/Load Configuration screen.

PRICING WIZARD SCREEN
The Pricing Wizard (Figure 15-4) includes tools for updating price information and inventory settings.
For information about using the Pricing Wizard, see Pricing Wizard on page 398.
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Figure 15-4: Pricing Wizard

Item Description

Price Change Lets you implement price changes or update items' settings.

Sale Lets you put items on sale.

Begin Date Defines the starting date for a sale.

End Date Defines the ending date for a sale.

Base Site Used only in TireMaster Corporate environments when updating A–E
price levels. Lets you define the site whose cost or price source field
entries will be used to calculate updated price levels.

Note: The Base Site selection is used when the Field to Update is
set to Price Levels and the Source Field is set to a cost (last,
next, or standard) or a price (base, parts, or labor). The Base



Pricing Wizard Screen

Item Description

Site selection is disregarded when both the Field to Update
and the Source Field are set to Price Levels.

Operation 1 Lets you define criteria for the first change you’ll make to the selected
item or items.

Operation 2 Lets you define criteria for the second change you’ll make to the
selected item or items.

Operation 3 Lets you define criteria for the third change you’ll make to the selected
item or items.

Source Field Lets you base a price update on one of the following:

Last Cost

Next Cost

Base Price

Parts Price

Labor Price

Standard Cost (in TireMaster Plus and TireMaster Corporate)

Price Level (A, B, C, D, or E parts or labor price level)

The Source Field drop-down is available for each of the three
operations.

Field to Update Lets you update one of the following for one or more items:

Sale Parts

Sale Labor

Parts Price

Labor Price

Base Price (the item’s cost)

Last Cost

Standard Cost (in TireMaster Plus and TireMaster Corporate)

Price Level (A, B, C, D, or E parts or labor price level)

Min Stock

Max Stock

Factor

Matrix

Color/Spiff
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Item Description

The Field to Update drop-down is available for each of the three
operations.

Percentage Change Lets you update the price of one or more items by a percentage. The
Percentage Change field is available for each of the three operations.
Note: For an increase, type a positive number. For a decrease, type

a negative number (such as -5).

$Amount Change Lets you update the price of one or more items by a fixed dollar
amount. The $Amount Change field is available for each of the three
operations.

Note: For an increase, use a positive number. For a decrease, use a
negative number (such as -5.50).

Ending in Cents Lets you end the prices of all updated items with the same amount
after the decimal point. For example, the prices of all updated items
could end with 99 cents ($5.99, $34.99, and $199.99). The Ending in
Cents field is available for each of the three operations.
Note: Type the cents amount without a decimal.

Item Factor Lets you update the price of items assigned factor calculations. The
Item Factor field is available for each of the three operations.

Value Lets you define the following:

The minimum stocking level for items

The maximum stocking level for items

The factor for items

The Value field is available for each of the three operations, but it's
visible only when Min Stock, Max Stock, or Factor are selected from
the Field to Update drop-down.

Unlabeled Drop-
Down

Lets you assign a price matrix to items. This drop-down is available for
each of the three operations when Matrix is selected from the Field to
Update drop-down.

Prod. Code Displays the product code for each of the selected items.

Size Displays the size of each of the selected items.

Name Displays the descriptions for each of the selected items.

Cat Displays the inventory categories assigned to each of the selected



Price Levels

Item Description

items.

Add-On Displays the add-on codes assigned to each of the selected items.

Price By Defines whether markups or margins are calculated by base price or
last cost for each of the selected items:

B = Base Price

C = Last Cost

Base Price Displays the base price for each of the selected items.

Percent Displays the relief percent for each of the selected items. If there is no
relief percent, TireMaster displays 0.

Parts Displays the parts price for each of the selected items.

Labor Displays the labor price for each of the selected items.

Sale Price Displays the sale parts price for each of the selected items.

Sale Labor Displays the sale labor price for each of the selected items.

Sale Begin Displays the beginning sale date for each of the selected items.

Sale End Displays the ending sale date for each of the selected items.

Inventory Lets you look up the items to which changes will be made.

Print for Review Lets you preview the pending changes on a report.

Load Configuration Lets you reuse the parameters from a previous update.

Save Configuration Lets you save the parameters from an update so they can be retrieved
and used for future updates.

Apply Lets you implement the changes you’ve defined with the Pricing
Wizard.

Close Lets you exit the Pricing Wizard.

PRICE LEVELS
With price levels, you can offer customers special pricing for one item, a group of items, or all of the
items you sell. You can assign price levels to individual customers or set up global price levels that are
available to all customers at point of sale.

Note: Although price levels are typically used to give customers discounts, they can also be used to
increase the prices some customers pay.
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A price level includes a price level code and one or more price level discounts that are associated with
the code. The purpose of price level discounts is to define which items to sell at special prices and how
to calculate the special prices.

CREATE PRICE LEVEL CODES
The first step in setting up a price level is to create the price level code.

To create a price level code
1. Select Inventory > Price Levels. The Price Levels screen opens.

2. Click Add. The Price Level Edit screen opens.

3. Type a code for the price level in the Price Level field.
Note: The price level code can be up to four characters long.

4. If you want the price level to be available to all customers at point of sale, select theGlobal check
box. Otherwise, leave it clear.

5. Type a description for the price level.

6. To save the new price level, clickOK.
Now you can create one or more price level discounts for the code. For more information, see Add
Price Level Discounts on page 417.

PRICE LEVEL DISCOUNT EDIT SCREEN
On the Price Level Discount Edit screen (Figure 15-5), you can define which item or items a price level
discount applies to and whether the special pricing available with the price level discount is calculated
by TireMaster or is a fixed dollar amount.
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Figure 15-5: Price Level Discount Edit

Item Description

Price Level Displays the price level that the price level discount is assigned to.

Description Lets you define the name of the price level discount.

Product Code Lets you offer special pricing for an item with a specific product code
or multiple items included within a range of product codes.

Inventory Category Lets you offer special pricing for items assigned a specific inventory
category or multiple items included within a range of inventory
categories.

Inventory Group Lets you offer special pricing for items assigned a specific inventory
group or multiple items included within a range of inventory groups.

Manufacturer Code Lets you offer special pricing for items assigned a specific
manufacturer code or multiple items that fall within a range of
manufacturer codes.

Range Search Lets you offer special pricing for a range of items.

Single Search Lets you offer special pricing for an item with a one product code or all
items assigned the same inventory category, inventory group, or
manufacturer code.

Lower Range Displays the code for the beginning of a range of items.

1 Lookup Lets you look up the product code, category, or manufacturer code for
the beginning of a range of items.

Upper Range Displays the code for the end of a range of items.
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Item Description

2 Lookup Lets you look up the product code, category, or manufacturer code for
the end of a range of items.

Multiply (Parts
Operator)

Calculates the price level discount by multiplying the parts factor by an
item’s EDL (the sum of an item's parts price and labor price), base
price, last cost, next cost, or standard cost.

Divide (Parts
Operator)

Calculates the price level discount by dividing an item’s EDL (the sum
of an item's parts price and labor price), base price, last cost, next cost
or standard cost by the parts factor.

Parts Factor Lets you define the factor for calculating an item’s parts price.

Parts Dollar Lets you define a dollar amount that will be subtracted from or added
to an item’s parts price.

Note: To increase an item’s price, type a negative dollar amount.

Multiply (Labor
Factor)

Calculates the price level discount by multiplying an item’s labor price
by the labor factor.

Note: When calculating the labor price using a factor, always select
EDL under Base.

Divide (Labor
Factor)

Calculates the price level discount by dividing an item’s labor by the
labor factor.

Note: When calculating the labor price using a factor, always select
EDL under Base.

Labor Factor Lets you define the factor for calculating an item’s labor price.

Labor Dollar Lets you define a dollar amount that will be subtracted from or added
to an item’s labor price.

Note: To increase an item’s price, type a negative dollar amount.

EDL Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s EDL (everyday low, which in the sum or the
parts price and labor price).

Base Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s base price.

Last Cost Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s last cost.

Next Cost Lets you calculate a special price for an item by multiplying or dividing



Price Levels

Item Description

a factor by that item’s next cost.

Standard Cost Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s standard cost (only in TireMaster Plus and
TireMaster Corporate).

Fixed Lets you charge a fixed price for an item’s parts, labor, or both when
the price level is used.

Parts Lets you define a fixed parts price

Labor Lets you define a fixed labor price.

Always Use Lets you do one of the following:

To always use the price level price, even if the EDL or sale price
is lower, select the check box.

To use the lowest price available, clear the check box. That
price could be the price level price, sale price, or the EDL.

OK Lets you save changes and exit the screen.

Cancel Lets you exit the screen without saving changes.

ADD PRICE LEVEL DISCOUNTS
Once you’ve created a price level code, you need to set up one or more price level discounts for the
code. Price level discounts define which items to sell at a special price and how to set the pricing for
those items. Price level discounts are typically used for giving customers discounts, however, they can
be also used to charge some customers higher prices.

Note: Price level discounts can be added only at the corporate site.

There are three ways to set up a price level discount:

You can add a markup or a margin to an item's regular price or cost.

Note: When calculations are based on last cost or next cost, the price one customer pays can
vary from another customer’s price, depending on how much and how often the item’s
receiving cost fluctuates. Therefore, ASA recommends that you talk to your accountant
before setting up price level discounts using last cost or next cost.

You can deduct a specific dollar amount from the item’s regular price or cost.

You can set a fixed price for parts, labor, or both.

To create a price level discount
1. If the Price Levels screen isn't already open, select Inventory > Price Levels.
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2. Select the price level for which you'll create a price level discount, and click Discounts. The Price
Level Discounts screen opens.

3. Click Add. The Price Level Discount Edit screen opens.

4. Type a description for the price level discount.

5. Identify which items are eligible for the price level discount.

a. Select one of the options under Type, to search by product code, inventory category, inventory
group, or manufacturer code.

b. To define whether the price level discount is for a range of items or a single product code,
category, group, or manufacturer, select Range Search or Single Search.



Price Levels

c. Click 1 Lookup and search for a specific item or select a category, group, or manufacturer
code. If the price level discount is for a range of items instead, click 1 Lookup to define the
product code, category, group, or manufacturer for the beginning of the range.

Note: You can also type full or partial product codes, categories, groups, or manufacturer
codes in the Lower Range and Upper Range fields.

d. If the price level discount is for a range of items, click 2 Lookup and select the product code,
category, group, or manufacturer for the end of the range. Otherwise, disregard this step.

6. For a price level discount that adds a markup or a margin to your cost, do the following. Otherwise,
disregard this step.

a. Under Base, select Base (for base price), Last Cost, Next Cost, or Standard Cost.
Standard cost is available only in TireMaster Plus and TireMaster Corporate.

b. SelectMultiply or Divide for the parts operator and then type the parts factor. For information
about operators, see Markups on page 387 and Margins on page 388.

Example: To charge wholesale customers 5% above your cost, you’d select Last Cost as
the base for the price level discount. Then, to define the parts operator, you’d selectMul-
tiply and type the factor 1.05. With these settings, TireMaster would multiply an item’s last
cost by 1.05 to determine the price level discount.
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Note: Disregard the labor operator if the price level discount is based on base price, last cost,
next cost, or standard cost.

7. For a price level discount that subtracts a set dollar amount from an item's regular price, type the
discount amount in the Parts Dollar field, Labor Dollar field, or both. Otherwise, disregard this
step.

Example: To deduct $10 from a tire’s everyday low price (the sum of the parts and labor
prices), you’d select EDL and type 10 in the Parts Dollar field. With these settings, TireMaster
would subtract $10 from the tire’s selling price.

Note: If you want to increase an item’s price instead, type a negative dollar amount.

8. For a price level discount that’s a fixed dollar amount, select Fixed (right side of the screen). Then
type the price that the customer will be charged in the Parts field, Labor field, or both.

Example: Example: To charge a customer $20 an hour for labor regardless of the kind of work
being done, you’d select Fixed and type 20 in the Labor field.

9. To use the price level price, even if the EDL price or sale price is lower, select Always Use.

10. To save the price level discount, clickOK.
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ASSIGN PRICE LEVELS TO CUSTOMERS
By assigning a price level to a customer, you can ensure that the customer is automatically charged
the price specified by the price level instead of the item’s regular price. There are two ways you can
assign price levels to customers:

For a single customer, look up the customer. When the Customer Maintenance screen opens,
click Edit. Then click the Price Level field, press , and select a price level from the list. For
more information, see Customer Searches on page 93 and Update Multiple Customer Records
on page 72.

For multiple customers, select Customers > List Editing and look up a range of customers.
When the Customer List Editing screen opens, scroll to the PLEVEL column and choose a price
level from the list for each customer. For more information, see Update Multiple Customer
Records on page 72.

Note: If you plan to assign price levels to national account customers, make sure prices levels
have been enabled for this customer type. For more information, see Price Levels for
National Account Customers on page 838.

Tip: You can rearrange the columns on this screen. For more information, see Rearrange
Table Columns on page 10.

SELECT PRICE LEVELS AT POINT OF SALE
With global price levels, you can give customers special pricing at point of sale by selecting price levels
for the items you’ve put on work orders.

To select a price level at point of sale
1. Start a work order and add one or more items to it. For more information, see Create a Regular

Work Order on page 442.
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2. Select the item for which you want to use the price level, and click Price Level. The Global Price
Levels screen opens.

Note: If no price levels are listed, none of your price levels include the selected item.

3. Select the level with the price you want to charge the customer and clickOK.

A–E PRICE LEVELS
With A–E price levels, you can assign up to five arbitrary, fixed prices to the items you sell. Then,
depending on which price level is assigned to customers, you charge them price A, price B, price C,
price D, or price E instead of the item’s regular price. In TireMaster, the regular price is referred to as
EDL, which means everyday low price.

Example: Karen Oliver is assigned price level B. The regular price for a Goodyear Wrangler tire is
$250.95, and price B for that same tire is $240. Because Karen is assigned price level B, she’s
charged $240 dollars for the tire instead of $250.95.

Note: If an item’s sale price is lower than the A–E price level, customers receive the sale price
instead.

To set up A–E price levels, you need to do the following:

Assign A–E prices to the items for which you want to use A–E pricing.

Update the descriptions for price levels A, B, C, D, and E and define whether those price levels
are global (available to all customers at point of sale).

Assign an A–E price level to customers for whom you want to use A–E pricing
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Once you complete these steps, customers who are assigned price levels A, B, C, D, or E will receive
special pricing.

ASSIGN A–E PRICES TO ITEMS
The first step in setting up A–E price levels is to assign A–E prices to items. You can assign A–E prices
to individual items or a group of items. In TireMaster Corporate environments, A–E prices can be set
up at the Corporate site only and are effective at all stores.

Note: The first time you set A–E prices for an item, TireMaster automatically creates up to five new
price levels (named A, B, C, D, and E). These price levels are listed along with any other price
levels that you use on the Price Levels screen.

ASSIGN A–E PRICES TO A SINGLE ITEM
If you need to assign A–E prices to a single item or only a few items, you can set the A–E prices for
each item one at a time.

To assign A–E prices to a single item
1. Search for the item to which you want to assign A–E price levels. For more information, see

Inventory Searches on page 230.

2. On the Inventory Maintenance screen, click theQty/Pricing tab.

3. Click Detail/Edit. The Site Prices and Quantity screen opens.

4. Click Levels. The A–E Price Levels screen opens.

5. Type up to five parts and labor prices for the item.
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6. ClickOK.

ASSIGN A–E PRICES TO MULTIPLE ITEMS
When you need to assign A–E prices to many items, you can use Inventory List Editing.

To assign A–E Prices to multiple items
1. Select Inventory > List Editing. TireMaster prompts you to search for items.

2. Look up the items whose A–E prices you want to set. For more information, see Inventory
Searches on page 230.

3. When the Inventory List Editing screen opens, scroll to the A Parts column and type an item’s
level A parts price.

Tip: Rearrange the columns so item descriptions, product codes, or some other identifying
information is displayed next to the columns for the A–E prices. To move a column, click
its heading and drag it to a different position

4. Move to the A Labor price column, and type the item’s level A labor price.

5. Type parts and labor prices in the B–E columns.
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6. Repeat steps 3 through 5 for each additional item whose A–E price levels you want to set.

7. Close the Inventory List Editing screen.

UPDATE A–E PRICE LEVELS
When you assign A–E prices to an item, TireMaster creates up to five new price levels (named A, B, C,
D, and E). For ease of use, you might want to edit the descriptions for these new price levels. You can
also define whether any of your A–E price levels should be available to all customers at point of sale.

To edit A–E Price Levels
1. Select Inventory > Price Levels. The Price Levels screen opens.

2. Select price level A and click Edit. The Price Level Edit screen opens.

3. Change the description as needed. Example:Price Level A.

4. If you want to make the price level available to all customers at point of sale, select theGlobal
check box. Otherwise, leave it alone.

5. ClickOK.

6. Repeat steps 2 through 5 for price levels B, C, D, and E.
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UPDATE MULTI-STORE A–E PRICE LEVELS WITH THE PRICING
WIZARD
When you use the Pricing Wizard to update A–E price levels in a TireMaster Corporate environment,
you need to define the site whose source cost or price entries will be used as the basis for the update.
To do this, you need to select a base site. For more information, see Base Site on page 410.

If you need general information about using the Pricing Wizard, see Change Prices for a Group of
Items on page 399 and Make Multiple Changes to a Group of Items on page 402.

To update multi-store A–E price levels with the Pricing Wizard
1. At the corporate site, select Inventory > Pricing Wizard.

2. When the Pricing Wizard screen opens, make sure Price Change is selected.

3. Select a site from the Base Site drop-down. The source cost or price for the selected site will be
used for updating the price levels. Because the corporate site does not have inventory, choose one
of the store sites.

4. UnderOperation 1, do the following:
a. For the Source Field, select one of the cost (last, next, or standard) or price (base, parts, or

labor) options from the drop-down.

Note: The base site has no effect when the Source Field is set to Price Level.

b. For the Field to Update, select Price Level. Then choose a price level and define whether it’s
for the parts or labor price.

c. Define whether the change will be a percentage or a fixed dollar amount.

d. Define whether to end updated prices with the same cents amount.
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5. To update additional price levels, repeat steps 4a and 4b for second and third operations, if
needed.

6. Click Inventory, and search for the items whose price levels you want to update.
7. To preview the pending changes, click Print for Review, and look over the report.

8. To implement the new price levels, click Apply.

CREATE PRICE LEVEL DISCOUNTS FOR A–E PRICE LEVELS
Occasionally, you might want to create a price level discount for one of your A–E price levels. For
example, if a vendor gives you a temporary discount on several items, you can pass the savings on to
your customers by setting up price level discounts for one or more of your A–E price levels. For more
information, see Add Price Level Discounts on page 417.

The advantage of creating a price level discount for an A–E price level is that you don’t have to
manually update the A–E prices for each of the affected items. When you want to resume using price
A, price B, price C, price D, or price E, you can delete the price level discount.

When the price generated by a price level discount is less than the A–E price assigned to the item,
TireMaster highlights it in yellow and displays it at the bottom of the Inventory List instead of the A–E
price.
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Figure 15-6: Price A Replaced by the Price Level Discount

Note: Whether A–E prices are displayed on the Inventory Lists depends on a pair of system control
settings. For more information, see Show Price Levels on page 1208 and Show Price Level
Question on page 1208.

If an item has a sale price, an A–E price, and a price generated by a price level discount, the customer
receives the lowest price available.

ASSIGN A–E PRICE LEVELS TO CUSTOMERS
Once you’ve established your A–E price levels, you can assign them to customers. While you can
assign these price levels to customers individually, it’s easier to assign them to a range of customers
with Customer List Editing. For more information, see Update Customer Records on page 71.

VIEW AN ITEM’S A–E PRICES
An item’s A–E prices and best price can be displayed at the bottom of the Inventory List (Figure 15-7)
some of the time, all of the time, or never.

Figure 15-7: A–E Prices Levels at the Bottom of the Inventory List

If the Show Price Level check box is included on the Inventory List, you can show or hide price levels
by doing either of the following:

Selecting or clearing the check box

Clicking each of the fields for the A–E prices and the best price

You can define whether the A–E prices are included on the Inventory by setting a pair of controls. For
details on setting these controls, see Show and Hide A–E Prices on page 428.

SHOW AND HIDE A–E PRICES
You can define when to show or hide A–E prices on the Inventory List by setting two controls.

To show or hide A–E prices
1. Select Setup > System Controls. The System Controls screen opens.
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2. Click the Inventory tab.
3. Depending on what you want to show or hide, set the controls Show Price Level Question and

Show Price Levels in one of the following ways:
If you want to show A–E price levels at all times, set Show Price Level Question to No and
set Show Price Levels to Yes.

If you want hide price levels until the Show Price Levels check box is selected, set Show
Price Level Question to Yes and set Show Price Levels to No.

If you want to show price levels until the Show Price Levels check box is cleared, set Show
Price Level Question to Yes and set Show Price Levels to Yes.

If you never want to show price levels, set Show Price Level Question to No and set Show
Price Levels to No.
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To set a control, select it and press Enter. Then select Yes or No.
4. Close the System Controls screen.

PRICE LEVEL DISCOUNT EDIT SCREEN
On the Price Level Discount Edit screen (Figure 15-8), you can define which item or items a price level
discount applies to and whether the special pricing available with the price level discount is calculated
by TireMaster or is a fixed dollar amount.

Figure 15-8: Price Level Discount Edit

Item Description

Price Level Displays the price level that the price level discount is assigned to.

Description Lets you define the name of the price level discount.

Product Code Lets you offer special pricing for an item with a specific product code or
multiple items included within a range of product codes.

Inventory Category Lets you offer special pricing for items assigned a specific inventory
category or multiple items included within a range of inventory
categories.
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Item Description

Inventory Group Lets you offer special pricing for items assigned a specific inventory
group or multiple items included within a range of inventory groups.

Manufacturer Code Lets you offer special pricing for items assigned a specific
manufacturer code or multiple items that fall within a range of
manufacturer codes.

Range Search Lets you offer special pricing for a range of items.

Single Search Lets you offer special pricing for an item with a one product code or all
items assigned the same inventory category, inventory group, or
manufacturer code.

Lower Range Displays the code for the beginning of a range of items.

1 Lookup Lets you look up the product code, category, or manufacturer code for
the beginning of a range of items.

Upper Range Displays the code for the end of a range of items.

2 Lookup Lets you look up the product code, category, or manufacturer code for
the end of a range of items.

Multiply (Parts
Operator)

Calculates the price level discount by multiplying the parts factor by an
item’s EDL (the sum of an item's parts price and labor price), base
price, last cost, next cost, or standard cost.

Divide (Parts
Operator)

Calculates the price level discount by dividing an item’s EDL (the sum
of an item's parts price and labor price), base price, last cost, next cost
or standard cost by the parts factor.

Parts Factor Lets you define the factor for calculating an item’s parts price.

Parts Dollar Lets you define a dollar amount that will be subtracted from or added
to an item’s parts price.

Note: To increase an item’s price, type a negative dollar amount.

Multiply (Labor
Factor)

Calculates the price level discount by multiplying an item’s labor price
by the labor factor.

Note: When calculating the labor price using a factor, always select
EDL under Base.

Divide (Labor
Factor)

Calculates the price level discount by dividing an item’s labor by the
labor factor.

Note: When calculating the labor price using a factor, always select
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Item Description

EDL under Base.

Labor Factor Lets you define the factor for calculating an item’s labor price.

Labor Dollar Lets you define a dollar amount that will be subtracted from or added
to an item’s labor price.

Note: To increase an item’s price, type a negative dollar amount.

EDL Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s EDL (everyday low, which in the sum or the parts
price and labor price).

Base Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s base price.

Last Cost Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s last cost.

Next Cost Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s next cost.

Standard Cost Lets you calculate a special price for an item by multiplying or dividing
a factor by that item’s standard cost (only in TireMaster Plus and
TireMaster Corporate).

Fixed Lets you charge a fixed price for an item’s parts, labor, or both when
the price level is used.

Parts Lets you define a fixed parts price

Labor Lets you define a fixed labor price.

Always Use Lets you do one of the following:

To always use the price level price, even if the EDL or sale price
is lower, select the check box.

To use the lowest price available, clear the check box. That
price could be the price level price, sale price, or the EDL.

OK Lets you save changes and exit the screen.

Cancel Lets you exit the screen without saving changes.

PRICE MATRICES
With a price matrix, an item’s selling price is updated by calculating a markup based on where the
item’s cost (the amount the vendor charges you) falls within a set of ranges.
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Example: You could use a matrix to calculate a 30%markup for items that cost between $1 and
$100 and a 20%markup for items that cost between $100 and $200.

Note: Amarkup is an amount that’s added to an item’s cost. Matrix price changes are calculated with
the items' next cost. If an item doesn’t have a next cost, its last cost is used for the calculation
instead.

SET UP A PRICE MATRIX
Setting up a price matrix includes creating cost ranges and defining how prices will be calculated for
those ranges. Each matrix can have up to seven cost ranges.

To set up a price matrix
1. Select Inventory > Price Matrix. The Price Matrix screen opens with the first matrix on the list

selected (unless none have been set up).

2. Click Clear Matrix to reset the screen.

Note: This step is unnecessary if there are no existing price matrices in TireMaster.

3. Type a name for the matrix.

4. For each range in the matrix, do the following.

a. Define the low and high cost amounts.

Note: Prices do not update when there are gaps between matrix ranges. Therefore, when
you add the second range and any additional ranges to a matrix, the amount in the
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Low Cost field needs to match the amount in the High Cost field for the previous
range.

b. For price changes based on a percentage, make sure Percent is selected. To change prices
by a fixed dollar amount, select Amount.

c. Type the percentage or amount for the range.

5. When you’re finished setting up the matrix ranges, click Save Matrix.

MANAGE EXISTING PRICE MATRICES
When you decide to change price calculations or that a matrix is no longer needed, you can make
changes to existing price matrices or delete them.

UPDATE A PRICE MATRIX
If you need to adjust the way in which a matrix calculates prices, update the matrix.

To update a price matrix
1. Select Inventory > Price Matrix. The Price Matrix screen opens.
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2. Select the name of the matrix you want to update. The cost ranges and price change information
for the selected matrix appears.

3. For each existing range that needs to be updated, do the following as needed:

Change one or more cost amounts.

Change the pricing method to Percent or Amount.
Change the percentage or fixed dollar amount.

4. Add a new range if needed, define the cost amounts, the pricing method, and the percentage or
dollar amounts.

5. To remove a range from the matrix, clear its check box.

6. Click Save Matrix.
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COPY A PRICE MATRIX
If many of the settings for an existing price matrix are similar to those you want to assign to a new
matrix, make a copy of the existing matrix and then make the needed changes.

To copy a price matrix
1. Select Inventory > Price Matrix. The Price Matrix screen opens.

2. Select the name of the matrix you want to copy.

3. Change the matrix name to the name of the new matrix you’re creating.

4. Change the settings for one or more matrix ranges, add ranges, or remove ranges. For more
information, see Update a Price Matrix on page 434.

5. Click Save Matrix. The name of the new matrix is added to the list.
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DELETE A PRICE MATRIX
When you no longer use a price matrix, you can delete it. When a matrix is deleted, it is also removed
from the items it was assigned to.

To delete a price matrix
1. Select Inventory > Price Matrix. The Price Matrix screen opens.
2. Select the name of the matrix you want to delete.

3. Click Remove Matrix. A confirmation message appears.

4. Click Yes. The matrix is removed from the database.

ASSIGN A PRICE MATRIX
Amatrix can be assigned to individual items or a group of items.

ASSIGN A MATRIX TO A SINGLE ITEM
If a price matrix needs to be assigned to a single item or a just few items, you can define the matrix in
the price and quantity settings.

To assign a matrix to a single item
1. Search for the item to which you want to assign a matrix. For more information, see Inventory

Searches on page 230.

2. On the Inventory Maintenance screen, click theQty/Pricing tab.

3. Click Detail/Edit. The Site Prices and Quantity screen opens.
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4. Select the matrix you want to assign from the Price Matrix drop-down.

5. ClickOK to save your changes. The screen closes and the item’s part price is updated based on
the calculation set up in the assigned matrix.

Note: To see the updated price, reopen the Site Prices and Quantity screen.

ASSIGN A MATRIX TO A GROUP OF ITEMS
If assigning price matrices to individual items is not practical, you can assign a matrix to a group of
items with the Pricing Wizard.

To assign a matrix to a group of items
1. Select Inventory > Pricing Wizard. The Pricing Wizard opens.

2. Make sure Price Change is selected.
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3. Select Matrix from the Field to Update drop-down for the operation you're using to update
matrices. A second drop-down with a matrix list appears.

4. Select the matrix you want to assign from the second drop-down.

5. Define the items to which you’ll assign the matrix.

a. Click Inventory. TireMaster prompts you to search for items.

b. Look up the items. For more information, see Inventory Searches on page 230.

6. Implement the matrix assignments.

a. Click Apply. A confirmation message appears.
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b. Click Yes. The update notification message appears.
c. ClickOK. The parts prices for the selected items are updated based on the calculations set

up in the assigned matrix.

7. Close the Pricing Wizard, or repeat steps 3 through 6 to assign a matrix to other items.

Note: To verify price changes for a group of items, open Inventory List Editing and search for
the items in the group. The updated prices are listed in the Parts column.

UPDATE SELLING PRICES WITH A PRICE MATRIX
Updating prices with a price matrix is a hands-off process. Parts prices are automatically recalculated
in the following scenarios:

When you assign a price matrix to an individual item

When you assign a matrix to a group of items

When you update your cost for items that you’re receiving into inventory (In this scenario, price
matrices were previously assigned to the items.)

To see price changes for a single item, look at the entry for the parts price. To see updated prices for a
group of items, open Inventory List Editing and look up the items in that group. The updated prices are
listed in the Parts column.



POINT OF SALE
Many daily tasks performed in TireMaster occur at point of sale. This chapter discusses various parts
of the Invoicing module and how to use them.

Work Orders and Invoices 442
Open Work Order List 462
Invoice Entry Screen 466
Deposits 470
Returns and Trade-Ins 474
Transfers 488
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WORK ORDERS AND INVOICES
When a customer needs to purchase items and services, you’ll usually start a work order, which will be
turned into an invoice upon completion of the sale.

Note: If you’ve created a quote for a customer, you can turn that quote into a work order. You can
also use information from a scheduled appointment to a create work order. For more
information, see Turn an Appointment into a Work Order on page 582 or Turn a Quote into a
Work Order on page 533.

CREATE A REGULAR WORK ORDER
When a sale requires little or no special handling, create a regular work order. Creating a work order
includes gathering customer and vehicle information and defining which items to sell.

Note: Work orders can be created at stores only. However, invoices for completed sales can be
viewed by users at the corporate site.

To create a regular work order
1. Click Invoicing. The OpenWork Order List opens.

2. Click New Work Order. TireMaster prompts you for the customer's name.

3. Enter the customer information:

For a returning customer, look up the customer. For more information, see Customer Searches
on page 93.

For a new customer, click Cancel and add the customer. For more information, see Add a
Cash Customer on page 66 or Add an AR Customer on page 68.

4. ClickOK to close the Customer Maintenance screen. If TireMaster prompts you for a vehicle, go to
step 5. If the Work Order screen opens instead, go to step 6.
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Note: If there is already at least one open work order for the customer, TireMaster prompts you to
select an existing work order or to create a new work order.

5. Enter vehicle information if needed:

For an existing vehicle, select it from the list and clickOK.

For a new customer, click Add and set up the vehicle. Then clickOK to continue. For more
information, see .

If there is no vehicle, clickOK to continue.

Note: Whether the Vehicle List appears at point of sale depends on the customer type
assigned to the customer. For more information, see Add a Customer Type on page 99
and Customer Type Edit Screen on page 102.

6. Do the following on the Work Order screen as needed. Then clickOK.
Enter your user ID (in the Starting Salesperson) field. To enter this information, press and
select a name from the list.
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Type the customer’s PO number, reference number, the vehicle’s mileage, and comments or
notes about the job. (Up to four thousand characters are allowed.)

Note: Depending on how the system controls are set, you might be required to enter the
mileage. For more information, see Force in Mileage on page 1211.

Select the Print Vehicle Spec check box if you want a hard copy of Epicor‘s specifications for
the vehicle. The specs will print on a separate sheet of paper.

Note: Epicor‘s vehicle specs can be printed if they’ve already been retrieved and saved with
the vehicle’s information in TireMaster. Specifications are available for retrieval if your
TireMaster system is integrated with the Epicor Integrated Service Estimator.

7. If you need to change the contact information, type the customer’s phone number in the Contact
field or click Contact and make a selection from the list that appears.

8. Add one or more items to the work order, using the following methods as needed:

Click Add and look up an item or scan its bar code. For more information, see Inventory
Searches on page 230, or Enter Bar Codes onWork Orders on page 350.

Click the Size field and type the item’s quick look (or another) code or scan its bar code.
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Note: To put additional items on the work order using this method, press to add a new line.
For more information, see Down Arrow Lookup Method on page 9.

Click Fitment to look up tires for the vehicle (if you have a subscription to Tire Guide Pro Plus).
For more information, see Look Up Tire Sizes at Point of Sale on page 553.

9. For each item, type the quantity and press Enter. If add-ons are assigned to an item, they appear
below the parent item. For more information, see Add-On Packages on page 252.

Note: If you decide to remove an item from the work order, select the item and press the Delete
key.

10. Change the parts price, labor price, and FET for the items if needed.
Note: Depending on how the system controls are set, an item’s FET is either the average cost of

its federal excise tax or the FET used on its last receiving. For more information, see Use
Next FET for POS/Receivings on page 1209.

11. Assign salespeople and mechanics to the items if needed, using one or both of the following
methods.

Type the employee’s user ID in the top row for the Sales,Mech 1, orMech 2 column and press
Enter or press and make a selection from the list that appears. Depending on how a system
control setting, the user ID will be entered for additional rows. For more information, see Work
Orders - Mechanic Autofill on page 1219.

Type the employee’s user ID in the Sales,Mech 1, orMech 2 field for the applicable row or
press and make a selection from the list that appears.
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12. Set the promised time and job status if needed. For more information, see Set the Promised Time
on page 588 and Change a Vehicle’s Job Status on page 587.

13. Follow the steps below to print a copy of the work order, or clickQuit:
a. ClickWork Order. The Work Order screen opens.

b. Make sure the Print check box is selected and type the number of copies you need.

Note: If the number of copies is set to 0, TireMaster displays the work order on the screen.

c. Update the remaining information on the screen if needed.

d. ClickOK.

OIL CHANGE WORK ORDERS
When you need to add an oil change to a customer’s work order, you can copy oil change items from
one of the customer’s historical invoices to the new work order. Reusing oil change information from a
previously-completed invoice helps to ensure that you consistently use the same oil filter, the same
type of oil, and the correct amount of oil every time a customer comes in for oil changes.

Note: If you’ve never performed an oil change for the customer’s vehicle, you need to add the oil
change via an inventory search. Once the first oil change is sold, you’ll be able to create
subsequent work orders by copying items from the first oil change invoice.
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To reuse oil change work order information
1. Start a work order. For more information, see Create a Regular Work Order on page 442.

2. On the Invoice Entry screen, clickOil History. The Oil History Invoices screen opens. It lists oil
change items that were sold during the past two years.

Note: To be included on the Oil History Invoices screen, an item’s product code, description, or
both must include the word oil. For more information, see Oil Change Items on page 371.

3. To see additional items sold on an invoice with an oil change, select the Show Invoice check box.

Example: If you sold a set of wiper blades on the same invoice as an oil change, selecting the
check box would allow you to see the wiper blades along with the oil-change items.

4. Make sure the Add check boxes for the oil change items you want to copy to the work order are
selected, and the check boxes for the items you want to exclude are clear. By default, the check
boxes for only a single invoice are selected.
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5. Click Add to WO. TireMaster adds the selected items to the work order.

Note: The items are all added to the work order as parent items, regardless of whether they were
originally part of an oil change package with a single parent item and one or more add-on
items.

Note: If your TireMaster system is integrated with the Epicor Integrated Service Estimator, the
Epicor ordering screen opens instead. If the vehicle uses a part (such as a filter) that is not
stocked, you can check to see if a vendor has the item and order it.

6. Update quantities, descriptions, and prices for the items you just added, if needed.

7. Do the following as needed:

Add other items to the work order.

ClickQuit to close the work order.
Complete the invoice. For more information, see Complete an Invoice on page 456.
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CREATE A SERVICE CALL WORK ORDER
Creating work orders for service calls differs from creating work orders in a store, because you need to
record the address where the service call occurred. Including that address on the final invoice creates
a paper trail that you can use for a tax audit. Depending on the service call location, you might also
need to change the tax level to ensure the proper amount of sales tax is collected.

Note: On the completed invoice, the service call address is listed to the right of the customer’s
regular address.

To create a service call work order
1. Start a work order and add items to it. For more information, see Create a Regular Work Order on

page 442.

2. Record the address of the service call location:

a. Click Ship To. The Ship-To Type Selection screen opens.

b. Select one of the following:

If the service call occurred at a location that’s on the customer’s Ship-To List, such as a fleet
warehouse or branch office, select Reusable Address and clickOK. Then select the
appropriate address from the list.

If the service call occurred at a location that’s not on the customer’s Ship-To List, select
One-Time Address and click OK. Then type the temporary address on the Ship-To
Maintenance screen, and clickOK.

3. Change the tax level if needed:

a. Click Tax Level. The Invoice Tax Level Selection screen opens.
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b. For both the parts and labor levels, click Lookup and make a selection from the list.

Note: If the tax level for the service call location is different than the one assigned to the
customer, you need to change the tax level. Selecting a different tax level for the work
order does not affect the settings in the customer’s record. To change tax levels, users
need to be assigned the Customer Edit permission.

c. ClickOK. TireMaster recalculates the sales tax.
4. Make additional changes to the work order if needed, print it, or complete the invoice. For more

information, see Complete an Invoice on page 456.

GM VIEWER
If you want to know the profit a sale will generate, you can view the gross profit margin for the
corresponding work order.

Note: By setting a system control, you can define whether the viewer displays an item’s last cost or
next cost and whether that value includes FET. For more information, see GM Viewer Cost
Options on page 1212.

To view a work order’s gross profit margin
1. If the Invoice Entry screen isn’t already open, click Invoices. Then select the work order whose

gross profit margin you want to view and click Select.
2. On the Invoice Entry screen, clickGM. TheGM Viewer opens and provides the following

information:

TheGM$ andGM% columns display the gross margin for each item.

TheGM$ andGM% fields at the bottom of the screen display the total gross margin amount
and percentage.

Note: The cost displayed on the viewer is the cost of the item at the time it was added to the work
order. Therefore, the cost displayed on an older work order might differ from the cost for
that same item if you just added it to a new work order.

3. To close the viewer, click Cancel.
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RETRIEVE A CUSTOMER'S WORK ORDER
When you need to print or make changes to an existing work order, you can retrieve it from the Open
Work List.

To retrieve a customer's work order
1. If the OpenWork Order List isn't already open, click Invoicing.

2. Select the work order, you want to update or print and click Select.

MANAGE EXISTING WORK ORDERS
Once a work order is started, you will likely to need to make changes to it before turning it into a sale
invoice or you might find that it's not longer needed.

UPDATE A WORK ORDER
When you need to sell additional products or services, you can add those items to a work order.
Likewise, when items aren't needed, you can delete them. You can also update a work order by
making additional changes, such as changing the customer's tax level or changing the job status.

To update the work order
1. If the OpenWork Order List isn't open, click Invoicing.

2. Select the work order, and click Select.
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3. Add an item to the work order, if needed, using one of the following methods. Then enter the
quantity.

Click Add and look up an item or scan its bar code. For more information, see Inventory
Searches on page 230, or Enter Bar Codes onWork Orders on page 350.

Press , and type an item’s quick look (or another) code in the Size field or scan its bar code.
For more information, see Down Arrow Lookup Method on page 9.

Click Fitment to look up tires for the vehicle (if you have a subscription to Tire Guide Pro
Plus). For more information, see Look Up Tire Sizes at Point of Sale on page 553.

4. To delete an item select it and click Delete. Then click Yes when confirmation message appears.
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5. Make additional changes to the work order if needed. For information about the options
available, see Invoice Entry Screen on page 466.

6. To close the Invoice Entry screen, clickQuit.

BAR CHANGE ENTRIES
If your state’s Bureau of Automotive Repair requires you to notify customers of changes to their work
orders, you can remind your employees to gather the information at point of sale.

Note: This feature is activated with a system control. For more information, see Enforce BAR for
Work Orders on page 1211.

To complete a BAR change entry
1. After making a change to a work order, clickQuit or Complete. The BAR Change Entry screen

opens and displays the work order’s original and updated prices.

2. Type an explanation for the change in the Reason field.
3. Type the name and phone number for the person who authorized the change.

4. To verify that the customer approved the change, select the Signature Acquired check box.
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5. To save the BAR change entry, clickOK.

DELETE A WORK ORDER
If you have a work order for a sale that will not be completed, you can delete the work order.

Note: With system controls settings, you can require employees to document their reasons for
deleting work orders, and you can specify whether to print deleted work orders automatically.
For more information, see Work Orders - Require Comments When Deleting on page 1220
andWork Orders - Print When Deleting on page 1219.

To delete a work order
1. If the OpenWork Order List isn’t already open, click Invoicing

2. Select the work order you want to delete and click Delete.
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3. If the Deleted Work Order Comment screen opens, type the reason for deleting the work order
and clickOK. If the confirmation message appears instead, click Yes. The deleted work order
prints automatically or is displayed in the Report Window.

4. If the Report Window is open, close it.

Tip: For additional copies of the deleted work order, click Print again before closing the
Report Window.

AT-A-GLANCE SALES HISTORY
By pressing a single key, you view a customer’s sales history at point of sale. Having quick access to
this information makes it easy to track down the date of the customer’s last visit, along with a list of
items the customer has already bought, returned, or traded-in.

Note: At-a-glance customer sales history is displayed on the same screen that’s used for tracking
returns and trade-ins.

To view at-a-glance sales history
1. If the customer's work order isn't open, click Invoicing. Then select the work order and click

Select. The Invoice Entry screen opens.
2. Press F8. The Customer Sales History screen opens.
3. To define which items are displayed, select the following as needed:

Match Inventory to display only the item selected on the Invoice Entry screen (if the customer
previously bought, returned, or traded-in that item)

Match Vehicle to display only the vehicle selected for the current work order
Under 90 Days to display only invoices that are less than 90 days old
Under 180 Days to display only invoices that are less than 180 days old
All to displays all invoices
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4. To exit the customer’s history, click Cancel.

COMPLETE AN INVOICE
In most cases, you create a work order when a customer arrives and leave it open while the work is
performed. When the work is finished, you need to complete the work order to create the final invoice.

To complete an invoice
1. Select the work order that you want to complete:

a. If the OpenWork Order List is not already open, click Invoicing.

b. Select the work order and click Select. The Invoice Entry screen opens.

Tip: To narrow your search for a work order, select Name, License #, orMake. Then type
the customer’s name, vehicle license plate number, or the manufacturer in the Find
field.

2. Update the work order if needed. This can include adding or removing items, making sure that
quantities have been entered, assigning mechanics and salespeople for each item, updating the
comments in theWO Notes tab, or updating the amount in the Flat Rate column. For more
information, see Calculate Mechanic Productivity on page 883.

3. Click Complete. The Invoice Completion screen opens.
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Note: If you use the DOT Interface, you’ll be prompted to enter tire identification numbers for tire
sales. For more information, see Record Tire Identification Numbers on page 560.

4. Enter the payment information:

a. Click the field for the type of payment the customer is using.

b. Type the payment amount or press  to enter the invoice total.

Note: If the customer is paying with a debit or credit card, see Complete a Credit or Debit
Card Sale on page 808 for more information.

5. Make sure the Print check box is selected and the number of copies is set.

6. Enter the following information as needed:

The vehicle’s license plate number

The ending salesperson’s user ID (type it or press and select it from a list)

The vehicle’s beginning and ending mileage

Note: Entering the ending mileage is required if Force in Mileage is set to Yes. This setting
is on theOther tab of the System Controls screen.

A PO or reference number

A message for the customer

7. If you need to include a tax exemption certificate on the invoice, select the Tax Exempt Cert
check box. Otherwise, leave it blank.

457



458

User Guide

8. If you want to associate the invoice with up to three postcards, clickMarketing. For more
information, see Associate an Invoice with a Postcard on page 605.

Note: The Marketing Module is an optional program that can be used with TireMaster Point of
Sale.

9. ClickOK. TireMaster prompts you to complete and print the invoice.

10. Click Yes.

REVERSE AN INVOICE
If you make an error on a customer’s invoice, you can reverse it. Then you can automatically create a
new work order with the same items and quantities if needed.

Note: Invoices that included deposits need to reversed manually with a return. Invoices for transfer
and interstore transfer sales cannot be reversed. For more information, see Deposits on page
470, Transfers on page 488, or Create an Interstore Transfer Invoice on page 955.

To reverse an invoice
1. Click Invoicing. The OpenWork Order List opens.

2. Click Rev. Invoice. TireMaster prompts you to look up an invoice to reverse.

3. Click Yes. The Name Lookup/Entry screen opens.
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4. Search for the customer whose invoice you want to reverse. The Customer Maintenance screen
opens. For more information, see Customer Searches on page 93.

5. Click the Ledger/History tab.

Note: If the AR Ledger view is selected, the invoice you need to reverse might not be visible.
Select the History view instead.

6. Select the invoice you want to reverse and click Reverse. A confirmation message appears.

7. Click Yes. TireMaster prompts you to create a new work order that is a duplicate of the reversed
invoice.

Note: If any sales tax rates affecting the invoice have changed in the time since the original sale,
you will not be allowed to reverse the invoice. In this scenario, create an invoice with
negative quantities. Then make journal entries to account for the difference in the amount
of sales tax collected.

8. If you want to create a duplicate work order, click Yes. TireMaster reverses the current invoice and
creates a work order with the same items and quantities. If you don’t want to duplicate the work
order, click No instead. Regardless of whether you click Yes or No, all previous charges are
reversed.

Note: Reversed invoices remain in the customer’s historical subledger.
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REUSE INVOICES
You can reuse the contents of previously-completed sale invoices to create new quotes and work
orders. Reusing invoices saves time and helps to ensure consistency when a current job needs to be
handled in the same manner as a prior job.

To reuse an invoice
1. Click Invoicing. The OpenWork Order List opens.

2. Click Reuse Invoice.

3. Search for the invoice using one or more of the following criteria:

Invoice date or date range. For a single day, use the same date in both the starting and ending
date fields.

Vehicle year or a range of vehicle years. For a single year, use the same year in both the
starting and ending year fields.

Vehicle make

Vehicle model

Customer name

Customer purchase order number

Note: Full and partial entries are accepted for year, make, model, name, and PO#.

4. Click Search Invoices. TireMaster retrieves invoices that match the search criteria.
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5. Select the invoice you want to reuse.

6. To use prices from the original invoice on the new work order or quote, select the Use Original
Pricing checkbox.
Note: If the original invoice includes (noninventoriable) option cost items, they'll be added to the

new quote or work order with the parts price $0.00. On work orders, the lines for option
cost items will also be colored pink to remind you to enter the cost for those items. For
more information, see Enter an Item’s Cost at Point of Sale on page 380.

7. Click one of the following:

Create WO
Create Quote
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TireMaster prompts you to search for the customer and choose a vehicle. For more information, see
Customer Searches on page 93.

8. When the confirmation message appears, clickOK.
9. Close the Reuse Invoice screen. New work orders are added to the OpenWork Order List. New

quotes can are available on the Quote and Estimate List.

Note: To see duplicated items on quotes, click . The duplicated invoice items are listed under
the Import line on the lower half of the screen.

OPEN WORK ORDER LIST
All customer transactions can be started on the OpenWork Order List.

OPEN WORK ORDER LIST PROPERTIES
The OpenWork Order List includes the following properties.

Note: Because the columns on the OpenWork Order List can be moved and resized, the columns for
your TireMaster systemmight be arranged differently than those described below. To see
additional columns, scroll to the right.

Figure 16-1: OpenWork Order List
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Item Description

Name Lets you look up a work order by customer name.

License # Lets you look up a work order by license plate number.

Make Lets you look up a work order by the vehicle make.

Invoice Lets you look up a work order by invoice number.

Find Lets you enter a customer’s name, license plate number, or vehicle
manufacturer and searches for the closest match.

S Identifies the status of a job by displaying the color and the letter or
number that represent a status. Examples of statuses include On Site,
In Progress, and Done. For more information, see Work Order Status
Indicator on page 584.

Promised Displays the date and time when a customer was promised that the
vehicle would be ready for pickup. Color coding indicates whether the
promised time for a job is approaching or has passed. If the promised
time is within an hour, the entry in the Promised column is yellow. For
jobs whose promised time has passed, the entry is red.

Date Displays the date the work order was started.

Invoice Displays the work order’s document number.

Name Displays the name of the customer associated with a work order.

Yr Displays the year for a vehicle. This column is blank if no vehicle is
selected.

Make Displays the make of a vehicle. This column is blank if no vehicle is
selected.

Model Displays the model of a vehicle. This column is blank if no vehicle is
selected.

License Displays a vehicle’s license plate number. This column is blank if no
vehicle is selected or if no license number has been entered for the
vehicle.

Unit Displays the unit number for a vehicle. This column is blank if no vehicle
is selected or if no unit number has been entered for the vehicle.

Sales Displays the starting salesperson for a work order.

Phone Displays the customer’s phone number.
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Item Description

Site# Displays the site where the work order or quote was started. In
TireMaster Plus and TireMaster Point of Sale systems, this number is
always 1.

Reference Displays the reference number, if any, entered on a work order.

PO# Displays the purchase order number, if any, entered on a work order.

Mod Displays a document type code. No code is displayed for work orders
created for normal sales.

Comments Displays the notes, if any, entered on a work order.

Total Displays the total of all the items, plus sales tax, on a work order.

Contact Displays the phone number or email at which the client can be reached.

New Work Order Lets you create a new work order.

Quote Lets you create a new quote or look up a quote that has already been
started.

Delete Lets you deleted work orders.

Core Case Lets you access Casing Manager or the Core Manager if one of those
features are enabled.

Schedule Lets you schedule appointments for customers.

New Paidout Lets you pay an expense from the till.

ROA Lets you process a payment from a customer.

Drawer Opens the till drawer.

Note: The till drawer must be set up on the Printer Selection screen for
this button to work.

Rev. Invoice Lets you reverse a completed invoice.

Save Layout Lets you save your changes after you rearrange the columns on the
screen.

Credit Memo Lets you issue a credit memo to a customer.

Select Lets you open the highlighted work order.

Close Closes the screen.
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SORT THE OPEN WORK ORDER LIST
To sort the OpenWork Order List, click the column headings. For example, if you want to arrange work
orders by document number, click the Invoice heading (Figure 16-2). By default, the newest work
orders are listed at the top of the screen.

Figure 16-2: Sorting the OpenWork Order List

MOVE AND RESIZE OPEN WORK ORDER LIST COLUMNS
You can customize the layout of the OpenWork Order List by moving and resizing the columns.

Note: The new layout affects only the workstation on which changes were made. Therefore, the
columns on the OpenWork Order List can be moved and resized differently for each
computer.

To move and resize Inventory List columns
1. To move a column, click the column heading. When the thick, black line appears, drag the column

to a different position.

2. To resize a column, move the pointer ( ) to the boundary for the column heading. When the
pointer turns into , drag the boundary to the new width.

3. When you’re done moving and resizing the columns, click Save Layout.
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The OpenWork Order List columns will be displayed in the new arrangement until their positions are
changed.

Note: Users do not need to be granted permission to update the layout of the OpenWork Order List.

INVOICE ENTRY SCREEN
Detailed information for a work order, including the items sold and their prices, is entered on the
Invoice Entry screen.

Figure 16-3: Invoice Entry Screen

Item Description

Reconciliation Code
Button

Displays the reconciliation code assigned to a work order. This button
is visible only for national account and government support work
orders.

Date Displays the date the work order was started. This date can be
changed for work orders that need to be backdated.
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Item Description

Sales Displays the user ID for the salesperson who started the work order.

Sold To Displays the customer's name. If you selected the wrong customer
when starting the work order, you can click this button and look up the
correct customer.

Contact Lets you select a phone number or email address for contacting the
customer from a list.

Tax Level Lets you change the tax level used for calculating the customer’s
sales tax.

Ship To Displays an alternate shipping or billing address, if any. To select a
shipping address, click this button. Then select Reusable Address
when prompted, and choose the address from the list. If you need to
enter the address for a roadside location where a service call
occurred, see Create a Service Call Work Order on page 449 for more
information.

Unlabeled Contact
Fields

Displays the phone number or email address selected from a list,
along with the name or description assigned to the selected contact
method. You can also type a customer’s contact number and a
description in these fields. (Example: 555-333-9393. Anne’s
Cell Phone.)

Vehicle Displays the vehicle’s year, make, and model, along with the mileage
entered.

Chk Lets you access a service checklist for tracking recommended
services.

Fitment Lets you look up tire sizes that are compatible with the selected
vehicle, along with other tire and wheel specifications such as PSI and
torque values.

Note: This button is active only if you’ve installed the fitment guide.
For more information, see Fitment Guide on page 552.

WO Notes Displays the notes that were entered in the Comments field on the
Work Order screen. The content of this tab can be updated, and it
prints on completed invoices.

Customer Notes Displays the content that was entered in the Notes field on the
General tab of the Customer Maintenance screen. These notes can
be updated on the Customer Maintenance screen only.
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Item Description

Customer
Information

Displays the content that was entered on the Information tab on the
Customer Maintenance screen. These notes can be updated on the
Customer Maintenance screen only.

Quantity Lets you enter the number of items being sold.

Size Displays an item’s size.

Description Displays an item’s description.

Note: Only the description of noninventoriable items can be updated
at point of sale.

Parts Displays an item’s parts price, if any. This number can be changed at
point of sale.

Labor Displays an item’s labor price, if any. This number can be changed at
point of sale.

FET Displays the federal excise tax assessed for the item. This number
can be changed at point of sale.

Tax Lets you define whether to assess sales tax on parts, labor, or both.
To cycle through the options for this field, press repeatedly.

Extend Displays the total price for an item. This amount is calculated by
multiplying the total of the parts, labor, and FET prices by the item’s
quantity.

Sales Displays the user ID for the salesperson who sold the item.

Mechanic 1 Displays the user ID of the primary mechanic for an item sold.

Mechanic 2 Displays the user ID of the secondary mechanic for an item sold.

Flat Rate Displays the default flat rate assigned to labor items. This value can
be updated with the actual number of hours taken to complete the job.
For more information, see Calculate Mechanic Productivity on page
883.

Core Return Lets you define the core charge that a vendor assessed when you
bought a part that can be remanufacturered. If a customer is buying a
part from you, this field can also be used to record a core charge that
you’re collecting from the customer. This amount can be refunded if
the customer returns the old core. For more information, see Record
Core Charges on page 932 . If you cannot see the Core Return field,
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Item Description

scroll to the right.

Product Code Displays the product code assigned to an item. If you cannot see this
field, scroll to the right.

Work Order Status
Settings (lower-left
corner)

Lets you select the status of the services and repairs associated with
the work order. (For example, In Progress or Done.) Work order
statuses can be customized for each dealer. For more information,
see Work Order Status Indicator on page 584.

Add Lets you add a item to the work order.

Price Level Lets you access a list of available price levels, which can be used to
offer the customer special pricing for an item.

Delete Lets you remove an item from the work order.

Adjust Lets you adjust the price of the replacement item that’s sold when a
customer returns an item that’s defective. For more information, see
Adjustment Sales on page 846.

Option Cost Lets you enter the actual cost, including federal excise tax, of
noninventoriable items. For more information, see Option Cost
Method on page 378.

Casings Lets you record information about casings that a customer has
brought in for retreading.

GM Viewer Lets you access the GM Viewer, which shows the gross profit that a
sale will generate.

CC Application Lets you access one or more credit card application screens and the
configuration screen for the Merchant Partners electronic card
processing system. This button is available only when the Merchant
Partners credit card processing system is installed.

Svc Intervals Lets you access service interval information for the selected vehicle
on systems that are integrated with the Epicor® ISE™.

Promised Lets you set a promised time for when the job will be finished.

Parts & Labor Lets you access integrated parts and labor guides, such as those
distributed by Mitchell 1® and Epicor®.

Note: This button is active only if you’ve installed an integrated parts
and labor guide. If you’re interested in using one of these

469



470

User Guide

Item Description

products, contact your sales representative.

Inspect Sheet Lets you access an inspection sheet for the selected vehicle on
systems that are integrated with the Epicor® ISE™.

Work Order Lets you generate hard copies of the work order.

Complete Let you collect payment for the sale and generate a completed
invoice.

Quit Let you close the screen.

Parts Displays the total parts price for the items on the work order.

Labor Displays the total labor price for the items on the work order.

Shop Lets you do one of the following:

To assess a shop charge for the work order, select the check
box.

To exclude a shop charge from the work order, clear the check
box.

Tax Displays the amount of sales tax assessed for the items on the work
order.

Total Displays the sum of the total parts price, total labor price, and sales
tax.

DEPOSITS
When a customer makes a partial payment or a prepayment toward a purchase, the transaction is
processed as a deposit. Depending on the payment method, a deposit is added to the day end cash,
check, or payment card totals. A deposit is also deducted from the sale total when the final invoice is
completed. A single deposit or multiple deposits can be made toward a purchase.

PREPARE TO TAKE DEPOSITS
Before you can accept deposits at point of sale, you need to do the following:

Define a minimum dollar amount for deposits in System Controls. For more information, see
Deposit - MIN Dollar Amount on page 1198.

Define a minimum percentage for deposits in System Controls. For more information, see
Deposit - MIN Percentage (%) on page 1198.

Note: When the minimum deposit percentage for an invoice is less than the minimum dollar
amount for deposits, the customer is required to pay the minimum deposit dollar amount.
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Add a clearing account for deposits to your general ledger. This account is typically a liability
account, because it’s used for tracking unearned revenue. For more information, see Add a
Liability Account on page 657.

Define the deposit clearing account in System Controls. For more information, see Deposit -
Clearing Account on page 1204.

Note: To pass the data validation in TireMaster Plus and TireMaster Corporate, the deposit
clearing account must be defined in System Controls.

In addition to completing these settings, you might want to add an inventory item for assessing a
service charge (such as a restocking fee) when customers back out of purchases and ask for refunds
of their deposits. For more information, see Add an Inventory Item on page 205 and Set Up Fees on
page 366.

PROCESS DEPOSITS
When a customer needs to make a partial payment or an advance payment toward a purchase, you
can add a deposit to a new or existing work order. Multiple deposits can be collected for a single work
order.

Note: Deposits need to meet or exceed a minimum percentage and a minimum dollar amount. Both
of these values are defined in System Controls. For more information, see Deposit - MIN Dollar
Amount on page 1198 and Deposit - MIN Percentage (%) on page 1198.

To process deposits
1. Start a work order and add items to it, or look up an existing work order. For more information, see

Create a Regular Work Order on page 442 or Update a Work Order on page 451.

2. On theWO Notes tab, type a comment about the payment being collected.

Note: Adding a comment about the deposit is not required. However, this type of note can be
helpful, because the total on the screen does not include deposits.

3. Click Deposit. The ROA/Deposit Complete screen opens.

4. Click the field for the payment method the customer is using, and type the payment amount.
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5. Make sure the Print check box is selected, and define the number of copies you want to print.

6. If you need to include your user ID on the invoice, click the Sales field. Then press and select
your name from the list that appears.

7. Type a comment about the deposit invoice if needed.

8. ClickOK. A confirmation message appears.

9. Click Yes to complete the deposit and print the deposit invoice.
10. Close the Invoice Entry screen. The work order for which you collected the deposit will remain on

the OpenWork Order List until the final sale invoice is completed.

Note: To see which customers have made deposits for pending purchases, generate an Open
Work Order Deposits Report. For instructions, see OpenWork Order Deposits on page
1070.

REFUND DEPOSITS
When a customer no longer wants to buy layaway or special order items, refund all or part of the
deposit. You can also charge the customer a restocking fee for the inconvenience of holding the items
or placing a special order. When you refund a deposit, you can reimburse the customer with cash,
credit, check, or payment card.

To refund deposits
1. Retrieve the work order that includes the deposit or deposits you need to refund.

2. Type a note stating the customer has changed his or her mind on theWO Notes tab.



Deposits

Note: Adding a comment is not required. However, this type of note can be helpful for research.

3. Perform a return for each item the customer was going to purchase.

a. Look up the item and enter the quantity as a negative number. The Customer Sales History
screen opens.

b. Click Return.

Note: The items should be listed twice on the work order to show that the customer intended
to buy them (positive quantities) and then backed out of the purchase (negative
quantities).

4. If you assess a service charge (such as a restocking fee), add it to the work order.

5. Click Complete.

6. On the Invoice Completion screen, define the reimbursement amount and method.

For cash reimbursements, click the Cash field and press to fill in the amount.

For credit reimbursements, click the Charge field and press to fill in the amount.
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For check reimbursements, click the Charge field and press to fill in the amount.

For payment card reimbursements, click the Credit/Debit field and press to fill in the
amount.

7. ClickOK. TireMaster prompts you to complete and print the invoice.
8. Click Yes.
9. Issue the refund, using one of the following methods:

For cash reimbursement, give the customer change out of the till.

For credit reimbursement, there is nothing else to do. The credit is available in the customer’s
open item ledger.

Note: Deposit refund credits post to the open item ledger regardless of whether the customer
has a charge account or is classified as cash-only.

For check reimbursement, write an AR easy check to the customer. Then apply the easy check
to the credit that posted to the customer’s open-item ledger when you completed the invoice.
For more information, see AR Easy Checks on page 782.

For payment card reimbursement, process the card. The customer’s account with the card
company will be credited for the refund amount.

RETURNS AND TRADE-INS
Returns and trade-ins are started in the same way as regular sales. However, you need to enter
negative quantities for the items being returned or traded in. When dealing with returns, the type of
item being returned and its costing method affect how you perform the return.

Note: When customers return items, you can flag the products that are being returned. Items that
were flagged during previous returns are highlighted in yellow on the screen for processing
returns and trade-ins. Flagging items helps to prevent fraud, because you can quickly
determine whether a customer is trying to return an item that was already returned in a
previous transaction.

INVENTORIABLE ITEM RETURNS
Returns of inventoriable items that you keep on hand are the simplest returns to perform.

To process the return of an inventoriable item

1. Start a work order for the customer who is returning the item. For more information, see Create a
Regular Work Order on page 442.

2. Click Add and look up the item being returned.
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3. Type the quantity of the item being returned in as a negative number and press Enter.

Example: If one item is being returned, type -1.)

The Customer Sales History screen opens. It lists items the customer previously bought,
returned, or traded-in. Items highlighted in yellow were flagged during previous returns.

4. If you want to flag the item being returned, make sure theMark Return check box is selected.
Otherwise, clear the check box and go to step 7.

5. Locate the item you want to flag.

To display only the item being returned, selectMatch Inventory.
To display the items sold for the vehicle selected for the current work order, selectMatch
Vehicle.
To display only items for which the core value has been defined, select the Cores check box.
To change the number of items displayed by invoice date, select Under 90 Days, Under 180
Days or All.

6. Select the returned item. It will be highlighted in yellow the next time you process a return for the
same customer.

7. Click Return. The Invoice Entry screen opens, and the returned item’s add-ons (if any) are added
to the work order.
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8. Delete the add-on items as needed.

9. Click Complete. Then complete the invoice and reimburse the customer with the original payment
method. For more information, see Complete an Invoice on page 456

NONINVENTORIABLE ITEM RETURNS
The method for handling noninventoriable item returns depends on the returned item’s costing method
and whether it is tracked.

RETURN TRACKED OPTION COST ITEMS
When a customer returns a tracked option cost item, you record its cost at point of sale and put it on a
(negative) receiving document. Because negative receiving documents are used for returning items
to vendors (negative RDs remove items from inventory), the returned item will not be available to sell
to another customer. Option cost items are typically obtained through outside purchases before
being sold to customers.

To process tracked outside purchase returns
1. Review the customer’s original sale invoice and the item’s receiving document. With this

information, you can:

Confirm the item was sold to the customer.

Identify the vendor who sold you the item and the price you paid for it.

For more information, see Verify Noninventoriable Item Returns on page 309.

2. Start a work order for the customer who is returning the outside purchase item.

3. Add the returned item to the work order.

a. Click Add and look up the item.
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b. Type the quantity as a negative number (-) and press Enter.

Example: If one item is being returned, type -1.)

The Customer Sales History screen opens. It lists the items the customer previously bought,
returned, or traded-in. Items highlighted in yellow were flagged during previous returns.

c. Select the item being returned and click Return.

Note: If you do not see the item being returned, select theMatch Inventory check box
(upper-right corner).

d. Type the returned item’s description and original selling price.

4. Enter the returned item’s cost.

a. ClickOption Cost. The Option Cost screen opens.
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b. Type the item’s cost.

5. Create the negative receiving document

a. Click Vendor and search for the vendor who sold you the item.
b. Select the Receive and Price check box.
c. ClickOK. The Receiving Document screen opens.

d. Click Receive. TireMaster prompts you to price the receiving.

e. Do one of the following:

If the vendor has issued a return invoice to you, click Yes. The Vendor Invoice screen
opens.
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If you do not have a return invoice from the vendor, click No. The Report Window opens
and displays the receiving document. Print it if needed and close the Report Window.
Then go to step 7. You can price the item and create the negative charge later.

6. To price the negative receiving document, click Complete. The Correcting VC screen opens.

7. Complete the return invoice.

a. Click Complete.
b. Process the customer’s reimbursement with the same payment method used for the original

invoice.

RETURN UNTRACKED OPTION COST ITEMS
When a customer returns an option cost item, you need to record its cost at point of sale and you
have the option to put the item on a (negative) receiving document. Depending on what you do, once
of the following occurs:

If you put the item on a negative RD, it will not be available to sell to another customer
(because the negative receiving document is used to return the item to the vendor)

If you disregard putting it on a negative RD, the item will be added to available inventory and
can then be sold to another customer

Option cost items are typically obtained through outside purchases before being sold to customers.

To process the return of an untracked option cost item

1. Start a work order for the customer who is returning the item. For more information, see Create a
Regular Work Order on page 442.

2. Click Add and look up the item being returned. For more information, see Inventory Searches on
page 230.

3. Type the quantity of the item being returned as a negative number, and press Enter.
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Example: If one item is being returned, type -1.)

The Customer Sales History screen opens. It lists items the customer previously bought,
returned, or traded-in. Items highlighted in yellow were flagged during previous returns.

4. If you want to flag the item being returned, make sure theMark Return check box is selected.
Otherwise, clear the check box and go to step 7.

5. Locate the item you want to flag.

To display only the item being returned, selectMatch Inventory.
To display the items sold for the vehicle selected for the current work order, selectMatch
Vehicle.
To display only items for which the core value has been defined, select the Cores check box.
To change the number of items displayed by invoice date, select Under 90 Days, Under 180
Days or All.

6. Select the returned item. It will be highlighted in yellow the next time you process a return for the
same customer.

7. Click Return. The Invoice Entry screen opens and the returned item’s add-ons (if any) are added
to the work order.

8. Delete the add-on items as needed.

9. Update the item’s description and selling (parts) price so they match the original sale invoice.
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10. Enter the item’s cost.
a. ClickOption Cost.

b. Type your cost for the item in theOption Cost field.

11. If you want to put the item on a negative receiving document, do the following. Otherwise go to
step 13.

a. Make sure the Put item on a receiving document check box is selected.
b. Click Vendor and look up the vendor who originally sold you the item. For more information,

see Vendor Searches on page 193.

c. Select the Receive and Price check box.
d. ClickOK. The Receiving Document screen opens.
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e. Click Receive. TireMaster prompts you to price the receiving document.

12. Price the receiving document and create a negative vendor charge, which will reduce the
vendor’s balance.

a. Click Yes. The Vendor Invoice screen opens.
b. Click Complete. The Correcting VC screen opens.

c. Define whether the vendor charge will be a system-generated amount or an amount of your
choice (TireMaster Plus and TireMaster Corporate):

For a vendor charge based on the next cost and next FET calculated by TireMaster, select
Create VC with system generated amount.
Note: The vendor charge number and amount listed are subject to change if other

transactions involving returned items are completed before you finish the
inventory return.

For a vendor charge amount of your choice, select Create VC with User defined
amount and type the charge amount.

d. Select a method for processing the vendor charge:

To automatically create the vendor charge and post it to the vendor’s subledger, select
Create and process a negative Vendor Charge when the VID is processed.



Returns and Trade-Ins

To create the vendor charge yourself, select Create a negative Vendor Charge
manually. For more information, see Enter a Vendor Charge on page 744.
To automatically create the charge and put it in an open batch of charges for the vendor,
select Create a negative Vendor Charge as part of an open batch. When the AP
Batch Charge screen appears, choose a batch or create a new batch.

Note: This option is not available when a user at the corporate site is pricing a receiving
document for a store.

e. ClickOK. The Report Window opens and displays the Vendor Invoice Document.

Note: If you click Cancel instead, you’ll need to create the negative vendor charge
manually.

f. Print the VID if needed, and close the Report Window. Once the negative charge is created,
apply it to the vendor’s subledger to reduce the vendor’s balance. For more information, see
Apply Payments and Credits to Vendor Balances on page 756.

13. If you don’t want to add the item to a negative receiving document, do the following:

a. Clear the Put item on a receiving document check box.
b. ClickOK.

14. Click Complete. Then complete the invoice and reimburse the customer with the original
payment method. For more information, see Complete an Invoice on page 456.

RETURN TRACKED EXPENSE AND RELIEF PERCENT ITEMS
When a customer returns a tracked item that’s assigned the expense or relief percent costing
method, the item is put on an unknown receiving document. Depending on what the item is, you
could sell it to another customer or return it to the vendor.
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To process tracked expense and relief percent item returns
1. Review the customer’s original sale invoice and the item’s receiving document. With this

information, you can:

Confirm the item was sold to the customer.

Identify the vendor who sold you the item and the price you paid for it.

For more information, see Verify Noninventoriable Item Returns on page 309.

2. Start a work order for the customer who is returning the outside purchase item.

3. Click Add and look up the item being returned.

4. Type the quantity as a negative number (-) and press Enter.

Example: If one item is being returned, type -1.)

The Customer Sales History screen opens. It lists the items the customer previously bought,
returned, or traded-in. Items highlighted in yellow were flagged during previous returns.

Note: If you do not see the item being returned, select theMatch Inventory check box.

5. Select the item being returned and click Return.
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6. ClickOK. A message tells you that the item will be assigned to an unknown receiving document.

7. ClickOK to close the message.

8. Complete the return invoice.

a. Click Complete.
b. Process the reimbursement with the same payment method used for the original invoice.

RETURN UNTRACKED EXPENSE AND RELIEF PERCENT ITEMS
When a customer returns an untracked expense method or relief percent item, it’s added back into
inventory. Depending on what the item is, you could sell it to another customer or return it to the
vendor.

To process untracked expense and relief percent item returns
1. Start a work order for the customer who is returning the item. For more information, see Create a

Regular Work Order on page 442.

2. Click Add and look up the item being returned. For more information, see Inventory Searches on
page 230.

3. Type the quantity of the item being returned as a negative number, and press Enter.
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Example: If one item is being returned, type -1.)

The Customer Sales History screen opens. It lists items the customer previously bought,
returned, or traded-in. Items highlighted in yellow were flagged during previous returns.

4. If you want to flag the item being returned, make sure theMark Return check box is selected.
Otherwise, clear the check box and go to step 7.

5. Locate the item you want to flag.

To display only the item being returned, selectMatch Inventory.
To display the items sold for the vehicle selected for the current work order, selectMatch
Vehicle.
To display only items for which the core value has been defined, select the Cores check box.
To change the number of items displayed by invoice date, select Under 90 Days, Under 180
Days or All.

6. Select the returned item. It will be highlighted in yellow the next time you process a return for the
same customer.

7. Click Return.

8. Click Complete. Then complete the invoice and reimburse the customer with the original
payment method. For more information, see Complete an Invoice on page 456

TRADE-INS
When a customer has an item to offer you as a payment or partial payment, add the trade-in to the
customer’s work order.
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To take a trade-in
1. Start a work order for the customer who is returning the item. For more information, see Create a

Regular Work Order on page 442.

2. Click Add and look up the item being traded in.

3. Type the quantity of the item being returned in as a negative number and press Enter.

Example: If four items are being traded in type -4.)

The Customer Sales History screen opens.
4. Click Trade-In. The Invoice Entry screen opens, and the add-ons for the traded item (if any) are

added to the work order.

5. Delete the add-ons.

6. If the customer is trading-in a noninventoriable item, update the description.

7. Type the amount you’re offering the customer (per item) in the Parts price field.

8. Add other items to the work order or complete the invoice. For more information, see Complete an
Invoice on page 456.
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TRANSFERS
Stores that are part of a chain or work with buying groups often need to transfer inventory from one
location to another. In TireMaster, transfers are handled as sales. In a transfer, you sell items at cost
instead of the regular selling price.

Note: Charges for transfers post to a special GL account and transfer sales are separated from other
sales on the income statement.

PREPARE FOR TRANSFER SALES
Before you can create transfer invoices, you need to complete various settings.

TRANSFER CUSTOMER TYPE
The startup database that ships with new TireMaster systems includes type T, which is a customer
type for transfer customers. You can use this setting or add your own customer type to handle
transfer customers. For more information, see Add a Customer Type on page 99.

SET TRANSFER SALE CONTROLS
Before you add transfer customers and perform any transfer sales, you need to define the default
customer type for transfer customers. If you're running TireMaster Plus or TireMaster Corporate, you
also need to define the GL class for transfers.

To set the transfer sale controls
1. Select Setup > System Controls. The System Controls screen opens.

2. Set the customer type control.

a. Click the Customer tab.
b. Select Customer - Transfer Type. By default, the control is set to type T.

c. If you do not want to use type T as the default transfer customer type, press Enter and select
a different type from the list. Otherwise, leave it alone.
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3. Set the transfer GL class control. If you're running TireMaster Point of Sale, disregard this step.

a. Click theGeneral Ledger tab.
b. Select Transfer GL Class. By default, the control is set to class 2.

c. If you do not want to use class 2 as the default class for transfer sales, press Enter. Then
type the number for the class you want to use. Otherwise, leave it alone. For more
information, see GL Classes on page 682.

4. Close the System Controls screen.

ADD TRANSFER CUSTOMERS
A transfer customer is usually a buying group or another store in a multistore chain.

Note: You should check with your accountant to determine whether transfer customers should be
taxable or nontaxable. For transfer customers, ASA recommends leaving the Taxable check
box selected on the Customer Maintenance screen and assigning an exempt tax level. The
result is that all transactions appear on your sales tax reports.

To add a transfer customer
1. Look up an existing AR customer, or add a customer record for the transfer customer. For more

information, see Customer Searches on page 93 or Add an AR Customer on page 68.

2. On the Customer Maintenance screen, make sure theGeneral tab is selected.

3. Click Edit (unless you just added the customer).
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4. Do the following:

a. To assign the transfer customer type, click the Type field and press . Then select the type
for transfer customers from the list.

Note: T is the default customer type set up in TireMaster for transfer customers. However,
you can add your own customer type to handle transfer customers. For more
information, see Add a Customer Type on page 99.

b. Clear the Cash Only check box.

5. Add additional information to the transfer customer’s record if needed.

6. To save the transfer customer, clickOK.

PERFORM A TRANSFER SALE
To transfer inventory from one store to another, start a work order as usual, looking up a transfer
customer when prompted. When you add items to the work order, they’re priced at your cost and don’t
include add-ons. Once you’ve added all of the items you need to transfer, you can complete the work
order. For more information, see Create a Regular Work Order on page 442 and Complete an Invoice
on page 456.

RECEIVE TRANSFERRED ITEMS
When you receive transferred inventory, create a work order and treat it like a trade-in. TireMaster
prices trade-ins from transfer customers at your last cost.

To receive a transferred inventory
1. Start a work order for the transfer customer who sold you the items. For more information, see

Create a Regular Work Order on page 442.
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2. On the Invoice Entry screen, click Add and look up transferred item.

3. In theQuantity column, type - followed by the quantity of transfer items being received. (For
example, to receive 2 tires, type -2.) The Customer Sales History screen opens.

4. Click Trade-In. The item is added to the work order at your cost and includes federal excise tax, if
any.

5. Complete the invoice as usual. For more information, see Complete an Invoice on page 456.
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QUOTES AND ESTIMATES
With TireMaster, you can prepare verbal quotes, basic quotes, and comparison quotes when
customers request price information. You can also increase the sales of preventative maintenance
and repairs by using vehicle inspection results to write estimates for recommended services. This
chapter includes the following sections:

Quote and Estimate Writer 494
Prepare Quotes 502
Vehicle Inspections 517
Prepare Estimates 522
Manage Your Quotes and Estimates 526
Quote and Estimate List 530
Convert Quotes to Sales 532
Convert Estimates to Sales 534
Service Checklists 538
Quick Quotes 549
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QUOTE AND ESTIMATE WRITER
With the Quote and Estimate Writer (Figure 17-1), you can perform all of the following tasks on a single
screen:

Create and save quotes

Record and save the results of vehicle inspections

Create and save service and repair estimates

The Quote and Estimate Writer is divided into two sections. The top panel is for writing quotes, and the
lower panel is for recording the results of vehicle inspections and writing estimates. The Quote and
Estimate Writer can be accessed when other screens are open by pressing F12.

Figure 17-1: Quote and Estimate Writer

Item Description

Customer Lets you search for a customer. You can also type a customer’s name
in this field.

Contact Lets you type the customer’s phone number, or your can click the
button and select the phone number from a list.
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Item Description

Vehicle Lets you look up a vehicle that has already been set up for the
selected customer. You can also type a vehicle description in this
field.

Fitment Lets you access the Tire Guide Pro Plusfitment guide, if it is installed
and the subscription is current. Tires selected from the fitment guide
can be added only to quotes.

Tax Level Lets you select a different tax level for the customer. You may change
the tax level only if you belong to security group that’s assigned the
Quotes Change Tax Level permission.

Quote Notes Lets you enter comments about the quote or estimate. On printed
quotes and estimates, these comments are located in the lower-left
corner of the page.

Cust Sale Displays the user ID for the salesperson assigned to the customer’s
account. If no salesperson is assigned to the customer, this field
displays the ID for the user logged in to TireMaster instead.

Quote/Est Sale Lets you enter your user ID.

Good for Days Lets you set an expiration date for the quoted prices.

Note: You can set a default number of days during which quotes will
be accepted. For more information, see Quotes - Keep for (#)
of Days on page 1215.

Incl Addons Indicates whether quoted prices automatically include the prices of
add-on items. The setting for this check box is defined by the system
controlQuotes - Include Add-Ons.
Along with the control, the settings for an add-on package also affect
whether quoted prices include add-ons. Therefore, quoted prices will
include add-on items if the following conditions are true:

The controlQuotes - Include Add-Ons is set to Yes
An add-on item is set to appear selected when its added to a
quote

For more information, see Quotes - Include Add-Ons on page 1214
and Assign Items to Add-On Codes on page 256.

Incl Taxes Indicates whether quoted prices automatically include sales tax.
Whether this check box is selected depends on a system control
setting. For more information, see Quotes - Include Sales Tax on

495



496

User Guide

Item Description

page 1214.

View Margin Lets you display the profit margin for parent items. The check box can
be selected only by users who belong to a security group assigned the
permissionQuotes View Margin.

Q (Top Panel) Lets you collapse or expand quote information.

Click in the top (blue) row to display all of the information for
a quote (items, name, description, and totals).

Click in the top (blue) row to display only the quote’s name,
description, and totals.

Auth (Top panel) Lets you do the following:

To turn a quote into a work order, select the check box in a
quote’s top (blue) row. To turn two or more quotes into a single
work order, select the check box for each quote that you want to
put on the work order.

To display the add-on items assigned to a parent item, click

in the parent item’s row.

To display a parent item only, click in that item’s row.

Incl (Top panel) Lets you do the following:

To include a quote on a printout, select the check box in the
quote’s top (blue) row and save your changes before printing.

To put a parent item and its add-on items on a quote, select the
check box in the parent item’s (green) row.

To include an add-on item on a quote, select the check box in
an add-on item’s (white) row.

Note: Whether the check boxes are automatically selected for add-
on items depends on the settings for the add-on package and
a system control setting. For more information, see Assign
Items to Add-On Codes on page 256 and Quotes - Include
Add-Ons on page 1214.

Qty Lets you do the following:

In the yellow rows, add a label to the quote. To add a label, click
in the yellowQty field and press repeatedly to choose Good,
Better, or Best.
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Item Description

In the green and white rows, change the quantity of items. The
default quantity for items put on a quote is defined by a system
control. For more information, see Quotes - Default Qty on page
1214.

Note: When the quantity of a parent item is changed, the quantities
of the add-on items change to match except for those add-ons
whose quantities are fixed.

Size Displays the following:

The name that you’ve entered for a quote in the top (blue) row

Note: A default quote name can be defined by setting a system
control. For more information, see Quotes - Default Name
on page 1214.

The size of parent items included in the quote (green rows)

The size of add-on items included in the quote (white rows)

Description Displays the following:

The description you’ve entered for a quote in the top (blue) row

The description for parent items included on a quote (green
rows)

The description for add-on items included on a quote (white
rows)

Parts Displays the parts prices for quoted items.

Labor Displays the labor prices for quotes items.

FET Displays the federal excise tax for quoted items.

Subtotal Displays the extended price (Quantity x Price + FET) for each item on
a quote, along with a subtotal for all of the items on the quote.

Tax Defines whether an item’s parts price, labor price, both, or neither are
taxed. To change an item’s tax status, click in the Tax column for that
item and repeatedly press . At the end of the quote, this column also
displays the total amount of sales tax for the quoted items.

Total Displays the total price (Subtotal + Sales Tax) of the quoted items at
the end of the quote.

Product Code Displays the product codes for parent (green rows) and add-on items
(white rows).
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Item Description

Margin Displays the profit margin percentage for inventoriable items when the
View Margin check box is selected. Margins can be viewed only by
users who belong to a security group that’s assigned the permission
Quotes View Margin.
Note: You can define the lowest margin you’re willing to earn by

setting a system control. For more information, see Quotes -
Lowest Margin Allowed on page 1215. If an item’s margin is
too low, it can be adjusted. For more information, see Adjust a
Quoted Item’s Margin on page 515.

Tip: The margin is calculated based on an item’s cost. Therefore, if
an item has no cost, the margin is 100%.

Checklist Lets you select the service checklist that you want to use for recording
the results of the vehicle inspection.

Add Quote Line Lets you add a new quote to the screen. When you click this button,
you’ll also be prompted to look up an item to include on the quote.
You’ll most likely use this button when writing a comparison quote.

Duplicate Quote
Line

Lets you add a copy of an existing quote to the screen. You can then
add or remove items from the duplicate as needed. You’ll most likely
use this button when writing a comparison quote.

Scv Intervals Lets you access service interval information for the selected vehicle
on systems that are integrated with the Epicor®ISE™.

Inspect Sheet Lets you access an inspection sheet for the selected vehicle on
systems that are integrated with the Epicor®ISE™.

Lets you enlarge the service checklist (bottom) panel.

Lets you enlarge the quote (top) panel.

Q (Bottom Panel) Lets you collapse or expand checklist information.

Click in the top (blue) row to display the inventory items
assigned to an inspection area.

Click in the top (blue) row to display only the name and
description of the inspection area and the estimate totals for
that inspection area.

Auth
(Bottom Panel)

Lets you do the following:
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Item Description

To put recommended services or repairs on a work order,
select the check box in an inspection area’s top (blue) row.

To display the add-ons for an item assigned to an inspection

area, click in the parent item’s row.

To display a parent item only, click in that item’s row.

Incl
(Bottom Panel)

Lets you do the following:

To include an inspection area’s name and description on a
printed estimate, select the check box for the inspection area’s
top (blue) row.

Note: Selecting an inspection area’s check box, displays totals
for that inspection area even if the list of items associated
with it has been collapsed.

To put a parent item and its add-ons on an estimate, select the
check box in the parent item’s (green) row.

To put an add-on item on an estimate, select the check box in
the add-on item’s (white) row.

Status/Qty Lets you do the following:

To set the status of an inspection area, click the yellow field in
the inspection area’s top row. Then press repeatedly. The
status can be set to OK, repairs suggested, and repairs
recommended immediately.

To set an item’s quantity, type the number you want to sell in
the green and white rows.

Note: When the quantity of a parent item is changed, the quantities
of the add-on items change to match except for those whose
quantities are fixed.

Inspection Area/Size Displays the following:

The name of an inspection area, in the top (blue) row

An item’s size, in the remaining (green and white) rows

Description Displays the following:

The description of an inspection area, in the top (blue) row

An item’s description, in the remaining (green and white) rows

Parts Displays the parts price for items on a checklist.
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Item Description

Labor Displays the labor price for items on a checklist.

FET/Miles Displays one of the following:

The federal excise tax for items on a checklist

The mileage at which service for an inspection area is
recommended

Sales/Sub Serves two purposes:

Lets you enter your user ID in the inspection area’s top row. To
change the user ID displayed, press and select a user from
the list that appears.

Displays the extended price (Quantity x Price + FET) of each
item on an estimate in the remaining green and white rows.

Displays subtotals for each of the inspection area (in bolded
text).

Tech/Tax Serves the following purposes:

Lets you enter a mechanic’s user ID.

Defines whether an item’s parts price, labor price, both, or
neither are taxed. To change an item’s tax status, click in the
Tax column for that item and repeatedly press .

Displays the estimated sales tax total for an inspection area (in
bold text).

Date/Total Serves the following purposes:

Lets you change the date on an estimate

Displays the estimated total price (Subtotal + Sales Tax) for an
inspection area

Notes/Product Code Displays the following:

The notes for an inspection area, in the top row. To add notes to
an inspection area, double-click the Notes/Product Code field
and type your message in the box that appears. To ensure the
entire note is included on a printout, save the estimate before
printing it.

Displays the product codes for items on an estimate.

Find Quote/Est Lets you look up an existing quote or estimate, depending on whether
the upper or lower panel is active.
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Item Description

To look up a quote, click the top panel. Then click Find
Quote/Est.
To look up an estimate, click the bottom panel. Then click Find
Quote/Est.

Delete Lets you remove a quote (from a comparison quote), an inspection
area, or items from a quote or service checklist.

To remove a quote, select its heading (blue) row and click
Delete.
To remove an item from a quote, select the item and click
Delete. When a parent item is deleted, any add-on items
associated with that parent item are also deleted.

To remove an inspection area from a service checklist, select
its heading (blue) row and click Delete.
To remove an item from a checklist, select the item and click
Delete. When a parent item is deleted, any add-on items
associated with that parent item are also deleted.

Inventory Lets you add an item to a quote or estimate.

Parts & Labor Lets you access the Epicor® Integrated Service Estimator if it is
installed. Parts and labor information from the ISEcan be retrieved to
write estimates for vehicle repairs.

Create/Update Appt Lets you schedule an appointment or update an existing appointment
for quotes or recommended services.

Reset Screen Removes the quote, checklist, or both currently on the screen, so you
can start a new quote or checklist for a different customer.

Price Level Lets you offer special pricing on an item. To offer special pricing,
select an item and click Price Level. Then select a level from the list
that appears. Users are allowed to change the price level only if they
belong to a security group that is assigned the permissionQuotes
Change Price Level.

Addons Lets you assign an add-on package (in other words, a group of add-on
items) to an item that has been put on a quote.

Clear Mechanic Lets you access the Clear Mechanic Interface if it’s installed.

Create/Update WO Lets you do the following:
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Item Description

Turn a quote into a work order

Create a work order based on authorized repairs from the
service checklist

Update an existing work order based on changes made to the
service checklist

WO and Auth Displays the following:

The customer’s work order total and the authorized total for the
selected quote/estimate.

The customer’s work order total

If there are multiple work orders for a customer that are all for the
same vehicle, the Quote and Estimate Writer shows the sum of the
work order totals instead.

Note: The asterisk (*) included with the value in theWO and Auth
field indicates that the amount might not always match the
total on the work order. Minor fluctuations between the
quote/estimate total and the work order total(s) are caused by
differences in how sales tax and shop supplies are calculated
in each of the program areas.

Shop Displays the shop charge associated with a quote (or estimate), plus
the sales tax assessed for the shop charge.

Authorized Total Displays the authorized total for the selected quote, estimate, or both.
To authorize a quote, select the Auth check box in the quote’s top
(blue) row. To authorize recommended services and repairs, select
the Auth check box in the applicable inspection area’s top (blue) row.
Note: The authorized total includes the amount of the shop charge.

Print Lets you print a hard copy of the selected quote or estimate.

Save Lets you save the quote or service checklist you’ve written for a
customer.

Close Lets you exit the Quote and Estimate Writer.

PREPARE QUOTES
When customers want to know howmuch items will cost, you can write quotes and provide them with
hard copies of the information. Quotes are written in the upper panel on the Quote and Estimate Writer
screen. Typically, the quoting panel is used to compile information about tires.
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BASIC TIRE QUOTES
When a customer wants to know how much one tire will cost, create a basic quote.

Note: You can also create comparison quotes for competing brands and quotes that show how much
items will cost when they're assigned various add-on packages. For more information, see
Good, Better, Best Quotes on page 506 and Price Comparison Quotes on page 511.

To create a basic quote
1. Press F12. The Quote and Estimate Writer opens.

2. Add the customer and vehicle information using one of the following methods:

Click Customer. Then look up the customer and select the vehicle. For more information, see
Customer Searches on page 93.

Type the customer’s name and the vehicle’s year, make, and model.

Tip: Quotes can be saved at any time by clicking Save.

3. Add contact and salesperson information, notes, and an expiration date.

a. Type the phone number at which the customer can be reached, or click Contact and select a
phone number from the list that appears.

b. Type comments about the quote (if any) in theQuote Notes field.
c. If your user ID is not already in theQuote/Est Sale field, press and select it from the list that

appears.

d. If you need to change the number of days the quote will be accepted, type a different number
in theGood for Days field.
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4. If you need to change the customer’s tax level, click Tax Level and select a different tax level.
5. If you want to see the profit margin for quoted items on the screen, select the View Margin check

box. If the margin is too low, you can adjust it. For more information, see Adjust a Quoted Item’s
Margin on page 515.

Note: The check box can be selected only by users who belong to a security group that’s
assigned the permissionQuotes View Margin.

6. If the quote (top) panel is not already active, click it. The quote panel is active when it’s surrounded
by a black box.

7. Click to enlarge the quote (top) panel. This button is located on the right side of the screen
between the quote and checklist panels.

8. Add an item to the quote using one of the following methods:

Click Inventory and look up an item. For more information, see Inventory Searches on page
230.



Prepare Quotes

Tip: If you decide that you want to create a comparison quote with competing brands
instead, press the Ctrl key, select multiple items when the Inventory List appears, and
then clickQuote. For more information, see Good, Better, Best Quotes on page 506.

Type the item’s size, quick look code, or manufacturer code in the Size field for the second
(white) quote row, and press Enter.

Scan its bar code. For more information, see Enter Bar Codes on Quotes on page 350.

Click Fitment and select an item from the fitment guide. For more information, see Look Up
Tire Sizes at Point of Sale on page 553.

If an item’s margin falls below the setting for the lowest margin allowed, TireMaster displays a
warning. You can then decide whether to add the item to the quote.

Note: An item’s margin can be adjusted to a higher or lower percentage, which raises or lowers
the selling price. For more information, see Adjust a Quoted Item’s Margin on page 515.

9. Make the following changes to the quoted item as needed:

Type the quantity and press Enter. TireMaster updates the quantities of the add-ons items.
Note: If there are no add-ons assigned to the item, you can add them to the quote by clicking

Addons and selecting an add-on package from the list that appears.

Type different prices, FET, or both.

To offer special pricing on an item using a global price level, select the item and click Price
Levels.
To change whether sales tax is calculated for an item’s part price, labor price, both, or none,
click in the Tax column for that item and repeatedly press .

To exclude an add-on item from the quote, clear its check box.
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10. Save the quote.

Note: If you want to use this quote as the starting point for a comparison quote, click Add Quote
Line and look up a similar group of items. If you want to quote the same item twice, with
some variations, click Duplicate Quote Line. Then add or delete add-on items and
change prices from the duplicate quote, as needed. For more information, see Good,
Better, Best Quotes on page 506.

11. Print a hard copy of the quote if needed. If you want to exclude an item from the printout, see Print
Quotes and Estimates on page 528.

GOOD, BETTER, BEST QUOTES
You can compare tires that are the same size on a good, better, best quote. This type of quote is also
called a GBB or comparison quote. A good, better, best quote can be used to compare quality, tread
life ratings, or prices.

On a printout for a good, better, best quote, product information for up to three tires can be displayed
near the top of the page. The content displayed depends on whether your TireMaster system is
integrated with the Tire Brands database from TGP Solutions LLC.

For Tire Brands subscribers, product images along with individual values for tread depth,
treadwear, traction, and mileage warranty are shown.

For dealers who do not use Tire Brands, the entries in the UTQG andWarranty fields from
Inventory Maintenance are shown instead. The UTQG values are labeledWear and warranty
values are labeledMiles.

To display product information near the top of the page, the following conditions must be true:

The system controlQuotes - Use Tire Brandsmust be set to Yes.
The labelsGood, Better, and Bestmust each be assigned to an item on the quote. Depending
on how the system controlQuotes - Use Good/Better/Best is set, these labels are assigned
automatically or you can assign themmanually. For more information, see Other Controls on
page 1209.

http://tgp-solutions.com/catalogs/list#tgpBrands
http://tgp-solutions.com/about_us


Prepare Quotes

Note: Both of these controls are store controls. Therefore, you have the option to include product
information on the quotes generated at some sites and not others.

To create a good, better, best quote
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.

2. Look up a items with similar characteristics. (For example, all size P215/60R16 tires.) The
Inventory List opens. For more information, see Inventory Searches on page 230.

3. Select the tires you want to include on the comparison quote.

a. Do the following if needed:

If the best tire is the most expensive tire, you can arrange the tires from lowest to highest
price by clicking the Best column heading once.
If you’ll be comparing tires by price (the best tire is the lowest-priced one), you can arrange
them from highest to lowest price by clicking the Best column heading twice.

b. Press the Ctrl key and select the first tire you want to add to the quote.
c. Continue pressing the Ctrl key and select one or more additional tires. The order in which you

select the tires is the order in which they’ll be added to the quote.

Note: If the system controlQuote - Use Good/Better/Best is set to Yes, the first tire will
automatically be classified asGood, the second one will be classified as Better, and
the last tire selected will be classified as Best. If you select four or more tires, the
additional tires will be added to the quote with no classification and no product
information will be displayed for them at the top of the printout.
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4. ClickQuote. The Quote and Estimate Writer opens and displays a quote for each of the selected
items.

If an item’s margin falls below the setting for the lowest margin allowed, TireMaster displays a
warning. You can then decide whether to add the item to the quote. On a comparison quote, the
message can appear multiple times depending on the margin for each item.

Note: An item’s margin can be adjusted to a higher or lower percentage, which raises or lowers
the selling price. For more information, see Adjust a Quoted Item’s Margin on page 515.

5. Click to enlarge the quote (top) panel. This button is located on the right side of the screen
between the quote and checklist panels.

6. Enter the following information as needed. For more information, see Basic Tire Quotes on page
503.

The customer’s name, vehicle, phone number, and tax level

An expiration date for the quote, the salesperson, and any notes that may be needed
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7. To see the profit margin for quoted items on the screen, select the View Margin check box. If the
margin is too low, you can adjust it. For more information, see Adjust a Quoted Item’s Margin on
page 515.

Note: The check box can be selected only by users who belong to a security group that’s
assigned the permissionQuotes View Margin.

8. For each item on the quote, do the following as needed:

Type the quantity and press Enter. TireMaster updates the quantities of the add-ons items.
Note: If there are no add-ons assigned to an item, you can add them to the quote. Select the

quote to which you want to retrieve add-on items. Then click Add-ons and select an
add-on package from the list that appears.

Type different prices, FET, or both.

To offer special pricing on an item using a global price level, select the item and click Price
Levels.
To change whether sales tax is calculated for an item’s part price, labor price, both, or none,
click in the Tax field for that item and repeatedly press .

To exclude an add-on item from the quote, clear its check box.

9. Add or update the identifying information for each quote.

To classify a quote asGood, Better, or Best, click theQty field (colored either yellow or purple)
in the quote’s top row and press repeatedly to find the appropriate label. You also have the
option to choose no label.

Note: If the system controlQuotes - Use Good, Better, Best (Other tab) is set to Yes,
these labels were added for you automatically.

In the blue Size field, type a name or additional information about the quote.

Example: If you’re comparing the tread life for multiple tires, you might have a description
such as 50,000 Mile Tread Life.
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10. If you want to add another quote to the comparison quote, do one of the following:
Click Add Quote Line. Then look up the items that you want to include on the additional quote,
define prices, and add names, if needed.

If you want to quote the same item twice, with some variations, click Duplicate Quote Line.
Then add or delete add-on items and change prices, as needed.

Note: If you want to display product information for the newly-added quote at the top of the
page, assign the classificationGood, Better, or Best to it. Then remove the
classification from one of the existing quotes. Product information for only oneGood,
one Better, and one Best quote can be displayed at the top of the page.

11. Click Save.

12. Generate a hard copy of the comparison quote.
a. Select the Auth check box for each quote that you want to include on the comparison quote

printout.

b. Click Print. The Report Window opens and displays the comparison quote.
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c. Print the good, better, best quote and close the Report Window.

PRICE COMPARISON QUOTES
You can write quotes that let customers see how much an item will cost depending on which add-on
package is assigned to it.

Example: If you use add-on packages to offer different types of tire warranties, you would add the
same tire to a quote two or more times. Then you would change the add-on package assigned to
each instance of the tire.

Note: You can also create price comparison quotes by excluding items, deleting individual add-on
items, or adding extra items to the quoted parent items instead.

To create a price comparison quote
1. Press F12. The Quote and Estimate Writer opens.

2. Add the customer and vehicle information using one of the following methods:

Click Customer. Then look up the customer and select the vehicle. For more information, see
Customer Searches on page 93.

Type the customer’s name and the vehicle’s year, make, and model.

3. Add contact and salesperson information, notes, and an expiration date.

a. Type the phone number at which the customer can be reached, or click Contact and select a
phone number from the list that appears.
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b. Type comments about the quote (if any) in theQuote Notes field.
c. If your user ID is not already in theQuote/Est Sale field, press and select it from the list that

appears.

d. If you need to change the number of days the quote will be accepted, type a different number in
theGood for Days field.

4. If you need to change the customer’s tax level, click Tax Level and select a different tax level.
5. If you want to see the profit margin for quoted items on the screen, select the View Margin check

box. If the margin is too low, you can adjust it. For more information, see Adjust a Quoted Item’s
Margin on page 515.

Note: The check box can be selected only by users who belong to a security group that’s
assigned the permissionQuotes View Margin.

6. If the quote (top) panel is not already active, click it. The quote panel is active when it’s surrounded
by a black box.

7. Click to enlarge the quote (top) panel. This button is located on the right side of the screen
between the quote and checklist panels.
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8. Add an item to the quote using one of the following methods:

Click Inventory and look up an item. For more information, see Inventory Searches on page
230.

Type the item’s size, quick look code, or manufacturer code in the Size field for the second
(white) quote row, and press Enter.

Scan its bar code

Click Fitment and select an item from the fitment guide. For more information, see Look Up
Tire Sizes at Point of Sale on page 553.

If an item’s margin falls below the setting for the lowest margin allowed, TireMaster displays a
warning. You can then decide whether to add the item to the quote.

Note: An item’s margin can be adjusted to a higher or lower percentage, which raises or lowers
the selling price. For more information, see Adjust a Quoted Item’s Margin on page 515.

9. Make the following changes as needed:

Type the quantity and press Enter. TireMaster updates the quantities of the add-ons items.
Type different prices, FET, or both.

To offer special pricing on an item using a global price level, select the item and click Price
Levels.
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To change whether sales tax is calculated for an item’s parts price, labor price, both, or none,
click in the Tax column for that item and repeatedly press .

To exclude an add-on item from the quote, clear its check box.

10. To add more quotes for the same tire, click Duplicate Quote Line for each additional quote. For
example, if you want to add two more quotes, you’d click Duplicate Quote Line twice.

11. Change the name and add-on package assigned to the first quote.
a. Type a unique name for the first quote in the Size field.

b. Click Add-Ons. The Add-On Code List appears.

c. Select the add-on package that you want to use for the first quote and clickOK. The add-on
items for the first quote are updated.

12. Change the name and add-on package for the remaining quotes.
Note: If a quote is already assigned the add-on package you want to use, you don’t need to look

up a different set of add-ons.

13. Enter identifying information for each quote as needed.
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a. To classify a quote asGood, Better, or Best, click theQty field (colored either yellow or purple)
in the quote’s top row and press repeatedly to find the appropriate label.

Note: The classification affects the positioning of product information near the top of quote
printouts. Because a maximum of three items can be displayed, only one quote should
be classified asGood, only one quote should be classified as Better, and only one
quote should be classified as Best. These classifications can be added for you
automatically, depending on your system control settings. For more information, see
Good, Better, Best Quotes on page 506.

b. In the blue Size field, type a name or additional information about the quote.

Example: If you’ve assign the silver level add-on package to a quote, you could type Sil-
ver Add-On Package.

14. Update theGood, Better, or Best classification if needed. To change a classification, click theQty
field (colored either yellow or purple) in a quote’s top row and press repeatedly to find the
appropriate label.

15. Save and print the quote.

START QUOTES FROM VARIOUS PROGRAM AREAS
The quickest way to start a quote is to press F12, however, you can also start quotes from the following
program areas:

On the OpenWork Order List, clickQuote.
On the Inventory List, select one or more items and clickQuote. For more information, see
Good, Better, Best Quotes on page 506.

Note: To choose multiple items, press the Ctrl key while making your selections.

The advantage of pressing F12 to start a quote is that you can leave other TireMaster screens open
while you create quotes.

ADJUST A QUOTED ITEM’S MARGIN
You can adjust an item’s margin to a higher or lower percentage. When an item’s margin is adjusted,
TireMaster recalculates the item’s parts price.

To adjust an item’s margin
1. If the quote for which you want to adjust an item’s margin isn’t already open, look it up. For more

information, see  Retrieve Quotes and Estimates on page 526.

2. If theMargin column is hidden, select the View Margin check box.
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Note: The check box can be selected only by users who belong to a security group that's
assigned the permissionQuotes View Margin.

3. Click theMargin field for the item whose margin you want adjust and press . The Margin screen
opens.

Tip: Margins can be adjusted for inventoriable parent items only.

4. Type new margin and clickOK. The item’s parts price is updated.

ADD TRADE-INS TO QUOTES
Some customers who request quotes might also ask to trade in tires or other items.

To add a trade-in to a quote
1. Press F12. The Quote and Estimate Writer opens.

2. Add the customer and vehicle information and items to the quote. For more information, see Basic
Tire Quotes on page 503.

3. Add the trade-in item.

a. Click the quote (top) panel to make it active. The quote panel is active when it’s surrounded by
a black box.
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b. Click Inventory and look up the trade-in item. For more information, see Inventory Searches
on page 230.

c. Type the item’s quantity as a negative number (such as -2), and press Enter. Any add-on
items associated with the parent item are removed from the quote.

d. Change the trade-in item’s price, if needed.

4. Save the quote and print it if needed.

VEHICLE INSPECTIONS
TireMaster includes space for recording and storing vehicle inspection results. This information is kept
in the Quote and Estimate Writer, the application for preparing tire quotes and service and repair
estimates.

PRINT A SERVICE CHECKLIST
When it’s time to inspect a customer’s vehicle, you can print a service checklist to take out to the shop.
As you examine the vehicle, you can write notes on the checklist and keep track of which inspection
areas you’ve already checked.

Service checklists generated with TireMaster include the name and description for each inspection
area. If inventory items have been assigned to any of the inspection areas, those items are also
included on the printout.
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To print a service checklist
1. Do one of the following to open the Service Checklists screen:

On the Quote and Estimate Writer screen, click Checklist. When TireMaster prompts you to
continue, click Yes.

Note: If a customer and vehicle have been selected in the Quote and Estimate Writer, the
printed checklist will include the customer’s name and vehicle information.

Select Setup > Vehicle Service Checklist.

2. Select the checklist you want to print and click Print. The Report Window opens.

3. Print the checklist and close the Report Window.

4. Close any open screens.

RECORD VEHICLE INSPECTION RESULTS
When vehicle inspections are finished, you can record the results of the inspections in TireMaster. This
information can be used to write estimates for recommended services or repairs.

To record the vehicle inspection results
1. Press F12 to open the Quote and Estimate Writer.
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Note: You can also open the Quote and Estimate Writer at point of sale by clicking Chk on the
Invoice Entry screen or by clicking Checklist on the Vehicle tab on the Customer
Maintenance screen.

2. If the customer and vehicle information isn’t already on the checklist, add it using one of the
following methods:

Click Customer. Then look up the customer and select the vehicle when prompted. For more
information, see Customer Searches on page 93.

Type the customer’s name and the vehicle’s year, make, and model.

Tip: The results of vehicle inspections can be saved at any time by clicking Save.

3. Type the phone number at which the customer can be reached, or click Contact and select a
phone number from the list.

4. If you need to change the customer’s tax level, click Tax Level and select a different tax level.

5. To enlarge the checklist panel, click until it reaches the size you want. This button is located
on the right side of the screen between the quote and checklist panels.

6. If you haven’t already activated the checklist panel, click it. The checklist panel is active when it’s
surrounded by a black box.

7. If you want to record the inspection results on a different checklist, click Checklist. When
TireMaster prompts you to save your changes, click No and select the checklist you want to use.
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8. Set the status for each inspection area and add any related notes. If you didn’t check an inspection
area, leave its status blank.

a. Click the Status/Qty field for an inspection area. Then press repeatedly until the applicable
status is listed. You can set the status to one of the following:

The inspection area is OK.

It’s suggested the inspection area be repaired soon.

It’s recommended that repairs be performed immediately.

b. Assign a different salesperson, mechanic, or change the date if needed. To change the
salesperson or mechanic, type the employee’s user ID or press and make a selection from
the list that appears. For dates, choose a different date from the calendar.

c. Select the Notes/Product Code field for an inspection area, and press to open the Notes
screen. Then type your notes for the inspection area, and clickOK.
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9. Define which parts and labor are needed to complete recommended services or repairs. These
items can be included on an estimate for the customer:

See if any items have already been associated with an inspection area by clicking in the
inspection area’s heading (blue) row.

Select the check boxes Incl column for the items you want to sell for the repair.

Tip: To automatically include all of the items on an estimate, select the Incl check box in
the heading (blue) row for the inspection area. Then you can clear the check boxes for
the items you don’t need.

Note: If the check box for a parent item is cleared, the check boxes for its add-on items are
cleared as well.

Add items to an inspection area if needed. To add an item, select a row for the inspection area.
Then click Inventory and look up the item that you want to add. For more information, see
Inventory Searches on page 230.
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Change the quantities, descriptions, prices, and federal excise tax for items as needed.

Change whether sales tax is calculated for an item’s part price, labor price, both, or none as
needed. Click in the Tax column for that item and repeatedly press to choose both, none,
parts, or labor.

10. Save your changes and close the Quote and Estimate Writer.

PREPARE ESTIMATES
The information gathered from vehicle inspections can be used to prepare estimates for recommended
services and repairs.

PREPARE ESTIMATES
When a customer’s vehicle needs service or repairs, you can prepare an estimate with the Quote and
Estimate Writer.

To write an estimate
1. Retrieve the customer’s vehicle inspection results.

a. Press F12 to open the Quote and Estimate Writer.

Note: You can also open the Quote and Estimate Writer at point of sale by clicking Chk on the
Invoice Entry screen or by clicking Checklist on the Vehicle tab on the Customer
Maintenance screen.

b. Click Find Quote/Est.
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c. Select the customer’s estimate from the list, and clickOK.

Tip: To quickly locate the estimate, type the customer’s last name or phone number or the
document number for the estimate and click Find.

2. If your user ID is not already in theQuote/Est Sale field, press and select it from the list that
appears.

3. If you haven’t already activated the checklist panel, click it. The checklist panel is active when it’s
surrounded by a black box.

4. To enlarge the checklist panel, click until it reaches the size you want. This button is located
on the right side of the screen between the quote and checklist panels.
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5. If you haven’t already done so, define which items are needed to complete recommended services
of repairs. For more information, see Record Vehicle Inspection Results on page 518.

6. Click Save and then click Print. The Report Window opens and displays a copy of the estimate.

7. Print a copy of the estimate for the customer. Then close the Report Window.

8. Close the Quote and Estimate Writer.

PREPARE ESTIMATES WITH THE INTEGRATED SERVICE
ESTIMATOR
If you use the Epicor® Integrated Service Estimator™ (ISE) with your TireMaster system, the process
for writing estimates is slightly different than it is on systems that are not integrated with the ISE.

To write estimates with the Integrated Service Estimator
1. Press F12 to open the Quote and Estimate Writer.

2. Add the customer’s name, vehicle, and contact information.

3. If you haven’t already activated the checklist panel (the bottom panel), click it. The checklist panel
is active when it’s surrounded by a black box.

4. To enlarge the checklist panel, click until it reaches the size you want. This button is located
on the right side of the screen between the quote and checklist panels.
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5. If the checklist that you use with the Integrated Service Estimator is not selected by default, click
Checklist and select it from the list that appears.

6. Look up the items needed to service the vehicle.

a. Click Parts & Labor. The Available Interfaces screen opens.

b. Select TM Epicor Interface and clickOK. The Epicor Interface screen opens.
c. Select the vehicle.

d. Look up the parts and labor needed for the services and repairs.

e. Add the ISE parts and labor information to the checklist.

7. To include all of the parts and labor information on the estimate, make sure the check boxes in the
Incl column are selected for both the inspection areas and the items.

Note: ISE inspection areas are listed in the top (blue) rows and the items are listed in the green
rows.
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8. Click Save and then click Print. The Report Window opens.

9. Print a copy of the estimate for the customer. Then close the Report Window.

10. Close the Quote and Estimate Writer.

MANAGE YOUR QUOTES AND ESTIMATES
TireMaster stores the quotes and estimates you’ve saved, until you turn them into completed sales or
decide that you no longer need them. In the meantime, you can retrieve existing quotes and estimates
and update them if needed.

RETRIEVE QUOTES AND ESTIMATES
You can retrieve quotes and estimates that have already been saved when a customer returns to
make a purchase or to review prices.

To retrieve quotes and estimates
1. Press F12. The Quote and Estimate Writer opens.

2. Click Find Quote/Est. The Quote and Estimate List opens.

3. If you don’t see the quote or estimate you want to retrieve, type the customer’s last name (last
name, first name), phone number, or quote number and click Find.

Tip: If you still don’t see the quote or estimate you’re looking for, it might be expired or locked.
To view expired quotes and estimates only, select Expired; to display both active and
expired quotes and estimates, select Both; or to display locked quotes and estimates only,
click Locked.

4. Select the quote or estimate you want to retrieve and clickOK. Now, you can update the quote or
estimate, print a copy of it, or turn it into a work order.
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UPDATE QUOTES AND ESTIMATES
You can update quotes and estimates by adding or removing items. You might also need to adjust
prices to encourage customers to buy items or recommended services from you instead of your
competitors.

To update quotes and estimates
1. Retrieve the quote or estimate you want to update. For more information, see  Retrieve Quotes

and Estimates on page 526.

2. If you’re updating a quote, click the quote (top) panel to make it active. If you’re updating an
estimate, click the checklist (bottom) panel instead. The quote or estimate is active when it's panel
is surrounded by a black box.

3. To enlarge the quote (top) panel, click . To enlarge the checklist panel, click as often as
needed. These buttons are located on the right side of the screen between the quote and checklist
panels.

4. Make the following changes as needed:

To update the quantities, prices, or FET for one or more items, type different amounts.

To add an item to the quote or estimate, click Inventory and look up the item or scan its bar
code. For more information, see Inventory Searches on page 230 or Enter Bar Codes on
Quotes on page 350

To remove an item from the quote or estimate, select the item and click Delete.
Note: Deleting a parent item also removes its add-ons.

To exclude an item from the quote or estimate, clear its check box in the Incl (include) column.
Note: Clearing the check box for a parent item also removes its add-ons.

To change whether sales tax is assessed for an item’s parts price, labor price, both, or none,
click the Tax column for the item and repeatedly press .

To change the expiration date, type a different number in theGood for Days field.
To change the salesperson assigned to the quote or estimate, click theQuote/Est Sale field
and press . Then select the salesperson’s name from the list that appears.

To change the customer’s tax level, click Tax Level and look up a different level.
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To offer special pricing for an item, select the item, click Price Levels, and select a level.
5. For comparison quotes, do the following as needed:

To delete a quote from a comparison quote, select its top (blue) row and click Delete.
To add another quote to the screen, click Add Quote Line or Duplicate Quote Line. For more
information, see Quote and Estimate Writer on page 494.

6. Save your changes, and print the updated quote or estimate or turn it into a work order. For more
information, see , Turn a Quote into a Work Order on page 533, or Turn an Estimate into a Work
Order on page 536.

PRINT QUOTES AND ESTIMATES
You can look up an existing quote or estimate and generate a hard copy.

To print an existing quote or estimate
1. Retrieve the customer’s quote or estimate. For more information, see  Retrieve Quotes and

Estimates on page 526.

2. Update the quote or estimate, if needed. For more information, see Update Quotes and Estimates
on page 527.

3. Define which quote or inspection areas and items you want to include on the printout by selecting
the applicable check boxes in the Incl column. In some cases, you might have a both a quote and
an estimate on the same printout.

4. Click Print. The Report Window opens and displays a copy of the quote or estimate.

5. Print the quote or estimate and close the Report Window.
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DELETE QUOTES AND ESTIMATES
If you no longer need a quote or estimate, you can delete it. To delete quotes and estimates, you must
belong to a security group that’s assigned the permissionQuotes Delete Quote.
Note: In addition to deleting individual quotes, you can also delete batches of expired quotes.

Typically, this is done during the month end closing process. For more information, see Delete
Expired Quotes on page 974.

To delete quotes and estimates
1. Press F12. The Quote and Estimate Writer opens.

2. Click Find Quote/Est. The Quote and Estimate List opens.
3. If you don’t see the quote or estimate you want to delete, type the customer’s name, phone

number, or quote number and click Find.
Note: If you still don’t see the quote you want to delete, it might be expired or locked. To view

expired quotes only, select Expired; to display both active and expired quotes, select
Both; to display locked quotes only, click Locked. For more information, see Quote and
Estimate List on page 530.

4. Select the quote or estimate that you want to delete, and click Delete Quote/Est. A confirmation
message appears.

5. Click Yes.
6. Close the open screens.

UNLOCK QUOTES AND ESTIMATES
Quotes and estimates are locked when they're already open on another workstation. If you need to
work with a locked quote or estimate, you can unlock it.

To unlock a quote
1. Press F12. The Quote and Estimate Writer opens.

2. Click Find Quote/Est. The Quote and Estimate List opens.

3. To display only locked quotes and estimates, click Locked.
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4. Select the quote or estimate you want to unlock. Then click Unlock Quote/Est. The Quote and
Estimate List displays all active quotes and estimates.

Note: If you don’t see the quote or estimate you just unlocked, it might have expired. In this
scenario, select Expired or Both to display the quote on the list.

QUOTE AND ESTIMATE LIST
Quotes and estimates that have been saved can be retrieved from the Quote and Estimate List (Figure
17-2).

Figure 17-2: Quote and Estimate List



Quote and Estimate List

Item Description

Name Lets you search for a quote or an estimate by typing the customer’s
name.

Phone Lets you search for a quote or an estimate by the phone number
recorded on the quote or estimate.

Quote # Lets you search for a quote or estimate by typing its system-assigned
document number.

Find Activates the search for a quote or estimate.

Clear Removes the names, document numbers, or phone numbers used to
search for a quote or an estimate.

Legacy Quotes Lets you convert quotes created and saved in the Quote Module in older
TireMaster versions to the Quote and Estimate Writer.

Active Displays only quotes that have not expired.

Expired Displays expired quotes only.

Both Displays both active and expired quotes.

Locked Displays only quotes and estimates that are already open on another
workstation.

Name Displays the name of the customer.

Phone Displays the phone number for contacting a customer.

Quote/Est. # Displays the system-assigned document number for a quote or
estimate.

Vehicle Displays the description of a customer’s vehicle.

Date Displays the date a quote or estimate was created.

Expires Displays the expiration date for a quote or estimate.

Sales Displays the name of the user who created the quote or estimate.

Locked By Displays the name of the user logged into the workstation on which the
quote is open.

Locked On Displays the date on which the quote was locked.

Delete Quote/Est. Lets you delete a quote or an estimate.
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Item Description

Unlock
Quote/Est.

Lets you unlock a quote or estimate.

OK Exits the Quote and Estimate List and displays the quote or estimate
that you selected on the main Quote and Estimate Writer screen.

Cancel Lets you exit the screen without selecting a quote or an estimate.

CONVERT QUOTES TO SALES
TireMaster includes tools to help you move from a quote to winning a sale.

FOLLOW UP ON QUOTES
When you want to follow up with customers whose quotes have not resulted in sales, refer to
TireMaster’s Open Quote report. For each quote, the report lists customer's name, vehicle, phone
number, and the items on the quote. For more information, see Open Quote Report on page 1067.

SCHEDULE WORK FOR QUOTED ITEMS
When a customer decides to buy the items on a quote but can’t have the work done right away, you
can use information from the quote to schedule an appointment.

To schedule work for quoted items
1. Retrieve the customer’s quote. For more information, see  Retrieve Quotes and Estimates on page

526.

Note: You can also open the Quote and Estimate Writer at point of sale by clicking Chk on the
Invoice Entry screen or by clicking Checklist on the Vehicle tab of the Customer
Maintenance screen.

2. Update the quote if needed. Updating the quote includes making changes such as raising or
lowering prices, adjusting margins, and making sure the Auth check box is selected for the quoted
items that will be sold to the customer.

3. Save your changes.

4. Click Create/Update Appt. A confirmation message appears.
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Note: If the Create/Update Appt button is disabled, the customer and vehicle need to be added
to TireMaster.

5. ClickOK to close the message. The Appointment List opens. On the Quote and Estimate Writer,
the rows in theQ and Auth columns turn green for the items set aside for the appointment.

6. Select the appointment, and click Edit.

7. Set the appointment date and time and select resources as needed. For more information, see
Schedule an Appointment on page 567.

8. Close the Appointment List and the Quote and Estimate Writer.

TURN A QUOTE INTO A WORK ORDER
When a customer is ready to make a purchase, you can turn the customer’s quote into a work order.

To turn a quote into a work order
1. Retrieve the customer’s quote. For more information, see  Retrieve Quotes and Estimates on page

526.

2. Update the quote if needed. Updating the quote includes making changes such as raising or
lowering prices, adjusting margins, and making sure the Auth check box is selected for the quoted
items that will be sold to the customer.

3. Save your changes.

4. Click Create/Update WO. If there’s already a work order for the customer, TireMaster gives you
the option of updating the existing work order or creating a new one.

533



534

User Guide

Note: If the Create/Update WO button is disabled, the customer and vehicle need to be added to
TireMaster.

5. ClickOK to close the message. The rows in theQ and Auth columns turn green for the items put
on the work order.

6. Close the Quote and Estimate Writer screen. The work order that you just created (or updated) is
added to the OpenWork Order List. You can update the work order, if needed, or complete the
sale.

CONVERT ESTIMATES TO SALES
You can use the information from estimates to encourage customers to schedule recommended
services and complete the sales process. Estimates for recommended services can be stored with
customer and vehicle records, simplifying follow-ups with customers who decline services.

SCHEDULE RECOMMENDED SERVICES
When you recommend services for a vehicle, the customer might ask to schedule an appointment. In
this scenario, you can begin the process of scheduling the appointment from the Quote and Estimate
Writer.

To schedule recommended services
1. Retrieve the customer’s vehicle inspection results.

a. Press F12 to open the Quote and Estimate Writer.

Note: You can also open the Quote and Estimate Writer at point of sale by clicking Chk on the
Invoice Entry screen or by clicking Checklist on the Vehicle tab of the Customer
Maintenance screen.

b. Click Find Quote/Est.

c. Select the customer’s estimate from the list, and clickOK.



Convert Estimates to Sales

2. To enlarge the checklist panel, click until it reaches the size you want. This button is located
on the right side of the screen between the quote and checklist panels.

3. Update the estimate if needed. Updating the estimate includes making changes such as raising or
lowering prices and adding or removing items.

4. To authorize the items (parts and labor) for the services the customer has decided to buy, select
the Auth check box for the applicable inspection area. The authorized total is updated (see lower-
right corner of the screen).

5. Click Save.

6. Click Create/Update Appt. A confirmation message appears.
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Note: If the Create/Update Appt button is disabled, the customer and vehicle need to be added
to TireMaster.

7. ClickOK to close the message. The Appointment List opens.

8. Choose the appointment date and time. You can also assign a mechanic and bay to appointment.
For more information, see Schedule an Appointment on page 567.

Note: Appointments that originate from the Quote and Estimate Writer are automatically
scheduled for the next day. If you don’t see the appointment when you click Calendar (on
the Appointment List), advance to the next day on the Appointment Calendar.

9. Close the Appointment screens to return to the Quote and Estimate Writer. The rows in theQ and
Auth columns are colored green to identify the items set aside for the appointment.

10. Close the Quote and Estimate Writer.

TURN AN ESTIMATE INTO A WORK ORDER
When a customer is ready for you to complete recommended services and repairs, you can turn the
estimate into a work order or add the recommended items to an existing work order.

To turn an estimate into a work order
1. If you haven’t done so already, retrieve the customer’s estimate. For more information, see

 Retrieve Quotes and Estimates on page 526.

a. Press F12 to open the Quote and Estimate Writer.

b. Click Find Quote/Est.

c. Select the customer’s estimate from the list, and clickOK.



Convert Estimates to Sales

Note: You can also retrieve a customer’s estimate at point of sale by clicking Chk on the
Invoice Entry screen or by clicking Checklist on the Vehicle tab of the Customer
Maintenance screen.

2. To enlarge the checklist panel, click until it reaches the size you want. This button is located
on the right side of the screen between the quote and checklist panels.

3. Update the estimate, if needed. Updating the estimate includes making changes such as raising
and lowering prices and adding and removing items. For more information, see Record Vehicle
Inspection Results on page 518.

4. To authorize the items (parts and labor) for the services the customer has decided to buy, select
the Auth check box for the applicable inspection area. The authorized total is updated (see lower-
right corner of the screen).

5. Click Save.
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6. Click Create/Update WO. A confirmation message appears.

Note: If there’s already a work order for the customer, TireMaster gives you the option of
updating the existing work order or creating a new one.

7. ClickOK. The rows in theQ and Auth columns are colored green to identify the items added to the
work order.

8. Close the Quote and Estimate Writer.

FOLLOW UP ON DECLINED SERVICES
When you want to follow up with customers who've declined recommended services and repairs, refer
to the Declined Services report. This document lists the names of the customers and descriptions of
the services they declined. For more information, see Declined Services Report on page 1047.

SERVICE CHECKLISTS
You can set up one or more service checklists for recording vehicle inspection results. Whether you
need multiple checklists depends on the types of services you provide to various customers.

Example: if your services for retail customers differ from those for commercial clients, consider
using separate checklists. Otherwise, you can probably use the same checklist for everyone.

New TireMaster systems include a basic checklist that can be used as is or modified. For more
information, see Update a Service Checklist on page 543.

Note: To manage service checklists, you need to belong to a user group that’s assigned the
permission Vehicle Service Checklist Add/Edit/Delete.



Service Checklists

SET UP A SERVICE CHECKLIST
You can design service checklists to meet the specific needs of your shop. To set up a service
checklist, add it to TireMaster, define whether it will be the default checklist, and add inspection areas
to it.

Note: Service checklists can be set up at both the corporate site and the stores. However, a system
control defines whether a store can see checklists created at the corporate and the other sites.
For more information, see Checklist - View All on page 1210.

Tip: For a detailed list of settings for each service checklist, print the Service Checklist Setup
Report. For more information, see Service Checklist Setup Report on page 1094.

CREATE A NEW SERVICE CHECKLIST
To create a new service checklist, add it to your TireMaster system.

To create a service checklist
1. Select Setup > Vehicle Service Checklist. The Service Checklists screen opens.

2. Click Add. The Service Checklist Maintenance screen opens.

3. Type a name and description for the checklist.

DEFINE THE DEFAULT CHECKLIST
Once you’ve added one or more service checklists to TireMaster, define which one you’ll use most
often by setting it as the default checklist.

Note: Each site needs to define its own default checklist.

To define the default checklist
1. If the Service Checklists screen isn’t already open, select Setup > Vehicle Service Checklist.
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2. Select the checklist you want to set as the default and click Edit. The Service Checklist
Maintenance screen opens.

3. Select the Default check box.

4. ClickOK to save your changes and return to the Service Checklists screen.

CREATE INSPECTION AREAS
Once you’ve added a new checklist to TireMaster, you can create inspection areas for it. Typically,
an inspection area includes a description of what to check on a vehicle and a list of items (parts and
labor) that can be put on an estimate, appointment, or a work order when repairs are recommended.



Service Checklists

You can also associate an inspection area with a postcard code for declined services mailings and
define whether services should automatically be recommended based on a vehicle’s beginning
mileage.

Note: If you use the Epicor® Integrated Service Estimator™, set up only one generic inspection
area with no items assigned to it or no inspection areas at all.

To create an inspection area
1. If the Service Checklists screen isn’t already open, select Setup > Vehicle Service Checklist.

2. Select the checklist you want to add inspection areas to, and click Edit. The Service Checklist
Maintenance screen opens.

3. Click Add. The Add/Edit Inspection Area screen opens.

4. Type a name for the inspection area.

Example: You could have inspections areas named Brake Inspection, Under Vehicle
Inspection, and Battery Inspection.

5. If services for the inspection area should be automatically recommended based on the vehicle’s
beginning mileage, select theMileage-Based Service check box and type the mileage at which
to recommend services.
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Note: Services are recommended when a vehicle’s beginning mileage falls within the range
defined by a system control. For example, if the threshold is set to 1000 and the mileage
for the inspection area is set to 30,000, services will be recommended when the
beginning mileage falls between 29,000 and 31,000 miles. For more information, see
Checklist - Mileage Threshold on page 1210.

6. To associate the inspection area with a postcard code for declined services mailings, click .
Then select a code from the Postcard Lookup screen. For more information, see Associate an
Inspection Area with a Postcard on page 606

7. Type a description of what to check.

8. To create a list of items that can be put on estimates, work orders, or appointments when
services for the inspection area are recommended, click Add Inventory and look up each item.
For more information, see Inventory Searches on page 230.

Tip: To save time at point of sale, look up all of the items that can be used to service the
inspection area. For example, if the inspection is for brakes, look up all brake pads,
rotors, discs, drums, and brake labor items.

Note: If any add-ons are assigned to an item, they will be included on work orders and
estimates automatically. Therefore, you only need to look up parent items.

9. To save the inspection area, clickOK.



Service Checklists

10. To move an inspection area closer to the top or bottom of the checklist, select the inspection
area. Then clickMove Up orMove Down.

11. When you’re done adding inspection areas to the checklist, close the Service Checklist
Maintenance and Service Checklists screens.

Tip: For a detailed list of the settings for each of your service checklists, print the Service
Checklist Setup Report. For more information, see Service Checklist Setup Report on
page 1094.

UPDATE A SERVICE CHECKLIST
Occasionally, you might need to update either an existing service checklist or an inspection area for a
checklist.

UPDATE AN EXISTING SERVICE CHECKLIST
You can update an existing checklist by renaming it or changing the inspection areas.

To update a service checklist
1. Select Setup > Vehicle Service Checklist. The Service Checklists screen opens.
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2. Select the checklist you want to update, and click Edit. The Service Checklist Maintenance
screen appears.

3. Do the following as needed:

Type a new name or description.

Select or clear the Default check box.
Move an inspection area up or down. To move an area, select the area’s name. Then click
Move Up orMove Down.
Add a new inspection area. For more information, see Create Inspection Areas on page 540.

4. To update the settings for an inspection area, select it and click Edit. For more information, see
Update an Inspection Area on page 544.

5. To delete an inspection area, select it and click Delete.
6. When you’re done making changes, clickOK.
7. Close the Service Checklists screen.

UPDATE AN INSPECTION AREA
You can change the settings for checklist inspection areas. For example, you might want to rename
an inspection area or assign additional items.

Note: If you use the Epicor® Integrated Service Estimator™, set up only one generic inspection
area with no items assigned to it or no inspection areas at all.

To update an inspection area
1. Select Setup > Vehicle Service Checklist. The Service Checklists screen opens.



Service Checklists

2. Select the checklist that includes the inspection area, and click Edit. The Service Checklist
Maintenance screen opens.

3. Select the inspection area you want to update, and click Edit. The Add/Edit Inspection Area
screen opens.

4. Do the following as needed:

If services for the inspection area should be automatically recommended based on the
vehicle’s beginning mileage, select theMileage-Based Service check box and type the
mileage at which to recommend services.

Note: Services are recommended when a vehicle’s beginning mileage falls within the range
defined by a system control. For example, if the threshold is set to 1000 and the
mileage for the inspection area is set to 30,000, services will be recommended when
the beginning mileage falls between 29,000 and 31,000 miles. For more information,
see Checklist - Mileage Threshold on page 1210.

If you need to associate the inspection area with a postcard code, click . Then select a
code from the Postcard Lookup screen, and clickOK. For more information, see Associate
an Inspection Area with a Postcard on page 606.
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Update the description of what to check.

To look up items that can be set aside for appointments or put on estimates and work orders
when repairs are recommended, click Add Inventory. For more information, see Inventory
Searches on page 230.

To remove an item from the inspection area, select the item and click Delete Inventory.
5. To save the changes, clickOK.

DELETE A SERVICE CHECKLIST
If you no longer use a checklist, you can delete it.

To delete a service checklist
1. Select Setup > Vehicle Service Checklist. The Service Checklists screen opens.
2. Select the checklist you no longer need and click Delete. A confirmation message appears.

3. Click Yes. The checklist is removed.
Note: If you deleted the default service checklist, you need to set one of the remaining checklists

as the new default. For more information, see Define the Default Checklist on page 539.

SET THE SERVICE CHECKLIST CONTROLS
The following system controls affect the default behavior of service checklists.

Checklist - Append to Comments defines whether to include notes about recommended
services on invoices.

Checklist - Mileage Threshold defines a range in which services are automatically
recommended for a vehicle based on the mileage. For more information, see Mileage Based
Services on page 547 .

Checklist - View All defines whether all service checklists are available to a site or if users at
that site can access only the checklists created there. If you're running TireMaster Plus or
TireMaster Point of Sale, disregard this setting.

Checklist - View Status defines which inspection areas to display when different service
checklists were used for previous vehicle inspections.



Service Checklists

Figure 17-3: Service Checklist System Controls

All of these checklist controls are on theOther tab of the System Controls screen. Whether you need
to set all of these controls depends on how you want to use the service checklist. For more information,
see Other Controls on page 1209.

MILEAGE BASED SERVICES
You can define whether TireMaster should automatically recommend services for an inspection area
based on a vehicle’s beginning mileage at point of sale. To set up mileage-based services, do the
following:

Set the milage threshold (a range in which services will be recommended automatically).

For one or more inspection areas, define the mileage at which services are recommend.

Here’s what happens once these settings are completed. When you start a work order, enter the
vehicle’s beginning mileage. If that mileage falls within the range set in System Controls, the
recommended service indicator (Figure 17-4) will be yellow when you open the Invoice Entry screen.

Figure 17-4: AMileage Based Service is Recommended

SET THE MILEAGE THRESHOLD
The mileage threshold is the range in which services are automatically recommended based on a
vehicle’s beginning mileage.
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Example: If you set the threshold to 1000 and state that the ignition system should be checked at
30,000 miles, TireMaster will automatically recommend services for the ignition system when a
vehicle’s beginning mileage falls between 29,000 and 31,000 miles.

To set the mileage threshold
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theOther tab.
3. Select Checklist - Mileage Threshold and press Enter.

4. Type the range in which services will be recommended automatically.

5. Close the System Controls screen.

DEFINE THE RECOMMENDED SERVICE MILEAGE
When you set up inspection areas, you can define whether TireMaster should automatically
recommend services based on a vehicle’s beginning mileage. Whenever a vehicle’s beginning
mileage falls within a user-defined range, TireMaster automatically recommends services for the
inspection area.

Example: If you set the mileage for an inspection area to 30,000 miles and the range for mileage-
based services to 1000, TireMaster automatically recommends services when a vehicle’s begin-
ning mileage falls between 29,000 and 31,000 miles.

Note: The range for mileage-based services is set in System Controls. For more information, see
Set the Mileage Threshold on page 547.

To define the recommended service mileage
1. Select Setup > Vehicle Service Checklist. The Service Checklists screen opens.



Quick Quotes

2. Select the checklist that includes the inspection area for which you'll define the recommended
service mileage, and click Edit. The Service Checklist Maintenance screen opens.

3. Select the inspection area and click Edit. The Add/Edit Inspection Area screen opens.

4. Select theMileage-Based Service check box, and type the mileage.

5. To save your changes, clickOK.
6. Close the open screens.

QUICK QUOTES
You can easily tell customers the price of one, two, or four quantities of an item by giving them a quick
quote. Prices included in a quick quote include add-ons and sales tax, which is calculated based on
your default tax settings.
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Note: If you need to calculate the price of multiple items and services, edit prices, and save and print
a quote, use the Quote and Estimate Writer. For more information, see Good, Better, Best
Quotes on page 506 and Price Comparison Quotes on page 511.

To give a quick quote
1. Search for the item the customer is asking about. For more information, see Inventory Searches on

page 230.

2. On the Inventory List, select the item and clickQuick Quote. The Quick Quote screen opens.

3. To include the item’s shop charge in the one-unit, two-unit, and four-unit totals, select the Shop
Supplies check box. To exclude the shop charge from the totals, clear the check box.

4. Share the quoted prices with the customer.

5. To exit the Quick Quote screen, clickOK.



TIRE FITMENT AND REGISTRATION
Optional tools that can be integrated with TireMaster simplify tire searches and the tire registration
process. This chapter includes the following sections:

Fitment Guide 552
Tire Guide and Vehicle Information Screen 556
DOT Interface 558
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FITMENT GUIDE
With the integrated fitment guide, you can easily identify standard and optional tire sizes for vehicles.
You can also use it to look up various tire and wheel settings including torque, air pressure, and hub
diameter. The fitment guide is available only if you’ve subscribed to and installed Tire Guide Pro Plus.
Data for the fitment guide is provided by Pearl Communications and Tire Guides, Inc.

LOOK UP TIRE AND WHEEL INFORMATION
When you need to see which tires are compatible with a vehicle, you can quickly find the information
with the fitment guide.

Note: You can also access the fitment guide from a quote or work order. For more information, see
Look Up Tire Sizes at Point of Sale on page 553.

To look up tire and wheel information
1. Do one of the following:

Select Fitment Guide from the Inventorymenu.
Press F7.
Note: The advantage of pressing F7 is that you can leave other TireMaster screens open

while looking up tire and wheel information.

The Tire Guide and Vehicle Information screen opens.

2. Select the vehicle year, make, model, and option from the drop-downs toward the top of the
screen. The fitment guide lists the vehicles that match your selections, along with OE and optional
tire sizes.

3. If multiple vehicle options are listed, select the one that matches the customer’s vehicle. The items
on theOE and Plus Sizes list change, based on your selection.

4. If the customer is looking for an optional size tire, select it from theOE and Plus Sizes list. Tires
on theMatching Items list change, based on your selection. If the customer wants standard size
tires, disregard this step.

5. If you need to see tires toward the bottom of theMatching Items list, scroll down.
6. Do the following if needed:

To look up tire and wheel information for another vehicle, click Choose Vehicle. Then select
the year, make, model, and option, and clickOK.
For additional information about the tires on theMatching Items list, click Inventory List.
To view prices for 1, 2, or 4 quantities of a tire displayed on theMatching Items list, select the
tire and clickQuick Quote.
To create a quote for one or more tires, select the item or items on theMatching Items list and
clickQuote. For more information, see Good, Better, Best Quotes on page 506.



Fitment Guide

Tip: For multiple items, select the first tire you want to include. Then press the Ctrl key and
select the other ones you want to add to the quote.

7. To exit the Tire Guide and Vehicle Information screen, click Cancel.

LOOK UP TIRE SIZES AT POINT OF SALE
You can access the fitment guide from a work order or a quote to find tires in your inventory that are
compatible with a customer’s vehicle.

Note: If you're working with a vehicle that has staggered fitments, see Look Up Staggered Fitments
on page 554 for information about adding tires to a quote or work order.

To look up tire sizes at point of sale
1. Start a work order or a quote. For more information, see Create a Regular Work Order on page

442 or Prepare Quotes on page 502.

2. Click Fitment. The Tire Guide and Vehicle Information screen opens.
Note: If a vehicle hasn’t already been added to the quote or work order, TireMaster prompts you

to look up one.

3. To narrow down the vehicle information displayed, make a selection from the option drop-down.
For a different vehicle instead, select another year, make, model, and option from the drop-downs.

4. If multiple vehicle options are shown, select the one that matches the customer’s vehicle. The
items on theOE and Plus Sizes list change, based on your selection. Otherwise, disregard this
step.

5. If both standard and optional tire sizes are listed, select the standard size or one of the optional
sizes from theOE and Plus Sizes list. Tires on theMatching Items list change, based on your
selection.

6. Do the following if needed:

To look up tire and wheel information for another vehicle, click Choose Vehicle. Then select
the year, make, model, and option, and clickOK.
For additional information about the tires on theMatching Items list, click Inventory List.
To view prices for 1, 2, or 4 quantities of a tire displayed on theMatching Items list, select the
tire and clickQuick Quote.

7. To add a tire on theMatching Items list to the quote or work order, select it and click Tire, Torque
& PSI. Depending on your system control settings, the labeling on this button might vary. For more
information, see Work Orders - Fitment Print Air Pressure on page 1218 andWork Orders -
Fitment Print TRQ on page 1218.

Note: Depending on your system control settings, you might be prompted to look up the
matching item with the Custom inventory Lookup screen. For more information, see
Fitment Guide - Skip Inventory Lookup on page 1206.

8. Type the tire’s quantity and press to include the add-on items.
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9. To exit the Invoice Entry screen for a work order, clickQuit. For quotes, click Save and close the
Quote and Estimate Writer screen.

LOOK UP STAGGERED FITMENTS
For vehicles that have staggered fitments, you need to access the fitment guide twice to add tires to a
quote or work order. Select the front tires first and then choose the rear tires.

To work with staggered fitments
1. Start a quote or a work order for the customer and select the vehicle.

2. Click Fitment. The Tire Guide and Vehicle Information Screen on page 556 opens. It displays both
front and rear options for the vehicle.

3. Add the front tires to the work order or quote.

a. On the list of vehicle options, select the front option that matches the customer’s car.

Tip: If you want to limit the options displayed to front fitments, make a selection from the
options drop-down.

b. Select a standard or plus size from theOE and Plus Sizes list. The tires on the Matching
Items list change based on your selection.

c. Select a tire from theMatching Items list, and click Tire Torque & PSI. The tire is added to
the quote or work order. Depending on your system control settings, the labeling on the button
might vary. For more information, see Work Orders - Fitment Print Air Pressure on page 1218
andWork Orders - Fitment Print TRQ on page 1218.

d. Type the tire’s quantity and press to include the add-on items.

4. To add the remaining tires to the work order or quote, repeat steps 2 and 3, but look up and select
rear tires instead.

FITMENT INVENTORY LOOKUP SETTINGS
A pair of system controls affect your work flow for using the fitment guide:

With the control Fitment Guide - Skip Inventory Lookup (Inventory tab), you can define
whether the tire selected on the fitment guide’sMatching Items list should be added directly to
a quote or work order. This control is set to Yes by default. If you set it to No, TireMaster will
always prompt you to look up an item regardless of whether a tire has already been selected in
the fitment guide.

With Fitment Guide - Use Size for Search (Inventory tab), you can define whether the tire
size identified by the fitment guide should be automatically entered in the Size Range field on
the Custom Inventory Lookup Screen on page 239. When the control is set to No, the size is
entered as a quick look code instead. Regardless of how the control is set, the tire size identified
by the fitment guide is displayed near the bottom of the Custom Inventory Lookup screen.

For more information, see Inventory Controls on page 1206.
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TORQUE AND AIR PRESSURE RECOMMENDATIONS
The fitment guide includes air pressure and torque recommendations from vehicle manufacturers.
This information can be printed on work orders and invoices.

SET THE TORQUE AND AIR PRESSURE CONTROLS
You can define whether torque amounts, air pressure amounts, or both print on work order and
invoices by setting the following system controls:

Work Orders - Fitment Print Air Pressure (Other tab)
Work Orders - Fitment Print TRQ (Other tab)

The settings for these controls also affect the labeling for two buttons on the Tire Guide and Vehicle
Information screen.

When both controls are set to Yes, the buttons look like this:

When the torque control is set to Yes and the inflation control is set to No, the buttons look like
this:

When the torque control is set to No and the inflation control is set to Yes, the buttons look like
this:

When both controls are set to No, only one buttons is visible: .

For more information, see Other Controls on page 1209.

ADD TORQUE AND INFLATION VALUES TO QUOTES AND WORK
ORDERS
When technicians need to know a vehicle’s torque amount, air pressure amount, or both, you can
include that information on the quotes and work orders. This information can also be printed on sale
invoices.

To add torque and inflation to quotes and work orders
1. Start a quote or work order. For more information, see Create a Regular Work Order on page 442.

2. Click Fitment. The Tire Guide and Vehicle Information Screen on page 556 opens.
Note: If a vehicle hasn’t already been added to the quote or work order, TireMaster prompts you

to look up one.

Warning: If you selected the wrong vehicle when you started the work order, look up the correct
one on the Invoice Entry or quote screen (by clicking Vehicle) and then in the fitment
guide. Otherwise, the torque or air pressure values printed on a quote, work order, or
invoice could no longer be accurate. Also delete any invalid torque and air pressure
information from the comments.

3. To narrow down the vehicle information displayed, make a selection from the option drop-down.

4. If multiple vehicle options are listed, select the one that matches the customer’s vehicle.
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5. Click Torque & PSI. A confirmation message appears.

Note: Depending on your system control settings, the labeling on this button can vary. For For
more information, see Set the Torque and Air Pressure Controls on page 555.

6. Click Yes. The torque recommendations, inflation values, or both are added to theWO Notes tab
and will print on the work order and final invoice.

TIRE GUIDE AND VEHICLE INFORMATION SCREEN
The Tire Guide and Vehicle Information screen displays tire and wheel information for the selected
vehicle.

Item Description

Year, Make, Model,
Option
(top left)

Lists information about the vehicle that was selected for a quote, work
order, or from the drop-downs.

Offset, Center Hub,
OE Hex, Thread
(top
middle)

Lists the manufacturer’s recommendations for the following for the
selected vehicle:

Offset: Distance from the hub’s mounting surface to the wheel’s
center

Center Hub: Hub diameter
OE Hex: Stud dimension
Thread: Stud thread dimension

Year, Make, Model,
and Option
Drop-Downs

Lets you do the following:

Choose different vehicle information (such as year or model) or
select a different vehicle altogether, when accessed at point of
sale.

Note: Selecting a different vehicle does not update the vehicle
chosen for the work order or quote.

Select the vehicle for which you need fitment information, when
accessed from the Inventorymenu or by pressing F7.

Year, Make
(middle of the
screen)

Lists vehicles matching the year and make selected from the drop-
downs.

Model, Option
(middle of the
screen)

Lists vehicles matching the model and options (in addition to the year
and make) selected from the drop-downs.



Tire Guide and Vehicle Information Screen

Item Description

Size
Inflate

Lists available tire sizes and the manufacturer’s recommended inflation
(psi) for the vehicle selected from the drop-downs. For the inflation, the
letters stand for the following:

F: Front tires
R: Rear tires
B: Both front and rear tires

Load
Speed

Lists the manufacturer’s recommended load-carrying capacity and tire
speed rating for the vehicle selected from the drop-downs.

Torque
WBC

Lists the manufacturer’s recommended wheel torque value and the
wheel bolt center position for the vehicle selected from the drop-downs.

Rim
Prefix

Lists the manufacturer’s recommended rim size and tire prefix, if any
for the vehicle selected from the drop-downs. The letter P stands for
passenger tire and LT stands for light truck tire.

Load
Ply/Weight

Lists the manufacturer’s recommended load range or ply rating and the
lowest gross weight (GVWR) for the vehicle selected from the
drop-downs.

OE and Plus Sizes Lists compatible tire sizes (both original equipment and optional) for the
selected vehicle, along with the following:

OE for standard sizes or the number of inches added to the
original wheel diameter for optional sizes

OE and optional tire sizes

The load index for original equipment and optional tire sizes

The range for the lowest width allowed to the highest rim width
allowed

Matching Items Lists the items in your inventory that match the selected OE or plus tire
sizes.

Choose Vehicle Lets you look up tire and wheel information for another vehicle.

Inventory List Lets you view additional information about the tires displayed on the
Matching Items list.

Quick Quote Lets you view prices for 1, 2, or 4 quantities of the tire selected on the
Matching Items list.

Quote Lets you add the tire or tires selected on theMatching Items list to a
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Item Description

quote, when the fitment guide is accessed from the Inventorymenu or
by pressing the F7 key.

Tire, Torque & PSI Lets you add the selected tire along with the vehicle’s torque and
inflation values to work orders.

Note: Depending on your settings in System Controls, torque, psi, or
both might be excluded from this button. For more information,
see Work Orders - Fitment Print Air Pressure on page 1218
andWork Orders - Fitment Print TRQ on page 1218.

Torque & PSI Lets you print the vehicle’s torque and inflation values on work orders.

Note: Depending on your system control settings, this button might
display only torque or psi or it might be excluded from the
screen. For more information, see Work Orders - Fitment Print
Air Pressure on page 1218 andWork Orders - Fitment Print
TRQ on page 1218.

Cancel Lets you exit the screen. At point of sale, the selected tire, torque, or
inflation information is not added to work orders or quotes.

DOT INTERFACE
With the DOT Interface for TireMaster, you can record tire identification numbers (TINs) when you
complete sale invoices. If you have a subscription to the CIMS Tire Registration Clearing House, you
can also use the interface to submit ID numbers to CIMS electronically. Electronic submission of
identification numbers occurs on the first day of the month. If you offer the Tire Pros Tire Protection
Plan, you can also print registration certificates with the DOT Interface.

Note: If you’ll be signing a contract with the CIMS Tire Registration Clearing House, keep in mind that
CIMS charges one-time registration and setup fees for new users of its automatic registration
service. CIMS also charges dealers a small fee for each tire registered.

PREPARE TO USE THE DOT INTERFACE
Before you can record tire identification numbers with the DOT Interface, you need to define which of
your inventory categories are assigned to tires. If you want to electronically submit tire identification
numbers to CIMS, you also need to enter the credentials issued to you by this tire registration clearing
house.

UPDATE YOUR TIRE INVENTORY CATEGORIES
Updating your inventory categories for tires ensures that TireMaster will prompt you for tire
identification numbers at point of sale.
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To update your tire inventory categories
1. Select Inventory > Categories. The Inventory Category List opens.
2. For each tire category, do the following:

a. Select a category on the list, and click Edit.
b. Select the Tire check box, and clickOK.

3. When you’re done updating all of your tire categories, close the Inventory Category List.

SET THE DOT INTERFACE CONTROLS
To use the DOT Interface you need to set a pair of system controls. One control activates the
interface and the other one defines whether recording tire identification numbers is required.

To set the DOT Interface controls
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theOther tab.
3. Activate the DOT Interface.

a. Select DOT Interface - Enabled, and press Enter.
b. Select Yes to enable the collection of DOT numbers. To disregard gathering DOT numbers,

select No instead.

4. Define whether collecting DOT numbers is required.

a. Select DOT Interface - Entry Bypass, and press Enter.
b. To require the entry of tire identification numbers, select No. To allow users to disregard

entering tire identification numbers, select Yes.
5. ClickOK.
6. Close the System Controls screen.

ENTER YOUR CIMS TIRE REGISTRATION CREDENTIALS
Before you can submit tire identification numbers to CIMS, you need to complete settings that allow
TireMaster to communicate with this tire registration clearing house.

Note: If you recorded tire identification numbers with the DOT Interface before activating electronic
submission, those previously gathered ID numbers will be included in the first batch of data
sent to CIMS.

To enter your CIMS credentials
1. Open an existing work order that includes tires, or start a new work order and add a tire to it.

2. Click Complete. The DOT Information screen opens.
3. Click Setup. The DOT Setup screen opens.
4. Type the dealer ID, user name, password, and FTP location provided to you by CIMS.
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5. Define the types of customers who buy the tires for which you want to collect DOT numbers.

a. Click Customer Types. The Customer/Vendor Type List appears.
b. Do one of the following:

For a single customer type, select it and clickOK.
For multiple customer types, press the Ctrl key, select each type you want to assign, and
clickOK.
For all customer types, leave the field blank.

6. If you want tire identification numbers to be sent to CIMS electronically on the first day of the
month, select the Send DOT Information check box.

7. To save your changes, clickOK.
8. Close the DOT Information screen and the work order.

RECORD TIRE IDENTIFICATION NUMBERS
You can record tire identification numbers when completing sale invoices. Whether you’re required to
enter these numbers depends on your system control settings. For more information, see

To record tire identification numbers
1. On the Invoice Entry screen, click Complete. Then assign the salesperson, mechanic, or both, if

you’re prompted for this information. The DOT Information screen opens. For more information,
see Complete an Invoice on page 456.

2. Type the identification number for the first tire listed.

3. Type the identification numbers for the remaining tires. If the numbers for the remaining tires are
the same or similar to the number for the first tire, click Copy DOT to the next line for each
additional tire and make changes to individual identification numbers as needed.

4. To save your entries, clickOK. Then complete the invoice. The numbers you entered are included
on both the original invoice and duplicate invoices.

In TireMaster Corporate, tire identification numbers are available only when a duplicate
invoice is printed at the store where the original sale occurred.

PRINT PROTECTION PLAN CERTIFICATES
If your store offers the Tire Pros Tire Protection Plan, you can produce warranty registration certificates
when recording tire identification numbers. The Tire Protection Plan Registration Certificate is a
preprinted form that you load in your printer. With the DOT Interface, you can add buyer, seller, tire,
and vehicle information to the certificate, along with serial numbers for each tire sold.
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To print Tire Protection Plan certificates
1. Record the identification number for each tire you’re selling to the customer on the DOT

Information screen. For more information, see Record Tire Identification Numbers on page 560.

2. Load one or more preprinted forms for the Tire Protection Plan Registration Certificate in the
printer.

3. Click Print. The Report Window opens and displays the information that will be added to the
preprinted form.

4. Print one or more copies of the certificate, and close the Report Window. Certificates cannot be
printed after the invoice is completed.
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MANAGE YOUR WORKLOAD
TireMaster helps you manage your daily workload by providing tools for scheduling appointments,
prioritizing jobs, and monitoring the status of vehicle repairs. This chapter includes the following
sections:

Appointment Scheduler 564
Appointment Calendar 583
Work Order Status Indicator 584
Promised Time Indicator 588
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APPOINTMENT SCHEDULER
With TireMaster’s Appointment Scheduler, you can collect information about upcoming jobs and
allocate resources needed to complete the work.

PREPARE TO USE THE SCHEDULER
Before you can use the Scheduler, you need to define which of your employees are mechanics, set up
a list of service bays (or a list of job types), and define how long expired appointments will be displayed
on the calendar.

DEFINE MECHANICS
To ensure that the names of your mechanics are available on the Appointment Calendar, you need to
define which of your employees are service technicians. To do this, make sure theMechanic check
box is selected on the Employee/User List. When the check box is selected for an employee, the
Appointment Calendar will include a column for that individual. FoFor more information, see Add
User Accounts on page 48 .

Figure 19-1: Defining a Mechanic

Note: If you assign an employee who has not been defined as a mechanic to an appointment, that
appointment will be listed in a column labeledOther on the Appointment Calendar.

DESIGNATE APPOINTMENT RESOURCES
You can schedule appointments based on mechanic availability, job type, or workspace availability.
Therefore, you need to create a list of bays or job typess.

Note: Each store needs to set up its own bay or job type list. These settings are not needed at the
corporate site.
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SET UP A BAY OR JOB TYPE LIST
In TireMaster, you can schedule appointments based on the availability of workspace or the kind of
work performed. Before you begin scheduling appointments, create a list of the bays in your shop or
the types of jobs performed.

When you set up your bay or job type list, you can assign a limit which prevents you from scheduling
too many appointments for the same bay or job type on the same date and time. Each store needs to
set up its own bay or job type list.

To set up a bay or job type list
1. Select Setup > Appointment Scheduling. The Bay/Job Type Maintenance screen opens.

2. For each bay or job type you want to set up, do the following:

a. Click Add. The Code and Limit fields appear.

b. Type a name for the bay or job type.

c. Type a code for the bay or job type.

d. In the Limit field, define the maximum number of appointments that can be scheduled for the
bay or job type on the same date and time.

Note: If no limit is defined, 0 appears in the Limit field.

e. Click Save.

3. Close the Bay/Job Type Maintenance screen.
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UPDATE BAY AND JOB TYPE SETTINGS
You can update the settings for a bay or a job type by renaming it or changing the code or the limit.

To modify a bay or job type
1. Select Setup > Customer Scheduling. The Bay/Job Type Maintenance screen opens.

2. Select the bay or job type you want to modify, and click Edit. The settings for the bay or job type
appear near the bottom of the screen.

3. Change the name, code, or limit.

4. Click Save.
5. Close the Bay/Job Type Maintenance screen.

DELETE A BAY OR JOB TYPE
If you add a bay or job type in error, you can remove it.

To delete a bay or job type
1. Select Setup > Customer Scheduling. The Bay/Job Type Maintenance screen opens.
2. Then select the bay or job type you want to remove, and click Delete. A confirmation message

appears.

3. Click Yes. The bay or job type is deleted.

SET THE EXPIRED APPOINTMENT CONTROL
By setting a system control, you can define when expired appointments are deleted from the
Appointment List and the Appointment Calendar.

To set the expired appointment control
1. From the Setupmenu, select System Controls.
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2. Click theOther tab.
3. Define the number of days that expired appointments will remain on the Appointment List and the

Appointment Calendar before they’re automatically deleted.

a. Select Schedule - Automatic Delete Days and press Enter.

b. Type the number of days to display expired appointments, and clickOK.

Example: If you set the number of days to 3, an appointment for August 10 will remain on
the list and calendar until August 13. On August 14, it will be gone.

4. Close the System Controls screen.

SCHEDULE AN APPOINTMENT
Scheduling an appointment in TireMaster includes stating the purpose for the upcoming visit, setting a
date and time, assigning a mechanic, and allocating a bay or defining the job type. You can also define
which items are needed to complete the recommended maintenance or repairs. Appointments can be
scheduled at stores only.

To schedule an appointment
1. If the OpenWork Order List isn’t open, click Invoicing.
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2. Click Schedule. The Appointment List opens.

Note: If you want to hide expired appointments, clear the Show Expired Appts check box. You
can define the number of days that expired appointments will remain on the Appointment
List by setting a system control. For more information, see Schedule - Automatic Delete
Days on page 1215.

3. Click Calendar. The Appointment Calendar opens.

Note: To bypass the appointment calendar, click Add and go to step 7.

Tip: The appointment calendar can be enlarged by resizing or maximizing it.

4. Type the date of the appointment or select it from the pop-up calendar.

5. Change the view if needed.

To see appointments for a particular day, along with mechanic or service bay availability, select
Day. Then select Bay or Technician.
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To see the appointments that have been scheduled during the week of the appointment date,
selectWeek.

To see the appointments that have been scheduled during the month of the appointment date,
selectMonth.

Tip: To see the appointments for the previous day, week, or month, depending on which view is
selected, click . To see appointments for the next day, week, or month instead, click

.

6. Define the time (day and week views only) for the appointment.

In day view, click the starting time in the column for an available bay or technician and drag to
the time you want the appointment to end.

In week view, click the starting time for the appointment and drag to the time when you want the
appointment to end.
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The Appointment Maintenance screen opens.

Note: You can also open the Appointment Maintenance screen by clicking the time you want an
appointment to start in both day and week views.

Tip: If other appointments are scheduled at the time when you want to add a new appointment,
click the gap next to an existing appointment and drag (day and week views only) or double
click (all views).

7. Identify which customer and vehicle the appointment is for.

a. Click Customer, and look up the customer. For more information, see Customer Searches on
page 93.

Note: If the appointment is for a new customer, click Cancel. Then click Add and set up the
new customer. For more information, see Add a Cash Customer on page 66 or Add an
AR Customer on page 68.

b. When prompted, select the customer’s vehicle, and clickOK.
Note: If the appointment is for a new customer, TireMaster prompts you to add the vehicle

once you save the customer. For more information, see Add and Manage Customers
on page 66.

c. ClickOK. The customer’s name and vehicle are added to the Appointment Maintenance
screen.

8. To define whether you want to send the customer a text message with an appointment reminder,
select or clear Do not send Text check box.
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9. If you haven’t already set the appointment’s starting and ending times, select them from the
drop-downs.

Note: The starting and ending times need to be set in month view and when the calendar is
bypassed.

10. To set a promised time for completing the scheduled job, click Promised and select a date and
time from the drop-down calendar and list. Otherwise, leave the promised time alone.

11. Type a reason for the appointment and comments about any vehicle problems reported by the
customer in the Notes field.

12. Assign resources to the appointment.
a. Click Bay/Job, and select a bay or job type. If the bay/job type was already defined for the

appointment, disregard this step.

Note: If a bay or job type is not available, you need to set up the bay/job type list. For more
information, see Set Up a Bay or Job Type List on page 565.
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b. ClickMechanic, and select the name of the technician who will perform the work. If the
technician was already defined, disregard this step.

13. Set aside any items needed for the appointment:
a. Click Add, and look up the items that you want to set aside. For more information, see

Inventory Searches on page 230.

Note: Only parent items are displayed on the Appointment Maintenance screen. When the
appointment is turned into a work order, add-on items will then be included along with
the parent item.

Tip: If you add an item to the appointment in error, select the item and click Delete.

b. Type the quantity for each item.

Note: The numbers entered here are included in the items’ on work order quantities. If the
appointment expires without becoming a completed invoice, the appointment
quantities will continue to affect the on work order quantities until the appointment is
deleted. Appointments can be deleted manually or you can schedule automatic
deletions. For more information, see Schedule - Automatic Delete Days on page 1215.

14. Click Save, and close the Appointment Maintenance screen. The new appointment is added to the
Appointment List.
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RESCHEDULE AN APPOINTMENT
When customers need to reschedule appointments, you can change the dates, times, and resources,
by dragging appointments to different spots on the calendar.

To reschedule an appointment
1. Open the appointment calendar.

a. If the OpenWork Order List isn’t already open, click Invoicing.

b. Click Schedule. The Appointment List opens.

Note: To view the notes for an appointment, select the appointment. Then select the Show
Detail check box.

c. Click Calendar. The Appointment Calendar opens.

2. Type the original date for the appointment in the date field or select the original appointment date
from the pop-up calendar.
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3. To reschedule an appointment on the sameday, do one of the following:

In day view (select Day), and move the pointer to the appointment heading. When
appears, click and drag the appointment to a new time only, a new time and mechanic, or a
new time and bay.

Note: If you want to reschedule the mechanic in addition to the time, make sure Technician
is selected. Similarly, if you want to reschedule the bay along with the time change,
make sure Bay is selected.

In week view (selectWeek), and move the pointer to the appointment heading. When
appears, click and drag the appointment to a new time during the same day.
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4. To reschedule an appointment earlier or later during the same week,make sureWeek is selected.

Then move the pointer to the appointment heading. When appears, click the appointment and
drag it to a different day (and a different time on that day, if needed).

5. To reschedule the appointment earlier or later in the same month, selectMonth. Then click the

appointment heading. When appears, click and drag the appointment to a different day.
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6. Close the Appointment Calendar.

SCHEDULE A DIFFERENT MECHANIC
If a mechanic is no longer available at the time when you’ve scheduled an appointment, you can
assign a different mechanic to the job.

To reschedule a mechanic
1. Open the appointment calendar.

a. If the OpenWork Order List isn’t already open, click Invoicing.

b. Click Schedule. The Appointment List appears.

Note: To view the notes for an appointment, select the appointment. Then select the Show
Detail check box.

c. Click Calendar. The Appointment Calendar opens.
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2. Type the date of the appointment in the date field or select it from the pop-up calendar.

3. Make sure Technician is selected.

4. Move the pointer to the heading of the appointment that needs to be assigned to another

mechanic. When appears, click and drag the appointment to the column for a different
employee.

5. Close the Appointment Calendar.
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SCHEDULE A DIFFERENT BAY
If a service bay is no longer available at the time when you’ve schedule an appointment, you can
assign a different bay to the job.

To schedule a different bay
1. Open the appointment calendar.

a. If the OpenWork Order List isn’t already open, click Invoicing.

b. Click Schedule. The Appointment List appears.

Note: To view the notes for an appointment, select the appointment. Then select the Show
Detail check box.

c. Click Calendar. The Appointment Calendar opens.

2. Type the date of the appointment in the date field or select it from the pop-up calendar.

3. Make sure Bay is selected.
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4. Move the pointer to the heading of the appointment that needs to be assigned to another bay.

When appears, click and drag the appointment to the column for a different bay.

5. Close the Appointment Calendar.

UPDATE AN APPOINTMENT
If you need to make changes to an appointment such as selecting a different vehicle or updating the
notes, you can do so on the Appointment Maintenance screen.

To update an appointment
1. If the OpenWork Order List isn’t open, click Invoicing.

2. Click Schedule. The Appointment List opens.
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Note: To view the notes for an appointment, select the appointment. Then select the Show
Detail check box.

3. Select the appointment you want to update, and click Edit. The Appointment Maintenance screen
opens.

4. Change the following as needed:

To change the customer, click Customer. Then look up a different customer.
Note: If you change the customer, you’ll be prompted to update the vehicle.

To change the vehicle, click Vehicle. Then select a different vehicle or click Add and look up a
new vehicle. For more information, see .

To reschedule the appointment, select a new date, time, or both.

To update the promised time, click Promised. Then select a different date, time, or both.
To update the notes, type additional information or delete unnecessary information.

To change the bay or job type, click Bay/Job and select a different bay or job type.
To assign the job to a different technician, clickMechanic and select an employee name.

5. To change which items are needed for the appointment, do the following as needed.

a. For additional items, click Add and look up the items you want to set aside. Then enter the
quantities For more information, see Inventory Searches on page 230.

Note: Only parent items are displayed on the Appointment Maintenance screen. If the
appointment expires (instead of becoming a completed invoice), the items will be
included in the quantities on work order until the appointment is deleted from the
calendar. For more information, see Schedule - Automatic Delete Days on page 1215.
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b. To remove an item, select the item you no longer need and click Delete.
6. Save your changes.

Note: At this point, the appointment is displayed in gray on the Appointment List to indicate that it
can no longer be edited.

DELETE AN APPOINTMENT
If a customer cancels an appointment, you can delete it from the Appointment List.

Note: If an appointment has already been turned into a work order, the work order is not deleted. You
will need to delete the work order manually.

To delete an appointment
1. If the OpenWork Order List isn’t open, click Invoicing.
2. Click Schedule. The Appointment List appears.
3. Select the appointment that has been canceled and click Delete. A confirmation message

appears.

4. Click Yes.
5. Close the Appointment List.

PRINT A LIST OF APPOINTMENTS
You can print a list of appointments to post around the shop. The Appointment Report can include all
appointments or you can limit it to only those for a particular mechanic or bay (or job type).

To print an Appointment Report
1. If the Appointment List isn’t already open, click Schedule on the OpenWork Order List.

2. Click Report. The Appointment Report screen opens.
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3. Select the beginning and ending dates for the appointments from the drop-downs.

4. To limit the report to a single bay or job type, select a bay or job type from the BayJob drop-downs.
By default, all bays or job types are included on the report.

5. To limit the report to a single technician, select a name from theMechanic drop-down. By default,
all technicians are included on the report.

6. Click Print. The Report Window opens and displays the Appointment Report.

7. Print the report and close the Report Window.

TURN AN APPOINTMENT INTO A WORK ORDER
You can use appointment information to automatically create a work order before a customer’s
scheduled visit or when the customer arrives.

To turn an appointment into a work order
1. If the OpenWork Order List isn’t open, click Invoicing.

2. Click Schedule. The Appointment List appears.
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3. Select the customer’s appointment, and clickWork Order. The new work order is added to the
OpenWork Order List.

Note: Once the work order is created, the appointment is displayed in gray on the Appointment
List to indicate it can no longer be edited.

APPOINTMENT CALENDAR
The appointment calendar (Figure 19-2) shows the dates and times of scheduled appointments, along
with the resources (bays, technicians, or both) allocated to those appointments.

Figure 19-2: Appointment Calendar
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Item Description

Today Lets you see appointments scheduled for the current day in all views.

Lets you see appointments scheduled for the previous day, week, or
month, depending on which view is selected.

Lets you see the appointments scheduled for the next day, week, or
month, depending on which view is selected.

Date Lets you see the appointments for a specific date in all views.

Day Lets you see the appointments scheduled for a specific date. In day
view, appointments can be organized by mechanic or bay assignment.

Week Lets you see the appointments scheduled for the week in which a
specific date (defined in the date field) falls.

Month Lets you view the appointments scheduled for the month in which a
specific date (defined in the date field) falls.

Bay Lets you view the appointments scheduled for each of your service
bays, when day or week view is selected.

Technician Lets you see the appointments scheduled for each of your mechanics,
when day or week view is selected.

Close Exits the screen.

WORK ORDER STATUS INDICATOR
With the Work Order Status Indicator, you can track the progress of each job in your shop. Once you
define the statuses you want to use, you can begin assigning them to work orders.

ADD A WORK ORDER STATUS
You can set up your own work order status options for point of sale. For each status, define the name,
along with a color and a letter, number, or symbol for identifying the status. You can also define
whether text messaging or email should be launched when a status is selected. You can set up a total
of eight statuses.

Note: Four statuses are available by default. They are No Status, On Site, In Progress, and Done.

To add a work order status
1. Select Setup > WO Status. The Work Order Status Options screen opens.
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2. Click Add. The WO Status screen opens.

3. Type the name of the status in theOption Name field.
Tip: For best results, limit the number of characters in the status name to ten or fewer.

4. Type the letter, number, or symbol that you want to use to identify the status in theOption Symbol
field. This character is used on the OpenWork Order List.

5. To assign a color to the status, clickOption Color. Then select a swatch from the Color screen
and clickOK. The selected color is also used on the OpenWork Order List.

6. If you want a text reminder to appear when the status is selected at point of sale, select the Send
Text check box.

7. If you want to the status to be assigned to new work orders by default, select the Default Status
check box. Otherwise, leave it alone.

Note: Only one status can be designated as the default status.

8. To save the new status, clickOK.

9. To set up additional work order statuses, repeat steps 2 through 8.

10. Define how the statuses should be arranged.

To move a status toward the top of the list, select the status and clickMove Up repeatedly until
it is in the position where you want it to be.

To move a status toward the bottom of the list, select the status and clickMove Down
repeatedly until it is in the position where you want it to be.
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11. When you’re finished setting up work order statuses, close the Work Order Status Options screen.

UPDATE A WORK ORDER STATUS
If you need to change the settings or position for a work order status, you can update it.

To update a work order status
1. Select Setup > WO Status. The Work Order Status Options screen opens.

2. To update the settings for a work order status, select it and click Edit.

3. Do the following as needed, and clickOK to save your changes.

Type a different name for the status in theOption Name field.
Tip: For best results, limit the number of characters in the status name to ten.

Type a different letter, number, or symbol in theOption Symbol field. This character is used
on the OpenWork Order List.

ClickOption Color, select a different swatch from the Color screen, and clickOK. The
selected color is also used on the OpenWork Order List.

Select or clear the Send Text check box, depending on whether you want a reminder for
texting or emailing the customer to appear when the status is selected at point of sale.
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Select or clear the Default Status check box, depending on whether you want the status to be
assigned to new work orders by default.

4. To change the position of the status on the list of work order statuses, select the status and click
Move Up orMove Down.

5. Close the Work Order Status Options screen.

DELETE A WORK ORDER STATUS
If you no longer use a work order status, you can delete it.

To delete a work order status
1. Select Setup > WO Status. The Work Order Status Options screen opens.

2. Select the status you want to delete, and click Delete. A confirmation message appears.

3. Click Yes. The status is deleted.
4. Close the Work Order Status Options screen.

CHANGE A VEHICLE’S JOB STATUS
With the Work Order Status Indicator, you can easily track the progress of each job in your shop. Once
you set the status, a color code and a letter, number, or symbol appears on the OpenWork Order List,
so you can see the status of all jobs at a glance.

To change a vehicle’s job status
1. Click Invoicing. The OpenWork Order List opens.

2. Select the work order whose job status you need to change, and click Select.

3. Select one of the status options.
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4. To exit the work order, clickQuit. One of the following happens on the OpenWork Order List:

If you set the status, the color and the letter, number, or symbol in the S column changes.

If you cleared the status, nothing is displayed in the S column.

PROMISED TIME INDICATOR
The Promised Time Indicator provides a visual means for prioritizing jobs. By setting promised times
for jobs, you can decide which ones need to be completed first and which ones can wait until later. The
Promised Time Indicator also helps you identify jobs that are taking longer than expected, so you can
notify customers of delays.

SET THE PROMISED TIME
The promised time for jobs is set at point of sale. Setting the promised time includes defining both the
date and time when you’ve pledged to complete a job.

To set the promised time
1. Click Invoicing. The OpenWork Order List opens.

2. Select the work order for which you need to set the promised time, and click Select. The Invoice
Entry screen opens.

3. Click Promised. The Promised Date & Time screen opens.
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4. If the promised time needs to be set for a different day, select a date from the pop-up calendar.

5. Select a time from the drop-down.

6. ClickOK. The promised time is displayed on the Invoice Entry screen.

7. To exit the work order, clickQuit. The promised date and time are displayed on the OpenWork
Order List.

PROMISED TIME COLOR CODING
On the OpenWork Order List, color coding identifies jobs for which the promised time is approaching
and those for which the promised time has passed. When the promised time is within a specific
amount of time (such as 15 minutes or an hour), the entry in the Promised column is yellow. For jobs
whose promised time has passed, the entry is red.

By setting a system control, you can define the time (in minutes) when the yellow color code for
approaching promised times appears.

To set the promised time threshold
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theOther tab.
3. SelectWork Orders - Threshold Promised Time Minutes and press Enter.
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4. Select the number of minutes when you want the promised time to turn yellow. For example, if the
promised time should turn yellow an hour before the job is slated to be done, you’d select 60
minutes.

5. ClickOK.

6. Close the System Controls screen.



MARKETING
TireMaster's Marketing Module helps you promote your business by providing tools for creating
postcards, mailing labels, and coupons. This chapter includes the following sections:

Design and Manage Postcards 592
Point of Sale Mailings 605
Mass Mailings 608
Generic Postcards 611
Labels 612
Name and Address Text Files 614
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DESIGN AND MANAGE POSTCARDS
With TireMaster, you can create a variety of postcards that you can use for promoting products,
services, and events to your customers. Each site has its own postcards. Postcards are saved on the
network, and can be accessed from any TireMaster workstation.

Note: For TireMaster Point of Sale, the Marketing Module is an optional application. If you’re
interested in adding the Marketing Module to your TireMaster Point of Sale system, contact
your ASA account manager.

POSTCARD DIMENSIONS
The Marketing Module is compatible with postcards that meet the following criteria:

Size: 5.5 x 4.25 inches
Number per sheet: 4 (on a sheet measuring 8.5 x 11 inches)

For information about postcards that are compatible with the Marketing Module, contact your account
manager.

LAY OUT A POSTCARD
Laying out a postcard includes designating a code for the card and positioning elements such as
customer address and vehicle information. You might also want to assign a filter to some postcards.
Assigning a filter helps you work more quickly when it’s time to print postcards, because you’ve already
established criteria for who will receive a mailing.

Tip: When you’ve finished the layout for a postcard, verify that it meets postal regulations. Take a
sample of the card to the post office where you will mail it and get a signature from the post
office clerk before you print the final copies.

To lay out a postcard
1. ClickMarketing. The Marketing screen opens.

2. Click Design Postcards. The Postcard List opens.

3. Define basic information for the postcard.

a. Click Add. The Postcard Design screen opens.
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Note: If you just printed a postcard with text or created the text message for a postcard, the
following message appears: “Use previously loaded/printed design as a starting point
for this new card?” Click Yes or No to continue.

b. Make sure the Setup tab is selected, and type a code (up to four characters long) and a
description for the postcard.

c. Select the Correct for Gutter check box, and type the correction amount in the in (inches)
field.

Note: Because most desktop printers cannot print ink on the edge of a page, completing the
gutter settings helps to ensure that the postcard text doesn’t get cut off. You can adjust
this setting later if needed.

d. To assign a filter to the postcard, click Select Filter. Then choose a filter from the list and click
OK.

e. Click Save.
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4. Click the Design tab to display the layout area.

5. Move the address, vehicle information, and message boxes if needed.

a. Select theMove check box.

b. Click the box you want to move, and drag it to a different location.

Note: Leave at least 5/8 inch of space at the bottom of the postcard for the postal service bar
code.

6. Resize the message box if needed.

a. Make sure theMove check box is selected (if it isn’t already).
b. Move the pointer to the lower-right corner of the message box. A double-ended arrow appears.
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c. Drag the box until it reaches the size you want.

7. Add content to the message box.

a. If theMove check box is selected, clear the check mark.

b. Type your message.

8. Generate a test page.

a. Click Print Test Page. TireMaster prompts you to save the postcard before printing the test
page.

b. Click Yes. The Print screen opens.
c. Print the test page.

d. Review the test page. Then make any needed changes to the layout.

Note: To ensure proper positioning of everything on the postcard, you might need to make
additional adjustments to the print gutter settings on the Setup tab.

9. Save the postcard.
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a. Click the Setup tab.

b. Click Save.

10. Close the open screens.

MANAGE EXISTING POSTCARDS
You can make changes to existing postcards and include or exclude them from the postcard list.

UPDATE A POSTCARD
Occasionally, you might want to change the code, filter, description, or message for a postcard. If so,
you can edit one or more of the card’s settings.

To update a postcard
1. ClickMarketing. The Marketing screen opens.

2. Click Design Postcards. The Postcard List opens.

3. Select the card whose settings you want to change, and click Edit.
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4. Do the following as needed:

To change the postcard code, type a new code.

To change the description, type a new description.

To assign a different filter, click Select Filter. Then select a new filter from the list, and click
OK.
To remove the filter, click Select Filter. Then click Cancel.
To change the postcard text, see Lay Out a Postcard on page 592.

5. To review your changes, click Print Test Page.

6. Save your changes.

a. Make sure the Setup tab is selected.

b. Click Save.

7. Close the opens screens.
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MAKE A POSTCARD INACTIVE
If you no longer use a postcard, you can make it inactive.

To make a postcard inactive
1. ClickMarketing. The Marketing screen opens.

2. Click Design Postcards. The Postcard List opens.

3. Select the card that you want to make inactive, and click Inactivate. A confirmation message
appears.

4. Click Yes. The postcard is removed from the list.

Note: To display inactive postcards on the list, clear the Active Only check box.

5. Close the open screens.

MAKE A POSTCARD ACTIVE
If you want to start using an inactive postcard again, you can make it active.

To make a postcard active
1. ClickMarketing. The Marketing screen opens.
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2. Click Design Postcards. The Postcard List opens.

3. To display both active and inactive postcards, clear the Active Only check box.

4. Select the card you want to make active, and click Reactivate. A confirmation message appears.

5. Click Yes.
6. Close the open screens.

POSTCARD FILTERS
With filters, you can select which customers will receive postcards in a mass mailing based on
parameters such as products purchased, purchase date, mileage intervals, and the amount of money
spent.

CREATE A POSTCARD FILTER
You can filter customer and purchase data on-the-fly when printing postcards. However, setting up
reusable filters can help you save time. Filters can be retrieved when you print postcards, or you can
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assign a filter to a postcard.

To create a postcard filter
1. ClickMarketing. The Marketing screen opens.

2. Click Filters. The Filter Selection screen opens.

Note: To remove settings for previously created filters from each of the tabs, click Reset
Filters.

3. To limit the mailing to specific customers, make sure the Customer Filter tab is selected. Then
do one or more of the following:

For a range of customers, click Beginning Customer and look up the name of the first
customer in the range. Then click Ending Customer and look up the name of the last
customer in the range. For more information, see Customer Searches on page 93.

For one customer, click Beginning Customer and look up the customer’s name. Then click
Ending Customer and look up the same name again. For more information, see Customer
Searches on page 93.

For specific customer types, click Customer Types. Then select one or more types from the
list.
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Note: For multiple types, press Ctrl while you select each type.

For customers who live in a particular city, type the city’s name.

For customers who live in a particular zip code, type the zip code.

4. To limit the mailing by the amount of money spent, purchase date, or both, click the Sales Filter
tab. Then do one or more of the following:

For customers who’ve spent a minimum amount of money, type the amount in theMin Sale
Amount field.

For customers who bought items or services during a particular date range, select the
Purchased check box. Then select the beginning and ending dates from the drop-down
calendars.
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For customers who haven’t bought anything since a particular date, select the Has Not
Purchased Since check box. Then select the last date of purchase from the drop-down
calendar.

5. To limit the mailing to customers who’ve bought specific items, select the Product Filter tab.
Then click Lookup Products, and look up the item or items sold. For more information, see
Inventory Searches on page 230.

6. To limit the mailing by vehicle mileage, clickMileage Filter. Then do one of the following:
For vehicle mileage that falls within a particular range, type the range in the fields for
Beginning Miles and Ending Miles.

For elapsed vehicle mileage and elapsed days since the last purchase, type the mileage and
number of days.
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7. Save the filter for reuse:

a. Click Save Filters. The Save Setting screen opens.

b. Type a name for the filter.

c. ClickOK.
8. Close the Filter Selection screen.

UPDATE A POSTCARD FILTER
When you want to change the settings for a filter, you can update it.

To update a postcard filter
1. ClickMarketing. The Marketing screen opens.

2. Click Filters. The Filter Selection screen opens.

3. Click Load Filters. The Filter List appears.

603



604

User Guide

4. Select the name of the filter you want to update, and clickOK. The settings for the filter are
displayed on the applicable filter tabs.

Tip: Write down the name of the filter to ensure that you’ll use the same spelling when you’re
prompted to save your changes.

5. Select each tab whose settings you want to update. Then make the needed changes. For more
information about the settings for each tab, see Create a Postcard Filter on page 599.

Note: To start over from scratch, click Reset Filters to remove the settings from all of the filter
tabs.

6. Click Save Filters. The Save Setting screen opens.

7. If a filter name is listed, make sure it is correct. Otherwise, type the correct filter name. Then click
OK. A confirmation message appears.

8. Click Yes.
9. Close the open screens.

DELETE A POSTCARD FILTER
If you no longer use a filter, you can delete it from the Marketing Module.

To delete a filter
1. ClickMarketing. The Marketing screen opens.
2. Click Filters. The Filter Selection screen opens.
3. Click Load Filters.
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4. When the Filter List appears, select the name of the filter you want to remove and click Delete.
The filter name is removed from the list.

5. Close the open screens.

POINT OF SALE MAILINGS
Point of sale mailings are typically used to target customers who’ve declined services and those
whose vehicles need recommended repairs. You can identify recipients for point of sale mailings using
the following methods:

Associate invoices with postcards.

Associate postcards with inspection areas on your service checklists.

Note: For TireMaster Point of Sale, the Marketing Module is an optional application. If you’re
interested in adding the Marketing Module to your TireMaster Point of Sale system, contact
your ASA account manager.

ASSOCIATE AN INVOICE WITH A POSTCARD
You can associate an invoice with up to three postcards when you complete an invoice. Once a
customer’s invoice has been associated with at least one postcard, that customer will be included in
the next point of sale mailing.

To associate an invoice with postcards
1. Begin the process of completing an invoice. For more information, see Complete an Invoice on

page 456.

2. On the Invoice Completion screen, clickMarketing. The Declined Services screen opens.

3. Assign up to three postcards to the invoice. To assign a postcard, click the Postcard #1, Postcard
#2, or Postcard #3 button. Then select a postcard from the list that appears.

Note: Invoices can be associated with active postcard codes only.
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4. To save your changes and exit the Declined Services screen, clickOK.

Note: Once you complete the invoice, the postcard codes assigned to it can no longer be
changed.

5. Finish completing the invoice.

ASSOCIATE AN INSPECTION AREA WITH A POSTCARD
You can associate each inspection area on a service checklist with a postcard. If a customer’s vehicle
needs services recommended for an inspection area, that customer will be included in the next point of
sale mailing. The customer will continue to be included in point of sale mailings as long as the status
for an inspection area is set to either suggested (yellow) or recommended (red).

To associate an inspection area with a postcard
1. Open the service checklist Add/Edit Inspection Area screen.

a. Select Setup > Vehicle Service Checklist. The Service Checklists screen opens.

b. Select the checklist that includes the inspection area you want to associate with a postcard,
and click Edit. The Service Checklist Maintenance screen opens.

c. Select the inspection area you want to associate with a checklist, and click Edit.
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2. Click . A list of postcards opens.

3. Select a postcard and clickOK.

4. Close the open screens.

PRINT POINT OF SALE POSTCARDS
When you’re ready to generate a mailing for customers who’ve declined repairs and recommended
services, you can print a batch of point of sale postcards.

Note: Verify that the postcards have printed successfully before completing the process described
below. Once point of sale postcards are printed, they are removed from TireMaster.

To print point of sale postcards
1. ClickMarketing. The Marketing screen opens.

2. In the Print Options area, select POS Postcards.
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3. Click Print. The Cards to Print screen opens.

4. Click Print These Postcards. The Print screen opens.

5. Select a printer, and clickOK. A confirmation message appears.

6. Do one of the following:

If the postcards printed okay, click Yes. The following message appears: “Verify that the
postcards have successfully printed. Once you click OK, they will be removed from
TireMaster.”

If you need to reprint the cards, click No to return to the Cards to Print screen.
7. When you’re finished printing postcards, Close the Marketing screen.

MASS MAILINGS
Mass mailing postcards are typically used for promoting sales or special events, sending thank you
notes, and reminding customers of services due. To generate postcards for a mass mailing, you need
to do the following:

Select a postcard for the mailing.

Identify the recipients by using a filter that’s been saved for reuse or by creating a filter on the fly.

Define whether the mailing should be based on customer names or vehicles.

Note: For TireMaster Point of Sale, the Marketing Module is an optional application. If you’re
interested in adding the Marketing Module to your TireMaster Point of Sale system, contact
your ASA account manager.

To generate mass mailing postcards
1. ClickMarketing. The Marketing screen opens.
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2. Make sure the print optionMass Mailing Postcards is selected.

3. Select a postcard:

a. Click Postcard.

b. Select a postcard from the list, and clickOK.

Note: If a filter has been assigned to the postcard, the following message appears: “There is
a filter assigned to this postcard. Do you want to load it?” If you click Yes, disregard
steps 4 and 5.

4. Select a reusable filter if needed. Otherwise, disregard this step.

a. Click Filters. The Filter Selection screen opens.

b. Click Load Filters. The Filter List appears.
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c. Select the filter you want to use, and clickOK.

d. Close the Filter Selection screen. A brief description of the filter selection criteria is displayed
on the Marketing screen for your reference.

5. If you need to create a filter on the fly, click Filters. Then fill in the filter selection criteria on the
applicable filter tabs. For more information, see Create a Postcard Filter on page 599.

6. Select one of the following in the Target Mailing area:
To send a postcard for each vehicle that meets the filter criteria, select Vehicles.
Note: When the Vehicles option is selected, some customers might receive multiple

postcards.

To send only one postcard to each customer who meets the filter criteria, select Customers.

7. Click Print. The Cards to Print screen opens.
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8. Click Print These Cards. The Print screen opens.

9. Select a printer, and clickOK and take note of the following:

If you’re using the Mileage filter, the following message appears: “Did all of the postcards print
OK?”

If you’re not using the mileage filter, skip step 10.

10. Do one of the following:
If the postcards printed okay, click Yes. The following message appears: “Verify that the
postcards have successfully printed. Once you click OK, they will be removed from TireMaster
for this interval.”

If you need to reprint the cards, click No to return to the Cards to Print screen.
11. When you’re finished printing postcards, close the Marketing screen.

GENERIC POSTCARDS
The Marketing Module includes a means of generating generic postcards that you can hand out to
customers at random. These postcards are referred to as blank postcards, because you don’t use a
filter to select the recipients.

Note: For TireMaster Point of Sale, the Marketing Module is an optional application. If you’re
interested in adding the Marketing Module to your TireMaster Point of Sale system, contact
your ASA account manager.

To generate generic postcards
1. ClickMarketing. The Marketing screen opens.

2. Select the print option Blank Postcards.
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3. Select a postcard:

a. Click Postcard. The Postcard List opens.

b. Select a postcard from the list, and clickOK.

c. Click Print. The Cards to Print screen opens.

d. Click Print These Postcards. The Print screen opens.

e. Select a printer from the drop-down, and type the number of copies you want to print. Then
clickOK.

4. Close the Marketing screen.

LABELS
You can use the Marketing Module to generate labels with customer names and addresses. The labels
can be printed from TireMaster, or you can save the information as a text file that can be used to create
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labels in another application.

Note: For TireMaster Point of Sale, the Marketing Module is an optional application. If you’re
interested in adding the Marketing Module to your TireMaster Point of Sale system, contact
your ASA account manager.

LABEL DIMENSIONS
The Marketing Module is compatible with Avery® 5160 labels or another brand that meets the following
criteria:

Size: 1 x 2.63 inches
Number per sheet: 30 (3 across, 10 down)

PRINT LABELS
To select the customer names and addresses for a batch of labels, use a reusable filter or create a
filter on the fly.

To print labels
1. ClickMarketing. The Marketing screen opens.

2. Select the Labels print option.

3. If you want to select a reusable filter, do the following. Otherwise, disregard this step.

a. Click Filters. The Filter Selection screen opens.

b. Click Load Filters. The Filter List appears.
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c. Select the filter you want to use, and clickOK.

d. Close the Filter Selection screen. A brief description of the filter selection criteria is displayed
on the Marketing screen for your reference.

4. If you want to create a filter on the fly, click Filters. Then fill in the filter selection criteria on the
applicable filter tabs. Otherwise, disregard this step. For more information, see Create a Postcard
Filter on page 599.

5. Click Print. The Report Window opens and displays the labels.

6. Print the labels and close the Report Window.

7. Close the Marketing screen.

NAME AND ADDRESS TEXT FILES
You can use the Marketing Module to look up customer names and addresses and save the results of
your search as a .txt (text) file. Then you can use the information in other applications.



Name and Address Text Files

Note: For TireMaster Point of Sale, the Marketing Module is an optional application. If you’re
interested in adding the Marketing Module to your TireMaster Point of Sale system, contact
your ASA account manager.

To save names and addresses in a text file
1. ClickMarketing. The Marketing screen opens.

2. Select the Labels print option.

3. If you want to select a reusable filter, do the following. Otherwise, disregard this step.

a. Click Filters. The Filter Selection screen opens.

b. Click Load Filters. The Filter List appears.

c. Select the filter you want to use, and clickOK.
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d. Close the Filter Selection screen. A brief description of the filter selection criteria is displayed
on the Marketing screen for your reference.

4. If you want to create a filter on the fly, click Filters. Then fill in the filter selection criteria on the
applicable filter tabs. If you selected a reusable filter instead (step 3), disregard this step. For more
information, see Create a Postcard Filter on page 599.

5. Click Save to File. The Save Customer Label File screen opens.

6. Select the computer drive or network location where you want to save the file from the Save in
drop-down.

7. Type a name for the file and the extension .txt in the File Name field. For example,
MyFileName.txt.

8. Click Save.
9. Close the Marketing screen.



SALES TAX
TireMaster‘s sales tax module helps you comply with state sales tax laws, and it's designed so you can
prepare for upcoming tax changes ahead of time. This chapter includes the following sections:

Sales Tax Rates and Levels 618
Tax Exemption Certificates 633
Sales Tax Adjustments 635
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Special Tax Requirements 643
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SALES TAX RATES AND LEVELS
To calculate sales tax in TireMaster, you need to set up tax rates and tax levels.

Tax rate: The percentage of the sale total collected by a tax authority.
Tax level: A combination of sales tax rates. Tax levels are assigned to customers, so
TireMaster can compute the amount of sales tax they owe.

The number of tax rates and levels that you need depends on the complexity of your state’s tax laws
and how many sales tax totals you need on your reports. If your state requires information for
nontaxable sales, create exempt tax rates and levels.

TAX RATE AND LEVEL EXAMPLES
If your state requires one sales tax total, you need only one or two rates and levels (Table 21-1).

Rates Levels

Rate 1: Idaho Rate Level 1: Idaho Level

Rate 2: Exempt Rate Level 2: Exempt Level

Table 21-1: Simple Sales Tax Settings

If your state requires a variety of sales tax totals, you need one level for each total (Table 21-2). You
can assign one or more rates to a level.

Rates Levels

Rate 1: Idaho Rate
Rate 2: Ada County Rate
Rate 3: Boise City Rate

Level 1: Idaho, Ada County, Boise Level
(includes Rates 1–3)

Rate 4:Oregon Rate
Rate 5: Farm Rate

Level 2:Oregon Farm Level

(includes Rates 4 and 5)

Rate 6:Government Rate Level 5:Government Level (includes Rate 6)

Rate 7: Exempt Rate Level 6: Exempt Level (includes Rate 7)

Table 21-2: Complex Sales Tax Settings

Because tax levels are created by combining various tax rates, you can customize tax collections
based on the requirements of different customers.

Example: A resident of Boise, Idaho would pay city, county, and state sales tax. However, an Ada
county resident who lives outside of the city limits would pay only county and state taxes.
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Note: By default, sales tax calculations are based on the parts price, labor price, and federal excise
tax for items. However, if you do business in a state where charging sales tax on FET is
optional or prohibited, you can exclude it from sales tax calculations. For more information, see
Exclude FET from Sales Tax on page 639.

TAX RATES
A tax rate is the rate of tax assessed by a tax jurisdiction such as a city, county, or state. Having
separate tax rates let you group different types of tax totals on the tax reports.

CREATE TAX RATES
The first component needed to calculate sales tax in TireMaster is the tax rate. The number and kind
of rates that you need depend on the following:

Whether the city, county, or state where your store is located collects sales tax

Whether you perform service calls in cities, counties, or states other than those where your
store is located

Whether some customers are exempt from paying taxes

To create a tax rate
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Make sure the Rates tab is selected.

3. To display both current and future tax rates, select All under Rates to display.
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4. Click Add. The Tax Rate Add screen opens.

5. Enter the following information for the new rate:

a. Type a description.

Note: For additional information about creating the descriptions for tax rates, see Tax Rate
Names on page 621.

b. Type the tax rate amount as a decimal. For example, if the tax rate is 5%, type .05.

c. If required by your state, enter the maximum taxable amount. Otherwise, leave the amount
as 0.00.

Note: The maximum taxable amount lets you limit how much sales tax is charged for
taxable items on an invoice. Therefore, if the total of the taxable items exceeds the
number entered in theMax Taxable Amount field, TireMaster calculates the sales
tax for the taxable items by multiplying the rate by the maximum taxable amount. For
example, the Idaho rate is 5% with a maximum taxable amount of $500. If the total of
taxable items on an invoice using the Idaho rate is $500 or higher, the amount of
sales tax calculated for those taxable items is limited to $25.

d. Assign a GL account to the rate. Click the Tax GL Account field, press and select an
account from the list.

e. To define when the rate goes into effect and ends, select dates from the Effective From and
to pop-up calendars.
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Note: Tax rates take effect at 12:00:00 a.m. (midnight) on the effective date and expire at
11:59:59 p.m. on the ending date.

Tip: To prevent rates from expiring, set the ending date far into the future (for example, 1-
1-2111). You can use the same ending date for all tax levels that are currently in
effect.

6. To save the new rate, clickOK.

Note: Once you assign a tax rate to a tax level, you can only edit its ending date. To change all
settings for a tax rate, update the rate. For more information, see Prepare for Tax Rate
Changes on page 623.

TAX RATE NAMES
When you set up your tax rates, name them in a consistent manner. Using a consistent naming
pattern helps to ensure that you will assign the proper rates to tax levels, and it helps you identify the
tax rates on the sales tax reports. Tax rates are organized alphabetically on the Sales Tax Setup
screen.

Figure 21-1: Tax Rates Displayed Alphabetically
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EDIT TAX RATES
The extent to which you can change the settings for a tax rate depends on whether the rate has been
assigned to a tax level.

If the rate has never been assigned to a tax level, all of its settings can be edited.

If the rate has been assigned to a tax level, only the description and its ending date can be
edited.

To edit a tax rate
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Make sure the Rates tab is selected.

3. To display both current and future rates, select All in under Rates to display.
4. Select the rate that needs to be changed, and click Edit.
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5. Change the description, rate, maximum taxable amount, GL account, or effective dates as
needed.

Note: The maximum taxable amount lets you limit how much sales tax is charged for taxable
items on an invoice. Therefore, if the total of the taxable items exceeds the number
entered in theMax Taxable Amount field, TireMaster calculates the sales tax for the
taxable items by multiplying the rate by the maximum taxable amount. For example, the
Idaho rate is 5% with a maximum taxable amount of $500. If the total of taxable items on
an invoice using the Idaho rate is $500 or higher, the amount of sales tax calculated for
those taxable items is limited to $25.

6. To save the changes, clickOK.
7. Close the Sales Tax Setup screen.

PREPARE FOR TAX RATE CHANGES
If your city, county, or state announces an increase or decrease for its sales tax rate, you can prepare
for the change in advance by updating the tax rate. To update a tax rate, edit the ending date of the
original rate. Then create a replacement rate.

Note: Once a tax rate has been assigned to a tax level, you can only edit its ending date. To
change other settings for the rate, you need to update the rate.

To prepare for tax rate changes
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.
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2. Make sure the Rates tab is selected.

3. To display both current and future rates, select All in the Rates to display area.

4. Edit the ending date of the original rate.

a. Select the rate that needs to be changed, and click Edit. The Tax Rate Edit screen appears.
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b. In the to field, change the ending date of the original tax rate to the day before the
replacement rate takes effect. You can select the date from the pop-up calendar.

Note: The original tax rate remains in effect until 11:59:59 p.m. on the ending date.
Therefore, if the new rate takes effect October 6 of the current year, change the
ending date of the original rate to October 5 of the current year.

c. ClickOK.

5. To create the replacement rate, do the following:

a. Reselect the rate that needs to be changed, and click Update.

625



626

User Guide

b. Change the description and the rate.

c. Change the maximum taxable amount if needed.

Note: The maximum taxable amount lets you limit how much sales tax is charged for
taxable items on an invoice. Therefore, if the total of the taxable items exceeds the
number entered in theMax Taxable Amount field, TireMaster calculates the sales
tax for the taxable items by multiplying the rate by the maximum taxable amount. For
example, the Idaho rate is 5% with a maximum taxable amount of $500. If the total of
taxable items on an invoice using the Idaho rate is $500 or higher, the amount of
sales tax calculated for those taxable items is limited to $25.

d. Change the GL account if needed.

e. Enter the date when the replacement rate goes into effect and the date when the
replacement date ends. You can select these dates from the Effective From pop-up
calendar.

Note: If the following message appears, you need to edit the ending date of the original
rate: “The dates overlap with the date range for another rate in the same group.
Please change the dates.” For more information, see step 4.

Tip: To prevent the rate from expiring, set the ending date far into the future (for example,
1-1-2111). You can use the same ending date for all tax levels that are currently in
effect.
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6. To save the replacement rate, clickOK.

Note: Once the replacement rate is assigned to a tax level, only its ending date can be
changed. To make other changes, you will need to update the rate again.

DELETE A TAX RATE
Tax rates that have never been assigned to any tax levels can be deleted.

Note: If a rate has been assigned to one or more tax levels, you need to let the rate expire instead
of deleting it. For more information, see Expired Tax Rates and Levels on page 633.

To delete a tax rate
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.
2. Make sure the Rates tab is selected.
3. To view both current and future rates, select All under Rates to display.
4. Select the rate you want to remove, and click Delete. A confirmation message appears.

5. Click Yes.

TAX LEVELS
A tax level is a group of tax rates. Tax levels are assigned to customers, so TireMaster can calculate
the proper amount of sales tax to collect from them.

CREATE A TAX LEVEL
The second component needed to calculate sales tax in TireMaster is the tax level. A tax level, which
is a combination of tax rates, can be assigned to customers to ensure that you collect the proper
amount of sales tax from them.

To create a tax level
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.
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2. Click the Levels tab.

3. To display both current and future tax levels, select All under Levels to display.

4. Click Add. The Level Add screen appears.

5. Type a description for the new tax level.
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6. If you don’t see a rate that you want to assign, select All under Rates to Display.

7. Assign one or more rates to the tax level:

To assign a single rate, select the rate in the Available Tax Rates panel and click .

To assign all rates, click .

Tip: If you assign rates in error, click for a single rate or click for all rates.
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8. To save the new level, clickOK.

Tip: You can review your sales tax settings by printing the Sales Tax Setup Report.

UPDATE TAX LEVELS
Because of changes in tax laws, you might need to update your tax levels by adding new rates or
removing existing rates.

To update a tax level
1. From the Setupmenu, select Sales Tax Maintenance. The Sales Tax Setup screen appears.

2. Click the Levels tab.

3. Select the level you want to update, and click Edit. The Level Edit screen appears.
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Note: If you don’t see the level that you want to update, select All in the Levels to display
area.

4. To display both current and future tax rates that can be assigned to the tax level, select Allunder
Rates to display.

5. Assign or remove rates from the level:

To assign a single rate to the tax level, select the rate in the Available Tax Rates area and
click . To assign all rates, click .

To remove a single rate from the tax level, select the rate in the Assigned Tax Rates area
and click . To remove all rates, click .

6. To save the updated level, clickOK.

ASSIGN TAX LEVELS TO CUSTOMERS
TireMaster calculates how much sales tax customers need to pay based on the tax levels assigned
to them. For each customer, you need to assign two tax levels. One is for an item’s parts price, and
the other is for an item’s labor price.

When new customers are added to TireMaster, they’re automatically assigned the default tax levels
set in System Controls. If the default levels don’t meet a new customer’s tax requirements, assign
different tax levels. For more information, see Update Customer Records on page 71.

Note: If you have customers who are not required to pay sales tax, create exempt tax levels and
assign those levels to your tax-exempt customers.
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SET THE DEFAULT TAX LEVEL
When new customers are added to TireMaster, they’re automatically assigned the default tax level.
To define your default tax level, you need to complete a pair of control settings. There are two
approaches for setting the default tax level:

Use the level that calculates the highest amount of tax. This method ensures you’ll collect
enough sales tax.

Use the tax level that’s required for the majority of your customers. With this method, you’ll
rarely need to change the tax level when adding new customers.

To set the default tax levels
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Customer tab.
3. Set the default labor level.

a. Select Customer/Site Default Tax Level - Labor and press Enter. The Tax Level Lookup
screen opens.

b. Select the tax level you want to use as the default for labor, and clickOK.
4. Set the parts level.

a. Select Customer/Site Default Tax Level - Parts and press Enter. The Tax Level Lookup
screen opens.

b. Select the tax level you want to use as the default for parts, and clickOK.

5. Close the System Controls screen.
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EXPIRED TAX RATES AND LEVELS
Expired sales tax rates and levels are tax settings that are no longer in effect. A tax rate expires when
the ending date passes. Once a rate expires, you cannot view, reinstate, edit, or update it.

A tax level expires when all of the tax rates assigned to it expire. When a tax level expires, you won’t be
able to complete invoices for customers who have been assigned that level. Although you can set up
new rates for a tax level, those rates won’t take effect until the next day.

Tip: You can view expired tax levels by selecting All on the Levels tab of the Sales Tax Setup
screen. Expired tax rates cannot be viewed.

To prevent your tax rates and levels from expiring, follow these guidelines:

Before changing tax rates, make sure you know which tax levels use those rates. Depending on
how often you use various tax levels, you might decide to delay rate changes.

When editing a tax rate, verify that you’ve entered the correct ending date before clickingOK.
Once you clickOK, you can’t reset the ending date.
When you create new rates or update existing rates, set the ending date far into the future.
Consider using the same date (such as 1-1-2111) for all of your rates.

When preparing for a rate change, create the replacement rate on the same day that you
change the ending date of the original rate. This will prevent the original rate from expiring
before you’ve created the replacement rate.

TAX EXEMPTION CERTIFICATES
If your state requires additional documentation for tax-exempt customers, you can create a tax
exemption certificate that can be printed on invoices for tax-exempt customers.

CREATE A TAX EXEMPTION CERTIFICATE
Creating a tax exemption certificate includes defining the certificate text and adding a signature line..

To create a tax exemption certificate
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.
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2. Click the Levels tab.

3. Click Certification. The Tax Exemption Certificate screen appears.

4. Type the certificate text and a signature line.

Tip: To create a signature line, repeatedly press the keyboard’s underline key.

5. To save the certificate, clickOK.
6. Close the Sales Tax Setup screen.

PRINT A TAX EXEMPTION CERTIFICATE
Tax exemption certificates can be printed on invoices for tax-exempt customers at point of sale.
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To print a tax exemption certificate
1. Turn a work order into an invoice. For more information, see Complete an Invoice on page 456.

2. Select the Tax Exempt Cert check box on the Invoice Completion screen.

3. Complete the invoice as usual. The printed invoice will include the text from the tax exemption
certificate.

SALES TAX ADJUSTMENTS
If you collected the wrong amount of sales tax from a customer, you can adjust the sales tax for the
corresponding invoice. A tax rate adjustment does not alter the amount of sales tax that appears on
the original invoice. If you charged too much sales tax, the adjustment produces a credit for the
customer. Likewise, if you didn't collect enough sales tax, the customer will owe you money. In
TireMaster Plus and TireMaster Corporate systems, a sales tax adjustment results in an adjusting
journal entry.

Because sales tax adjustments post to customer accounts (subledgers), you need to reimburse
customers if you reduced the sales tax for their invoices. If customers owe sales tax, send them
statements so you can collect the additional tax money. To see how much sales tax customers owe,
print the Unapplied Credit Report .

Note: The document type code ST is used to identify transactions in which the sales tax has been
changed for an invoice.

To make a sales tax adjustment
1. Look up the customer whose invoice needs a sales tax adjustment. For more information, see

Customer Searches on page 93.

2. On the Customer Maintenance screen, click the Ledger/History tab.
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3. Select the invoice for which you want to change the sales tax amount, and click Tax. The Sales
Tax Adjustment screen opens.

4. To change the amount of tax assessed for a particular rate, select the rate and type the new sales
tax amount in the New Amount column. For rates that do not need to be changed, leave the
entries in the New Amount field alone.

5. ClickOK. A confirmation message appears.

6. To process the changes, click Yes.
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Note: Changing the tax rate does not alter the amount of sales tax that appears on the original
invoice. It creates an entry in the customer's account instead. In TireMaster Plus and
TireMaster Corporate, it also results in an adjusting journal entry.

7. If you reduced the tax, reimburse the customer for the difference between the old amount and the
new amount. If you increased the tax, send a statement to the customer so you can collect the
additional tax owed. For more information, see Customer Reimbursements on page 710.

SALES TAX COLLECTION METHODS
You can base your sales tax collections on one of the following:

The default tax levels for your store

The tax levels assigned to individual customers

Basing tax collections on the levels assigned to individual customers is sufficient if your sales tax
requirements are minimal, such as if you only need to collect state sales tax or if all of your stores are
located within the same tax jurisdiction.

If you need to collect taxes for a variety of government agencies, such as the state and multiple cities
that each have different tax rates, you can base your sales tax collections on the default tax levels for
your store. Basing collections on your store’s levels, helps to ensure that you collect enough sales tax
to satisfy the requirements of all of the various government agencies.

Example: You have a store in Minneapolis which charges 10% sales tax. Five percent of it goes to
the state and the other 5% goes to the city. Many of your customers, however, are assigned a tax
level amounting to 6% sales tax. They’re from nearby St. Paul where they pay the same 5% state
tax and a city tax of only 1%. By basing sales tax collections on your store’s default tax levels, you
can automatically charge the customers from St. Paul 10% sales tax instead of 6%, which ensures
that the state of Minnesota and the city of Minneapolis both get their share of tax dollars.

Although this scenario typically occurs in TireMaster Corporate environments, where customers are
added at various locations with differing sales tax requirements, the option to base sales tax on store
levels can also be used in TireMaster Plus and TireMaster Point of Sale systems.

Note: If you base sales tax collections on your store’s default levels, there are two instances in which
this setting is disregarded: 1) When the customer is exempt from paying sales tax, and 2)
When you’re prompted to choose the customer’s tax level at point of sale, because of settings
for the customer’s customer type.

You can define how sales tax is collected by setting a system control.

To define how sales tax is collected
1. Select Setup > System Controls. The System Controls screen opens.
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2. Click the Customer tab.
3. Select Sales Tax - Use Tax Levels Assigned to Customers and press Enter.

4. Do one of the following:

To base your sales tax collections on the default parts and labor tax levels for your store, select
No.
Note: The system controls for setting your store’s default tax levels are Customer/Site

Default Tax Level - Labor and Customer/Site Default Tax Level - Parts.

To base your sales tax collections on the tax levels assigned to individual customers, select
Yes.

5. In TireMaster Corporate, repeat steps 3 and 4 until the control has been set for all sites.

6. Close the System Controls screen.

SALES TAX ROUNDING ACCOUNT
The sales tax rounding account is a GL account that’s used in to track the amount of sales tax that’s
rounded off during sales tax calculations.

When calculating sales tax, TireMaster temporarily extends the tax amount for each item by two digits.
Using the extra digits ensures that the sales tax total for each of the items equals the sales tax total for
the invoice. Once the sales tax total is calculated, the extra digits are no longer needed. As a result, the
amount of tax that posts to the general ledger matches the amount of tax actually charged.

Note: Talk to your accountant before you choose an account to use for posting sales tax rounding
amounts. If you use TireMaster’s default chart of accounts, you can create an offset minor
account under the 2020-0 Sales Tax Payable account.

To define the sales tax rounding account
1. Select Setup > System Controls. The System Controls screen opens.
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2. Click theGeneral Ledger tab.
3. Select Default Account - Sales Tax Rounding and press Enter. The Chart of Accounts screen

opens.

4. Select the account you want to use to track sales tax rounding, and clickOK.
5. Close the System Controls screen.

EXCLUDE FET FROM SALES TAX
By default, the sales tax for quotes and work orders is calculated based on the parts price, labor price,
and federal excise tax for items. However, if you do business in a state where charging sales tax on
FET is optional or prohibited, you can exclude it from sales tax calculations by changing a control
setting.

To exclude FET from sales tax
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theOther tab.
3. Select Apply Sales Tax to FET, and press Enter.
4. Select No and clickOK.
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5. Close the System Controls screen.

CUSTOMER AND INVENTORY TAX SETTINGS
In addition to creating sales tax rates and levels, you also need to complete tax settings for individual
customers and inventory items to ensure that you collect sales tax when required. The settings that
you need to complete vary depending on the circumstances.

COLLECT TAX ON AN ITEM’S PARTS PRICE
If you need to collect sales tax on an item’s parts price only, complete the following settings:

On the Inventory Maintenance screen, select the Parts check box for that item and leave the
Labor check box clear.

On the Customer Maintenance screen, select the Taxable check box (unless the customer
doesn’t have to pay tax), and use the same tax level for both parts and labor to include them
both in the same section of the Sales Tax Report.

COLLECT TAX FOR BOTH PARTS AND LABOR
If you need to collect sales tax on both the parts and labor prices for an item, complete the following
settings:

On the Inventory Maintenance screen, select both the Parts and Labor check boxes (unless the
item is not taxed).
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On the Customer Maintenance screen, select the Taxable check box (unless the customer
doesn’t have to pay tax), and use the same tax level for both parts and labor to include them
both in the same section of the Sales Tax Report.

COLLECT TAX IN MULTIPLE STATES
If labor is not taxed in your state, but you do work in a state that charges sales tax for labor, complete
the following settings:

On the Inventory Maintenance screen, select both the Parts and Labor check boxes (unless the
item is not taxed).

On the Customer Maintenance screen, make sure the Taxable check box is selected (unless
the customer does not have to pay sales tax and you haven’t set up an exempt tax level). If labor
is taxed, use the same tax level for both parts and labor. However, if the customer does not have
to pay tax on labor, use a non-taxable tax level for labor instead.

However, if the customer does not have to pay tax on labor, use a non-taxable tax level for labor
instead.
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CHANGE A CUSTOMER’S TAX LEVEL AT POINT OF SALE
Occasionally, you might need to change a customer’s price level at point of sale (such as when a
service call occurs in another state). Changing the tax level at point of sale helps you collect the proper
amount of sales tax without affecting the sales tax settings in the customer’s record. To change the tax
level at point of sale, you need to be assigned the Customer Edit permission.
Note: This method of changing the tax level applies only to customers who are set up as taxable (the

Taxable check box is selected on the Customer Maintenance screen on theGeneral tab).

To change a customer’s tax level at point of sale
1. Start a work order or retrieve an existing work order. For more information, see Create a Regular

Work Order on page 442 or Update a Work Order on page 451

2. On the Invoice Entry screen, click the Tax Level button.

Note: Tax levels can also be changed in a similar manner when working with the Quote and
Estimate Writer.

3. Do the following as needed:

a. Click Lookup 1 and select the tax level for parts.
b. Click Lookup 2 and select the tax level for labor.
c. ClickOK to save your changes.

4. Make additional changes to the work order, or clickQuit to close the Invoice Entry screen.
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SPECIAL TAX REQUIREMENTS
Some states require businesses to charge a percentage of the regular tax rate for certain items. For
example, retreads might be taxed at 75% of the regular rate. If you conduct business in a state with this
type of tax requirement, you need to set up one or more tax rate adjustments in TireMaster.

Setting up tax rate adjustments includes the following steps:

Creating one or more inventory tax adjustment groups

Creating one or more tax rate adjustments, to define which tax rate and items are affected by an
adjustment

With a tax rate adjustment, only the tax on the parts price is adjusted. Labor and federal excise tax are
calculated as usual. If you’re unsure of whether you need to set up tax rate adjustments, talk to your
accountant.

INVENTORY TAX ADJUSTMENT GROUPS
An Inventory tax adjustment group is a collection of items that need to be taxed at a percentage of the
regular tax rate. Inventory adjustment groups can be assigned to tax rate adjustments.

CREATE AN INVENTORY TAX ADJUSTMENT GROUP
When you create an inventory tax adjustment group, look up and assign the items that need to be
included in the group.

To create an inventory tax adjustment group
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Click theGroups tab.
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3. Click Add. The Inventory Group Add screen opens.

4. Type a description for the inventory tax adjustment group.

5. Click Lookup, and look up items that you want to include in the inventory tax adjustment group.
For more information, see Inventory Searches on page 230.

6. Assign items to the tax adjustment group:

For a single item, select it and click .

For all items, click .



Special Tax Requirements

Tip: If you assign an item in error, select it and click . To remove all items, click .

7. To save the new tax adjustment group, clickOK.

UPDATE AN INVENTORY TAX ADJUSTMENT GROUP
If you need to add or remove items from an inventory tax adjustment group, you can update the
group.

To update an inventory tax adjustment group
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Click theGroups tab.
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3. Select the group you want to update and click Edit.

4. Add or remove items as needed:

To add items, click Lookup and search for the items you want to add. For a single item, select
it and click . To add all items, click instead. For more information, see Inventory
Searches on page 230.

To remove an assigned item, select it and click . To remove all items, click .

5. To save your changes, clickOK.

DELETE AN INVENTORY TAX ADJUSTMENT GROUP
If an inventory tax adjustment group has never been used for a tax rate adjustment, you can delete it.

To delete an inventory tax adjustment group
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.
2. Click theGroups tab.
3. Select the group you want to remove, and click Delete. A confirmation message appears.

4. Click Yes.
5. Close the Sales Tax Setup screen.

COPY AN INVENTORY TAX ADJUSTMENT GROUP
You can create a new inventory tax adjustment group by copying an existing group. Copying an
existing group saves you time if the new group needs to have many of the same settings as an
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existing group.

To copy an inventory tax adjustment group
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Click theGroups tab.

3. UnderGroups, select the group you want to copy and click Copy. The Inventory Group Copy
screen appears.

4. Type a description for the new inventory tax adjustment group.

5. Add or remove items as needed:
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To add items, click Lookup and search for the items you want to add. For a single item, select
it and click . To add all items, click instead. For more information, see Inventory
Searches on page 230.

To remove an assigned item, select it and click . To remove all items, click .

6. To save the new group, clickOK.

TAX RATE ADJUSTMENTS
A tax rate adjustment is a setting that ensures that items are taxed at a percentage of the regular tax
rate. Each tax rate can have only one tax rate adjustment.

CREATE A TAX RATE ADJUSTMENT
The settings for a tax rate adjustment define which tax rate to adjust and which items are taxed at the
adjusted rate. If you sell items that should be tax exempt for certain customers, you can set up an
exempt tax rate adjustment. In this case, federal excise tax is exempt.

To create a tax rate adjustment
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Click the Adjustments tab.

3. Click Add. The Adjustment Add screen appears.
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4. Enter the following information:

a. Type a description for the tax rate adjustment.

b. Define which rate will be adjusted by clicking the Tax Rate field, pressing , and selecting a
rate from the list.

Tip: To display both current and future tax rates, select All under Rates to Display.

c. Define the percentage of an item’s price that will be taxed, by typing the number as a decimal
in the Taxable Factor field. (For example, if 75% of the item’s price is taxable, type .75.) If
the items assigned to this group should not be taxed, select the Exempt check box instead.

5. Assign one or more inventory tax adjustment group to the adjustment:

To assign a single inventory tax adjustment group, select the group, and click .

To assign all inventory tax adjustment groups, click .

Note: If you assign multiple inventory tax adjustment groups to a tax rate adjustment, the
items each of those groups must be unique. If TireMaster detects that the same item
is used in multiple inventory tax adjustment groups, you will be required to remove
the duplicate item from all but one of the groups before assigning the groups to the
tax rate adjustment.

Tip: If you assign a group in error, select it and click . To remove all groups, click .

6. To save the new tax rate adjustment, clickOK. A message that lists the settings for the tax rate
adjustment appears.

649



650

User Guide

7. Review the settings described in the message, and do one of the following:

If the settings are correct, click Yes.
If the settings are not correct, click No, and make the needed changes.

UPDATE A TAX RATE ADJUSTMENT
You can update a tax rate adjustment by changing its name, adding new inventory tax adjustment
groups, and removing inventory tax adjustments groups.

Note: The tax rate and taxable factor used for the group cannot be edited. To change that
information, you need to make the tax rate adjustment inactive and create a new one. For
more information, see Make a Tax Rate Adjustment Inactive on page 651.

To edit a tax rate adjustment
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Click the Adjustments tab.

3. Select the tax rate adjustment that you want to update and click Edit. The Adjustment Edit screen
appears.
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4. Change the description and add or remove inventory tax adjustment groups as needed:

To add a single inventory tax adjustment group, select the group, and click . To assign all

tax adjustment groups, click .

Note: If you assign multiple inventory tax adjustment groups to a tax rate adjustment, each
item in each of those groups must be unique. If the program detects that the same
item is in multiple inventory tax adjustment groups, you will be required to remove the
duplicate item from all but one of the groups before assigning the groups to the tax
rate adjustment.

To remove a single inventory tax adjustment group, select the group, and click . To

remove all inventory tax adjustment groups, click .

5. To save the updated tax rate adjustment, clickOK.

MAKE A TAX RATE ADJUSTMENT INACTIVE
If you no longer need to use a tax rate adjustment, you can make it inactive.

To make a tax rate adjustment inactive
1. Select Setup > Sales Tax Maintenance. The Sales Tax Setup screen opens.

2. Click the Adjustments tab.
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3. Select the tax rate adjustment that you want to make inactive, and click Delete.

4. Click Yes to confirm that you want to delete the tax rate adjustment. The following message
appears: “This Adjustment has been associated with a tax level. To make it inactive, click OK.
Otherwise click Cancel.”

5. ClickOK. The tax rate adjustment is removed from the Sales Tax Setup screen.
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CHART OF ACCOUNTS
The chart of accounts lists all of the accounts in your general ledger. Depending on how this screen is
accessed, you can do the following:

Add, update, or delete an account.

Select an account to assign to a code or a setting in System Controls.

Select an account whose activity you want to research.

Tip: To locate an account on the Chart of Accounts screen, click Find. Then type all or part of the
account number or name, and clickOK.

GENERAL LEDGER ACCOUNT NUMBERS
In TireMaster, general ledger account numbers are made up of five different parts. Each part of the
account number provides different information and defines how to post transactions to the general
ledger (Figure 22-1).

Figure 22-1: The Parts of a General Ledger Account Number

Note: You can control the amount of detail on the income statement depending on whether you show
or hide the minor account information.

GENERAL LEDGER ACCOUNT TYPES
The chart of accounts in TireMaster uses five types of accounts. The code (shown in the Type column
on the Chart of Accounts screen) defines the account type (Table 22-1).
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Code Account Type Definition

A Asset The historical value of things you own.

L Liability The debts you owe to individuals, businesses, or organizations.

R Owner’s
Equity

The difference between the total assets and total liabilities of your
business.

I Income An increase in equity that comes from the sale of goods and
services.

E Expense A decrease in equity that comes from the cost of materials and
services used to produce income.

Table 22-1: Account Types

DEBITS AND CREDITS
Depending on the transaction that’s performed, the balance of an account increases or decreases.
Some accounts are known as debit accounts, and others are known as credit accounts. Debits are
used to record an increase in asset and expense accounts, while credits are used to record an
increase in liability, owner’s equity, and income accounts (Table 22-2).

Account Type Debit Credit

Asset + -

Liability - +

Owner’s Equity - +

Income - +

Expense + -

Table 22-2: Debits and Credits

For your general ledger to be in balance, the amount in the debit accounts on the left side must equal
the amount in the credit accounts on the right side (Figure 22-2).
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Figure 22-2: A General Ledger That's in Balance

UPDATE THE CHART OF ACCOUNTS
New TireMaster systems include a standard chart of accounts that can be used as is or customized.

Note: If the chart of accounts is updated, you might also need to update System Control settings that
define defaults for how transactions post to the general ledger. For more information, see Set
Default General Ledger Accounts on page 661.

ADD AN ASSET ACCOUNT
An asset is something that you own that has a dollar value. Asset accounts include cash, accounts
receivable, and inventory accounts.

To add an asset account
1. Select General Ledger > Chart of Accounts. The Chart of Accounts opens.

2. Click Add. The GL Account Edit screen appears.

3. Type the major account number and primary description for the new account.

4. Type the minor account number and secondary description for the new account.

Note: If the minor account number is 0, leave the description blank.

5. Under Type, select Asset.
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6. If the new account is for inventoriable items, select the Inventory Items check box. Otherwise,
leave it blank. For more information, see Add an Inventory Item on page 205.

7. Make sure the Active check box is selected.

8. To save the new account, clickOK.

ADD A LIABILITY ACCOUNT
Liabilities are debts that you owe. Liabilities include your vendor accounts, loans, and taxes.

To add a liability account
1. Select General Ledger > Chart of Accounts. The Chart of Accounts opens.

2. Click Add. The GL Account Edit screen opens.

3. Type the major account number and primary description for the new account.

4. Type the minor account number and secondary description for the new account.

Note: If the minor account number is 0, leave the description blank.

5. Under Type, select Liability.
6. Make sure the Active check box is selected.
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7. To save the new account, clickOK.

ADD AN EQUITY ACCOUNT
Equity is the difference between the total assets and total liabilities of a business. Equity accounts
include your capital and retained earnings accounts.

To add an equity account
1. Select General Ledger > Chart of Accounts. The Chart of Accounts opens.

2. Click Add. The GL Account Edit screen opens.

3. Type the major account number and primary description for the new account.

4. Type the minor account number and secondary description for the new account.

Note: If the minor account number is 0, leave the description blank.

5. Under Type, select Ret. Earn.
6. Make sure the Active check box is selected.
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7. To save the new account, clickOK.

ADD AN INCOME ACCOUNT
Income is any revenue that comes from the sale of goods and services or from other sources. Your
income accounts are mainly sales accounts.

To add an income account
1. Select General Ledger > Chart of Accounts. The Chart of Accounts opens.

2. Click Add. The GL Account Edit screen opens.

3. Type the major account number and primary description for the new account.

4. Type the minor account number and secondary description for the new account.

Note: If the minor account number is 0, leave the description blank.

5. Under Type, select Income.
6. To define which section of the income statement will include information about the new account,

select one of the following:

Administrative
Normal Income/Expense
Other Income/Expense

7. Make sure the Active check box selected.
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8. To save the new account, clickOK.

ADD AN EXPENSE ACCOUNT
An expense is a decrease in equity that comes from the cost of materials and services used to
produce income. Examples of expenses are the cost of inventory, loan fees, and insurance.

To add an expense account
1. Select General Ledger > Chart of Accounts. The Chart of Accounts opens.

2. Click Add. The GL Account Edit screen opens.

3. Type the major account number and primary description for the new account.

4. Type the minor account number and secondary description for the new account.

Note: If the minor account number is 0, leave the description blank.

5. Under Type, select Expense.
6. To define which section of the income statement will include information about the new account,

select one of the following:

Administrative
Normal Income/Expense
Other Income/Expense

7. Make sure the Active check box selected.
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8. To save the new account, clickOK.

SET DEFAULT GENERAL LEDGER ACCOUNTS
Setting default accounts in System Controls ensures that many routine transactions consistently post
to the general ledger. In new TireMaster systems, general ledger account numbers are already
assigned to the following controls:

Default Account - Cash
Default Account - Cash Over/Short
Default Account - FET Correction
Default Account - Finance Charge Income
Default Account - Freight
Default Account - Inventory Correction
Default Account - PO Sales Tax Expense
Default Account - Sales Tax
Default Account - Sales Tax Rounding
Default Account - Year-End Profit Loss

You can leave the default settings as is or assign different accounts to the controls.

To set a default general ledger account
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theGeneral Ledger tab.
3. Select the control for the default account that you want to set and press Enter. The Chart of

Accounts screen opens.
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4. Select an account, and clickOK.
5. To set additional controls for default accounts, repeat steps 3 and 4.

6. Close the System Controls screen.

MANAGE EXISTING ACCOUNTS
If your chart of accounts includes rarely-used and unused accounts, you can make it easier to manage
by deleting those accounts or making them inactive.

MAKE A GL ACCOUNT INACTIVE
If you no longer use a general ledger account, you can make it inactivate. By making an account
inactive, you can exclude it from the Chart of Accounts screen.

To make a GL account inactive
1. Select General Ledger > Chart of Accounts. The Chart of Accounts opens.

2. Select the account you want to make inactive, and click Edit. The GL Account Edit screen opens.
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3. Clear the Active check box, and clickOK. The Chart of Accounts screen opens.

Note: If the Active Only check box is selected on the Chart of Accounts screen, the inactivate
account won’t be listed.

4. Close the Chart of Accounts screen.

DELETE A GL ACCOUNT
If you’ve never used a general ledger account, you can delete it from the Chart of Accounts.

Note: If an account can’t be deleted, you can make it inactive. For more information, see Make a
GL Account Inactive on page 662.

To delete a general ledger account
1. Select General Ledger > Chart of Accounts. The Chart of Accounts opens.
2. Select the account you want to remove, and click Delete. A confirmation message appears.

3. Click Yes.

SUBLEDGERS
In TireMaster, the term subledger refers to the record in which account activity for an individual
customer, vendor, or item is tracked. There are also subledgers for tracking the credits you expect to
receive from vendors for national account, government support, and adjustment sales.

The balances of similar subledgers are added together to generate the total of one general ledger
account. For example, the total of all customer subledger balances equals the balance of the accounts
receivable account. Similarly, the total of all expected credits from each vendor equals the balance of
the accounts payable expected credits account.
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VIEW SUBLEDGER BALANCES
The following information describes how you can view the balances for different kinds of subledgers:

For customers, look at the Ledger/History and Aging tabs on the Customer Maintenance
screen.

For vendors, look at Ledger/History and Aging tabs on the Vendor Maintenance screen.

For inventory items, print the Inventory Value Report.

For expected credits, print a National Account Reconciliation Report for each vendor’s
reconciliation code.

Note: For subledger information, you need to print this report from the National Credits screen
and display only items that have not been reconciled. For more information, see National
Account Reconciliation Report on page 855.

GL RANGES
TireMaster uses GL ranges to verify that account numbers fall within the numerical range allowed for
an account type, such as asset or liability. When you set up a new a general ledger account,
TireMaster compares the major account number to the account type. If the account number doesn’t
belong in the GL range for the account type, TireMaster displays a warning. To save the new account,
you need to enter a valid account number or select a valid account type.

DEFAULT GL RANGES
New TireMaster systems ship with a set of default GL ranges (Table 22-3). It includes five primary
ranges for general account types and 13 secondary ranges for the kinds of accounts that can be
grouped under the general account types.

Note: The default GL ranges meet current accounting standards. In almost all cases, the ranges for
assets, liabilities, equity, income, and expenses should not be changed. Before you update the
GL ranges, contact your accountant.

ID Range Name Major Account Range

1 Assets 1000 – 1999

6 Accounts Receivable 1100 – 1199

7 Inventory 1200 – 1399

8 Cash 1000 – 1099

9 Checking 1010 – 1019

2 Liability 2000 – 2999

Table 22-3: Default GL Ranges
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ID Range Name Major Account Range

10 Accounts Payable 2000 – 2099

11 National Account, Government Support, Adjustment 2000 – 2099

3 Equity 3000 – 3999

4 Income 4000 – 4999

12 Sales 4000 – 4699

13 Commission 4500 – 4599

14 Sales Offset 4500 – 4599

15 Cost Offset 4500 – 4599

16 Accounts Receivable Discount 4600 – 4699

5 Expense 5000 – 9999

17 Cost of Goods Sold 5000 – 9999

18 Accounts Payable Discount 5600 – 5699

UPDATE GL RANGES
The GL ranges can be updated by changing the account numbers used for a range or associating a
secondary range with a different primary range.

Note: Although you can update the secondary ranges, some changes might adversely affect the
income statement and balance sheet.

To update the GL ranges
1. Select Setup > GL Ranges. The GL Ranges screen opens.

2. To change the account numbers used for a range, type different major account numbers for the
beginning and end of the range in the From and To columns.
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3. To associate a secondary range with a different primary range, do one of the following in the
Relate column:

To associate the range with the asset account range, type 1.

To associate the range with the liability account range, type 2.

To associate the range with the equity account range, type 3.

To associate the range with the income account range, type 4.

To associate the range with the expense account range, type 5.

4. Close the GL Ranges screen.

DISABLE A GL RANGE
If you don’t want TireMaster to verify account numbers for a particular account type, you can disable
the GL range.

Note: If you disable a GL range that contains secondary ranges, you must disable all secondary
ranges

To disable a GL Range
1. Select Setup > GL Ranges. The GL Ranges screen opens.
2. Type the number 0 in the From and To fields for the range you want to disable.

3. If the range’s Relate column contains a value, delete it.
4. To save the changes, clickOK.

JOURNAL ENTRIES
Journal entries are used to record transactional activity in the general ledger. Journal entries are made
up of two or more lines and must have equal totals for debits and credits.

TireMaster makes some journal entries automatically when you perform various transactions (for
example, completing an invoice or closing the day). In these instances, the settings for inventory items,
vendors, and customers determine which general ledger accounts transactions post to.
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For some journal entries, you need to define which accounts some or all of the lines should post to. For
example, when you perform a paidout, TireMaster credits the GL account assigned to your till but you
need to define which expense account to debit. For manual journal entries, you need to define all of the
GL accounts to debit and credit. Manual journal entries are entered on the Journal Entries screen.

Note: Entries that need to post to both a bank account and the general ledger must be entered on the
Check Reconciliation Add screen. For more information, see Manage Bank Activity on page
767.

MAKE A MANUAL JOURNAL ENTRY
You need to make manual journal entries for transactions that do not post to the general ledger
automatically. The credits and debits in a manual journal entry must equal each other before you can
post it to the general ledger.

Note: Multiple users can make journal entries at the same time. Each user who makes journal entries
needs to log in to TireMaster with a unique ID and password. If one user saves a journal entry,
only that user can view and complete the journal entry at a later time.

To make a manual journal entry
1. SelectGeneral Ledger > Journal Entries. The Journal Entries screen opens.

2. If you need to backdate the entry, select a different date from the Effective Date drop-down.

3. Add a line for the journal entry.

a. Click Add. A journal-entry line appears.

b. If you use departments, click the Dept field and press . Then select the department you want
to entry to post to.

c. Click theMajor orMinor field and press . Then select the general ledger account you want
the entry to post to.

d. Type the amount for the entry.
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e. In the D/C field, type D for a debit or C for a credit.

f. Type a description for the entry.

Tip: Using the same description for all the lines of a journal entry can make researching
manual entries easier.

g. If you need to change the GL class, click the CL field and press . Then select the GL class
that you want the entry to post to.

4. To add the remaining lines of the journal entry, repeat step 3.

Tip: Check the Diff field to verify that the debits and the credits for the entry are in balance.

5. To post the entries to the general ledger immediately, click Post and answer the questions when
prompted. If you want to post the entries later, click Save instead.

RECURRING JOURNAL ENTRIES
You can set up a series of journal entries to record transactions that occur on a regular basis, such as
depreciation and prepaid expenses. When it’s time to post one or more recurring entries, you can load
the preset information into the Journal Entries screen, make any needed changes, and post to the
general ledger.

SET UP A RECURRING ENTRY
Recurring entries are set up on the Recurring Journal Entry Setup screen. If an entry is for a fixed
amount, you can specify it at this time.

To set up a recurring entry
1. SelectGeneral Ledger > Journal Entries. The Journal Entries screen opens.
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2. Click Recurring Setup. The Recurring Journal Entry Setup screen opens.

3. Click Add. A journal-entry line appears.

4. Enter the following information for the journal entry line as needed:

Site number (in TireMaster Corporate systems)

Department number (if you use multiple departments)

Major and minor account numbers

D for debit or C for credit

A description of the entry

GL class number

Note: To enter the site, department, account, and GL class, press and make a selection from
the list that appears.

5. To add the remaining lines of the recurring entry, repeat steps 3 and 4.
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6. When you’re finished setting up the entries, click Save. The Recurring Journal Entry Setup
screen closes.

Note: The debit and credit amounts must match for the entries to be saved.

POST A RECURRING ENTRY
When you’re ready to post one or more recurring entries, you can import the preset information for
those entries into the Journal Entries screen.

To post a recurring entry
1. SelectGeneral Ledger > Journal Entries. The Journal Entries screen opens.

2. Click Recurring Setup. The Recurring Journal Entries Setup screen opens.

3. Select the entries you want to post:

For all entries, select theMark All check box.
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For a single entry, select the check box for its line.

To exclude an entry, clear the check box for its line.

4. Click Save. The Journal Entries screen opens.

5. Select the Include Recurring check box. The recurring entries that you selected are added to
the Journal Entries screen.

6. Change the amounts of the recurring entries if needed.

7. Make additional entries if needed. For more information, see Make a Manual Journal Entry on
page 667.

8. To post the entries to the general ledger, click Post and answer the questions when prompted. If
you want to post the entries later, click Save instead.
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REVERSE A JOURNAL ENTRY
In some cases, you might need to cancel a transaction after it posted to the general ledger. You can
reverse a journal entry to negate the effects of the original transaction.

Note: When you reverse an entry that posted to an inactive general ledger account, you need to
make the account active before you can post the reversal. Once you’ve completed the
reversing entry, you can make the account inactive again.

To reverse a journal entry
1. Look up the journal entry for the original transaction on the GL Transaction View screen, and print

a copy of the GL Transaction View List. For more information, see Search for General Ledger
Entries on page 675.

2. SelectGeneral Ledger > Journal Entries. The Journal Entries screen opens.

3. Type the date of the original journal entry in the Effective Date field.

Note: If the fiscal period for the original journal entry date has been locked, unlock it. For more
information, see Unlock a Fiscal Period on page 689.

4. For each line of the original transaction that resulted in a debit, do the following.

a. Click Add.
b. In the Site, Dept,Major,Minor, and Amount fields, type the same values as the line in the

original transaction.

c. In the D/C column, type C (the opposite of the original transaction) to credit the account.

d. Type a description for each reversing line.
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Tip: To simplify research, type REVERSAL: and the description from the original
transaction. For example, if the description of the original transaction was Postage,
type REVERSAL: Postage.

5. For each line of the original transaction that resulted in a credit, do the following:

a. Click Add.
a. In the Site, Dept,Major,Minor, and Amount fields, type the same values as the line in the

original transaction.

b. In the D/C column, type D (the opposite of the original transaction) to debit the account.

c. Type a description for each reversing line.

6. When you are finished adding lines and the debits equal the credits, click Post and answer the
questions when prompted. If you want to post the entries later, click Save instead.

JOURNAL ENTRIES SCREEN
You can make manual journal entries on the Journal Entries screen.

Figure 22-3: Journal Entries Screen

673



674

User Guide

Item Description

Effective Date Lets you backdate journal entries. By default, this field displays the
current date.

Include Recurring Lets you add one or more preset recurring journal entries to the screen,
so you can post them to the general ledger.

DR Displays the total debit amount in a group of journal entries.

CR Displays the total credit amount in a group of journal entries.

Diff Displays the difference (if any) between the total debit and credit
amounts. Journal entries cannot post if the debits and credits do not
equal each other.

Site Lets you define the site for a journal entry in TireMaster Corporate
systems.

Dept Lets you enter the department (if any) for a journal entry.

Major Lets you define the major account number for a journal entry.

Minor Lets you define the minor account number for a journal entry.

Amount Lets you enter the amount for a journal entry.

D/C Lets you define whether to post a debit (D) or credit (C).

Note: Debits increase only debit accounts, while credits increase only
credit accounts.

Description Lets you enter a description for a journal entry. This description appears
on the GL Transaction View screen.

CL Lets you define the GL class for a journal entry line that posts to an
income or expense account.

Recurring Setup Opens the screen for setting up recurring journal entries.

Add Creates a line for a new journal entry.

Delete Removes the selected journal entry line.

Total Displays the total and difference for the journal entries. If the entries
don’t balance, TireMaster adds a balancing entry.

Note: You can save unbalanced journal entries, but you cannot post
them to the general ledger.

Save Lets you save a group of journal entries without posting them to the
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Item Description

general ledger.

Post Posts a group of journal entries to the general ledger.

Note: After posting, you can view and print a detail report.

Cancel Exits the screen without saving or completing the journal entries.

RESEARCH TRANSACTIONS
When you need to review completed transactions or reprint a document, TireMaster provides two
methods for finding the information you need.

SEARCH FOR GENERAL LEDGER ENTRIES
When you need to see how a transaction posted to the general ledger, you can search for it up with the
GL Transaction View screen .

To search for general ledger entries
1. SelectGeneral Ledger > Transaction View. The GL Transaction View screen opens.

2. Enter one or more search parameters under Selection Criteria:
Date: For a single day, select the same beginning and ending dates from the pop-up calendar.
For a range, select different beginning and ending dates.

Note: To limit the search to the date a transaction was performed, select the Actual Date
check box.

Yr/Num/Per: For a fiscal period, select the beginning year, number, and period from the drop-
down. For a range, select both a beginning and an ending year, number, and period.
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Note: To retrieve a year end journal entry, select a beginning year and number. Then select
period 0.

Site: For a specific site, select the site from the drop-down. For a range, select both a
beginning and an ending site number.

Department: For a specific department, select the department number from the drop-down.
For a range, select both a beginning and an ending department number.

Account: For transactions that posted to one account, click the beginning account field, press
, and select an account. For a range, enter an account number in both the beginning and

ending account fields.
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GLNO: If you know a the journal entry number for a transaction, type the number in theGLNO
field.

3. To limit the search by document type, select one or more check boxes under Document Type
(Keymod).

4. Click Filter. TireMaster retrieve the entries that match the selected search parameters and
document types.

5. Do the following as needed:
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To retrieve the document produced by the selected transaction, click Research. Then click
Reprint when the Invoice/Document Search screen opens.
For a hard copy of the entries, click Print.

6. To clear the entries from the screen, click Reset.

7. Close the GL Transaction View screen.

SEARCH FOR INVOICES AND OTHER DOCUMENTS
If you need to reprint documents or research transactions, use the Invoice/Document Search screen to
retrieve the information you need.

To search for a document
1. SelectGeneral Ledger > Invoice & Document Search. The Invoice/Document Search screen

opens.

2. Type the document, reference, claim, or VID number for the document you want to retrieve in the
Find field. Then select one of the following:

3. Type the document number for the document you want to retrieve in the Find field. Then select
one of the following:

Doc# to look up a document by the system-generated document number
Ref/Claim# to look up a document by the reference or claim number entered during a
transaction

VID# to look up a document by the system-generated vendor invoice document number
Deleted Work Order to look up a work order that was deleted
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Cust. PO to look up a sale invoice by a customer’s purchase order number. This functionality is
available in TireMaster 9.4.0.

4. Click Find.

5. Do the following as needed:

To reprint a document, select the document and click Reprint.
To view any BAR change entries for a document, select the document, and click BAR.
To view the journal entries for a document, select the document and click Research.

6. Close the Invoice/Document Search screen.

GL TRANSACTION VIEW SCREEN
With the GL Transaction View screen, you can search for journal entries and completed transactions
and print any corresponding documents.

Note: At a resolution of 1024 x 768 or higher, the GL Transaction View screen displays document
information in the upper-right corner.

Figure 22-4: GL Transaction View Screen
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Item Description

Date Lets you look up transactions that occurred on a specific date or
during a specific date range.

Year/Num/Per Lets you look up transactions that occurred during a specific fiscal
period or a range of fiscal periods.

Site Lets you look up transactions for a specific site or a range of sites.

Department Lets you look up transactions that posted to a specific department or a
range of departments.

Account Lets you look up transactions that posted to a specific account or
range of accounts.

Actual Date Lets you sort transactions by the actual date instead of the effective
date. The actual date is the day a transaction was performed. The
effective date is the day that the transaction posted to the general
ledger.

GLNO Lets you look up a specific transaction by entering its journal entry
number.

Filter Displays transactions that meet the parameters you’ve selected.

Document Type
(keymod)

Lets you look up transactions that produced a specific document type.

Effect Displays the date when a transaction posted to the general ledger.

Actual Displays the date and time a transaction was performed.

YR Displays the fiscal year that a transaction posted to.

Per Displays the fiscal period that a transaction posted to.

Site Displays the site where a transaction took place.

Dept Displays the department affected by a transaction.

Maj Displays the number of the major account that a transaction posted to.

Min Displays the number of the minor account that a transaction posted to.

Description Displays the description for a transaction. Some descriptions (such as
those for easy checks and vendor charges) are created by TireMaster.

Debit Displays the debit amount posted to the account for a transaction line.
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Item Description

Credit Displays the credit amount posted to the account for a transaction line.

GLNO (column) Displays the journal entry number for a transaction line. All lines of a
journal entry have the same GLNO.

KEYMOD Displays the transaction type or document resulting from the
transaction.

DOC# Displays the number for a transaction or document.

Note: The series of transaction or document numbers is based on
the keymod or document type.

MAJNAME Displays the name of the major account that a transaction posted to.

MINNAME Displays the name of the minor account that a transaction posted to.

CLASS Displays the GL class for a transaction.

NUM Displays the number of the fiscal series.

CUST/VEND Displays the name of the customer or vendor for a transaction.

Research Displays the document or transaction that caused the journal entry.

Print Prints the transactions currently displayed on the GL Transaction
View screen.

Reset Clears the transactions currently displayed on the GL Transaction
View screen.

Close Closes the GL Transaction View screen.

INVOICE/DOCUMENT SEARCH SCREEN
With the Invoice/Document Search screen (Figure 22-5), you can search for and reprint documents
generated by TireMaster. From this screen, you can also access the GL Transaction View screen to
see the journal entries related to a selected document.

Figure 22-5: Invoice/Document Search Screen
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Item Description

Find (field) Lets you type a document or transaction number for the document
that you want to retrieve.

Doc# Lets you search by document or transaction number.

Ref/Claim# Lets you search by the value in the Reference or Claim field.

VID# Lets you search by the system-generated vendor invoice document
number.

Deleted Work Order Lets you search by document number for deleted work orders.

Find (button) Lets you carry out the search.

Site# Displays the site where a transaction took place.

Mod Displays the code for the document or transaction type for a
transaction.

Invoice Displays the document or transaction number for a transaction.

Date Displays the effective date of a transaction. The effective date is the
day that the transaction posted to the general ledger.

Reference Displays the value in the reference field for a transaction.

VID# Displays the number of the vendor invoice document.

VIDSite# Displays the site where a vendor invoice document was created.

Customer/Vendor Displays the name of the customer or vendor associated with a
document. For deleted work orders, the system-assigned customer
number is shown instead of the customer’s name.

Reprint Lets you reprint the selected document.

BAR Lets you view any BAR change entries for a selected transaction, if
BAR auditing is required and has been enabled in System Controls.

Research Lets you view the transactions that posted to the general ledger.

Close Closes the Invoice/Document Search screen.

GL CLASSES
With GL classes, you can display information for each type of sale in its own section on the income
statement. Therefore, you can report the profit (or loss) for items that bring in little or no money
separately from items sold under normal circumstances.
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Low-profit or no-profit items include tires that are sold in national account, government support,
adjustment, and transfer sales. When sales figures for these items are combined with the sales figures
for items sold at their regular prices, the overall gross profit margin is lowered.

In TireMaster, sales are typically divided into the following GL classes:

Class 1: Normal Sales

Class 2: Transfer Sales

Class 3: NA/GS/ADJ Sales (for national account, government support, and adjustment sales)

Note: When you set up a reconciliation code to track vendor credits, you need to assign a GL class
for national account, government support, and adjustment sales to the code.

When you print an income statement, you can do one of the following:

Display a summary of the net gain or loss for a particular type of sale. For this summary, roll up a
GL class.

Display the sales and cost totals for a particular type of sale. To include these totals, don’t roll up
a GL class.

GL classes are also part of general ledger account numbers. For more information, see General
Ledger Account Numbers on page 654.

DEFINE INCOME STATEMENT DETAIL WITH GL CLASSES
The amount of detail on your income statements depends on the number of GL classes. The startup
database in new TireMaster systems includes the following GL classes:

Class 1: Normal Sales

Class 2: Transfer Sales

Class 3: NA/GS/ADJ Sales

With these settings, national account, government support, and adjustment sales are lumped into one
GL class. If you want a separate profit (loss) report for each type of sale, you could set up your GL
classes in the following manner:

Class 1: Normal Sales

Class 2: Transfer Sales

Class 3: National Account Sales

Class 4: Government Support Sales

Class 5: Adjustments

You can also add detail to the income statement by setting up GL classes based on your vendors:

Class 1: Normal sales

Class 2: Transfer Sales

Class 3: Goodyear Sales

Class 4: Tires Express Sales
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Class 5: Napa Sales

Class 6: O'Reilly Sales

Class 7: Other Vendors

ADD A GL CLASS
You can use GL classes to affect the appearance of information on the income statement. Each GL
class that you add increases the amount of detail on the income statement.

To add a GL class
1. Select Setup > GL Class Options. The GL Class Options screen opens.

2. Click Add. The GL Class Edit screen opens.

3. Type a description for the GL class.

4. To save the new GL class, clickOK.
Note: Disregard the Roll Up/Net check box. You can define whether to roll up the GL class when

printing the income statement.

5. Close the GL Class Options screen.
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SET THE DEFAULT GL CLASS
Typically, the GL class for normal sales is the default GL class. If needed, you can change this setting
in System Controls.

To set the default GL class
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theGeneral Ledger tab.
3. Select Default GL class, and press Enter.

4. Type the number for the GL class that you want to use as the default.

5. ClickOK.

RENAME A GL CLASS
If you dislike the description for a GL class, you can rename it.

To rename a GL class
1. Select Setup > GL Class Options. The GL Class Options screen opens.
2. Select the GL class you want to rename and click Edit.
3. Type a new description for the GL class and clickOK.

DELETE A GL CLASS
If you have never used a particular GL class, you can delete it.

To delete a GL class
1. Select Setup > GL Class Options. The GL Class Options screen opens.
2. Then select the GL class you want to delete and click Delete. A confirmation message appears.

3. Click Yes. The GL class is removed.
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FISCAL CALENDAR
In TireMaster, a fiscal calendar is used to implement your fiscal year. A fiscal year is the 12 month
period businesses and government agencies use for accounting, budgeting, and reporting earnings. A
fiscal year can but does not have to correspond to the actual calendar year. Although the fiscal year
can begin with any month, you need to start with the same day and month every year, unless you get
government approval to change your company’s fiscal year.

SET THE FISCAL CALENDAR
When you go online, you need to set up the fiscal calendar for the current year and any previous years
for which you need to make journal entries. For some companies, fiscal periods start on the first day of
the month and end on the last day of the month. After going live, you need to update the calendar for
each new fiscal year.

To set the fiscal calendar
1. SelectGeneral Ledger > Fiscal Calendar. The Fiscal Calendar opens.

2. In the Fiscal Year field, type the earliest fiscal year for which you’ll make journal entries.

Note: Once you’ve set up a particular year in the fiscal calendar, you cannot set up any years that
come before it. For example, if you type 2020, you won’t be allowed to type 2019 and
2018.

3. Click Add Period. The Date Range screen opens.

4. Do one of the following:

To use the default date range, clickOK.
To change the date range, select an ending date from the pop-up calendar and clickOK.
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A new period is added to the fiscal calendar.

5. Repeat steps 3 and 4 for each of the remaining periods you need to add.

6. To add more years to the fiscal calendar, click Duplicate Year for each additional year.

Tip: To see the fiscal years that you just added, click the Fiscal Year field and repeatedly press
.

Note: If you changed the your company’s fiscal calendar by creating a short year and a new
fiscal year, TireMaster sets the value in the Number column to 2. For more information,
see Change the Fiscal Calendar on page 687.

7. Close the Fiscal Calendar screen.

CHANGE THE FISCAL CALENDAR
Although it’s rare, some businesses decide to change their fiscal calendar. A business might change
its fiscal year under the following circumstances:

A new owner buys the company

The company gets a new accountant who wants to change the bookkeeping system

The company hasn’t been in existence for an entire fiscal year

To change the fiscal calendar, you need to receive permission from the Internal Revenue Service.

To implement changes to the fiscal calendar, you need to create a short tax year. A short tax year is a
fiscal year that’s less than 12 months.

Example: If you change from a fiscal year that lasts from January through December to a fiscal
year that begins in October, the first nine months of the year (January through September) become
a short tax year.

When you change the fiscal calendar, TireMaster uses a fiscal number to distinguish the short fiscal
year from the new fiscal year. Typically, the number 1 identifies the short year and number 2 identifies
the new fiscal year. TireMaster resets the number to 1, once both the short year and the new fiscal
year of 12 periods are completed.

Note: To implement a short fiscal year, you need to get a security code from ASA Support.

To change the fiscal year
1. SelectGeneral Ledger > Fiscal Calendar. The Fiscal Calendar opens.
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2. In the Fiscal Year field, type the year that you want to turn into a short year.

Tip: You can also put the cursor in the Fiscal Year field and press to select the year.

3. Select the last period for the year, and click Delete Period. The period is removed from the Fiscal
Calendar screen.

Note: If you cannot delete the selected period, make sure no periods follow it. For example, if you
cannot delete Period 12 of the year 2019, you first need to delete Period 1 of 2020.

4. Repeat step 3 to delete remaining periods that are not part of the short year.

5. Create the first period of the new fiscal year.

a. Click Add Period. The Date Range screen opens.

b. If you need to change the ending date, select a date from the pop-up calendar.

c. To change the fiscal number for the new fiscal year, click . The Security Pass Code screen
appears.

Note: The value in the Number column distinguishes the short fiscal year from the new fiscal
year on the Fiscal Calendar screen. When both the short year and the new fiscal year
of 12 periods are completed, TireMaster resets the number to 1.

d. Type the security code provided by TireMaster Support and clickOK.
e. To save your changes and exit the Date Range screen, clickOK.
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6. Add the remaining periods of the new fiscal year.

a. Click Add Period. The Date Range screen opens.
b. Verify the ending date is correct, and clickOK.
c. Repeat steps a and b until the new fiscal year has 12 periods.

7. Close the Fiscal Calendar screen.

UNLOCK A FISCAL PERIOD
Before you can post an entry to a fiscal period that has been closed, you need to unlock the period on
the Fiscal Calendar screen. Once the entry has posted, you can relock the period. Fiscal periods are
locked during the month end closing process. For more information, see Lock a Fiscal Period on page
975.

Note: You cannot unlock a period that comes before a closed period. For example, to unlock Period
3, you need to unlock Period 4 first, if Period 4 is closed.

If a fiscal period is part of a fiscal year that has been closed, it cannot be unlocked.

To unlock a fiscal period
1. SelectGeneral Ledger > Fiscal Calendar. The Fiscal Calendar opens.

2. Select the period that you want to unlock, and click Unlock Period. The status changes from
closed to open.
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Note: If you try to unlock a period that comes before a locked period, the following message
appears: “You cannot reopen a period prior to a period that is closed!” ClickOK to close
the message. Then unlock all of the closed periods that follow the period you want to
unlock before repeating step 2.

3. Close the Fiscal Calendar screen.

Now you can post entries to the period that you just unlocked. When you’re done, relock the period.
For instructions, see Lock a Fiscal Period on page 975.

SITES
The site number identifies each of your stores, and it's used in GL account numbers to identify where
transactions have taken place.

SET UP SITES
When you set up a site, you define information that prints on various documents, such as quotes and
invoices. The site settings also include fields for recording contact information and ID numbers for
government agencies.

Note: If need to add a site for your TireMaster Corporate system, contact ASA Support for
assistance.

To set up a site
1. Select Setup > Sites. The Site List opens.



Sites

2. Click Edit. The Site Identification Maintenance screen opens.

3. Type the name, address, city, state, and zip code for the site.

Tip: Use the physical address in the Address 1 field and the mailing address in the Address 2
field. If the mailing address and the physical address are the same, leave the Address 2
field blank.

4. Type the data phone, fax, and phone numbers for the site.

Tip: The field for the data phone can be used to record information about the site’s Internet
connection.

5. Type the name of the person ASA Support should talk to in the Contact field.
6. Type your dealer number, if any.

7. Type the number assigned to you by the Bureau of Auto Repair or another consumer agency in the
BAR ID field.

8. In the EPA ID field, type in the number assigned to you by the Environmental Protection Agency.

9. To save the site information, clickOK.
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Note: Disregard setting the Active check box and defining the display name, sort order, and
customer. These settings are used when the Data Exchange program is installed or by
other sites (in TireMaster Corporate) that want to include your store's on-hand quantities
on the Inventory List. For more information, see Define Site-Specific Quantity Information
on page 951.

10. Close the Site List.

DEPARTMENTS
With departments, you can track the profitability of different segments of your business. The
profitability for each department is displayed on the income statement. The department number is also
included in GL account numbers to show which departments transactions posted to.

If you use multiple departments, you need to set them up in one of the following ways:

By customer types, such as wholesale and retail (see Customer Method on page 695)

By types of inventory items and services sold (see Inventory Method on page 696)

With multiple departments, you need to assign departments to several program settings and you need
to select which department various transactions should post to. For some transactions, such as
manual journal entries, you can only change the department when the transaction posts to an income
or expense account (the accounts used for the income statement).

DEPARTMENT CONSIDERATION
Although multiple departments can give you additional information about different segments of your
business, they take time to set up and maintain. For example, having three departments triples the size
of your chart of accounts. If you use multiple departments, you might want to add more accounts to the
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chart of accounts to generate additional information about your income and expenses. If departments
are not properly maintained, you're at risk of having incorrect departmental totals on the income
statement.

Note: If you want to use multiple departments, ASA recommends that you set them up them during
the going-online process. Although you can add departments after going live, doing so can
adversely affect the quality of your historical data.

ADD A DEPARTMENT
Before you set up multiple departments, determine what kind of information departments can help you
gather and how many departments you need.

With multiple departments, there is a risk of user error when manually completing transactions. For
example, selecting the wrong department for a journal entry can result in inaccurate information on
departmental income statements. To prevent user error, give your departments names that make it
easy for employees to know which departments they should post entries to.

To add departments
1. Select Setup > Departments. The Department Listing opens.

2. Click Add. The Department Edit screen appears.

3. Type a description for the department.

4. ClickOK.
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5. Close the Department Listing screen.

SET THE DEFAULT DEPARTMENT
In a multi-department system, you need define which department to use as the default department
(that is, which department will automatically appear in various program screens that use department
settings). If you don’t set up multiple departments, use the department that comes already set up in
TireMaster. If you use only one department, you don’t need to define a default department because it
has already been set.

Tip: Your default department should be the one that’s most frequently used.

To change the default department
1. Select Setup > System Controls. The System Controls screen opens.

2. Click theGeneral Ledger tab.
3. Select Default Department, and press Enter.

4. Type the number for the department that will be the default department, and clickOK.
5. Close the System Controls screen.

DEPARTMENT METHODS
When you set up departments, you need to use either the customer method or the inventory method.
The method that you choose depends on the kind of information you want your departments to
provide.
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CUSTOMER METHOD
With the customer method, you can see which types of customers generate the most profit. A retail
department and a wholesale department are examples of customer method departments.

To set up departments by customer, you need to do the following:

Set the customer department method in System Controls.

Assign a department to each customer type.

To set up departments by customer
1. To set the customer department method, do the following:

a. Select Setup > System Controls. The System Controls screen opens.

b. Click theGeneral Ledger tab.
c. Scroll to the control Department Method and verify whether Customer is already assigned.

If it isn’t, press Enter. Then select Customer and clickOK.

d. Close the System Controls screen.

2. To assign a department to each customer type, do the following:

a. Select Customers > Types. The Customer/Vendor Type List opens.

b. Select the customer type that you want to assign a department to and click Edit. The
Customer/Vendor Type Edit screen opens.

c. Click the Department field and press . Then select a department from list that appears.
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d. To save you changes, clickOK
e. Repeat steps 2b through 2d to assign departments to the remaining customer types.

f. Close the Customer/Vendor Type List.

INVENTORY METHOD
With the inventory method, you can see which types of items and services, such as tires and brake
jobs, generate the most profit. A tire department and a repair department are examples of inventory
method departments.

To set up departments by inventory, you need to do the following:

Set the inventory department method in System Controls.

Assign departments to each inventory GL code.

To set up departments by inventory
1. Set the inventory department method.

a. Select Setup > System Controls. The System Controls screen opens.

b. Click theGeneral Ledger tab.
c. Select Department Method and press Enter.

d. Select Inventory and clickOK.
e. Close the System Controls screen.

2. Assign a department to eachGL Code.

a. Select Inventory > Inventory GL Codes. The Inventory GL Code List opens.
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b. Select the GL code that you want to assign to a department to and click Edit. The Inventory
GL Code Maintenance screen appears.

c. Click the Department field and press . Then select the appropriate department from list that
appears.

d. To save your changes, clickOK.
3. Close the Inventory GL Code List.

CHANGE THE DEPARTMENT AT POINT OF SALE
If you want an invoice to post to a department that's not the one assigned to a customer type or an
inventory GL code, you can override the setting at point of sale.

To change a department at point of sale
1. Begin the process of completing an invoice as usual. For more information, see Complete an

Invoice on page 456. The Invoice Completion screen opens.

2. Type the number of the department that you want the invoice to post to in the Dept field.

3. Fill in the remaining fields as needed, and clickOK.

RENAME A DEPARTMENT
If you dislike the description for a department, you can rename it.
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To rename a department
1. Select Setup > Departments. The Department Listing opens.
2. Select the department you want to rename and click Edit.
3. Type a new description and clickOK.



ACCOUNTS RECEIVABLE
With TireMaster, you can manage customer account balances and track income from pending sales.
This chapter includes the following sections:

ROAs 700
Open Item Ledger 705
Customer Balance Adjustments 707
Credit Memos 709
Customer Reimbursements 710
Finance Charges 712
Statements 714
Monthly Statement Screen 735
Beginning Balances 738
Cbal Utility 740
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ROAS
An ROA (received on account) is a payment received from a customer who has a charge account.
When you process an ROA, you can apply the payment to the customer’s balance immediately, apply
the payment later, or leave the payment unapplied.

An ROA decreases a customers balance, and it accomplishes the following:

It decreases (credits) the balance of the general ledger’s AR account.

It increases (debits) the balance of the GL account for your cash till.

Note: When you close the day, the ROAmoves out of the cash till account to the GL account for your
bank's checking account.

PROCESS AN ROA
Processing an ROA includes recording a customer's payment and applying it to the customer’s
account balance now or later.

To process an ROA
1. Click Invoicing. The OpenWork Order List opens.

2. Click ROA. TireMaster prompts you for the customer's name.

3. Look up the customer, and clickOK on the Customer Maintenance screen to continue. For more
information, see Customer Searches on page 93.

Tip: To check the customer’s balance, click the Aging tab.

4. On the ROA entry screen, type the payment amount in the Cash,Check, or Credit/Debit card row
and press Enter. For check payments, TireMaster prompts you for a check number.
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5. To print a different number of copies, change the number in the # of Copies field.

6. Select the following check boxes as needed:

Direct Deposit, if the payment was already put into your bank account.
Note: Typically, only credit card companies make direct deposits, although other customers

or vendors might also pay in this manner under special circumstances. For more
information, see Record a Payment from a Credit Card Company on page 810.

Apply ROA, if you want to open the customer’s open item ledger and apply the payment.

Flag Old Invoices, if you want to apply the payment to the oldest invoices first.
Note: Whether this check box is selected by default depends on a system control setting. For

more information, see ROA Complete - Flag Old Invoices Selected on page 1199.

7. Type any notes about the payment (such as recommendations for applying it) in the Comments
field.

Note: ROA comments can be accessed from a customer's open item ledger.

8. Finalize the payment.

a. ClickOK. TireMaster prompts you to complete and print the ROA.

b. Click Yes. Then do one of the following:
If the Open Item Ledger opens, continue with step 8c.
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If the Report Window opens, go to step 9.

c. If you want to apply the ROA to a different invoice, select the letter A for the invoice it's current
applied to and press the space bar. Then type an A in the Apply field for another invoice.

Note: An ROA entered at a store isn't actually applied to an invoice. In this scenario, you’re
suggesting that users at the corporate site apply the payment to a specific invoice.

d. ClickOK. TireMaster prompts you to save your changes.
e. Click Yes. TireMaster prompts you to apply the items.
f. To apply the payment to the customer's balance now, click Yes. To apply it later, click No. The

Report Window opens and displays the ROA document.

9. Print the ROA document and close the Report Window.

APPLY AN ROA
If you have an ROA that was not applied to any invoices, you can apply the ROAmanually in the
customer’s open item ledger.

To apply an ROA
1. Look up the customer whose ROA you want to apply. For more information, see Customer

Searches on page 93.

2. When the Customer Maintenance screen opens, click the Ledger/History tab.

3. ClickOpen Item. The Open Item Ledger screen opens.

4. To sort items on the screen, select Invoice or Due Date.
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5. To see if any comments about an ROA were entered when it was processed, select the ROA and
click Notes.

6. Type the letter A in the Apply field for the ROA you want to apply.

7. Do the following for each invoice to which you want to apply the ROA:

a. Type the letter A in the Apply field.

Note: If you’re entering the ROA at a store, you won’t actually apply the payment to an
invoice. You’re suggesting that users at the corporate site apply the payment to a
specific invoice instead.

b. Change the amount in the Pay field if needed.

Note: Although the amount in the Pay field is automatically filled in when you mark an item
with an A, you can change it. The remaining balance of the payment, if any, is
displayed in the Unapplied Amt field.

8. ClickOK. TireMaster prompts you to save your changes.
9. Click Yes. TireMaster prompts you to apply the items.
10. To apply the payment to the customer’s balance, click Yes.
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UNAPPLY AN ROA
If you make a mistake when entering a customer payment, you can unapply the ROA.

To unapply an ROA
1. Look up the customer whose ROA you want to unapply. For more information, see Customer

Searches on page 93.

2. When the Customer Maintenance screen opens, click the Ledger/History tab.

3. ClickOpen Item. The Open Item Ledger screen opens.

4. Click Un-Apply. The ROA UnApply screen opens.

5.

6. Select a row for the ROA you want to unapply.

Note: All of the invoices that an ROA was applied to are assigned an identification number, which
is displayed in the Apply Group field.

7. ClickOK. A confirmation message appears.
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8. Click Yes. The invoices are added back to the Open Item Ledger.

9. ClickOK. TireMaster prompts you to save your changes.
10. Click Yes. TireMaster prompts you to apply the items.
11. Click No. The payment is no longer applied to the customer’s balance.

OPEN ITEM LEDGER
The Open Item Ledger screen shows the outstanding items for a customer’s account, including unpaid
charges, unpaid finance charges, unapplied ROAs, and unapplied discounts. ROAs are shown as
negative amounts (to help you see how the balance is calculated).

Figure 23-1: Customer Open Item Ledger

Item Description

Sort Lets you displays the documents on the screen by either the invoice
number or due date.

Discount Displays the total of any early pay discounts that are being applied to the
customer’s balance.

Unapplied Amt. Displays the amount that you can still apply to the customer’s balance.
When you finish applying payments and credits, the amount is 0.00.

Search Lets you narrow down the documents displayed by invoice number,
reference number, or amount.

Current ROA Displays the amount of the ROA you just completed when the Apply
ROA check box is selected on the ROA/Deposit Complete screen.
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Item Description

Site Displays the site where a transaction originated.

Mod Identifies the item with one of the following document type codes:

Blank is for regular invoices.

NA is for national account invoices.

GS is for government support invoices.

FC is for finance charges.

RO is for ROAs and early pay discounts.

XX is for adjustments to the customer’s balance (AR journal
entries) and beginning balance entries.

Invoice Displays the item’s system-assigned document number. When charges
are set up with multiple payments, the same invoice number is used for
each scheduled payment.

Ref # Displays the reference number for an invoice, ROA, or adjustment to the
customer’s balance.

Amount Displays the amount of the scheduled payment. For charges with only
one payment, this amount is the entire amount of the invoice.

UnApplied
(column)

Displays the amount of an ROA or credit that has not been marked to be
applied to an invoice or finance charge.

DueDate Displays the system-assigned invoice due date for invoices and ROA
posting date.

Note: If the due date for a customer charge is too soon, make sure that
statements have not been cut off. If the date is too far in the
future, make sure that statements have not been cut off more
than once. You can check date of the last statement cut off on
the Customer tab on the System Controls screen.

DiscAmt Lets you enter an expected early pay discount for an invoice.

Pay Displays the following:

The amount of a payment or credit that’s being applied to an
invoice or finance charge

The amount of an invoice or finance charge that’s being
subtracted from the customer’s balance, because a payment or
credit was applied to it

Apply Lets you define the following:
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Item Description

Which payments and credits to apply to invoices and finance
charges

Which invoices and finance charges are being paid by payments
and credits

DiscDate Displays the date by which the customer needs to pay you to receive an
early pay discount.

DiscAvail Displays the early pay discount, if any, for an invoice.

InvDate Displays the date when the transaction was entered in TireMaster.

Paid Displays the amount that has previously been applied to an invoice,
finance charge, or other entry.

DiscTotal Displays the total of early pay discounts, if any, given for an invoice.

Notes Not used.

AR Journal Entry Lets you adjust a customer’s balance by making an entry that posts to
the customer’s subledger and the general ledger.

Un-Apply Lets you unapply a group of items that were previously applied at the
same time.

OK Lets you save your changes and exit the screen.

Cancel Lets you exit the screen without saving your changes.

CUSTOMER BALANCE ADJUSTMENTS
When you need to adjust a customer’s balance, make an AR journal entry. Two examples of when
you'd make an AR journal entry include writing off a customer's bad debt and penalizing a customer for
writing a nonsufficient funds check.

Note: For information about customer historical and AR ledgers, see Customer Ledger/History Tab
on page 89.

To adjust a customer’s AR balance
1. Look up the customer whose balance you want to adjust. For more information, see Customer

Searches on page 93.

2. On the Customer Maintenance screen, click the Ledger/History tab.
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3. ClickOpen Item. The Open Item Ledger opens.

4. Click AR Journal Entry. The Customer Balance Adjustment screen opens.

5. Add the following information:

Select the date on which the adjustment should be applied, along with the discount date and
payment due date from the pop-up calendars.

Type a reference for the adjustment if needed.

6. Create the offset entry:

a. Click Add. A journal entry line appears underOffsets.

b. If you use the customer department method, click the Dept# column, press , and select the
appropriate department .

Click theMajor column, press , and select an account from the list.
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c. Type a description for the entry.

d. Type the amount of the adjustment.

Note: A positive amount increases the customer’s balance. A negative amount reduces the
customer’s balance. You can disregard entering a value in the Disc $ field.

7. To finish the adjustment, clickOK. A confirmation message appears.

8. Click Yes.
You can apply the adjustment to an invoice or another document right away or later. For more
information, see Apply an ROA on page 702.

CREDIT MEMOS
Occasionally, you might need to issue a credit memo to a customer who has provided a service to your
company but would prefer an in-store credit instead of a direct payment. For example, your computer
technician repaired a workstation and wants to be paid with an in-store credit. Issuing a credit memo
allows you to credit the customer’s account and record the expense in the GL.

To issue a credit memo
1. Click Invoicing. The OpenWork Order List opens.

2. Click Credit Memo. TireMaster prompts you for the customer’s name.
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Note: You can also create a credit memo from the Customer Maintenance screen. To begin, look
up the customer, click the Ledger/History tab, and click Credit Memo.

3. Look up the customer. For more information, see Customer Searches on page 93

4. On the Customer Balance Adjustment screen, do the following:

a. Add a reference number for the memo.

b. Click theMajor field, press , and select the general ledger account for the offsetting entry.

c. Type the amount of the credit as a negative number (for example, -89.00).

d. Make sure the amount in the Disc $ field is 0.00.
5. ClickOK. A confirmation message appears.

6. Click Yes. The Report Window opens.

7. Print the credit memo and click Close. The Open Item Ledger screen opens. You can apply the
credit in the same manner as an ROA, or leave it as an open item.

CUSTOMER REIMBURSEMENTS
When you reverse invoices or when customers return or trade in items, you might need to refund their
money. You can reimburse customers in the following ways:

Issue a cash refund

Issue a store credit

Issue a credit memo

Write a check
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Reverse a credit card payment

Typically, you reimburse customers in the same manner in which they paid you. When you create an
invoice for a return or trade-in, you need to define the payment method you’re using for the
reimbursement.

Tip: When customers pay by check, you might want to wait until the check clears before issuing a
reimbursement.

REIMBURSE WITH CASH
A cash reimbursement reduces the amount of cash you have on hand.

Warning: Do not use a paidout for a cash reimbursement. Reimbursing customers with cash from
the till does not update inventory quantities or the customer’s history.

To reimburse a customer with cash, create a work order with a negative total for a return or trade-in.
When you complete the invoice, give the customer the cash due.

ISSUE A STORE CREDIT
Issuing a store credit reduces the customer’s balance. To issue a store credit, create a work order with
a negative total for a return or trade-in and complete the invoice as a charge payment. You can apply
the reimbursement to the customer’s balance immediately or wait until later to apply it to a future
charge.

Tip: To issue the credit, you might need to change the customer’s status from cash-only to charge.

Note: If you have a customer who provides services to your company in exchange for in-store credit,
issue a credit memo. For more information, see Credit Memos on page 709.

REIMBURSE WITH A CHECK
For large reimbursements, you might want to write a check instead of giving a customer cash. To
reimburse a customer with a check, create an invoice with a negative total for a return or trade-in. Write
an AR easy check to the customer for the amount of the reimbursement. For more information, see
AR Easy Checks on page 782.

For TireMaster Point of Sale, write a check manually or with your bookkeeping software, and
adjust the customer’s balance for the amount of the check. For more information, see Customer
Balance Adjustments on page 707.

REVERSE A CREDIT CARD INVOICE
Credit card reversals reduce the accounts receivable for the credit card.

To reimburse customers with a credit card reversal
1. Create an invoice with a negative total for a return or trade-in.

2. Enter a negative amount for the credit card on the Invoice Completion screen.
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3. When the Card Authorization Box opens, process the credit card manually or automatically with
card processing software. For more information, see Complete a Credit or Debit Card Sale on
page 808.

4. To complete the invoice, clickOK.
Tip: Make sure to give the customer copies of the invoice and the credit card receipt.

FINANCE CHARGES
Finance charges are applied to outstanding customer balances during the month end closing process.
In TireMaster, you have the option to calculate finance charges on all outstanding invoices or only
those that are a certain age. For more information, see Finance Chrg Later than Day on page 1199.

APPLY FINANCE CHARGES
Before you perform the statement cutoff, you should apply any finance charges to outstanding
customer balances.

Note: Depending on your system control settings, finance charges might calculated only for invoices
that exceed a certain age. For more information, see Finance Chrg Later than Day on page
1199.

To apply finance charges
1. Select Closing > Statements > Apply Finance Charges. The Report Window opens and

displays the Finance Charge Edit Report.

2. Review the charges listed on the report.

Note: If you don’t want to assess finance charges for a customer listed on the report, close the Report
Window and click No when prompted to post the charges. Then look up the customer’s record
and clear the Finance Charge check box on theGeneral tab of the Customer Maintenance
screen.

3. Print the report if needed and close the Report Window. A confirmation message appears.

4. To post the finance charges, click Yes. A confirmation message appears.

Note: If you applied finance charges to a customer’s balance in error, see Reverse Finance
Charges on page 712.

REVERSE FINANCE CHARGES
If you applied a finance charge to a customer’s subledger account by mistake, you can reverse the
finance charge by creating a special type of ROA.



Finance Charges

To reverse a finance charge
1. Click Invoicing. The OpenWork Order List opens.

2. Click ROA. TireMaster prompts you for the customer's name.

3. Look up the customer whose finance charge you want to reverse, and clickOK on the Customer
Maintenance screen to continue. For more information, see Customer Searches on page 93.

4. On the ROA Entry screen, type the amount you want to reverse in the Rev. Finance Charge row.

5. To print a different number of copies, change the number in the # of Copies field.

6. Do the following as needed:

If you want the reversal to be applied to open invoices automatically, make sure the Apply
ROA check box is selected.

If you want the reversal to be applied to the oldest open invoices first, make sure the Flag Old
Invoices check box is selected.
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7. ClickOK. TireMaster prompts you to complete and print the ROA.

8. Click Yes. The Open Item Ledger opens.

9. Select the finance charge you want to reverse, and type an A in the Apply field.

Note: You might need to remove the A from one of the other fields. To remove the letter A from a
field, select it and press the space bar or Backspace key.

10. ClickOK. TireMaster prompts you to save your changes.

11. Click Yes. TireMaster prompts you to apply the items.
12. Click Yes.

STATEMENTS
If you have customers with in-store charge accounts, you need to send them regular statements so
they know their account balances and can make payments on their accounts.
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Note: During the going-online process, you should have set a starting date for statement cutoffs. The
date is changed in monthly increments, so your statement cutoff should occur on the same
date each month. For more information, see Statement Cutoff Date on page 1201 and
Statement Cutoff Date - Most Recent on page 1201.

STATEMENT PROPERTIES
Statements include balances and a list transactions affecting customer accounts, such as invoices,
finance charges, and payments.

Figure 23-2: A Customer Statement

Item Description

Date Displays the date of transactions affecting the customer’s balance since
the last statement cutoff.

Doc. No Displays the document numbers for transactions affecting the
customer’s balance since the last statement cutoff.

Amount Displays the original amounts for transactions affecting the customer’s
balance since the last statement cutoff.

Due Displays the amounts due for charges to the customer’s account since
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Item Description

the last statement cutoff.

Payments Displays the amounts of payments (as negative numbers) received from
the customer since the last statement cutoff.

PO# or Ref# Displays the purchase order number entered on an invoice, the
reference number entered on an invoice, or nothing. The entry, if any, for
this column is defined in the statement print options. For more
information, see Define Statement Print Options on page 722.

Due Date Displays the original due dates for invoices, finance charges, overdue
charges, and payments that have not been applied to the customer’s
account.

Balance Owing Displays the amount owed to you for transactions affecting the
customer’s balance since the last statement.

Current Displays the balance resulting from in-house charge and finance-charge
activity that occurred since the last statement cutoff. This balance also
includes the following:

Any negative charges that have not been fully applied to positive
invoices.

Any payments that have not been applied to the customer’s
balance.

Any balances that will be due on future statements (only when the
Include Future Due check box is selected on the Statement
Setup screen). For more information, see Define Statement Print
Options on page 722.

1–30 Displays any balances due as of the last statement.

31–60 Displays any balances due as of the second-to-last statement.

61–90 Displays any balances due as of the third-to-last statement.

91+ Displays any balances due for more than 90 days.

Total Due Displays the amount the customer owes you as of the statement cutoff
date.

Note: Any in-house charges and finance charges due in the future are
excluded from this amount.

STATEMENTS SCREEN
With the Monthly Statement screen, you manage the process of generating customer statements.
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Note: This screen is also used when producing real-time statements from the Report List (Customer
tab).

Figure 23-3: The Monthly Statement Screen

Item Description

Beginning
Customer

Lets you define the customer for the beginning of the customer range.

Ending Customer Lets you define the customer for the end of the customer range.

Customer Types Lets you define the types of customers for whom you’ll generate
statements. All types are selected by default.

Sites Lets you define the sites for which you’ll generate statements.

Load List Retrieves the customers who fall within the defined customer range and
match the selected customer types.

Customer Sites Generates statements only for customers who were added at the
selected site or sites.

Note: To use this option, at least one site must be selected.
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Item Description

Invoice Sites Generates statements for customers with invoices completed at the
selected site or sites.

Note: To use this option, at least one site must be selected.

All Displays customers with balances who receive statements and those
who do not.

Note: If you generate statements for customers with zero balances,
they’re included on the list. For more information, see Define
Statement Print Options on page 722.

Email Displays only the customers with balances who receive statements by
email.

Print Displays only the customers with balances who receive printed
statements.

Email or Print Limits the customers displayed to those with balances who receive
statements.

Cust# Displays system-assigned customer numbers.

Site # Identifies the site where customers were added.

Name Displays customer names.

Invoices Displays the number of transactional documents (such as invoices,
payments, finance charges, and credit memos) listed on statements .

Current Balance Displays the amount of money the customer owes you as of today.

Email Displays one of the following:

The last date on which a statement was emailed

Note: The Email field is blank for new customers who have not yet
been emailed statements. It is also blank prior to the first-
ever statement run, after updating to TireMaster 9.3.0.

None for customers who do not receive statements by email

Print Displays one of the following:

The last date on which a statement was printed

Note: For new customers, the Print field is blank until their
statements are printed. It is also blank prior to the first-ever
statement run, after updating to TireMaster 9.3.0.
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Item Description

None for customers who do not receive printed statements

Lets you access the Statement Setup screen.

Email Sends statements to customers who are assigned the email delivery
method.

Print Prints statements for customers who are assigned the print delivery
method.

Close Closes the Monthly Statement screen.

STATEMENT CONFIGURATION
Statement configuation includes customizing statement forms, preparing to send statements by email,
and defining how customers will receive their statements.

ADD A STORE LOGO (OPTIONAL)
You can add your store logo to the statement form. The logo image file used for statements needs to
meet the following requirements or recommendations:

The file extension must be .jpg

The dimensions of the logo should be small enough to fit in the limited amount of white space
in the statement header.

The file size cannot exceed 500 KB.

The resolution should be at least 300 DPI (dots per inch)

Note: Logo dimensions typically range from 150 x 150 pixels to 300 x 300 pixels. The typical
logo file size is 10 KB to 15 KB, and the resolution is typically 300 DPI.

Before you add the logo, note its dimensions. You’ll use this information when adding it to the
statement form.

To add a logo to the statement form
1. Prepare to load the logo.

a. If the logo isn’t already stored on your computer, save a copy of it on the computer’s desktop
or in a folder.

Note: To successfully add a logo to statements, the logo image file must be retrieved from
your local computer instead of the network.

b. Right-click the image’s file name and select Properties. The properties screen opens.
c. Click the Details tab. Then locate the height and width, and write down those values.
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2. Open the Statement Setup screen.

a. Select Closing > Statements > Print. The Monthly Statements screen opens.

b. Click .

3. Click Load Logo, go to the location on your computer where the logo is stored, and select it.

Note: Logo file format is set to .jpg and the logo is saved in the TireMaster database.

4. Define the position of the logo.

a. In the Left Position field, type the number of pixels from the left edge of the available print
space where the logo will be placed.

Note: Available print space is the area on a page on which text and images can be printed.
Because printers do not print at the edges of a page, available print space does not
extend to page edges.

b. In the Top Position field, type the number of pixels from the top edge of the available print
space where the logo will be placed.
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5. Referring to the dimensions recorded in step 1c, type the height and width of the logo.

6. Review the placement of the logo.

a. Click Lookup Customer and search for a customer who receives statements.

b. Click Test Logo. The Report Window opens and displays a sample statement.

c. If the logo position needs to be adjusted, change the position values.

d. If the logo needs to be resized, change the dimensions in an image-editing program. Then
reload the logo and update the values in theWidth and Height fields. Examples of image-
editing programs include Microsoft® Paint, Tech-Smith® Snag-It, and GIMP.

e. Click Test Logo (again) to review your changes.

f. Repeat steps 6c through 6e until you’re satisfied with the sample statement’s appearance.

7. Click Save Logo.
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Note: When you re-open the Statement Setup screen after completing the logo configuration,
the file name for the logo will no longer be in the Load Logo field. Although the file name
is not visible, the logo will continue to be used on statements because it’s stored in the
TireMaster database.

DEFINE STATEMENT PRINT OPTIONS
By setting the statement print options, you define the type of information that prints on statements
and whether to generate statements for customers with $0 balances.

To set the statement print options
1. Open the Statement Setup screen.

a. Select Closing > Statements > Print. The Monthly Statements screen opens.

b. Click .

2. Select the following as needed:

To include customer payment terms on statements, select Print Customer Terms.
To define whether customer purchase order or reference numbers print on statements, select
PO# or Ref#. To exclude PO numbers and reference numbers, select None.
To include customer fax numbers on statements, select Print Customer Fax.
To include customer email addresses on statements, select Print Customer Email
address.
To include future due balances on statements, select Include Future Due.



Statements

Note: You can override this setting for individual customers in the configuration of their
payment terms. For more information, see Customer Payment Terms on page 94.

To use the customer’s payment due date as the due date for finance charges, select Age
Fin. Charge by Due Date. To use the statement cutoff date as the due date for finance
charges instead, clear the Age Fin. Charge by Due Date check box.
To include site information on statements instead of the information for the corporate site,
select Print Site Header.
To generate statements for customers with $0 balances, select Print 0 Balances.
To include your business address on statements, select Statement - Print Address.
To generate the statement as of the last statement cutoff date, select the Statement - Print
from Cutoff check box. For a statement as of today’s date, clear the Statement - Print from
Cutoff check box.
Type the number of days that need to pass before previously-generated statements can be
printed or emailed again in the Statement - Days After Cutoff field. This value is set to 25 by
default.

Note: The purpose of this setting is to prevent you from accidentally emailing or printing
another set of statements after you’ve already generated them. If you need to resend
or reprint a statement, you can override this setting. For more information, see
Regenerate Statements on page 734.

To include a message in the statement header (underneath the word STATEMENT at the top
of the page), type the message in the Statement - Verbiage field.
Note: The Statement - Verbiage field holds up to 1024 characters. However, for best

results, keep the message brief.
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3. Click Save.

CONFIGURE STATEMENT EMAIL
Define the email address that will be used for sending statements to customers and customize the
subject and body text for statement emails.

To complete statement email configuration
1. Select Setup > Printers. The Printer Selection screen opens.

2. Click E-Mail Options.

Statements_PrintOptions1.png
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3. On the left side of the screen, select the name and email address that emails will be sent from.

4. In the lower-right corner of the screen, select the Statements check box and click Save.

Note: In addition to defining the address for sending emails, this setting also enables the ability
to email statements from TireMaster.

5. Update the subject and body text for statement emails (optional).

a. Click Verbiage. The E-Mail Verbiage Setup screen opens.

b. Under Documents, select Statement.
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c. Type the subject line and body text for statement emails in the applicable fields.

d. Click Save.

6. Close the open screens.

DEFINE THE STATEMENT DELIVERY METHOD FOR CUSTOMERS
Settings in individual customer records define whether customers receive printed statements,
emailed statements, or emailed statements and the corresponding invoices. For customers who
receive statements by email, you also need to define the email addresses to which statements will be
sent.

To define a customer’s statement delivery method
1. Search for the customer whose statement delivery method you want to define. For more

information, see Customer Searches on page 93.

2. On the Customer Maintenance screen, click Edit.
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3. Under Statement, select one or more of the following delivery methods:
For a hard copy of a statement to send by US mail, select Print.
To send a statement by email, select Email.
To send a statement and copies of the documents listed on the statement, select Email &
Invoices.
For a customer who does not receive statements, clear the Print, Email, and Email &
Invoices check boxes.

4. If the customer will receive statements by email, define the email addresses to which the
statements will be sent. If the customer will receive only printed statements, disregard this step.

a. Click Emails. The Customer Statement screen opens.

b. Do the following as needed:

To send statements to an email address that’s in the customer’s contact information, click
Select Email and choose a name from the list that appears. Repeat as needed.
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To send statements to an email address that’s not in the customer’s contact information,
click Add. Then type the email address and a name (or description) of the email address
in the screen that opens, and clickOK. Repeat as needed.

Note: If you need to correct an email address, select it and click Edit. Then make your
changes and clickOK. If the email address is included in the customer’s contact
information, TireMaster will prompt you to update the contact email as well.

c. Close the Customer Statement screen.

5. On the Customer Maintenance screen, clickOK to save your changes. Then click Close.

UPDATE CUSTOMER STATEMENT EMAIL ADDRESSES
Occasionally, you might need to change the email addresses used to distribute statements to
existing customers. The following functionality is available in TireMaster 9.4.0.

To update a customer’s statement email addresses
1. Search for the customer whose statement email addresses needs to be updated. For more

information, see Customer Searches on page 93.

2. On the Customer Maintenance screen, click Edit.
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3. Click Emails. The Customer Statement screen opens.

4. Use the following options to update the email addresses:

To add an email address that’s in the customer’s contact information, click Select Email and
choose a name from the list that appears.

To add an email address that’s not in the customer’s contact information, click Add. Then
type the email address and a name (or description) of the email address in the screen that
opens, and clickOK.
To update (or correct) an existing email address, select it and click Edit. Then make your
changes and clickOK.
Note: If the edited email address is included in the customer’s contact information,

TireMaster will prompt you to update the contact email as well.

To remove an existing email address, select it and click Delete.

5. When you’re done making changes, close the open screens.

PROCESS STATEMENTS
Processing statements include applying finance charges, performing the statement cutoff, and
generating printed statements and statement emails.
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APPLY FINANCE CHARGES
Before you perform the statement cutoff, you should apply any finance charges to outstanding
customer balances.

Note: Depending on your system control settings, finance charges might calculated only for
invoices that exceed a certain age. For more information, see Finance Chrg Later than Day
on page 1199.

To apply finance charges
1. Select Closing > Statements > Apply Finance Charges. The Report Window opens and

displays the Finance Charge Edit Report.

2. Review the charges listed on the report.

Note: If you don’t want to assess finance charges for a customer listed on the report, close the
Report Window and click No when prompted to post the charges. Then look up the
customer’s record and clear the Finance Charge check box on theGeneral tab of the
Customer Maintenance screen.

3. Print the report if needed and close the Report Window. A confirmation message appears.

4. To post the finance charges, click Yes. A confirmation message appears.

Note: If you applied finance charges to a customer’s balance in error, see Reverse Finance
Charges on page 712.

CUT OFF STATEMENTS
Once you’ve applied finance charges, you can run the statement cutoff. This process ages customer
balances. You should perform this procedure on the same day every month.

To cut off customer statements
1. Generate a Customer Balance Report and review your customers’ balances (optional). For more

information, see Customer Balance Report on page 1105.

Note: Because the statement cutoff ages balances, the amounts listed on this report are
displayed in different buckets than those on the statements. Therefore, you might also
want to print the report once the statement cutoff is complete.

2. Select Closing > Statements > Cutoff. TireMaster prompts you to print an unapplied credit
report.
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3. Click Yes. The Report Window opens and displays the Unapplied Credit Report.

4. Print the report or view it on the screen.

Note: If the report lists any unapplied credits, close the Report Window and click No when
prompted to continue the statement cutoff. Then apply the credits to the appropriate
customer balances, if possible. For more information, see Apply an ROA on page 702.

5. Close the Report Window. A confirmation message appears.

6. Click Yes. Another confirmation message appears.
7. ClickOK.

GENERATE CUSTOMER STATEMENTS
Once you’ve completed the cutoff, you can generate statements to send to customers as part of your
monthly billing cycle. When you generate customer statements, you can produce them for all
customers or limit the statement run to those who meet specific requirements. Then you can send
statement emails and print the hard copies. Statements can be generated with corporate-wide
balances or balances for an individual site.

Note: Various factors can affect the balances of statements that are printed for a site. For example,
if an ROA is entered at the corporate site and it is not applied toward the customer’s balance,
the ROA will not be included on the statement printed for a site.

To generate statements
1. Open the statements screen using one of the following methods:

Select Closing > Statements > Print.

Click Reports to open the Report List. Click the Customer tab, select Real-time Statements,
and click Launch.
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2. To define whether all customers, a group of customers, or individual customers will receive
statements, do one of the following:

For all customers, leave all of the fields blank.

For one customer, click Beginning Customer and look up the customer for whom you want
to generate a statement.

For a range of customers, click Beginning Customer and search for the first customer in the
range. Then click Ending Customer and search for the last customer in the range.
For specific customer types, click Customer Types. Then select one or more types from the
list that appears and clickOK.
Note: For multiple types, press the Ctrl key while making your selections.

For transactional activity from specific sites, click Sites and select one or more sites from the
list that appears. Then select Customer Sites to print statements for customers added at the
selected site(s), or select Invoice Sites to print statements for customers for with invoices
completed at the selected site(s).

Note: For multiple sites, press the Ctrl key while making your selections.

3. Click Load List. TireMaster adds the names and account balances for the customers who will
receive statements to the screen.
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The colors, codes, and dates in the Email and Print columns indicate the following:
The color green means a statement can be generated for a customer

The color red means a statement has been printed or emailed to a customer

The code Nonemeans the delivery method is not used for a customer

The date is the date when a statement was last emailed or printed.

Note: The Email field is blank for new customers who have not yet been emailed
statements. It is also blank prior to the first-ever statement run, after updating to
TireMaster 9.3.0.

4. If you want to narrow down the number of customers displayed, do one of the following. By
default, all customers with balances are displayed regardless of whether they receive
statements.

Note: If you generate statements for customers with zero balances, they’re also listed. For
more information, see Define Statement Print Options on page 722.

For only the customers with balances who receive statements by email, select Email.
For only the customers with balances who receive printed statements, select Print.
For customers with balances who receive statements, select Email or Print.

5. Generate the statements.

a. Click EMail. TireMaster emails statements to customers assigned the email delivery method.
Note: Distributing statements by email can last several minutes to several hours,

depending on the number of customers receiving statements by email. The PDFs of
statements and duplicate invoices that are emailed to customers are available in the
Out folder in your TireMaster program directory.

733



734

User Guide

b. Click Print. Statements for customers assigned the print delivery method are sent to the
printer.

Once a customer’s statement is printed or emailed, the Print field, Email field, or both turn red
(depending on the customer’s delivery method) and the statement-generation date appears.

6. If you experience an issue such as a printer jam or an email failure, resend the affected
statements as needed. Otherwise, disregard this step. For more information, see Regenerate
Statements on page 734.

7. Close the statements screen.

REGENERATE STATEMENTS
Statements can be reprinted or resent to customers if they need duplicates or if you encountered an
issue during a statement run.

To regenerate statements
1. If the statement screen isn’t already open, select Closing > Statements > Print.
2. Define the customer or customers for whom you want to regenerate statements.

3. For each statement that needs to be resent, double-click the red field in the Email or Print column.

4. If any of the statements need to be delivered by email, click Email. Otherwise, disregard this step.
5. If any of the statements need to be delivered by the postal service, click Print. Otherwise,

disregard this step.

6. Close the statement screen.
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GENERATE A DUPLICATE SET OF STATEMENTS
A duplicate, or second, set of statements can be printed if you need a set to send to customers and
one to keep on file.

Note: The ability to generate a duplicate set of statements is available in TireMaster 9.3.1 (also
known as 9.3.0.183 SP1) and newer.

To generate a duplicate set of statements
1. Print the first set of statements. For more information, see Generate Customer Statements on

page 731.

2. Press the Ctrl key and double-click one of the entries in the Print column.

3. When TireMaster prompts you to reverse the entire column, click Yes. The red column entries (for
customers who received printed statements) change to green.

4. Click Print to generate the second set of statements.
Note: When none of your emailed statements are sent, you can use a similar process to resend the

entire statement run. In that scenario, press the Ctrl key and double-click one of the entries in
the Email column instead. Then you can email the statements again.

MONTHLY STATEMENT SCREEN
With the Monthly Statement screen, you manage the process of generating customer statements.

Note: This screen is also used when producing real-time statements from the Report List (Customer
tab).
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Figure 23-4: The Monthly Statement Screen

Item Description

Beginning
Customer

Lets you define the customer for the beginning of the customer range.

Ending Customer Lets you define the customer for the end of the customer range.

Customer Types Lets you define the types of customers for whom you’ll generate
statements. All types are selected by default.

Sites Lets you define the sites for which you’ll generate statements.

Load List Retrieves the customers who fall within the defined customer range and
match the selected customer types.

Customer Sites Generates statements only for customers who were added at the
selected site or sites.

Note: To use this option, at least one site must be selected.

Invoice Sites Generates statements for customers with invoices completed at the
selected site or sites.

Note: To use this option, at least one site must be selected.
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Item Description

All Displays customers with balances who receive statements and those
who do not.

Note: If you generate statements for customers with zero balances,
they’re included on the list. For more information, see Define
Statement Print Options on page 722.

Email Displays only the customers with balances who receive statements by
email.

Print Displays only the customers with balances who receive printed
statements.

Email or Print Limits the customers displayed to those with balances who receive
statements.

Cust# Displays system-assigned customer numbers.

Site # Identifies the site where customers were added.

Name Displays customer names.

Invoices Displays the number of transactional documents (such as invoices,
payments, finance charges, and credit memos) listed on statements .

Current Balance Displays the amount of money the customer owes you as of today.

Email Displays one of the following:

The last date on which a statement was emailed

Note: The Email field is blank for new customers who have not yet
been emailed statements. It is also blank prior to the first-
ever statement run, after updating to TireMaster 9.3.0.

None for customers who do not receive statements by email

Print Displays one of the following:

The last date on which a statement was printed

Note: For new customers, the Print field is blank until their
statements are printed. It is also blank prior to the first-ever
statement run, after updating to TireMaster 9.3.0.

None for customers who do not receive printed statements

Lets you access the Statement Setup screen.

Email Sends statements to customers who are assigned the email delivery
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Item Description

method.

Print Prints statements for customers who are assigned the print delivery
method.

Close Closes the Monthly Statement screen.

BEGINNING BALANCES
When you go online, you need to enter the outstanding customer balances from your previous system.
The application that you use to enter these balances in TireMaster is called the Customer Balance -
Startup Utility, which is referred to as Cbal.

ENTER A CUSTOMER'S BEGINNING BALANCES
With the Cbal utility, you can enter outstanding customer balances from your previous system into
TireMaster. You can add entries to Cbal in one of the following ways:

Make an entry for the lump sum of each aging breakdown (such as future, current, or 1–30).

Make an entry for each payment owed to you. If a customer has four invoices and is set up for
two installments for each invoice, you would need eight entries.

Note: The last statement cutoff in System Controls needs to be set to two months before you go live.
So if you go live October 1, set the last statement cutoff to August. 25.

To enter a customer’s beginning balances
1. Generate a report of customer balances from your previous system.

2. Open the Cbal utility.

a. Select Help > Cust Begin Balance. The Cbal login prompt appears.

Note: You can also access the Cbal utility from the TireMaster program folder. Open the local
disk drive in which TireMaster is installed (usually D: or C:), and double-click
(TireMaster, qdstm, or tmpos program folder. The double-click cbal.exe.

b. Type your user ID and password, and clickOK. TireMaster prompts you for the customer's
name.
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3. Look up the customer whose beginning balances you want to enter. For more information, see
Customer Searches on page 93.

4. For each balance you need to enter, do the following:

a. Click Add Invoice. The Add Invoice screen opens.

b. For the reference, type Beginning Balance.

c. If you’re entering a lump sum for an aging breakdown, type the statement cutoff date in the
Invoice Date field. If you’re entering individual invoices instead, type the invoice date for the
invoice you’re entering.

d. Type the date when payment from the customer is (or was) due in the Due Date field. This
date will be used to age the balance.

e. Type the balance due for the aging breakdown or invoice in the Charge field.
f. To save the entry, clickOK.

5. If you’re at the corporate site, select the store that the entry is for and clickOK (TireMaster
Corporate only).

6. When you’ve entered all of the customer’s balances, click Complete Adjustments.

7. To enter balances for another customer, click Pick Customer and repeat steps 3 through 6.
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8. To close the Cbal utility, click Exit.

9. When you’re done entering balances, print the Customer Balance Report from TireMaster and
compare it to the customer balances from your previous system to verify that they match. For more
information, see Customer Balance Report on page 1105.

CBAL UTILITY
Entering customer beginning balances with the Cbal utility automatically debits the general ledger’s
AR account and credits the offset balances directly to the Startup AR account. Cbal entries also post to
the selected customer’s ledger.

Note: The Cbal utility is only to be used during the going-online process to enter outstanding
customer balances from your previous system.
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Figure 23-5: Customer Balance - Startup Utility

Item Description

Blank fields Display a customer’s name, site, and the system-assigned customer
number.

Pick Customer Lets you look up a customer.

Balance Displays the total amount a customer owes you.

Current Displays a customer’s current balance.

Future Displays the balance that will appear as current on a customer’s next
statement.

GL Offset
Account

Displays the general ledger account used for posting AR beginning
balances.

Note: In the startup database, this account is 3999-100. However, you
can select a different account in System Controls.

1-30 Displays the balance due as of a customer’s last statement.

31-60 Displays the balance due as of a customer’s second-to-last statement.
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Item Description

61-90 Displays the balance due as of a customer’s third-to-last statement.

Over 90 Displays any balances due for more than 90 days.

SITE Displays the number for the site where the Cbal entry is being made.

KEY Displays the document type code XX, which identifies Cbal entries and
adjustments to the customer’s balance.

INVOICE Displays the system-generated number for the Cbal entry.

EFFECT Identifies the site where the Cbal entry takes place.

REF Lets you enter reference number for the Cbal entry.

INVDATE Lets you enter the date when the invoice or balance was completed.

DUEDATE Lets you enter the due date for the invoice or balance.

CHARGE Lets you enter the amount for the entry.

Add Invoice Lets you add a new entry.

Edit Invoice Lets you change the reference number, dates, or charge amount for an
invoice that hasn’t been posted.

Delete Invoice Lets you delete the selected entry.

Complete
Adjustments

Lets you post a customer’s beginning balance entries.

Exit Lets you close the screen.



ACCOUNTS PAYABLE
With TireMaster, you can track your supplier balances and manage vendor payment activity. This
chapter includes the following sections:
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VENDOR CHARGES
Vendor charges are used to record purchases that aren't received through the PO system. Rent,
utilities, and janitorial services are examples of purchases entered with vendor charges. The document
type code VC identifies vendor charges. Vendor charges increase (credit) the balance of a vendor’s
subledger and the general ledger’s accounts payable account.

Vendor charges can also be used to record credits or reimbursements from vendors. In this scenario,
you enter the invoice total as a negative amount and refer to the entry as a vendor credit.

ENTER A VENDOR CHARGE
When a vendor sends you an invoice or a credit memo, enter it in TireMaster by creating a vendor
charge.

Note: Users at the corporate site can create vendor charges for all stores. Users at a store, however,
can only create vendor charges for that store.

To enter a vendor charge
1. Select Vendors > Charges. The Vendor Charges screen opens.

Note: If you want to limit the charges displayed to those for a specific vendor, click Lookup and
search for the vendor. Then click the Limit check box. For more information, see Vendor
Searches on page 193.

2. Click New. TireMaster prompts you to search for the vendor.

3. Look up the vendor. For more information, see Vendor Searches on page 193.

4. Add the following information to the charge.

a. Select the site to which you want to post the charge.

b. Select the charge date, discount date, and payment due date from the pop-up calendars.

c. Type a reference number for the charge.
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5. Create the offsetting entry.

a. Click Add. A journal-entry line appears underOffsets.

Note: If the vendor is assigned a default GL account, the journal entry line and account
number are added automatically.

b. Click theMajor field, press , and select the account that the offsetting entry will post to.

c. Type a description for the entry.

d. Type the amount.

Note: If you’re receiving a credit or reimbursement from the vendor, type a negative number
(such as -55.55).

e. If the charge is for a transfer, a national account sale, a government support sale, or a defect
adjustment, click the CL column, press and select the appropriate GL class.

6. If you do not want to take a discount for the charge, type 0.00 in the Disc $ field.
7. To save the charge, clickOK .
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8. When the confirmation message appears, click Yes. The charge is added to the Vendor Charges
screen.

9. If you want to create another charge, click New and use the same vendor or look up a different
vendor. Then repeat steps 4 through 7.

10. To complete the charge (or charges), clickOK. prompts you to print the Charge Edit Report.

Note: To complete the charges for a single vendor, click Lookup and look up the vendor’s name.
Then click the Limit check box.

11. For a copy of the report, click Yes and print it. Otherwise, click No.
12. When the confirmation message appears, click Yes.

PROCESS VENDOR CHARGES IN BATCHES
If you process a high volume of charges for a vendor, you might want to process that vendor’s changes
in a batch. The charges in a batch can be completed as soon as they’re entered, or you can save the
batch and add new charges to it later. Because TireMaster keeps a running total of all the charges in a
batch, you can easily compare that total to the statement issued by the vendor.

CREATE A BATCH OF VENDOR CHARGES
You can create a group of charges for a single vendor. The charges can be completed right away or
saved for processing at a later time. Batches created at one site can include charges for other sites.

To process a batch of vendor charges
1. Select Vendors > Charges. The Vendor Charges screen opens.

2. ClickManage Batches. The AP Batch Charges screen appears.
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Note: You can also open the AP Batch Charges screen by clicking in the Batch field and
pressing .

3. Create a batch for the group of charges you need to process:

a. Click New Batch and select a vendor from the list. The Batch Description screen opens.

b. Type a name for the batch and clickOK.

c. To close the AP Batch Charges screen, clickOK. The Vendor Charges screen opens.

4. Enter each charge for the new batch:

a. Click New. TireMaster prompts you to use the selected vendor

b. Click Yes. TireMaster prompts you to use the selected batch.
c. Click Yes. The Vendor Charge screen opens.
d. Create one or more charges for the vendor. For more information, see Enter a Vendor Charge

on page 744.
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5. When you’re done entering each charge, clickOK. TireMaster prompts you to print the Charge Edit
Report.

6. Click Yes. The Report Window opens.

7. Print the report and close the Report Window. TireMaster prompts you to complete the charges.

8. To finish processing the batch of charges now, click Yes. To save the batch of charges, click No.
Then click Cancel to exit the Vendor Charges screen.

RETRIEVE A BATCH OF VENDOR CHARGES
If you saved a batch of vendor charges, you can easily retrieve it. in TireMaster Corporate, users at the
corporate site can view completed batches for all sites, while users at a store can retrieve batches
created and completed at that store only.

To retrieve a batch of vendor charges
1. Select Vendors > Charges. The Vendor Charges screen opens.

2. ClickManage Batches. The AP Batch Charges screen appears.

Note: If you know the batch number, you can type it in the Batch field and skip the remaining
steps.



Process Vendor Charges in Batches

3. Select the batch you want to update. If you can’t find the batch you’re looking for, do the following
as needed:

Select a different sort order from drop-down.

Select a different batch status from the drop-down.

Display batches for a single vendor. Click next to the Vendor field and select a vendor from
the list.

Note: Users a the corporate site can view completed batches for all sites by selecting Sort by
Site, Batch # from the Sort Order drop-down and Show All from the Batch Status drop-
down.

4. ClickOK. The Vendor Charges screen opens. You can add more charges to the batch, delete it,
view its totals, or finish processing it.

UPDATE A BATCH OF VENDOR CHARGES
If you’ve saved a batch of vendor charges, you can update it by adding or removing charges.

To update a batch of vendor charges
1. Look up a batch of vendor charges. For more information, see Retrieve a Batch of Vendor Charges

on page 748.

2. To add a new charge to the batch, do the following.

a. Click New.

b. Click Yes when prompted to use the selected vendor.
c. Click Yes when prompted to use the selected batch.
d. Select the charge date, discount date, and payment due date from the pop-up calendars.

e. Type a reference number for the charge if needed.

f. Click Add and make the offsetting entry for the charge. For more information, see Enter a
Vendor Charge on page 744.

749



750

User Guide

3. To remove a charge from the batch:

a. Select the charge you want to remove and click Delete.

b. Click Yes to confirm that you want to remove the selected document from the batch.

c. Click Yes to confirm that you want to delete the document.

4. When you’re finished updating the batch of charges, close the Vendor Charges screen or process
the charges. For more information, see Create a Batch of Vendor Charges on page 746.

ADD CHARGES TO A BATCH
If you have several individual charges for a particular vendor that haven’t been completed, you can add
them to an existing batch for that vendor.

To add a charge to a batch
1. Select Vendors > Charges. The Vendor Charges screen opens.

2. Select the charge you want to assign to a batch and click Edit. The Vendor Charge screen opens.
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3. Click the Batch field and press . The AP Batch Charges screen opens.

Note: If you know the batch number, you can type it in the Batch field and go to step 5.

4. Select the batch you want to assign the charge to and clickOK. A confirmation message appears.

Note: Only batches for the vendor assigned to the selected charge are displayed.

5. Click Yes to return to the Vendor Charge screen.
6. ClickOK. TireMaster prompts you to save the charge.
7. Click Yes.

Tip: To verify that the charge was added to the batch, view the batch details. For more
information, see View a Batch of Vendor Charges on page 751.

VIEW A BATCH OF VENDOR CHARGES
When a vendor sends you a statement, compare it to your records in TireMaster Corporate. You can
view the running total for a batch and the individual charges for it on the AP Batch Details screen.
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Tip: If you know the batch number for the batch you want to view, type the number in the Batch field
on the Vendor Charges screen to display the charges and the total for the batch.

To view a batch of vendor charges
1. Look up a batch of vendor charges. For more information, see Retrieve a Batch of Vendor Charges

on page 748.

2. Select the batch you want to see, and click View Details. The AP Batch Details screen opens.

Tip: If you don’t see the batch you want to view, select a different sort order, batch status, or
both from the drop-downs.

3. To see the entries that posted to the general ledger for a charge, select the charge and click
Research.

Note: Journal entries can be viewed only for batches whose charges have been processed
(completed).

4. To close the AP Batch Details screen, clickOK.

DELETE A BATCH OF VENDOR CHARGES
If you no longer need a particular batch of vendor charges or if you created a batch in error, you can
delete it. Only unlocked batches can be deleted.



PO Charges

To delete a batch of vendor charges
1. Look up a batch of vendor charges. For more information, see Retrieve a Batch of Vendor Charges

on page 748.

2. Select the batch you want to delete, and click Delete Batch.

Note: If you don’t see the batch you want to delete, select different sort order, batch status or
both from the drop-downs.

3. To confirm that you want to delete the batch, click Yes.
4. To confirm that you want to delete the charges included in the batch, click Yes. To delete the batch

only, click No.The charges that were once part of the batch are listed individually on the Vendor
Charges screen.

PO CHARGES
PO charges are entries that post to vendor accounts automatically when purchases are completed in
TireMaster's PO System. The document type code PO identifies PO charges. For information about
completing PO charges, see Inventory Receipts on page 274.

AP PAYMENTS
TireMaster includes tools for paying your vendors and applying those payments, along with any credits
you’ve received, to the applicable account balances.

GENERATE AP PAYMENTS
You can efficiently generate payments for a group of vendors with the AP Payments module. With this
application, payments are automatically applied to the applicable vendor balances. When you process
AP payments, you can print checks to give to your vendors or you can record payments that were
made with debit cards or your bank’s online bill pay application.

Note: You can also pay vendors with AP easy checks. For more information, see Easy Checks on
page 780.
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To generate a group of AP payments
1. Select Vendors > AP Payments. The AP Payments screen opens.

2. To sort the documents on the screen, select the Due, Name, Ref, and Invoice Date (available in
TireMaster 9.4.0) check boxes. Select the check box for the primary organization method first,
followed by the others from most to least important. Numbers appear next to the check boxes
based on the order in which they’re selected.

Note: By default, the charges are sorted alphabetically by name.

3. To display only the charges that need to be paid by a certain date, type the number of days until
that date in the Show Next ____ days field. Then click Refresh.

4. To display only the charges for a single vendor, click Vendor and look up the vendor. For more
information, see Vendor Searches on page 193.

Tip: If you decide to display payments for all vendors, click Vendor. Then click Cancel on each
of the two screens that open.

5. Define which charges you want to pay and the payment amounts.

a. For each charge you want to pay, type an A in the PAY field.
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Tip: To mark payments for all charges, clickMark All. To unapply charges, click UnMark
All or UnMark. You can also unmark individual charges by clicking the A in the PAY
field and pressing the Space Bar.

b. Change the payment and discount amounts as needed.

6. Complete the payment.

a. ClickOK. A confirmation message appears. If

b. Click Yes to confirm that you want to process the payment. The Pending Payment Check
Listing opens.

Note: If you decide that you do not want to generate the payment for one of the vendors
listed, clear the check box in the Print field for that vendor.

c. To generate a Check Edit Report, click Report. Then print the report and close the Report
Window.

d. If you want to generate checks to give to the vendors, make sure the Print Checks check box
is selected. If the payment was processed with a debit card or your bank’s online bill pay
application, clear the check box.

7. Click Print.
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8. Click Yes. One of the following occurs:
If you printed checks, TireMaster prompts you to verify the checks printed okay. If they did, click
Yes and generate a check detail report (if needed). If you need to reprint the checks, click No
and follow the on screen instructions.

If you didn’t print checks, generate the check detail report (if needed).

Note: Depending on a system control setting, TireMaster either returns to or closes the AP
Payments screen. For more information, see Print Checks Return to AP Payments.

APPLY PAYMENTS AND CREDITS TO VENDOR BALANCES
Once you’ve made payments to or received credits from a vendor, you can apply those items to the
vendor’s balance.

To apply payments and vendor credits
1. Select Vendors > Maintenance. TireMaster prompts you for the vendor's name.

2. Look up the name of the vendor whose payment and credits you want to apply. For more
information, see Vendor Searches on page 193.

3. On the Vendor Maintenance screen, click the Ledger/History tab.

4. ClickOpen Item. The Payment Editing screen (the vendor's open item ledger) opens.
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5. To sort items on the screen, select Ref#, Due Date, or Site#.
6. Apply items to the outstanding charges.

a. Select the payment or credit you want to apply to a purchase order or vendor charge, and type
A in the Apply field.

b. Select one or more purchase orders or vendor charges that you want to apply the payment or
credit to.

c. Type the amount you want to apply in the Pay field, and press Enter. The letter A appears in
the Apply field.

d. Type the amount of the discount you want to take, if any, in the DiscAmt field.

Tip: If you plan to apply the full amount and take the full discount, you can type A in the
Applyfield instead.

7. ClickOK. TireMaster prompts you to save your changes.

8. Click Yes. TireMaster prompts you to apply the items.
9. To apply the items now, click Yes. If you click No, you can open to the vendor’s Payment Editing

screen and apply them later.

UNAPPLY PAYMENTS AND CREDITS IN A VENDOR’S SUBLEDGER
Unapplying items in a vendor’s subledger can be done in one of the following ways:

You can unapply items that are marked to be applied, by clearing the letter A from the Apply
field on the Payment Editing Screen on page 760 (the vendor’s open-item ledger). To clear the
letter A, click the Apply field, and press the space bar or the Backspace key.
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You can unapply AP Payments checks by voiding them. For more information, see Void an AP
Payment on page 797.

AP PAYMENTS SCREEN
The AP Payment screen (Figure 24-1) lists the outstanding charges (purchase orders and vendor
charges) for your vendors. It also provides the means to apply payments to those charges and
generate payment checks.

Figure 24-1: AP Payments Screen

Item Description

Account Displays the bank accounts you’ve set up in TireMaster.

Balance Displays the current balance for the selected account.

End Balance Displays the projected ending balance after the total from all applied
items is deducted from the selected checking account.

Due Lists charges from oldest due date to newest due date.
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Item Description

Name Lists charges alphabetically by vendor name.

Ref Lists charges in numerical order by reference number (REF column).

Invoice Date Lists charges from oldest invoice date to newest invoice date. Available
in TireMaster 9.4.0.

# Checks Displays the number of pending checks.

Note: Only one check is created for each vendor. If you want to print
separate checks for a vendor, apply each payment and print the
resulting checks one at a time.

Search Lets you locate documents with criteria including vendor name, invoice
number, reference, charge amount, unapplied amount, paid amount,
address, and city. Available in TireMaster 9.4.0.

Discounts Displays the total discount amount for all payments that are marked to
be applied.

Total Check $ Displays the total check amount for all payments that are marked to be
applied, minus any discount amounts.

Total Displays the total amount of the check plus any discounts.

# Applied Displays the number of vendor accounts to which payments have been
applied.

Total Neg $ Displays the total amount of credits applied to one or more vendor
accounts.

Mark All Lets you quickly mark all payments to be applied.

Note: When all items are marked, the name of this button changes to
UnMark All.

UnMark Lets you remove the selected payment, all payments, or payments for a
specific vendor.

Tip: You can also unapply a payment by selecting the A in the PAY
column for that payment and pressing the Backspace key or
Space Bar.

Vendor Lets you display the charges for a particular vendor.

Note: To display all vendors again, click Vendor and then click Cancel
twice.
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Item Description

Totals Displays the total amount owed to each vendor for the items applied.

Show Next ____
days

Lets you specify and view the payments that are due within a certain
number of days.

Refresh Updates the table after you change the Show Next ___ days value.

OK Accepts items marked to be applied.

Cancel Exits the screen without saving any changes.

PAYMENT EDITING SCREEN
You can apply payments and credits to vendor balances on the Payment Editing screen (Figure 24-2).
This screen, which is also referred to as a vendor’s open item ledger, lists all outstanding items in the
vendor’s subledger.

Figure 24-2: Payment Editing Screen

Item Description

Sort Lets you organize items on the screen by either reference number or
due date.

Discount Displays the total of any early pay discounts for the PO and vendor
charges that payments and credits are being applied to.

Check Amount Displays the amount that you can still apply. When you finish applying a
payment or vendor credit to a PO or vendor charge, the amount is 0.00.

Search Lets you narrow down the documents displayed by invoice number,
reference number, or amount.

Total Amount Paid Displays the sum of the amounts in the Discount and Check Amount
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Item Description

columns.

Site Identifies the site where a transaction was generated.

Mod Identifies the item with one of the following document type codes:

PO is for PO charges

VC is for vendor charges (positive amounts) and vendor credits
(negative amounts)

EC is for easy checks

PY is for payments

Invoice Displays the system-generated number for the charge, payment, or
credit.

Ref # Displays the reference number for the charge, payment, or credit.

Amount Displays the amount for the charge, payment, or credit. For PO charges
that are set up for multiple payments, each installment is displayed
separately by due date.

UnApplied Displays the amount for the transaction that has not yet been applied.

DueDate Displays the due date for the charge, payment, or credit.

Note: Vendor terms are used only in TireMaster Plus and TireMaster
Corporate.

DiscAmt Lets you enter the expected early pay discount for a charge.

Pay Displays the amount to apply. You can identify the to apply by typing it in
this field or by marking PO charges and vendor charges on the AP
Payments screen.

Apply Displays an A when a charge, credit, or payment is marked to be
applied.

DiscDate Displays the due date for early pay discounts.

Note: Vendor terms are used only in the full version of TireMaster.

DiscAvail Displays the early pay discount for a charge.

InvDate Displays the date the charge, credit, or payment occurred.

Paid Displays the amount previously applied for a charge, payment, or credit.
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Item Description

DiscTotal Displays the total of early pay discounts given for a charge.

Notes Not used.

Un-Apply Lets you unapply a group of charges, payments, or credits that were
previously applied at the same time.

OK Lets you save changes and close the screen. Any currently-due items
that are applied will automatically be marked for payment on the AP
Payments screen.

Cancel Lets you close the screen without saving changes.



BANKING
TireMaster includes tools for paying bills and tracking the activity of one or more bank accounts. This
chapter includes the following sections:

Payment Accounts 764
Manage Bank Activity 767
Easy Checks 780
Returned Checks 786
ACH Payments 793
Void Payments 797
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PAYMENT ACCOUNTS
Multiple bank accounts, referred to as payment accounts, can easily be added and updated in
TireMaster. When you set up a payment account, you need to define the following:

The GL account to which payment activity will post

Whether the payment account will be included on the screens used for processing payments

Once you’ve added all of your payment accounts, you also need to identify which one will be selected
by default when you open various payment processing screens (the AP Payments screen, the easy
checks screens, and the Check Reconciliation screen).

ADD A PAYMENT ACCOUNT
You can set up one or more payment accounts in TireMaster. If you set up multiple accounts, name
them in a manner that describes the purpose of each account. (For example, Checking, Savings,
Payroll, and ACH Payments.)

To add a payment account
1. Select Setup > Payment Accounts. The Payment Account List opens.

2. Click Add. The Payment Account screen opens.

3. Select the site that will use the payment account.

4. Enter the following information:

a. The name of the bank where the account was opened.

b. A name for the account (such as Checking, Savings, Payroll, or ACH Payments).

c. The account number assigned by the bank.
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5. Assign a GL account to the new payment account. To assign an account, click theGL Account
field, press , and select an account from the list that appears.

6. To include the payment account on payment processing screens (the AP Payments screen, the
Check Reconciliation Add screen, and easy check screens), make sure the Show on Payment
Screens check box is selected. To exclude the payment account from the payment processing
screens, clear the check box.

7. To save the new account, clickOK.
8. Close the Payment Account List or repeat steps 2 through 6 add another payment account.

SET THE DEFAULT CHECKING ACCOUNT
The default checking account is the bank account that’s typically used for paying bills. When you begin
the process of making a payment or recording payment information, the default checking account is
automatically selected for you. This setting also defines which GL account till deposits and direct
deposit ROAs post to when performing he day-end close.

To set the default checking account
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the Vendor tab.
3. Select Default Checking Account and press Enter.
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4. Select the account that you want to use as the default checking account, and clickOK.
5. Close the System Controls screen.

UPDATE A PAYMENT ACCOUNT
You can update the settings for a payment account, including the bank name and general ledger
account number.

To update a payment account
1. Select Setup > Payment Accounts. The Payment Account List opens.

2. Select the account you want to update and click Edit. The Payment Account screen opens.

3. If you want to assign the account to a different site, click Site and choose a site from the list.
Otherwise, disregard this step.

4. Change the bank name, account name, and the bank assigned account number if needed.

5. Assign a different GL account if needed. To assign an account, click theGL Account field, press
, and select an account from the list that appears.
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6. To include the payment account on payment processing screens (the AP Payments, the Check
Reconciliation Add, and easy check screens), make sure the Show on Payment Screens check
box is selected. To exclude the payment account from the payment processing screens, clear the
check box.

7. To save your changes, clickOK.

8. Close the Payment Account List.

DELETE A PAYMENT ACCOUNT
You can delete payment accounts that have never been used.

To delete a payment account
1. Select Setup > Payment Accounts. The Payment Account List opens.
2. Select the account you want to delete, and click Delete. A confirmation message appears.

3. Click Yes. The account is removed from the list.

MANAGE BANK ACTIVITY
You can perform various transactions and track the activity of your bank accounts with TireMaster.

MAKE A PAYMENT
With TireMaster, you can generate checks and record electronic payments (debit card, online bill pay,
and ACH). If you’ve set up customer or vendor records for payees, you can post payments to both
customer or vendor subledger accounts and the general ledger. When there are no customer or
vendor records for payees, payments post to the general ledger only.

Note: For tracking purposes, you can look up payments made with the Check Reconciliation module
in the subledger for ZZ-Misc Vendor.

To make a payment
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

767



768

User Guide

2. Select the bank account from which the payment is being made.

3. Click Add. The Check Reconciliation Add screen opens.

4. For the transaction type, make sure Check is selected.

5. To backdate or postdate the payment, change the entry in the Date field.
6. Define how the payment should be handled:

To post the payment to a vendor’s subledger account, select AP and look up the vendor when
prompted. For more information, see Vendor Searches on page 193.

To post the payment to a customer’s subledger account, select AR and look up the customer
when prompted. For more information, see Customer Searches on page 93.

For a payment that should not post to a vendor or customer subledger account, selectOther.
Then type the name of the payee.

Note: Addresses are not included on checks written with the Check Reconciliation module. If you
need to print an address on a check, close the Check Reconciliation screen. Then go to
General Ledger > Easy Checks.

7. Type a memo, reference (such as a document number), or both if needed.
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8. Enter the payment amount:

If you’re posting the payment to a customer or vendor subledger, type the amount in the lower-
right corner of the screen.

If check is not posting to a customer or vendor subledger, click Add. Then enter the GL
account number and amount for the offsetting entry.

Note: Depending on the scenario, you might also need to select a different site, department,
or GL class for the offsetting entry. To look up an account number, site, department, or
class, press in the appropriate field and make a selection from the list that appears.

9. Indicate whether to produce a check.

To print a check, make sure the Print Checks check box is selected.
If the payment will be or was already processed electronically (with a debit card, online bill pay,
or ACH), clear the Print Checks check box.

10. ClickOK. TireMaster prompts you to complete the payment.

11. Click Yes. One of the following occurs:

769



770

User Guide

If you printed a check, TireMaster prompts you to verify the check printed okay. If it did, click
Yes and generate a check detail report (if needed). If you need to reprint the check, click No
and follow the on-screen instructions.

If you didn’t print a check, generate the check detail report if needed.

An entry for the payment is added to the Check Reconciliation screen.

Note: Payments processed with the Check Reconciliation screen use the document-type code
EC. For more information, see Easy Checks on page 780.

MAKE A DEPOSIT
When you make a deposit into one or your bank accounts, you can record it in TireMaster.

To make a deposit
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

2. Select the bank account into which the deposit was made.

3. Click Add. The Check Reconciliation Add screen opens.

4. For the transaction type, select Deposit.
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5. To backdate or postdate the deposit, change the entry in the Date field.
6. Enter the following information.

a. Type the name of the payee.

b. Type a memo, reference (such as a document number), or both if needed.

7. Create an offsetting entry.

a. Click Add. A journal entry line appears.

b. Enter the account number and the amount of the offsetting entry.

Note: Depending on the scenario, you might also need to select a different site, department,
or GL class for the offsetting entry. To look up a site, department, or class, press in
the appropriate field and make a selection from the list that appears.

c. To make additional entries for this deposit, repeat steps 7a and 7b. TireMaster calculates the
total amount of the deposit.
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8. ClickOK. TireMaster prompts you to complete the transaction.
9. Click Yes. The Report Window opens and displays the JE Edit Report.

10. Print the report and close the Report Window.

RECORD A BANK FEE
If your bank charges fees for various services, you can track them with the Check Reconciliation Add
screen.

To record a bank fee
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

2. Select the bank account from which the fee will be withdrawn.

3. Click Add. The Check Reconciliation Add screen appears.

4. For the transaction type, select Fee.

5. To backdate or postdate the fee, change the entry in the Date field.
6. Enter the following information:

a. Type the name of the payee.

b. Type a memo, reference (such as a document number), or both if needed.
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7. Create an offsetting entry for the fee:

a. Click Add. A journal-entry line appears.

b. Enter the account number, account name (description), and amount for the offsetting entry.

Note: Depending on the scenario, you might also need to select a different site, department,
or GL class for the offsetting entry. To look up an account number, site, department, or
class, press [accent] in the appropriate column and make a selection from the list that
appears.

c. To make additional entries for the fee, repeat steps 7a and 7b. TireMaster calculates the total
amount of the fee.

8. ClickOK. TireMaster prompts you to complete the transaction.
9. Click Yes. The Report Window opens and displays the JE Edit Report.

10. Print the report and close the Report Window.

MAKE A WITHDRAWAL
You can record transactions such as ATM cash withdrawals in TireMaster Corporate by making
withdrawals from a bank account. When you enter a withdrawal in TireMaster, you can post it to a
vendor’s subledger account, a customer’s subledger account, or neither.
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Note: Although withdrawals do not result in a printed easy check, they are identified with the
document type code EC. Similarly, if you create a withdrawal that posts to a customer or
vendor subledger, the JE Edit Report produced in such a transaction includes the description
AR Easy Check or AP Easy Check.

To withdraw money from a bank account
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

2. Select the bank account from which you want to make a withdrawal.

3. Click Add. The Check Reconciliation Add screen appears.

4. For the transaction type, selectWithdrawal.

5. To backdate or postdate the withdrawal, change the entry in the Date field.
6. Define how the withdrawal should be handled:

To post the withdrawal to a vendor’s subledger account, select AP and look up the vendor
when prompted.

To post the withdrawal to a customer’s subledger account, select AR and look up the customer
when prompted.

For a withdrawal that should not post to a vendor or customer subledger, selectOther. Then
type the name of the payee.
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7. Type a memo, reference (such as a document number), or both if needed.

8. Enter the amount of the withdrawal:

If you’re posting the withdrawal to a vendor or customer subledger, type the amount in the
lower-right corner of the screen.

If the withdrawal should not post to a vendor or customer subledger, click Add. Then enter the
account number, account name (description), and amount of the offsetting entry.

9. ClickOK. TireMaster prompts you to complete the transaction.

10. Click Yes. The Report Window opens and displays the JE Edit Report.

11. Print the report and close the Report Window.

TRANSFER MONEY TO ANOTHER BANK ACCOUNT
To transfer money from one bank account to another, you need to do the following:

Make a withdrawal from the account that the money is being transferred from
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Make a deposit into the account that the money is being transferred to

When you transfer money from one account to another, you need to make sure the transfer is recorded
in the check registers for both accounts. To do this, use the unknown expense account to offset the
entries for each part of the transfer.

To transfer money to another bank account
1. Make a withdrawal from the bank account that the money is being transferred from:

a. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

b. Select the payment account that the money is being transferred from. Then click Add.

c. For the transaction type, selectWithdrawal.
d. Type the name of the payee for the withdrawal.

e. Type a memo, reference (such as a document number), or both if needed.

f. Click Add, and make an offsetting entry to the unknown expense account. For more
information, see Make aWithdrawal on page 773.

g. ClickOK, and follow the on-screen instructions to complete the withdrawal. When you’re
finished, leave the Check Reconciliation screen open.

2. Make a deposit into the account that the money is being transferred to.
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a. On the Check Reconciliation screen, select the payment account that the money is being
transferred to. Then click Add.

b. For the transaction type, select Deposit.
c. Enter the payee.

d. Type a memo, reference (such as a document number), or both if needed.

e. Click Add. Then make an offsetting entry for the same amount as the withdrawal performed in
step 1, posting it to the unknown expense account.

f. ClickOK, and follow the on-screen instructions to complete the deposit.

MARK A PENDING VOID
If you need to remove a check, electronic payment, deposit, fee, or withdrawal from the check register,
mark it as a pending void. When you reconcile a bank account, entries marked as pending voids are
removed from the Check Reconciliation screen.

Note: If you have not already created vendor charges or journal entries to remove items marked as
pending voids from the general ledger, refer to the information on the Check Reconciliation -
Voids Report to make the reversing entries.

To mark a pending void
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.
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2. Select the payment account with the item you want to make as a pending void.

3. Select the check, deposit, fee, or withdrawal that you want to mark as a pending void, and click
Mark.

4. SelectMark as Pending Void, and clickOK.

The letter P is displayed in the C column for items that have been marked as pending voids. If you
cannot see any items marked with a P, select the Show Pending Voids check box.



Manage Bank Activity

RECONCILE A BANK ACCOUNT
By reconciling a bank account, you can verify that the balance you’ve calculated for the account
matches the balance calculated by the bank.

Note: Before you can reconcile a bank account, the check register’s ending balance must match the
general ledger’s balance for the bank account.

To reconcile a bank account
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

Tip: To display payments or deposits that are marked to be voided, select the Show Pending
Voids check box.

2. Compare the check register and general ledger balances:

a. Write down the amount in the Balance field.

b. Click Reconcile.

c. Write down the amount in theGL Bal field. If the two balances differ, make adjusting journal
entries or check register entries as needed. Keep in mind that pending voids affect this
amount.

d. Click Cancel to exit reconcile mode.
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3. Mark each check, deposit, fee, and withdrawal on the bank statement as cleared on the Check
Reconciliation screen. To mark an item as cleared, double-click its row. The letter C is displayed in
the C column for items that have been marked as cleared.

4. If the bank statement shows any payments, deposits, or withdrawals that are missing from the
Check Reconciliation screen, add them and mark them as cleared.

Tip: To generate a record of cleared and outstanding items, click Cancel to close the Check
Reconciliation screen. Then print the Check Register Report. After the report prints,
resume the reconciliation. For more information, see Check Register Report on page 1144
.

5. Click Reconcile. The Check Reconciliation screen goes into reconcile mode.
6. Type the bank statement’s ending balance in the End Bal field. The amount in the Difference field

should be $0. If it isn’t, make sure the beginning balance is correct and that the appropriate items
have been marked as cleared.

Note: The amount in the Begin Bal field should match the bank statement’s beginning balance.

7. Verify that the difference is $0.00, and clickOK. One of the following occurs:
If any items are marked as pending voids, the Report Window appears. Print the Check
Reconciliation - Voids Report and close the Report Window. Then finish the reconciliation.

If no items are marked as pending voids, TireMaster prompts you to finish the reconciliation.

EASY CHECKS
An easy check is a payment that you can process quickly, because you can wait until later to apply it to
an invoice or a vendor charge. Easy checks can also be used to pay miscellaneous expenses.

Note: In addition to generating checks, debit card transactions and bills paid online can be entered as
AP, AR, and miscellaneous easy checks.

AP EASY CHECKS
When you need to quickly process a payment for a single vendor, generate an AP easy check. This
type of payment posts to the vendor’s subledger without requiring you to process other pending
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payments.

To generate an AP easy check
1. Select Vendors > Easy Checks. The Easy Checks screen opens.

2. Select the account from which the payment will be made.

3. Select AP. TireMaster prompts you for the vendor's name.

4. Look up the vendor you’re paying. For more information, see Vendor Searches on page 193.

5. Enter the following information:

a. Type a memo, reference (such as a document number), or both if needed.

b. If you need to backdate or postdate the payment, select a different date from the pop-up
calendar.

c. Type the payment amount.

d. If you want to generate a check to give to the vendor, make sure the Print Checks check box
is selected. If the payment will be or was handled electronically (with debit card, online bill pay,
or ACH), clear the check box.

6. ClickOK. TireMaster prompts you to complete the payment.
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7. Click Yes. One of the following occurs:
If you printed a check, TireMaster prompts you to verify the check printed okay. If it did, click
Yes and generate a check detail report if needed. If you need to reprint the check, click No and
follow the on-screen instructions.

If you didn’t print a check, generate the check detail report if needed.

AR EASY CHECKS
AR easy checks are used for reimbursing customers. When you process an AR easy check, the
payment posts to the customer’s subledger and the general ledger.

To generate an AR easy check
1. Select Customers > Easy Checks. The Easy Check screen opens.

2. Select the bank account from which the payment will be made.
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3. Select AR. TireMaster prompts you for the customer's name.

4. Look up the customer you’re reimbursing. For more information, see Customer Searches on page
93.

5. Enter the following information:

a. Type a memo, reference (such as a document number), or both if needed.

b. If you need to backdate or postdate the payment, select a different date from the pop-up
calendar.

c. Type the payment amount.

d. If you want to generate a check to give the customer, make sure the Print Checks check box
is selected. If the payment will be or was handled electronically (with debit card, online bill pay,
or ACH), clear the check box.

6. ClickOK.TireMaster prompts you to complete the payment.
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7. Click Yes. One of the following occurs:
If you printed a check, TireMaster prompts you to verify the check printed okay. If it did, click
Yes and generate a check detail report if needed. If you need to reprint the check, click No and
follow the on-screen instructions.

If you didn’t print a check, generate the check detail report (if needed).

MISCELLANEOUS EASY CHECKS
Miscellaneous easy checks are for paying bills that don’t need to post to a customer or vendor
subledger account. For tracking purposes, miscellaneous easy checks post to the subledger for the
ZZ-Misc Vendor.

To generate a miscellaneous easy check
1. SelectGeneral Ledger > Easy Checks.

2. Select the bank account from which the check will be paid.
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3. Make sureOther is selected.

4. Enter the following information:

a. Type the payee’s name and address.

b. Type a memo, reference (such as a document number), or both if needed.

c. If you need to backdate or postdate the payment, select a different date from the pop-up
calendar.

5. Define how the payment should post to the general ledger:

a. Click Add. A journal entry line appears.

b. Enter the account number and the amount of the offsetting entry. Also, change the site
number, department, and GL class if needed. To look up a site, department number, or GL
class, press . Then make a selection from the list that appears.

c. If the check needs to post to more than one general ledger account, repeat steps 5a and 5b.
TireMaster calculates the total check amount.

d. If you want to generate a check to give the payee, make sure the Print Checks check box is
selected. If the payment will be or was handled electronically (with debit card, online bill pay, or
ACH), clear the check box.

6. ClickOK. TireMaster prompts you to complete the payment.
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7. Click Yes. One of the following occurs:
If you printed a check, TireMaster prompts you to verify the check printed okay. If it did, click
Yes and generate a check detail report (if needed). If you need to reprint the check, click No
and follow the on-screen instructions.

If you didn’t print a check, generate the check detail report (if needed).

RETURNED CHECKS
When a bank returns a check because of nonsufficient funds (NSF), you need to adjust the customer’s
balance and the balance of your bank account. Depending on the circumstances, you might choose to
penalize the customer and your bank might charge you a fee.

When a bank returns a check because of nonsufficient funds (NSF), you need to adjust the customer’s
balance and the balance of your bank account. Depending on the circumstances, you might choose to
penalize the customer and your bank might charge you a fee.

RECORD A RETURNED CHECK
When a check is returned, you need to record a withdrawal in TireMaster’s check register. This
transaction accomplishes the following:

It reduces the balance of your checking account by the check amount.

It increases the customer’s balance by the check amount.
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Note: If you use a debt-recovery service, you need to create a customer record for it and select that
customer when recording the withdrawal instead of the original customer who wrote the bad
check.

To record a returned check
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

2. Select the bank account from which the NSF check amount will be withdrawn.

3. Click Add. The Check Reconciliation Add screen opens.

4. For the transaction type, selectWithdrawal.

5. Select AR. TireMaster prompts you for the customer's name.
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6. Enter the following withdrawal information.

a. Look up the customer who paid you with an NSF check. For more information, see Customer
Searches on page 93.

Note: If you use a debt-recovery service, look up that customer record instead of the record
for the customer who originally wrote the bad check.

b. Type Returned check in theMemo field.

c. Type the check number in the Ref field.

d. Type the amount of the returned check (lower-right corner).

7. ClickOK. TireMaster prompts you to complete the transaction.
8. Click Yes. The Report Window opens and displays the JE Edit Report.

9. Print the report and close the Report Window. The withdrawal for the returned check is added to
the Check Reconciliation screen.
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Note: Although the report description indicates that an AR easy check is written, no easy
checks are produced in this type of transaction.

10. If the returned check was originally processed as an ROA, complete these additional steps.
a. Unapply the ROA in the customer's open item ledger. For more information, see Unapply an

ROA on page 704.

b. Apply the withdrawal (for the NSF check) to the original payment that you just unapplied.

Once the withdrawal is completed, there is an entry for it on the Check Reconciliation screen and the
customer’s account balance is increased by the amount of the withdrawal.

CHARGE A RETURNED CHECK FEE
If you want to penalize a customer for paying you with an NSF check, you can record the
corresponding fee by making an AR journal entry in the customer's subledger. This entry, along with
the adjustment made to the customer’s balance, will appear on the customer’s next statement.

Note: If the customer doesn’t normally receive a statement, change the statement setting in the
customer's record. To do this, look up the customer and select the Statement check box on
the Customer Maintenance screen.

To charge a customer a returned check fee
1. Select Customers > Maintenance. TireMaster prompts you for the customer's name.

2. Look up the customer who paid you with an NSF check. For more information, see Customer
Searches on page 93.

3. Access the Customer Balance Adjustment screen.

a. On the Customer Maintenance screen, click the Ledger/History tab.
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b. ClickOpen-Item. The Open Item Ledger screen opens.

c. Click AR Journal Entry.

4. Select the current date from both the Date and Due Date pop-up calendars.
5. Type a reference number or code (such as the check number) for the fee.

6. Create the offset entry.

a. Click Add. A journal entry line appears underOffsets.

b. In theMajor field, press , and select the GL account that you want the fee to post to.

Note: You can post NSF check fees to income and expense accounts.

c. Type a description for the entry (for example, Fee for NSF check).
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d. Type the amount of the fee.

Note: You can disregard entering a value in the Disc $ field.

7. ClickOK. A confirmation message appears.

8. Click Yes. The Open Item Ledger screen opens.

9. ClickOK. TireMaster prompts you to save your changes.
10. Click Yes. TireMaster prompts you to apply the items.
11. Click Yes. The customer’s balance is increased by the amount of the fee you just assessed.

RECORD THE BANK FEE FOR A RETURNED CHECK
If your bank charges you a fee for taking a nonsufficient funds check, you need to deduct that fee
from your checking account.

Note: You will probably make this check register entry when you receive a statement from your
bank.

To record a bank fee for a returned check
1. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

2. Select the checking account that the fee is being withdrawn from.
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3. Click Add. The Check Reconciliation Add screen opens.

4. For the transaction type, select Fee.

5. Enter the following information.

a. Select the date on which the fee should post to the general ledger from the pop-up calendar.

b. Type the name of the bank in the Payee field.
c. Type a description for the entry (for example, Bank fee for returned check) in

theMemo field.

6. Create the offset entry.

a. Click Add. A journal entry line appears.
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b. Click theMajor column, press , and select the general ledger account that you use for this
type of bank fee.

c. Type the amount of the bank fee.

7. To complete the entry, clickOK. A confirmation message appears.

8. ClickOK. The Report Window opens and displays the JE Edit Report.

9. Print the report and close the Report Window.

ACH PAYMENTS
If you’ve made arrangements with a bank to generate Automated Clearing House (ACH) payments for
you, that activity can be recorded and tracked in TireMaster.

PREPARE TO TRACK ACH PAYMENTS
If you are going to use one bank account for managing ACH payments and another for the rest of your
banking activities, you need to add the following to TireMaster:

A general ledger account for tracking ACH payments

A payment account for ACH payments

To add these accounts, refer to the steps below.
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Note: If you plan to use the same bank account for all banking activities, including making ACH
payments, the extra GL and bank accounts are unnecessary. In this scenario, you can
disregard the following steps.

To prepare for ACH payment tracking
1. Add a general ledger account for tracking ACH payment activity. This account should be an asset

account, such as 1010–400 Cash in Bank–ACH Payments. For more information, see Add an
Asset Account on page 656.

2. Add a payment account for ACH payments. When you assign a general ledger account to the new
payment account, select the GL account created in step 1 and make sure the Show on Payment
Screens check box is selected. For more information, see Add a Payment Account on page 764.

RECORD ACH PAYMENTS
Recording ACH payments includes identifying the outstanding invoices and miscellaneous expenses
you want to pay, along with providing your ACH processor with that information.

To record ACH Payments
1. Enter one or more payments in TireMaster AP Payments, easy checks, or the Check

Reconciliation module. When you enter the payments, do the following:

Select the account that you use for ACH payments.

Clear the Print Checks check box before you complete the payment.
For more information, see one of the following:
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Generate AP Payments on page 753

Easy Checks on page 780

Make a Payment on page 767

2. Generate a list of payments for the ACH processor to make. For more information, see Generate a
Payment List for Your ACH Processor on page 795.

3. If you use a separate bank account for ACH payments, withdraw the payment total from your bank
account for paying bills and deposit that amount in the payment account for tracking ACH
payments. This transfer will adjust the balance of the bank account for paying bills and reset the
balance of the ACH payment account to $0.00. For more information, see Transfer Money to
Another Bank Account on page 775.

Note: If you want to remove the entries for the completed ACH payment and transfer from the
Check Reconciliation screen, complete the following steps. First, change the status of
each pay entry and the transfer entry to cleared (double-click in the C field), and click
Reconcile. Then make sure all of the balances are $0.00, and clickOK.

GENERATE A PAYMENT LIST FOR YOUR ACH PROCESSOR
You can provide your ACH processor with a list or vendors and other clients who need to be paid by
exporting payment data from TireMaster to a spreadsheet.

To generate a payment list for ACH processor
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

2. Select Vendor Payment History Report, and click Launch.
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3. Enter the beginning and ending dates for the date range when the payments occurred. For a single
day, enter the same date for both the beginning and ending dates.

4. From the Payment Account drop-down, select the account for ACH payments.

5. To group the information on the report, select Payment Number, Document Number, or Vendor
Name.

6. Click Export. A confirmation message appears.

7. ClickOK to close the message. A message, which states the report is in the TireMaster program
directory’s Apps folder, appears.
Note: Depending on the name of your TireMaster program directory, the report will be saved in

the folder TireMaster\apps, qdstm\apps, or tmpos\apps.

8. ClickOK to close the second message.
9. Close the open report screens.

10. Import the report into a spreadsheet. When you’re prompted to define the data type, selected
Delimited and choose Comma when you’re prompted to define the type of delimiter.
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11. Make any adjustments needed to comply with the requirements from your ACH processor. For
example, you might need to provide a payment total for each vendor instead of listing individual
invoices that were paid.

12. Save the list in the format specified by your ACH provider (for example, a comma delimited CSV
file).

VOID PAYMENTS
If you make a mistake when processing, you can clear it out of TireMaster. The process for voiding
payments differs, depending on how they were processed.

VOID AN AP PAYMENT
To void a payment generated from the AP Payments screen, you need to unapply the payment in the
vendor’s subledger. In addition to voiding the payment, this process also removes the entry from the
check register (Check Reconciliation module) and adds the voided amounts back to the AP Payments
module.

Note: For information about AP payments, see Apply Payments and Credits to Vendor Balances on
page 756.

To void an AP Payment
1. Select Vendors > Maintenance. TireMaster prompts you for the vendor's name.

2. Look up the vendor whose payment you want to void. For more information, see Vendor Searches
on page 193.

3. On the Vendor Maintenance screen, click the Ledger/History tab.

4. ClickOpen Item. The Payment Editing screen opens.
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5. Click Un-apply. The ROA Unapply screen opens.

6. Select a row for the payment you want to unapply.

Note: The document-type code PY identifies transactions for which you can void AP payment
entries. The number in the Apply Group column identifies a group of bills that was paid.

7. ClickOK. A confirmation message appears.

8. Click Yes. The voided entry is added back to the Payment Editing screen (the vendor's open item
ledger).

9. ClickOK. TireMaster prompts you to save your changes.

10. Click Yes. TireMaster prompts you to apply the items.
11. If you want to apply items at this time, click Yes. Otherwise, click No.
The check is no longer listed on the Check Reconciliation screen, the payment is unapplied in the
vendor's subledger, and the voided amounts are added back onto the AP Payments screen.
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VOID A PAYMENT GENERATED FROM THE CHECK REGISTER
TireMaster classifies payments originating from the check register (Check Reconciliation Add screen)
as easy checks, so they’re assigned the document type code EC. Therefore, payments generated in
the check register can be voided in the same manner as AP, AR, and miscellaneous easy checks. For
more information, see one of the following:

Void an AP Easy Check on page 799

Void an AR Easy Check on page 801

Void a Miscellaneous Easy Check on page 803

VOID AN AP EASY CHECK
To void an AP easy check (or an electronic payment processed as an easy check), you need to create
a vendor charge to reverse the payment in the vendor’s subledger. You also need to mark the payment
as a pending void on the Check Reconciliation screen.

Note: You can also use this process to void checks written to vendors in the check register (Check
Reconciliation Add screen).

To void an AP easy check
1. Select Vendors > Charges. The Vendor Charges screen opens.

2. Click New. TireMaster prompts you for the vendor's name.

3. Look up the vendor whose easy check you want to void. The Vendor Charge screen opens. For
more information, see Vendor Searches on page 193.

4. Enter the following information:

a. Enter the date when the payment was originally made in the Date field.
b. Type a reference number or a reason for voiding the payment.
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5. Create an offsetting entry.

a. Click Add. A journal entry line appears underOffsets.

b. Enter the GL account number associated with the bank account that was originally used for the
payment.

c. Type the GL account name (description) and amount of the payment being voided.

d. Change the site number, department, and GL class if needed.

Note: To look up an account, site, or department number or GL class, press . Then make a
selection from the list that appears.

6. ClickOK. TireMaster prompts you to save the charge.

7. Click Yes.
8. On the Vendor Charges screen, clickOK. TireMaster prompts you to print a Charge Edit Report.
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9. Click Yes. The Report Window opens.

10. Print the report and close the Report Window. TireMaster prompts you to complete the charges.

11. Click Yes.
12. Open the Check Reconciliation screen and mark the easy check as a pending void. For more

information, see Mark a Pending Void on page 777.

VOID AN AR EASY CHECK
To void an AR easy check, you need to create a negative AR journal entry to reverse the check in the
customer’s subledger. Then you need to open the Check Reconciliation screen and mark the check as
a pending void.

Note: You can also use this process to void checks written to customers in the check register (Check
Reconciliation Add screen).

To void an AR easy check
1. Select Customers > Maintenance. TireMaster prompts you for the customer's name.

2. Look up the customer whose easy check you want to void. For more information, see Customer
Searches on page 93.

3. On the Customer Maintenance screen, click the Ledger/History tab.

4. ClickOpen Item. The Open Item Ledger screen opens.
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5. Click AR Journal Entry. The Customer Balance Adjustment screen opens.

6. Enter the following information.

a. Enter the date when the check was originally written in the Date field.
b. Type a reference number or a reason for voiding the check.

7. Create an offsetting entry.

a. Click Add. A journal-entry line appears underOffsets.

b. Enter the GL account number associated with the bank account that was originally used to
write the check.

c. Type the GL account name (description).

d. Type the amount of the check that’s being voided as a negative number. For example, if you’re
voiding an AR easy check for $15.00, type -15.00.

e. Change the site number, department, and GL class if needed.
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Note: To look up an account, site, or department number or GL class, press . Then make a
selection from the list that appears.

8. ClickOK. A confirmation message appears.

9. Click Yes. The Open Item Ledger screen opens.

10. Close the Open Item Ledger and the Customer Maintenance screens.

11. Open the Check Reconciliation screen and mark the easy check as a pending void. For more
information, see Mark a Pending Void on page 777.

VOID A MISCELLANEOUS EASY CHECK
To void a miscellaneous easy check, you need to create a manual journal entry to reverse the check in
the general ledger. Then you need to mark the check as a pending void in the Check Reconciliation
module.

Note: You can also use this process to void miscellaneous checks written in the check register
(Check Reconciliation Add screen).

To void a miscellaneous easy check
1. SelectGeneral Ledger > Journal Entries. The Journal Entries screen opens.

2. Type the date the check was originally written in the Effective Date field.
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3. Click Add to add a second journal entry line.

4. For the first line, debit the GL account associated with the payment account used to write the easy
check.

a. Enter the account number and the amount of the payment being voided.

b. Make sure the letter D is in the D/C field.

c. Type the account name (description).

d. Change the site number, department, and GL class, if needed.

Note: To look up an account, site, or department number or GL class, press . Then make a
selection from the list that appears.

5. For the second line, credit the GL account used for the offset entry when the payment was created.

a. Enter the account number and the amount of the check being voided.

b. Make sure the letter C is in the D/C field.

c. Type description for the entry.

d. Change the site number, department, and GL class, if needed.

6. Click Post. A confirmation message appears.

7. Click Yes. TireMaster prompts you to print a detail report.
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8. Click Yes. The Report Window opens.

9. Print the JE Edit Report and close the Report Window.

10. Open the Check Reconciliation screen and mark the easy check as a pending void. For more
information, see Mark a Pending Void on page 777.
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CREDIT AND DEBIT CARDS
TireMaster’s card processing functions include the means to collect and track information about the
credit and debit cards customers use to pay for their purchases.

Process Payment Cards 808
Set Up Credit Cards 813
Set Up Debit Cards 817
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PROCESS PAYMENT CARDS
When a customer pays you with a credit or debit card, you need to gather the card information at point
of sale to ensure that the amount charged posts to the credit card company’s subledger account.

Note: For automatic payment card processing, you can integrate TireMaster with a third-party card
processing application. For more information, contact your account manager.

COMPLETE A CREDIT OR DEBIT CARD SALE
When a customer pays for a purchase with a debit or credit card, you need to identify which card is
being used and provide the customer’s account information to complete the sale.

To complete a credit card or debit card sale
1. If the OpenWork Order List isn't already open, click Invoicing.

2. Select the work order you want to complete and click Select. The Invoice Entry screen opens.

3. Click Complete. The Invoice Completion screen opens.

4. Select the first Credit/Debit row. Then press to fill in the exact invoice amount or type the
amount being paid with the card and press Enter. The Card Authorization Box opens.
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5. Select the card type.

Note: If auto authorization was enabled in the card’s settings, the Auto Authorize check box in
the lower-left corner of the screen will be selected by default.

6. Do one of the following.

To manually process the card, type a reference number (such as the last four digits of the card
number) and the authorization code. Then clickOK.

For an automatically processed credit card, clickOK and swipe the card.
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For an automatically processed debit card, clickOK and swipe the card. Then ask the
customer to enter the PIN when prompted.

7. Complete the invoice and print a copy for the customer to sign. For more information, see
Complete an Invoice on page 456.

Note: If you cancel a sale in TireMaster after swiping an automatically processed payment card,
you’ll be prompted to void the payment in your card processing software.

REVERSE A CREDIT CARD INVOICE
When a customer returns items that were paid for with a credit card, you need to refund the payment
by creating a return invoice on which you charge a negative amount to the customer’s credit card.
Completing the sale in this manner reduces the credit card company’s AR balance in TireMaster. For
more information, see Reverse an Invoice on page 458 and Reverse a Credit Card Invoice on page
711.

RECORD A PAYMENT FROM A CREDIT CARD COMPANY
A credit card company pays you by making a direct deposit into your bank account. To enter a
payment from a credit card company in TireMaster, create an ROA. Whether the ROA is for the full
amount charged by customers depends on when the credit card company collects merchant fees from
you:
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If the fees will be withdrawn from your checking account after you receive the payment, the ROA
will be the full amount charged by customers. In this scenario, you need to record the merchant
fees in the check register for your checking account.

If the credit card company deducted the merchant fees before sending you the payment, the
amount of the ROA will be the difference between the amount charged by customers and the
merchant fees. In this scenario, the merchant fees are entered as a discount in the credit card
company’s open item ledger.

To record a payment from a credit card company
1. Click Invoicing. The OpenWork Order List opens.

2. Enter the payment received from the credit card company:

a. Click ROA. TireMaster prompts you for a name.

b. Look up the name of the credit card company, and clickOK on the Customer Maintenance
screen to continue. For more information, see Customer Searches on page 93.

c. Type the amount of the direct deposit in the Check field and press Enter. TireMaster prompts
you for a check number.

d. Because there is no check, type Direct Deposit and date the payment was received.
Then clickOK.

e. Make sure the Direct Deposit check box is selected and the Flag Old Invoices check box is
clear.
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f. ClickOK. TireMaster prompts you to complete and print the ROA.
g. Click Yes. The Open Item Ledger screen opens.

3. Apply the payment to the invoices listed on the Open Item Ledger screen.

a. Type the amount paid for each invoice in the Pay field.

Note: To automatically enter the amount paid, type the letter A in the Apply field for an
invoice.

b. Depending on how the credit card company handles merchant fees, do one of the following:

If the ROA was for the full amount charged, clickOK. The credit card company will withdraw
the merchant fees from your checking account.

If the credit card company deducted the merchant fees before paying you, enter the fee
amount in the DiscAmt field for one of the invoices the payment is being applied to. Then
clickOK, and disregard step 4.

Note: If the amount displayed in the Discount field matches the total of the merchant fees on
the statement, the fees were entered correctly in TireMaster.

c. Click Yes to save your changes. Then click Yes again to apply the payment
4. Record the merchant fees in the register for your checking account.
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a. SelectGeneral Ledger > Check Reconciliation. The Check Reconciliation screen opens.

b. Select your checking account, and click Add.
c. Select either the Fee orWithdrawal transaction type.
d. Type the name of the credit card company in the Payee field, along with a description of the

transaction.

e. Click Add. Then enter the account number for your bank/card charges expense account,
along with a description and the merchant fee amount.

f. ClickOK, and complete the transaction when prompted. For more information, see Record a
Bank Fee on page 772 or Make aWithdrawal on page 773.

SET UP CREDIT CARDS
TireMaster handles credit cards differently from cash and in-store charge sales. With cash and in-store
charge sales, you bill a customer directly. However, when a customer pays with a credit card, you
need to bill the credit card company instead. For this reason, you need to create a customer record for
each credit card you accept. If you plan to process credit and debit cards automatically, the Merchant
Partners card processing system also needs to be installed and set up on your computers.

Note: The database that ships with TireMaster includes credit card accounts for American Express,
Discover, MasterCard, and Visa. The names of these credit card customer records are
preceded by the prefix ZZ- to simplify card selection at point of sale.
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ADD A CUSTOMER TYPE FOR CREDIT CARDS
Before you can add a customer record for a credit card, you need a customer type for tracking credit
card activity. In TireMaster Plus and TireMaster Corporate systems, this customer type defines how
credit card charges post to the general ledger

Note: New TireMaster systems ship with customer type Z already set up for credit cards. However,
you can add your own customer type for credit cards if you want. For more information, see
Add a Customer Type on page 99.

ADD A CREDIT CARD CUSTOMER
Before you can bill credit card companies and collect payments for credit card sales, you need to set
up customer records for each of the credit cards your store accepts. The customer records you create
for credit cards will be assigned to credit card codes.

Note: If a customer, such as ZZ-Visa/MasterCard, is assigned to multiple credit cards, TireMaster
uses the same GL account number for all of those cards. If you need each of those cards to
post to different accounts instead, create separate GL account numbers and card customers,
such as ZZ-Visa and ZZ-MasterCard.

To add a credit card customer
1. Select Customers > Maintenance. TireMaster prompts you for a name.

2. Click Cancel to close the Name Lookup/Entry screen.

3. Click Add.
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4. Type the name of the credit card and clickOK. The Customer Maintenance screen opens.

Tip: To group credit card customers together on the Customer List, use the same prefix for all
credit card customer name s (such as, ZZ-DINER’S CLUB and ZZ-AMERICAN
EXPRESS).

5. Type Do Not Delete and Do Not Use for Invoicing in the address fields.

6. Do the following:

Clear the Taxable, Statement, and Finance Charge check boxes.
Click the Type field, and press . Then select the customer type for credit cards and bank cars
(usually type Z).

7. Fill in additional information about the credit card company as needed.

8. To save the new customer record, clickOK.
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CREDIT CARD CODES
Credit card codes provide unique identifiers for credit cards and they define whether cards can be
authorized automatically. In the full version of TireMaster, credit card codes also identifies which
general ledger accounts are affected by transactions involving credit cards.

Note: If a customer, such as ZZ-Visa/MasterCard, is assigned to multiple credit cards, TireMaster
uses the same GL account number for all of those cards. If you need each of those cards to
post to different accounts instead, create separate GL account numbers and card customers,
such as ZZ-Visa and ZZ-MasterCard.

If you’ll be processing debit cards manually, set them up in the manner described below. For
information about automatically processing debit cards, see Set Up Debit Cards on page 817 instead.

To set up a credit card code
1. Select Setup > Credit Cards. The Credit Card Controls screen opens.

2. Click Add. The Credit Card Edit screen opens.

3. Type a unique code for the credit card.

Note: You can use any letter or number, except 0, as the code. The number 0 is reserved for
automatically authorizing debit cards.

4. To enable automatic card authorization, select the Auto Authorize check box. Otherwise, leave it
alone.

5. Type the name of the credit card in the Description field.
6. Click Lookup, and look up the customer record for the credit card. For more information, see

Customer Searches on page 93.

7. Type card’s Issuer Identification Number or a unique number of your choice in the Identify By. For
a list of commonly used prefixes, see Card Issuer Identification Numbers on page 817. (For
example, the prefixes for MasterCard are 51 – 55. Therefore, you would type
51,52,53,54,55.)

8. Depending on your TireMaster application, do one of the following:
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For TireMaster Plus and TireMaster Corporate, click theGL Acct field and press . Then
select the GL account for tracking credit card transactions from the list that appears.

For TireMaster Point of Sale, click theGL Acct field and press . Then select preset account
1110-0.

9. To save the credit card code, clickOK.
10. Close the Credit Card Controls screen.

CARD ISSUER IDENTIFICATION NUMBERS
Each type of credit card begins with certain prefix or a range of prefixes that are known as Issuer
Identification Numbers (IIN). The prefixes for the most commonly used credit cards are listed in Table
26-1.

Card Prefix

MasterCard 51–55

Visa 4

American Express 34, 37

Diners Club 36, 38, 300–305

Discover 6011

Table 26-1: Card Identification Numbers

SET UP DEBIT CARDS
The way in which you set up debit cards depends on whether you’ll process themmanually or
automatically:

For manual processing, set up debit cards in the same manner as credit cards. See Set Up
Credit Cards on page 813 for instructions.

For automatic processing, complete the steps below. Regardless of whether you process debit
cards manually or automatically, you need only one debit card setting.

Note: Cash back for debit cards is not supported in this version of TireMaster.
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To set up a debit card
1. Select Setup > Credit Cards. The Credit Card Controls screen opens.

2. Click Add. The Credit Cards screen opens.

3. Type 0 in the Code field.

Note: The code 0 allows TireMasterto distinguish debit cards from credit cards.

4. Select the Auto Authorize check box.
5. Type the description Debit Card.

6. Click Lookup and search for the customer record for Visa/Mastercard. For more information, see
Customer Searches on page 93.

Note: Because debit cards are not automatically detected when scanned, typing the description
Debit Cardmakes it easier to select the debit card from a drop-down at point of sale.

7. Type a number (such as 9999) that does not match the prefixes already used for the credit cards
in the Identify By field.

8. Depending on your TireMaster application, do one of the following:

For TireMaster Plus and TireMaster Corporate systems, click theGL Acct field and press .
Then select the GL account for tracking debit card transactions and clickOK.
For TireMaster Point of Sale, click theGL Acct field and press . Then select the preset
account 1110-0.
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9. To save the debit card settings, clickOK.
10. Close the Credit Card Controls screen.
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SPECIAL SALES
With TireMaster, you can process national account, government support, and adjustment sales
separately from regular sales and track the vendor credits associated with these transactions. This
chapter includes the following sections:

Reconciliation Codes 822
National Recon Code Edit Screen 827
National Account Sales 830
Government Support Sales 838
Adjustment Sales 846
Credit Reconciliation 851
National Credits Screen 853
National Account Reconciliation Report 855
Sales Commission Adjustments 855
National Sales Commission List 858
Sales Commission Adjustments Screen 860
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RECONCILIATION CODES
Reconciliation codes make it possible for you to track the credits you expect to receive from vendors
when you perform national account, government support, and adjustment sales. They also define how
these types of sales post to the general ledger.

You need to create a reconciliation code for each vendor with whom you do national account,
government support, or adjustment sales. Once you create a reconciliation code for a vendor, you
need to assign it to the following:

Items in the vendor’s product line

Customers who have national account or government support agreements with the vendor

Reconciliation codes are sometimes called recon codes.

GENERAL LEDGER SETTINGS FOR RECONCILIATION CODES
Reconciliation codes define the following:

How national account, government support, and adjustment sales post to the general ledger

How credits resulting from national account, government support, and adjustment sales post to
the general ledger

Major Minor Account Name

2000 100 Accounts Payable - General

2000 999 Accounts Payable - Expected Credits

4500 0 NA/GS/ADJ Gain/Loss

4510 0 NA/GS/ADJ Commission

Table 27-1: Default General Ledger Accounts for Reconciliation Codes

You also need to assign GL classes to your reconciliation codes. Depending on which GL classes you
assign, you can track profit information for national account, government support, and adjustment
sales separately from the profit information for the rest of your sales. The startup database for new
TireMaster systems includes GL Class 3 - NA/GS/ADJ Sales. For more information, see GL Classes
on page 682.

ADD A RECONCILIATION CODE
The process of setting up a reconciliation code includes assigning a vendor and defining the general
ledger accounts to which national account, government support and adjustment sale activity posts.

To add a reconciliation code
1. Select Vendors > National Accounts. Then Natl/Recon Codes/Credits screen opens.
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2. Click Add. The National Recon Code Edit screen opens.

3. Enter the following information:

a. In the RecCode field, type a unique two-character code.
b. Type a description for the reconciliation code.

c. Click Lookup, and search for the vendor you want to associate with the reconciliation code.
For more information, see Vendor Searches on page 193.

Note: This vendor is the local or regional distributor for the national vendor.

4. Assign GL accounts for posting expected credits, commissions, and profits or losses. To assign an
account, click the field for an account, press , and make a selection from the list that appears.
For information about these accounts, see National Recon Code Edit Screen on page 827.

5. Under Commission Percentages, type the expected commission percentage for each type of
sale (optional).

Note: The percentages entered here are used to calculate the value that appears in the Com
column on the National Credits screen.

6. Assign GL classes to the reconciliation code. Click the field for a sale type, press , and select a
class from the list that appears.
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7. To save the reconciliation code, clickOK.
The new code can be assigned to items in the vendor’s product line and customers who have national
account or government support agreements with the vendor.

MANAGE EXISTING RECONCILIATION CODES
When the need arises, reconciliation codes can be updated and removed from TireMaster.

UPDATE A RECONCILIATION CODE
In rare instances, you might need to update the settings for a reconciliation code. Such changes are
needed if a mistake was made when the code was originally set up or if a vendor’s business is
renamed.

To update a reconciliation code
1. Select Vendors > National Accounts. Then Natl/Recon Codes/Credits screen opens.
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2. Select the reconciliation code you want to update, and click Edit. The National Recon Code Edit
screen opens.

3. Make the needed changes. For more information, see National Recon Code Edit Screen on page
827.

4. To save your changes, clickOK.

DELETE A RECONCILIATION CODE
If a reconciliation code has never been used, it can be deleted. If a reconciliation code has
transaction history, you can make it inactivate. For more information, see Make a Reconciliation
Code Inactive on page 825.

To delete a reconciliation code

1. Select Vendors > National Accounts. Then Natl/Recon Codes/Credits screen opens.
2. Select the code you want to delete, and click Delete. Confirmation message appears.
3. Click Yes. The code is removed.
4. Close the Natl/Recon Codes/Credits screen.

MAKE A RECONCILIATION CODE INACTIVE
If you no longer use a reconciliation code, you can inactivate it.

To make a reconciliation code inactive
1. Select Vendors > National Accounts. Then Natl/Recon Codes/Credits screen opens.
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2. Select the reconciliation code you want to make inactivate, and click Edit. The National Recon
Code Edit screen opens.

3. Clear the Active check box and clickOK.

4. Close the Nat’l/Recon Codes/Credits screen.

CHANGE A WORK ORDER’S RECONCILIATION CODE
If you assign the wrong reconciliation code to a work order in error, you can change it point of sale.

Note: To change a work order’s reconciliation code, you must belong to a security group assigned
the permissionWork Order Change Recon Code. This permission is available in TireMaster
9.4.0.

To change a work order’s reconciliation code
1. Click Invoicing. The OpenWork Order List opens.

2. Select the work order for which the reconciliation code needs to be changed, and click Select. The
Invoice Entry screen opens.
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3. Click the button that displays the reconciliation code (upper-left corner of the screen). The
Customer Recon Codes screen opens.

4. Select the code that should be assigned to the work order, and clickOK. The following message
appears: “All prices will be reset to default values. Any changes you have made will be
overwritten.”

Note: If you need to remove a reconciliation code from a work order, click Cancel on the
Customer Recon Codes screen. Then click No to create a regular work order.

5. ClickOK. The new reconciliation code appears in the upper-left corner of the screen and prices for
the items on the work order are recalculated.

6. ClickQuit to close the work order, or complete the invoice. For more information, see Complete an
Invoice on page 456.

NATIONAL RECON CODE EDIT SCREEN
Reconciliation codes are set up and managed on the National Recon Code Edit screen (Figure 27-1).
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Figure 27-1: National Recon Code Edit

Item Description

RecCode Let you enter a two-character code for tracking national-account,
government-support, and adjustment sales. This code can, but
doesn’t need to, match the vendor’s manufacturer code.

Description Lets you enter a description for the reconciliation code. This
description can, but doesn’t need to, include the name of the national
vendor.

Vendor Displays the name of the local vendor who distributes the national
vendor’s products.

Lookup Lets you look up and assign a local vendor to the reconciliation code.

Accounts Includes fields for assigning general ledger accounts to the
reconciliation code.

National AR Lets you set the general ledger account for posting expected credits
received from the selected vendor for national-account sales. This
account is usually a contra AP account (such as Accounts Payable -
Expected Credits) or an AR account.

Government AR Lets you assign the general ledger account for posting expected
credits received from the selected vendor for government-support



National Recon Code Edit Screen

Item Description

sales. This account is usually a contra AP account (such as Accounts
Payable - Expected Credits) or an AR account.

Adjustment AR Lets you assign the general ledger account for posting expected
credits received from the selected vendor for adjustment sales. This
account is usually a contra AP account (such as Accounts Payable -
Expected Credits) or an AR account.

Commission Sales Lets you assign the general ledger account for posting any
commissions or handling fees received from the selected vendor. This
account is usually a revenue or income account.

Cost Offset Lets you assign the general ledger account for posting any losses for
national-account, government-support, or adjustment invoices
associated with the selected vendor. This account is usually an
NA/GS/ADJ Gain/Loss account.

Note: The loss is the difference between the expected credit and the
actual credit.

Profit Offset Lets you assign the general ledger account for posting any gains for
national-account, government-support, or adjustment invoices
associated with the selected vendor. This account is usually an
NA/GS/ADJ Gain/Loss account.

Note: The gain is the difference between the expected credit and the
actual credit.

Commission
Percentages

Includes fields for setting the commission percentages (handling fees)
you expect from the vendor assigned to the reconciliation code.

National% Lets you define the commission percentage (handling fee) you expect
to receive for national-account invoices.

Government% Lets you define the commission percentage (handling fee) you expect
to receive for government-support invoices.

Adjust% Lets you define the commission percentage (handling fee) you expect
to receive for adjustment invoices.

Calculate
Commission on FET

Lets you define whether to include federal excise tax (if any) in
commission calculations.

GL Class Includes fields for assigning a GL class to each type of sale.

National The GL class for any national-account sales associated with this
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Item Description

vendor.

Government The GL class for any government-support sales associated with this
vendor.

Adjust The GL class for any adjustments associated with this account.

Active Lets you define whether the reconciliation code is currently in use.

NATIONAL ACCOUNT SALES
National account customers have agreements with vendors to buy tires, and perhaps other items or
services, from certain dealers. In these arrangements, the vendors set the prices. Typically, an item’s
price is your cost for that item, or it might be a price established by a price level.

Note: If you don’t want to sell items to national account customers at cost, you can use price levels to
establish prices. For more information, see Price Levels for National Account Customers on
page 838.

WHAT HAPPENS IN A NATIONAL ACCOUNT SALE
When a you perform a national account sale, you sell items at vendor-assigned prices to a customer.
At the end of the sale, the customer doesn’t pay you for the items and services; the customer pays the
vendor instead. The vendor completes the cycle by giving you a credit and possibly a commission or
handling fee (Figure 27-2).
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Figure 27-2: National Account Sale Cycle

NATIONAL ACCOUNT SALE REQUIREMENTS
Before you can perform national account sales, you need to do the following:

Add a reconciliation code for each vendor who does national account sales with you.

Assign at least one reconciliation code to each of the customers who have national account
agreements with your vendors.

Assign a reconciliation code to each of the items distributed by your vendors.

NATIONAL ACCOUNT SALE EXAMPLE
When a tire is sold to a national account customer, it’s added to the work order at your cost, but you
charge the regular price for the add-ons (Figure 27-3).
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Figure 27-3: National Account Sale Work Order

When you complete the sale, the invoice total posts to a holding account for expected credits instead
of an accounts receivable or cash account (Figure 27-4). The remaining entries are similar to those for
a regular sale in TireMaster Plus and TireMaster Corporate.

Figure 27-4: National Account Sale Journal Entries

When you receive an invoice from the vendor, it includes the amount of the actual credit and it might
include a handling fee (Figure 27-5).
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Figure 27-5: National Account Sale Credit and Handling Fee

When you reconcile the vendor credit, the following entries post to the general ledger in TireMaster
Plus and TireMaster Corporate (Figure 27-6).

Figure 27-6: National Account Sale Reconciled Credit Journal Entry

ADD A NATIONAL ACCOUNT CUSTOMER
To ensure that sales to national account customers are handled correctly, you need to differentiate
them your other clients by assigning the following:

The national account customer type

Note: If you want to use price levels for your national account customers, you need to enable
price levels for that customer type.

At least one reconciliation code

The reconciliation code identifies the vendor with whom the customer has a national account
agreement.

To add a national account customer
1. Add the new customer to TireMaster. For more information, see Add an AR Customer on page 68.

2. Enter the customer’s contact information.
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3. To complete the customer’s account settings, do the following:

a. Clear the Taxable and Cash Only check boxes.
Note: If the control Sales Tax - Charge Natl. Customer is set to No, TireMaster does not

calculate sales tax on national account work orders regardless of the customer’s sales
tax settings.

Tip: If you want to include national account sales on your sales tax reports, select the
Taxable check box and assign an exempt tax level to the customer. In this scenario,
the control Sales Tax - Charge Natl. Customer needs to be set to Cust.

b. If you’ll perform any normal charge sales in addition to national account sales for the customer,
leave the Statement and Finance Charge check boxes selected. If not, clear them.

c. To base pricing for the customer on a price level, click the Price Level field, press , and
select a level from the list that appears. To sell items to the customer at cost, leave the Price
Level field blank.
Note: To use price levels for national account customers, price levels must be enabled in the

settings for the national account customer type. For more information, see Price Levels
for National Account Customers on page 838.

d. Click the Type field, and press . Then select the national account customer type (N) from the
list that appears.

4. ClickOK to save the new customer.
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5. To assign reconciliation codes to the customer, do the following:

a. Click Recon Codes. The Customer Recon Codes screen opens.

b. Click Add. The Recon Codes screen opens.

c. Select the customer’s reconciliation code and clickOK.

d. If the vendor assigned identifying numbers, such as non-sigs, to the customer, type that
information in the National/GS # field, Dealer # field, or both.

e. If the vendor wants prices, the title Delivery Receipt, or both to print on invoices, select the
corresponding check boxes.
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f. If you need to assign additional reconciliation codes, repeat steps 5b through 5e.

g. If multiple reconciliation codes are assigned to the customer, select the code that will be used
most often and select the Default check box.

h. Close the Customer Recon Codes screen.

6. Add vehicles and shipping addressees for the customer if needed.

7. Close the Customer Maintenance screen.

Tip: For a list of all the national account settings assigned to a customer, print the Customer
Recon Codes Report. For more information, see Customer Recon Codes Report on page
1120.

PERFORM A NATIONAL ACCOUNT SALE
The process of creating national account work orders is similar to the process for regular work orders.
The only difference is that TireMaster prompts you to verify the customer’s reconciliation code.

To perform a national account sale
1. Start a work order as you normally would for a regular customer. For more information, see Create

a Regular Work Order on page 442.

2. When the Customer Recon Codes screen opens, select the vendor’s reconciliation code, and click
OK. The Invoice Entry screen opens.
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Note: If this is an instance when you need to create a regular work order for a national account
customer, click Cancel on the Customer Recon Codes screen.

3. Add items to the work order.

Note: If an item is noninventoriable, it’s added to the work order at its regular price. If an item is
inventoriable, its selling cost is either its last cost or an amount established by a price level
that has been assigned to the customer. For more information, see Price Levels for
National Account Customers on page 838.

4. If you need to collect sales tax for an item, make sure the entry in the Tax field is Parts, Labor, or
Both. If you need to change the entry, click the Tax field and press repeatedly to make your
selection.

Note: A system control defines whether sales tax is calculated by default for national account
invoices. For more information, see .

5. To finish the sale, click Complete. The Invoice Completion screen opens and the Charge field is
selected.

6. Press to insert the invoice total in the Charge field.

Note: Charge is the only available payment type for national account sales. Do not collect any
money from the customer. The vendor will send you a credit invoice for this charge.

7. Complete the invoice. For more information, see Complete an Invoice on page 456.

Note: Whether the invoice includes prices depends on the customer’s arrangement with the
vendor.
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PRICE LEVELS FOR NATIONAL ACCOUNT CUSTOMERS
If you don’t want to sell items to national account customers at cost, you can establish selling prices
with price levels. To use price levels for your national account customers, you need to do the following:

Enable price levels for the national account customer type by selecting the Price Levels for
National/GS check box on the Customer/Vendor Type Edit screen.

Figure 27-7: Enabling Price Levels for National Account Customers

Assign price levels to one or more national account customers as needed.

If you’ve enabled price levels for national accounts and assigned a price level to a national account
customer, the selling price for an item added to a quote or a work order for that customer will be based
on the assigned price level.

GOVERNMENT SUPPORT SALES
Government support customers have agreements with vendors to buy tires at discounted prices from
certain dealers. Vendors set the tire prices to amounts that are usually below your cost. You can also
sell other items and services at their regular prices. Government support customers include both
government agencies and other organizations that receive price supports.

WHAT HAPPENS IN A GOVERNMENT SUPPORT SALE
When you perform a government support sale, you sell the customer tires at a discount and other
items at their regular prices. The customer pays you, and then you submit a claim to the vendor. The
vendor gives you a credit for the difference between your cost of the tires and the price they were sold
for. Depending on the circumstances, the vendor might also give you a commission or a handling fee
(Figure 27-8).
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Figure 27-8: Government Support Sale Cycle

GOVERNMENT SUPPORT REQUIREMENTS
To perform government support sales, you need to do the following:

Add a reconciliation code for each vendor who does government support sales with you.

Assign at least one reconciliation code to each of the customers who have government support
agreements with your vendors.

Assign a reconciliation code to each of the items distributed by your vendors.

GOVERNMENT SUPPORT SALE EXAMPLE
When a tire is sold to a government support customer, it’s added to the work order at your cost (Figure
27-9). You need to replace this amount with the price supplied by the vendor.
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Figure 27-9: Government Support Work Order

When you complete the sale, the difference between your cost and the selling price posts to both the
holding account for expected credits and the income account for tire sales. The remaining entries are
similar to those for regular sales (Figure 27-10).

Figure 27-10: Government Support Sale Journal Entries

When you receive an invoice from the vendor, it includes the amount of the actual credit and it might
include a handling fee (Figure 27-11).
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Figure 27-11: Government Support Credit and Handling Fee

When you reconcile the vendor credit, the entries in Figure 27-12 post to the general ledger in
TireMaster Plus and TireMaster Corporate.

Figure 27-12: Government Support Credit Journal Entries

ADD A GOVERNMENT SUPPORT CUSTOMER
To ensure that sales to government support customers are handled correctly, you need to differentiate
them your other clients by assigning the following:

Assign the government support customer type.

Assign at least one reconciliation code.

Select a check box that identifies the customer as having a government support agreement.

The reconciliation code defines the vendor with whom the customer has a government support
agreement.

To add a government support customer
1. Add the new customer to TireMaster. For more information, see Add an AR Customer on page 68.
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2. Enter the customer’s contact information.

3. To complete the customer’s account settings, do the following:

a. Leave the Taxable, Statement, and Finance Charge check boxes selected.
Note: If the control Sales Tax - Charge Govt. Customer is set to No, TireMaster does not

calculate sales tax on government support work orders regardless of the customer’s
sales tax settings.

b. Clear the Cash Only check box.
c. To base pricing for the customer on a price level, click the Price Level field, press , and

select a level from the list that appears. Otherwise, leave the Price Level field blank.
Note: To use price levels for government support customers, price levels must be enabled in

the settings for the government support customer type. For more information, see
Price Levels for government support Customers on page 846.

d. Click the Type field, and press . Then select the government support customer type (S) from
the list that appears.

Note: If government support customers are not required to pay federal excise tax in your
state, you can identify the government support customer type as FET exempt. For
more information, see Update a Customer Type on page 101.

4. ClickOK to save the new customer.



Government Support Sales

5. To assign reconciliation codes to the customer, do the following:

a. Click Recon Codes. The Customer Recon Codes screen opens.

b. Click Add. The Recon Codes screen opens.

c. Select the customer’s reconciliation code and clickOK.

d. If the vendor assigned identifying numbers, such as non-sigs, to the customer, type that
information in the National/GS # field, Dealer # field, or both.

e. Select theGovernment Support check box.
f. If the vendor wants prices, the title Delivery Receipt, or both to print on invoices, select the

corresponding check boxes.
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g. If you need to assign additional reconciliation codes, repeat steps 5b through 5f.

h. If multiple reconciliation codes are assigned to the customer, select the one that will be used
most often and select the Default check box.

i. Close the Customer Recon Codes screen.

6. Add vehicles and shipping addressees for the customer if needed.

7. Close the Customer Maintenance screen.

PERFORM A GOVERNMENT SUPPORT SALE
The process of creating government support work orders is similar to the process for regular work
orders. The only difference is that TireMaster prompts you to verify the customer’s reconciliation code.

To perform a government support sale
1. Start a work order as you normally would for a regular customer. For more information, see Create

a Regular Work Order on page 442.

2. When the Customer Recon Codes screen opens, select the vendor’s reconciliation code, and click
OK. The Invoice Entry screen opens.



Government Support Sales

Note: If this is an instance when you need to create a regular work order for a government
support customer, click Cancel on the Customer Recon Codes screen.

3. Add items to the work order.

Note: If an item is noninventoriable, it’s added to the work order at its regular price. If an item is
inventoriable, its selling cost is its last cost.

4. Change the tire price to match the amount on the price list provided by the vendor.

5. If you need to collect sales tax for an item, make sure the entry in the Tax field is Parts, Labor, or
Both. If you need to change the entry, click the Tax field and press repeatedly to make your
selection.

Note: A system control defines whether sales tax is calculated by default for government support
invoices. For more information, see Sales Tax - Charge Govt. Customers on page 1199.

6. To finish the sale, click Complete. The Invoice Completion screen opens and the Charge field is
selected.

7. Press to insert the invoice total in the Charge field.
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Note: Although government support customers can pay with cash or a check, these types of
sales are usually charged to an in-store account.

8. Complete the invoice. For more information, see Complete an Invoice on page 456.

Note: Whether the invoice includes prices depends on the customer’s arrangement with the
vendor.

PRICE LEVELS FOR GOVERNMENT SUPPORT CUSTOMERS
You can define prices for government support customers with price levels. To use price levels for
government support customers, you need to do the following:

Enable price levels for the government support customer type by selecting the Price Levels for
National/GS check box on the Customer/Vendor Type Edit screen.

Figure 27-13: Enabling Price Levels for Goverment Support Customers

Assign price-levels to one or more government support customers as needed.

If you’ve enabled price levels for the government support customer type and assigned a price level to a
government support customer, the price of items sold to that customer will be based on the assigned
price level.

ADJUSTMENT SALES
When a customer returns a defective product, you can sell a replacement item at a reduced price. If the
replacement item’s selling price is less than your cost, the vendor will give you a credit.



Adjustment Sales

WHAT HAPPENS IN AN ADJUSTMENT SALE
When a customer returns a defective item, you sell the customer a replacement item at a discount.
After the sale, you submit a claim to the vendor. The vendor gives you a credit for the difference
between the item’s cost and the selling price for the replacement (Figure 27-14).

Figure 27-14: Adjustment Sale Cycle

ADJUSTMENT SALE REQUIREMENTS
To perform adjustment sales, you need to complete the following settings:

Set up a reconciliation code for each of your vendors.

Assign a reconciliation code to each of the items distributed by your vendors.

ADJUSTMENT SALE EXAMPLE
When you perform an adjustment sale, the tire is added to the work order at its regular price. You need
to replace this amount with the adjusted price (Figure 27-15).

847



848

User Guide

Figure 27-15: Adjustment Work Order

For adjustment sales, the expected credit is the difference between your cost and the replacement
item’s adjusted parts price on the invoice. When you complete the sale, this amount posts to a holding
account for expected credits and the income account for tire sales. The remaining entries are similar to
those for regular sales (Figure 27-16).

Figure 27-16: Adjustment Sale Journal Entries

When you receive an invoice from the vendor, it includes the amount of the actual credit and it might
include a handling fee (Figure 27-17).

Figure 27-17: Adjustment Credit and Handling Fee

When you reconcile the vendor credit, the entries shown in post to the general ledger (Figure 27-18).



Adjustment Sales

Figure 27-18: Adjustment Credit Journal Entries

CREATE AN ADJUSTMENT WORK ORDER
When a customer returns a defective item, you can sell a replacement at a reduced price. In this
scenario, you need to create an adjustment work order.

Note: Before you create an adjustment work order, make sure a reconciliation code has been set up
for the vendor. For more information, see Add a Reconciliation Code on page 822.

To create an adjustment work order
1. Start a work order as you normally would for a regular sale. For more information, see Create a

Regular Work Order on page 442.

2. Add the replacement item and its add-ons to the work order.

3. Make sure the line for the replacement item is selected and click Adjust. The
Nat’l/ReconCodes/Credits screen opens.
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4. Select the reconciliation code for the vendor who distributes the item and clickOK.

5. Type the claim number for the adjustment sale and clickOK. The line for the adjusted item turns
yellow and the following message appears: “You should change the sales price to the adjusted
price of the item.”

Note: If the following message appears, you need to choose the correct reconciliation code in the
upper-left corner of the screen: “Error: Reconcile code already set for this invoice. You can
only work with one national account per invoice.”

6. ClickOK.
7. Type the price for the replacement item in the Parts column.



Credit Reconciliation

Note: The price of add-on items is unaffected unless you also adjust their prices.

8. Delete the add-on items that you do not want to include on the final invoice. Typically, all add-ons
are deleted except the state tire fee.

9. Complete the invoice as usual. For more information, see Complete an Invoice on page 456.

Note: On printouts for completed invoices, the letter A identifies the lines for adjusted items.

CREDIT RECONCILIATION
When you receive a vendor credit for a national account, government support, or adjustment sale, you
need to compare it to the expected credit to determine your profit or loss. In TireMaster, this process is
called reconciliation.

A vendor credit for national account sales should reimburse you for roughly the entire amount of an
invoice, in addition to any commissions or handling fees. Credits for government support agreements
and adjustments can vary.

RECONCILE A VENDOR CREDIT
When you receive a vendor credit, compare it to the expected credit to determine your profit or loss.

To reconcile a vendor credit
1. Select Vendors > National Accounts. Then Natl/Recon Codes/Credits screen opens.

2. Select the reconciliation code for the vendor who issued the credit, and click Recon. The National
Credits screen opens.
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3. Retrieve the invoice associated with the credit:

Click Invoice and type the number of the invoice you want to view. For a specific invoice, make
sure the Exact Match check box is also selected.
Note: When the check box is clear, TireMasterretrieves all documents whose invoice

numbers begin with the first number or numbers entered in the Invoice field. In this
scenario, typing the number 23 would retrieve invoices #233, #234, and #236.

Click Start Date and select or type a start date.
Click Claim and type the claim number from an adjustment invoice or the reference number
from a national account or government support invoice.

Note: To display processed credits along with those that have not been reconciled, select the
Show Processed check box.

4. ClickQuery. All available credits for the vendor appear.

5. Fill in the following information for the credit you want to reconcile:

Memo#: This number should appear on the vendor credit memo you receive.
CR Date: This date is when the credit actually posted.
Note: When you type the date, put slashes (/) between the month, day, and year. Also, type

all four digits for the year.

CR Amount: This value should be the actual credit amount not including any commission.
CR Com: This value is the actual commission you receive from the vendor.



National Credits Screen

6. Click Process Credit on Selected Line.

7. Click Yes to confirm that you want to complete the credit memo.

Note: The letter P is displayed in the P column for credits that have been reconciled. To display
reconciled credits, select the Show Processed check box.

8. Close the National Credits screen.

NATIONAL CREDITS SCREEN
The National Credits screen is used for processing vendor credits.

Figure 27-19: National Credits Screen

Item Description

Invoice Lets you look up credits by invoice number.

Exact Match Lets you limit the search to a credit with a specific invoice number.
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Item Description

Claim Lets you look up credits by claim number (the invoice’s reference
number).

Start Date Lets you view claims or invoices completed on or after the selected date.

Show Processed Lets you show or hide credits that have already been processed.

Date Displays the date the invoice posted to the general ledger.

Site Displays the site where the invoice was completed. In TireMaster Point
of Sale and TireMaster Plus, the site number is always 1.

Mod Displays the document type for the invoice:

NA is for national account invoices

GS if for government support invoices

Blank is for adjustment invoices

Invoice Displays the document number for the invoice.

Amount Displays the expected credit amount for the invoice (not including a
commission).

Com Displays the expected commission for the vendor credit.

Note: This amount is a percentage of the invoice total. The percentage
for calculating the expected commission is set on the National
Recon Code Edit screen.

Claim Displays the reference number entered on the invoice.

Memo# Lets you enter the vendor-assigned credit memo number.

Note: This number is displayed in the Ref field on the AP Payments
screen and the vendor’s ledger.

CR Date Lets you enter the date that the actual credit posted to the general
ledger. When entering the date, use the MM/DD/YYYY format.

CR Amount Lets you enter the amount of the credit received from the vendor.
Typically, this amount is the total of the line-item credits without any
commission.

Note: If you want to include the commission in the credit amount, the
reconciliation code needs to be set up so the commission gains
and losses post to the same general ledger account.

CR Com Lets you enter the amount of the actual commission received for a



National Account Reconciliation Report

Item Description

vendor credit, if any. This amount posts to the commission sales
account assigned to the reconciliation code.

Diff Displays the total gain or loss for the credit and commission. Gains are
shown as positive amounts and losses are shown as negative amounts.

P Identifies which credits have been processed.

Expected
(as listed)

Displays the total of the expected credits.

Process Credit on
Selected Line

Lets you update the information about the selected vendor credit.

Reconcile Report Lets you print the Reconciliation Report.

NATIONAL ACCOUNT RECONCILIATION REPORT
You can generate a national account reconciliation report to view national account, government
support, and adjustment invoices where a credit was owed to you. For each invoice, the report shows
the following:

Invoice date

Invoice number

Invoice amount (minus tax)

Claim number

Credit memo number

Credit date

Credit amount

Credit commission

Amount owed

You can print the report either from the Report List or from the National Credits screen (by clicking
Reconcile Report). If you print the report from the National Credits screen, the report shows the totals
for the selected reconciliation code for all three credit types (national account, government support,
and adjustment) and for either all items or unreconciled items only. If you print the report from the
Report List, it shows the totals for each reconciliation code for a specified invoice date range.

SALES COMMISSION ADJUSTMENTS
If the vendor credit received for a national account, government support, or adjustment invoice does
not match the expected credit, you might have paid too much or too little sales commission to an
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employee. You can ensure that the primary salesperson receives the proper commission by adjusting
the sales commission amount. The sales commission for an invoice can be adjusted only once.

Note: To adjust sales commissions for national account, government support, and adjustment sales,
you need to set the Adjust National Commission control to Yes. This setting is on the
Commissions tab on the System Controls screen.

ENABLE SALES COMMISSION ADJUSTMENTS
Before you can adjust the amount of sales commission paid to the primary salesperson for a national
account, government support, or adjustment sales, you need to complete a pair of settings in System
Controls.

To enable sales commission adjustments
1. Select Setup > System Controls. The System Controls screen opens.

2. Make sure the Commission tab is selected.
3. To enable commission adjustments, do the following:

a. Select Adjust National Commissions and press Enter.
b. Select Yes and clickOK.

4. To set the commission threshold, do the following:

a. Select Adjust National Commission Threshold and press Enter.
b. Type the amount you want to set for the commission threshold and clickOK.

Note: If the amount in this field is more than the suggested sales commission adjustment
amount for an invoice, the focus on the Sales Commission Adjustments screen will be
on the Cancel button instead of theOK button. The purpose of this setting is to help
you work more quickly when adjusting sales commissions.

5. Close the System Controls screen.



Sales Commission Adjustments

ADJUST SALES COMMISSION FOR SPECIAL SALES
You can change the amount of sales commission paid to the primary salesperson when there is a
difference between the expected vendor credit and actual credit received for a national account,
government support, or adjustment sale.

To adjust sales commission for a special sale
1. Select Vendors > National Accounts. The Natl/Recon Codes/Credits screen opens.

2. Click Commission. The National Sales Commission List opens.

Note: If you cannot see the Commission button, you need to set Adjust National Commission
to Yes. This setting is on the Commission tab of the System Controls screen.

3. Select one of the following options:

To view invoices whose vendor credits were reconciled during the past two weeks, select 2 -
Weeks.
To view invoices whose vendor credits were reconciled during the past month, select 1 -
Month.
To view invoices whose vendor credits were reconciled during the past six months, select 6 -
Months.
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Note: The sales commission for an invoice cannot be adjusted if more than six months have
passed since the vendor credit was reconciled.

4. Select the invoice whose sales commission you want to adjust, and click Adjust Commission.
The Sales Commission Adjustments screen appears and displays a suggested adjustment
amount in the Sales Commission Adjustment field.

5. In the Sales Commission Adjustment field, do one of the following:
To change the sales commission by the suggested amount, leave the value as is.

To reduce the sales commission, type a negative adjustment amount.

To increase the sales commission, type a positive adjustment amount.

6. Type a note about the adjustment in the Sales Commission Comment field. This note prints on
the Commission Report.

7. ClickOK.

NATIONAL SALES COMMISSION LIST
The national account, government support, and adjustment invoices for which you can adjust sales
commissions are displayed on the National Sales Commission List. Invoices are displayed on this
screen once the vendor credits have been reconciled.

Note: You have until six months after the credit date to adjust the sales commission on a national
account, government support, or adjustment invoice.



National Sales Commission List

Figure 27-20: National Sales Commission List

Item Description

Invoice Displays the invoice number for a national account, government
support, or adjustment sale.

Mod Displays one of the following document type codes:

NA is for national account invoices.

GS is for government support invoices.

Blank is for adjustment invoices.

Site Displays the site where a sale occurred.

Credit Date Displays the date that a vendor credit posted to the general ledger.

Invoice Date Displays the date that an invoice posted to the general ledger.

Ex Credit Displays the amount of the credit you expected to receive from a
vendor for an invoice.

Cr Amount Displays the amount of the actual credit you received from a vendor for
an invoice.

Diff Displays the difference between the expected credit and the credit you
actually received from a vendor.

Adjustment Displays the amount subtracted from or added to the sales
commission for an invoice.

Claim # Displays the claim number entered for an adjustment invoice or the
reference number entered for a national account or government
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Item Description

support invoice.

2 - Weeks Lets you view all special sale invoices for which vendor credits were
processed within the past two weeks.

1 - Month Lets you view all special sale invoices for which vendor credits were
processed within the past month.

6 - Month Lets you view all special sale invoices for which vendor credits were
processed within the past six months.

Adjust Commission Lets you adjust the sales commission for the selected invoice. The
sales commission for an invoice can only be adjusted once.

Close Lets you exit the screen.

SALES COMMISSION ADJUSTMENTS SCREEN
You can define the amount of a sales commission adjustment on the Sales Commission Adjustments
screen. TireMaster displays a suggested amount for adjusting the sales commission for an invoice, or
you can type your own amount.

Item Description

Salesperson Displays the user ID and name of the primary salesperson for the
invoice.

Invoice Displays the invoice number and customer name.

Qty Displays the quantity for each of the items sold on the invoice.

Description Displays the description for each of the items sold on the invoice.

Price Displays the price for each of the items sold on the invoice.

Invoice Total Displays the invoice total.

Actual Credit Displays the amount of the credit received from the vendor.

Expected Credit Displays the credit amount you expected to receive from the vendor.

Difference Displays the difference between the expected credit and the actual
credit received from the vendor.

% Difference Displays the percentage of difference between the expected credit
and the actual credit received from the vendor.

Commission Displays the system-calculated amount of commission for the



Sales Commission Adjustments Screen

Item Description

Current/Locked invoice, and the amount of locked commission for the invoice. If the
field on the right is blank, the commission has not been locked.

Sales Commission
Adjustment

Displays the suggested amount for adjusting the sales commission.
This amount is calculated by multiplying the percentage of difference
by the current commission.

Sales Commission
Comment

Lets you type a comment for a sales commission adjustment. This
comment prints on the Commission Report.

OK Lets you save a sales commission adjustment.

Cancel Lets you exit the screen without saving a sales commission
adjustment.
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PRODUCTIVITY
With TireMaster's productivity tools, you can track hours and work performed, offer employees
incentives, and reward teammembers for their efforts. This chapter includes the following sections:

Time Clock 864
Flat Rate Reporting 882
Color/Spiff Codes 885
Commissions 892
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TIME CLOCK
TireMaster includes a basic time clock for recording employees’ time worked. Once the time clock is
launched, it can be run continuously in the background while you use other TireMaster modules.

Note: The time used by the time clock coincides with the time on the TireMaster server.

ADD EMPLOYEES TO THE TIME CLOCK
You can define which employees will record their time worked with the Time Clock. Typically, the Time
Clock is used only by hourly employees. This functionality is available in TireMaster 9.4.0.

To add employees to the Time Clock
1. Select Setup > Users & Permissions. The User List opens.

2. Select the employee you want to add to the Time Clock, and click Edit. The Employee/User Edit
screen opens.

3. Select the Time Clock checkbox.



Time Clock

4. Re-enter or change the employee’s password.

5. To save your changes, clickOK.

6. Close the User List.

UPDATE THE CURRENT PAY PERIOD
When a new pay period begins, the Time Clock's Current Pay Period date range needs to be
updated. Updating the dates at the beginning of the pay period ensures that the total hours each
employee works are accurate. Those totals are displayed in the Pay Period Hrs column. This
functionality is available in TireMaster 9.4.0.

Note: To update the current pay period, you must belong to a security group assigned the permission
Time Clock Entry of Others.

To update the current pay period
1. Access the time clock using one of the following methods:

If the time clock is already running, click on the Windows Task Bar.
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If the time clock is not running, click Time Clock on the menu.

2. Click Clock In/Out Others. The Clock In/Out Others status changes toOn (red).

3. When the login prompt appears, type your user name and password and clickOK.

4. Select the new pay period’s beginning and ending dates.



Time Clock

5. Click Clock In/Out Others. The Clock In/Out Others status changes toOff (black).

RECORD YOUR IN AND OUT TIMES
When you’re ready to begin or finish working, access the time clock and record your time in or out. The
following instructions describe recording time in TireMaster 9.4.0.

Note: Any employee can open the time clock. However, logging in with TireMaster credentials is
required to enter time.

To record in and out times
1. Access the time clock using one of the following methods:

If the time clock is already running, click on the Windows Task Bar.
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If the time clock is not running, click Time Clock on the menu.

2. Do one of the following:

If you’re going to begin working, select your name from the list of clocked out employees (left
side of screen) and click Clock IN.

Tip: To limit the number of names on the list, make sure the Active Users and Local
Users check boxes are selected.

If you’ve just finished working, select your name from the list of clocked in employees (right side
of screen) and click Clock OUT.

3. When the login prompt appears, type your TireMaster password and clickOK. Depending on
whether you’re entering time in or time out, your name moves to the right side of the screen (list of
clocked in employees) or the left side of the screen (clocked out employees).



Time Clock

4. When the login prompt appears, type your TireMaster password and clickOK.

One of the following occurs:

If you’re entering your starting time, the time in appears next to your name on the right side of
the screen and your name disappears from the list of clocked out employees (left side of
screen).

If you’re entering your ending time, the time out appears near your name on the right side of the
screen and your name is added back to the list of clocked out employees (left side of screen).

5. Do one of the following:

Click away from the time clock. This allows the time clock to remain open while you perform
other tasks in TireMaster.

Close the time clock.

RECORD IN AND OUT TIMES FOR OTHERS
In some instances, employees might need a manager or another authorized person to clock them in or
out. For example, this would occur when an employee starts his or her work day off site or by picking
up parts for an upcoming job on the way to work. The following instructions describe recording time for
others in TireMaster 9.4.0.

Note: To record the in and out times for other employees, you must belong to a security group
assigned the permission Time Clock Entry of Others.

To record in and out times for other employees
1. Access the time clock using one of the following methods:

If the time clock is already running, click on the Windows Task Bar.

If the time clock is not running, click Time Clock on the menu.
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2. Click Clock In/Out Others. A login prompt appears.

3. Type your TireMaster user name and password, and clickOK. The Clock In/Out Others status
changes toOn (red).

4. Do the following for each employee who needs to be clocked in or out:

To record time in, select a name on the list of clocked out employees (left side of screen) and
click Clock IN. The time in appears next to the employee’s name on the right side of screen,
and the name disappears from the list of clocked out employees (left side of screen).



Time Clock

Tip: To limit the number of names on the list, make sure the Active Users and Local
Users check boxes are selected.

To record time out, select a name on the list of clocked in employees (right side of screen) and
click Clock OUT. The time out appears near the employee’s name on the right side of screen,
and the name is added back to the list of clocked out employees (left side of screen).

5. When you are done recording in and out times for other employees, click Clock In/Out Others
(again). The Clock In/Out Others status changes from On (red) toOff (black).

6. Do one of the following as needed:
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Click away from the time clock. This will allow it to continue running while you perform other
TireMaster tasks.

Close the time clock.

ENTER TIME IN AND OUT MANUALLY
You can record time manually in the following scenarios:

When you need to correct a mistake

When you were unable to enter your time for a previous shift

When you need to report unworked time due to holidays, vacation, illness, jury duty, or
bereavement leave

Manual time entry can also be used to record or correct time entries for other employees. The following
instructions describe manually recording time in TireMaster 9.4.0.

Note: To record manual time clock entries, you must belong to a security group assigned the
permission Time Clock Manual Entry.

To manually enter time in and out
1. Access the time clock using one of the following methods:

If the time clock is already running, click on the Windows Task Bar.

If the time clock is not running, click Time Clock on the menu.

2. Do one of the following:

If you’re going to enter time for yourself, select your name.

If you’re going to enter time for another employee, select that person’s name.

3. ClickManual Time Entry. The login prompt appears.



Time Clock

4. Type your TireMaster user name and password, and clickOK. The Manual Time Entry screen
opens.

5. For a new entry, do the following. If you do not need to enter a new time, disregard this step.

a. Select the week for the entry from the drop-down (upper-right corner).

b. Click the day of the week for which you need to enter time. The day abbreviation turns red.

Note: The numbers underneath the day abbreviations represent the total number of hours
and minutes worked during a day. For example, 8 - 20 means the employee worked
eight hours and twenty minutes.

c. Click Add. The Add Time Menu opens.
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d. Select the hours and minutes as needed from the Time In and Time Out drop-downs.
Tip: If the entry is for eight hours of holiday, vacation, illness, jury duty, or bereavement

time, you can disregard this step. TireMaster will automatically enter eight hours for
you (in step 5e).

e. If the entry is not for regular work time, select the applicable time category.

f. ClickOK.
6. To correct an entry, do the following. If you do not need to correct a time entry, disregard this step.

a. Select the week for the entry from the drop-down (upper-right corner).

b. Click the day of the week for which you need to make a correction. The day abbreviation turns
red.



Time Clock

c. Click Edit.The Edit Time Menu opens.

d. Change the hours and minutes as needed, using the Time In and Time Out drop-downs.

e. If you need to change the time category, select the applicable option.

f. ClickOK.
7. To delete an entry, do the following. If you do not need to remove a time entry, disregard this step.

a. Select the week for the entry from the drop-down (upper-right corner).

b. Click the day of the week for which you need to delete a time. The day abbreviation turns red.
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c. Select the entry you want to remove and click Delete.

8. Close the Manual Time Entry screen.

TIME CLOCK ENTRIES FOR TIME OFF
The TireMaster Time Clock accommodates entries for scenarios in which employers often grant
employees paid time off. Time entries for holidays, vacation, illness, jury duty, or bereavement need to
be entered manually. Holiday time can also be entered for a group of employees by making a global
entry. For more information, see Enter Time In and Out Manually on page 872 or Add a Global Time
Entry on page 876.

ADD A GLOBAL TIME ENTRY
With a global entry, you can record time that affects all employees or a group of staff members. Global
entries can be made for regular work time and holiday time. This functionality is available in TireMaster
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9.4.0.

When you make a global time entry for a group of employees, you need to define the employees to
whom the entry does not apply.

Example: If you have both full and part-time employees and only the full-time employees
are eligible for holiday pay, you would exclude the part-time employees from the global
entry for a holiday.

Note: To record a global time entry you must belong to a security group assigned the permission
Time Clock Entry of Others.

To add a global time entry
1. Access the time clock using one of the following methods:

If the time clock is already running, click on the Windows Task Bar.

If the time clock is not running, click Time Clock on the menu.

2. Click Clock In/Out Others. A login prompt appears.

3. Type your TireMaster user name and password, and clickOK. The Clock In/Out Others status
changes toOn (red).
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4. ClickGlobal Time Entry. The Manual Time Entry screen opens.

5. If the time entry will not apply to some employees, select the checkboxes next to their names. If
none of the employees need to be excluded from the time entry, disregard this step.



Time Clock

Tip: If most of the employees need to be excluded from the entry, clickMark All. Then clear the
checkboxes for staff members to whom the time entry applies. If you need to remove check
marks for all employee names, click UnMark All.

6. Add the details for the global time entry.

a. Select the week for the entry from the drop-down (upper-left).

b. Click the day of the week for the entry. The day abbreviation turns red.

c. Click Add. The Add Time Menu opens.

d. To accept the default eight hour entry, leave the in and out times alone. For a different number
of hours, change the in and out times.

879



880

User Guide

e. If this entry is not for a holiday, select Regular. Otherwise, disregard this step.
f. ClickOK.

The following message appears: “Are you sure you want to add this time, except for those marked
as excluded?”

7. Click Yes.
8. Close the Manual Time Entry screen.

9. Click Clock In/Out Others. The Clock In/Out Others status changes toOn (red).

TIME CLOCK REPORT
With the Time Clock Report, you can generate a list of time clock entries for a user-defined date range.
Along with the time clock entries, the report also includes the following for each employee:

The total number of hours worked by time category

The total number of minutes worked during a date range

You also have the option to generate a breakdown of each employee’s regular and overtime hours for
one or two work weeks. You can use this information to prepare paychecks.

Depending on your security settings, you can print a report for yourself or all employees.

Note: To generate the report for all employees, you must belong to a security group assigned the
permission Time Clock Entry of Others.

The following instructions describe printing the report in TireMaster 9.4.0.

To generate a Time Clock Report
1. If the time clock is not already displayed, do one of the following:

If the time clock is already running, click on the Windows Task Bar.

If the time clock is not running, click Time Clock on the menu.
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2. Click Print. The login prompt appears.

3. Type your TireMaster user name and password, and clickOK. The Time Clock Report screen
opens.

4. Define the date or date range for the time clock entries you want to include on the report. For a
single day, use the same date for both the beginning and end of the range.

Note: In addition to the time clock entries, the report will also include the total number of hours
worked by time category and the total number of minutes worked during a date range for
each employee.

5. Define whether the report is for one employee or all employees.

For all employee times, leave the Employee field blank.
For one employee, click the Employee field and press . When the User List opens, select a
name and clickOK.
Note: If you’re allowed to generate the report only for yourself, your user ID will be

automatically entered in the Employee field.

6. For a breakdown of each employee’s regular and overtime hours, define the dates for one or two
weeks in a pay period.

a. For one week, select checkbox 1. Then define the date range.
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b. For a second week, select checkbox 2. Then define the date range.
7. If you want to print a separate page for each employee, select the Page Break by Employee

checkbox.

8. Click Print. The Report Window opens.

9. Print the report and close the Report Window.

10. Close the Time Clock Report screen.
11. Do one of the following as needed:

Click away from the time clock. This will allow it to continue running while you perform other
TireMaster tasks.

Close the time clock.

FLAT RATE REPORTING
Flat rate reporting is method of measuring employee productivity. You can assign a flat rate, which is
the amount of time it takes an average mechanic to complete a job, to each of your labor items. You
can then base a mechanic’s payment for performing a service or repair on the flat rate assigned to the
job, regardless of how much time was actually spent completing the work.

SET AN ITEM’S FLAT RATE
You can set an item’s flat rate by including the number of hours an average mechanic takes to
complete the service or repair in the item’s price and quantity settings. Flat rates for the automotive
field are published in industry labor guides, or you use a rate of your choice. Assign flat rates to labor
items only.
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Note: For a list of items whose flat rates have already been set, generate the Inventory Flat Rate
Report. For more information, see Inventory Flat Rate Report on page 1000.

To set an item’s flat rate
1. Look up the item whose flat rate you want to set. For more information, see Inventory Searches on

page 230.

2. On the Inventory Maintenance screen, click theQty/Pricing tab.

3. Click Detail/Edit. The Site Prices & Quantity screen opens.

4. Type the average number of hours needed to complete the job in the Flat Rate field.

5. To save your changes, clickOK.

6. Close the Inventory Maintenance screen.

CALCULATE MECHANIC PRODUCTIVITY
Calculating the number of hours that a mechanic worked is a two-step process. First, add the job to a
work order. If a flat rate has already been assigned to the item, that value will be included on the work
order automatically. You can pay the mechanic for the number of hours defined by a job’s default flat
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rate, or you can enter a different number of hours.

When you’re ready to see the number of hours produced by a single mechanic or a group of
mechanics, print a Mechanic Flat Rate Report. This report can be generated on a daily, weekly, or
monthly basis.

To calculate mechanic productivity
1. Start a work order. For more information, see Create a Regular Work Order on page 442.

2. Add a job (labor item) to the work order. The flat rate that has been assigned to the job is displayed
in the Flat Rate column.

3. Assign the mechanic to the items on the work order. Click theMech 1 field for the first item listed,
type the mechanic’s ID, and press .

Note: If you don’t know the mechanic’s ID, press , and select the mechanic’s name from the list
that appears.

4. When the mechanic is done with the job, enter one of the following in theQty column:
The amount of time you want to bill the customer.

Example: If you told the customer the job would take two hours, you’d type the number 2. If
the customer has been waiting on site and knows the work was finished in less time, you
might enter the amount of time it took to complete the repair or you might change the price
you’re charging the customer instead.

The job’s flat rate

The quantity of 1
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Note: For quick and simple jobs, such as flat repairs, some dealers prefer to use a fixed
quantity of 1 instead of a time.

5. If you want to pay the mechanic for the number of hours defined by the job’s default flat rate, leave
the entry in the Flat Rate column alone. If you want to base the payment on a different number of
hours, change the value in the Flat Rate column.

6. Complete the invoice. For more information, see Complete an Invoice on page 456.

7. Generate a flat rate report. For more information, see Mechanic Flat Rate Report on page 1059.
On the report, the number of hours worked is displayed under the flat rate heading.

COLOR/SPIFF CODES
A spiff is a bonus given to salespeople as incentive to sell items. When color/spiff codes are assigned
to items, TireMaster includes bonuses on the Commission Report for employees who sold the items.
When items are assigned color/spiff codes, they're easy to spot on the Inventory List, because they're
highlighted in the colors defined in the color/spiff code settings.

Tip: You can also use color/spiff codes to help employees identify specific items, such as those that
have been discontinued. Because it's likely you won't pay a bonus for selling items in such a
scenario, leave the spiff dollar amount and percentage fields blank.

To find out which spiffs are assigned to items, print the Inventory Spiff Report. To see how much
employees earned in spiff bonuses, print the Spiff Salesperson Report. For more information, see
Inventory Spiff Report on page 1022 or Spiff Salesperson Report on page 1096

ADD A COLOR/SPIFF CODE
The settings for a color/spiff code define how the spiff bonus is calculated and which color is used to
identify the spiff when it's assigned to items. Spiffs can be either a percentage of an item’s selling price
or a specific dollar amount.

To add a color/spiff code
1. Select Inventory > Color & Spiff Codes. The Color/Spiff Code List opens.

2. Click Add. The Color/Spiff Code Edit screen opens.
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3. Type a code and description for the new color/spiff code.

Note: Depending on the width of the letters or numbers used, the spiff code can be one or two
characters long.

4. Define the spiff amount if needed:

To pay a fixed dollar amount each time items assigned the spiff code are sold, type the amount
in the Spiff $ field.

To pay a percentage of the selling price each time items assigned the spiff code are sold, type
the percentage in the Spiff % field.

If the spiff will be used to identify specific items, such as those that are discontinued, leave the
Spiff $ and Spiff % fields blank.

5. Select a color for the spiff:

a. Click Select. The Color screen opens.

b. Click one of the basic or custom color swatches.
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Tip: To create a custom color, click Define Custom Colors. Then select the color you want
to use, and click Add to Custom Colors.

c. ClickOK.

6. To save the new spiff, clickOK (again).

7. Close the Color/Spiff Code List.

MANAGE EXISTING COLOR/SPIFF CODES
Existing color/spiff codes can be modified when the display properties or bonus calculations need to
be changed, and unused color/spiff codes can be eliminated.

UPDATE A COLOR/SPIFF CODE
Updating a color/spiff code can include changing the description, color, or bonus calculation.

To update a color/spiff code
1. Select Inventory > Color & Spiff Codes. The Color/Spiff Code List opens.
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2. Select the color/spiff code you want to update and click Edit. The Color/Spiff Code Edit screen
opens.

3. Change the description if needed.

4. Define the spiff amount if needed:

To pay a set dollar amount each time items assigned the spiff code are sold, type the amount
in the Spiff $ field.
To pay a percentage of the selling price each time items assigned the spiff code are sold, type
the percentage in the Spiff % field.

If the spiff will be used to identify particular items, such as those that are discontinued, leave
the Spiff $ and Spiff % fields blank.

5. Change the color if needed.

a. Click Select. The Color screen appears.
b. Click one of the basic or custom color swatches..

Tip: To create a custom color, click Define Custom Colors. Then select the color you
want to use, and click Add to Custom Colors.

c. ClickOK.
6. To save your changes, clickOK (again).

7. Close the Color/Spiff Code List.

DELETE A COLOR/SPIFF CODE
If a color/spiff code is not being used, you can delete it.

To delete a color/spiff code
1. Select Inventory > Color & Spiff Codes. The Color/Spiff Code List opens.
2. Select the color/spiff code you want to delete, and click Delete.



Color/Spiff Codes

3. When the confirmation message appears, click Yes. The color/spiff code is removed from the
database.

4. Close the Color/Spiff Code List.

ASSIGN COLOR/SPIFF CODES TO ITEMS
Once color/spiff codes are established, you can assign them to individual items or groups of items.

ASSIGN A COLOR/SPIFF CODE TO A SINGLE ITEM
To assign a color/spiff code to a single item
1. Search for the item. For more information, see Inventory Searches on page 230.

2. On the Inventory Maintenance screen (General tab), click Edit.

3. Click the Color/Spiff field, press , and select a spiff code from the list that appears.

4. To save your changes, clickOK.

ASSIGN VARIOUS COLOR/SPIFF CODES TO A GROUP OF ITEMS
If you want to assign various color/spiff codes to multiple items, use Inventory List Editing to
complete the assignments.

To assign various color/spiff codes to a group of items
1. Select Inventory > List Editing.
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2. Search for a group of items. For more information, see Inventory Searches on page 230.

3. Insert a code in the Color/Spiff field for as many items as needed. For more information, see
Update Information for Multiple Items on page 211.

Tip: Rearrange the columns so item descriptions, product codes, or some other identifying
information is displayed next to the Color Spiff column. To move a column, click its
heading and drag it to a different position

4. Close the Inventory List Editing screen.

ASSIGN THE SAME COLOR/SPIFF CODE TO A GROUP OF ITEMS
If you want to use the same color/spiff code for a group of items, you can assign the code with the
Pricing Wizard.

To assign the same color/spiff code to a group of items
1. Select Inventory > Pricing Wizard.

2. When the Pricing Wizard opens, make sure Price Change is selected.
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3. From the Field to Update drop-down for the operation being used to update the color/spiff code,
select Color/Spiff. A second drop-down appears and replaces the price change fields.

4. Select the color/spiff code you want to assign from the drop-down.

5. Click Inventory, and look up the item or items to which you want to assign the color/spiff code.
For more information, see Inventory Searches on page 230.

6. Review the pending changes.

a. Click Print for Review. The Report Window opens and displays the Pricing Wizard Report.
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b. Verify that the changes you want will be made.

c. Print the report if needed, and close the Report Window.

7. Click Apply. A confirmation message appears.

8. Click Yes. A second message verifies the update has been completed.

To view the color/spiff code assignment, look up the same items you just updated. On the Inventory
List, they’ll be shown in the color associated with the selected code.

COMMISSIONS
TireMaster calculates employee commissions based on a variety of preset values arranged in a grid,
called the Commission Matrix (Figure 28-1). You can set up a Commission Matrix for each employee.

Figure 28-1: A Commission Matrix

Before you can design a commission matrix for each employee, you need to add the following to
TireMaster:

Customer commission types, which are listed down the left side of the matrix
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Inventory commission types, which are listed across the top of the matrix

Commission codes (also called commission matrix codes), which are contained in the cells of
the matrix

To calculate the commission for a sale, TireMaster looks at the code entered in the spot on the matrix
where the customer’s commission type meets the commission type for the items sold. In other words,
the amount of commission calculated depends on the type of customer and the type of items involved
in a sale.

CUSTOMER COMMISSION TYPES
With customer commission types, you can calculate commissions based on the different kinds of
customers who buy your products and services. For example, you might pay a higher commission for
commercial sales than you would for regular sales.

New customers are automatically assigned the default customer commission type. However, you can
change customer's assigned type if needed.

Note: If there is no entry in the Commission field on the Customer Maintenance screen, TireMaster
uses the default customer commission type for calculating commissions. For more
information, see Set the Default Customer Commission Type on page 895.

ADD A CUSTOMER COMMISSION TYPE
If you want to calculate commissions based on sales to different groups of customers, you need to
create multiple customer commission types. You should also set up a type to use for non-
commission sales, such as transfers.

Note: You also need to set up inventory commission types and assign them to your inventory items.
For more information, see Inventory Commission Types on page 895.

To create a customer commission type
1. Select Setup > Customer Commission Types. The Customer Commission Types screen

opens.

2. Click Add. The Customer Commission Type Edit screen opens.
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3. Type a unique 1-character code in the Type field.
Note: This code cannot be used for any inventory commission type.

4. Type a name for the customer commission type in the Description field. (For example, Regular
Sales or Commercial Sales.)

5. To save the new customer commission type, clickOK.

6. Close the Customer Commission Types screen.

ASSIGN A CUSTOMER COMMISSION TYPE
If you want to pay commissions, you need to assign customer commission types to your clientele.
Assigning commission types to customers defines how TireMaster calculates commissions when you
sell products and services to them.

Note: If no commission type code is entered for a customer, TireMaster uses the default customer
commission type set in System Controls. For more information, see Set the Default Customer
Commission Type on page 895.

To assign a customer commission type
1. Select Customers > Maintenance. TireMaster prompts you for the customer's name.

2. Search for the customer to whom you want to assign a commission type. For more information,
see Customer Searches on page 93.

3. On the Customer Maintenance screen (General tab), click Edit.
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4. Click the Commission field, press and select the type you want to assign from the list.

5. To save your changes clickOK. Then close the Customer Maintenance screen.

SET THE DEFAULT CUSTOMER COMMISSION TYPE
If you don’t assign a commission type to a customer, TireMaster automatically assigns the default
commission type, which is defined by setting a system control. When you set the default customer
commission type, use the one that you’d assign to the majority of your customers. For instructions,
see Set the Commission Controls on page 899.

INVENTORY COMMISSION TYPES
With inventory commission types, you can calculate commissions based on the different kinds of items
sold. For example, you might pay a higher commission for tires than you would for service parts.

New items are assigned the default inventory commission type automatically. However, you can
change the type assigned to a customer if needed.

ADD AN INVENTORY COMMISSION TYPE
If you want to calculate commissions based on sales of different kinds of items, you need to create
multiple inventory commission types. Also set up a type to use for items for which no commission is
paid, such as shop supplies and disposal fees.

Note: You also need to set up customer commission types and assign them to your customers. For
more information, see Customer Commission Types on page 893.
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To add an inventory commission type
1. Select Setup > Inventory Commission Types. The Inventory Commission Types screen

opens.

2. Click Add. The Inventory Commission Type Edit screen opens.

3. Type a unique 1-character code in the Type field.
Note: This code cannot be used for any customer commission types.

4. Type a name for the commission type in the Description field (for example, Tires &Wheels or
Warranties).

5. To save the new type, clickOK.

6. Close the Inventory Commission Types screen.

ASSIGN AN INVENTORY COMMISSION TYPE
If you want to pay commissions, you need to assign inventory commission types to your items.
Assigning commission types to items defines how TireMaster calculates commissions when you sell
them.

Note: You can set a default inventory commission type in System Controls. For more information,
see Set the Default Inventory Commission Type on page 897.

To assign an inventory commission type
1. Select Inventory > Maintenance. TireMaster prompts you to search for an item.
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2. Look up the inventory item whose commission type you want to assign. For more information,
see Inventory Searches on page 230.

3. On the Inventory Maintenance screen (General tab), click Edit.

4. Click the Commission field, press , and select the commission type you want to assign from
the list.

5. To save your changes, clickOK. Then close the Inventory Maintenance screen.

SET THE DEFAULT INVENTORY COMMISSION TYPE
If you don’t assign a commission type to an inventory item, TireMaster automatically assigns the
default commission type, which is defined by setting a system control. When you set the default
inventory commission type, use the one that you’d assign to the majority of your items. For
instructions, see Set the Commission Controls on page 899.

COMMISSION CODES
Commission codes define the rates for calculating commissions. Commission codes are assigned to
employees in the Commission Matrix. TireMaster then calculates the commission based on the
combination of customer and inventory commission types. You can pay different commissions
depending on the role (mechanic or salesperson) an employee plays during a sale.
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CREATING COMMISSION CODES
Commission codes define how the following commission rates are calculated:

Unit Rate is the primary rate for the commission. This value can be either a percentage or a
flat dollar amount.

Mechanic 2 Rate is the amount of commission that a second mechanic gets for a sale. This
value is a percentage of the unit rate.

You can base the calculations for commission rates on the percentage of the profit, a percentage of a
sale, or you can set a fixed dollar amount. When you create commission codes, set up one for each
rate, along with one to use for those instances in which no commission is paid.

To create a commission code
1. Select Setup > Commission Matrix Codes. The Commission Codes list opens.

2. Click Add. The Commission Code Edit screen opens.

3. Type a code for the commission.

Note: The code can have four letters, numbers, or a combination of both.

4. Type a name for the commission code in the Description field. (For example, Senior Mechanic
or Sales.)

5. Type the percentage or dollar amount for the commission in the Unit Rate field. For a percentage
of gross sales or gross profit, enter the rate in decimal form (such as .10 or .30).

6. Type the percentage of the commission that a second mechanic receives in theMechanic 2
Rate field.
Note: If only one mechanic is entered in theMech 1 column on the Invoice Entry screen, that

mechanic receives the entire commission. If a second mechanic is entered in theMech 2
column, that mechanic receives a percentage of the unit rate based on the value entered
in theMechanic 2 Rate field.

7. Select an option for calculating the commission:
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Gross Profit calculates the commission based on gross profit.
Gross Sales calculates the commission based on total sales.
Flat $ Amount calculates the commission based on a set dollar amount for each unit.

8. To save the new commission code, clickOK.

ASSIGN COMMISSION CODES
Commission codes can be assigned to the commission matrix for each employee. Assigning
commission codes defines the rate to pay when a certain customers buy certain items. For more
information, see Set Up an Employee Commission Matrix on page 901.

SET THE DEFAULT COMMISSION MATRIX CODE
If you don’t assign a commission code to a matrix, TireMaster automatically assigns the default
commission type, which is defined by setting a system control. For more information, see Set the
Commission Controls on page 899.

SET THE COMMISSION CONTROLS
When you’re finished adding commission codes and types, set the commission defaults in System
Controls. TireMaster uses these default settings when customers, items, or users do not have a
commission type or code assigned to them.

Note: Once you define a default commission setting, you cannot go back to having no default. You
can, however, reset the default to use a code that you don’t assign to anything.

To set the commission controls
1. Select Setup > System Controls. The System Controls screen opens.

2. Make sure the Commission tab is selected.
3. Set the commission cutoff date.
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a. Select Commission Cutoff Date - Most Recent, and press Enter.

b. Select the date of your most recent commission cutoff, and clickOK.
Note: Once you clickOK, the commission cutoff date cannot be changed.

4. Set the default commission matrix code.

a. Select Default Commission Matrix Code, and press Enter.

b. Select the code that you want to use as the default, and clickOK.
5. Set the default customer commission type.

a. Select Default Commission Type - Customer, and press Enter.

b. Select the type that you want to use as the default, and clickOK.
Note: Unlike other TireMaster default settings, the default customer commission type code

does not automatically appear on the Customer Maintenance screen when you add a
new customer.

6. Set the default inventory commission type.

a. Select Default Commission Type - Inventory, and press Enter.
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b. Select the default inventory commission type that you want to use, and clickOK.
Note: Unlike other TireMaster default settings, the default inventory commission type code

does not automatically appear on the Inventory Maintenance screen when you add a
new customer.

7. Set the commission matrix that will be assigned to users by default.

a. Select Default Employee - Commission Matrix, and press Enter.

b. Select the name of an employee or a commission matrix template. The matrix for the selected
employee or template will be used as the default matrix.

8. Close the System Controls screen.

Note: Although the control Sales Spiff - Customer Type to Exclude is included on the
Commission tab, setting it is not required for handling commissions.

THE COMMISSION MATRIX
You can define how much commission an employee will earn by setting up a grid called the
Commission Matrix.

SET UP AN EMPLOYEE COMMISSION MATRIX
To set up an employee’s commission matrix, you need to assign a commission code to each
combination of customer and inventory commission types. The number of combinations available,
along with the number of codes you need to assign, depends on how many customer and inventory
commission types are have been set up in TireMaster.

You can reduce the amount of time needed to set up a commission matrix in two ways:

Copy another user’s matrix into the one you’re setting up, and make any needed changes.
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Copy a commission matrix template into the one you’re setting up, and make any needed
changes. For more information, see Create Commission Matrix Templates on page 903.

To set up an employee commission matrix
1. Select Setup > Users & Permissions. The User List opens.

2. Select the user whose matrix you want to set up, and click Edit. The Employee/User Edit screen
opens.

3. Click Commissions. The Commission Matrix screen opens.

4. Enter a code into each cell of the matrix, using one of the following methods:

Click the cell whose code you want to update, press , and select a code from the list.
Repeat this process until all cells in the matrix are filled.

To copy another user’s matrix or commission matrix into the one you’re setting up, click Copy
and make a selection from the list that appears. You can leave the copied matrix as is or
modify it using the method described above.
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5. To save the changes to the matrix, clickOK.

6. Close the Employee/User Edit screen.

CREATE COMMISSION MATRIX TEMPLATES
If the commission matrix will be the same or similar for several employees, you can reduce the
amount of setup time by creating one or more commission matrix templates. Creating a template
includes setting up a generic user and the entering codes for the generic user’s matrix.

Note: Any changes you make to a commission matrix template are used only when new users are
added to TireMaster. However, you can update an existing user’s matrix by copying the
modified template.

To create a commission-matrix template
1. Select Setup > Users & Permissions. The User List opens.

2. Create a generic user.

a. Click Add. The Employee/User Edit screen appears.

b. For the name, type ZZ-Commission Template or another similar name.

c. For the user ID and password, type COMM or another similar code.
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3. Set up the generic user’s matrix.

a. Click Commissions. The Commission Matrix screen appears.

b. Enter a commission code into each cell of the matrix. Click the cell you want to update, press
, and select a commission code from the list. Repeat this process until all cells in the matrix

are filled.

c. To save the changes to the matrix, clickOK.

4. Close the Employee/User Edit screen.

CALCULATE COMMISSIONS FOR PAYROLL
By generating the Commission Report, you can determine the amount of commission to pay. A few
days before the end of each pay period, you might want to print the report and review it with your
employees. If there are discrepancies, you can change commission percentages before the end of the
pay period.

Once you’re satisfied with the calculations, you can lock the commissions for the pay period by
launching the report again and clicking Save & Lock. Once the commissions are locked, they cannot
be changed. For more information, see Commission Report on page 1035.



CASINGS
You can use TireMaster's Casing Manager to track the casings you send to a retread facility. Once the
retreading is complete, you can also use it to handle the process of returning the finished goods to their
owners, selling them to the retreader, or adding them to your inventory.

Retread Scenarios 906
Prepare to Track Casings 909
Add Casings to the Casing Manager 912
Send Casings to a Retreader 914
Mark Casings as Defective 916
Record Retreading Service Fees 918
Casing Credits 921
Casing Manager Reports 926
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RETREAD SCENARIOS
Typically, there are three retread scenarios in which the Casing Manager is used:

To facilitate retread services. In this scenario, you collect casings from customers and send
them to a retreading plant where they’re repaired and recapped.

To buy casings from a customer and add them to your inventory. In this scenario, you collect the
casings from a customer, send them to the retreader, and then add the finished retreads to your
inventory. At the end of this process, you give the customer a credit for the casings you’ve
purchased.

To buy casings from a customer and sell them to a retreader. In this scenario, you collect the
casings from a customer and send them to the retreading plant. At the end of this process, the
retreader keeps the finished casings and gives you a credit for them. Then you turn around and
give the customer a credit for selling the casings to you.

FACILITATE RETREAD SERVICES
You can use the Casing Manager to facilitate retreading services for your customers. In other words,
you’re the middleman who ensures that a customer’s casings are sent to a retreader and then returned
to the customer once the recapping and repairs are finished.

To complete this type of transaction, you need to do the following:

Generate a vendor charge for the various costs that the retreader passes on to you.

Charge the customer service fees for the finished retreads and disposal fees for any casings
that were defective.

To facilitate retreading services
1. Add the customer’s casings to the Casing Manager. For more information, see Add Casings to the

Casing Manager on page 912.

2. Send the casings to the retreader. For more information, see Send Casings to a Retreader on
page 914.

3. When the retreader returns the order, do the following:

If the order included casings that the vendor refused to retread, mark them as defective and set
them aside. For more information, see Mark Casings as Defective on page 916.

For each finished retread, record the recap and repair costs and the amount of the service fee
you’re going to charge the customer. For more information, see Record Retreading Service
Fees on page 918.

4. Once all of the finished retreads and defective casings on the order have been received, generate
a work order for the customer (so you can collect your service and disposal fees).

a. Display only the orders that have been returned. If you’re using the Casing Manager’s default
status settings, make sure Received is selected.
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Tip: If you know the order number, tag ID, or number for a casing in the order, you can
locate the order with the Search by drop-down list. Select the parameter you want to
use (such as number), then type the number or ID and click Find. To include all orders,
regardless of status, select the Search All check box.

b. Select the order and click Create Work Order. A confirmation message opens.

c. ClickOK to close the confirmation message.

d. Close the Casing Manager.

5. Return the finished retreads to the customer and collect your service and disposal fees.

a. If the OpenWork Order List isn’t already open, click Invoicing.
b. Select the customer’s work order, and click Select. The Invoice Entry screen opens. It lists the

finished retreads and fees that the customer is being charged.

c. Add items or make other changes to the work order, if needed. For more information, see
Create a Regular Work Order on page 442

d. Complete the invoice and collect the payment from the customer. For more information, see
Complete an Invoice on page 456.

BUY CASINGS FROM A CUSTOMER
At times, you might buy casings from a customer. Once they’ve been retreaded you can add the
finished caps and casings to your inventory and sell them in your store. When you buy a finished
retread, TireMaster generates a credit in the subledger account for the customer who originally
brought the casings to you.
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To buy casings from a customer
1. Add the customer’s casings to the Casing Manager. For more information, see Add Casings to the

Casing Manager on page 912.

2. Send the casings to the retreader. For more information, see Send Casings to a Retreader on
page 914.

3. When the order is returned, do the following:

If the order included casings that the vendor refused to retread, mark them as defective. For
more information, see Mark Casings as Defective on page 916.

For each finished retread that you’re going to buy, record the credit that you’ll give the
customer, along with the cost of recapping the casing. Then add the finished retreads to your
inventory. For more information, see Issue Casing Credits to a Customer on page 921.

4. Verify that the customer’s ledger history includes a credit for each casing that you bought.

5. If you assess fees for handling defective casings, create a work order and charge the customer a
fee for each rejected casing. For more information, see step 4 of Facilitate Retread Services on
page 906.

SELL CASINGS TO A RETREADER
Sometimes retreaders will offer to buy the casings that customers have brought to you once they’ve
been retreaded. You can use the Casing Manager to record the credit you’ll receive from the retreader,
along with the credit you’ll give the customer.

To sell casings to a retreader
1. Add the casings to the Casing Manager. For more information, see Add Casings to the Casing

Manager on page 912.

2. Send the casings to the retreader. For more information, see Send Casings to a Retreader on
page 914.

3. When the order is finished, do the following:

If the order included casings that the vendor refused to retread, mark them as defective. For
more information, see Mark Casings as Defective on page 916.

For each finished retread that you’re going to sell to the retreader, record the credit that the
retreader will give you and the credit that you’ll give to the customer for the cap. For more
information, see Issue Dual Casing Credits on page 924.

4. Verify that there is a vendor credit for each finished retread in the retreader’s ledger history.

5. Verify that there is a credit for each casing that you bought in the customer’s ledger history.

6. If you assess fees for handling defective casings, create a work order and charge the customer a
fee for each rejected casing. For more information, see step 4 of Facilitate Retread Services on
page 906.
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PREPARE TO TRACK CASINGS
Before you can begin to track casings in TireMaster, you need to enable the Casing Manager and
complete various settings that define how the process is handled. Before you can set up the Casing
Manager, ASA Support needs to activate this feature for you.

Note: The Casing Manager and the Core Manager both use the same setup screen.

To set up the Casing Manager
1. Log a call with ASA Support to activate the Casing Manager.

Note: During the activation, a Support representative will also review the process of setting up
the Casing Manager with you.

2. Add GL accounts for tracking retread items, sales, and expenses to the chart of accounts. For
information about the recommended accounts for handling Casing Manager activity, see GL
Accounts for the Casing Manager on page 1232.

At a minimum, you need the following.

An asset account for casings and an asset account for caps, if your retread casing item and
retread cap items (set up in step 4) will be classified as inventoriable.

An income account for retread sales.

An expense account for processing retreads.

Note: This expense account is to be used by the Casing Manager only to post the cost of
caps to the general ledger. It will be assigned to the GL code for the clearing item (in
step 4) and it needs to be assigned in the Expense Account field on the Core/Casing
Setup screen.

3. Add GL codes that will be assigned to the inventory items used for tracking retread activity. Each
GL code should be assigned a unique expense account. For information about the recommended
accounts for handling Casing Manager activity, see GL Codes for the Casing Manager on page
1233.

4. Add the following items to your inventory. When you add the items, disregard setting prices for
them. For information about the items recommended for handling Casing Manager activity, see
Inventory Items for the Casing Manager on page 1237.

A clearing item, which is used to make adjusting entries when finished retreads are received.
The clearing item needs to be classified as noninventoriable.

A casing item, which is used to track the cost of casings that are retreaded. To include profit
and loss information for casings on sales reports, classify the casing item as an inventoriable
item. Otherwise, it can be classified as noninventoriable.

A cap item, which is used to track the cost of caps added to casings that are retreaded. To
include profit and loss information for caps on sales reports, classify the cap item as an
inventoriable item. Otherwise, it can be classified as noninventoriable.
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A repair item, which is used to track the cost of repairs made to a casing. The repair item needs
to be classified as noninventoriable.

A miscellaneous item, which is used to track the cost of any other items used to create a
retread. The miscellaneous item needs to be classified as noninventoriable.

Note: To simplify general ledger research for retread activity, each item should be assigned a
unique GL code and each of the GL codes should be assigned unique expense accounts.

For more information, see Add an Inventory Item on page 205.

5. Open the casing setup screen.

a. Click Invoicing. The OpenWork Order List opens.

b. Click Core Case. The Casing Manager screen appears.

c. Click Setup.

6. In the At Store, At Retreader, and Returned fields, type labels that describe the status of the
casings you’re tracking (For example, the labels could state whether casings are at your store or at
the retread plant.) These labels will be listed next to the heading View Status on the Casing
Manager screen. If you prefer, you can use the labels that have been provided.

7. Define the starting tag ID, order number, or both (optional). If you use your own tags, books, or
both to track individual casings that are sent to the plant, type the starting numbers in the Default
TagID and Default Order # fields. These numbers will be incremented as casings are added to the
Casing Manager.
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8. Complete the following inventory and vendor settings:

If you want casings and caps to be treated as separate items in TireMaster, select Yes from the
Separate Casings and Caps drop-down. Otherwise, leave this setting alone.
Note: ASA recommends setting Separate Casings and Caps to No.

If the default retread vendor should automatically be selected every time you add a casing to
track, select Yes from the Always Use Default Vendor drop-down. Otherwise, leave this
setting alone. (You’ll define the default vendor in step 9.)

9. Do the following to define the default vendor, the clearing account, and inventory items for tracking
casings. For better control of how retread activity posts to the general ledger and to simplify GL
research, assign unique account numbers and items for each setting.

For Default Vendor, click Lookup and look up the vendor to whom you send the majority of
your retreads.

For Expense Account, click Lookup and look up the general ledger account for processing
retreads.

For Clearing Item, click Lookup and look up the inventory item that will be used to make
adjusting entries when finished retreads are received.

For Casing Item, click Lookup and look up the inventory item for tracking casings.

For Cap Item, click Lookup and look up the inventory item for tracking caps.

For Repair Item, click Lookup and look up the inventory item for tracking repairs.

ForMisc. Item, click Lookup and look up the inventory item for tracking miscellaneous items.
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10. If you also track cores, you can define the clearing account and core item. Otherwise, skip this
step. For more information, see Prepare to Track Cores on page 931.

11. Save the entries that you made in the Core/Casing Setup screen. Then close it.

ADD CASINGS TO THE CASING MANAGER
When a customer brings you casings that need to be sent to a retreader, add them to the Casing
Manager. You can add casings to the Casing Manager from a work order or the Casing Manger itself.

To add casings to the Casing Manager
1. Use one of the following methods to open the Add/Edit Casings screen:

Start a work order for the customer who has brought you the casings. Then click Casings on
the Invoice Entry screen. For more information, see Create a Regular Work Order on page 442.

Click Invoicing. Then click Core Case on the OpenWork Order List. When the Casing
Manager opens, click Receive/Buy Casings, and look up the customer who brought you the
casings. For more information, see Customer Searches on page 93.



Add Casings to the Casing Manager

2. Add the following information for the first casing in the group of tires that will be retreaded. Fields
for required information are labeled in red.

The number of casings that the customer brought to you (required).

The starting tag ID number

Note: If you don’t want to use the default starting number defined in the Casing Manager
setups, clear the Use Default check box.

The size of the casing (required)

Tip: To fill in the rim size automatically, press the Tab key after typing the tire’s size.

The casing’s rim size

A description of the casing (required)

Whether you’ll buy the casing from the customer—select Yes or No from the Buy From
Customer drop-down.
The amount you plan to pay the customer for the casing (if you’ll buy it)

The type of tread that will be put on the casing

Type casing’s number

Notes about the casing

3. ClickOK. The Process Casings screen opens. The number of rows displayed equals the number
that you typed in the # of Casings or Tags field on the Add/Edit Casings screen.

913



914

User Guide

4. Update the information for each row as needed. For example, you might need to make changes for
any variations in sizes, descriptions, or serial numbers. There should be one row for each casing
that the customer has brought to you.

To update information about a casing, click the cell that the information is in. Then click the cell again
to make the text editable, and type your changes.

Tip: You can copy the information in one cell to the cell below it by pressing . For example, if
you change the description of the casing in the first row to Goodyear Wrangler and press
, the description for the second row will change to Goodyear Wrangler.

5. Update the vendor (retreader) if needed. To select a retreader, click Lookup and look up the
vendor you want to use. For more information, see Vendor Searches on page 193.

6. To save the casing information, click Complete.

7. Close the Casing Manager screen.

SEND CASINGS TO A RETREADER
Once you’ve sent casings to a retreader, update the entries in the Casing Manager so you know that
those items are no longer at your store.

To send casings to a retreader
1. Open the Casing Manager.

a. Click Invoicing.



Send Casings to a Retreader

b. Click Core Case. The Casing Manager screen opens.

2. Make sure that the casings displayed are those that have recently been brought in by customers. If
you’re using the Casing Manager’s default status settings, make sure In House is selected.

3. Select the customer whose casings you want to send to the retreader. Then click Send Casings.
TireMaster prompts you to select the vendor to whom you’ll send the casings.

4. If you want to send the casings to the default vendor, click Yes. Otherwise, click No and look up
the name of the retreader you want to use. TireMaster prompts you to update the order.

5. If you want to update the order before sending it, click Yes and go to step 6. To send the order as
is, click No and disregard the remaining steps.

6. To update the order, make the following changes as needed:

To change the vendor (retreader), click Lookup and look up a different vendor.
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To update information for an individual casing (such as size, number, or description), type your
changes directly on the screen or select the casing you want to update and click Edit Casing
Information.
If you didn’t send a casing to the retreader, clear the Send check box for that item.
Tip: To select or clear the Send check boxes for all casings, selectMark/Unmark All -

Send to Retreader.

If you changed your mind about whether to buy a casing from the customer, select or clear the
Buy check box as needed.
Tip: To select or clear the Buy check boxes for all casings, selectMark/Unmark All - Buy

from Customer.

7. Click Complete to finish sending the retreads.

8. To send additional casings to a vendor, repeat steps 3 through 7.

MARK CASINGS AS DEFECTIVE
If a retreader refuses to recap a casing, you can mark it as defective in the Casing Manager. You can
also record any costs you’ve incurred or charges you plan to pass on to the customer for handling the
defective casing.

To mark casings as defective
1. If the Casing Manager isn’t already open, click Invoicing. Then click Core Case on the Open

Work Order List.

2. Look up the customer’s order.

a. Display only the orders that have been sent to a retreader. If you’re using the Casing
Manager’s default status settings, make sure At Retreader is selected.



Mark Casings as Defective

Tip: If you know the order number, tag ID, or number for a casing in the order, you can
locate the order with the Search by drop-down list. Select the parameter you want to
use (such as number), then type the number or ID and click Find.

b. Select the customer’s order, and click Receive Retreads. The Process Casings screen
opens.

3. Select the Defect check box for the defective casing. The Receive from Vendor screen opens.

4. Enter the fees for the defective casing.

a. If the retreader charged you a handling fee for the defective casing, type the amount of the fee
in theMisc. Cost field.

b. If you’re going to pass a disposal fee on to the customer for the defective casing, type the
amount of the fee in the Cust Charge field.
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c. If the vendor charged you for freight, type that amount in the Freight field.
5. To generate a vendor charge for the costs you owe retreader, click Save.

Note: To complete the credit entry, the total needs to equal the sum of the charge and discount.
To recalculate the difference, click outside of the Vendor Charge column.

6. Repeat steps 3 through 5 for each additional casing that is defective.

7. Verify that the amounts (highlighted in cyan) for each casing are correct. If you need to change any
amounts for a casing, select it and click Edit Received Charges.

8. If there are other casings on the order, record the service fees or credits for them as needed. Then
click Complete when you’re done. To finish your work later, close the Process Casings screen.
Note: If all of the casings on an order are defective, create a work order so you can collect a fee

from the customer who originally brought you the casings. For more information, see
Facilitate Retread Services on page 906 (step 4).

RECORD RETREADING SERVICE FEES
When you facilitate retreading services for a customer, you can offset the recapping and repair costs
that the retreader charges you by passing a service fee on to the customer. You need to record the
service fee, along with your costs, for each casing that become s a finished retread.

To record retreading service fees
1. If the Casing Manager isn’t already open, click Invoicing. Then click Core Case on the Open

Work Order List.

2. Look up the customer’s order.



Record Retreading Service Fees

a. Display only the orders that have been sent to a retreader. If you’re using the Casing
Manager’s default status settings, make sure At Retreader is selected.

Tip: If you know the order number, tag ID, or number for a casing in the order, you can
locate the order with the Search by drop-down. Select the parameter you want to use
(such as number), then type the number or ID and click Find. To include all orders,
regardless of status, select the Search All check box.

b. Select the customer’s order, and click Receive Retreads. The Process Casings screen
opens.

3. Select the BillCust check box for a casing that has been retreaded. The Receive from Vendor
screen opens.

4. Type the cost of the cap and any repairs, miscellaneous costs, and freight charges assessed by
the retreader.

5. Type the amount of the fee that you’ll charge the customer in the Sell For field.
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6. Click Save.

Note: To process the charges assessed by the retreader, the total needs to equal the sum of the
charge and discount. To recalculate the difference, click outside of the Vendor Charge
column.

7. Repeat steps 3 through 6 for each additional casing that will be returned to the customer.

8. Verify that the amounts (highlighted in cyan) for each casing are correct. If you need to change any
amounts for a casing, select it and click Edit Received Charges.

9. Do one of the following:

If you’re ready to finish recording the service fee, click Complete. When the Report Window
opens, print the Charge Edit Report. The number of Charge Edit Reports generated, depends
on the number of completed retreads in an order.

If you need to wait until later to finish recording the service fee, close the Process Casings
screen.



Casing Credits

CASING CREDITS
At the end of the retreading process you will need to process casing credits if you're adding finished
goods to your inventory or if the retreader is buying the finished goods from you.

ISSUE CASING CREDITS TO A CUSTOMER
If you want to add finished retreads to your inventory, you can issue a credit to the customer who
originally brought the casings to you.

To issue casing credits to a customer
1. If the Casing Manager isn’t already open, click Invoicing. Then click Core Case on the Open

Work Order List.

2. Look up the customer’s order.

a. Display only the orders that have been sent to a retreader. If you’re using the Casing
Manager’s default status settings, make sure At Retreader is selected.

Tip: If you know the order number, tag ID, or number for a casing on the order, you can
locate the order with the Search by drop-down list. Select the parameter you want to
use (such as number), then type the number or ID and click Find.

b. Select the customer’s order, and click Receive Retreads. The Process Casings screen
opens.

3. Select the Buy check box for a casing you want to buy.
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4. Do one of the following:

If you originally said that you weren’t buying the casing from the customer, click Yes to verify
that you have decided to buy it now. Then click No when you’re asked if the retreader will
purchase the finished product.

If you originally said that you would buy the casing from the customer, click No when you’re
asked if the retreader will purchase the finished product.

The Receive from Vendor screen opens.

5. Type the cost of the cap and any repairs, miscellaneous costs, and freight charges assessed by
the retreader.

6. If it isn’t already filled in, type the amount of the credit you’ll give the customer in theGive Cust
field.

7. Click Save.

Note: To post the fees assessed by the retreader, the total needs to equal the sum of the charge
and discount. To recalculate the difference, click outside of the Vendor Charge column.

8. Repeat steps 3 through 7 for each additional finished retread you want to buy.

9. Review the amounts listed at the top of the screen (highlighted in cyan). If you need to make any
changes, select the casing and click Edit Received Charges.
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10. Click Complete. The Report Window opens and displays a credit memo.

11. Generate the credit memos and add the finished retreads to a receiving document.
a. Print the credit memo and give it to the customer. Then close the Report Window. Depending

on how the Casing Manager is set up, TireMaster prompts you to look up the cap item or both
the cap and casing items.

Note: Whether you need to look up one or both items depends on whether you separated
caps from casings in your Casing Manager setups. For more information, see Prepare
to Track Casings on page 909.

b. Look up the cap item or cap and casing items.

c. Repeat steps 11a and 11b until you are no longer prompted to print credit memos or look up
items. The Receiving Document screen opens.

Note: The negative numbers on the receiving document represent the credits you’re giving
the customer who originally brought you the casings that are now finished retreads.

12. Receive and price the finished retreads.
a. Click Receive. TireMaster prompts you to price the items.

b. Click Yes. The Vendor Invoice screen opens.
c. Click Complete. The Report Window opens and displays a copy of the vendor invoice

document.
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d. Print the vendor invoice document and close the Report Window.

13. Close the Casing Manager and the point of sale screens. A duplicate copy of the vendor invoice
document can be retrieved from the Historical Vendor Invoices tab on the PO System screen. A
charge for the finished retreads posts to the vendor’s (retreader’s) subledger and a credit posts to
the customer’s subledger.

ISSUE DUAL CASING CREDITS
If the retreader buys the finished product from you, you need to generate two credits with the Casing
Manager. One of the credits is for the customer who originally brought you the casing. (In other words,
you’re buying the casing from the customer in order to sell the finished product to the retreader.) The
other credit reduces the balance you owe the retreader (because the retreader is buying the finished
product from you).

To issue dual casing credits
1. If the Casing Manager isn’t already open, click Invoicing. Then click Core Case on the Open

Work Order List.

2. Look up the order.

a. Display only the orders that have been sent to a retreader. If you’re using the Casing
Manager’s default status settings, make sure At Retreader is selected.

Tip: If you know the order number, tag ID, or number for a casing on the order, you can
locate the order with the Search by drop-down list. Select the parameter you want to
use (such as number), then type the number or ID and click Find. To include all orders,
regardless of status, select the Search All check box.

b. Select the order, and click Receive Retreads. The Process Casings screen opens.
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3. Select the Buy check box for a casing that you want to buy.

4. Do one of the following:

If you originally said that you weren’t buying the casing from the customer, click Yes to verify
that you have decided to buy it now. Then click Yes when you’re asked if the retreader will buy
the finished product.

If you originally said that you would buy the casing from the customer, click Yes when you’re
asked if the retreader will buy the finished product.

The Receive from Vendor screen opens.

5. If it isn’t already filled in, type the amount of the credit you’ll give the customer in the CR Customer
field.

6. Type the amount of the credit that the retreader is giving you in the CR Retreader field.

7. Click Save.
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8. Repeat steps 3 through 7 for each additional casing you’re selling to the retreader.

9. Review the amounts listed at the top of the screen (highlighted in blue). If you need to make any
changes, select the casing and click Edit Received Charges.

10. Click Complete. The Report Window opens and displays a charge edit report.

11. Print the charge edit report, and close the Report Window. The Report Window re-opens and
displays an account credit memo.

12. Print the account credit memo for the customer, and then close the Report Window.

13. Repeat steps 11 and 12 until you’re no longer prompted to print charge edit reports and credit
memos. The Casing Manager screen opens.

14. Close the Casing Manager and the point of sale screens. A credit for the finished retreads posts to
the vendor’s (retreader’s) subledger and a credit posts to the customer’s subledger.

CASING MANAGER REPORTS
With TireMaster, you can generate the following information about the casings you’ve tracked:

A list of completed casings

A list of casings that have been brought in to your store

A list of casings that have been taken to a retreader

A list of casings that can be picked up by customers

A list of customers organized by item (casing)

A list of casings organized by customer

A duplicate credit memo (customer receipt)

To generate Casing Manager reports
1. If the Core Manager isn’t already open, do the following:
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a. Click Invoicing. The OpenWork Order List opens.

b. Click Core Case. The Casing Manager screen opens.

2. Click Reports. The Casing Reports screen opens.

3. Select the name of the report you want to generate, and clickOK. The Casing Report Options
screen opens.

4. Define the parameters for generating the report. The availability of report parameters depends on
which document you’re generating.

a. To generate a report for a date range, type the beginning and ending dates or select them from
the pop-up calendar. To generate a report for a single day, enter the same date for both the
beginning date and ending date.

b. To generate the report for a specific customer, click the Customer field and press . Then
look up the customer.

c. To generate the report for a specific vendor, click the Vendor field and press . Then look up
the vendor.

927



928

User Guide

d. To generate the report for a casing that was assigned a specific tag number, type the ID
number from the tag in the TagID field.

e. To generate the report for a specific group of casings (an order) or a specific point of sale
invoice, type the document number in theOrder#/Invoice # field.

5. Click Print. The Report Window opens.

6. Print the report and close the Report Window.

7. Close the Casing Reports screen.



CORES
With the Core Manager, you can recover core charges issued by the vendors from whom you buy
parts. The Core Manager includes the means to track the quantities of cores, along with the credits
issued by vendors for the cores they collect from you. This chapter includes the following sections:

Core Tracking Scenarios 930
Core Items 930
Prepare to Track Cores 931
Core Charges 932
Maintain Core Cost Information 937
Core Manager Reports 938
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CORE TRACKING SCENARIOS
You use the Core Manager to recover core charges issued by parts suppliers. There are three
scenarios in which you track cores:

You have high-value core items that you wish to track in your inventory, and you want to receive
and invoice the items and their associated cores.

Your service department replaces an item, such as a water pump, in a customer’s vehicle. In this
scenario, the core is in your possession and the core charge can be recorded.

A customer purchases an item, such as a battery, and takes it off site. In this scenario, you can
pass a core charge of your own on to the customer and refund it when (or if) the customer
returns the original core.

CORE ITEMS
Core items are high-value cores that you track in your inventory.

PREPARE TO TRACK CORE ITEMS
The Core Item field on the Inventory Maintenance screen allows you to track high-value cores as
inventory items. When a core item is assigned to a parent item, you can invoice or receive the parent
item and automatically put the associated core item on the same document.

To prepare to track a core item
1. Enable the Core Item field.

a. Select Setup > System Controls. The System Controls screen opens.

b. Click the Inventory tab.
c. Click Enable Core Item Field and press Enter.
d. Select Yes, and clickOK.

2. If you want to track core items with a specific GL account, add it to the chart of accounts.

3. Add an inventoriable core item to your inventory.

Note: When you add the core item, disregard setting prices for it.

4. Associate the inventoriable core item with the parent item.

a. Look up the parent item. For more information, see Inventory Searches on page 230.

b. Click Edit.
c. Click the Core Item field, press , and search for the core item you want to associate.

5. ClickOK, and close the Inventory Maintenance screen.
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WORK WITH CORE ITEMS
Core items are automatically included on purchase orders and receiving documents when you receive
the associated parent items from vendors. Similarly, core items also added to work orders for you
when you sell the associated parent items.

To work with a core item
1. Create a receiving document, and add the inventory item that has the been assigned a core item.

For more information, see Create a Receiving Document on page 284.

Note: The associated core item appears below the parent item so you can account for its core
charge.

2. Receive and price the order.

3. Create a work order and add the inventory item that has the linked core item. For more information,
see Create a Regular Work Order on page 442.

Note: The linked core item appears as a separate line item on the work order.

4. Verify the quantity of each item is correct. Then complete the invoice. For more information, see
Complete an Invoice on page 456.

PREPARE TO TRACK CORES
Before you can track cores, you need to complete a variety of settings.

Note: The Core Manager and the Casing Manager both use the same setup screen.

To set up core tracking
1. Enable the Core Manager.

a. Select Setup > System Controls. The System Controls screen opens.

b. Click the Inventory tab.
c. Select Track Cores and press Enter.
d. Select Yes, and clickOK.
e. Close the System Controls screen.

2. Add a clearing account for tracking cores to your general ledger. This account should be a liability
account or an expense account (such as 2200–100 Track Cores - Clearing or 5200–900 COGS -
Cores). For more information, see Add a Liability Account on page 657 or Add an Expense
Account on page 660.

3. Add a noninventoriable item for core charges to your inventory. Adding a core charge item
establishes a connection between the Core Manager and the general ledger. You’ll also add this
item to work orders when you need to pass core charges on to customers. For more information,
see Core Tracking Scenarios on page 930.

Note: When you add the core charge item, disregard setting prices for it.

4. Open the Core Manager setup screen.
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a. Click Invoicing. The OpenWork Order List opens.

b. Click Core Case. The Casing Manager screen opens.
Note: You access the Core Manager via the Casing Manager.

c. Click Setup.
5. In the Core Settings section of the screen, define the clearing account and inventory item for

tracking cores.

a. For Clearing Account, click Lookup and select the GL account for tracking cores.
b. For Core Item, click Lookup and look up the inventory item for core charges. For more

information, see Inventory Searches on page 230.

Note: If you also track casings, you can define the clearing account and casing items at this
time. Otherwise, skip this step. For more information, see Prepare to Track Casings on
page 909.

6. Save the entries that you made in the Core/Casing Setup screen. Then close it.

CORE CHARGES
Managing core charges includes adding core charge amounts to TireMaster, ensuring core charge
information is complete and accurate, and processing core credits issued by vendors.

RECORD CORE CHARGES
When you sell replacement parts to customers, you can record the core charges that the vendors
assessed when you bought the items. When customers take parts off site and perform installations
themselves, you can also pass core charges of your own on to them. If the customers return the
original cores, the core charges can be refunded.

To record core charges
1. If you haven’t done so already, start a work order for the customer. For more information, see

Create a Regular Work Order on page 442.

2. Add the replacement part to the work order and define the quantity.

Note: If you entered the item’s core cost when it was received or manually defined it in Inventory
Maintenance, the Add Cores screen will appear with the core cost information. In this
scenario, go to step 3b. For more information, see Maintain Core Cost Information on page
937.

3. If one of your technicians will install the part, enter the core charge issued by the vendor. If the
customer will install the part instead, go to step 4.

a. Do one of the following to define the core charge amount:

Note: If the Add Cores screen appeared in step 2, go to step 3b.
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Type the amount of the core charge in the Core Return field for the replacement item, and
press Enter. The Add Cores screen opens.
Click Cores. When the Add Cores screen opens, type the amount of the core charge in the
Vendor Core Charge field.

Note: The vendor core charge is not included on the customer’s invoice. This value is used
by the Core Manager to track the credit you’ll receive when the vendor collects the core
from you.

b. Click Vendor and look up the name of the supplier who sold you the item.
Note: You can disregard the entry in the Customer Core Charge field.

c. Update the reference number and note, if needed.

d. ClickOK.
4. If the customer will install the part off site, collect a core charge of your own. If the part is being

installed at your shop, go back to step 3.

a. Do one of the following to define the core charge you’re assessing:

Note: If the Add Cores screen appeared in step 2, then go to step 4b.

Type the amount of the core charge you want to collect from the customer in the Core
Return field, and press Enter. The Add Cores screen opens with both the vendor and
customer core charge fields filled in. You can disregard the amount of the vendor core
charge.

Click Cores. When the Add Cores screen opens, type the amount of the core charge you
want to pass on to the customer in the Customer Core Charge field. You can disregard the
amount of the vendor core charge.

b. Select the Add Core Line to POS check box.

c. ClickOK. A core charge is added to the customer’s work order.

5. Add additional items to the work order if needed, and complete the invoice as usual. For more
information, see Complete an Invoice on page 456.

PROCESS CORE CREDITS
When a vendor comes to your shop to pick up the cores you’ve collected, you can process the credits
that the vendor will give you for the cores. You can process credits for individual cores or a group of
cores.

To process core credits
1. Open the Core Manager.

a. If the OpenWork Order List isn’t already open, click Invoicing.
b. Click Core Case. The Casing Manager opens.

Note: You access the Core Manager via the Casing Manager.
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c. Click Cores. The Core Manager opens. For each vendor, it lists the number of cores collected
and total credit amount for those cores.

2. To view a list of cores for a vendor, do one of the following:

Select the row for the vendor and click View.
Generate a hard copy of outstanding cores. For more information, see Core Manager Reports
on page 938.

3. If the information for one or more core charges is incorrect, make the needed changes. Otherwise,
disregard this step. For more information, see Update Core Charges on page 935.

4. If the core charges for one or more items wasn’t entered at point of sale, add them. Otherwise,
disregard this step. For more information, see Add Missing Core Charges on page 935.

5. Verify that all of the needed changes have been made by viewing a list of core charges on the
screen or printing a list of outstanding cores. For more information, refer to step 2.

6. Generate credits for one or more individual vendor core charges. If you want to generate a single
credit for all of the core charges issued by the vendor instead, go to step 7.

a. On the Core Manager screen, select the row for the vendor and click Edit. The Process Cores
screen opens.

b. Select the check box for each core charge for which you’re receiving a credit. The total vendor
credit amount is shown at the bottom of the screen.

Tip: If the vendor has several core charges, it might be easier to select theMark All check
box (upper-left) and then clear the check boxes for the cores you’re not processing at
this time.

c. Click Create Vendor Credit. A confirmation message appears.

d. Click Yes. TireMaster prompts you for a credit memo or reference number.
e. Type the credit memo or reference number, and clickOK. The Report Window opens.

f. Print the Charge Edit Report and close the Report Window. A confirmation message appears.

g. To close the message, clickOK.
7. Generate a single credit for the all of the vendor’s core charges. If you want to generate credits for

individual core charges, go back to step 6.

a. On the Core Manager screen, select the row for the vendor and click Create Vendor Credit. A
confirmation message appears.

b. Click Yes. TireMaster prompts you for a credit memo or reference number.
c. Type the credit memo or reference number, and clickOK. The Report Window opens.

d. Print the Charge Edit Report and close the Report Window. A confirmation message appears.

e. ClickOK to close the confirmation message.

8. Process the cores for another vendor or close the Core Manager and Casing Manager screens.
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UPDATE CORE CHARGES
If the information for a core charge is incorrect, you can update it.

To update a core charge
1. If the Core Manager isn’t already open, do the following.

a. Click Invoicing. The OpenWork Order List opens.

b. Click Core Case. The Casing Manager opens.
Note: You access the Core Manager via the Casing Manager.

c. Click Cores. The Core Manager opens.
2. Select the row for the vendor whose core charge you need update, and click Edit.
3. Type the needed corrections for the core charge. To activate a field for editing, click it and then

click the entry that needs to be changed.

Note: The entries in the Customer, Invoice, Description, Amount, Reference, and Note fields
can be edited.

4. When you’re done making your changes, click Save & Exit.

ADD MISSING CORE CHARGES
If the core charge information wasn’t entered for an item at point of sale, you can add it from the Core
Manager. There are two methods for adding core charge information from the Core Manager.

ADD CORE CHARGES FROM THE CORE MANAGER
Missing core charge information can be added from the Core Manager, which lists the vendors for
whom you’ve collected cores.

To add missing core charge information
1. If the Core Manager isn’t already open, do the following.

a. Click Invoicing. The OpenWork Order List opens.

b. Click Core Case. The Casing Manager opens.
Note: You access the Core Manager via the Casing Manager.

c. Click Cores. The Core Manager opens.
2. Click Add. The Add Cores screen opens.
3. Type the amount of the core charge in the Vendor Core Charge field.
4. Type the quantity. Typically, it’s 1.

5. Click Vendor and look up the vendor who issued the core charge. For more information, see
Vendor Searches on page 193.

6. Type a reference number, note, or both.
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7. Type a description of the item.

8. If you remember which customer purchased the item associated with a core charge, click
Customer and look up the customer.

9. To save the new core charge, clickOK.

ADD CORE CHARGES FROM THE PROCESS CORES SCREEN
Missing core charge information can be added from the Process Cores screen, which lists individual
core charges for a selected vendor.

Note: When you add core charges in this scenario, customer names and invoice numbers cannot
be defined.

To add missing core charge information
1. If the Process Cores screen isn’t already open, do the following:

a. Click Invoicing. The OpenWork Order List opens.

b. Click Core Case. The Casing Manager opens.
Note: You access the Core Manager via the Casing Manager.

c. Click Cores. The Core Manager opens.
2. Select the row for the vendor for whom a core charge is missing, and click Edit.
3. Click Add Line. TireMaster adds an empty line to the list of core charges for the vendor.
4. Type a description for the item that was sold.

5. Type the amount of the core charge issued by the vendor.

6. Type a reference number and note, if needed.

7. To save the new core charge, click Save & Exit.

DELETE UNCOMPLETED CORE CHARGES
If one or more core charges was added for a vendor in error, you can remove them from the Core
Manager. All of the cores can be removed as a group, or you can remove individual core charges.

1. If the Core Manager isn’t already open, do the following.

a. Click Invoicing. The OpenWork Order List opens.

b. Click Core Case. The Casing Manager opens.
Note: You access the Core Manager via the Casing Manager.

c. Click Cores. The Core Manager opens. For each vendor from whom you’ve collected cores, it
lists the number of cores you’ve collected and the total credit amount for those cores.

2. Delete individual core charges, as needed. If you want to delete the entire group of core charges
for a vendor, go to step 3 instead.
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a. Select the row for the vendor whose core charges you want to remove, and click Edit. The
Process Cores screen opens.

b. Select the check box for each core charge you want to remove. Then click Delete Line.
c. Click Save & Exit.

3. Delete the group of core charges you want to remove.

a. On the Core Manager screen, select the row for the vendor whose core charges you want to
remove.

b. Click Delete. A confirmation message appears.

c. Click Yes.
4. Close the Core Manager and Casing Manager screens.

REFUND CUSTOMER CORE CHARGES
When a customer purchases a part from you and performs the installation off site, you can refund the
core charge you assessed when the customer returns with the original core.

To refund a core charge
1. Start a work order for the customer. For more information, see Create a Regular Work Order on

page 442.

2. Add the core charge item to the work order.

3. Enter the quantity for the core charge as a negative amount (-1) and press Enter. The Customer
Sales History screen opens.

4. Make sure theMark Return check box is selected.
5. Select the row for the core charge and click Return.
6. Type the core charge amount that you passed on to the customer (the amount you’re refunding) in

the Parts field.
7. Type the price of the core charge that the vendor charged you in the Core Return field and press

Enter. The Add Cores screen opens.
8. Click Vendor and look up the name of the vendor who sold you the item. For more information, see

Vendor Searches on page 193.

9. ClickOK.
10. Complete the invoice. For more information, see Complete an Invoice on page 456.

MAINTAIN CORE COST INFORMATION
If you stock parts, such as batteries or brake pads, you can maintain core cost information for those
items. Core cost amounts are tracked on the Site Prices and Quantity screen in the same manner as
last cost amounts. When a part is ordered or received into inventory, the item’s core cost is added to
the purchase order or receiving document. You can then leave it alone or change it, depending on the
amount the vendor is charging. Once the order is priced, the item’s core cost is updated.
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ASSIGN AN ITEM’S CORE COST
The core charge that a vendor assesses for an item can be stored along with the item’s price and cost
information. This allows you to recall the core cost at point of sale, and it gives you the option to include
the charge on a customer’s invoice or track it as a vendor credit. For more information, see Record
Core Charges on page 932. An item’s core cost can be defined on purchase orders and receiving
documents, or you can assign it directly to an item.

To assign an item’s core cost on a purchase order or receiving document
1. Start a purchase order or receiving document. For more information, see Create a Purchase Order

on page 262 and Create a Receiving Document on page 284.

2. Type the core charge in the Core field for the line item that has a core charge.

Note: The core cost typed in the Core field does not calculate in the total for the order.

3. Receive and price the order.

Note: The core cost will be updated in the item’s Inventory Maintenance screen.

To assign an item’s core cost manually through Inventory Maintenance
1. Look up the item whose core cost you want to assign.

2. On the Inventory Maintenance screen, click theQty/Pricing tab. The Site Prices and Quantity
screen opens.

3. Type the amount of the vendor’s core charge in the Core Cost field.
4. ClickOK.
5. Close the open screens.

UPDATE AN ITEM’S CORE COST ON AN ORDER
When you put an item on a purchase order or a receiving document, the amount of the vendor’s core
charge is listed in addition to the item’s cost. If the vendor has changed the amount of the core charge
since you last purchased the item, type the new amount in the Core field. Once the item is received
into inventory and priced, the amount from the receiving will be used to update the item’s core cost.

CORE MANAGER REPORTS
With TireMaster, you can generate the following information about the cores you’ve collected:

A list of cores you’ve finished processing

A list of cores that can be turned in to a vendor for credit

A list of customers organized by item (core)

A list of cores organized by customer

To generate Core Manager reports
1. If the Core Manager isn’t already open, do the following.

a. Click Invoicing. The OpenWork Order List opens.
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b. Click Core Case. The Casing Manager screen appears.
Note: You access the Core Manager via the Casing Manager.

c. Click Cores. The Core Manager opens. For each vendor from whom you’ve collected cores, it
lists the number of cores you’ve collected and total credit amount for those cores.

2. Click Reports. The Core Reports screen opens.
3. Select the name of the report you want to generate, and clickOK. The Core Report Options screen

opens.

4. Define the parameters for generating the report. The availability of report parameters depends on
which document you’re generating.

a. To generate a report for a date range, type the beginning and ending dates or select them from
the pop-up calendar. To generate a report for a single day, enter the same date for both the
beginning and ending date.

b. To generate the report for a specific customer, click the Customer field and press . Then
look up the customer.

c. To generate the report for a specific vendor, click the Vendor field and press . Then look up
the vendor.

d. To generate the report for a specific point of sale invoice, type the document number in the
Invoice # field.

e. To generate the report for a vendor charge created when a core credit was processed, type the
document number in the Vendor Charge # field.

f. To organize the report by vendor, select theGroup by Vendor check box. Otherwise, clear
the check box.

5. Click Print. The Report Window opens.

6. Print the report and close the Report Window.

7. Close the Core Reports screen.
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MULTI-STORE OPERATIONS
TireMaster Corporate includes a corporate site and two or more stores that send information back and
forth. Although TireMaster Corporate has the same functions as a single-store application, some tasks
can be performed only at the stores or only at the corporate site. This chapter includes the following
sections:

Replication 942
Shared Databases 943
Background Colors 943
User Accounts in TireMaster Corporate 943
System Controls in TireMaster Corporate 946
Customer Accounts in TireMaster Corporate 946
Point of Sale in TireMaster Corporate 948
Vendor Accounts in TireMaster Corporate 949
Inventory in TireMaster Corporate 950
Interstore Transfers 952
Purchasing in TireMaster Corporate 959
Accounting in TireMaster Corporate 961
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REPLICATION
Replication is the process of moving data back and forth between stores and the corporate
headquarters. Here’s how the replication cycle works for a remote store (Figure 31-1). The store
sends its data to the corporate site. The corporate site receives the data from the store and transmits it
to the other stores. Likewise, the other stores send their data to the corporate site. Then the corporate
site sends the data from the other stores to the originating store.

Figure 31-1: The Replication Cycle

Replication runs as a service, and it can be manually stopped or started from the Microsoft®Windows®

Services module.

To manually stop or start replication

1. Right-click and select Search from the menu that opens.

2. Type services in the search field and press Enter. The Services screen opens.
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3. Right-click ASA-Replication and select Start or Stop.
Tip: For easier access to the Services module, set up a shortcut. Type Administrative

Services in the Windows search field. Then right-click Services and select Create
Shortcut and put it on the computer’s desktop.

SHARED DATABASES
With TireMaster Corporate, you have the option of having two sites share a single database.

Example: If you operate a store out of your corporate headquarters, both the store and corporate
systems can use the same database. Likewise, if you have two stores at one location to manage
two different businesses (one retail and one commercial), you can share a single database and still
manage the sites independently.

Sites that share a database sometimes behave differently than two remote sites. A shared database
has one password per user, so two stores that share a database would have the same password for a
user. Some customer information (such as vehicle history) is also shared, and you would be able to
generate some general ledger reports from any site of a shared database. Shared databases in
TireMaster Corporatesystem are sometimes called colocated databases.

BACKGROUND COLORS
The background color for the main TireMaster screen is purple for workstations logged in to the
corporate database. For store databases, the background color is blue. Using two background colors
helps you differentiate between the corporate site and your stores, if you log in to TireMasterremotely
from your corporate headquarters or if you have a colocated (shared) database. For more information,
see Shared Databases on page 943.

USER ACCOUNTS IN TIREMASTER CORPORATE
All user accounts and security groups are added at the corporate site. Permissions and reports are
assigned at the corporate site too.

In TireMaster 9.4.0, passwords can be assigned at both the corporate site and stores. For more
information, see Manage Passwords in TireMaster Corporate on page 944. Once a user’s password is
set at a site, he or she becomes a local user at that site.

Note: If a store and the corporate site share a database, the password for each user is automatically
the same for both sites. For more information, see Shared Databases on page 943.

SET UP CORPORATE USER ACCOUNTS
In TireMaster Corporate, user accounts are added at the corporate site.

To set up a user account in TireMaster Corporate
1. At the corporate site, select Setup > Users & Permissions. The User List opens.
2. Click Add. The Employee/User Edit screen opens.
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3. Define the user’s name, ID, SQL user ID, and e-mail account. For more information, see Add User
Accounts on page 48.

4. Define the site or sites that the new user is allowed to access.

a. Click Site Selection. The Site List opens.
b. Select the site or sites where the user will log in to TireMaster.

Note: To select multiple sites, press the Ctrl key while making your selections. If the user will
be logging in at all sites, select the Select All Sites checkbox.

5. Select the following checkboxes as needed.

Time Clock defines whether the employee’s time worked is tracked with the TireMaster Time
Clock.

Mechanic defines whether the user is a mechanic.
6. Assign a password by typing it in both the Password and Confirm fields.

Note: If the corporate site shares a database with a store, this password will also be used at the
store. For remote stores, this password will be transmitted to those sites during the next
replication cycle. Passwords can be updated at both the corporate site and remote stores.
For more information, see Manage Passwords in TireMaster Corporate on page 944.

7. To save the new user account, clickOK.

MANAGE PASSWORDS IN TIREMASTER CORPORATE
User account passwords can be changed at both the corporate site and stores. However, anytime a
user’s password is updated at the corporate site, it will change for all sites. Here are some examples:

When a new user account is originally created at the corporate site and replicated to a store, the
new user can then change the password at the store. If a subsequent password change occurs
at the corporate site, it will override the password assigned at the store.

When a new user account is originally created at the corporate site and replicated to multiple
stores, the new user can change the password at each of the stores. In this scenario, the new
user might create a unique password for each store. If a subsequent password change occurs at
the corporate site, it will override the passwords that were assigned at the stores.

Existing users can update their passwords at the stores as often as they see fit. If those
password changes are followed by password changes implemented at the corporate site, the
passwords assigned at the stores will be overwritten.

MANAGE A USER’S SITE ACCESS
When you need to define whether a user is allowed to log in to a site, you can grant or restrict the
user’s site access with one of the following methods.
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DEFINE SITE ACCESS AT THE CORPORATE HEADQUARTERS
At the corporate site, you can identify which stores the user is allowed to log in to by selecting them
from a list. The user will not have access to the sites that are not selected.

1. At the corporate site, select Setup > Users & Permissions. The User List opens.
2. Select the user whose site assignments you want to change, and click Edit.
3. Click Site Selection. The Site List opens.
4. Select the site or sites that the user is allowed to log in to TireMaster.

Note: To select multiple sites, press the Ctrl key while making your selections. If the user is
allowed to log in at all sites, select the Select All Sites checkbox.

5. Type a password in the Password and Confirm fields.

6. ClickOK.

ASSIGN A PASSWORD TO THE USER AT THE SITE
To allow a user to log in to a site, you can grant access by assigning a password to the user at that
site.

To give a user site access
1. Log in to the site where you want to give the user access.

2. Select Setup > Users & Permissions. The User List opens.
3. Clear the Local Users Only check box.

Note: By default, only the names of active, local users are displayed.

4. Select the user to whom you want to give site access, and click Edit. The Employee/User Edit
screen opens.

5. Type a password in the Password and Confirm fields.

6. ClickOK. The user’s name will remain on the User List screen when the Local Users Only
check box is selected.

RESTRICT SITE ACCESS AT THAT SITE
Users can log in at all sites until you specify otherwise. To restrict access to a site, remove the user’s
ability to log in at that location.

Note: To see which users are allowed to log in at a site, make sure the Local Users Only check
box is selected on the User List.

To restrict site access
1. Log in to the site where you want to restrict a user’s access.

2. Select Setup > Users & Permissions. The User List opens.
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Note: By default, only the names of active, local users are displayed.

3. Select the name of a user who does not work at your location, and click Edit. The Employee/User
Edit screen opens.

4. Clear the Local User check box. A confirmation message appears.

5. Click Yes.
6. ClickOK. The user’s name is no longer displayed on the User List.

Note: To view both local and restricted users, clear the Local Users Only check box on the
User List.

SYSTEM CONTROLS IN TIREMASTER CORPORATE
Some system control settings in TireMaster Corporate are effective at all sites, while others need to be
completed for each store. The controls that affect all sites are referred to as corporate controls, and the
settings that can differ on a site-by-site basis are called store controls. You can move back and forth
between the corporate and store controls by selecting the radio buttons in the lower-left corner of the
System Controls screen

Note: Because store controls can be set on a site-by-site basis, each control is listed for each site.
Therefore, if you have four sites, each control is listed four times.

SET THE SAME CONTROL FOR MULTIPLE SITES
For some store controls, you might need to assign the same setting (such as the statement APR or
default tax level) to all sites. In this scenario, you can set the control for one site and easily apply the
changes to all of the other sites.

To set a group of store controls
1. Select Setup > System Controls. The System Controls screen opens.

2. Click the tab that includes the control you want to set.

3. Select Store Controls.
4. Select the Apply Changes to All Stores check box.
5. Select the control you want to set for one of the sites listed, and press Enter.
6. Set the control as needed, and clickOK. The control is updated with the same settings for all sites.
7. Close the System Controls screen.

CUSTOMER ACCOUNTS IN TIREMASTER
CORPORATE
Customer records can be created at all sites. Likewise, customers’ vehicles and ship-to addresses can
be added at any location. For ease of maintenance, however, ASA recommends that you set up your
national account and government support customers (if any) at the corporate site.
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Users at all sites can update customer records regardless of where customers were added to
TireMaster. Any changes to a customer record will take effect at all other sites after the corporate site
has processed the information and sent it to the other stores.

CUSTOMER SETTINGS
System administrators at the corporate site can control whether users at the stores can add or update
customer records by removing permissions from the security groups that store users are assigned to.

Although most system controls for customers are effective system wide (they’re corporate controls),
you can define default tax levels, APR rates, and minimum finance charge amounts for each store.
Also, because the control for the default customer type is a corporate control, employees should check
whether the customer type needs to be changed each time they add new customers.

CUSTOMER HISTORY
Customer history includes more detail at the corporate site than at the stores. At the corporate site, a
customer’s subledger includes all transactions for all sites. At a store, only information about the
transactions done at that store are available.

Although transaction history is limited at stores, aging information is detailed at all sites. Employees at
the corporate site and stores can see information such as unapplied credits and 30-, 60-, and 90-day
balances.

Note: At times, aging information might vary among sites. This variation occurs when a site
processes an invoice or a payment, but has not yet replicated information about the
transaction to the corporate site.

TireMaster Corporate handles vehicle history in the same manner as it handles customer history. At a
store, only the vehicle history for that store is available. At the corporate site, history of the work done
at all sites is available. Sites with shared databases can also see a vehicle’s complete history. For
more information, see Shared Databases on page 943.

CUSTOMER STATEMENT ADDRESSES
Both monthly and real-time customer statements can be generated only at the corporate site.
However, the business address that prints on customer statements can be one of the following:

The address of the corporate site

The address of the site (store) where the customer was added to TireMaster

By default, the corporate site address is listed as the business address on customer statements. If you
want to use the address for the site where a customer was added instead, complete the following
settings:

Set the system control Invoice - Print Header (Other tab) to Yes.
Note: Because the control needs to be set to Yes, the store address cannot be used for

preprinted forms.

Select the Print Site Address check box on the Form Options screen.

947



948

User Guide

ROAS
Although all sites can enter payments received on an account (ROAs) in TireMaster Corporate, only
users at the corporate site can apply an ROA to a customer’s balance and print statements. Store
users can suggest (by marking) how to apply payments; however, users at the corporate site can make
changes before actually applying payments.

When processing an ROA, users at the corporate site can do any of the following:

Apply the payment to the store that entered the ROA.

Apply the payment to charges at other stores.

Leave an unapplied balance in the customer’s subledger.

Because ROAs can be entered at stores, users at the corporate site need to generate an Unapplied
Credit Report for all sites before applying payments. That’s because the report shows which stores
have entered ROAs.

Once an ROA has been applied to a customer’s account, users at the corporate site can view detailed
information about the customer’s new balance, including unapplied credits and the unapplied item
count. At the stores, only the customer’s balance is available.

POINT OF SALE IN TIREMASTER CORPORATE
Point of sale activity is reserved for the stores and the corporate site manages all general ledger
activity related to invoicing. Users at the corporate site can also define how work orders, quotes, and
interstore transfers are handled by setting various system controls.

POINT OF SALE CONTROLS
Various controls that affect point of sale are located on theOther tab on the System Controls screen.
Most of these settings define how work orders, quotes, and invoices look and whether certain
information must be included on them. Another group of settings is used to configure the Quote
Module. Additional controls on the Enterprise tab define how interstore transfers are handled by
stores. For more information, see Other Controls on page 1209 and Enterprise Controls on page 1202.

QUOTES, WORK ORDERS, AND INVOICES
Only stores can create work orders and complete invoices. Quotes can be created at the corporate
site, but only users at stores can save, print, and turn quotes into work orders.

When an invoice is completed at a store, the transaction information is sent to the corporate site
through replication so it can post to the general ledger. You can look up completed invoices from a
store by selectingGeneral Ledger > Invoice and Document Search. For more information, see
Search for Invoices and Other Documents on page 678.

At a store, you can view and reprint only the quotes, work orders, and invoices created at that store. At
the corporate site, you can view and reprint completed invoices from all stores. To identify which store
created an invoice, look at the prefix of the invoice number.
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Example: The number 3 at the beginning of invoice number 3-104 identifies Site 3 as the store
where the invoice was created.

At the corporate site, you can also view all general ledger activity related to a completed invoice. This
information is not available to stores.

VENDOR ACCOUNTS IN TIREMASTER CORPORATE
In TireMaster Corporate, employees at all sites can add vendors and update vendor settings (such as
address, credit limit, and payment terms). Any changes that are made by a site are then sent to all
other sites. Although all sites have the ability to create vendor records, ASA recommends that you set
them up at the corporate site because only the corporate site can apply payments to vendor charges.
You can define which employees are allowed to update vendor settings by completing permission
assignments at the corporate site.

Users at the corporate can also delete vendors who have no history. System administrators a the
corporate site, can set the controls that define the default bank account and default number of
payment terms for each store. Default discount and payment due dates are the same for all sites.

CHARGES AND PAYMENTS
All sites can create vendor charges. However, a store can create and view only the vendor charges
created at that store. Users at the corporate site can create regular vendor charges for all sites. Vendor
charges created at the corporate site can be viewed only at the corporate site. Similarly, when a
purchase order charge is created at the corporate site, only the corporate site can see that charge.

Vendor payments can be made at the corporate site only. Vendor payments can be applied to charges
generated by multiple locations.

Example: If an employee at the corporate site creates a $500 payment for Napa Auto Parts, that
check can be applied to a $300 charge at Store A and a $200 charge at Store B.

Although stores cannot create vendor checks, they can suggest which invoices to pay by marking
charges in the vendor’s open item ledger. When generating checks, employees at the corporate can
either follow or override a store’s suggestions.

All locations can create AP easy checks. An employee at a store can create AP easy checks for that
store only. However, users at the corporate site can create AP easy checks for all sites. The corporate
site can also offset a single easy check to the different stores’ general ledger accounts.

VENDOR CREDITS
Reconciliation codes can be set up at the corporate site only, and only employees at the corporate site
can process vendor credits manually for national account, government support, and adjustment sales.
If you’re using an integrated application to process vendor credits electronically, refer to the
documentation for that product for information about processing vendor credits.
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INVENTORY IN TIREMASTER CORPORATE
The availability of inventory setup and management functions varies, depending on whether a site is
the corporate headquarters or a store.

NEW ITEMS
Inventory items can be added at both the stores and the corporate site, however, you should add items
at the corporate. This practice prevents problems that can occur when employees at one store want to
add an item that already exists at another store. Stores can maintain different prices and quantities for
items at their respective sites. For more information, see Add and Manage Items on page 205 and
Pricing on page 950.

If you add an item at a store, employees at that store and the corporate site can update any of its
settings. Another store, however, can only update prices for that site. For example, if you add an item
at Store A, Store B cannot make changes to the basic information for that inventory item. However,
Store B can set a different price for the item than Store A.

INVENTORY SETTINGS
In TireMaster Corporate, only the corporate site can create add-on packages. Although the same add-
on packages are available for all sites, you can vary which items are assigned and how they are set up
for each site. For more information, see Add-On Packages on page 252.

Inventory categories and groups can only be set up at the corporate site. Although manufacturer codes
can be added at all sites, ASA recommends that you maintain them at the corporate site to ensure that
everyone in your organization follows the same standards. For more information, see Inventory
Categories and Groups on page 340 and Manufacturer Codes on page 346.

BEHAVIOR
By setting a group of system controls that are effective system wide (corporate controls), you define
the inventory costing method, the default inventory category, the shop supplies item, and whether an
item’s base price should be used as its last cost (if the current last cost is $0). The store controls for
inventory include settings that affect shop supplies, the availability of A–E price levels on the Inventory
List, and whether and item’s base price is used instead of its last cost on purchase orders. For more
information, see Inventory Controls on page 1206.

Sales and receiving history for all sites is available at the corporate site only. A store can only see an
item’s sales and receiving history for that store. For more information, see Inventory History on page
244.

PRICING
Both the corporate site and the stores can edit prices for items. For stores, prices affect only the site at
which they’re set. The corporate site can also update prices with the Pricing Wizard and the Inventory
List Editing screen. Any price changes made at the corporate site take effect at all locations once a
replication cycle is completed. For more information, see Pricing Wizard on page 398 and Update
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Information for Multiple Items on page 211.

When changing an item’s margin or markup, you can update the factor and operator at either the
corporate site or the stores. Because only the corporate site can access the Pricing Wizard, the
corporate site must always recalculate prices before the changes go into effect. For more information,
see Pricing Wizard on page 398.

Price levels, which are available for all sites, can be set up at the corporate site. Because price levels
use a site’s price settings to calculate the price, you might see some inconsistencies in pricing among
your stores. To keep an item’s price the same at all stores, use the item’s base price when setting up
price levels. For more information, see Price Levels on page 413.

QUANTITY INFORMATION FOR OTHER SITES
In TireMaster Corporate, you can view on-hand quantity information for other sites in one of the
following ways:

Look at theOther Sites column on the Inventory List. It shows a combined total of the on-hand
quantities for all of the other sites.

Click theOther Site button at the bottom of the Inventory List to open a screen that shows the
available and on order quantities for each of the other sites.

Refer to the site specific on-hand quantity information displayed at the bottom of the Inventory
List. For this scenario, a manager or system administrator at your location needs to define the
sites whose on-hand quantity information will be available at your store. For more information,
see Define Site-Specific Quantity Information on page 951.

DEFINE SITE-SPECIFIC QUANTITY INFORMATION
Each location can define whether on-hand quantity information for one or more of the other sites is
included on the Inventory List, and if so, how it’s displayed.

Note: The settings described in this section need to be completed at the corporate headquarters
and each of the stores.

To define site specific quantity information
1. Select Setup > Sites. The Site List opens.
2. Select the site you want to update, and click Edit.
3. If you want employees at your location to see on-hand quantity information for the selected site,

complete the following settings. Otherwise, go to step 4.

a. Type a nickname for the site in the Disp Name (display name) field.
b. For the status, select the Active check box.
c. To indicate the column position for this site’s information, type the corresponding number in

the Sort Order field. For example, if the column for this site should be in the second position,
type 2.

951



952

User Guide

d. Go to step 5.

4. If you want to exclude this site’s on-hand quantity information from the Inventory List at your
location, make sure the Active check box is clear.

5. To save your changes, clickOK.
6. Repeat steps 1 through 5 for each of the remaining sites.

INTERSTORE TRANSFERS
In TireMaster Corporate, stores can sell inventory to each other by performing interstore transfers.
When an interstore transfer occurs, the selling store adds the items to an interstore transfer invoice
and a transfer purchase order is automatically created for the store buying the items.

Note: This type of transfer deals specifically with processing transfers between stores that are all part
of a TireMaster Corporate system. For information about transferring inventory in a non-
corporate environment, see Transfers on page 488.

Depending on your settings, interstore transfer purchase orders can require manual processing or they
can be processed automatically from start to finish. If interstore transfers are to be processed
manually, you can define whether the manual processing can be done at the stores or at the corporate
site.

PREPARE FOR INTERSTORE TRANSFERS
Before you can perform interstore transfers, a variety of settings need to be completed. To prepare for
interstore transfers, do the following:

1. At the corporate site, add general ledger accounts for tracking interstore transfer activity. For more
information, see Interstore Transfer GL Accounts on page 952.

2. At the corporate site, add a customer type for classifying interstore transfer customers. For more
information, see Interstore Transfer Customer Type on page 953.

3. At the corporate site, set the system controls that affect the handling of various interstore transfer
activities. For more information, see Interstore Transfer Controls on page 954

4. At each site, add a customer record for purchasing items via interstore transfers. For more
information, see Interstore Transfer Customers on page 955.

INTERSTORE TRANSFER GL ACCOUNTS
To track interstore transfer activity in the general ledger, make sure the following accounts are
included in your chart of accounts:

An accounts payable account for interstore transfers
When an interstore transfer occurs, one store functions as the vendor and another functions as the
customer. Setting up the AP interstore transfer account ensures that you have a place for posting
the accounts payable entry that results when one store sells items to another. The interstore transfer
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accounts payable account is a liability account, such as 2000–200 Accounts Payable Interstore
Transfers.

An interstore offset account
This account allows you to perform transactions between stores while maintaining balanced general
ledgers for each site. Without an interstore offset account, the general ledger for the company as a
whole would be in balance, but the general ledgers for the individual sites would be out of balance.
The interstore offset account is typically a liability account, such as 2700–0 Interstore Offset, or an
expense account.

Note: To ensure posting is handled correctly for interstore transfers, the minor account number
for the interstore offset account must be 0.

An interstore transfer clearing account
This account is for posting the offsetting entries needed to clear interstore transfer activity from the
customer and vendor subledgers. The interstore offset account is typically an expense account,
such as 8888–8888 Interstore Transfers Clearing.

Along with the required interstore transfer accounts, adding the following to your GL will help you to
further separate interstore transfers from regular transfers:

An interstore transfer accounts receivable account. This is an asset account, such as 1100–
400 AR Interstore Transfer.

A discount account for accounts receivable interstore activity. This is an income account, such
as 4600–100 AR Interstore Discounts.

INTERSTORE TRANSFER CUSTOMER TYPE
Before your sites can transfer inventory to each other, you need to set up an interstore transfer
customer type. This customer type is different from a regular transfer customer and is used solely in
a multi-store environment.

Note: For information on transferring inventory in a non-corporate environment, see Transfers on
page 488.

To create an interstore transfer customer type
1. At the corporate site, select Customers > Types. The Customer/Vendor Type List opens.
2. Click Add. The Customer/Vendor Type Edit screen opens.
3. For the type, type the letter U or another code that will distinguish this type from your other

customer types.

4. Make sure the letters AR appear in the AR or AP field.

5. For the description, type Interstore Transfer or some other name that will distinguish
this customer type from regular transfer customers.

6. Assign GL accounts to the customer type. To assign an account, click the account field, press ,
and select an account from the list that appears.
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For AR Acct, assign the account for accounts receivable transfers. This is account 1150–0 in
the TireMaster startup database or an account such as 1100–400 Accounts Receivable
Interstore Transfers.

For AP Acct, assign the accounts payable account that you created for interstore transfers,
such as account 2010–0 Accounts Payable Interstore Transfers.

For AR Dis Acct, assign the account for sales discounts. This is account 4600–0 in the
TireMaster startup database or an account such as 4600–100, if you created a separate one
for interstore transfers.

For AR Dis Acct, assign the account for vendor discounts. This is account 5600–0 in the
TireMaster startup database.

For Exp. Acct, assign a miscellaneous expense account, such as account 9999–9999 in the
TireMaster startup database.

7. Make sure all of the check boxes are clear in theOptions area.
8. To save the interstore transfer customer type, clickOK.

INTERSTORE TRANSFER CONTROLS
To perform interstore transfers, you need to make sure the following system controls are set:

Interstore Offset - Major Account defines which account offsetting entries should post to
when transactions affect multiple sites. Using an interstore offset account ensures that the
general ledger for each site remains in balance. This setting is a corporate control.

Note: The interstore offset account is typically a liability or expense account. Many dealers use
the account 2600–0 Interstore Transfers. For more information, see Create and Define
the Interstore Offset Account on page 962.

Interstore Transfers - Clearing Account defines which account adjusting entries post to
when interstore transfers are cleared (usually during the month-end closing). This setting is a
corporate control.

Note: The interstore transfer clearing account is typically an expense account. Many dealers
use the account 8888–8888.

Interstore Transfers - Customer Type defines the customer type for interstore transfer
customers. This setting is a corporate control. For more information, see Interstore Transfers -
Customer Type on page 1202.

Interstore Transfer POs - Stop with PO (Ordered) defines whether sites are allowed to
automatically receive and price interstore transfer items. This setting is a store control.

Interstore Transfers - Edit Prices defines whether sites are allowed to change the cost of
items received in an interstore transfer. This setting is a store control.
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Show AP AR check box in Name/Lookup Entry dialog lets you look up both the AP and
AR activity for customers. For more information, see Show AR AP check box in Name
Lookup/Entry dialog on page 1216.

Note: To allow for interstore transfers, customer records are created for sites. These interstore
customers can have both AR and AP activity.

The interstore transfer controls are on the Enterprise tab and AP AR check box control is on the
Other tab. For more information, see Enterprise Controls on page 1202 and Other Controls on page
1209.

INTERSTORE TRANSFER CUSTOMERS
Each site needs to create a customer record for itself to use for interstore transfers. This customer
record needs to be assigned the interstore transfer customer type and an exempt sales tax level.

Note: Sites should not add other sites as interstore transfer customers.

To set up an interstore transfer customer
1. Log in to a store site, and add a new customer. This customer should be named after the store at

which you’re logged in. For example, if you’re logged in at the Meridian store, you would create a
customer record called Meridian Store. For more information, see Add an AR Customer on page
68.

2. Clear the Taxable, Cash Only, Statement, and Finance Charge check boxes.
3. Click the Tax Level - Parts field, and press . Then select an exempt tax level, and clickOK.
4. Click the Tax Level - Labor field, and press . Then select an exempt tax level, and clickOK.
5. Click the Type field, and press . Then select the interstore transfer customer type from the

Customer/Vendor Type List, and clickOK.
6. For the credit limit, type 0.00.

Note: Typing 0.00 gives you unlimited credit when buying items from the other stores.

7. When you’re finished adding information for the store, clickOK.

CREATE AN INTERSTORE TRANSFER INVOICE
Creating an interstore transfer invoice is similar to creating an invoice for a regular customer. However,
once you’ve created the invoice for an interstore transfer, TireMaster creates a purchase order for the
items on the invoice and, depending on how the system controls are set, a vendor invoice document.

To create an interstore transfer invoice
1. Begin a work order as you would for a regular sale, selecting the customer record associated with

the store that you want to transfer inventory to. For more information, see Create a Regular Work
Order on page 442.

2. Add items to the invoice.
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Note: For interstore transfer invoices, items are added at cost. Add-on items are not included.

3. When you’re finished adding items, click Complete. The Invoice Completion screen opens, and
the Charge field is selected.

4. To insert the amount of the invoice, press .

Note: Charge is the only available payment type for interstore transfer invoices.

5. ClickOK. TireMaster prompts you to complete the invoice.
6. Click Yes.
After the completed invoice is sent to the corporate site, an interstore transfer purchase order is
automatically created. What happens to the purchase order after the completed invoice is sent to the
corporate site depends on the system control settings for the purchasing store.

AUTOMATIC RECEIVING FOR INTERSTORE TRANSFERS
Depending on a site’s settings in System Controls, you may or may not be able to receive interstore
transfers automatically. This function is controlled by the store setting Interstore Transfer POs - Stop
with PO (Ordered). If this control is set to Yes, interstore transfers automatically create a purchase
order at the receiving site, but no receiving document is generated.

Note: If the receiving cost of an interstore transfer item is higher than a store wants to pay, that store
needs to transfer the item back to the store that sold it.

Typically, the interstore transfer proceeds as follows:

1. When Store A sends the completed transfer invoice to the corporate site, an interstore transfer
purchase order is created automatically.

Note: The reference number of the interstore purchase order is created automatically if it’s not
entered manually. The site number is added to the beginning of the number to identify the
site where the transfer started.

2. Corporate sends a receiving document to Store B.

The receiving document uses the purchase-order number from the corporate site as its
reference number.

The order is automatically received.

The VID is automatically created and uses the purchase order number from the corporate site
as its VID reference number.

3. Store B sends the VID to the corporate site, and the purchase order posts to the general ledger.

CLEAR INTERSTORE TRANSFERS
As part of your month end closing, you should clean up the AR and AP subledgers for each of your
sites by clearing out the documents for completed interstore transfer activity. During the interstore
clearing process, the following occurs:
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TireMaster creates adjusting AR journal entries for the sites that sold items to other stores.
Those entries are then applied to interstore transfer invoices in the sites’ AR open item ledgers.

TireMaster creates adjusting vendor charges for the sites that received interstore transfers.
Those charges are then applied to open interstore transfer POs in the sites’ AP open item
ledgers.

When the adjusting entries are applied to open interstore invoices and POs, those items are removed
from their respective open item ledgers and transfer clearing entries are added to the sites’ AR and AP
histories.

The interstore transfer clearing process can be performed at the corporate site only. When you clear
interstore transfers, you have two options:

You can clear all interstore transfer documents that were created during a user-defined date
range.

You can clear only the documents for which the AR subledger entries (TR) have matching AP
subledger entries (PO).

The interstore transfer clearing process affects all sites.

To clear interstore transfers
1. At the corporate site, selectGeneral Ledger > Clear Interstore. The Clear Interstore Transfers

screen opens. It lists the AR balances (transfer invoice totals) and AP balances (PO totals for
items received) for each site.

2. Define the date range for the transfers you want to clear. For a single day, enter the same date for
both the beginning and end of the range.

3. To review interstore transfer activity for the selected date range, do the following as needed:

If you need to see the transfer invoices and POs for a specific site, click the name of the site on
the locations list. The documents for the selected site appear in the lower half of the screen.

For a hard copy that lists all transfer invoices and POs for the selected date range, click Print.
The Report Window opens and displays the Interstore Transfer Report, which is organized by
site. Print the report, if needed, and then close the Report Window.

4. To clear only the transfers for which the AR entries (TR) have matching AP entries (PO), select the
Clear Only Matching AR and AP Entries check box. To clear all transfers, clear the check box.
Note: When an AR entry does not have a matching AP entry, the reference number for that

transfer invoice is blank on the AR Detail (TR) list.

5. Click Create and Apply All. A confirmation message appears.

6. Click Yes. TireMaster prompts you to print an Interstore Transfer Report.
7. Do one of the following:

To view the report, click Yes. The Report Window opens and displays the Interstore Transfer
Report. For a hard copy, print the report and close the Report Window.

If you want to finish clearing the transfers without viewing a report, click No instead.
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When all of the adjusting entries have been applied to documents in the sites’ customer and vendor
subledgers, a confirmation message appears.

8. ClickOK to close the message, and close the Clear Interstore Transfers screen.

VIEW A SITE’S AR AND AP SUBLEDGERS
For interstore transfers, sites are set up as customers in TireMaster. However, they can function as
both customers and vendors. To view a site’s AR interstore activity, look up the customer record
created for the site in the same manner as any other customer. For the site’s AP interstore activity, you
need to do a vendor search instead.

Note: The Both AR and AP check box on the Name Lookup/Entry screen allows you to look up a
customer’s AP activity. Before you an use this check box, however, you need to set a system
control. For more information, see Set the AP and AR Check Box Control on page 958.

To view a site’s AR and AP subledgers
1. Log in to TireMasterat the corporate site, if it isn’t already running.

2. If you need to look up a site’s AR subledger activity, do the following.

a. Select Customers > Maintenance. TireMaster prompts you for a name.
b. Type all or part of the name for the site and clickOK. The Customer Maintenance screen

opens.

c. Click the Ledger/History tab. It lists the site’s transfer invoices and the AR journal entries
created to clear interstore activity from the site’s AR open item ledger.

d. When you’re done looking at the AR interstore activity, close the Customer Maintenance
screen.

3. If you need to look up a site’s AP subledger activity, do the following:

a. Select Vendors > Maintenance. TireMaster prompts you for a name.
b. Type all or part of the name for the site

c. Select the Both AP and AR check box.

d. ClickOK. The Vendor Maintenance screen opens.
e. Click the Ledger/History tab. It lists the site’s transfer POs and the vendor charges created to

clear interstore activity from the site’s AP open item ledger.

f. When you’re done looking at the AP interstore activity, close the Vendor Maintenance screen.

SET THE AP AND AR CHECK BOX CONTROL
For interstore transfers, sites are set up as customers in TireMaster. Because they can function as
both customers and vendors, however, you need to be able to retrieve both the AR and AP subledger
account information for your sites. To access the accounts payable subledgers associated with the
customer records for your sites, set a system control that allows you look up both the AP and AR
activity.
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To set the AP and AR check box control
1. At the corporate site, select Setup > System Controls.
2. Click theOther tab.
3. Select Store Controls.
4. Select Show AP AR check box in Name/Lookup Entrydialog for the corporate site only, and

press Enter.
5. Select Yes, and clickOK.
6. Close the System Controls screen.

PURCHASING IN TIREMASTER CORPORATE
The purchasing system is similar to many other areas of a TireMaster Corporate, because the
corporate site can see purchase orders for all sites, while a store only sees purchase orders created
for that store. Furthermore, system administrators at the corporate site can also define how purchases
are handled by setting group of system controls and assigning or removing permissions from security
groups.

PURCHASING CONTROLS AND PERMISSIONS
Depending on the system control settings, purchase orders can be created at the corporate site, the
stores, or both. Similar controls also define whether orders can be received and priced at the corporate
site, the stores, or both.

Example: You could give Store A only the ability to receive items, while giving Store B the ability to
create purchase orders and receive items.

Depending on your control settings, you can perform any or all of the purchase order processing
stages at the corporate site.

Example: You can create a purchase order at the corporate site, receive the order at a store, and
price it at the corporate site. You can also perform all steps of the process at the corporate.

The settings that affect which purchasing functions stores can perform are located on the Enterprise
tab on the System Controls screen. For more information, see Enterprise Controls on page 1202.

To enable purchase order processing at the corporate site, the following store settings should be set to
Yes for the corporate location:

Can Create New PO
Can Create New RD
Can Create New VID

You can also use permissions to affect how purchase orders are processed at stores.
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Example: If you don’t want users at Store B to override prices and quantities when receiving items,
don’t assign Store B employees to a security group with the PO/Recv Override Price and
PO/Recv Override Qty permissions.

Note: If you choose to do all purchase order processing at the corporate site, all stores involved in the
transaction must still process the results and send them back to the corporate site to complete
the transaction. For example, a store must acknowledge a receiving document created at the
corporate site before the corporate site can send the vendor invoice that results from pricing
the receiving document.

CREATE PURCHASE ORDERS AT THE CORPORATE SITE
To create purchase orders at the corporate site, you need to set the Can Create New PO control to
Yes on the Enterprise tab on the System Controls screen.

To create purchase orders from Corporate
1. At the corporate site, select Inventory > PO & Receiving. The PO System opens.

2. Click Add. TireMaster displays a list of vendors.
3. Select a vendor for the order, and clickOK. TireMaster prompts you for a site.
4. Select the site that will receive the order, and clickOK.
5. Complete the purchase order as you normally would. For more information, see Purchase Orders

on page 262.

Note: The purchase order appears at the store only after the corporate site has sent the
information for the order to the store.

RECEIVE INVENTORY FOR A STORE AT THE CORPORATE SITE
To receive inventory for a store at the corporate site, you need to set the Can Create New RD control
to Yes on the Enterprise tab on the System Controls screen.

Note: Before you can receive inventory for a store on a purchase order completed at the corporate
site, the store must process the transaction and send the results back to the corporate site.

To receive inventory for a store at the corporate site
1. At the corporate site, select Inventory > PO & Receiving. The PO System opens.

2. On the Purchase Orders tab, select the status of All.
3. Select the purchase order that you want to receive, and click Receive.
4. Receive the order as you normally would. For more information, see Receive Items on a Purchase

Order on page 274.

PRICE INVENTORY FOR A STORE AT THE CORPORATE SITE
To price inventory for a store at the corporate site, you need to set the Can Create New VID control to
Yes on the Enterprise tab of the System Controls screen.
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Note: Before you can price inventory for a store at the corporate site, the store must process the
transaction and send the results back to the corporate site.

To price inventory for a store at the corporate site
1. At the corporate site, select Inventory > PO & Receiving. The PO System opens.

2. Click the Receiving Document tab, and select the status Received (Un-priced).
3. Select the receiving document you want to price, and click Price. The Vendor Invoice screen

opens.

4. Complete the pricing process as usual. For more information about pricing inventory, see Price
Items on a Receiving Document on page 277.

ACCOUNTING IN TIREMASTER CORPORATE
In TireMaster Corporate, accounting is handled entirely by the corporate site. The following can be set
up and changed only at corporate:

Chart of accounts

Payment (bank) accounts

Fiscal calendar

GL class options

Inventory GL codes

GL financial statement design

GL ranges

Sales tax rates and levels

Credit cards

Because credit cards are set up at the corporate site, they’re available at all sites. Therefore, you need
to let your employees know which credit cards they can use at their respective sites.

Although stores cannot access TireMaster’s accounting system, they can press  to display the chart
of accounts and select accounts for paidouts, accounts receivable adjustments, easy checks, and
other transactions. Stores can also view the fiscal calendar. However, only employees at the corporate
site can close fiscal periods.

JOURNAL ENTRIES
Only users at the corporate site can view and post journal entries, either manually or automatically
(from completed documents). When a document is completed at a store, the resulting journal entries
aren’t actually posted from the store’s location. The next time that store’s data is updated, the
corporate site checks for any conflicts and then posts the journal entries. Journal entries that affect
accounts at multiple locations can also be created at the corporate site.
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Example: If some advertising was purchased by an employee at the corporate site, you could cre-
ate journal entries to divide the expense among all locations.

Although stores cannot view journal entries, they can view and reprint documents they’ve completed
(such as invoices and purchase orders) that generated the journal entries.

When setting up bank accounts, you need to define which site each bank account is for and you need
to assign a default bank account for each site. Users at the corporate location can access all bank
accounts from the Check Reconciliation screen, while users at a store can see only the bank accounts
for their location.

CREATE AND DEFINE THE INTERSTORE OFFSET ACCOUNT
The interstore offset account makes it possible for you to perform transactions between stores in
TireMaster Corporate while maintaining a balanced general ledger for each site.

Without an interstore offset account, a transaction involving two sites would show the company as a
whole in balance but the general ledgers for the individual sites would be out of balance. The interstore
offset account is typically a liability or expense account. Once you create the interstore offset account,
you need to complete a setting for it in System Controls.

To set up an interstore offset account
1. At the corporate site, add a new account called Interstore Offset. For more information,

see Update the Chart of Accounts on page 656.

Note: If you’re using the default chart of accounts for TireMaster, you should put this account in
the 2000–2999 range.

2. Define the interstore offset account in System Controls.

a. At the corporate site, select Setup > System Controls.
b. Click the Enterprise tab and make sure Corporate Controls is selected.
c. Select Interstore Offset - Major Account, and press Enter. The following message appears:
“This interstore offset account will be used automatically by the system and cannot be edited once
specified. Are you sure you want to continue?”

d. Click Yes. Then select the account you created in step 1 from the Chart of Accounts, and click
OK.
Note: Make sure to select the correct account for this setting. If you select the wrong account,

you will have to call ASA Support to change it.

e. Close the System Controls screen.



CASH AND CLOSING
At the end of a business day, a fiscal period, and a fiscal year, you need to perform various closing
procedures in TireMaster to ensure your business information is up-to-date.

Tills 964
Paidouts 966
Close a Shift 967
Day End Procedures 969
Day End Close Screen 970
Month End procedures 972
Year End Procedures 976
Reports for Closing 977
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TILLS
You have the option to use a single till or as many as four tills at a store. The starting till float amount
can be the same for all of your tills or it can differ for each of them.

DEFINE THE NUMBER OF TILLS
TireMaster allows a store to have as many as four tills. The number of tills is defined by setting a
system control.

To define the number of tills
1. On the TireMaster server, select Setup > System Controls .

2. Click theOther tab.
3. Select Store Controls.
4. Select Tills - Number of Tills and press Enter.

5. Select one of the choices, and clickOK.
6. Close the System Controls screen.

DEFINE STARTING TILL FLOATS
If you use multiple tills, the starting till float amount can be the same for all of them or it can vary. If you
change the till float for a shift, update this number when the shift begins and before any transactions
occur. Otherwise, leave it alone.

To define starting till floats
1. On either the TireMaster server or a workstation, select Setup > System Controls.



Tills

2. Click theOther tab.
3. Select Store Controls.
4. Select Tills - Till#1 Starting Float and press Enter.

5. Type the float amount, and clickOK.
6. If you have multiple tills, repeat steps 4 and 5 for each additional till.

7. Close the System Controls screen.

UPDATE A WORKSTATION’S TILL NUMBER
When you need to update the till number for a workstation, change an entry in the settings for your
forms.

To update a workstation’s till number
1. Select Setup > Printers. The Printer Selection screen opens.

2. Click Forms. The Forms Selections screen opens.
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3. Change the entry in the Till# field. The number entered cannot exceed the number of tills defined
in System Controls; however, you can use the same till number for more than one workstation.

4. Click Save Setup. Then close the open screens.

PAIDOUTS
In some cases, you might need to pay for a miscellaneous expense directly from the till. This type of
transaction is called a paidout. To perform paidouts, you must belong to a security group assigned the
permission Invoicing New Paidout.

To create a paidout
1. Click Invoicing. The OpenWork Order List opens.

2. Click New Paidout. The Cash Paidout screen opens.



Close a Shift

3. Type a description of the expense.

4. Record the offsetting entry for the paidout.

a. Click Add. A new line is added in theGL Offset field.

b. Click theMajor column, press , and select an account from the list. For example, if you're
paying for shipping, you might select a freight expense account.

c. Type the account name in the Descr column.
d. Type the payment amount, and press Enter.

5. ClickOK. TireMaster prompts you to complete the paidout.
6. Click Yes.

CLOSE A SHIFT
In TireMaster, closing a shift is the process of stopping transactions for a specific till so you can count
the cash, checks, credit card receipts, and debit card receipts in that till at that point in time. You can
close a shift once a day or several times a day. Shifts can be closed regardless of whether there is
activity for a till during a shift. If you have one till, you can perform the shift end close at any
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workstation. If you have multiple tills, perform the shift end close on the workstation that the till is
assigned to.

Note: Because TireMaster keeps track of the till float, you need to include it when entering the total
cash for a shift. For example, if your till started with $300 and you end the shift with $700, you
would enter $700 for the cash amount.

To close a shift
1. Determine the individual totals for cash, checks, credit cards, and debit cards from the till for the

shift.

Note: Because TireMaster has no distinct method for handling debit cards, handle them in the
same manner as credit cards.

2. Select Closing > Shift-End. TireMaster prompts you to review the daily invoice listing before
closing the shift.

Note: If you have one till, you can perform the shift end close at any workstation. If you have
multiple tills, perform the shift end close on the workstation that the till is assigned to.

3. To print a daily invoice listing, click Yes. Otherwise, click No. A confirmation message appears.

Note: If you choose to print, the Report Window opens and displays the invoice listing. You can
close the window to continue the closing process.

4. To continue closing the shift, click Yes. The screen that opens includes the shift number and till
number.

5. Enter the following amounts:

a. Type the total of cash, including the starting till amount. For example, if your till started with
$300 and you ended the shift with $700, you would enter $700.

b. Type the total of all checks.

c. Type the total of all credit and debit card receipts in the Cards field.
6. When you are finished entering totals, clickOK. TireMaster prompts you to verify that the till

amounts are correct.
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7. To accept the amounts listed, click Yes. Otherwise, click No and change the amounts as needed.
8. When the shift closed confirmation message appears, clickOK.

DAY END PROCEDURES
When you close a day, you have an opportunity to review the day’s receipts and determine if your till is
over or short. You can then correct any overages or shortages before finishing the day end closing
process.

CLOSE A DAY
Typically, you close a day before making a deposit into your bank account. Depending on how much
business you have in an average day, you might not want to actually perform a day end closing each
business day.

Example: If you make bank deposits every other day, you close the day every other day.

Note: Before closing a day, you need to close all of the shifts for that day.

To close a day
1. Count the total cash, checks, and payment card receipts for all shifts.

2. From the Closingmenu, select Day-End. The Day End Close screen opens.

3. If any cash, check, or payment card amounts are incorrect, type the correct amounts in the Cash
Count, Check Count, and Card Count fields for the applicable shifts. The totals for all shifts
recalculate automatically.
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Note: When you close the day, the amount in the Deposit field is the amount that posts to the
day end deposit and day end cash accounts defined in System Controls. This amount also
appears on the Check Reconciliation screen as your daily deposit.

4. If you want to view the day end reports before closing the day, click Report.

5. When you are ready to close the day, clickOK. The day end reports print and a confirmation
message appears.

6. Click Yes. Another confirmation message appears.
7. ClickOK.

Tip: You can generate day end closing information at any time by printing the Daily Transaction
Report on page 1039, Day End Daily Sales Report on page 1041, Day End Daily Till Detail
Report on page 1043, andDay End Transaction Report on page 1045. These reports are
on the Report List on the Close tab.

OVERAGES AND SHORTAGES
If there is a difference between the cash or check count that you’ve entered and the actual amount
calculated by TireMaster, the amount over or short posts to an account designated for overages and
shortages. For more information, see Default Account - Cash Over/Short on page 1203.

DAY END CLOSE SCREEN
Counts for individual shifts are displayed at the top of the Day End Close screen, and the combined
totals for all shifts are displayed beneath them.



Day End Close Screen

Figure 32-1: Day End Close Screen

Item Description

Shift Displays the shift number for a line.

Till Displays the till number for a line.

Cash Displays the cash amount (including the starting till amount) originally
entered for a shift.

Check Displays the check amount originally entered for a shift.

Card Displays the card amount originally entered for a shift.

Cash Count Lets you correct the cash amount for a shift.

Check Count Lets you correct the check amount for a shift.

Card Count Lets you correct the card amount for a shift.

Float Displays the till float amount for a shift.

Note: If you need to use a different till float amount for a shift, update
the starting till float amount for the applicable till on the System
Controls screen before the shift begins. For more information,
see Define Starting Till Floats on page 964.

Daily Receipts Displays the calculated receipts (based on your invoices and ROAs) for
cash, checks, and cards.

Till Float Displays the starting till float for the first shift of the day.
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Item Description

Paidouts Displays the total of cash paid out of the till and the amount of cash paid
toward purchase orders for a day.

Deposit Displays the calculated bank deposit (based on the total of your cash and
check counts).

Total Displays the total cash amount calculated from your daily cash receipts
(including your till float) minus any cash paid out of the till and cash paid
toward purchase orders.

Actual Counts Displays the total of the amounts that you entered at the close of each
shift for cash, checks, and cards (both debit and credit).

Over & Short Displays any short or over amounts for cash, check, or credit or debit
cards. A negative amount indicates a shortage. A positive amount
indicates an overage.

Report Lets you print your day end reports before completing the day end
closing. After reviewing these reports, you can clickOK to close the day
or you can click Cancel to exit.

OK Continues closing the day.

Cancel Discontinues the day end closing procedure. Any changes made in this
window are lost.

MONTH END PROCEDURES
At the end of each month, perform tasks that prepare your TireMaster system to collect business data
for upcoming month.

Closing a fiscal period ensures that the information on your income statement and balance sheet for a
month is consistent and won’t change because of future transactions. Closing a fiscal period also helps
to ensure that you can associate activity in the subledger accounts with the asset and liability accounts
in the general ledger.

Note: Several reports can provide you with information for comparing subledger accounts to the
general ledger accounts. For more information, see Reports for Closing on page 977.

To close a fiscal period
1. Apply any outstanding payments and credits in the customer and vendor open item ledgers. For

more information, see Apply an ROA on page 702 or Apply Payments and Credits to Vendor
Balances on page 756.
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2. Verify that transactions posted to the appropriate GL accounts:

a. Review the balance sheet and income statement.

b. If an account balance seems too large or too small, research the transactions that posted to
that account. If you find any transactions that posted incorrectly, make correcting entries.

3. Verify that customer and vendor subledger balances equal accounts receivable and accounts
payable balances in the general ledger:

a. Compare the totals on the Customer Balance Report to the accounts receivable totals on the
balance sheet. Research and correct any discrepancies.

b. Compare the totals on the Vendor Balance Report to the accounts payable totals on the
balance sheet. Research and correct any discrepancies.

4. Make sure the balances of the inventory subledger accounts equal the balances of the inventory
accounts in the general ledger. For more information, see on page 974.

Note: To further ensure the accuracy your inventory balances, take a physical inventory count.
You can conduct a physical count as part of each month end close or only when you close
Period 12.

5. Delete expired quotes (optional). For more information, see Delete Expired Quotes on page 974.

6. Reset the quantities of noninventoriable items to zero (optional). For more information, see Reset
Quantities of Noninventoriable Items on page 975

7. Before the first transaction of the new fiscal period, establish a financial baseline for the month
that’s being closed by generating the following documents:

Balance sheet

Income statement

Reports detailing activity in the customer, vendor, and inventory subledger accounts.

Note: The information on some reports changes with new activity. Therefore, you need to print
them before the first transaction of the new month. For more information about reports you
might want to print at closing time, see Reports for Closing on page 977.

8. Record adjusting journal entries for items such as depreciation, payroll, and interest. Backdate the
entries so they post to the month that’s being closed.

Note: You might need to generate additional balance sheets to monitor changes in account
balances as you make adjusting entries.

9. When you have finished posting journal entries to the month that’s being closed, lock the month.
For more information, see Lock a Fiscal Period on page 975.

Note: A fiscal period can be locked and relocked until you close the year in which that period is
included.

10. Back up your data to removable media. For more information, see Month End Backups on page 7.
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Recalculating the value of your inventory, which is often referred to as running the Calc and Post, helps
you determine whether the total of your inventory subledger accounts equals the value of the inventory
accounts in the general ledger. If there are differences between the subledger and GL, you need to
make adjusting journal entries.

TireMaster can make the entries automatically, or you can make themmanually. For TireMaster to
perform the journal entries automatically, the following conditions must be true:

You must be assigned the Automatic Calc & Post JE permission.

Your inventoriable items must be assigned inventoriable GL codes.

Note: If TireMaster detects that there are noninventoriable GL codes are assigned to inventoriable
items, you will be prompted to print a list of such items. You can use the information on that list
to either modify your GL codes or assign different GL codes to the affected items. Then you
can generate the Inventory Calculation Report again.

To recalculate the value of your inventory
1. Select Closing > Inventory Calc & Post. A confirmation message appears.

2. Click Yes. The Report Window opens and displays the Inventory Calculation Report.

3. Click Print. Review the Inventory Calculation Report.

4. Click Close. TireMaster prompts you to automatically post the figures.
Note: This message for posting the figures appears only if you’re assigned the Automatic Calc

& Post JE permission and your inventoriable items are assigned inventoriable GL codes.

5. Define how you want to post the entries:

If you want TireMaster to make the entries for you, click Yes. TireMaster prompts you to define
the fiscal year, number, and period that the entries will post to.

If you want to make the entries yourself, click No. A confirmation message with a reminder to
make journal entries appears.

6. ClickOK.

DELETE EXPIRED QUOTES
At the end of the month, or any other time you feel it's necessary, you can delete expired quotes.
Although deleting expired quotes is not required to close the month, it makes finding quotes easier
because fewer are displayed on the Quote List.
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To delete expired quotes
1. Select Closing > Delete Expired Quotes. The Report Window opens and displays a list of

expired quotes.

2. Print the Expired Quote List if needed, and close the Report Window. A confirmation message
appears.

3. Click Yes. A confirmation message appears.

RESET QUANTITIES OF NONINVENTORIABLE ITEMS
When noninventoriable items are sold, TireMaster displays the on-hand quantity as a negative
number. You can reset the on-hand quantity to zero by performing the month end cutoff. This process
also changes the status of any discontinued items to inactive. Perform the month end cutoff at each
store.

To reset quantities of noninventoriable items
1. From the Closingmenu, selectMonth End Procedures and then Cutoff Month. A confirmation

message appears.

2. Click Yes. A confirmation message appears.

3. ClickOK.

LOCK A FISCAL PERIOD
When you no longer want transactions to post to a month, you need to lock it. You can perform this
step of the month-end closing process after the last day of the month that’s being closed.

To lock a fiscal period
1. Generate the GL Temp Report and Post Error Report to see whether all system generated entries

have posted to the general ledger since the last day of the month. If the reports identify any posting
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errors, fax the reports to ASA Support at 503-296-2800. For more information, see GL Temp
Report on page 1149.

2. Select Closing > Month End Procedures > Lock Month.

3. To lock a month in the current year, select Current Year and clickOK. A confirmation message
appears.

Note: Although you cannot post transactions to a locked month, you can unlock months and then
post transactions.

4. Click Yes. A confirmation message appears.

5. ClickOK.
6. Back up your data to removable media or a recordable memory device. For more information, see

Backups on page 5.

YEAR END PROCEDURES
There are two reasons why businesses close a fiscal year. It shows the increase or decrease in the
owner’s equity, and it provides a fresh start for accumulating information for a new fiscal year. Closing
the year includes closing fiscal period 12 and making adjusting entries recommended by your
accountant. Once you perform those tasks, you can formally close the year in TireMaster, which
results in the following:

Income and expense accounts are closed, and any profit or loss is posted to the owner’s
retained earnings account.

No additional transactions (manual or system-generated) can post to the year that was just
closed.

Note: To close the year, you need to be assigned the Close Year permission.

To close a year
1. At the end of the year, close and lock period 12. For more information, see on page 972 and Lock

a Fiscal Period on page 975.

Note: Closing and locking period 12 prevents the amounts from changing on the reports you’ll be
giving to your accountant.

2. Generate the reports requested by your accountant.

3. Unlock period 12, and make any adjusting entries recommended by your accountant. When you’re
done, lock period 12 again. For more information, see Unlock a Fiscal Period on page 689.
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Note: Period 12 needs to be unlocked when making adjusting entries. Otherwise, they’ll post to
the current period.

4. Have your accountant review the adjusting entries.

5. Back up your data to removable media. For more information, see Year End Backups on page 8.

6. Select Closing > Year End Procedures. A confirmation message appears.

7. Click Yes. The Report Window opens and displays the JE Edit Report.

Note: Once you click Yes, you can no longer unlock periods and post journal entries in the year
that’s being closed.

8. Print the report and close the Report Window. A second confirmation message appears.

9. ClickOK.

REPORTS FOR CLOSING
Several reports in TireMaster can provide you with the information that you need at the month end or
year end. They include details about the state of your business, and they can be used to compare
subledger balances to general ledger balances.

Note: The information displayed on reports identified with a check mark (✓ ) changes with activity.
Therefore, you might want to print these time-sensitive reports before you perform
transactions in a new fiscal period.

You might want to generate reports other than those listed here during your closing procedures.

GENERAL LEDGER REPORTS
The reports in Table 32-1 provide financial information about the activity that has occurred in your
business.
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Report Description

Balance Sheet Shows the financial position of your company for a selected period.
This report includes the totals of your asset, liability, and equity
accounts.

GL Summary Shows the beginning balance, ending balance, and total debits and
credits for each general ledger account during the selected period.

GL Transaction
Details

Displays information for each transaction in the selected date range.

Income Statement Shows the profit or loss earned by your company during the selected
period.

Long Form Displays detailed information about the activity for each general ledger
account during the selected period.

Table 32-1: General Ledger Reports

ACCOUNTS RECEIVABLE REPORTS
The reports in Table 32-2 provide information about your accounts receivable.

Note: The information displayed on reports identified with a check mark (✓ ) changes with activity.
Therefore, you might want to print these time-sensitive reports before you perform transactions
in a new fiscal period.

Time-Sensitive Report and Description

✓ AR Detail - By Customer displays accounts receivable activity for the
selected customers.

✓ Customer Balance Report displays all customers with balances and
shows aged balances for those customers.

Table 32-2: Accounts Receivable Reports

ACCOUNTS PAYABLE REPORTS
The reports in Table 32-3 provide information about your accounts payable.

Note: The information displayed on reports identified with a check mark (✓ ) changes with activity.
Therefore, you might want to print these time-sensitive reports before you perform transactions
in a new fiscal period.
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Time-Sensitive Report and Description

✓ Vendor Balance Report displays each vendor with whom you have
outstanding charges and shows the past due, future due, and total
balances for each vendor.

✓ Vendor Statement Report displays detailed accounts payable information
for all vendors.

National Account Reconciliation Report displays national account,
government support, and adjustment invoices in the selected date range
for which vendors owe you credits.

Table 32-3: Accounts Payable Reports

INVENTORY REPORTS
The reports in Table 32-4 provide information about your inventory.

Note: The information displayed on reports identified with a check mark (✓ ) changes with activity.
Therefore, you might want to print these time-sensitive reports before you perform
transactions in a new fiscal period.

Time-Sensitive Report and Description

Inventory Counting Deck lists inventory items and includes blank lines for
noting the actual quantities of items.

✓ Consignment Inventory displays all consignment items as well as their
quantities and costs.

✓ Inventory Value Report displays the value of inventory items sorted by
category and group.

Inventory Reconciliation Report displays inventory quantities and the
transactions that increased or decreased those quantities during the
selected date range.

✓ Open Work Order - Item List shows all items that are currently on open
work orders sorted by site and product code.

✓ Open Work Order - Qty lists all items that are currently on open work
orders sorted by site and invoice.

Table 32-4: Inventory Reports
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REPORTS
TireMaster includes an array of reports that provide information about the different areas of your
business. This chapter includes the following sections:

TireMaster Dashboard 982
Report List 987
Inventory Tab Reports 988
Close Tab Reports 1031
Customer Tab Reports 1098
GL Tab Reports 1134
Vendor Tab Reports 1159
Unlisted Reports 1174
Document Screens 1178
Financial Statement Settings 1179
Sales Report Options 1183
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TIREMASTER DASHBOARD
On-screen reporting of gross profit, sales, and quantity information is readily available on the
TireMaster Dashboard (Figure 33-1).

Figure 33-1: TireMaster Dashboard

Specifically, the Dashboard includes the following:

Gross profit dollar (GP$) and gross profit percentage (GP%) figures, parts and labor totals, and
document counts for today’s work orders and invoices (upper-right corner of the screen).

Various options for generating on-screen graphs and pie-charts are listed below today’s
information. These options include the ability to show daily or monthly GP$, GP%, sales totals,
or quantities sold, organized by category, employee, group, manufacturer, or customer type.

The option to compare this year’s and last year’s GP$, GP%, sales, and quantity totals.

The option to set monthly sales and gross profit goals, so you can see whether you’re keeping
pace with those objectives.

SET DASHBOARD REPORTING GOALS
You can quickly assess your progress toward monthly business objectives by setting Dashboard
reporting goals. When reporting goals are defined, the Dashboard includes sales and gross profit
markers for gauging your success.

To set Dashboard reporting goals
1. Select Setup > Dashboard Goals. The Dashboard Goals screen opens.

Dashboard_Full.png
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2. Select the store for which you want to set reporting goals.

3. Select the year for which you want to set reporting goals.

Note: If you’re prompted to save your changes before continuing, click Yes.

4. To set the goals for a month, do the following for that month.

a. Type the number of days the store is open.

b. Type the amount of money you want to earn in sales.

c. Type the gross profit you want to earn.

d. Type the gross profit percentage you want to earn.

Note: An entry is needed in each of the fields for the month for which you’re setting goals. If
you do not want to report on a dollar amount or percentage, type a 0.

5. To use the goals from an existing month to set the goals for another month, copy the existing
month’s goals and assign them to the other month.

a. Select the month with the goals you want to reuse from the Copy From drop-down.

b. Select the month that you want to assign the copied goals to from the Copy To drop-down.
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c. Change the number of days, sales amount, GP$, and GP% if needed.

d. Click Create.
6. To delete the goals for a month, select one of the fields for that month and click Delete.
7. Click Save. A confirmation message appears.

8. ClickOK.
9. Close the Dashboard Goals screen.

VIEW THE DASHBOARD
To open the Dashboard, press F9 on your computer’s keyboard. Access to the Dashboard is controlled
with the permission Dashboard View.

To generate on-screen Dashboard graphics
1. If the Dashboard is not already open, press F9.

Note: When the Dashboard is already open, click on the task bar.

2. For a hard copy of the work order and invoice data (displayed in the upper-right corner), click Print.



TireMaster Dashboard

3. Under Show, define whether you want to generate sales, GP$, GP%, or quantity information.

4. Under By, do the following as needed:
Define whether you want to compare years, view the status of your goals, or organize the
information by month, inventory category, employee, inventory group, manufacturer, or
customer type.
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Select the 3D check box if you want to generate a three-dimensional bar graph. For a one-
dimensional bar graph, clear the check box.

Note: 3D is available only for reports generated by month.

5. Under For, define whether to show today’s information or month-to-date (MTD) information.

Note: These options are not available when the information is organized by month, when
comparing two years, and viewing the status of goals.

6. To generate a pie chart, select the View as Pie Chart check box (lower-left corner of the screen).

7. Do one of the following:

If want to view additional information on the Dashboard, repeat steps 3 through 6.

If you want to exit the Dashboard, click Close.
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REPORT LIST
The Report List displays most of the reports available in TireMaster and any custom reports you’ve
purchased.

Figure 33-2: Report List

Item Description

All This tab displays all reports that can be generated from the Report List.

Close These reports are useful for day end, month end, and year end activities.

Custom These reports are developed on special request.

Note: If you have not requested any custom reports, this tab is not
available.

Customer These reports display customer-related information, including accounts
receivable activity and outstanding balances.

GL These reports let you access information about the general ledger, as
well as generate balance sheets and income statements.

Inventory These reports let you track and manage your inventory.

Vendor These reports display vendor related information, including accounts
payable activity and outstanding balances.
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Item Description

Launch Does one of the following, depending on the selected report:

Opens the screen for generating the report

Displays the document on the Report Window, for reports that do
not have screens

Custom Tabs Accesses tools for creating your own report tabs.

Close Closes the Report List.

INVENTORY TAB REPORTS
These reports are useful for managing your inventory.

CONSIGNMENT INVENTORY
This report lists all consignment items (items assigned type C) as well as their quantities and costs.

To generate a Consignment Inventory Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Consignment Inventory and click Launch. The Custom Inventory Lookup screen opens.



Inventory Tab Reports

3. Look up one or more items. The Report Window opens. For more information, see Inventory
Searches on page 230.

4. Print the report and close the Report Window.

DISCONTINUED INVENTORY LIST
This report lists all items marked as discontinued on the Inventory Maintenance Screen. Information
displayed on the report includes the on hand quantity, unpriced quantity, total quantity, parts price,
labor price, and FET.

To generate a Discontinued Inventory List
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Discontinued Inventory List and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

HISTORICAL QTY ADJUSTMENT REPORT
This report lists all the inventory quantity adjustments for the selected date range.

To generate a Historical Qty Adjustment Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Historical Qty Adjustment Report and click Launch. The Report Option screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Category
Group

5. To include individual items, make sure the Show All Details check box is selected. For group or
category totals only, clear the check box.

6. ClickOK. The Report Window opens.

7. Print the report and close the Report Window.

INVENTORY ADD-ON CODES
This report shows all add-on codes, along with the settings and items assigned to each of the codes.

To generate an Inventory Add-On Codes Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Add-On Codes and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

INVENTORY BAR CODES
With this report, you can generate bar code labels that can be attached to shelves or pricing sheets. In
addition to bar codes, the labels can include up to four types of information, such as sizes and
descriptions. Bar codes can be printed on Avery® 8163 label sheets or other compatible label sheets (2
x 4 inches).

To generate inventory bar codes
1. Load the printer with label sheets.

2. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

3. Select Inventory Bar Codes and click Launch. The Bar Code Report screen opens.
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4. Select up to four of the following types of information to include with the bar code:

Product Code
Size
Description
Quick Look
Bar Code #
Store Name

Note: This information prints in the order that it’s selected. To rearrange the information, clear the
check boxes and then select them in the order that you want.

5. Select the bar code that you want to print from the drop-down.

Note: If you’ve stored bar codes in the Inventory Maintenance screen’s Vendor Part# field, you
can also retrieve that data from the drop-down.

6. Click Print. The Custom Inventory Lookup screen opens.
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7. Look up the items whose bar codes you want to print. The Report Window opens. For more
information, see Inventory Searches on page 230.

8. Print the labels and close the Report Window.

INVENTORY CALCULATION REPORT
This report displays the following information for each of the general ledger’s inventory accounts:

The calculated inventory quantity

The general ledger account’s current balance

The recommended adjustment

You can launch this report from the Report List, and it is automatically generated when you select
Closing > Inventory Calc & Post from the menu.

Note: For information about generating this report from the Closingmenu, see on page 974.

To generate an Inventory Calculation Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Calculation Report and click Launch. TireMaster prompts you to show report
detail.
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3. To include information for individual items, click Yes. For account totals only, click No. The Report
Window opens.

4. Print the report and close the Report Window.

INVENTORY CATEGORY LIST
This report lists all inventory category codes and their descriptions.

To generate an Inventory Category List
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Category List and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

INVENTORY CHECK UP REPORT
This report compares TireMaster’s inventory quantities to the quantities calculated from detailed
histories for sales, receivings, and adjustments. If the report notes any differences, call ASA Support.
Print this report at stores only.

Note: To ensure that TireMaster reports item quantities and any potential discrepancies correctly,
generate this report only when no other users are logged in to the program.

To generate an Inventory Check Up Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Check Up Report and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

INVENTORY COST LISTING
This report provides a variety of information about items, including quantities, cost, federal excise tax,
parts and labor prices, and gross profits. With this report, you can also view month-to-date, year-to-
date, and last year’s total quantities sold for items.

Note: An asterisk (*) next to the parts price indicates that an item is on sale.

To generate an Inventory Cost Listing
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Cost Listing and click Launch. The Inventory Cost Listing Report screen opens.
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3. Click Lookup and select the site or sites whose information you want to include on the report.
Note: For multiple sites, press Ctrl and select each site that you want to include on the report. For

all sites, select the check box.

4. Select one of the following methods for organizing items on the report:

Inventory Group
Inventory Category
Site

5. To include information for individual items, make sure the Show Detail check box is selected. For
totals only, clear the check box.

6. Click Print. The Custom Inventory Lookup screen opens.

7. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

8. Print the report and close the Report Window.

9. Close the Inventory Cost Listing Report screen.
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INVENTORY COUNTING DECK
This report lists the items you want to count, and it includes blank lines where you can write the actual
quantity for each of the items.

Note: For a counting deck that includes TireMaster’s system-generated inventory quantities, print
Inventory Counting Deck w/ QTY instead.

To generate an Inventory Counting Deck
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Counting Deck and click Launch. The Custom Inventory Lookup screen opens.

3. Look up the items you want to count. The Report Window opens. For more information, see
Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY COUNTING DECK W/ QTY
This report lists the items that you want to count. For each item, it includes the current
system-generated quantity, a blank line where you can write the actual quantity, and the quantity on
work orders.

To generate an Inventory Counting Deck w/QTY
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.
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2. Select Inventory Counting Deck w/ QTY and click Launch. The Custom Inventory Lookup screen
opens.

3. Look up the items you want to count. The Report Window opens. For more information, see
Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY FLAT RATE REPORT
This report lists items whose settings include a flat rate. For more information, see Flat Rate Reporting
on page 882.

To generate an Inventory Flat Rate Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Flat Rate Report and click Launch. The Custom Inventory Lookup screen opens.
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3. Look up the items you whose flat rate you want to see. The Report Window opens. For more
information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY GL CODE DETAIL
This report lists the items that GL codes are assigned to, along with category, group, quantity, and cost
information. It can be generated for a single GL code or all GL codes. You can also limit the report to
specific items, items with differing last costs and next costs, or both.

To generate an Inventory GL Code Detail Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory GL Code Detail Report and click Launch. The Inventory GL Code Detail Report
screen opens.
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3. Select one or more GL codes:

For one code, click Lookup and select a code from the list that opens.

For all codes, leave theGL Code field blank.
4. To display only those items whose last and next costs differ, select the Show Differences Only

check box. For all items, leave the check box clear.

5. Click Print. The Custom Inventory Lookup screen opens.

6. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

7. Print the report and close the Report Window.

INVENTORY GL CODE LISTING
This report lists each inventory GL code as well as its description, inventoriable status, department,
and each of the general ledger accounts assigned to it. The Inventory GL Code Listing is available only
.

To generate an Inventory GL Code Listing
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.
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2. Select Inventory GL Code Listing and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

INVENTORY GROUP LIST
This report lists the inventory groups set up in TireMaster.

To generate an Inventory Group List
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Click Inventory Group List and click Launch. The Report Window opens and displays the report.
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3. Print the report and close the Report Window.

INVENTORY LABEL
This report prints a label for each selected item. Each page of the report prints three labels across and
ten labels down. The labels include the following information:

Product Code

Manufacturer

Name (Description)

Size

Rim Size

Vendor Part Number

Everyday Low Price

Note: For best results, print on Avery® 5160 labels or a similar label type.

To create inventory labels
1. Load the reports printer with label sheets.

2. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

3. Select Inventory Labels and click Launch. The Custom Inventory Lookup screen opens.
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4. Look up the items for which you’re creating labels. The Report Window opens. For more
information, see Inventory Searches on page 230.

5. Print the report and close the Report Window.

INVENTORY LIST - NEGATIVE
This report lists inventory items that have negative quantities in TireMaster.

To generate an Inventory List - Negative Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory List - Negative and click Launch. The Custom Inventory Lookup screen opens.
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3. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY LIST - NOT ZERO
This report lists all selected items with either positive or negative quantities.

To generate an Inventory List - Not Zero Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory List - Not Zero and click Launch. The Custom Inventory Lookup screen opens.
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3. Look up the items you want to check. The Report Window opens. For more information, see
Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY LISTING BY MANUFACTURER
This report lists items by manufacturer with costs for on hand and unpriced items.

To generate an Inventory Listing by Manufacturer
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Listing By Manufacturer and click Launch. The Custom Inventory Lookup screen
opens.
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3. Look up items for one or more manufacturers. The Report Window opens. For more information,
see Search by Manufacturer on page 231.

4. Print the report and close the Report Window.

INVENTORY MASTER LIST
This report lists all selected items, showing the quantity on hand, parts and labor prices, and FET for
each. This report includes both inventoriable and noninventoriable items.

To generate an Inventory Master List
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Master List and click Launch. The Custom Inventory Lookup screen opens.
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3. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY MIN/MAX QTY LIST
This report shows the minimum and maximum quantity settings for the selected items and the number
of items that exceed the maximum stocking levels. In addition to stocking level information, the report
also includes on work order, on hand, unpriced quantities.

To generate an Inventory Min/Max Qty List
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Min/Max Qty List and click Launch. The Custom Inventory Lookup screen opens.
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3. Look up the items you want to check. The Report Window opens. For more information, see
Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY MONTHLY MOVING
This report lists inventory items, as well as the quantities that have been received and sold, during the
last 30 days.

To generate an inventory monthly moving report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Monthly Moving and click Launch. The Custom Inventory Lookup screen opens.
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3. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY MOVING REPORT
This report lists the quantities on hand and the quantities sold each month, during a user-defined date
range.

To generate an Inventory Moving Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Moving Report and click Launch. The Inventory Moving Report screen opens.
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3. Type the beginning and ending dates of the date range. For a single day, use the same day for the
beginning and ending date.

4. Select one of the following methods for organizing items on the report:

Product Code
Size
Description
Category
Group
MFG

5. To include minimum/maximum quantities, location (where the item is stored), and site, select one
or more of the check boxes.

6. Click Print. The Custom Inventory Lookup screen opens.
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7. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

8. Select the site or sites whose information you want to include on the report, and clickOK.
Note: For multiple sites, press Ctrl and select each site whose information you want to include on

the report. For all sites, select the check box.

9. Print the report and close the Report Window.

INVENTORY NONINVENTORY LIST
This report lists selected noninventory items, including the quantity on hand, parts and labor prices,
and FET for each.

To generate an Inventory NonInventory List
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory NonInventory List and click Launch. The Custom Inventory Lookup screen
opens.
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3. Look up the items you want to include you want to include on the report. The Report Window
opens. For more information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY NOT MOVING REPORT
For items you currently have on hand, this report shows those that have not had any activity at all (for
example, sales, receipts, or adjustments) during the selected date range.

Note: If the report is blank, verify that you’ve entered a valid date range for the time your TireMaster
system has been online.

To generate an Inventory Not Moving Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Not Moving Report and click Launch. The Not Moving Report Options screen
opens.
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3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Inventory Group
Inventory Category

5. To exclude inactive items, make sure the Include Active Only check box is selected. For both
active and inactive items, clear the check box.

6. To include information for individual items, make sure the Show All Details check box is selected.
For group or category totals only, clear the check box.

7. Click Print.

8. Print the report and close the Report Window.
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INVENTORY ON ORDER
This report provides information about items that have been ordered. For each item, the report
displays the vendor, date ordered, prices, and quantity ordered and received.

To generate an Inventory On Order Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory On Order and click Launch. The Inventory On Order screen opens.

3. Click Lookup, and select the site or sites for which you want to include information on the report.
Note: For multiple sites, press Ctrl while you select each site. For all sites, select the check box.

4. To include purchase order information on the report, make sure the Show Detail check box is
selected. To display ordered items only, clear the check box.

5. Click Print. The Custom Inventory Lookup screen opens.

6. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.
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7. Print the report and close the Report Window.

8. Close the Inventory On Order screen.

INVENTORY PRICE LEVEL REPORT
This report lists each price level in a selected range, the four-digit code and description for each price
level, and all of the corresponding price level discounts.

To generate an Inventory Price Level Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Price Level Report and click Launch. The Report Options screen opens.

3. Select one price level or a range of price levels:

For one price level, click next to the Beginning Price Level field and select a price level
from the list. Then repeat this process for the Ending Price Level field.
For a range of price levels, click next to the Beginning Price Level field and select the
price level for the beginning of the range. Then click next to the Ending Price Level field
and select the price level for the end of the range.

4. Click Print. The Report Window opens.
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5. Print the report and close the Report Window.

INVENTORY RECONCILIATION REPORT
With the Inventory Reconciliation Report, you can research your inventory quantities and the
transactions that increased or decreased those quantities in a given date range. Because this report
displays the ending quantities and costs of items for the specified date range, you might want to
include printing it in your month end closing procedures.

To generate an Inventory Reconciliation Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Reconciliation Report and click Launch. The Custom Inventory Lookup screen
opens.

3. Look up the items you want to include on the report. The Selected Inventory screen opens. For
more information, see Inventory Searches on page 230.
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Note: If you want to look up different items, click Change.

4. ClickOK. The Inventory Reconciliation Report screen opens.

5. Select the starting and ending dates for the report’s date range.

6. Select one of the following methods for organizing items on the report:

Category
Group

7. Select or clear the following check boxes as needed:

Show Detail includes document numbers, unit costs, and part numbers on the report.
Show Current Qty includes current on hand and current work order quantities.

8. Click Print. The Report Window opens.

9. Print the report and close the Report Window.

10. Close the Inventory Reconciliation Report screen.
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INVENTORY REORDER REPORT
This report lists on hand quantities for all items in the selected range. It also includes the total weight
and month-to-date, year-to-date, and last year’s quantities sold for each of the items. Unlike the
reorder report generated by the suggested purchase order feature, this one is not based on minimum
stocking levels.

Note: The control Reorder Reports - Include Transfers affects whether transfers are included in
the report’s month-to-date, year-to-date, and last year totals. This setting is on theInventory
tab on the System Controls screen.

To generate an Inventory Reorder Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Reorder Report and click Launch. The Custom Inventory Lookup screen opens.

3. Look up the items that you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY SLOW MOVING REPORT
This report shows items for which the following is true:

They have an on hand quantity of any number except zero.

They have not been sold during the specified date range.
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This report also provides the dates on which the items were last sold.

To generate an Inventory Slow Moving Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Slow Moving Report and click Launch. The Report Options screen opens.

3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Inventory Group
Inventory Category

5. To exclude inactive items, make sure the Include Active Only check box is selected. For both
active and inactive items, clear the check box.

6. If you want to include individual items on the report, make sure the Show All Details check box is
checked. For category or group totals only, clear the check box.

7. Click Print. The Report Window opens.
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8. Print the report and close the Report Window.

INVENTORY SPIFF REPORT
This report lists each sales spiff, its associated color, and its settings. The report also lists all the items
associated with a spiff, the calculated spiff commission, and the parts price that’s used in the
calculation.

To generate an Inventory Spiff Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Spiff Report and click Launch. The Custom Inventory Lookup screen opens.
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3. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

INVENTORY VALUE REPORT
This report lists the value of inventory items sorted by category or group. The value is the quantity on
hand multiplied by the item’s cost (usually the next cost) including any FET.

Note: The reported inventory value is not reconciled with the general ledger.

To generate an Inventory Value Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Inventory Value Report and click Launch. The Report Options screen opens.
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3. Select one of the following methods for organizing items on the report:

Category
Group

4. To include information for individual items, make sure the Show All Details check box is selected.
For group or category totals only, clear the check box.

5. ClickOK. The Report Window opens.

6. Print the report and close the Report Window.

INVENTORY ZERO COST & ZERO MIN REPORT
This report helps you identify items that have incomplete settings. The report displays only
inventoriable items whose settings are missing the last cost and minimum quantity.

To generate an Inventory Zero Cost & Zero Min Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.
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2. Select Inventory Zero Cost & Zero Min Report and click Launch. The Custom Inventory Lookup
screen opens.

3. Look up the items you want to check. The Report Window opens. For more information, see
Inventory Searches on page 230.

4. Print the report and close the Report Window.

ITEMS ON SALE
This report lists all items currently on sale, including their prices and sale starting and ending dates.

To generate an Items on Sale Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Items on Sale and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

PRICE LEVEL REPORT
Lists prices for items based on A–E price levels or the price level discounts that are set up in
TireMaster.

To generate a Price Level Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Price Level Report and click Launch. The Price Level Report screen opens.
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3. Do one of the following:

For a list of items that are assigned A–E price levels, select one or more of the check boxes
labeled A, B, C, D, and E.
For a list of items that are assigned price level discounts, click Lookup and select one or more
price level discounts.

Note: For multiple price level discounts, press Ctrl while you select each discount.

4. Select one of the following methods for organizing items on the report:

None
Inventory Group
Inventory Category
Manufacturer

5. Click Print. The Custom Inventory Lookup screen opens.

1027



1028

User Guide

6. Look up the items that you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

7. Print the report and close the Report Window.

RECEIVING HISTORY BY PRODUCT REPORT
This report shows the receiving history for a selected range of items.

To generate a Receiving History by Product
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Receiving History by Product Report and click Launch. The Custom Inventory Lookup
screen opens.



Inventory Tab Reports

3. Look up the items you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

4. Print the report and close the Report Window.

VENDOR PART NUMBER LIST
This report shows the vendor part numbers assigned to a selected group of items, along with the
corresponding reconciliation codes for each of the vendor part numbers.

To generate a vendor part number list
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Vendor Part Number List and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

WORK ORDER QTY
This report lists the quantities of all items that are currently on open work orders.

To generate a Work Order Qty Report
1. Select Inventory > Reports. The Report List opens with the Inventory tab selected.

2. Select Work Order Qty and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

CLOSE TAB REPORTS
The reports on the Close tab are useful for day end, month end, and year end closing activities. Some
reports on this tab are also useful for accounting or payroll purposes.

ADJUSTMENTS
This report shows any items that were adjusted on an invoice during the selected date range. For each
adjusted item, this report displays the invoice number, the item’s product code, quantity, parts price,
labor price, federal excise tax, amount, cost, and gross profit margin percentage.

To generate the Adjustments Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Adjustments and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.
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4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

AR COLLECTIONS
Referring to the AR Collections Report can help you collect money from customers who have
outstanding balances. Depending on which customer lookup is used, information generated by this
report can be grouped by customer, customer type, or salesperson. Balances displayed on the report
can be aged by the date of the sale or by the payment due date.

To generate the AR Collections Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select AR Collections, and click Launch. The AR Collections Report screen opens.

3. To look up balances, do the following as needed:

For all outstanding balances, leave the Customer Name, Customer Type, and Salesperson
fields blank.

For a specific customer, click Customer Name and look up the customer. For more
information, see Customer Searches on page 93.

For one or more customer types, click Customer Type. Then select one or more types and
clickOK.
Note: For multiple types, press Ctrl while selecting each type.
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For customers assigned to a specific salesperson, click Salesperson and select a name from
the list that appears.

4. Indicate how to age the balances by selecting either Invoice Date or Invoice Due Date.
5. Indicate how to organize information on the report by making a selection from theGroup By

drop-down.

Note: This option is not available when generating a report for a single customer.

6. To include invoice information on the report, make sure the Show Detail check box is selected.
For totals only, clear the check box.

7. Click Print. The Report Window opens.

8. Print the report and close the Report Window.

9. To generate a report for other customers, click Reset. Then repeat steps 3 through 8.
10. Close the AR Collections Report screen.

CASH IN
This report displays all of the cash collected during a date range, including invoices and amounts
received on account (ROAs). It shows each invoice listed by transaction type and the method of
payment.

To generate the Cash In Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Cash In and click Launch. The Date Range screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

CASH OUT
This report displays all of the cash paid out of the till for a selected date range.

To generate the Cash Out Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Cash Out and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.
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5. Print the report and close the Report Window.

COMMISSION REPORT
This report displays the sales commissions and spiffs for an individual employee or all employees for a
specific date range. The information included on the Commission report is described in Table 33-1.

Item Description

CommType Identifies the type of commission that was used for a line:

GM: Gross margin or gross profit (based on the report’s GP$ 
column)

TS: Total sales or gross sales (based on the report’s TOTAL
column)

FD: Flat dollar amount (based on the report’s QTY column)

S: Salesperson (from the work order’s SALES column)

M1: Mechanic 1 (from the work order’s MECH1 column)

M2: Mechanic 2 (from the work order’s MECH2 column)

Qty Identifies the number of units for a line item.

Total Identifies the total cost for a line item.

GP$ Identifies the amount over your cost for an item.

GPM% Identifies the markup percentage for an item.

SpiffAmount Shows the calculated spiff for each item sold by an employee.

CommAmount Shows the calculated commission for each item sold by or worked on
by an employee.

Split Defines whether the commission matrix code used for a line item is
set up with a MECHANIC 2 rate (even if the job was not actually split).

Table 33-1: Commission Report Properties

Tip: After you verify commission calculations, you can launch the report again, choose the same
settings, and click Save & Lock. Commissions will not change on locked reports if you update
any of your commission settings.
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To generate a Commission Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Commission Report and click Launch. The Commission Report screen opens.

3. Look up one or more employees:

For one employee, click the Employee field and press . Then select the employee’s name
from the list that opens.

For all employees, leave the Employee field blank. Commission calculations can be saved and
locked only when generating a report for all employees.

4. Select a beginning and ending date for the report’s date range.

5. Define which information will appear on the report.

a. To include national account and government support sales, select the National and
Government check boxes as needed.

b. To list the items sold, make sure the Detail check box is selected. For totals only, clear the
check box.

c. To exclude customer commission totals, select the Employee Only check box.
6. Define whether you want to generate information about locked or unlocked commissions:

For unlocked commissions, select Current.
Note: Until you lock commissions, data on the report could change if you update the settings

for commission rates, commission types, and the employee’s commission matrix.

For locked commissions, selected Locked (Saved).
7. Click Print. The Report Window opens.



Close Tab Reports

8. Print the report and close the Report Window.

Once you have verified that the commission calculations are accurate, you can prevent them from
being changed by launching the report again and clicking Save & Lock.
Warning: Once you save and lock the commissions for a date rage, you cannot unlock or change the

commissions in that range.

CREDIT CARD LIST FOR DATE RANGE
This report lists all credit card purchases for a selected date range. It’s useful for reconciling payments
from credit card companies.

To generate a Credit Card List for Date Range Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Credit Card List for Date Range and click Launch. The Credit Card List for Date Range
screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. Select one or more credit cards.

Note: For multiple credit cards, press Ctrl while selecting each card. For all cards, select All.

5. To include invoice, credit card, and authorization numbers on the report, make sure the Show
Detail check box is selected. For card totals only, clear the check box.

6. Click Print. The Report Window opens.

7. Print the report and close the Report Window.

CUSTOMER BALANCE REPORT BY SALESPERSON
This report lists the aging balances for all of the customers that a salesperson is assigned to. You can
generate the report for all salespeople, one salesperson, or a range of salespeople.

To generate a Customer Balance Report by Salesperson
1. Select Closing > Reports. The Report List opens with the Close tab selected.



Close Tab Reports

2. Select Customer Balance Report by Salesperson and click Launch. The Customer Balance
Report by Salesperson screen opens.

3. Select one or more salespeople:

For one salesperson, press in the Beginning Salesperson field and select an employee
from the list that opens.

For a range of salespeople, press in the Beginning Salesperson field and select an
employee from the list that opens. Then click the Ending Salesperson field select another
employee in the same manner.

For all salespeople, leave the Beginning Salesperson and Ending Salesperson fields as is.
4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

DAILY TRANSACTION REPORT
This report lists all transactions that occurred at point of sale during a selected date range. You can
use this information to verify that the daily subledger totals match the account balances in general
ledger.
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To generate a Daily Transaction Report
1. Select Reports from the Closingmenu. The Report List opens with the Close tab selected.

2. Select Daily Transaction Report and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

DAY END COMPARISON REPORT
This report lets you generate information about year-to-date, month-to-date, and today’s sales activity.
This information includes figures such as gross cost and net dollar margin.

Note: The amounts on this report are calculated based on the settings for your GL ranges. If the
totals appear to be skewed, verify that none of you GL ranges overlap. To view these settings,
selectGL Ranges from the Setupmenu.

To generate a Day End Comparison Report
1. Select Reports from the Closingmenu. The Report List opens with the Close tab selected.



Close Tab Reports

2. Select Day End Comparison Report and click Launch. The Day End Comparison Report screen
opens.

3. Click Lookup, and select the site or sites whose information you want to include on the report.
Note: For multiple sites, press Ctrl while you select each site. For all sites, select the check box.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

DAY END DAILY SALES REPORT
This report lets you view the totals and averages of all transactions that occurred at point of sale for a
selected date range. This report is useful for determining your total sales and gross profit margin for a
given period.

To generate a Day End Daily Sales Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Day End Daily Sales Report and click Launch. The Day Close Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. To retrieve documents that were completed on a specific day, select Use Invoice Date. For the
documents included in the closing for a business day, select Use Day Close Date instead.

5. To organize information on the report by site, make sureGroup by Site is selected. To combine
the information instead, clear the check box.

6. To include invoice information, select the Show Detail check box. For invoice totals and averages
only, clear the check box.

7. ClickOK. The Report Window opens.

Note: When printing the report at the corporate site, you will be prompted to select one or more
sites. For multiple sites, press Ctrl while you select each site. For all sites, select the check
box.



Close Tab Reports

8. Print the report and close the Report Window.

DAY END DAILY TILL DETAIL REPORT
This report displays all transactions that have taken place for the till that has been closed, grouping
items by invoice type. Like the Day End Daily Sales Report, it presents invoice totals but with different
groupings.

To generate a Day End Daily Till Detail Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Day End Daily Till Detail Report and click Launch. The Day Close Date Range screen
opens.

3. Select the starting and ending dates for the report’s date range.

4. To retrieve documents that were completed on a specific day, select Use Invoice Date. For the
documents included in the closing for a business day, select Use Day Close Date instead.

5. To include invoice information, select the Show Detail check box. For invoice totals and averages
only, clear the check box.

6. ClickOK. The Report Window opens.
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Note: When printing the report at the corporate site, you will be prompted to select one or more
sites. For multiple sites, press Ctrl while you select each site. For all sites, select the check
box.

7. Print the report and close the Report Window.

DAY END TILL TOTALS REPORT
This report lists the till totals recorded for a specific date.

To generate a Day End Till Totals Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Day End Till Totals Report, and click Launch. The Day Close Date Range screen opens.

3. Enter the date for which you want a list of till totals in the Start Date field.
4. ClickOK. The Report Window opens.



Close Tab Reports

Note: When printing the report at the corporate site, you will be prompted to select one or more
sites. For multiple sites, press Ctrl while you select each site. For all sites, select the check
box.

5. Print the report and close the Report Window.

DAY END TRANSACTION REPORT
This report displays the same information as the Day End Daily Till Detail Report (all transactions for
the till that has been closed) but with slightly more detail. It also includes a deposit slip for the day’s
receipts.

To generate a Day End Transaction Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Day End Transaction Report and click Launch. The Day Close Date Range screen opens.
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3. Select the starting and ending dates for the report’s date range. For a single day, use the same
date for both the starting and ending dates.

4. Do one of the following:

For transactions completed on a specific day, select Use Invoice Date.
For transactions included in the closing process run for a business day (or a range of business
days), select Use Day Close Date.

5. To include invoice information, select the Show Detail check box. For invoice totals and averages
only, clear the check box.

6. ClickOK. The Report Window opens.

Note: When printing the report at the corporate site, you will be prompted to select one or more
sites. For multiple sites, press Ctrl while you select each site. For all sites, select the check
box.

7. Print the report and close the Report Window.
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DECLINED SERVICES REPORT
This report lists customers who’ve declined services, along with descriptions of the services they did
not authorize, during a selected date range. You can generate the report for all customers, a single
customer, or by salesperson. When generating the report for all customers or by salesperson, you also
have the option to limit the information retrieved to a single checklist and inspection area.

To generate a Declined Services Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Declined Services Report, and click Launch. The Declined Services screen opens.

3. Select the starting and ending dates for the report’s date range.

4. To retrieve information for a specific customer, click Customer and look up the customer.
Otherwise, leave this field empty.

5. To retrieve information for a specific salesperson, click Salesperson and make a selection from
the list that opens. Otherwise, leave this field empty.

6. To retrieve information for a specific checklist and inspection area, select the name of the checklist
from the Service Checklist drop-down. Then make a selection from the Inspection Area drop-
down. You can disregard the numbers listed to the right of the service checklist and inspection
area names.

Note: If you use the Epicor® Integrated Service Estimator™ with your TireMaster system, select
the ISE checklist instead of the generic checklist set up for use with the Integrated Service
Estimator.

7. Select or clear the check boxes to define whether services should be included based on the
condition of inspection areas.
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8. To organize the report by inspection area, select theGroup by Inspection Area check box.
Otherwise, leave the check box alone.

9. Click Print.The Report Window opens.

10. Print the report and close the Report Window.

DELETED WORK ORDERS REPORT
With this report, you can generate one of the following:

A list of work orders deleted during a specific date range

A list of deleted work orders that were created during a specific date range

For each deleted work order, the report includes item quantity, cost, and price information. It also
displays the name of the user who started and deleted each work order

Note: User names are available for work orders started in TireMaster Point of Sale 3.8.1, TireMaster
Plus 8.1.0, or TireMaster Corporate 8.1.0 or newer.

When the System ControlWork Orders - Require Comments When Deleting is set to Yes, the
report also includes the reasons for deleting work orders.

To generate a Deleted Work Orders Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.



Close Tab Reports

2. Select Deleted Work Orders and click Launch. The Deleted Work Order Report screen opens.

3. Select one of the following options:

For a list of deleted work orders created during a specific date range, select Date Created.
For a list of work orders deleted during a specific date range, select Date Deleted instead.

4. Select the starting and ending dates for the report’s date range.

5. Click Print. The Report Window opens.

6. Print the report and close the Report Window.

DIRECT DEPOSIT
This report shows all your direct deposits for the selected date range.
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To generate a Direct Deposit Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Direct Deposit and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

EMPLOYEE CUSTOMER TYPE LIST
This report lists all of your employees and their contact information.

To generate an Employee Customer Type List
1. Select Closing > Reports. The Report List opens with the Close tab selected.



Close Tab Reports

2. Select Employee Customer Type List and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

EMPLOYEE/USER LIST
This report lists the employees/users set up in TireMaster. It includes information assigned to user
accounts, such as user name, ID, and the system-assigned employee number. This report can be
generated for all employees/users or only those who are active.

Note: This report includes employee/user information for the entire organization regardless of
whether it’s printed at the corporate site or a store.

To generate an Employee/User List
1. Select Reports from the Closingmenu. The Report List opens with the Close tab selected.

2. Select Employee/User List and click Launch. The Employee/User List screen opens.
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3. To limit the report to active employees/users, make sure the Show Active Only check box is
selected. For both active and inactive employees/users, clear the check box.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

GOVERNMENT SUPPORT INVOICES
This report provides detailed sales information for each government support invoice generated during
the selected date range.

To generate a Government Support Invoices Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Government Support Invoices and click Launch. The Date Range screen opens.



Close Tab Reports

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

GS & ADJUSTMENT CHECKUP REPORT
This report is no longer used.

HISTORICAL OPTION COST SALES
This report provides sales details for option cost items for a selected date range.

To generate a Historical Option Cost Sales Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Historical Option Cost Sales and click Launch. The Report Options screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Category
Group

5. To include invoice information on the report, make sure the Show all Details check box is
selected. For totals only, clear the check box.

6. ClickOK. The Report Window opens.

7. Print the report and close the Report Window.

HISTORICAL SALES
This report shows quantities sold, parts and labor prices, total price, FET, cost, and gross profit (GPM)
for each item sold and the total of all items sold during a selected date range. This report is useful for
month end closing procedures.

Note: The cost shown for inventoriable items depends on the item’s costing method. For more
information, see Inventoriable Costing Methods on page 374.

To generate a Historical Sales Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.



Close Tab Reports

2. Select Historical Sales and click Launch. The Report Option screen opens.

3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Category
Group

5. To include invoice information on the report, make sure the Show All Details check box is
selected. For totals only, clear the check box.

6. ClickOK. The Report Window opens.

7. Print the report and close the Report Window.
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HISTORICAL SALES BY ZIP CODE
This report is similar to the regular historical sales report, except that items are sorted by site and by
the customer’s zip code. For more information, see Historical Sales on page 1054.

To generate a Historical Sales by Zip Code Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Historical Sales by Zip Code and click Launch. The Report Options screen opens.

3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Category
Group

5. To include invoice information on the report, make sure the Show All Details check box is
selected. For totals only, clear the check box.

6. ClickOK. The Report Window opens.



Close Tab Reports

7. Print the report and close the Report Window.

INVOICE AVERAGES BY DATE
You can use this report to see if your invoice and gross profit averages increased as the result of
selling a particular item, such as a coupon discount, during a specified date range. You can include
information for all customers or a single customer on the report.

Note: Discounts are set up in the same manner as items in TireMaster. For more information, see
Set Up Discounts on page 365

To generate an Invoice Averages by Date Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Invoice Averages by Date and click Launch. The Invoice Averages by Date screen opens.

3. Select the starting and ending dates for the report’s date range.
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4. Click the Lookup button next to the Inventory Product Code field, and search for the item on
which you want to base the report. For more information, see Inventory Searches on page 230.

5. Define how much customer information you want to include on the report:

For all customers, leave the Customer and Vehicle fields blank.
For a single customer, click the Lookup button next to the Customer field and look up the
customer. To retrieve information about a specific vehicle owned by the customer, also click
the Lookup button next to the Vehicle field and select the vehicle. For more information, see
Customer Searches on page 93.

6. To include individual invoice totals, leave the Show Detail check box selected. For a summary of
the invoice averages, clear the check box.

7. Click Print. The Report Window opens.

8. Print the report and close the Report Window.

INVOICE DETAIL
This report shows the detail for each invoice by customer during the selected date range. It can be
generated any time or as a daily or weekly report.

To generate an Invoice Detail Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Invoice Detail and click Launch. The Date Range screen opens.



Close Tab Reports

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

MECHANIC FLAT RATE REPORT
This report lists the number of hours of work produced by a single mechanic or all of your mechanics.
The number of hours worked is displayed in the flat rate column. For more information, see Calculate
Mechanic Productivity on page 883.

To generate a Mechanic Flat Rate Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Mechanic Flat Rate Report and click Launch.
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3. Select the starting and ending dates for the report’s date range.

4. To generate the report for all employees, leave the Employee field blank. For a single employee,
click the Employee field, press , and select a name from the list that appears.

Tip: To limit the User List to mechanics only, select theMechanics check box at the top of the
screen.

5. Select one of the following methods for organizing items on the report:

Category
Group
Invoice

6. To print information for each mechanic on a separate page, make sure the Page Break check box
is selected. For one continuous document, clear the check box.

7. To include the time spent on each job, make sure the Show All Details check box is selected. For
subtotals only, clear the check box.

8. To exclude gross profit percentages, select the Suppress profit information check box. To
include the information, clear the check box.

9. ClickOK. The Report Window opens.



Close Tab Reports

10. Print the report and close the Report Window.

MECHANIC REPORT
This report lists sales totals, costs, and gross profit by mechanic. It can be generated at the end of the
month to help you determine commission amounts for mechanics.

To generate a Mechanic Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Mechanic Report and click Launch. The Report Options screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Category
Group

5. To include information about each item sold, make sure the Show All Details check box is
selected. For category or group subtotals, clear the check box.

6. Do one of the following in the Employee Range area:
For all mechanics, leave the From and To fields blank.
For a range of mechanics, select the employees for the beginning (From field) and end (To
field) of the range. To select an employee, click a field and press . Then choose a name from
the list that appears.

For a single mechanic, click the From field and press . Then choose a name from the list that
appears.

7. ClickOK. The Report Window opens.



Close Tab Reports

8. Print the report and close the Report Window.

NATIONAL ACCOUNT INVOICES
This report shows detailed sales information for each of your national account invoices for a selected
date range.

To generate a National Account Invoices Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select National Account Invoices and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.
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4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

NATIONAL ACCOUNT RECON. REPORT
This report lists national account, government support, and adjustment invoices for which vendors owe
you credits. When this report is generated from the Report List, it shows the totals for each
reconciliation code for a specified date range.

Note: This report can also be generated for a single vendor from the National Credits screen by
clicking Reconcile Report. In this scenario, you can limit the report to unreconciled items if
needed.

To generate a National Account Recon Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select National Account Recon. Report and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.



Close Tab Reports

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

NEGATIVE OPTION COST TOTALS
This report lists the option cost (outside purchase) items that were returned or traded in during the
selected date range. It shows the cost (including FET) that posted to the inventory and cost of goods
sold accounts.

To generate a Negative Option Cost Totals Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Negative Option Cost Totals and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.
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5. Print the report and close the Report Window.

NONINVENTORY SALES
This report shows the selling price, cost, gross profit amount, and gross profit percent of all
noninventoriable items that have been sold within the selected date range.

Note: The cost shown on this report (and your regular sales report) depends on the item’s costing
method.For more information, see Noninventoriable Costing Methods on page 375.

To generate a Noninventory Sales Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Noninventory Sales and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.



Close Tab Reports

5. Print the report and close the Report Window.

NULL SALESPERSON REPORT
This report helps users identify invoices that have no salespeople assigned to some of the items sold.

To generate a Null Salesperson Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Null Salesperson Report and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

OPEN QUOTE REPORT
This report lists quotes written during a selected date range. You can generate the report for all quotes,
only those that have expired, only those still in effect, or only those that have been turned into work
orders. You can also limit information retrieved by the report to a particular customer, salesperson, or
quotes whose total margin was negative.

1067



1068

User Guide

To generate an Open Quote Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Open Quote Report, and click Launch. The Open Quote Report screen opens.

3. Depending on which quotes you want to include, select All Quotes, Expired, Not Expired, or
Work Order.

4. Select the starting and ending dates for the date range in which the quotes were written.

5. Do one of the following:

For all quotes, leave the Customer and Salesperson fields blank.
For quotes for a single customer, click Customer and look up the customer. For more
information, see Customer Searches on page 93.

For quotes assigned to a single salesperson, click Salesperson and select the employee’s
name from the list that opens.

6. To display only those quotes whose total margin is negative, select theQuotes with negative
total margin only check box.

7. Click Print. The Report Window opens.



Close Tab Reports

8. To print the report, click Print. Then click Close.

OPEN WORK ORDER - ITEM LIST
This report lists all items that are currently on open work orders sorted by product code.

To generate an Open Work Order - Item List
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select OpenWork Order - Item List and click Launch. The Report Window opens.

3. Print the report and close the Report Window.
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OPEN WORK ORDER - QTY
This report lists all items that are currently on open work orders sorted by invoice.

To generate an Open Work Order - Qty Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select OpenWork Order - Qty and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

OPEN WORK ORDER DEPOSITS
This report shows deposits that have been collected from customers who have open work orders. The
deposit total for this report should match the balance of the clearing account for tracking point of sale
deposits.

To generate the Open Work Order Deposits Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.



Close Tab Reports

2. Select OpenWork Order Deposits and click Launch. The OpenWork Order Deposits screen
opens.

3. To include invoice and customer contact information on the report, select the Show Detail check
box. For customer deposit totals only, clear the Show Detail check box.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

OPEN WORK ORDER REPORT
This report lists all open work orders.

To generate an Open Work Order Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select OpenWork Order Report and click Launch. The Report Window opens.

3. To print the report, click Print. Then click Close.

OVER SHORT REPORT
This report lists over and short amounts for each date in the selected date range.

To generate an Over Short Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Over Short Report and click Launch. The Date Range screen opens.



Close Tab Reports

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

PAIDOUT LIST FOR DATE RANGE
This report lists paidouts and purchase orders that you paid cash for during the selected date range.

To generate a Paid List for Date Range Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Paidout List for Date Range and click Launch. The Date Range screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

POST ERROR REPORT
This report is one of two reports used by Support to resolve posting errors. You should generate this
report as part of the month end closing process and if you receive a message about posting errors
when logging in to TireMaster.

To generate a Post Error Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Post Error Report and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

PURCHASE ORDER REPORT
This report shows purchases by inventory category or group for the selected date range.

To generate a Purchase Order Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Purchase Order Report and click Launch. The Report Options screen opens.

3. Select the starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Group
Category

5. To include information for each item ordered, make sure the Show All Details check box is
selected. For totals only, clear the check box.

6. ClickOK. The Report Window opens.

7. Print the report and close the Report Window.
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SALES ANALYSIS REPORT
This report compares the sales totals of two different dates or date ranges and shows the percentage
of change between the two. It provides several different settings for retrieving information, and the first
page of the report shows which settings were chosen. Because your selections are saved until you exit
the report settings screen, you can go back and modify them after printing.

To generate a Sales Analysis Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Sales Analysis Report and click Launch. The Sales Analysis Report Options screen opens.

3. Select one of the following report types:

Store to generate storewide sales figures
Salesperson to generate sales figures by salesperson

4. Select one of the following methods for organizing items on the report:

Category
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Group
Neither

5. Select one of the following in the Sort By area:
Units to display items from the highest to the lowest number of units sold

Dollars to display items from the highest to lowest dollar amount sold

6. To include items sold on the report, make sure the Show Detail check box is selected. For totals
only, clear the check box.

7. Choose the following date ranges.

a. Select a date or date range from the Report Date Range pop-up calendars.
b. Select another date or date range from the Compare Date Range pop-up calendars.

8. Define whether to display the sales figures in report subgroups:

If you selected the store report type (step 3), select Salesperson or Customer. Then, look up
one salesperson, a range of salespeople, all salespeople, one customer, or all customers.
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Note: To look up the name of a salesperson or customer, click the Beginning Salesperson,
Ending Salesperson or Selected Customer field. Then press and select an
employee or customer from the list that opens. For all salespeople or customers, leave
the fields blank.

If you selected the salesperson report type (step 3), look up one salesperson, a range of
salespeople, or all salespeople. Then limit the report to one customer or include all customers.

If you don’t want to display the information subgroups, select Suppress
Salesperson/Customer Grouping.

9. Click Print. The Report Window opens.

10. Print the report and close the Report Window.

SALES COMPARISON REPORT
With the Sales Comparison Report, you can compare sales that occurred in up to four different date
ranges. These date ranges can be selected at random or they can be a series of weeks, months,
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quarters, or years. You can also generate the report for specific sites.

To generate a Sales Comparison Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Sales Comparison Report and click Launch. The Sales Comparison Report screen opens.

3. Select the date ranges you want to compare from the pop-up calendars. To compare three date
ranges, select the Include check box forOptional Date Range 1. For four date ranges, select the
Include check boxes for bothOptional Date Range 1 andOptional Date Range 2.

4. Choose which customers you want to include on the report by doing the following as needed:

For a single customer, click Customer Name and look up the customer. For more information,
see Customer Searches on page 93.
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For one or more customer types, click Customer Type. Then select one or more types from
the list that opens.

Note: For multiple types, press Ctrl while you select each type.

For customers assigned to a specific salesperson, click Salesperson and select a name from
the list that opens.

For all customers, leave the Customer Name, Customer Type, Salesperson, and Sites
fields blank.

5. Choose which items you want to include on the report by doing one of the following:

For a single item or a group of items, click Inventory and look up the item or items. For more
information, see Inventory Searches on page 230.

For all items, disregard looking up any inventory.

6. To organize items retrieved by the report, do the following.

a. Select the main method of grouping the items from the Primary Group drop-down.
b. Select an additional grouping method from the Secondary Group drop-down if needed.

Note: Disregard the Name, Sales, andGP options for each group.

7. Set the display options for the report.

a. To include item descriptions and vendor part numbers, leave the Show Description and
Show Detail check boxes selected. For item totals only, clear the check boxes.

b. Select a sorting method from the Sort Detail drop-down.
c. To display the sort detail from highest to lowest, select the Descending check box. Otherwise,

leave the check box clear.
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8. Click Print. The Report Window opens.

9. Print the report and close the Report Window.

10. Close the Sale Comparison Report screen.

SALES INFORMATION REPORT
With the Sales Information Report, you can identify which items were popular sellers during a specific
date range and which customers affect sales and profits the most. You can also use this report to
gauge mechanic productivity.

Example: You could generate this report to identify the following:
Which brand of tires is the most or least profitable

Which tire of a particular size is sold the most or least

Which customer spent the most or least money

Which customer type contributes the most or least to your gross profit

Which services (labor) are sold the most or least

Which services (labor) did a mechanic perform the most

Note: When none of the sales report options are selected on the Sales Report Options screen,
generating this report retrieves items sold in normal sales. When Adjustment Lines is
selected on the Sales Report Options screen, this report retrieves items sold at an adjusted
price along with items sold in normal sales. For more information, see Sales Report Options on
page 1183.

To generate a Sales Information Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Sales Information Report and click Launch. The Sales Information Report screen opens.

3. Select starting and ending dates from the Sales Date Range pop-up calendars.

4. Select the following check boxes as needed:

Active Employees Only to limit the report to active employees
Include Labor w/Sales to retrieve sales information for labor items
Include FETax w/Sales to retrieve federal excise tax assessed for items (Available in
TireMaster 9.4.0.)

Show Top 25 Only to limit information to the 25 most popular items
All Customer Types to retrieve information for all customer types (Available in TireMaster
9.4.0.)

All Sites to retrieve information for all sites (Available in TireMaster 9.4.0.)
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Note: The All Customer Types and All Sites checkboxes default to being selected. The
checkboxes clear when you click the Customer Type or Sites buttons and make
manual customer type or site selections. The option to select sites is present only in
multi-store environments. This functionality is available in TireMaster 9.4.0.

5. Define which customer or employee information to include on the report by doing one of the
following:

For all customers, leave the Customer Name, Customer Type, and Salesperson fields
blank.

For a single customer, click Customer Name and look up the customer. For more information,
see Customer Searches on page 93.

For one or more customer types, click Customer Type. Then select one or more types from
the list that opens.

Note: For multiple types, press Ctrl while you select each type.

For information about customers assigned to a specific salesperson, click Salesperson and
select a name from the list that opens.

For information from specific sites, click Sites. Then select one or more sites from the list that
opens (multi-store environments only).

For information about mechanic productivity, clickMechanic and select a name from the list
that opens.

6. Define which items you want to include on the report by doing one of the following:
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For a single item or a group of items, click Inventory and look up the item or items. For more
information, see Inventory Searches on page 230.

For all items, leave the Inventory field blank.
7. To organize the items retrieved by the report, do the following:

a. Define how to list the items by selecting Inventory or Customer.
b. Select the main method of grouping the items from the Primary Group drop-down.
c. Select an additional grouping method from the Secondary Group drop-down, if needed.

Note: If you selectMechanic from the list of secondary groups, the report displays the
names of both mechanics when the work on an invoice was performed by a pair of
employees.

8. To display both invoice detail and totals on the report, do the following.

a. Select the Show Detail check box.
b. To limit the report to noninventoriable items, select the Non-Inventory only check box.
c. Select a sorting method from the Sort Detail drop-down.
d. To display the sort detail from highest to lowest, select the Descending check box. Otherwise,

leave the check box clear.
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9. To limit report output to the site from which you're running the report, select the Local Site Only
checkbox (Data Exchange environments only).

10. Click Print. The Report Window opens.

11. Print the report and close the Report Window.

SALES TAX BY RATE
This report provides a summary of the following information for each sales-tax rate:

Taxable sales total

Nontaxable sales total

Tax collected

Labor sales total

Taxable sales and nontaxable sales total

Note: For detailed sales tax information, refer to Sales Tax Report on page 1087.

To generate a Sales Tax by Rate Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Sales Tax by Rate and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

SALES TAX LEDGER REPORT
With the Sales Tax Ledger Report, you can compare the total sales tax collected in individual
transactions to the balance of the general ledger’s sales tax account. This report also displays the GL
codes associated with the general ledger’s income accounts.

Note: To ensure that the amounts on this report aren’t distorted, make sure your GL Ranges do not
overlap.

To generate a Sales Tax Ledger Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Sales Tax Ledger Report and click Launch. The Sales Tax Ledger Report screen opens.

3. Select a fiscal year and period from the drop-downs.

4. To include invoice information on the report, make sure the Detail check box is selected. For
account totals only, clear the Detail check box.

5. Click Print. The Report Window opens.

6. Print the report and close the Report Window.

SALES TAX REPORT
This report lists sales tax information for each invoice generated during the selected date range.

To generate a Sales Tax Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Sales Tax Report and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

SALES TAX SETUP REPORT
This report shows how your sales tax rates are combined into the different sales tax levels.

To generate a Sales Tax Setup Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Sales Tax Setup Report and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

SALES TREND REPORT
This report lets you compare the monthly sales for two different years. You can display trend
information as numbers or as a bar graph, and group it by customer, salesperson, or manufacturer if
needed.

Note: This report does not include sales of add-on items or shop supply charges.

To generate a Sales Trend Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Sales Trend Report and click Launch. The Sales Trend Report Options screen opens.
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3. Select one of the following report types:

Store to generate a report of storewide sales trends
Salesperson to generate report of sales trends by salesperson

4. Select one of the following methods for organizing items on the report:

Category
Group
Neither

Note: When generating a bar graph, it is not necessary to select a means of grouping report
information.

5. Select one of the following in the Display area:
Units to display the number of units sold
Dollars to display the dollar amount generated
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6. Select one of the following in the Report area:
Detail to generate a report showing units sold or dollar amounts as numbers
Graph to generate a bar graph that represents units sold or dollar amounts

7. If you want to group trend information by customer, salesperson, or manufacturer, select
Customer, Salesperson, orManufacturer in the Selection area. Otherwise, go to step 9.

8. Depending on your selection in step 7, look up one of the following:

For a single customer, manufacturer, or salesperson, click the Selected Customer field,
Beginning Salesperson field, or Beginning Manufacturer field and press . TireMaster
prompts you to type a customer’s name or select a salesperson or manufacturer from a list.

For a range of customers or manufacturers, click the Beginning Salesperson field or
Beginning Manufacturer field, press , and select a salesperson or manufacturer from the
list that opens. Repeat this process for the Ending Salesperson or Ending Manufacturer
fields.

For all customers, salespeople, or manufacturers, leave the fields blank.

9. Type the two years you want to compare in the Report Year and Compare Year fields.
10. If you want to disable the grouping of trend information by customer, salesperson, or

manufacturer, select the Suppress Salesperson, Customer, MFG Grouping check box.
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11. Click Print. The Report Window opens.

12. Print the report and close the Report Window.

SALESPERSON REPORT
This report lists sales totals by salesperson for the selected date range.

To generate a salesperson report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Salesperson Report and click Launch. The Report Options screen opens.

3. Select starting and ending dates for the report’s date range.

4. Select one of the following methods for organizing items on the report:

Category
Group
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5. To include information about each item sold, make sure the Show All Details check box is
selected. For category or group subtotals, clear the check box.

6. Do one of the following in the Employee Range area:
For all users, leave the From and To fields blank.
For a range of users, select the employees for the beginning (From field) and end (To field) of
the range. To select an employee, click a field and press . Then choose a name from the list
that opens.

For a single user, click the From field and press . Then choose a name from the list that
opens.

7. ClickOK. The Report Window opens.

8. Click Print. Then close the Report Window.

SENT EMAIL/TEXT LIST
This report lists all customers and vendors who’ve been sent text messages or documents by email
from TireMaster during the selected date range.

For emails, the report lists the email address and the type of document sent to it. If the same
document is listed multiple times, it was emailed more than once or both the original document
and one or more duplicate copies were sent.

For text messages, the report lists a the type of text message that was sent. If the same type of
text message is listed multiple times, it was sent more than once.

To generate a Sent Email/Text List
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Sent Email List and click Launch. The Sent Email Report List screen opens.

3. Select a date or date range for the report, and click Print. The Report Window opens.

4. Print the report and close the Report Window.

SERVICE CHECKLIST SETUP REPORT
This report provides a detailed listing of the inspection area settings for each of your service checklists.
For each inspection area, the report includes a description of what to check and a list of items that can
be sold to customers when services are recommended. The report also identifies which postcard code,
if any, is assigned to an inspection area and whether services are recommended based on vehicle
mileage.

To generate a Service Checklist Setup Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.
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2. Select Service Checklist Setup Report and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

SITE SETUP REPORT
This report lists all of your sites and includes information such as site number, dealer number, Bar ID
number, and EPA number.

To generate the Site Setup Report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Site Setup Report and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

SPIFF SALESPERSON REPORT
This report shows the sales spiff information for each salesperson during the specified date range. For
each spiff item that’s sold, this report shows the quantity sold, the parts total, and the resulting spiff
amount. It also shows the spiff percentage and spiff amount to remind you of the settings for a
particular spiff.

Note: Generate the spiff report before updating the spiffs or the items to which they’re assigned, so
you can keep track of the changes.

To generate a spiff salesperson report
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Spiff Salesperson Report and click Launch. The Date Range screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

TRANSFER INVOICES
This report shows detailed sales information for each of your transfer invoices.

To generate a report of transfer invoices
1. Select Closing > Reports. The Report List opens with the Close tab selected.

2. Select Transfer Invoices and click Launch. The Date Range screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

CUSTOMER TAB REPORTS
This tab includes reports for generating customer information, such as purchase history and account
balances.

AR DETAIL - BY CUSTOMER
This report shows accounts receivable activity for one or more customers.

Note: When you select a customer range, this report lists all customers alphabetically that fall
between the first and last names you select.

To generate the AR Detail - By Customer Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.
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2. Select AR Detail - By Customer and click Launch. The Customer Range screen opens.

3. Select one or more customers:

For one customer, click 1 Lookup and look up the customer’s name. For more information, see
Customer Searches on page 93.

For a range of customers, click 1 Lookup and look up the customer for the beginning of the
range. Then click 2 Lookup and look up the customer for the end of the range.
For all customers, leave the Beginning Customer and Ending Customer fields blank.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.
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CHECK HISTORY REPORT
This report is designed to help you research which checks or direct deposits were used to pay for
which invoices. The report includes any checks and direct deposits that were received from the
customer at either the time of the sale or received later on account. If a check number was not entered
at the time of payment, that check is excluded from the report.

To generate a Check History Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Check History Report and click Launch. The Check History Report Options screen opens.

3. Select one of the following:

To look up checks written during on a specific day or during a date range, click the Date tab.
To look up a specific check number or invoice number, click the Number tab. Then go to step
6.
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4. Select the starting and ending dates for the report’s date range.

5. Select one of the following in theGroup By area. Then go to step 7
Check Number to sort checks by the check number that was entered at point of sale
Invoice Number to sort checks by invoice number

6. Type the check number or the invoice number.

7. Click Print. The Report Window opens.

8. Print the report and close the Report Window.
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CUSTOMER BALANCE BY CURRENT DATE
This report lists customers with balances as of the current date. It includes future, current, 30 day, 60
day, and 90 day balances.

To generate a Customer Balance Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Balance by Current Date and click Launch. The Customer Balance Reports
screen opens.

3. Select one or more customers:

For all customers, leave the Beginning Customer and Ending Customer fields blank.
For one customer, click Beginning Customer and look up the customer’s name. For more
information, see Customer Searches on page 93.

For a range of customers, click Beginning Customer and Ending Customer to look up the
first and last customers in the range.

To retrieve information for specific customer types only, click Customer Types. Then select
one or more types from the list.

Note: Information for all types is included on the report by default.
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To retrieve information for specific sites only, click Sites. Then select one or more sites from
the list.

Note: Information for all sites is included on the report by default.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

6. Close the Customer Balance Reports screen.

CUSTOMER BALANCE FOR PREVIOUS PERIOD
This report provides balance information for a single customer, a group of customers, or all customers
for a previous fiscal period.

New fiscal period data for this report is available once the period ends. If your computer is running at
10:30 PM on the last day of the period (typically the end of the month), the report data is compiled at
that time. If your computer is not running then, the compilation occurs the next time the computer is
turned on.

Note: This report and the corresponding data compilation were introduced in TireMaster 9.2.0.
Therefore, fiscal period data for the report is available as of the end of the first period that
occurred after TireMaster 9.2.0 was installed.

The data compiled for this report represents a moment in time. Therefore, it will not include backdated
entries posted after the compilation.

Example: An entry created in Period 5 and backdated to Period 4 would be excluded.

To generate a Customer Balance for Previous Period Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.
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2. Select Customer Balance for Previous Period and click Launch. The Customer Balance History
screen opens.

3. Select one or more customers:

For a specific customer, click Customer and look up the customer’s name. For more
information, see Customer Searches on page 93.

For all customers, leave the Customer field blank.
For information for specific customer types only, click Customer Types. Then select one or
more types from the list that appears.

Note: Information for all types is included on the report by default.

4. Select the fiscal year and period from the drop-downs.

5. Click Print. The Report Window opens.
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6. Print the report and close the Report Window.

CUSTOMER BALANCE REPORT
This report lists customers with balances as of the last statement cutoff. It includes future, current, 30
day, 60 day, and 90 day balances.

To generate a Customer Balance Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Balance Report and click Launch. The Customer Balance Reports screen
opens.

3. Select one or more customers:
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For all customers, leave the Beginning Customer and Ending Customer fields blank.
For one customer, click Beginning Customer and look up the customer’s name. For more
information, see Customer Searches on page 93.

For a range of customers, click Beginning Customer and Ending Customer to look up the
first and last customers in the range.

To retrieve information for specific customer types only, click Customer Types. Then select
one or more types from the list.

Note: Information for all types is included on the report by default.

To retrieve information for specific sites only, click Sites. Then select one or more sites from
the list.

Note: Information for all sites is included on the report by default.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

6. Close the Customer Balance Reports screen.

CUSTOMER CATEGORY LIST
This report lists all the customer types as well as their settings.

To generate a Customer Category List
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Category List and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

CUSTOMER CONTACT LIST
This report lists the addresses, phone numbers, and email addresses for all customers or one or more
customer types. Information generated with this report can be printed or exported to a spreadsheet.

To generate a Customer Contact List
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Contact List and click Launch. The Customer Contact List screen opens.
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3. Define which customers you want to include:

For all customers, leave the entries in the Customer Types field alone.
For specific customer types, click Customer Types. Then select one or more types from the
list that appears, and clickOK. For multiple types, press the Ctrl key while you make your
selections.

4. To generate the report, do one of the following:

For a printed copy, click Print. When the Report Window opens, click Print again. When you’re
done printing the report, close the Customer Contact List screen.

For a spreadsheet, click Export. Then clickOK to close the message. The spreadsheet is
saved in the Apps folder inside your TireMaster program directory.

CUSTOMER CREDIT REPORT
This report shows the credit limit, remaining credit available, and aged balances for one or more
customers. You can generate the report for the following:

One customer

Customers who are all assigned the same customer type

Customers who are assigned two or more different customer types
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To generate a Customer Credit Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Credit Report and click Launch. The Customer Credit Report screen opens.

3. Select one or more customers:

For one customer, click 1 Lookup. Then look up the name of the customer. For more
information, see Customer Searches on page 93.

For customers who are all assigned the same type, click 2 Lookup. Then select a type from
the list.

For customers who are assigned two or more different types, click 2 Lookup. Then press Ctrl
and select each type that you want to include on the report.

4. To include invoices that haven’t been paid, select theOpen Invoice Detail check box. Otherwise,
leave the check box clear.

5. Click Print. The Report Window opens.
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6. Print the report and close the Report Window.

CUSTOMER GPM REPORT
This report shows the sales total and gross profit for each item sold to each customer during a selected
date range.

To generate a Customer GPM Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer GPM Report and click Launch. The Customer GPM Report Options screen
opens.

3. Select one or more customers:
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For one customer, click the Beginning Customer field, press , and look up the customer.
Then look up the same customer by repeating this process in the Ending Customer field. For
more information, see Customer Searches on page 93.

For a range of customers, click the Beginning Customer field, press , and look up the first
customer in range. Then click the Ending Customer field and look up the customer for the end
of the range.

For all customers, leave the Beginning Customer and Ending Customer fields as is.
4. Select the starting and ending dates for the report’s date range.

5. Select one of the following methods for organizing items on the report:

Inventory Group
Inventory Category
Customer Type

6. To include invoice information, make sure the Show All Details check box is selected. For totals
only, clear the Show All Details check box.

7. Click Print. The Report Window opens.

8. Print the report and close the Report Window.

CUSTOMER HISTORY REPORT
With this report, you can generate the following:

For one customer, the running balance and a list of all transactions that occurred during a date
range

For all customers, running balances and a list of all transactions that have occurred since you
started using TireMaster
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In addition to generating detailed history, you can also print a summary that shows only the balance
and sale and payment totals for one or all customers.

To generate a Customer History Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer History Report and click Launch. The Customer History Report screen opens.

3. Select one or more customers:

For one customer, click the Customer field and press [accent]. Then look up the customer’s
name. For more information, see Customer Searches on page 93.

For all customers, leave the Customer field blank and make sure the All Customers check
box is selected.

4. To include individual invoice totals, make sure the Show Details check box is selected. To display
only balances and sale and payment totals, clear the Show Details check box.
Note: The report’s Cash/Credit column includes cash, check, and credit card amounts.

5. If you’re generating the report for one customer, select a date range.

6. To sort transactions by reference number, select the check box. Otherwise, leave it alone.

7. Click Print. The Report Window opens.



Customer Tab Reports

8. To print the report, click Print. Then click Close.

CUSTOMER LIST BY TYPE
This report lists the customer types in TireMaster and the customers who are assigned to each of
those types.

To generate a customer list by customer type
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer List by Type and click Launch. The Customer Range screen opens.

3. Select one or more customers:
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For one customer, click 1 Lookup and look up the customer’s name. For more information, see
Customer Searches on page 93.

For a range of customers, click 1 Lookup and look up the customer for the beginning of the
range. Then click 2 Lookup and look up the customer for the end of the range.
For all customers, leave the Beginning Customer and Ending Customer fields blank.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

CUSTOMER MASTER LIST
With this report, you can generate the following:

A list of all active customers

A list of customers assigned one or more customer types

A list of customers assigned to a specific salesperson

A list of customers assigned one or more customer types and a specific salesperson.

To generate a Customer Master List
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Master List and click Launch. The Report Window opens.



Customer Tab Reports

3. To limit the report to specific customer types, do the following.

a. Click Customer Types. The Customer/Vendor Type List opens.
b. Select one or more types from the list. For multiple types, press the Ctrl key and select each

type that you want to include on the report.

c. ClickOK.
4. To limit the report to customers who are assigned to a specific salesperson, do the following.

a. Click Salesperson. The User List opens.
b. Select the salesperson’s name from the list and clickOK.

5. Click Print. The Report Window opens.

6. Print the report and close the Report Window.

CUSTOMER OVERDUE BALANCE REPORT
This report lists customers with past due balances as of the last statement and shows their aging
balances.

To generate a Customer Overdue Balance Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.
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2. Select Customer Overdue Balance Report and click Launch. The Customer Balance Reports
screen opens.

3. Select one or more customers:

For all customers, leave the Beginning Customer and Ending Customer fields blank.
For one customer, click Beginning Customer and look up the customer’s name. For more
information, see Customer Searches on page 93.

For a range of customers, click Beginning Customer and Ending Customer to look up the
first and last customers in the range.

To retrieve information for specific customer types only, click Customer Types. Then select
one or more types from the list.

Note: Information for all types is included on the report by default.

To retrieve information for specific sites only, click Sites. Then select one or more sites from
the list.

Note: Information for all sites is included on the report by default.

4. Click Print. The Report Window opens.
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5. Print the report and close the Report Window.

6. Close the Customer Balance Reports screen.

CUSTOMER OVERDUE BY CURRENT DATE
This report lists customers grouped by site and customer type with past due balances as of the current
date.

To generate a Customer Overdue Balance by Current Date Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Overdue by Current Date and click Launch. The Customer Balance Reports
screen opens.
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3. Select one or more customers:

For all customers, leave the Beginning Customer and Ending Customer fields blank.
For one customer, click Beginning Customer and look up the customer’s name. For more
information, see Customer Searches on page 93.

For a range of customers, click Beginning Customer and Ending Customer to look up the
first and last customers in the range.

To retrieve information for specific customer types only, click Customer Types. Then select
one or more types from the list.

Note: Information for all types is included on the report by default.

To retrieve information for specific sites only, click Sites. Then select one or more sites from
the list.

Note: Information for all sites is included on the report by default.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

6. Close the Customer Balance Reports screen.
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CUSTOMER PRICE LIST
This report helps you identify which items are associated with the price level discount for a price level
that’s assigned to a customer.

To generate a Customer Price List
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Price List and click Launch. The Price List Report screen opens.

3. Select one or all customers:

For one customer, click Lookup. Then look up the customer whose price level information you
want to view. For more information, see Customer Searches on page 93.

For all customers, leave the Customer field blank.
4. Select one of the following methods for organizing items on the report:

None
Inventory Category
Manufacturer

5. To include price level codes and descriptions, make sure the Detail check box is selected. To
show items and their prices only, clear the check box.
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6. Click Print. The Custom Inventory Lookup screen opens.

7. Look up the items that you want to include on the report. The Report Window opens. For more
information, see Inventory Searches on page 230.

8. Print the report and close the Report Window.

9. Close the Price List Report screen.

CUSTOMER RECON CODES REPORT
This report lists each of the national account and government support settings assigned to your
customers. This listing includes the reconciliation code, the customer’s vendor-assigned account
number, and your dealer ID number. The report also identifies whether prices and the term “delivery
receipt” are to be printed on invoices for each reconciliation code.

To generate a Customer Recon Codes Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Customer Recon Codes Report and click Launch. The Customer Range screen opens.
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3. Select one or more customers:

For one customer, click 1 Lookup and look up the customer’s name. For more information, see
Customer Searches on page 93.

For a range of customers, click 1 Lookup and look up the customer for the beginning of the
range. Then click 2 Lookup and look up the customer for the end of the range.
For all customers, leave the Beginning Customer and Ending Customer fields blank.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

CUSTOMER SALES REPORT
This report compares the sales totals of two different dates or date ranges and shows the percentage
of change between the two. It provides several different settings for retrieving information, and the first
page of the report shows which settings where chosen. Because your selections are saved until you
exit the report settings screen, you can go back and modify them after printing.

To generate a Customer Sales Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.
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2. Select Customer Sales Report and click Launch. The Customer Sales Report Options screen
opens.

3. Select one of the following report types:

Store to generate storewide sales figures
Salesperson to generate sales figures by salesperson

4. Select one of the following methods for organizing items on the report:

Category
Group
Neither
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5. Select one of the following in the Sort By area:
Units to display items from the highest to the lowest number of units sold

Dollars to display items from the highest to lowest dollar amount sold

6. To include items sold on the report, make sure the Show Detail check box is selected. For totals
only, clear the check box.

7. Select dates for which you want to compare sales totals.

a. Select the date or date range for current sales from the Report Date Range pop-up calendars.
b. Select the date or date range that you want to compare your current sales to from the

Compare Date Range pop-up calendars.

8. Define whether you want to display sales figures in report subgroups:

If you selected the store report type (step 3), select Salesperson or Customer. Then, look up
one salesperson, a range of salespeople, one customer, or all customers.

Note: To look up the name of a salesperson or customer, click the Beginning Salesperson,
Ending Salesperson or Selected Customer field. Then press and select an
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employee from the list that opens or look up a customer when prompted. For all
salespeople or customers, leave the fields blank.

If you selected the salesperson report type (step 3), look up one salesperson, a range of
salespeople, or all salespeople. Then limit the report to one customer or include all customers.

If you don’t want to display the information in subgroups, select Suppress
Salesperson/Customer Grouping.

9. Click Print. The Report Window opens.

10. Print the report and close the Report Window.

REAL TIME STATEMENTS
When you generate customer statements, you can produce them for all customers or limit the
statement run to those who meet specific requirements. Then you can send statement emails and print
the hard copies. Statements can be generated with corporate-wide balances or balances for an
individual site.

Various factors can affect the balances of statements that are printed for a site. For
example, if an ROA is entered at the corporate site and it is not applied toward the cus-
tomer’s balance, the ROA will not be included on the statement printed for a site.

Note: You can also print real time statements for individual customers from the Ledger/History tab
of the Customer Maintenance screen. To generate a real time statement, click Print. Then
select Print real-time statement and clickOK.

To generate real time statements
1. Open the statements screen using one of the following methods:

Select Closing > Statements > Print.
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Click Reports to open the Report List. Click the Customer tab, select Real-time Statements,
and click Launch.

2. To define whether all customers, a group of customers, or individual customers will receive
statements, do one of the following:

For all customers, leave all of the fields blank.

For one customer, click Beginning Customer and look up the customer for whom you want to
generate a statement.

For a range of customers, click Beginning Customer and search for the first customer in the
range. Then click Ending Customer and search for the last customer in the range.
For specific customer types, click Customer Types. Then select one or more types from the
list that appears and clickOK.
Note: For multiple types, press the Ctrl key while making your selections.

For transactional activity from specific sites, click Sites and select one or more sites from the
list that appears. Then select Customer Sites to print statements for customers added at the
selected site(s), or select Invoice Sites to print statements for customers for with invoices
completed at the selected site(s).

Note: For multiple sites, press the Ctrl key while making your selections.
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3. Click Load List. TireMaster adds the names and account balances for the customers who will
receive statements to the screen.

The colors, codes, and dates in the Email and Print columns indicate the following:
The color green means a statement can be generated for a customer

The color red means a statement has been printed or emailed to a customer

The code Nonemeans the delivery method is not used for a customer

The date is the date when a statement was last emailed or printed.

Note: The Email field is blank for new customers who have not yet been emailed statements.
It is also blank prior to the first-ever statement run, after updating to TireMaster 9.3.0.

4. If you want to narrow down the number of customers displayed, do one of the following. By default,
all customers with balances are displayed regardless of whether they receive statements.

Note: If you generate statements for customers with zero balances, they’re also listed. For more
information, see Define Statement Print Options on page 722.

For only the customers with balances who receive statements by email, select Email.
For only the customers with balances who receive printed statements, select Print.
For customers with balances who receive statements, select Email or Print.
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5. Generate the statements.

a. Click EMail. TireMaster emails statements to customers assigned the email delivery method.
Note: Distributing statements by email can last several minutes to several hours, depending

on the number of customers receiving statements by email. The PDFs of statements
and duplicate invoices that are emailed to customers are available in theOut folder in
your TireMaster program directory.

b. Click Print. Statements for customers assigned the print delivery method are sent to the
printer.

Once a customer’s statement is printed or emailed, the Print field, Email field, or both turn red
(depending on the customer’s delivery method) and the statement-generation date appears.

6. If you experience an issue such as a printer jam or an email failure, resend the affected statements
as needed. Otherwise, disregard this step. For more information, see Customer Tab Reports on
page 1098.

7. Close the statements screen.

UNAPPLIED CREDIT REPORT
This report lists all customers who have unapplied credits (ROAs, sales tax adjustments, easy checks,
or other). For each unapplied credit, the report shows the document type and number, the original
credit amount, the applied amount, and the unapplied amount. You should generate this report before
printing statements.

To generate an Unapplied Credit Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.
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2. Select Unapplied Credit Report and click Launch. The Customer Range screen opens.

3. Select one or more customers:

For one customer, click 1 Lookup and look up the customer’s name. For more information, see
Customer Searches on page 93.

For a range of customers, click 1 Lookup and look up the customer for the beginning of the
range. Then click 2 Lookup and look up the customer for the end of the range.
For all customers, leave the Beginning Customer and Ending Customer fields blank.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.
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UNAPPLIED OPEN ITEM REPORT
This report displays the open items in accounts receivable subledgers for the selected customers.
These items include ROAs, finance charges, discounts, and other items that haven’t been fully
applied. This report shows the original amount, the applied amount, and the unapplied amount.

To generate an Unapplied Open Item Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Unapplied Open Item Report and click Launch. The Customer Range screen opens.

3. Select one or more customers:

For one customer, click 1 Lookup and look up the customer’s name. For more information, see
Customer Searches on page 93.

For a range of customers, click 1 Lookup and look up the customer for the beginning of the
range. Then click 2 Lookup and look up the customer for the end of the range.
For all customers, leave the Beginning Customer and Ending Customer fields blank.

4. ClickOK. The Report Window opens.
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5. Print the report and close the Report Window.

UNPAID FINANCE CHARGE REPORT
This report lists the names of customers who have outstanding finance charges. It displays the original
amount for each outstanding charge, the amount paid on the charge, and the remaining amount due.
In addition to those numbers, the report also includes aging information for the outstanding charges.

To generate an Unpaid Finance Charge Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Unpaid Finance Charge Report and click Launch. The Customer Range screen opens.

3. Select one or more customers:

For one customer, click 1 Lookup and look up the customer’s name. For more information, see
Customer Searches on page 93.
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For a range of customers, click 1 Lookup and look up the customer for the beginning of the
range. Then click 2 Lookup and look up the customer for the end of the range.
For all customers, leave the Beginning Customer and Ending Customer fields blank.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

VEHICLE
This report lists vehicle information for all customers, active customers, or a selected customer. For
each vehicle, the report includes the year, make, model, mileage, license plate number, VIN, and the
date of the last service.

To generate a Vehicle Report
1. Select Customers > Reports. The Report List opens with the Customer tab selected.

2. Select Vehicle and click Launch. The Vehicle Master List screen opens.
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3. Select the vehicles for one or more customers:

For a list of all vehicles, leave the Customer field blank.
For a list of vehicles belonging to a particular customer, click Customer. Then look up the
customer’s name. For more information, see Customer Searches on page 93.

4. To exclude inactive vehicles from the report, make sure the Active Only check box is selected. For
all vehicles, clear the check box.

5. Click Print. The Report Window opens.

6. Print the report and close the Report Window.

VEHICLE EXPENSE REPORT
The Vehicle Expense Report displays the vehicle history for one customer, active customers, or all
customers for the specified date range. It can be printed from either the Report List or the Vehicle tab
on the Customer Maintenance screen.

To generate a Vehicle Expense Report
1. Do one of the following to launch the report:

Select Reports from the Customersmenu. Then select Vehicle Expense Report and click
Launch.
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On the Customer Maintenance screen, click the Vehicle tab. Then select a vehicle and click
Expense.

The Vehicle Expense Report Options screen opens.

2. Select the starting and ending dates for the report’s date range.

3. Define whether to generate a report for one customer or all customers. If you’re generating this
report from Customer Maintenance, disregard this step.

For one customer, click Customer and look up the customer. For more information, see
Customer Searches on page 93.

Note: The customer’s name is already entered when printing the report from the Customer
Maintenance screen.

For all customers, leave the Customer field blank.
4. Define whether to generate a report for one vehicle or all vehicles:

For one vehicle, click Vehicle and select a vehicle from the list that opens.

1133



1134

User Guide

Note: The vehicle is already entered when printing the report from the Customer
Maintenance screen.

For all vehicles, leave the Vehicle field blank.
5. Select one of the following methods for organizing items on the report:

Category
Group
Invoice

6. To exclude inactive vehicles from the report, select the Active Only check box.
7. To include invoice information, make sure Show Detail is selected. To only display totals, clear the

check box.

8. Click Print. The Report Window opens and displays the report.

9. Print the report and close the Report Window.

GL TAB REPORTS
This tab displays all reports that relate to the general ledger and accounting in TireMaster.

AR OR AP AGING
This report lets you see aged customer or vendor balances as of the end of a specific fiscal period.

To generate an AR or AP Aging Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.
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2. Select AR or AP Aging and click Launch. The AR or AP Aging Report screen opens.

3. Select one of the following:

Accounts Receivable for a list of customer balances
Accounts Payable for a list of vendor balances

4. Type the fiscal year, number, and period for which you’re generating the report.

Note: Unless you’ve changed your fiscal calendar, the fiscal number should always be 1.

5. To include individual customer or vendor balances, make sure the Show Detail check box is
selected. For totals only, clear the check box.

6. Click Print. The Report Window opens.
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7. Print the report and close the Report Window.

AR OR AP PAYMENTS
This report displays information about payments from customers or payments to vendors. For vendors,
the report also lists each of the items that were applied when processing a check with the AP
Payments screen or when updating the vendor’s ledger with the Payment Editing screen.

To generate an AR or AP Payments Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select AR or AP Payments and click Launch. The AR or AP Payments screen opens.
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3. Select one of the following:

Accounts Receivable for a list of payments from customers

Accounts Payable for a list of payments to vendors or a list of applied items
4. Select one or more customers or vendors:

For payments from a specific customer or vendor, click Lookup. Then look up the customer or
vendor. For more information, see Customer Searches on page 93 or Vendor Searches on
page 193.

For payments from all customers or vendors, leave the Customer or Vendor field blank.
5. Click Lookup, and select the site or sites whose information you want to retrieve.

Note: For multiple sites, press Ctrl and select each site whose information you want to include on
the report. For all sites, select the check box.

6. To limit the information retrieved by the report, do one of the following:

For all payments, select None.
For payments that a specific check number was used for, select Check # and type the check
number.

Note: For accounts payable, a vendor’s name needs to be selected to look up payments by
check number.

For a specific invoice that an ROA has been applied to, select Invoice #. Then type the invoice
number. (AR report only.)

For a specific group of applied items from the vendor’s payment ledger, select Apply Group.
Then type the apply group number. (AP report only.)

Tip: If you don’t know the apply group number, look in the ROA Unapply screen. The ROA
Unapply screen can be accessed by clicking Unapply on the Payment Editing screen.
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For payments that occurred during a specific date range, select Date Range. Then select the
beginning and ending dates from the drop-downs. (AR report only.)

7. To define how to organize information on the report, select Check # or Invoice # from theGroup
By drop-down. (AR report only.)

Note: TheGroup By drop-down is active only when None or Date Range is selected.

8. To include document numbers on the report, make sure the Show Detail check box is selected. To
exclude document numbers, clear the check box.

9. Click Print. The Report Window opens.

10. Print the report. Then close the Report Window.

BALANCE SHEET
This report shows the financial position of your company on a given date, including the totals in your
asset, liability, and equity accounts.

To generate a Balance Sheet
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.
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2. Select Balance Sheet and click Launch. The Report Options screen opens.

3. Type the fiscal year, number, and period for the balance sheet.

Note: Unless you’ve changed your fiscal calendar, the fiscal number should always be 1.

4. To exclude a site from the balance sheet, double-click the row for it. All sites are included by
default.

5. Do one of the following:

To specify which information is displayed on the report, select one or more of the report option
check boxes.

To print the report using a memorized setting, clickOpen. When the Memorized Selections
screen opens, click the appropriate setting and click Select. For more information, see
Financial Statement Settings on page 1179.

Note: To restore the original settings that came with the report, click Reset.

6. Click Print. The Report Window opens.
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7. Print the balance sheet and close the Report Window.

8. Close the Report Options screen.

BALANCE SHEET - MTD
Like the regular balance sheet, this report shows the financial position of your company on a given
date. Along with that information, it also includes month-to-date totals for your asset, liability, and
equity accounts for the selected fiscal period.

To generate a Balance Sheet with month-to-date totals
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select Balance Sheet - MTD and click Launch. The Report Options screen opens.
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3. Type the fiscal year, number, and period for the balance sheet.

Note: Unless you’ve changed your fiscal calendar, the fiscal number should always be 1.

4. To remove a site from the balance sheet, double-click its row. All sites are selected by default.

5. Select one or more of the report option check boxes.

6. Click Print. The Report Options screen opens.

7. Print the report and close the Report Window.

8. Close the Report Options screen.

CHART OF ACCOUNT LISTING
This report lists the major and minor accounts in your chart of accounts.
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To generate a Chart of Accounts Listing
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select Chart of Accounts Listing and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

CHECK RECONCILIATION REPORT
The Check Reconciliation Report lists the checks, deposits, fees, and withdrawals reconciled during a
user-defined date range.

To generate a Check Reconciliation Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.
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2. Select Check Reconciliation Report and click Launch. The Check Reconciliation Report screen
opens.

3. Define whether the report is for all bank accounts or a single account by making a selection from
the Checking Account drop-down.

4. Define the date range. For a single day, enter the same date for both the beginning and end of the
range.

5. Click Print. The Report Window opens.
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6. Print the report and close the Report Window.

7. Close the Check Reconciliation Report screen.

CHECK REGISTER REPORT
This report retrieves information from one or more checking accounts. You can generate the report
based on the transaction type, check range, date range, customer range, description text, and status
of your checkbook entries. For more information, see Generate AP Payments on page 753 and
Manage Bank Activity on page 767.

To generate a Check Register Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select Check Register Report and click Launch. The Check Register Report Options screen
opens.
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3. Select the type of transaction whose information you want to retrieve:

Check for checks drawn on the selected account or accounts
Deposit for deposits made into the selected account or accounts
Fee for fees assessed against the selected account or accounts
Withdraw for withdrawals from the selected account or accounts

All for all transactions affecting the selected account or accounts
Note: The transaction types listed on this screen correspond to the transaction types on the

Check Reconciliation Add screen.

4. For checks in a specific range, type the beginning and ending check numbers.

5. If you want to retrieve transactions by date, do one of the following:

For all transactions that occurred on a particular day, click Use Date and type the date.
For all transactions that occurred in a date range, click Use Date Range and type the
beginning and ending dates.

6. If you want to retrieve transactions for one or more payees do the following:

For one payee, click next to the Begin field and select a name from the list that opens.
TireMaster displays the payee’s name in both the Begin and End fields.

For a range of payees, click next to the Begin field and select a name from the list that
opens. Then repeat this process for the End field.

7. If you want to retrieve transactions based on their description on the Check Reconciliation screen,
type the text in the Description field.

8. In theMarked as area, select one of the following transaction states:
Voided for all voided transactions
Reconciled for all reconciled transactions
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Cleared for all transactions that have been cleared
Unmarked for all transactions that are unmarked
All Lists all transactions regardless of their status.

9. Select the account or accounts whose information you want to retrieve.

Note: For multiple accounts, press Ctrl and select each account you want to include on the
report.

10. Click Print. The Report Window opens.

11. Print the report and close the Report Window.

12. Close the Check Register Report Options screen.

GL INACTIVE ACCOUNT DETAIL
This report shows transactions that automatically posted to inactive general ledger accounts. This type
of posting occurs when general ledger accounts that are set to inactive are still used in setup screens
or as settings in System Controls. The report includes information such as the fiscal period, the
account number, and the debit or credit amount to use to make an adjusting entry.
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To generate a GL Inactive Account Detail Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select GL Inactive Account Detail and click Launch. The Date Range screen opens.

3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

GL SUMMARY
This report shows the following information for each general ledger account during the selected period:
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Beginning balance

Total debits

Total credits

Ending balance

To generate a GL Summary
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select GL Summary and click Launch. The Report Options screen opens.

3. Select the fiscal year, period, and number that you want a summary for from the drop-downs.

4. Click Print. The Report Window opens.
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5. Print the report and close the Report Window.

6. Close the Report Options screen.

GL TEMP REPORT
If you receive a posting error message when you log in to TireMaster, email a copy of the GL Temp
Report to TireMaster Support. Also log a support call, so Support will be looking for your email. Posting
errors need to be resolved before closing the month.

To generate a GL Temp Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select GL Temp Report and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

GL TRANSACTION DETAILS
This report provides detailed information for each transaction in the selected date range, including the
GL transaction number, invoice number, fiscal period, debits, credits, and description of each journal
entry line. This information is grouped by the GL transaction number.

To generate a GL Transaction Details Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select GL Transaction Details and click Launch. The Date Range screen opens.
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3. Select the starting and ending dates for the report’s date range.

4. ClickOK. The Report Window opens.

5. Print the report and close the Report Window.

INCOME STATEMENT
This report is one of your two main financial statements. The income statement shows the financial
progress of your company in detail. It is also called a profit and loss (P&L) statement.

Note: The percentage of gross profit in the expense section of this document is based on the total of
all expenses. To see the percentage of gross profit based on the total gross profit (or loss),
generate the Income Statement Summary.

To generate an income statement
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.
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2. Select Income Statement and click Launch. The Report Options screen opens.

3. Type the fiscal year, number, and period whose information you want to retrieve.

Note: Unless you’ve changed your fiscal calendar, the fiscal number should always be 1.

4. To remove a site, department, or GL class from the income statement, double-click it. By default,
all sites, departments, and GL classes are selected.

5. To roll up sales for a specific GL class, double-click the R column next to the class for which you
want summary information only.

Note: The X indicates which GL classes are being rolled up.

6. Do one of the following:

To specify which information is displayed on the report, select one or more of the report option
check boxes.

To print the report using a memorized setting, clickOpen. When the Memorized Selections
screen opens, click the appropriate setting and click Select. For more information, see
Financial Statement Settings on page 1179.

Note: To restore the report’s original settings, click Reset.



GL Tab Reports

7. Click Print. The Report Window opens.

8. Print the report and close the Report Window.

9. Close the Report Options screen.

INCOME STATEMENT SUMMARY
This report provides a summary of your company’s financial progress.

Note: The percentage of gross profit in the expense section of this document is based on the total
gross profit (or loss). To see the percentage of gross profit based on total expenses, generate
the regular income statement.

To generate an Income Statement Summary
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select Income Statement Summary and click Launch. The Report Options screen opens.
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3. Type the fiscal year, number, and period whose information you want to retrieve.

Note: Unless you’ve changed your fiscal calendar, the fiscal number should always be 1.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.

6. Close the Report Options screen.

INTERSTORE BALANCE REPORT
This report shows general ledger transactions that have posted across sites (in TireMaster Corporate).

To generate an Interstore Balance Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.
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2. Select Interstore Balance Report and click Launch. The Date Range screen opens.

3. ClickOK. The Report Window opens.

4. Print the report and close the Report Window.

LONG FORM
This report provides detailed information about one or more general ledger accounts for a fiscal year,
fiscal period or a range of either fiscal years or periods. The report’s information is organized by
general ledger account number and can include separate groupings for each fiscal year and period.

To generate a Long Form
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.
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2. Select Long Form and click Launch. The Long Form screen opens.

3. Select the dates for the report:

For one fiscal year or period, select the same year, number, and period from both drop-downs.

For a range of fiscal years or periods, select different years and periods from the drop-downs.

Note: Unless you’ve changed your fiscal year, the number should always be 1.

4. Select the sites to include on the report from the Site drop-downs (in TireMaster Corporate).
5. Select the accounts whose information you want to generate:

For one account, enter the same account number for the beginning and end of the range.

For a range of accounts, enter different beginning and ending account numbers.

Note: To look up an account, click an Account field and press . Then select an account from
the Chart of Accounts.

6. To group report information by fiscal year and fiscal period, select the Group by Year/Period check
box. To go without grouping, clear the check box.

7. Click Print. The Report Window opens.
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8. Print the report and close the Report Window.

SHORT FORM
This report shows generalized accounting information for each general ledger account for all periods.
For each general ledger account, the report shows all of the offsetting accounts as well as the total
debit or credit amount.

To generate the Short Form
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select Short Form and click Launch. The Report Window opens.
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3. Print the report and close the Report Window.

TRIAL BALANCE
This report lists each GL account, including the description and the current balance.

To generate a Trial Balance Report
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.

2. Select Trial Balance and click Launch. The Report Options screen opens.
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3. Type the fiscal year, number, and period whose trial balance you want to generate.

Note: Unless you’ve changed your fiscal calendar, the fiscal number should always be 1.

4. Select the sites whose balance sheets you want to generate (in TireMaster Corporate).

5. If you want to include accounts with zero balances on the report, clear the Suppress Zero
Balances check box. Otherwise, leave the check box alone.

6. Click Print. The Report Window opens.

7. Print the report and close the Report Window.

8. Close the Report Options screen.

VENDOR TAB REPORTS
These reports provide information about your vendor accounts.

CASH REQUIREMENTS
This report can help you make decisions about paying your vendors. It displays the balances you owe
vendors, along with information about available early pay discounts and discounts you are eligible to
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receive if you pay by the discount due date.

Note: Before you generate this report for the first time, set the default number of days between check
runs in System Controls. To complete this setting, select System Controls from the Setup
menu. Click the Vendor tab, select Days between check run, and press Enter. Then type the
number of days that typically separate your check runs.

To generate a Cash Requirements Report
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

2. Select Cash Requirements and click Launch. The Cash Requirements Report screen opens.

3. Change the check run and next check run dates if needed.

Note: The check run date defaults to today’s date. The date of the next check run is determined
by the setting Days between check run, which is on the Vendor tab of the System
Controls screen.

4. Select one of the following methods for organizing purchase orders and vendor charges from the
Sort Detail By drop-down:

Doc #
Doc Date
Due Date



Vendor Tab Reports

Reference
To generate the report in summary view instead, clear the Show Detail check box.
5. Look up the balances for one or more vendors:

For all vendor balances, leave the Vendor Name and Vendor Type fields blank.
For one vendor’s balance, click Vendor Name. Then look up the vendor.
To retrieve balances for specific vendor types, click Vendor Type. Then select one or more
types from the list.

Note: For multiple types, press Ctrl and select each type that you want to include on the
report.

6. Click Print. The Report Window opens.

7. Print the report and close the Report Window.

8. Close the Cash Requirements Report screen.

VENDOR 1099 REPORT
With this report, you can see how much you paid your 1099 vendors and generate information needed
to complete IRS form 1099-Misc. You can also use it throughout the year to see how much you paid
your 1099 vendors during a specific date range. You can refer to this report when completing IRS form
1099 Misc or convert it into a .CSV file., which can be imported into tax preparation software.

To generate a vendor 1099 report
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.
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2. Select Vendor 1099 Report and click Launch. The Vendor 1099 Reporting screen opens.

3. Define the beginning and ending dates for the report’s date range. To generate a report for a single
day, enter the same date for both the beginning and ending dates.

4. Define whether to generate the report for one vendor or all vendors:

To generate the report for a specific vendor, click the Vendor field and press . Then look up
the vendor.

To generate the report for all vendors, leave the Vendor field alone.
To generate the report for a specific vendor type, make a selection from the Vendor Type
drop-down.

5. To limit the report to those vendors who earned more than a specific dollar amount, type that value
in theMinimum Amount field. Only whole numbers are accepted.

6. Select or clear the following check boxes as needed:

If you’re generating the report based on vendor type, make sure All Vendors is selected. If
you’re generating the report for a single vendor, make sure the check box is clear.

To organize the report information by vendor type assignments, make sure theGroup by
Vendor Type check box is selected. Otherwise, make sure the check box is clear.
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To include invoice information on the report, make sure the Show Details check box is
selected. For totals only, make sure the check box is clear. To limit the report to 1099 vendors,
select the 1099s Only check box.

7. Generate the output.

For a hard copy, click Print. If you’re prompted to include $0.00 payment amounts, answer the
question. The Report Window opens, and you can print the report.

For a .CSV file that can be imported into tax preparation software, click Create CSV File. Then
answer one or more questions when prompted. The .CSV file is saved in the apps folder in
your TireMaster program directory.

Note: Whether the .CSV file requires column headings depends on the type of tax
preparation software you’re using. For more information, refer to the documentation for
that product.

VENDOR BALANCE REPORT
This report lists one or more vendors with whom you have outstanding charges. It also shows the past
due balance, the aged future due balances, and the total balance for each vendor.

To generate a Vendor Balance Report
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

1163



1164

User Guide

2. Select Vendor Balance Report and click Launch. The Vendor Balance Report screen opens.

3. Select one or more vendors:

For all vendors, leave the Beginning Vendor and Ending Vendor fields blank.
For one vendor, click Beginning Vendor and look up the vendor. The vendor’s name opens in
both the Beginning Vendor and Ending Vendor fields. For more information, see Vendor
Searches on page 193.

For a range of vendors, click Beginning Vendor and look up the first vendor in the range. Then
click Ending Vendor and look up the last vendor in the range.

4. Click Print. The Report Window opens.

5. Print the report and close the Report Window.
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6. Close the Vendor Balance Report screen.

VENDOR CONTACT LIST
This report lists the addresses, phone numbers, and email addresses for all vendors or one or more
vendor types. Information generated with this report can be printed or exported to a spreadsheet.

To generate a Vendor Contact List
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

2. Select Vendor Contact List and click Launch. The Vendor Contact List screen opens.

3. Define which vendors you want to include:

For all vendors, leave the entries in the Vendor Types field alone.
For specific vendor types, click Vendor Types. Then select one or more types from the list that
appears, and clickOK. For multiple types, press the Ctrl key while you make your selections.

4. To generate the report, do one of the following:

For a printed copy, click Print. When the Report Window opens, click Print again. When you’re
done printing the report, close the Vendor Contact List screen.
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For a spreadsheet, click Export. Then clickOK to close the message. The spreadsheet is
saved in the Apps folder inside your TireMaster program directory.

VENDOR HISTORY REPORT
With this report, you can generate the following:

For one vendor, the running balance and a list of all transactions that occurred during a specified
date range

For all vendors, the running balances and a list of all transactions that have occurred since you
started using TireMaster.

In addition to generating detailed history, you also can print a summary that lists only the balance and
cash, charge, payment, and discount totals for one or all vendors.

To generate a Vendor History Report
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

2. Select Vendor History Report and click Launch. The Vendor History Report screen opens.
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3. Select one or more vendors:

For one vendor, click the Vendor field and press . Then look up the vendor’s name. For more
information, see Vendor Searches on page 193.

For all vendors, leave the Vendor field blank and make sure the All Vendors check box is
selected.

4. To include individual purchases, charges, and payments on the report, leave the Show Details
check box selected. For balances and cash, charge, payment, and discount totals only, clear the
check box.

5. If you’re generating the report for one vendor, select a date range.

6. To sort the report by reference number, select the Sort by Reference check box. Otherwise the
default sort is document date.

7. Click Print. The Report Window opens.

8. Print the report and close the Report Window.

VENDOR MASTER LIST
This report lists each of your active vendors along with their addresses and phone numbers.
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To generate a Vendor Master List
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

2. Select Vendor Master List and click Launch. The Report Window opens.

3. Print the report and close the Report Window.

VENDOR PAYMENT HISTORY REPORT
This report lists the payments made during a date range for all payment accounts or a single payment
account, or you can generate information for a specific payment or document.

Note: If a bank or another organization processes Automated Clearing House (ACH) payments for
you, this report can be used to generate a list of payments that you can give to your ACH
processor. For more information, see Record ACH Payments on page 794 and Generate a
Payment List for Your ACH Processor on page 795.

To generate a Vendor Payment History Report
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.
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2. Select Vendor Payment History and click Launch. The Payment History Report Options screen
opens.

3. For a list of payments generated during a date range, complete the following steps. For information
about a specific payment or document, go to step 4.

a. Make sure the Date tab is selected.
b. Define the beginning and ending dates for the date range. For a single day, enter the same

date for both the beginning and ending dates.

c. Select the account whose payment history you want to generate from the Payment Account
drop-down. For information about all accounts, leave the entry alone.

d. Define how to organize the payments by selecting Payment Number, Document Number, or
Vendor Number.

e. Click Print. The Report Window opens.
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Note: If you want to generate a spreadsheet for an ACH payment processor instead, click
Export. For more information, see Generate a Payment List for Your ACH Processor
on page 795.

f. Print the report and close the Report Window.

4. For information about a specific payment or document, complete the following steps. If you want a
list of payments for a date range, complete step 3 instead.

a. Click the Number tab.
b. For information about a specific payment, type the payment number.

Note: Exclude the site from this entry. For example, to look up payment 122, type only 122
instead of typing 2-122.

c. For information about a specific document, type the document number.

d. Click Print. The Report Window opens.
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e. Print the report and close the Report Window.

5. Close the Payment History Report Options screen and the Report List.

VENDOR PURCHASES REPORT
This report lists the purchases and vendor charges that occurred during a selected date range for one
vendor or all vendors.

To generate a Vendor Purchases Report
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

2. Select Vendor Purchases Report and click Launch.

1171



1172

User Guide

3. Look up one or more vendors:

For one vendor, click the Vendor field and press . Then look up the name of the vendor. For
more information, see Vendor Searches on page 193.

To generate a report for all vendors, leave the Vendor field blank.
4. If you’re generating the report for one vendor, select a date range.

5. To include information for PO line items, select the Show Details check box. For totals only, leave
the check box clear.

6. Click Print. The Report Window opens.

7. Print the report and close the Report Window.

VENDOR STATEMENT REPORT
This report provides detailed information about vendors with whom you have outstanding charges. It
lists each charge, the date, discount date, due date, charge amount, discount amount, remaining
available discount, amount owed, and reference number. This report also provides aging information
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for the outstanding charges.

To generate a Vendor Statement Report
1. Select Vendors > Reports. The Report List opens with the Vendor tab selected.

2. Select Vendor Statement Report and click Launch. The Vendor Statement Report screen opens.

3. Do one of the following:

For all vendors, leave the Beginning Vendor and Ending Vendor fields blank.
For one vendor, click Beginning Vendor and look up the vendor. The vendor’s name appears
in both the Beginning Vendor and Ending Vendor fields. For more information, see Vendor
Searches on page 193.

For a range of vendors, click Beginning Vendor and look up the first vendor in the range.
Then click Ending Vendor and look up the last vendor in the range.

4. To sort the list by reference number, select the Sort by Reference check box. Otherwise the
default sort is document number.
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5. To include aging information for each invoice, select the Detail check box. For an aging summary,
leave the check box blank.

6. Select the site or sites whose information you want to retrieve.

Note: For multiple sites, press Ctrl and select each site that you want to include on the report. For
all sites, select the check box.

7. Click Print. The Report Window opens.

8. Print the report and close the Report Window.

UNLISTED REPORTS
The following reports are not shown on the Report List. Some of these reports are generated when you
perform various tasks, such as closing a shift or applying finance charges.

APPOINTMENT REPORT
This report, which is generated from the Scheduler, lists the appointments for the selected day or date
range. For more information, see Print a List of Appointments on page 581.

CASING MANAGER REPORTS
The Casing Manager includes seven reports that provide information about casings and the customers
who’ve brought casings to your store.

CHARGE EDIT REPORT
This report is generated automatically when you create a vendor charge. For more information, see
Enter a Vendor Charge on page 744.

CHECK EDIT REPORT
This report is generated automatically when you create a check but before you process it. For more
information, see Generate AP Payments on page 753.

CORE MANAGER REPORTS
The Core Manager includes four reports that provide information about cores and the customers
who’ve brought cores to your store.
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DAILY INVOICE REPORT
This report prints automatically when you close a day. It displays sales activity, beginning balances,
cash paid out of the till, and any overages or shortages. This report cannot be printed except when you
close a day. For more information, see Day End Procedures on page 969.

DAILY SALES REPORT
This report prints automatically when you close a day. It displays all sales activity for the day and
includes separate listings for national account, government support, and adjustment activity. This
report also includes daily and month-to-date sales totals. It cannot be printed except when you close a
day. For more information, see Day End Procedures on page 969.

Note: The amounts on this report are calculated based on the settings for your GL ranges. If the
totals appear to be skewed, verify that none of your GL ranges overlap. To view these settings,
selectGL Ranges from the Setupmenu.

DAILY TILL DETAIL REPORT
This report prints automatically when you close a shift or day. It displays all transactions that have
taken place for the till that has been closed, grouping items by invoice type. This report cannot be
printed except when you close a day. For more information, see Day End Procedures on page 969.

DAY END TRANSACTION REPORT
This report prints automatically when you close a day. It displays slightly more detail than the Daily Till
Detail Report on page 1175, and it includes a deposit slip for the day’s receipts. This report cannot be
printed except when you close a day. For more information, see Day End Procedures on page 969.

EASY CHECK DETAIL REPORT
This report is detail document that you can print for each check. It can be sent with the corresponding
check to show payees which charges the check was applied to. After you print an easy check,
TireMaster prompts you to print the payment detail report.

FINANCE CHARGE EDIT REPORT
This report, which shows each customer who will be assessed finance charges, can be printed before
applying finance charges.

Note: TireMaster calculates finance charges based on the total of all the aged amounts in the
customer’s ledger. To prevent an over assessment of finance charges, make sure all
unapplied credits are applied to the customer’s balance before generating this report.

To generate a Finance Charge Edit Report
1. Select Closing > Statements > Apply Finance Charges. The Report Window opens.

2. Print the report and close the Report Window. TireMaster prompts you to post the finance charges.

3. To apply the charges, click Yes. A confirmation message appears.
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Note: If you applied finance charges to a customer in error, see Reverse Finance Charges on
page 712.

GL CODES REPORT
If you have any noninventoriable GL codes assigned to inventoriable items, you'll be prompted to print
this report during the process of recalculating the value of your inventory (running the Calc and Post).
You can then refer to the report to do the following:

Modify the GL codes listed on the report.

Assign different GL codes to the items listed on the report.

GL TRANSACTION VIEW LIST
Printing this report provides a hard copy of the transaction entries displayed on the GL Transaction
View screen. For more information, see Search for General Ledger Entries on page 675.

INTERSTORE TRANSFER REPORT
This report can be generated when clearing interstore transfers. It lists all of the transfer invoices and
POs, organized by site, for a selected date range. For more information, see Clear Interstore Transfers
on page 956.

INVENTORY LIST EDITING REPORT
This report lists the items currently displayed on the Inventory List Editing screen. For more
information, see Update Information for Multiple Items on page 211.

ITEM TRACKING REPORT
This report provides you with a hard copy of the items listed on the Item Tracking screen. For more
information, see Item Tracking Screen on page 317 and Verify Noninventoriable Item Returns on page
309.

JE EDIT REPORT
This report can be generated when you create manual journal entries. It lists the account numbers,
descriptions, dates, and debit and credit amounts for journal entries. For more information, see Make a
Manual Journal Entry on page 667.

LIST EDITING REPORT
This report lists the records currently displayed on the Customer List Editing and Vendor List Editing
screens. For more information, see Update Multiple Customer Records on page 72.

Note: Multiple vendor records are updated in the same manner as multiple customer records with
Vendor List Editing.
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PAIDOUT REPORT
This report, which displays all cash transactions paid out of the till, prints automatically during the day
end closing process. If needed, you can print a similar report from the Close tab of the Reports List.
For more information, see Paidout List for Date Range on page 1073 and Day End Procedures on
page 969.

PAYMENT DETAIL REPORT
This report is a detail document for each check printed from the AP Payments screen. It can be sent
with the corresponding check to show vendors which charges the check was applied to. For more
information, see Generate AP Payments on page 753.

PHYSICAL INVENTORY COUNT
This report prints automatically before you adjust inventory quantities. It lets you preview the results of
a pending adjustment. A positive quantity adjustment indicates a reduction in an item’s quantity. For
more information, see Adjust Inventory Quantities on page 249.

PRICING WIZARD REPORT
This report provides a preview of price or cost changes that you plan to implement with the Pricing
Wizard. For each item being updated or put on sale, this report shows the current price or cost and
what the price or cost will be. For more information, see Change Prices for a Group of Items on page
399 and Put Items on Sale on page 404.

SECURITY ASSIGNMENTS REPORT
This report lists the assignments for a security group, user, permission, or report. It’s generated from
the View Security Assignments screen. For more information, see Review Security Assignments on
page 60.

SERVICE CHECKLIST
This report lists the inspection areas for a service checklist. Technicians can refer to this document
while conducting vehicle inspections and write notes about any needed services or repairs on it. For
more information, see Print a Service Checklist on page 517.

SUGGESTED REORDER REPORT
This report is generated when you create a suggested reorder. After generating the report, you can
decide whether to create a purchase order based on the report’s information.

The Suggested Reorder Report lists the items in the selected range for which the available quantity
(on hand, unpriced, and on order) is less than the minimum quantity specified in the item’s settings.
This report also displays the total weight and month-to-date, year-to-date, and last year’s quantities
sold for each of the items.
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Note: You can choose whether to include transfers in the report’s month-to-date, year-to-date, and
last year totals by setting the control Reorder Reports - Include Transfers. This setting is on
theInventory tab on the System Controls screen.

To generate a Suggested Reorder Report
1. Select Inventory > Suggested Reorder & PO. TireMaster prompts you to look up items.
2. Select the item or range of items that you want to generate the report for and clickOK. The Report

Window opens. For more information, see Inventory Searches on page 230.

3. Print the report and close the Report Window.

TIME CLOCK REPORT
This report, which is generated from the Time Clock, lists employee time clock entries and the amount
of time worked during a date range. For more information, see Time Clock on page 864.

DOCUMENT SCREENS
Documents are typically displayed on screen, unless they print automatically as part of a program
function (such as the day end close) or you've disabled the on-screen display for them.

Note: You can send work orders, invoices, ROAs, and deposits directly to the printer by setting the
number of copies to 1 or a higher number.

REPORT WINDOW
The Report Window is used for reports, credit memos, and documents generated by the PO System.
The top of the Report Window includes buttons for navigation, printing, magnification, and printer
setups (Figure 33-3).

Figure 33-3: Report Window Top Buttons

You can use the Report Window buttons (Figure 33-4) to do the following:

To move to another page or print a report, click one of the arrow buttons.

To adjust the size at which a report is displayed, select the magnification from the drop-down or
type a value and click outside the magnification field.

Note: The magnification can range from 25% to 400%.
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To find a specific quantity, dollar amount, item, or name on a report, type the information in the
data search field and click .

To export report data to other software applications, click and select the application and
destination.

To ensure that the report includes the most up-to-date information, click .

Example: The Inventory Master List displays an on hand quantity of 5 for your 36 month
batteries. Then a salesperson places one of those batteries on a work order while the report is
displayed on the screen. Clicking updates the item’s on hand quantity to 4.

The bottom of the Report Window includes a Close button and additional navigation, printing, and
magnification buttons.

Figure 33-4: Report Window Bottom Buttons

REPORT SCREEN
The Report screen is used for forms (work orders, invoices, ROAs, and deposits). All buttons for
navigation, printing, magnification, and printer setups are at the top (Figure 33-5).

Figure 33-5: Report Screen Buttons

FINANCIAL STATEMENT SETTINGS
You can create and save one or more report settings for the balance sheet and income statement.
Creating your own settings lets you control what information is displayed on these documents. It also
makes generating financials easier, because you don’t have to remember which options to use every
time you print them.

CREATE FINANCIAL STATEMENT SETTINGS
You can create and save a variety of report settings for the income statement and balance sheet.

To create your own financial statement settings
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.
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2. Select one of the following reports and click Launch. The Report Options screen opens.
Balance Sheet

Income Statement

3. Click New.

4. Type a name for the setting and clickOK.



Financial Statement Settings

5. Select or clear the report setting check boxes as needed.

6. Click Save. A confirmation message appears.

7. Click Yes. The name of the new setting is displayed in the Current Selection field.
Note: If you want to use the new setting as the default setting, clickOpen. Then select the new

setting and click Default.

Warning: If you click Reset on the Memorized Selections screen, the original settings for the
income statement and balance sheet will replace the default setting that you’ve just
created.

8. Continue generating the report as usual.

MAKE FINANCIAL STATEMENT SETTINGS INACTIVE
If you want to exclude a report setting from the list of memorized settings, make it inactive.

To make a report setting inactive
1. SelectGeneral Ledger > Reports. The Report List opens with theGL tab selected.with theGL

tab selected.
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2. Select one of the following and click Launch. The Report Options screen opens
Balance Sheet

Income Statement

3. ClickOpen. The Memorized Selections screen appears.

4. Click the setting that you want to make inactive and click Inactivate.



Sales Report Options

Note: Once you make a setting inactive, it cannot be made active again. To view settings that are
no longer active, clear the Active check box. If you want to use one of the inactive settings
for generating a report, select its name and click Select.

5. Close the Memorized Selections screen.

SALES REPORT OPTIONS
To generate an accurate picture of the sales activity that occurs in your store, you can define which
types of sales to include on your sales reports by completing settings on Sales Report Options screen
(Figure 33-6).

Figure 33-6: Sales Report Options Screen

Item Description

National Account
Invoices

Displays national account invoices on sales reports.

Government
Support Invoices

Displays government support invoices on sales reports.

Adjustment Lines Displays adjustment lines from invoices on sales reports.

Normal Invoices Displays normal invoices on sales reports.

Transfer Invoices Displays all transfer invoices on sales reports.

Employee Invoices Not used.
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PERMISSIONS
Permissions define which program areas users in a security group are allowed to access. This
appendix includes a list of TireMaster's permissions descriptions for each of them.

PERMISSIONS LIST
TireMaster's permissions (Table A-1) define which program areas users in a security group are
allowed to access.

Item Description

Automatic Calc & Post
JE

Lets the user choose whether to have TireMaster make adjusting
journal entries automatically when recalculating inventory value (in
TireMaster Plus and TireMaster Corporate).

Card Auto-Auth Lets the user enable or disable auto authorization at point of sale
(for systems set up to automatically process credit and debit
cards).

Close a Shift Lets the user close a shift.

Close Day Lets the user close a day.

Table A-1: TireMaster Permissions

1185

APPENDIX A



1186

User Guide

Item Description

Close Day/OverShort Lets the user proceed with the day end close regardless of
whether the system totals for cash, checks, and cards match the
actual totals. Available in TireMaster 9.4.0.

Close Month Lets the user close a month.

Close Month Unlock Lets the user unlock a month that has been locked.

Close Reports Lets the user access the closing reports including the mechanic
and salesperson reports.

Close Year Lets the user close the year.

Credit Card Setup Lets the user access the setup screen for the Merchant Partners
credit card processing system.

Credit Limit Clearance Lets the user start work orders and complete invoices for
customers who have gone over their credit limits. This permission
also allows users to see a customer’s credit limit on the Invoice
Entry screen.

Customer Access Gives the user permission to access and update parts of customer
records that aren’t protected by specific permissions.

Customer Add Lets the user add a customer.

Customer Combine
Customer

Lets the user make a customer account inactive and combine it
with another customer’s account.

Customer Delete Lets the user delete an unused customer record.

Customer Edit Account Lets the user update a customer’s sales tax, statement, and price
level settings.

Note: To allow users to update addresses, email addresses,
phone numbers, and notes only, assign the permission
Customer Edit Contact instead.

Customer Edit Cash
Only

Lets the user change a cash only customer to a charge customer
or vice versa.

Customer Edit Contact Lets the user update a customer’s address, phone numbers, email
addresses, and notes.

Customer Edit Cred.
Limit

Lets the user view and change a customer’s credit limit on the
General tab of the Customer Maintenance screen. The Credit
Limit field is visible only to users who have this permission.
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Item Description

Customer Edit
Information Tab

Lets the user add or update content on the Customer Maintenance
screen’s Information tab.

Customer Edit
Required PO

Lets the user change the setting for the Require P.O. check box
on theGeneral tab of the Customer Maintenance screen.

Customer Ledger View Lets the user access a customer’s open item ledger.

Customer List Editing Lets the user update a range of customer or vendor records with
Customer List Editing or Vendor List Editing.

Customer Nat Recon
Edit

Lets the user assign reconciliation codes to customers. If the user
isn’t assigned this permission, the Recon Codes button is
disabled on theGeneral tab of the Customer Maintenance screen.

Customer Terms Lets the user access and make changes to a customer’s payment
terms.

Customer Update
Salesperson

Lets the user change the salesperson assigned to a customer.

Dashboard View Lets the user view the TireMaster Dashboard. For more
information, see TireMaster Dashboard on page 982.

Default Salesman
Override

Lets the user override the salesperson for a line item on a work
order. This permission is also required for changing the starting
salesperson on a work order.

Easy Checks Lets the user create easy checks (in TireMaster Plus and
TireMaster Corporate).

Ext Data Access Read
Only

Lets the user extract data from the TireMaster database.

Note: In addition to this permission, users also needs to be
granted external data access by ASA Support.

Fleet Pricing Not used.

GL Accounts Add/Edit Lets the user add or update general ledger accounts and
departments (in TireMaster Plus and TireMaster Corporate).

GL Accounts View Lets the user view the chart of accounts.

GL Check Add Lets the user add or update a check or its status on the Check
Reconciliation screen (in TireMaster Plus and TireMaster
Corporate).
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Item Description

GL Check
Reconciliation

Lets the user view the Check Reconciliation screen (in TireMaster
Plus and TireMaster Corporate).

GL Journal Entries Lets the user make journal entries and AR journal entries to adjust
customer balances.

GL Transaction View Lets the user view general ledger activity on the GL Transaction
View screen (in TireMaster Plus and TireMaster Corporate).

Gross Margin Viewer Lets the user access and view the gross profit margin for a work
order with the GM Viewer. For more information, see GM Viewer
on page 450.

Inventory Access Lets the user open the Inventory Maintenance screen and access
any inventory menus that aren’t protected by a specific
permission.

Inventory Add Lets the user add inventory items.

Inventory Edit Lets the user update basic settings for items, such as product
codes, descriptions, manufacturer codes, and categories (settings
that are on theGeneral tab of the Inventory Maintenance screen).

Inventory Edit Price Lets the user update prices in each of the following program areas:

Site Prices & Quantity screen

Inventory List Editing screen

Pricing Wizard

Price Levels

Inventory GL Code
Add/Edit

Lets the user change inventory GL codes (in TireMaster Plus and
TireMaster Corporate).

Inventory GL Code
Delete

Lets the user delete existing inventory GL codes that have never
been used (in TireMaster Plus and TireMaster Corporate).

Inventory GL Code
View

Lets the user view inventory GL codes.

Inventory Pricing Not used.

Inventory Qty
Adjustment

Lets the user access the Quantity Adjustment Wizard.

Inventory View Only Prevents the user from updating items’ price and cost information,
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Item Description

Price/Cost by overriding the editing functionality granted by the Inventory
View/Edit Cost permission.
When both Inventory View/Edit Cost and Inventory View Only
Price/Cost are assigned, the user is able to see price and cost
information but cannot edit amounts, assign price matrices, or
recalculate factor based prices on the Site Prices and Quantity
screen.

Inventory View/Edit
Cost

Lets the user do the following:

View or update an item’s cost on the Site Prices and
Quantity screen.

View the next cost, last cost, and base cost of items on the
Inventory List.

View general ledger entries for completed receivings.

Print historical receiving documents.

Invoicing Access Lets the user access quotes, work orders, invoices, ROAs, and
paidouts. Also lets the user access the customer screens that are
accessible with the Customer Access permission at point of sale.

Invoicing Change Date Lets the user change the beginning or ending date of an open work
order.

Invoicing Edit Printed
WO

Lets the user change work orders that have been printed.

Invoicing New Paidout Lets the user pay an expense with cash from the till.

Invoicing New ROA Lets the user process payments received from customers.

Invoicing Pop Till Causes the till to open when users accept cash for completed
invoiced at their assigned tills.

Note: This option is only available if you have an electronic cash
drawer attached to your TireMaster system.

Invoicing Reverse
Invoice

Lets users who have the Invoicing Access permission
automatically reverse (and create a duplicate of) any customer’s
completed invoice.

Invoicing WO Delete Lets the user delete open work orders and unknown receiving
documents (from the Item Tracking screen).

Message Critical Notice Lets the user access the TireMaster messaging center.
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Item Description

Note: In future versions, critical notices could alert users to
issues that adversely affect TireMaster.

Message Marketing
Notice

Lets the user access the TireMaster messaging center.

Note: In future versions, marketing notices could notify users of
sales events and describe new TireMaster products and
services.

Message Support
Notice

Lets the user access the TireMaster messaging center.

Note: In future versions, support notices could provide
troubleshooting information.

Message Update Notice Lets the user access the TireMaster messaging center and view
messages about the availability of TireMaster updates.

Nat’l Recon
Codes/Credits

Lets the user view or edit reconciliation code settings.

Nat’l Recon Credits Lets the user view or edit credits on the National Credits screen,
where credits from national account, government support, or
adjustment invoices can be tracked.

Option Cost Change RD
Option

Lets the user choose whether to put an option cost item on a
receiving document by selecting or clearing a check box on the
Option Cost screen.

Note: To force users to always put option cost items on receiving
documents, assign this permission and set the control
Option Cost - Create RD Default to Yes.

Overdue Balance
Clearance

Lets the user start work orders and complete invoices for
customers who have overdue balances.

Note: If the system control Suppress overdue balance
warning in POS is set to No, warning messages appear
before the override prompts.

Override Document
Lock

Lets the user override a security lock that protects a work order
from being opened on two workstations at the same time.

Note: This override should only be used under special
circumstances, such as if a workstation is locked when it
has a work order opened. A work order should never be
edited on two workstations at the same time.

Payroll Comm Lets the user prevent commission and spiff calculations from being
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Item Description

Lock/Adjust changed. Commissions can be saved and locked for a specified
date range when printing the Commission Report.

PO Access/Receiving Lets the user view, create, and process purchase orders and
receiving documents.

PO Edit Locked Not used.

PO Suggested Lets the user generate the Inventory Reorder Report and create a
suggested purchase order.

PO/Recv All
Qtys/Prices

Not used.

PO/Recv Override Price Not used.

PO/Recv Override Qty Lets the user change quantities or prices for items on a receiving
document or vendor invoice document (VID).

Price Level Change Lets the user change the price of an item on a quote or work order
by making a selection from the global price levels list.

Price Level Override Lets the user manually change the parts price (by typing a different
amount) for items associated with the customer’s assigned price
level.

Quotes Admin
Templates

Lets the user create quote templates, which can be saved and
repeatedly used to serve as a starting point for future quotes.

Quotes Change Tax
Level

Lets the user change the tax level used for a quote or quotes.

Quotes Delete Quote Lets the user delete individual quotes.

Quotes Extend Expired Lets the user change the expiration date for quotes.

Quotes Lock Override Lets the user unlock a quote that is open on the same workstation
or another workstation.

Quotes Make Work
Order

Lets the user turn a quote into a work order.

Quotes Print Quote Lets the user print a quote or a set of quotes.

Quotes Sell Below
Margin

Lets the user override the price of an item and sell it at an amount
that doesn’t meet the required margin set in System Controls.
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Item Description

Quotes View Margin Lets the user view the margin for an item.

Reports Customer Lets the user print the customer reports.

Reports GL Lets the user print general ledger reports (in TireMaster Plus and
TireMaster Corporate).

Reports Inventory Lets the user print inventory reports.

Reports
Mech/Salesperson

Not used. To limit access to the mechanic and salesperson
reports, assign the Close Reports permission.

Reports Month-End Not used. To limit access to the month end reports, assign the
Close Reports permission.

Reprint Documents Lets the user reprint historical documents.

Save Screen Layout Lets the user rearrange columns on the Inventory List and the
Inventory List Editing screens and save the changes.

Setup Lets the user access any command on the Setupmenu that
doesn’t have a specific permission. Also lets the user create
custom report tabs.

Setup Interfaces Lets the user access the setup menu for various applications that
are integrated with TireMaster (such as the CARFAX Interface and
the Bridgestone National Accounts Interface).

Setup
Users/Permissions

Lets the user view, edit, add, or delete user settings, permissions,
commissions, and menus.

Note: This permission should be granted to the system
administrator only.

Site Selection Lets the user access only the sites that are assigned to that user
account in colocated environments. This permission is referenced
in the following scenarios:

When users log in to TireMaster and are prompted to select
a site.

When users attempt to change the site by double-clicking
the bar at the bottom of the screen.

Skip Electronic
Submission

Lets the user submit national account claims manually on systems
running electronic claims applications, such as the Firestone
National Account Interface and the Goodyear Tire-HQ Interface.
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Item Description

Time Clock Entry of
Others

Lets the user do the following:

Enter in and out times for other employees

Make global time entries (Available in TireMaster 9.4.0)

Generate Time Clock Reports for other employees

Time Clock Manual
Entry

Lets the user do the following:

Enter forgotten in and out times

Correct previously-entered in and out times

Vehicle Service
Checklist Access

Lets the user access the service checklist from an open work order
and from the customer’s record.

Vehicle Service
Checklist
Add/Edit/Delete

Lets the user add, modify, and delete service checklists.

Vendor Access Lets the user access any vendor menus that don’t have a specific
permission.

Note: Some vendor menus are available only in TireMaster Plus
and TireMaster Corporate.

Vendor AP Payments Lets the user access the AP Payment screen and the vendor’s
open item ledger (in TireMaster Plus and TireMaster Corporate).

Vendor Charges Lets the user access the Vendor Charge screen (in TireMaster
Plus and TireMaster Corporate). Once the screen is open, the
permission does not affect whether the user can add or update
vendor charges.

Vendor Reports Lets the user print vendor reports (in TireMaster Plus and
TireMaster Corporate).

Vendor View/Change
Bank Information

Lets the user see the vendor’s bank name, routing number, and
bank account number.

Work Order Change
Tax Level

Lets the user select a different tax level for a work order.

Work Order Change
Recon Code

Lets the user perform the following tasks:

Choose a different reconciliation code for a work order.
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Item Description

Remove the reconciliation code from a work order to change
a national account or government support sale to a normal
sale.

Assign a reconciliation code to a work order to change a
normal sale to a national account or government support
sale.

This functionality is available in TireMaster 9.4.0.

Work Order Sell Below
Cost

Lets the user sell items at prices that are below your cost.

ZZ 3rd-Party Add to PO Lets the user add an item to a purchase order directly from the
invoicing screen for selected third party vendors.



SYSTEM CONTROLS
By setting system controls, you can define many default settings for your TireMaster system. The
controls are available on a series of tabs, organized by program areas. This appendix includes the
following sections:

Commission Controls 1196
Customer Controls 1197
Enterprise Controls 1202
General Ledger Controls 1203
Inventory Controls 1206
Other Controls 1209
Vendor Controls 1220

1195
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COMMISSION CONTROLS

Item Description

Adjust National
Commissions

Defines whether you can adjust sales commissions for national
account, government support, and adjustment sales.

Adjust National
Commissions
Threshold

Defines a minimum amount for sales commission adjustments. If the
suggested sales commission for an invoice is less than the amount
defined here, the focus of the Sales Commission Adjustments screen
will be on the Cancel button instead of theOK button.

Note: The purpose of this setting is to help you work more quickly
when adjusting sales commissions.

Commission Cutoff
Date - Most Recent

Defines the cutoff date for commissions.

Default Commission
Matrix Code

Defines which commission matrix code to use if no other code has
been assigned.

Default Commission
Type - Customer

Defines the default commission type for customers who have no
assigned commission type.

Default Commission
Type - Inventory

Defines the default commission type for inventory items that have no
assigned commission type.

Default Employee -
Commission

Defines the default commission matrix code for new employees who
have no assigned code.

Sales Spiff -
Customer Type to
Exclude

Lets you define a customer type to exclude from your sales spiffs.

Table B-1: TireMaster's Commission Controls
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CUSTOMER CONTROLS

Item Description

Auto Inactivate
Vehicles

Improves loading times for the Vehicle List when customers have
dozens of vehicles that you’ll work on only once. When this control
is enabled and a customer has more than 100 vehicles set to
Active, the following occurs:

If there was activity for fewer than 100 of the vehicles during
the last 180 days, all of the vehicles that did not have sale
invoices during that time will be marked inactive.

If there was activity for more than 100 vehicles during the last
180 days and activity for fewer than 100 vehicles during the
last 90 days, the vehicles that did not have sale invoices in
the last 90 days will be marked inactive.

If there was activity for more than 100 vehicles during the last
90 days and activity for fewer than 100 vehicles in the last 60
days, the vehicles that did not have sale invoices in the last
60 days will be marked inactive.

If there was activity for more than 100 vehicles in the last 60
days, the vehicles that did not have sale invoices in the last
30 days will be marked inactive.

Check for Duplicate
PO

Lets you define whether the same PO number can be repeatedly
used on a customer's invoices. When this control is enabled,
TireMaster compares the PO number entered for the current sale
(on the Work Order or Invoice Completion screen) to PO numbers
used for the customer's sales during the past year. If a duplicate is
detected, you’ll be instructed to enter a different PO number.

Customer Default
Price Level

Defines which price level is assigned to new customers by default.

Customer - Transfer
Type

Defines the default customer type code for transfer customers.

Customer Default Type Defines the which customer type is most commonly used for new
customers

Customer/Site Default
Tax Level - Labor

Defines which tax level is most commonly used for calculating the
amount of sales tax a customer will pay for labor. When you add
new customers, they’re automatically assigned this tax level.

Table B-2: TireMaster's Customer Controls
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Item Description

Customer/Site Default
Tax Level - Parts

Defines which tax level is most commonly used for calculating the
amount of sales tax a customer will pay for parts. When you add
new customers, they’re automatically assigned this tax level.

Debit Cards - Allow
Cash Back

Defines whether you allow customers paying with debit cards to
add an additional amount to their purchases that is given back to
them in cash.

Note: This control needs to be set only if a payment card
processing application is integrated with your TireMaster
system.

Default AR Discount
#Days/Date

Defines the number of days or a day of the month for calculating
early pay discounts.

Default AR Discount
(D=#Days or T=Date)

Defines the discount scheduling option:
Set to D to apply the discount if payment is received before
the number of days has passed.

Set to T to apply the discount if payment is received on or
before the selected date.

Default AR Discount
Percentage (%)

Defines the most commonly used percentage for calculating
discounts.

Default AR Due
#Days/Date

Defines the number of days or a day of the month for payment due
dates. This setting is used for all new customers, unless it’s
changed in a customer’s payment terms. It is also used for aging
balances, but not for calculating finance charges.

Default AR Due
(D=#Days or T=Date)

Defines payment due dates:

Set to D if payments are due a specific number of days after
the purchase

Set to T for a specific day of the month.

Default AR Invoice
Terms (#Payments)

Sets the default number of payments for an invoice.

Deposit - MIN Dollar
Amount

Defines the minimum dollar amount customers are required to pay
toward purchases.

Deposit - MIN
Percentage (%)

Defines the minimum percentage of the invoice total that customers
are required to pay toward future purchases.

Note: When the minimum deposit percentage for an invoice is
less than the minimum dollar amount for deposits (Deposit
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Item Description

- MIN Dollar Amount), the customer is required to pay the
minimum deposit dollar amount.

Enable
Customer/Vendor Next
& Prev buttons

Defines whether the Next and Prev (previous) buttons should be
available on the Customer Maintenance and Vendor Maintenance
screens.

Note: The shortcut key for the Prev button is PageUp, and the
shortcut for the Next button is PageDown. To move to the
next or previous customer, you must be out of edit mode.

Finance Charges on
Finance Charges

Defines whether to include previous finance charges in the
calculation of new finance charges.

Note: Assessing finance charges on finance charges might not be
allowed in your state. Contact your state’s Attorney
General’s office before setting this control.

Finance Chrg Later
than Day

Lets you define the age (in days) at which to begin calculating
finance charges for invoices.

Example: If you set the control to 90, finance charges will be cal-
culated only for invoices that are older than 90 days. When the
control is set to 0, it is disabled.

Ledger History show all
sites

Defines whether the site you are signed into will list other site
invoices in the ledger/history on the Customer Maintenance screen.

Note: This control is used for sites that are part of a corporate
database configuration.

ROA Complete - Flag
Old Invoices Selected

Defines whether the Flag Old Invoices check box on the
ROA/Deposit Complete screen is selected by default.

Sales Tax - Charge
Govt. Customers

Defines whether sales tax is calculated by default on work orders
for government support customers.

Set to No to exclude sales tax from government support
invoices. Selecting No overrides the tax settings assigned to
individual customers.

Set to Cust to use customer tax settings to determine
whether sales tax is calculated for government support
invoices.

Sales Tax - Charge
Natl. Customers

Defines whether sales tax is calculated by default on work orders
for national account customers.
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Item Description

Set to No to exclude sales tax from national account
invoices. Selecting No overrides the tax settings assigned to
individual customers.

Set to Cust to use customer tax settings to determine
whether sales tax is calculated for national account invoices.

Sale Tax - Ignore
Single Exemptions

Helps to ensure that enough sales tax is collected when the
following conditions exist:

Your stores are in multiple locations (counties or states) with
tax rates that vary.

Your default tax levels are based on site instead of the tax
levels assigned to customers. (Another control, Sales Tax -
Use Levels Assigned to Customers, is set to No.)
One of the tax levels assigned to a customer is an exempt
level. (For example, parts are taxed and labor is not.)

That customer buys items at stores besides the one where
he or she was added to TireMaster.

By setting Sales Tax - Ignore Single Exemptions (Customer
tab) to Yes, a customer who is assigned one exempt level will be
charged the site’s sales tax for both parts and labor when shopping
at a store in an area where there is a different tax rate.

Example: A customer is added at a Store A, which is located in
a county that does not tax labor. Sometimes this customer buys
items at Store B, which is in another county that levies sales tax
on both parts and labor. Enabling the new control ensures that
when tax collections are based on site defaults instead of the
customer's assigned tax levels, the site defaults are used to cal-
culate sales tax. Therefore, the customer will be charged for
both parts and labor at Store B, but will be taxed only for parts
when shopping at Store A.

Note: There are two scenarios in which the new control has no
effect: 1) Customers who are exempt from paying tax on
both parts and labor will never pay sales tax, regardless of
which store they visit, and 2) When customers are assigned
a customer type with Tax Select enabled, TireMaster will
prompt you to choose tax levels at point of sale.

Sales Tax - Use Levels Defines whether sales tax collections should be based on the
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Item Description

Assigned to
Customers

default tax levels assigned to a store or the tax levels assigned to
individual customers.

To base your sales tax collections on the default parts and
labor tax levels for your store, select No.
Note: The system controls for settings for your store’s default

tax levels are Customer/Site Default Tax Level -
Labor and Customer/Site Default Tax Level - Parts.

To base your sales tax collections on the tax levels assigned
to individual customers, select Yes.

Set Credit Color Code Enables the automated process that assigns credit colors to
customers with 30, 60, or 90 day overdue balances.

Statement Cutoff Date Defines the day of the month for cutting off statements.

Statement Cutoff Date
- Most Recent

Defines the latest cutoff date. TireMaster increments this date by
one month with each cutoff.

Statement Cutoff
Grace Period

Defines the number of days for the statement grace period.
Charges made within the number of days you specify won’t be due
until the following cutoff date.

Note: The grace period does not stop TireMaster from calculating
finance charges for past due balances.

Statement Fin. Charge
- Annual Percentage
Rate (%)

Defines the annual percentage rate (APR) for finance charges.

Statement Fin. Charge
- Minimum Amount ($)

Defines the minimum finance charge amount.

Statement Fin. Charge
- Periods per Year

Defines the number of fiscal periods per year. This value should be
12 unless you’ve implemented a short tax year.

Statement Print 0
Balances

Defines whether to print statements for customers who have paid
off their balances since the last statement cutoff.

Suppress overdue
balance warning in
POS

Defines whether warnings should appear when starting work orders
and completing invoices for customers who have overdue
balances.

Vehicle Year Format Defines whether vehicle years are added to customer records as
two digit (such as 16) or four digit numbers (such as 2016). This
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Item Description

setting affects vehicles chosen from the Standard Vehicle Selection
screen, not those entered manually.

Zip Code Length for
Prompts

Defines how many numbers you need to type in zip code entry
fields before the Zip Code list automatically opens.

ENTERPRISE CONTROLS

Item Description

Can Create New
PO

Lets a site create new purchase orders. If this option is set to YES for the
corporate site, then the corporate site can order items for the stores. If
this option is set to YES for a store, then that store can order its own
items.

Can Create New
RD

Lets a site create receiving documents, either manually or by receiving a
purchase order. If this option is set to YES for the corporate site, then the
corporate site can receive items for any sites. If this option is set to YES
for a store, then that store can receive its own orders.

Can Create New
VID

Lets a site price receiving documents (RDs) to create vendor invoice
documents (VIDs). If this option is set to YES for the corporate site, then
the corporate site can price items for any sites. If this option is set to YES
for a store, then that store can price its own orders.

Note: If this control is set to NO at a store, then it must be set to YES at
the corporate site.

Interstore Offset -
Major Account

Defines the major account that offsetting entries should post to when
transactions affect multiple sites. The interstore offset account ensures
that the general ledgers for individual sites remain in balance.

Interstore
Transfers -
Clearing Account

Defines the account that adjusting entries (AR journal entries and
negative vendor charges) will post to, so they can be cleared.

Interstore
Transfers -
Customer Type

Defines the default customer type for interstore transfer customers
(usually type U). Whenever an invoice is created for this customer type,
TireMaster handles it as an interstore transfer invoice. When the store
replicates to the corporate site, TireMaster automatically creates an
interstore transfer purchase order.

Note: Do not assign the customer type for regular transfer customers
(usually type T) to this control. This setting is for transfers

Table B-3: TireMaster's Enterprise Controls
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Item Description

between stores using the same TireMaster Corporate system.

Interstore
Transfers - Edit
Prices

Allows a site change the cost of items received in an interstore transfer.

Interstore
Transfer POs -
Stop with PO
(Ordered)

Defines how to process interstore transfers for a site. If this control is set
to NO for a site, interstore transfers are received and priced
automatically at that site. If it is set to YES for a site, interstore transfers
need to be received and priced manually at that site.

Update Factor
and Base Price at
All Sites

Allows users at the corporate site to implement changes made to an
item’s factor, base price, or both at the stores. To send base price and
factor changes to the stores, click Update All Sites on the Site Prices
and Quantity screen. The changes take effect at the stores after
replication occurs.

Update Last Cost
at All Sites

Allows users at the corporate site to implement changes affecting an
item’s last cost at the stores. To send last cost changes to the stores,
click Update All on the Site Prices and Quantity screen. The changes
take effect at the stores after replication. The Last Cost is updated after
you price each new receiving, and you can manually update it.

Update Last FET
at All Sites

Allows users at the corporate site to implement changes affecting an
item’s last FET at the stores. To send last FET changes to the stores,
click Update All on the Site Prices and Quantity screen. The changes
take effect at the stores after replication. The Last FET is updated after
you price each new receiving, and you can manually update it.

GENERAL LEDGER CONTROLS

Item Description

Default Account -
Cash

Defines the default general ledger account for tracking any cash or
checks received throughout the day. This amount (minus the till
float) is taken out of the account during the day end close. Assign an
asset account for this control.

Default Account -
Cash Over/Short

Defines the default general ledger account for posting any overages
or shortages from the day end close. This account is usually an
expense account.

Table B-4: TireMaster's General Ledger Controls

1203



1204

User Guide

Item Description

Default Account - FET
Correction

Defines the default general ledger account for posting FET rounding
error corrections. This function occurs during the month end
inventory value recalculation. This account is usually an expense
account.

Default Account - Fin.
Charge Income

Defines the default general ledger account for posting any finance
charge income. This account is usually an income account.

Default Account -
Freight

Defines the default general ledger account for posting any non-line
freight. This account is usually an expense account.

Default Account -
Inventory Correction

Defines the default general ledger account for posting any rounding
errors found in the inventory value recalculation. This account is
usually an asset account.

Default Account - PO
Sales Tax Expense

Defines the default general ledger account for posting any sales tax
you pay for the inventory you receive.

Default Account -
Sales Tax

Not used.

Default Account -
Sales Tax Rounding

Defines the default general ledger account for posting sales tax
rounding amounts.

Default Account -
Year-End Profit/Loss

Defines the default general ledger account used for posting your
year end profit or loss. Assign an equity account for this control.

Default Department Defines the default department.

Default Department -
Freight

Defines a default department for any freight expenses. This setting
must be 1 unless you have multiple departments.

Default Department -
Sales Tax Expense

Defines a default department for any sales tax expenses. This
setting must be 1, unless you have multiple departments.

Default GL Class Defines the default GL class. This setting is usually 1.
Note: In the TireMaster startup database, class 1 is the Normal GL

class.

Default Inventory GL
Code

Defines the default inventory GL code.

Department Method Defines whether departments are set up to provide information
about customers or items.

Deposit - Clearing Defines the general ledger account used for tracking deposits
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Item Description

Account collected at point of sale when customers make payments toward
purchases.

Fin. Statements -
Asset

Not used.

Fin. Statements -
Expense

Not used.

Fin. Statements -
Income

Not used.

Fin. Statements -
Liability

Not used.

Fin. Statements -
Owner's Equity

Not used.

Income Statement -
Administrative

Not used.

Income Statement -
Other
Income/Expenses

Not used.

Income Statement -
Sales & COGS

Not used.

Inventory Clearing
Acct

Defines which general ledger account is used to offset entries for
inventory returns to vendors. This account is usually a liability
account.

Startup Account -
Accounts Payable

Defines the vendor account for your startup balance. Do not change
this account number.

Startup Account -
Accounts Receivable

Defines the customer account for your startup balance. Do not
change this account number.

Startup Account -
Inventory

Defines the inventory account for your startup balance. Do not
change this account number.

Transfer GL Class Define the GL class for transfer invoices.
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INVENTORY CONTROLS

Item Description

Base Price - Use
Instead of Last Cost for
POs/RDs

Defines whether to use the base price or last cost as the cost
(price) of items added to purchase orders and receiving
documents.

Base Price Copied to
Last Cost if Zero

Defines whether to use a new item’s base price as its last cost if
the cost for that item is zero:

If you select Yes, the base price is copied only if the last
cost is zero. You are then notified that the base price was
copied.

If you select No, nothing is copied. You are then warned
that the last cost is zero.

Core - Noninventory
Core Item

Defines the item used to assess core charges on work orders.

Cost Replacement Code
(10 unique alphas)

Defines the cost replacement code for noninventoriable items that
are set up with the option cost or relief percent costing methods.
This code must include ten unique letters.

Cost Replacement Code
- Show on Invoices

Defines whether to display the cost replacement code on invoices
and on the Option Cost screen at point of sale.

Custom Inventory
Lookup

Enables the Custom Inventory Lookup screen:

If you select Yes, TireMaster uses the Custom Inventory
Lookup screen for all searches.

If you select No, TireMaster uses the Custom Inventory
Lookup screen for some searches and the standard lookup
screen for other searches.

Enable Core Item Field Enables the Core Item field on the Inventory Maintenance screen,
so core items can be assigned to parent items.

Fitment Guide - Skip
Inventory Lookup

Defines how the fitment guide uses the Custom Inventory Lookup
screen:

Set to Yes, if you want the tire selected in the fitment guide
to be added directly to a quote or work order.

Set to No, if you want the Custom Inventory Lookup screen
to open regardless of whether you’ve already selected a tire
in the fitment guide.

Table B-5: TireMaster's Inventory Controls
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Item Description

Fitment Guide - Use
Size for Search

Defines whether the fitment guide automatically uses size for
inventory searches:

Set to Yes, if you want to display the tire size identified by
the fitment guide on the Custom Inventory Lookup screen.

Set to No, if you want to display the quick look code for the
tire size identified by the fitment guide on the Custom
Inventory Lookup screen.

Interface Labor PartNo Defines the part number used to add labor items retrieved from
Epicor to quotes and work orders.

Interface Parts PartNo Defines the part number used to add parts retrieved from Epicor to
quotes and work orders.

Inventory Cost Method
(FIFO, AVG, LIFO)

Defines which costing method to use (FIFO, AVG, or LIFO) as
your inventoriable costing method.

Note: Once you complete your first invoice, you will not be able
to change this setting. Consult with your accountant about
which costing method to use. For more information, see
Inventoriable Costing Methods on page 374.

Inventory Default
Category

Defines the default category for new inventory items.

Noninventory Vendor
Item

Identifies the nonstock item used to order items that you don't
carry from American Tire Distributors (ATD). This setting also
makes it possible for you to access Quick Quote information for
items distributed by ATD.

PO System - Re-Open
Ordered POs

Defines whether purchase orders for which ordering has already
occurred can be opened and edited.

Price Level Override -
Reset Price

Enforces price levels for items added to work orders via the Epicor
Integrated Service Estimator (ISE). Enabling the control ensures
that an item's price will reset to the amount defined by a
customer's price level, when a price change is attempted by a user
who is not assigned the price level override permission.

Reorder Reports -
Include Transfers

Defines whether to include transfer sales in the month-to-date,
year-to-date, and last-year totals on the Suggested Reorder
Report and the Inventory Reorder Report.

Shop Supplies (YES or Defines whether to include shop charges on work orders. If you
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NO) select Yes, a shop charge is calculated for every work order. If you
select No, the remaining shop supply settings are ignored.

Shop Supplies Amount
- Maximum

Defines the maximum dollar amount that can be charged for shop
supplies on each invoice.

Shop Supplies Amount
- Minimum

Defines the minimum dollar amount that can be charged for shop
supplies on each invoice.

Shop Supplies Item -
Part#

Defines which item to use as the shop supply item.

Shop Supplies Labor
Amount - Percentage
(%)

Defines the percentage used to calculate shop charges based on
labor prices. Shop charge amounts change each time you add
items to work orders.

Shop Supplies Parts
Amount - Percentage
(%)

Defines the percentage used to calculate shop charges based on
the parts prices. (For shop supplies, the parts price also includes
FET.) Shop charge amounts change each time you add items to
work orders.

Shop Supplies Service
Checklist

Defines whether shop supplies are included on the service
checklist (Quote and Estimate Writer screen) when items are
retrieved from the Epicor Integrated Service Estimator (ISE).

Show Price Level
Question

Defines whether to display the Show Price Levels check box on
the Inventory List.

Show Price Levels Defines whether to display A–E price levels and the best prices for
items on the Inventory List.

Note: Depending on how this control and Show Price Level
Question are set, A–E prices and best prices are
displayed all of the time, some of the time, or never. For
more information, see Show and Hide A–E Prices on page
428.

Show
Recalculate/Update EDL
Message

Defines whether a confirmation message appears when the price
of a single item is being recalculated. For more information, see
Recalculate Prices for Individual Items on page 391.
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Track Cores Enables the Core Manager.

Use Next FET for
POS/Receivings

Defines whether the next FET is used for items put on purchase
orders, receiving documents, quotes, or work orders.

Set to Yes to use an item’s next FET. An item’s next FET is
the system-calculated average of the various FET amounts
entered when receiving that item.

Set to No to use the FET from an item’s last receiving.

Note: This setting also determines whether an item’s next FET
or last FET is added to the cost displayed in the GM
Viewer. For more information, see GM Viewer Cost
Options on page 1212.

OTHER CONTROLS

Item Description

Activate Employee
Payroll Field

Defines whether the Payroll field on the Employee/User Edit
screen can be used to store data that can be accessed by third
party applications.

Apply Sales Tax to
FET

Defines whether federal excise tax is included when calculating the
sales tax for an invoice:

Set to Yes to calculate the sales tax based on parts prices,
labor prices, and FET. This control is set to Yes by default.
Set to No to exclude FET from sales tax calculations.

AR/AP Lookup Date Lets you limit the number of documents retrieved when looking up
customer and vendor history by date. Only documents completed
after the selected date will be displayed on the Ledger/History
tabs for both the Customer Maintenance and Vendor Maintenance
screens.

Example: If you set the control date to 1/1/2021, only doc-
uments completed between 1/1/2021 and the present are dis-
played.

ASN Manager Defines whether the ASNManager for the Bridgestone Electronic
Inventory Replenishment Interface is active on your TireMaster
system.

Table B-6: TireMaster's Other Controls
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ATW Interface Defines whether the Around the Wheel integration has been
installed on your TireMaster system.

Cash Disbursement
Vendor/Customer

Defines the default vendor to use for tracking the history of cash
paid out of the till.

Tip: To exclude this vendor from vendor reports and regular
vendor searches, set it to inactive.

Cash Drawer - Open
for Credit Card

Defines whether your cash drawers will open when a credit card
transaction is completed.

Checklist - Append to
Comments

Defines whether to include notes about recommended services on
invoices.

Checklist - Include
Add-Ons for
Inspection Areas

Defines whether add-ons are automatically included with service
checklist inspection areas (when you’re setting up service
checklists) and on the Quotes and Estimate Writer screen.

Checklist - Mileage
Threshold

Defines a range at which mileage-based services are automatically
recommended to customers.

Example: If you set the threshold to 1000 and defined that
spark plugs should be checked at 30,000 miles, the check spark
plug service will be recommended when the mileage falls
between 29,000 and 31,000 miles.

Checklist - View All Defines whether all service checklists are available to a site or if
users at that site can access only the checklists created there. This
setting is for TireMaster Corporate systems only.

Checklist - View Status Defines which inspection areas to display when different service
checklists were used for previous vehicle inspections:

Set to 1 to display inspection areas from another checklist
with the status of 1, 2, or 3.

Set to 2 to display only inspection areas from another
checklist with the status of 2 or 3.

Set to 3 to display only inspection areas from another
checklist with the status of 3.

How this control works depends on the following:

It affects stores that use multiple checklists (such as one for
retail and another for fleets).
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It affects TireMaster Corporate systems in which the
checklists used by each of the sites vary.

Note: Disregard this setting if only one service checklist is used by
everyone.

Days for Saving Text
Messages

Defines the number of days text messages are visible in text history
before being automatically deleted.

DOT Interface -
Enabled

Defines whether the DOT interface for recording tire identification
numbers appears at point of sale.

DOT Interface - Entry
Bypass

Defines whether recording tire identification numbers is required to
complete invoices:

Set to Yes to let users complete invoices without tire
identification numbers.

Set to No to require users to enter tire identification numbers.
Note: When DOT Interface - Enabled is set to No, set this

control to No as well.

DOT Interface - Print Defines whether registration certificates for the Tire Pros Tire
Protection Plan can be printed at point of sale. When the control is
enabled, the Print button on the DOT Interface screen is active and
you can add tire serial numbers and buyer, seller, tire, and vehicle
information to preprinted registration certificate forms.

DVI Company ID Lists the identification code the Digital Vehicle Inspection App uses
to identify ASA.

DVI Location ID Lists the identification code the Digital Vehicle Inspection App uses
to identify your business.

Enforce BAR for
Quotes

Defines whether changes to quotes require a BAR change entry.

Enforce BAR for Work
Orders

Defines whether changes to work orders require a BAR change
entry.

Force in Mileage Defines whether to require a mileage entry when starting a work
order and completing an invoice.

Note: Forcing mileage applies only when a vehicle has been
selected for a work order.

Force Mechanics Defines whether salesperson and mechanic information is required
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on invoices:

Set to Yes to require the information for each item before the
invoice can be completed.

Set to No to remind users to enter this information.

Force Option Cost
Required

Defines whether entering the actual cost for noninventoriable items
is required:

Set to Yes to require users to enter the cost before invoices
can be completed.

Note: When this control is set to Yes, TireMaster prevents
users from entering a cost of $0.00.

Set to No to display a warning and let users complete
invoices anyway.

Force PO System to
Create New PO

Defines whether purchase orders must be created before users can
create receiving documents:

Set to Yes to require users to create new purchase orders
before items can be received.

Set to No to let users create new receiving documents
instead of starting with purchase orders.

Note: Regardless of how this control is set, users can still create
receiving documents for returning items to vendors.

GM Viewer Cost
Options

Defines whether an item’s next cost or last cost should be displayed
in the GM Viewer and whether FET should be added to that cost.
The options for this control include the following:

1 LstCost displays the item’s last cost only.
2 LstCost + FET displays the total of the item’s last cost and
its FET.

3 NxtCost displays the item’s next cost only.
4 NxtCost + FET displays the total of the item’s next cost
and its FET.

Note: If the control Use Next FET for POS/Receivings tab is set
to Yes (on the Inventory tab), the item’s next FET will be
added to the cost. Otherwise, the last FET will be used
instead.

Grid Control - Limit 1 Defines how many historical documents (also referred to as
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Item Description

records) are displayed when selecting a corresponding radio button
that’s on the Inventory Maintenance screen’s History tab.

Example: If you wanted to display 30 documents when the but-
ton is selected, you’d set this control to 30.

Grid Control - Limit 2 Defines how many historical documents are displayed in the
following scenarios:

When a corresponding radio button is selected on the
Inventory Maintenance screen’s History tab.

Example: If you wanted to display 90 documents when the
button is selected, you’d set this control to 90.

When viewing a list of documents on the PO System screen.

Example: If the control is set to 90, a maximum of 90
purchase orders, receiving documents, or historical vendor
invoices will be displayed until you click Filter Off.

Invoice - Print Header Defines whether to print company information on invoices.

Note: If you use preprinted invoice paper, Select No.

Invoice - Print
Signature Line

Defines whether to print signature lines at the bottom of invoices
and work orders.

Note: If you use preprinted invoice paper, Select No.

Log Files - Delete
Previous Months

Defines whether to delete the previous month’s log files. These log
files are used along with your backups to restore data.

Log Files - Path to
Back Up

Not used.

Option Cost - Create
RD Default

Defines whether the Put item on a receiving document check
box is selected by default on the Option Cost screen.

Note: To force users to always put option cost items (outside
purchases) on receiving documents, set this control to Yes
and assign the permissionOption Cost Change RD
Option.

PDF save copy to Defines whether to save PDF copies of original sale invoices,
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server ROAs, POs, receiving documents, vendor invoice documents, and
day end closing reports in a subfolder in the TireMaster program
directory. Available in TireMaster 9.4.0.

POS Message - Show
Below Cost Message

Defines whether a message appears at point of sale to let you know
that an item’s price is being changed to an amount that’s less than
its cost.

POS Messages -
Disable Mechanics Not
Assigned

Disables the message that prompts you to assign mechanics to the
items on a work order (only when the control Force Mechanics is
set to No).

POS Messages -
Disable Selling into
Negative Qtys

Disables the warning that an item’s available quantity will fall below
zero if it’s added to a work order.

Quote Module Enabled Defines whether the Quote and Estimate Writer can be accessed
and used to prepare quotes and estimates

Quotes - Default
Description

Defines the default description for quotes.

Quotes - Default Name Defines the default name for quotes.

Quotes - Default Qty Defines the default quantity for items that are added to quotes.

Quotes - Epicor Show
Part #

Defines whether supplier part numbers for items retrieved from the
Epicor Integrated Service Estimator (ISE) are added to the Size
field on service checklists (Quote and Estimate Writer screen) in
TireMaster. This control is used only by TireMaster systems that
are integrated with the ISE.

Quotes - Include Add-
Ons

Defines whether the total price for quotes includes add-on items by
default.

Quotes - Include Sales
Tax

Defines whether the total price for quotes includes sales tax by
default.

Quotes - Include Shop
Supplies

Defines whether the total price for quotes includes shop charges.

Note: The shop supplies amount is not shown as a line item on
the screen and on printed quotes. On the screen, it’s
displayed in the Shop field next to the authorized total. On
printouts, the shop supplies charge is included in the totals
at the bottom of the page.
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Quotes - Keep for (#)
of Days

Defines the default number of days before a quote expires. You can
override this default when saving a quote. You can delete expired
quotes as part of the month end closing process.

Quotes - Lowest
Margin Allowed

Defines the lowest margin you’re willing to earn for quoted items.

Note: Although margins are displayed as percentages on the
Quote and Estimate Writer, you need to enter the default
margin as a whole number for the system control. For
example, to earn at least a 25%margin, type 25.

Quotes - Print Add-
Ons

Defines whether add-on items are printed on hard copies of quotes.

Quotes - Print Header Defines whether to print your store’s name on quotes. The store
name is defined on the Site Identification Maintenance screen. (Go
to Setup > Sites.)

Quotes - Print total on
bottom

Defines whether the total for a quote prints in the lower-right corner
of the page. For good, better, best quotes, the amount is the sum of
all of the quotes.

Quotes - Require
Phone#

Defines whether a phone number is required to save quotes.

Quotes - Use Good/
Better/Best

Defines whether defines whether to automatically assign the labels
Good, Better, and Best to the first three items added to a
comparison quote.

Quotes - Use Tire
Brands

Defines whether product information for up to three items is
displayed across the top of the page. If your TireMaster system is
integrated with Tire Brands, this information includes product
images (when available).

Report Detail Shading Enables shading for reports and formatting for documents printed
on plain paper.

Reports - Header
(Company Name)

Defines your company name and an identifier (a street name, store
number, or some other unique piece of information).

Schedule - Automatic
Delete Days

Defines the number of days that expired appointments remain on
the Appointment List and the Appointment Calendar before they’re
automatically deleted.

Example: If you set the number of days to 3, an appointment for
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August 10 will remain on the list until August 13. On August 14, it
will be gone.

Note: Items on an expired appointment are included in the on
work order quantities until the appointment is deleted.

Shop Supplies Service
Checklist

Defines whether shop supplies are included on the service
checklist (Quote and Estimate Writer screen) when items are
retrieved from the Epicor Integrated Service Estimator. This control
is used only by TireMaster systems that are integrated with the
Epicor ISE.

Show AR AP check
box in Name
Lookup/Entry dialog

Defines whether to include the Both AP and AR checkbox on the
Name Lookup/Entry screen. Setting the control to Yes allows to you
to include vendors in customer searches and vice versa.

Signature Capture Defines whether the Signature Capture Interface is enabled. If you
haven’t installed the Signature Capture Interface, you can
disregard setting this control.

Site Number - Current Defines the site number for a store. This option should be set to 1
unless you have multiple stores.

Startup/IC Vendor Defines which vendor is used to document your startup accounts
payable balances and any inventory count adjustments.

Statement - Days After
Cutoff

Defines the number of days that need to pass before previously-
generated statements can be printed or emailed again. The
Statement Setup screen also includes a field for defining this value.

Statement - Print
Address

Defines whether to include your business address on statements.

Note: This control can also be set on Statement Setup screen.

Statement Cutoff or
Real-time

Defines whether statements are generated based on the most-
recent statement cutoff date or today’s date.

Note: This control can also be set on the Statement Setup screen
by selecting or clearing the Statement - Print from Cutoff
check box.

Surcharge -
Percentage

Defines your state's surcharge percentage rate for credit card
sales. Enter this value as a whole number.

Surcharge for CC - Defines the inventory item used to add credit card surcharges to
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Noninventory Item sale invoices.

Texting - Send
Automated
Appointment
Reminders

Defines whether appointment reminder text messages should be
sent to customers.

Texting - Send Thank
You Text at
Completion

Defines whether the TireMaster- Texting screen appears when
completing an invoice, so you can send a thank you text message
to customers at that time.

Tills - Number of Tills Defines the number of tills. You can have up to four tills.

Tills - Till #1 Starting
Float

Defines the starting till float amount for Till #1. If you use the same
float amount for each shift, you don’t need to change this setting as
part of your shift-end closing process.

Tills - Till # 2 Starting
Float

Defines the starting till float amount for Till #2. If you use the same
float amount for each shift, you don’t need to change this setting as
part of your shift-end closing process. If you do not have a second
till, disregard this entry.

Tills - Till #3 Starting
Float

Defines the starting till float amount for Till #3. If you use the same
float amount for each shift, you don’t need to change this setting as
part of your shift-end closing process. If you do not have a third till,
disregard this entry.

Tills - Till #4 Starting
Float

Defines the starting till float amount for Till #4. If you use the same
float amount for each shift, you don’t need to change this setting as
part of your shift-end closing process. If you do not have a fourth till,
disregard this entry.

TM Install - Auto
download location

Defines the location where installers are placed when they’re
automatically deployed as part of the nightly backup. These
installers can be for TireMaster or integrated tools, such as utilities
for processing payroll or national account sales.

Note: If no location is set, installers are automatically placed in the
apps folder in the TireMaster,QDSTM, or TMPOS
directory.

Use Embedded Fonts
in PDF

Defines whether font information used to create PDFs is included in
those documents when they’re emailed. The purpose of this setting
is to ensure that text in emailed documents is not distorted when
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those PDFs are opened on recipients’ computers.

Note: Setting this control to Yes results in larger PDF file sizes.

Validate Database Defines whether the nightly backup should check for data
corruption.

Note: If this control is not set, the database validation is enabled
by default.

Vehicle History - This
site only checked

Defines whether the Vehicle History screen's This Site Only
checkbox is selected by default. The checkbox is visible at stores in
TireMaster Corporate environments.

Work Orders - Default
Quantity

Defines a default quantity for items that are added to work orders.

Work Orders - Epicor
Auto Order

Defines whether to automatically place an order with a supplier,
when items are added to a work order. This control is used only by
TireMaster systems that are integrated with the Epicor ISE.

Note: When this control is set to Yes, the controlWork Orders -
Epicor View Order is typically set to No.

Work Orders - Epicor
Create Receiving
Document

Defines whether you want TireMaster to create receiving
documents for the items added to work orders via the Integrated
Service Estimator. This control is used only by TireMaster systems
that are integrated with the Epicor ISE.

Work Orders - Epicor
Show Part#

Defines whether you want to display supplier part numbers instead
of item sizes on work orders (both on screen and printed). This
control is used only by TireMaster systems that are integrated with
the Epicor ISE.

Work Orders - Epicor
View Order

Defines whether you want the ability to preview a pending order
and make changes before placing the order. Enabling this setting
also gives you the ability to associate items retrieved from the
Integrated Service Estimator with items in TireMaster at point of
sale. This control is used only by TireMaster systems that are
integrated with the Epicor ISE.

Work Orders - Fitment
Print Air Pressure

Defines whether to include air pressure values recommended by a
vehicle’s manufacturer in work order and invoice comments.

Work Orders - Fitment
Print TRQ

Defines whether to include torque values recommended by a
vehicle’s manufacturer in work order and invoice comments.
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Work Orders -
Mechanic Autofill

Defines how salesperson and mechanic assignments are handled
at point of sale (on the Invoice Entry screen):

When Yes is selected, the user ID entered in the top row of
the Sales,Mech 1, andMech 2 columns is automatically
entered in the remaining rows, regardless of whether user
IDs have already been entered in them.

When No is selected, the user ID entered in the top row of
the Sales,Mech 1, andMech 2 columns is not be entered in
any of the remaining rows. In this scenario, you need to enter
a user ID in each row manually.

When EMPTY is selected, the user ID entered in any row of
the Sales,Mech 1, andMech 2 columns is also
automatically entered in the remaining rows that have no
user IDs in them.

When BELOW is selected, the user ID entered in a row is
automatically entered in all of the rows below it.

Work Orders - NAGS
Sell Below Cost

Defines whether users are allowed to sell items to national account
and government support customers at prices that are below cost.

Work Orders - Print
Header

Defines whether to include your address and signature line on work
orders.

Work Orders - Print
Vehicle Spec

Defines whether the Print Vehicle Spec checkbox is selected by
default on the Work Order screen. When the checkbox is selected,
vehicle specs print on a separate sheet of paper when you print a
work order. Manufacturer vehicle specifications can be retrieved
from Epicor if the Integrated Service Estimator (ISE) is integrated
with your TireMaster system.

Work Orders - Print
When Deleting

Defines whether deleted work orders are printed:

Set to Yes to send deleted work orders directly to the printer
Set to No to display deleted work orders in the Report
Window. You can then decide whether to print them
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Work Orders - Require
Comments When
Deleting

Defines whether to print notes on deleted work orders that state the
reason for deleting them.

Work Orders -
Threshold Promised
Time Minutes

Defines when the promised time for work orders should turn yellow
on the OpenWork Order List (to indicate that the promised time is
approaching).

Example: If you want the promised time to turn yellow an hour
before it occurs, you’d select 60 minutes.

VENDOR CONTROLS

Item Description

AP Current Days Defines the number of days for displaying payments due on the AP
Payments screen.

Example: If AP Current Days is set to 10, the AP Payments screen
would show all the payments that are due within 10 days.

Days between
check run

Defines how many days typically separate payments to vendors. This
setting enables TireMaster to estimate the next check run date for the
Cash Requirements Report.

Default AP
Discount #Days /
Date

Defines the number of days or a day of the month for calculating early-
pay discounts.

Default AP
Discount (D=#Days
or T=Date)

Defines the discount scheduling option:
Set to D to apply the discount if the payment is made before the
number of days has passed.

Set to T to apply the discount if the payment is made on or before
the selected date.

Default AP
Discount
Percentage (%)

Defines the most commonly used percentage for calculating discounts.

Default AP Due
#Days/Date

Defines the number of days or a day of the month for due dates. This
setting is used for all new vendors, unless it’s changed in a vendor’s

Table B-7: TireMaster's Vendor Controls
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payments terms. It is also used for aging balances, but not for
calculating finance charges.

Default AP Due
(D=#Days or
T=Date)

Defines payment due dates:

Set to D if payments are due a specific number of days after the
purchase.

Set to T for a specific day of the month.

Default Checking
Account

Lets you select a default bank account. This number corresponds to the
value in the Amount column of the Checking Account List.

Duplicate Ref
Number
Notification

Lets you define whether to display a message when a reference
number has already been used on a vendor charge, purchase order, or
receiving document for the selected vendor. If the control is enabled
and TireMaster detects a duplicate number, the message appears prior
to completing the vendor charge or pricing the order.

Note: For the message to appear, the new reference number must be
an exact match of the existing number. For example, 12345 is a
duplicate of 12345. However, 012345 is not.

Interfaces - Update
Vendor Part No

Defines whether the Goodyear and Firestone national account
integrations are allowed to automatically update the vendor part
numbers assigned to inventory items.

Misc. Vendor Defines a vendor for handling special charges.

Print Checks
Return to AP
Payments

Defines whether TireMaster automatically returns to or closes the AP
Payments screen after you print checks.

Require Reference
Number - Pricing
POs

Defines whether a reference number is required when you price an
order.

Require Reference
Number -
Receiving
Documents

Defines whether reference numbers are required on receiving
documents.

Vendor Default
Terms

Sets the default number of payments made to your vendors.

Vendor Default Defines the most commonly used vendor type.
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ZZ 3rd-Party
Vendor

Lets you look up and select a third-party vendor.



VALIDATION MESSAGES
When the data validation detects uncompleted settings, TireMaster displays errors, warnings, or both.
This appendix lists the troubleshooting messages that provide information to help you resolve setup
and configuration issues.

Resolve Validation Errors 1224
Resolve Validation Warnings 1226
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RESOLVE VALIDATION ERRORS
The following information describes errors generated during the validation process. You need to
complete the settings identified in validation errors.

Note: You can disregard validation messages referring to GL codes, general ledger accounts,
checking accounts, departments, reconciliation codes, the fiscal calendar, and TireMaster
Enterprise. These items pertain only to TireMaster Plus and TireMaster Corporate.

System Control Corporate checks the corporate-site control for TireMaster Corporate
systems. To change this setting, call ASA Support.

System Control: Enterprise checks the Enterprise setting. To change this setting, call ASA
Support.

System Control (GL): Default Department checks the default department setting in System
Controls. If the validation generates an error, make sure the department set in theGeneral
Ledger tab exists in the Department Listing screen.
System Control (GL): Default GL Class checks the default GL class setting in System
Controls. This option is set in the System Controls and cannot be changed.

System Control (Inventory): Inventory Cost Method checks whether an inventory costing
method has been set in the System Controls. If the validation generates an error, select a
costing method in the Inventory tab.
System Control (Vendor): Default Checking Account checks whether a default checking
account has been set. If the validation generates an error, make sure the checking account set
in the Vendor tab exists in the Checking Account List.
System Control (GL): Default Account - Cash checks the default general ledger account
setting for cash. If the validation generates an error, make sure the account set in theGeneral
ledger tab in System Controls exists in the chart of accounts.

System Control (GL): Default Account - Freight checks the default general ledger account
setting for freight. If the validation generates an error, make sure the account set in theGeneral
ledger tab in System Controls exists in the chart of accounts.

System Control (GL): Default Account - Sales Tax checks the default general ledger
account setting for sales tax. If the validation generates an error, make sure the account set in
theGeneral ledger tab in System Controls exists in the chart of accounts.

System Control (GL): Default Account - Fin Charge Income checks the default general
ledger account setting for finance charge income. If the validation generates an error, make sure
the account set in theGeneral ledger tab in System Controls exists in the chart of accounts.

System Control (GL): Default Account - Year-end Profit/Loss checks the default general
ledger account setting for year end profit or loss. If the validation generates an error, make sure
the account set in theGeneral ledger tab in System Controls exists in the chart of accounts.



Resolve Validation Errors

System Control (GL): Default Account - Over & Short checks the default general ledger
account setting for posting overages and shortages. If the validation generates an error, make
sure the account set in theGeneral ledger tab in System Controls exists in the chart of
accounts.

System Control (GL): Default Account - Inventory Correction checks the default general
ledger account setting for rounding errors in inventory calculations. If the validation generates
an error, make sure the account set in theGeneral ledger tab in System Controls exists in the
chart of accounts.

System Control (GL): Default Account - Inventory Clearing Account checks the general
ledger account setting for the inventory clearing account. If the validation generates an error,
make sure the account number for your inventory clearing account has been set in theGeneral
ledger tab in System Controls. If this setting has been completed, then verify that the general
ledger account is valid.

System Control (GL): Default Account - FET Correction checks the default general ledger
account for FET rounding error corrections. If the validation generates an error, make sure the
account set in theGeneral ledger tab in System Controls exists in the chart of accounts.

System Control (GL): Startup Account - Accounts Receivable checks the default general
ledger account for the accounts receivable startup account. If the validation generates an error,
make sure the account set in theGeneral ledger tab in System Controls exists in the chart of
accounts.

System Control (GL): Startup Account - Accounts Payable checks the default general
ledger account for the accounts payable startup account. If the validation generates an error,
make sure the account set in theGeneral ledger tab in System Controls exists in the chart of
accounts.

System Control (GL): Startup Account - Inventory checks the default general ledger
account for the inventory startup account. If the validation generates an error, make sure the
account set in theGeneral ledger tab in System Controls exists in the chart of accounts.

System Control (Other): Startup/IC Vendor checks the vendor designated for documenting
startup accounts payable balances and any inventory count adjustments. If the validation
generates an error, make sure there is a vendor record for the vendor named in theOther tab in
System Controls.

General Ledger: Fiscal Calendar (Year and Period) checks the fiscal calendar for the current
date. If the validation generates an error, add the period with today’s date to the fiscal calendar.

System Control (Customer): Statement Cutoff Date - Most Recent checks whether the
date set for your last statement cutoff is valid. If the validation generates an error, define the date
when you last cut off statements. If you don’t generate customer statements, enter any date in
the past except the default date.
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Customer/Vendor Types: Type (GL Accounts and Dept) checks whether any customer and
vendor types are set up and if the settings used in those types are valid. If the validation
generates an error, make sure that you have at least one customer or vendor type set up and
that the GL accounts and departments used in it exist.

Customer/Vendor Maintenance: Customers/Vendors (Type) checks whether any
customers and vendors are set up and that the type assigned to them exists in the
Customer/Vendor Type List. If the validation generates an error, check customer and vendor
records to see whether an invalid customer or vendor type has been assigned.

System: System User Messages checks whether all user messages are present in the
system. If the validation generates an error, call ASA Support.

Inventory Maintenance: Inventory (GL Code) checks whether any inventory items are set up
and that the GL codes assigned to items are valid. If the validation generates an error, make
sure the GL codes assigned to items exist.

System Control (Enterprise): Interstore Offset - Major Account checks whether an
interstore offset account has been set for Enterprise systems. If the validation generates an
error, create an interstore offset account in the chart of accounts. Then define the number for the
new account in the Interstore Offset - Major Account field in the Enterprise tab in System
Controls.

System: GL Accounts in Use (Active Only) checks whether valid general ledger accounts
are used in program settings. If the validation indicates that a general ledger account is invalid or
does not exist, make sure the account is included in the chart of accounts and is marked as
active.

RESOLVE VALIDATION WARNINGS
The following information describes warnings generated during the validation process. You are not
required to complete the settings identified in validation warnings.

System Control (Inventory): Shop Supplies Item checks whether a shop supplies item has
been set in System Controls. If the validation generates a warning and you charge a shop
supplies fee, consider setting this control in the Inventory tab.
Setup: Inventory GL Codes (GL Accounts and Dept) checks whether any GL codes are set
up. To eliminate a warning, you might want to create at least one GL code.

Vendors: Nat’l Recon Codes (GL Accounts and Dept) checks whether any reconciliation
codes are set up. To eliminate a warning, create at least one reconciliation code.

Setup: Checking Accounts (GL Account) checks whether any checking accounts are set up.
To eliminate a warning, create at least one checking account.

Setup: Credit Cards (GL Account) checks whether any credit cards are set up. To eliminate a
warning, create at least one credit card.



Resolve Validation Warnings

Customer/Vendor Maintenance: Customers/Vendors (Type) checks whether any
customers and vendors are set up and that the type assigned to them exists in the
Customer/Vendor Type List. To eliminate a warning, create at least one customer and one
vendor.

Inventory Maintenance: Inventory (GL Code) checks whether any inventory items are set up
and that the GL codes assigned to items are valid. To eliminate a warning, add items to the
system.

System Control (Commission): Default Commission Matrix Code checks whether a default
commission matrix code has been set. If the validation generates a warning and you pay sales
commissions, make sure that a default matrix code is set in the Commission tab in System
Controls and that the code exists in the Commission Codes List.

System Control (Commission): Default Commission Type - Customer checks whether a
default customer commission type has been set. If the validation generates a warning and you
pay sales commissions, make sure that a default customer commission type code is set in the
Commission tab in System Controls and that the code exists in the Customer Commission
Types screen.

System Control (Commission): Default Employee Commission Matrix checks whether a
default commission matrix has been set. If the validation generates a warning and you pay sales
commissions, make sure that a default employee commission matrix is set in System Controls.

System Control (Commission): Default Commission Type - Inventory checks whether a
default inventory commission type has been set. If the validation generates a warning and you
pay sales commissions, make sure that a default inventory commission type code is set in the
Commission tab in System Controls and that the code exists in the Inventory Commission
Types screen.
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DOCUMENT TYPES
When transactions are completed, a variety of documents are produced in TireMaster. This appendix
provides information about each available document type.

DOCUMENT TYPE CODES
A document type code identifies the type of document that resulted from a transaction. In some areas
of TireMaster, the document type code is called a keymod or MOD. The document type code is
typically displayed to the left of the document number.

Item Description

Blank Normal sale invoice.

CC Credit card invoice.

Note: When a customer pays with a credit card, the charge posts to the
AR account for the credit card company (such as ZZ-
Visa/Mastercard). This type of sale is treated like a cash sale in the
customer’s history.

DC Disbursement of cash, in which money was taken from the till to pay for an
expense. In TireMaster, this kind of transaction is called a paidout.

Table D-1: Document Type Codes
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Item Description

DE Deposits entered at point of sale when customers made partial payments or
prepayments for items on layaway or special purchases.

EC Easy check or a check written in the check register (Check Reconciliation
Add screen).

FC Finance charge that was applied to a customer’s outstanding customer
balance before the statement cutoff.

GS Government support sale invoice.

IC Inventory correction in which an item’s quantity was adjusted.

IR Inventory return.

JE Journal entry that was created manually.

NA National account sale invoice.

PO A vendor charge that was created automatically by

completing (pricing) a purchase order or receiving document.

PY An amount paid to a vendor for either a purchase order or a manual vendor
charge.

RO A payment received on account (ROA) from a charge customer. Can also
be an early pay discount that was given to a charge customer.

SA Scheduled appointments.

ST Indicates that the amount of sales tax for an invoice has been adjusted.

TR Transfer sale invoice.

VC Vendor charge that was created manually.

VR Vendor return, in which an item on a purchase order was received and
priced at a negative quantity.

Note: This code was discontinued in TireMaster 6.0.2. Therefore, it will
appear in your vendor and inventory histories only if you started
using TireMaster before that release.

XX Either a customer’s beginning balance or a customer balance adjustment
(AR journal entry).



CASING MANAGER SETUP
RECOMMENDATIONS

ASA recommends that you add general ledger accounts, GL codes, inventory categories, and
inventory items (in that order) that will be used only by the Casing Manager. The benefit of these
settings is that they help to simply research and reconciliation of general ledger activity for the
retreading process. This appendix includes the following sections:

GL Accounts for the Casing Manager 1232
GL Codes for the Casing Manager 1233
Categories for the Casing Manager 1236
Inventory Items for the Casing Manager 1237
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GL ACCOUNTS FOR THE CASING MANAGER
The general ledger accounts for the Casing Manager include a set of inventory accounts, sales
accounts, and expense accounts.

Note: Depending on the structure of your chart of accounts, you might need to use account numbers,
names, or both that are different from the examples shown in this appendix.

CASING MANAGER INVENTORY ACCOUNTS
If you plan to use the Casing Manager, ASA recommends adding the following inventory accounts to
your chart of accounts.

Note: Depending on the structure of your chart of accounts, you might need to use account
numbers that are different from the examples shown below (Table E-1). For the Casing
Manager inventory accounts, ASA recommends using a major account number that falls
within the GL range for inventory accounts. To view your GL ranges, select Setup > GL
Ranges from the menu.

Major Minor Description Type

1220 100 Retread Inventory - Clearing Item Asset

1220 200 Retread Inventory - Casings

Note: If you’ll be classifying your casing item as
inventoriable, select the Inventory Item
check box on the GL Account Edit screen
when adding this account.

Asset

1220 300 Retread Inventory - Caps

Note: If you’ll be classifying your cap item as
inventoriable, select the Inventory Item
check box on the GL Account Edit screen
when adding this account.

Asset

1220 400 Retread Inventory - Repairs Asset

1220 500 Retread Inventory - Misc. Asset

Table E-1: Casing Manager Inventory Accounts

CASING MANAGER SALES ACCOUNTS
If you plan to use the Casing Manager, ASA recommends adding the following sales accounts to
your chart of accounts.

Note: Depending on the structure of your chart of accounts, you might need to use account
numbers that are different than the examples shown below (Table E-2.



GL Codes for the Casing Manager

Major Minor Description Type

4220 100 Retread Sales Income

4220 200 Retread Sales - Casings Income

4220 300 Retread Sales - Caps Income

4220 400 Retread Sales - Repairs Income

4220 500 Retread Sales - Misc. Income

Table E-2: Casing Manager Sales Accounts

CASING MANAGER EXPENSE ACCOUNTS
If you plan to use the Casing Manager, ASA recommends adding the following expense accounts to
your chart of accounts.

Note: Depending on the structure of your chart of accounts, you might need to use account
numbers that are different than the examples shown below (Table E-3).

Major Minor Description Type

5220 100 Retread Expense Expense

5220 200 Retread Expense - Casings Expense

5220 300 Retread Expense - Caps Expense

5220 400 Retread Expense - Repairs Expense

5220 500 Retread Expense - Misc. Expense

Table E-3: Casing Manager Expense Accounts

GL CODES FOR THE CASING MANAGER
Once you’ve established the general ledger accounts for the Casing Manager, set up five GL codes.
These GL codes will be assigned to the inventory items for tracking retread activity.

GL CODE RTRD
The purpose of the GL code RTRD is to define how the retread clearing item will post to the general
ledger. Use the following image (Figure E-1) as a guide to set up this GL code.
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Figure E-1: Settings for the GL Code RTRD

GL CODE RTCS
The purpose of the GL code RTCS is to define how the retread casing item will post to the general
ledger. Use the following image (Figure E-2) as a guide to set up this GL code.

Figure E-2: Settings for the GL Code RTCS

Note: If your retread casing item will be classified as inventoriable, select the Inventory check box
when setting up this GL code.

GL CODE RTCP
The purpose of the GL code RTCP is to define how the retread cap item will post to the general
ledger. Use the following image (Figure E-3) as a guide to set up this GL code.



GL Codes for the Casing Manager

Figure E-3: Settings for the GL Code RTCP

Note: If your retread cap item will be classified as inventoriable, select the Inventory check box
when setting up this GL code.

GL CODE RTRP
The purpose of the GL code RTRP is to define how the retread repair item will post to the general
ledger. Use the following image (Figure E-4) as a guide to set up this GL code.

Figure E-4: Settings for the GL Code RTRP

GL CODE RTMS
The purpose of the GL code RTMS is to define how the miscellaneous retread item will post to the
general ledger. Use the following image (Figure E-5) as a guide to set up this GL code.
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Figure E-5: Settings for the GL Code RTMS

CATEGORIES FOR THE CASING MANAGER
Before you set up the inventory items that will be used for tracking Casing Manager activity, create a
set of inventory categories that can be assigned to those items. The categories will affect how
information about the Casing Manager items is organized on reports.

CATEGORY RTCS
Use the following image (Figure E-6) as a guide to add the category RTCS to your TireMaster
system. This category will be assigned to the retread casing item.

Figure E-6: Settings for the Category RTCS

CATEGORY RTCP
Use the following image (Figure E-7) as a guide to add the category RTCP to your TireMaster
system. This category will be assigned to the retread cap item.



Inventory Items for the Casing Manager

Figure E-7: Settings for the Category RTCP

CATEGORY RTZZ
Use the following image (Figure E-8) as a guide to add the category RTZZ to your TireMaster
system. This category will be assigned to the retread clearing, repair, and miscellaneous items.

Figure E-8: Settings for the Category RTZZ

INVENTORY ITEMS FOR THE CASING MANAGER
When you set up the Casing Manager, you need to define which inventory items will be used to track
caps, casings, repairs, and other items consumed during the retreading process. The Casing Manager
setups also require a clearing item, which is used to make adjusting entries when finished retreads are
received.

CLEARING ITEM
Use the following image (Figure E-9) as a guide to add the retread clearing item to your TireMaster
system.
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Figure E-9: Casing Manager Clearing Item

CASING ITEM
Use the following image (Figure E-10) as a guide to add the retread casing item to your TireMaster
system.

Figure E-10: Casing Manager Casing Item

CAP ITEM
Use the following image (Figure E-11) as a guide to add the retread cap item to your TireMaster
system.



Inventory Items for the Casing Manager

Figure E-11: Casing Manager Cap Item

REPAIR ITEM
Use the following image (Figure E-12) as a guide to add the retread repair item to your TireMaster
system.

Figure E-12: Casing Manager Repair Item

MISCELLANEOUS ITEM
Use the following image (Figure E-13) as a guide to add the miscellaneous retread item to your
TireMaster system.
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Figure E-13: Casing Manager Miscellaneous Item
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tax levels 627
tax rate adjustments 648
tax rates 619
tax-exemption certificates 633
templates, commission matrix 903
types, customer commission 893
types, inventory commission 895
vendor charges, batches 746
vendor records 176
work orders 442

credit accounts 655
credit and debit card processing 808
credit card company

payments, recording 810
subledger accounts 814

Credit Card List for Date Range 1037
credit cards

codes, adding 816
customer type 814
payment reversals 711
prefixes 817
reversing invoices 810
sales 808
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setting up 813
credit customer color codes 109
credit limit

customers 81
vendors 186

credit memos 709
credit reconciliation overview 851
credits

applying to vendor accounts 756
reconciling vendor 851
unapplying in vendor subledgers 757

Custom Inventory Lookup screen
enabling 242
overview 239
properties 239
setting up 242

custom settings, financial statements 1179
customer

color codes 105
department method 695
list editing 72
statement email addresses 728

customer accounts
adjusting balances 707
finance charges 712, 730
outstanding items 705

Customer Balance by Current Date 1102
Customer Balance for Previous Period

Report 1103
Customer Balance Report 1105
Customer Balance Report by

Salesperson 1038
customer beginning balance utility 740
Customer Category List 1106
customer color codes

assigning 107
creating 105
deleting 107
overview 104
removing 108

updating 106
customer color codes, credit 109
customer commission types

adding 893
assigning 894
default setting 899
overview 893

Customer Contact List 1107
customer controls 1197
customer credit color codes 109
Customer Credit Report 1108
Customer GPM Report 1110
customer history

TireMaster Corporate 947
TireMaster DOS 111
TireMaster Lite 111

Customer History Report 1111
customer information

updating, multiple customers 72
updating, one customer 71

customer information tab 75
Customer List by Type 1113
Customer Maintenance screen

Aging tab 92
General tab 81
Information tab 93
Ledger/History tab 89
overview 81
ShipTo tab 89
Vehicle tab 87

Customer Master List 1114
Customer Overdue Balance Report 1115
Customer Overdue by Current Date 1117
customer payments

applying to invoices 702
multi-store systems 948
overview 700
processing 700
unapplying 704

Customer Recon Codes Report 1120
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customer refund checks 711
customer reports

AR Detail - by Customer 1098
Check History Report 1100
Customer Balance by Current Date 1102
Customer Balance for Previous

Period 1103
Customer Balance Report 1105
Customer Category List 1106
Customer Contact List 1107
Customer Credit Report 1108
Customer GPM Report 1110
Customer History Report 1111
Customer List by Type 1113
Customer Master List 1114
Customer Overdue Balance

Report 1115
Customer Overdue by Current

Date 1117
Customer Recon Codes Report 1120
Customer Sales Report 1121
overview 1098
Real-Time Statements 1124
Sent E-mail/Text List 1093
Unapplied Credit Report 1127
Unapplied Open Item Report 1129
Unpaid Finance Charge Report 1130
Vehicle 1131
Vehicle Expense Report 1132

Customer Sales Report 1121
customer statements 714
Customer tab, reports 1098
customer transactions, overview 442
customer turnaround 564
customer types

adding 99
assigning 101
credit card 814
default 100
deleting 102

interstore transfers 953
managing 102
overview 98
transfer sales 488
updating 101

customers
adding 66
adding, AR 68
adding, cash 66
additional information 75, 93
addresses, delivery 74
addresses, shipping 74
A-E price level assignments 428
aging balances 730
aging information 92
beginning balances, entering 738
beginning balances, overview 738
color codes 104, 106
combining records 75
contact information 81
credit card company 814
credit limit 81
deleting 81
finding 93
government support 841
history 89
history, multi-store systems 947
inactive 80
looking up 93
maintaining 66
managing in multi-store systems 946
national account 833
open item ledger 705
payment settings 81
payment terms, overview 94
payment terms, setting 97
price level assignments 421
reimbursement overview 710
searches 93
separating records 79
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settings, multi-store systems 947
subledger 89
tax level assignments 631
tax settings 81
tax settings overview 640
text messages 140
TireMaster Corporate 947
uncombining 79
vehicle listing 87

customizable menu overview 28
cut off, month end 975
cutting off, customer statements 730

D
daily backups 6
Daily Invoice Report 1175
Daily Sales Report 1175
Daily Till Detail Report 1175
daily till totals 970
Daily Transaction Report 1039
Dashboard

setting goals 982
viewing 984

data archive 7-8
data backups 5
Data validation 3
databases

maintaining 3
shared 943
validating 3

Day End Close screen 970
day end closing

overages and shortages 970
overview 969
procedures 969

Day End Comparison Report 1040
Day End Daily Sales Report 1041
Day End Daily Till Detail 1043

day end reports
Day End Comparison Report 1040
Day End Daily Sales Report 1041
Day End Daily Till Detail 1043
Day End Transaction Report 1045

Day End Till Totals Report 1044
Day End Transaction Report 1045, 1175
debit accounts 655
debit card

sales 808
setting up 817

declined services
follow-ups 538
postcards 605

declined services postcards 606
Declined Services Report 1047
default

account, checking 1221
accounts, general ledger 661, 1203
AP discount settings 197
AR discount settings 1198
checking account, setting 765
code, commission matrix 899
code, GL 354, 1204
commission matrix code 1196
department 694, 1204
GL class 685, 1204
GL Ranges 664
inventory category 342, 1207
service checklist 539
tax levels 632, 1197-1198
terms, customer 94
till float 1217
type, customer 100, 1197
type, customer commission 895, 1196
type, inventory commission 897, 899,

1196
type, vendor 1221
types, commission 899
vendor discount settings 1220, 1220
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vendor payment terms 197
default vendor type, setting 195
defective casings 916
defining

mechanics 564
number of tills 964
recommended service mileage 548
statement delivery method 726
statement print options 722
till floats 964
workstation till number 965

Deleted Work Orders 1048
deleting

accounts, general ledger 663
appointments 581
bank accounts 767
bays 566
checking accounts 767
codes, add-on 256
codes, customer color 107
codes, GL 356
codes, manufacturer 347
codes, reconciliation 825
codes, spiff 888
contact types 160
customer e-mail addresses 168
customer phone numbers 168
customers 81
estimates 529
expired appointments 566
financial statement account groups 43
GL classes 685
inventory categories 343
inventory groups 346
inventory items 219
inventory tax adjustment groups 646
job types 566
menu assignments 33
postcard filters 604
price matrix 437

Pricing Wizard Configurations 409
purchase order items 264
purchase orders 273
quotes 529
quotes, expired 974
savings accounts 767
service checklists 546
tax rates 627
types, customer 102
types, vendor 197
uncompleted core charges 936
vehicles 119
vendor charge batches 752
vendor email addresses 168
vendor phone numbers 168
vendors 186
work order statuses 587
work orders 454

delivery addresses 74
delivery method for statements 726
department methods

customer 695
inventory 696
overview 694

departments
adding 693
changing at point of sale 697
maintaining 692
overview 692
renaming 697

deposits
bank account 770
point of sale overview 470
processing at point of sale 471
refunding point of sale 472
setups for point of sale 470

designing
financial statements 41
GL codes 351
income statements, detailed 683
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invoices 40
service checklists 539
statements 719, 722
work orders 40

dimensions
label 613
postcards 592

Direct Deposit 1049
disabling GL ranges 666
Discontinued Inventory List 989
discontinued items 218
discounts

overview 365
setting up 365

document email
body text 148
overview 151
subject lines 148

document searches 678
document type codes 1229
document types, printer selection 37
documents

designing 40
emailing historical invoices 153
emailing newly-completed 151
setting up 38

DOT Interface
CIMS registration 559
defining availability 559
enabling and disabling 559
overview 558
protection plan certificates 560
recording DOT numbers 560
setting up 558
tire category settings 558

down-arrow lookup method
settings 242
using 9

dual casing credits 924
duplicate statements 735

E
Easy Check Detail Report 1175
easy checks

AP 780
AR 782
detail report 1175
miscellaneous (other) 784
overview 780
writing miscellaneous 784

editing
support requests 19
tax rates 622

EDL, setting 386
email

overview 151
server setups 148
statement configuration 724
support requests 18

email addresses
adding for customers 161
adding for vendors 161
deleting for customers 168
deleting for vendors 168
updating for customers 164
updating for vendors 164

email, statements 731
emailing documents

historical invoices 153
newly completed 151

employee commission matrix, setting
up 901

Employee Customer Type List 1050
employee email addresses 148
Employee/User Edit screen 46
Employee/User List 1051
employees

user accounts, adding 48
user accounts, inactivating 52
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enabling
Custom Inventory Lookup screen 242
item tracking 298

enhancement requests 25
entering

bar codes on purchase orders 350
bar codes on quotes 350
bar codes on receiving documents 350
bar codes on work orders 350
bar codes, overview 350
customer balances 738
customer beginning balances 738
option cost 380
vendor invoices 744
work times for others 869
work times for yourself 867
work times manually 872

Enterprise System Controls 1202
Epicor Integrated Service Estimator 524
equity accounts

creating 658
definition 654

errors, validation 5, 1224
estimates

customer follow-ups 538
deleting 529
Integrated Service Estimator 524
preparing 522
preparing with ISE 524
printing 528
retrieving 526
turn into work orders 536
unlocking 529
updating 527

everyday low price settings 395
examples, tax rates and levels 618
EXE version 13
expense accounts

Casing Manager 1233
creating 660

definition 654
expense costing method 375
expense method items

returns, tracked 483
returns, untracked 485

expenses, paying from the till 966
expired

quotes 974
tax rates and levels 633

expired appointments, deleting 566
exporting reports 1178
External History

TireMaster DOS customer 111
TireMaster DOS vehicle 112
TireMaster Lite customer 111
TireMaster Lite Vehicle 112

External History Viewer 111

F
F keys 8
factor based prices

margins 388
markups 387
overview 387
recalculating 391

factors
assigning to group of items 389
updating 404

federal excise tax
excluding from sales tax 639
handling cost 327
settings 395

fees
charged by banks 772
overview 366
retread services 918
returned checks 789
setting up 366

FET cost, handling 327
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FIFO 374
filters

created on-the-fly 599
customer 599
mailing labels 613
managing postcard 599
mileage 599
postcard 599
product 599
reusable 599
sales 599
selecting reusable 608
updating 603

Finance Charge Edit Report 1175
finance charges

applying to customer accounts 712, 730
report 1175
reversing 712

financial statement account groups
deleting 43
updating 42

financial statements
custom settings 1179
designing 41
inactivating settings 1181

finding
customers 93
inventory items 9
vendors 193

first in, first out costing method 374
fiscal calendar

changing 687
overview 686
setting up 686
short year 687
updating 686

fiscal periods
closing 972
locking 975

fitment guide
F7 access 552
inventory lookup settings 554
overview 552
quote access 553
recommended air pressure 555
recommended torque 555
screen overview 556
staggered fitments 554
work order access 553

fixed prices, setting 386
flat rates

calculating productivity 883
overview 882
setting for items 882

follow-ups, quotes 532
former employee user accounts 52
forms

preprinted 38
text length 38

front tire size 554
function keys 8

G
gas items

linking 362
viewing links 364

Gas Link Maintenance screen 361
gas links

breaking 364
overview 361
settings 361

gasoline
adding to work orders 364
overview 361
selling 364
setting up 361

general ledger
account list 654
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account numbers 654
entries 666
system controls 1203

general ledger accounts
credit 655
debit 655
default settings 661
deleting 663
inactivating 662
inventory clearing 329
sales tax rounding 638
types 654

general ledger reports
AR or AP Aging 1134
AR or AP Payments 1136
Balance Sheet 1138, 1140
Chart of Accounts Listing 1141
Check Reconciliation 1142
Check Register Report 1144
closing 977
GL Inactive Account Detail 1146
GL Summary 1147
GL Temp Report 1149
GL Transaction Details 1150
Income Statement 1151
Income Statement Summary 1153
Interstore Balance Report 1154
Long Form 1155
overview 1134
Short Form 1157
Trial Balance 1158

generating
AP Payment checks 753
customer statements 714
duplicate statements 735
mass mailing postcards 608
Time Clock Report 880

generic postcards 611
GL accounts

debit 655

inventory clearing 329
GL accounts for Casing Manager 1232
GL classes

adding 684
creating 684
default 685
deleting 685
overview 682
setting up 684

GL codes
adding 353
Casing Manager 1233
default 354
deleting 356
designing 351
overview 350
report 1176
retread cap 1234
retread casing 1234
retread clearing 1233
retread miscellaneous 1235
retread repairs 1235
updating 355

GL Codes Report 1176
GL Inactive Account Detail 1146
GL ranges

default 664
disabling 666
overview 664
updating 665

GL settings 352, 356
GL Summary 1147
GL tab, reports 1134
GL Temp Report 1149
GL Transaction Details 1150
GL Transaction View List 1176
GL Transaction View screen 679
global messages, creating 43
global price levels, using 421
GM Viewer 450
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good, better, best quotes 506
government support customers

adding 841
price levels 846

Government Support Invoices 1052
government support sales

example 839
overview 838
requirements 839

gross profit
invoices 982
work orders 982

group user accounts 50
groups

inventory 340, 344
security 54

GS & Adjustment Checkup Report 1053
guidelines, printer selection 37

H
handling

FET cost 327
interstore balances 962
overages, day end close 970
returned checks 786
shortages, day end close 970

historical document searches 678
historical ledger

customers 89
vendors 190

Historical Option Cost Sales 1053
Historical Qty Adjustment Report 990
Historical Sales 1054
Historical Sales by Zip Code 1056
history

customer 89
items, overview 244
text messages 146
vendor 190

hot keys 8
hours worked list 880
hours worked, calculating 883

I
inactivating

customers 75
general ledger accounts 662
tax rate adjustments 651
user accounts 52
vendors 181

inactive
customers 80
items 218
postcards 598
predefined text messages 136
reconciliation codes 825
vehicles 119
vendors 185

income accounts
creating 659
definition 654

Income Statement 1151
Income Statement Summary 1153
income statements

detail, controlling 683
GL class effects 683
organizing 41-42

inspection areas
associating postcards 606
creating 540
updating 544

installing patches and updates 1
Integrated Service Estimator 524
Interstore Balance Report 1154
interstore offset account 962, 1202
interstore transfer clearing account 1202
interstore transfers

automatic receiving 956
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clearing 956
customer settings 955
customer type 953
GL accounts 952
invoices 955
overview 952
preparations 952
setting up customers for 955
site settings 955
system control settings 954
viewing site AP activity 958
viewing site AR activity 958

Interstore Trasfer Report 1176
inventoriable costing methods

average (AVG) 374
defined 374
first in, first out (FIFO) 374
last in, last out (LIFO) 374
setting 374
standard cost 383

inventoriable items
overview 204
returning to vendors 329

inventory
adding 205
department method 696
history, overview 244
linking to photos 229
linking to web sites 229
multi-store systemmanagement 950
note settings 229
price settings 395
receiving from vendors 274
required settings 205
searches 230
specifications settings 229
system controls 1206
tax settings, overview 640
transfer receivings 490
transferring to other stores 488

updating 209
inventory accounts for Casing

Manager 1232
Inventory Add-On Codes 991
Inventory Bar Codes 992
Inventory Calculation Report 994
inventory categories

adding 340
deleting 343
overview 340
updating 342

Inventory Category List 995
inventory category, default 342
Inventory Check-Up Report 996
inventory clearing account 329
inventory commission types

adding 895
assigning 896
overview 895

Inventory Cost Listing Report 997
inventory cost settings 395
Inventory Counting Deck

printed from Quantity Adjustment
Wizard 247

printed from Report List 999
Inventory Counting Deck w/ QTY 999
inventory counts

overview 247
resetting 975

Inventory Flat Rate Report 1000
Inventory GL Code Detail 1001
Inventory GL Code List 1002
Inventory GL Code Maintenance

screen 352, 356
Inventory Group List 1003
inventory groups

adding 344
deleting 346
overview 340
updating 345
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inventory history
looking up 244, 246
viewing, Inventory List 246
viewing, item records 244

inventory items
adding and receiving simultaneously 286
Casing Manager 1237
commission types 892
counting 249
gasoline 361
history 226
interstore transfers 952
looking up 9
ordering 262
product details 219
quantity and price information 225
reordering 271
resetting noninventoriable quantities 975

Inventory Label Report 1004
Inventory List

item history, accessing 246
layout, changing 243
overview 243
sorting items 243

Inventory List - Negative 1005
Inventory List - Not Zero 1006
Inventory List Editing 211
Inventory List Editing Report 1176
Inventory Listing by Manufacturer 1007
Inventory Maintenance Screen

General tab 219
History tab 226
overview 219
Qty/Pricing tab 225

Inventory Master List 1008
Inventory Min/Max Qty List 1009
Inventory Monthly Moving Report 1010
Inventory Moving Report 1011
Inventory Non-Inventory List 1013
Inventory Not Moving Report 1014

Inventory On Order Report 1016
Inventory Price Level Report 1017
inventory quantities, adjusting 249
Inventory Quantity Adjustment Wizard 249
inventory receipts 274
Inventory Reconciliation Report 1018
Inventory Reorder Report 1020
inventory reports

closing 979
Consignment Inventory 988
Discontinued Inventory List 989
Historical Qty Adjustment Report 990
Inventory Add-On Codes 991
Inventory Bar Codes 992
Inventory Calculation Report 994
Inventory Category List 995
Inventory Check-Up Report 996
Inventory Cost Listing 997
Inventory Counting Deck 999
Inventory Counting Deck w/ QTY 999
Inventory Flat Rate Report 1000
Inventory GL Code Detail 1001
Inventory GL Code List 1002
Inventory Group List 1003
Inventory Label 1004
Inventory List - Negative 1005
Inventory List - Not Zero 1006
Inventory Listing by Manufacturer 1007
Inventory Master List 1008
Inventory Min/Max Qty List 1009
Inventory Moving 1011
Inventory Non-Inventory List 1013
Inventory Not Moving Report 1014
Inventory On Order 1016
Inventory Price Level Report 1017
Inventory Reconciliation Report 1018
Inventory Reorder Report 1020
Inventory Slow Moving Report 1020
Inventory Spiff Report 1022
Inventory Value Report 1023
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Inventory Zero Cost & Zero Min
Report 1024

Items on Sale 1025
monthly moving 1010
overview 988
Price Level Reports 1026
Receiving History by Product

Report 1028
Vendor Part Number List 1029
Work Order Qty 1030

inventory returns
combined with receivings 335
inventoriable items 329
noninventoriable items 332
overview 328
process 328
tracking account 329

inventory searches
bar codes 235
item ranges 233
manufacturer codes 231
multiple codes 237
quick look codes 230
staggered fitment tires 236

Inventory Slow Moving Report 1020
Inventory Spiff Report 1022
Inventory tab, reports 988
Inventory Value Report 1023
inventory value, recalculating 974
Inventory Zero Cost & Zero Min

Report 1024
Invoice Averages by Date 1057
invoice completion text messages 144
Invoice Detail 1058
Invoice Entry screen 466
Invoice/Document Search screen 681
invoices

adjustment sale 849
changing departments at point of

sale 697
completing 456

global messages 43
government support sale 844
gross profit 982
interstore transfers 955
looking up 678
multi-store systems 948
national account sale 836
reusing 460
reversing 458
text length settings 38

invoicing controls, multi-store systems 948
invoicing core items 931
ISE estimates 524
issuing

casing credits 921
duel casing credits 924

item ranges, inventory searches 233
item tracking

expense method items 299
how it works 297
option cost items 300
overview 297
previously-received option cost 302
relief percent items 299
setup 298
unknown receiving document 299
verify returns 309

Item Tracking Report 1176
Item Tracking screen 317
items

adding and receiving simultaneously 286
add-on codes, removing 258
A-E price assignments 423-424
assigning add-on codes 259
assigning price matrix 437
associating with add-on codes 256
consignment 360
core cost assignments 938
deleting 219
discontinuing 218
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history, overview 244
inventoriable 204
looking up 230
make inactive, automatically 218
make inactive, manually 218
noninventoriable 204
nonstock 204
ordering 262
price matrix assignments 437-438
putting on sale 404
receiving from vendors 274
stock 204
updating individual 210
updating multiple 211
upselling 252

Items on Sale Report 1025

J
JE Edit Report 1176
job status 587
job type list, setting up 565
job types, deleting 566
journal entries

AR 707
looking up 675
manual 667
multi-store systems 961
overview 666
recurring 668
researching 675
reversing 672
TireMaster Corporate 961
viewing 675

Journal Entries screen 673

K
keymod 1229
keys, function 8

L
labels

dimensions 613
mailing 612
printing 613

last in, first out costing method (LIFO) 374
ledgers

customer 89
vendor 190

liability accounts
creating 657
definition 654

LIFO 374
linking gas items 362
list editing

customer 72
inventory 211

List Editing Report 72, 1176
list of sent emails 155
lists

permissions 1185
reports 987

local users, multi-store systems 944
locked quotes 529
locking

fiscal periods 975
month 975

locking commissions 1035
logging in, TireMaster 8
logins, overview 46
logos, statements 719
Long Form 1155
looking up

customers 93
documents, transaction 678
estimates 526
historical vendor invoices 290
history, inventory 244, 246
history, TireMaster DOS customer 111
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history, TireMaster DOS vehicle 112
history, TireMaster Lite customer 111
history, TireMaster Lite vehicle 112
history, vehicle 121
inventory items 230
journal entries 675
purchase history 290
quotes 526
staggered tire fitments 554
tire sizes at point of sale 553
tire sizes with fitment guide 552
vehicles with CARFAX 122
vendors 193
wheel information 552

M
mailing labels 612-613
mailings

mass 608
point of sale 605

maintaining
customers 66
departments 692

making
bank account deposits 770
journal entries, manual 667
sales tax adjustments 635
vendors inactive 185

making active, predefined text
messages 138

making inactive
GL accounts 662
predefined text messages 136

managing
bank activity 767
core charges 932
customer turnaround 564
customer types 102
items 205
postcard filters 599

postcards 592
quotes and estimates 526
service checklists 538
tills 964
vendor records 186

manual backups 6
manual journal entries 667
manufacturer codes

adding 346
deleting 347
inventory searches 231
updating 347

margins
adjusting on quotes 515
calculating 388
recalculating 391
settings 395

Marketing Module
active postcards 598
associating invoices 605
blank postcards 611
creating filters 599
declined services 605-606
deleting filters 604
inactive postcards 598
label dimensions 613
laying out postcards 592
making labels 612
mass mailing postcards 608
modifying postcards 596
point of sale mailings 605
point of sale postcards 607
printing labels 613
target mailings 608
text files 612, 614
updating filters 603

marking pending voids 777
markups

calculating 387
recalculating 391
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settings 395
maximum stocking levels, Pricing

Wizard 215
Mechanic Flat Rate Report 1059
mechanic productivity, calculating 883
Mechanic Report 1061
mechanics

defining for Scheduler 564
rescheduling appointments 576

menus
adding 28
assigning 32
deleting 31
deleting assignments 33
setup overview 27-28, 30
updating 30

merchant fees 810
merging

customer records 75
vendor records 181
zip codes 10

message center 3
messages, validation 4
mileage

intervals 599
threshold 547

mileage based services
indicating mileage 548
overview 547
recommended service range 547

minimum stocking levels, Pricing
Wizard 215

miscellaneous
expenses 966

miscellaneous easy checks 784
miscellaneous item, Casing Manager 1239
month end

backups 7
cutoff 218
lock 975

procedures 972
moving

Inventory List columns 243
OpenWork Order List columns 465
table columns 10

multiple codes, inventory searches 237
multi-store systems

accounting 961
adding items 950
AR and AP subledgers 958
AR/AP check box control 958
background colors 943
cleraing interstore transfers 956
customer management 946
customer type, interstore transfer 953
interstore offset account 962
interstore transfer accounts 952
interstore transfer controls 954
interstore transfer customer setups 955
interstore transfer invoices 955
interstore transfer receiving 956
inventory controls 950
inventory management 950
invoices 948
invoicing controls 948
item settings 950
journal entries 961
point of sale 948
pricing items 950, 960
purchase orders 960
purchasing 959
purchasing controls 959
quantities, other sites 951
quantity information controls 951
quotes 948
receiving inventory 960
replication 942
ROAs 948
shared databases 943
site access 944
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site access restrictions 945
statement origination sites 947
transferring inventory between sites 952
user account setup 943
user accounts 943
user logins 945
vendor charges 949
vendor credit processing 949
vendor payments 949
vendor settings 949
work orders 948

myCARFAX registration 123

N
naming tax rates 621
National Account Invoices 1063
National Account Recon. Report 855, 1064
national account sales

commission adjustments 856
customer price levels 838
customers 833
example 831
not selling at cost 838
process 830
requirements 831

national accounts
credits 855

National Credits screen 853
National Recon Code Edit screen 827
National Sales Commission List 857-858
Negative Option Cost Totals 1065
negative vendor charge 744
new feature requests 25
noninventoriable costing methods

defined 375
expense method 375
option cost method 378
relief percent method 377

noninventoriable items
overview 204
resetting counts 975
returning to vendors 332

noninventoriable returns, verifying 309
NonInventory Sales 1066
nonstock items 204
normal sale work orders 442
Notes Tab, Inventory Maintenance 229
notifications 3
NSF checks

bank fees 791
charging customers fees 789
overview 786
recording in register 786

Null Salesperson Report 1067

O
oil change

item setups 371
items examples 372
work orders 446

Open Item Ledger screen 705
open item ledger, applying payments 702
open item ledger, vendor 760
Open Quote Report 1067
OpenWork Order - Item List 1069
OpenWork Order - Qty 1070
OpenWork Order Deposits 1070
OpenWork Order List

changing layout 465
overview 462
properties 462
sorting 465

OpenWork Order Report 1071
open-item ledger, customer 705
operation, Pricing Wizard 402
option cost

entering 380
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forcing 380
method 378

option cost item returns, untracked 479
ordering contact information

globally 169
individually 170

ordering items 262
organizing

balance sheets 41-42
income statements 41-42

organizing contact information 169
other (miscellaneous) controls 1209
other easy checks 784
outgoing server setups 148
outside purchases

overview 322
performing 323
requirements 322
tracked items 323
untracked items 325

outstanding items on customer
accounts 705

Over Short Report 1072
owner

security group 54
user accounts 50

owner’s equity accounts, defined 654

P
PaidOut List for Date Range 1073
Paidout Report 1177
paidouts 966
parent items 259
passwords, multi-store systems 944
passwords, user account 51
patches, TireMaster 1
paying

miscellaneous expenses 966
paying vendors 753

payment accounts
adding 764
overview 764
updating 766

Payment Detail Report 1177
Payment Editing screen 760
payment settings for customers 81
payment terms

customer 94, 97
customer default 94
default vendor 197
vendor 199
vendors 197

payments
applying to vendor accounts 756
check writing 767
credit card 808
debit cards 808
electronic 767
multi-store ROAs 948
voiding AP 797
voiding, check register 799

pending voids 777
per unit cost calculation 267
performing the day-end close 969
permissions

assigning 55
list 1185
overriding 63
removing assignments 62
viewing assignments 60

phone numbers
adding for customers 161
adding for vendors 161
deleting for customers 168
deleting for vendors 168
updating for customers 164
updating for vendors 164

physical counts 247
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overview 700
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commission matrix templates 903
core tracking 931
cost replacement codes 381
costing method, expense 375
costing method, option cost 378
costing method, relief percent 377
costing method, standard cost 383
credit cards 813
Custom Inventory Lookup screen 242
customers, AR 68
customers, cash 66
debit cards 817
departments 693
departments by customer 695
departments by inventory 696
discounts 365
documents 38
DOT Interface 558



Index

email body text 148
email outgoing servers 148
email subject lines 148
employee email addresses 148
fees 366
gas links 362
GL classes 684
global messages 43
groups, inventory 344
groups, inventory tax-adjustment 643
inspection areas 540
interstore transfers 952
inventory categories 340
item tracking 298
items, consignment 360
items, gasoline 361
items, inventory 205
job type list 565
journal entries, recurring 668
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overview 366
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overview 690
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GL code settings 352, 356
setting up 383
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quotes 515
TireMaster 8
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cut off 730
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generating 714
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properties 715
real-time 1124
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status indicator for work orders 587
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assigning, Pricing Wizard 215
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overview 643
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overview 633
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overview 627
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AR/AP check box control 958
background colors 943
clearing interstore transfers 956
customer history 947
customer management 946
customer payments 948
customer settings 947
customer type, interstore transfer 953
instore transfer controls 954
interstore offset account 962
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point of sale 948
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cost 302
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processing credits 933
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control settings 488
overview 488
performing 490
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money to another bank account 775
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Trial Balance 1158
troubleshooting tips 12
turnaround, customer 564
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types
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ROAs 704
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Casing Manager Report 1174
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Check Edit Report 1174
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GL Codes Report 1176
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JE Edit Report 1176
List Editing Report 1176
overview 1174
Paidout Report 1177
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Pricing Wizard Report 1177
Security Assignments Report 1177
Service Checklist 1177
Suggested Reorder Report 1177
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estimates 527
factor for multiple items 389
factors 404
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fiscal calendar 686
GL codes 355
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inspection areas 544
inventory categories 342
inventory groups 345
inventory items, multiple 211
inventory items, single 210
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inventory tax adjustment groups 645
item core costs 938
item settings 399
items, add-on 258
job type settings 566
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payment accounts 766
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postcard filters 603
postcard settings 596
predefined text messages 135
price matrix 404, 434
prices with matrix 440
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primary contact method 172
purchase orders, open 266
purchase orders, reopened 269
quotes 527
sales report options 1183
sales tax rates 623
savings accounts 766
selling prices 399
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stocking levels 404
tax levels 630
tax rate adjustments 650
TireMaster 1
vehicle information 116
vendor charge batches 749
vendor email addresses 164
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work orders 451
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upselling items 252
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adding 48
adding multi-store 943
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making active 52
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overview 46
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TireMaster Corporate 943
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reviewing 60
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using global price levels 421
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overview 517
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deleting 119
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managing 115
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system controls 1220
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deleting 752
overview 746

retrieving 748
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TireMaster Corporate 949
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TireMaster Corporate 949
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overview 744
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overview 186
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Vendor Part Number List 1029
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overview 1159
Vendor 1099 Report 1161
Vendor Activity Report 1171
Vendor Balance Report 1163
Vendor Contact List 1165
Vendor History Report 1166
Vendor Master List 1167
Vendor Payment History Report 1168
Vendor Statement Report 1172

vendor returns
combining with receivings 335
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noninventoriable items 332
overview 328

Vendor Statement Report 1172
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adding 194
deleting 197
overview 194
updating 196
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adding 176
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deleting 186
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managing 178, 186
multi-store settings 949
overview 176
payment terms 197
payments 753
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searches 193
separate records 184
setting default payment terms 197
text messages 141
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updating information for one 178
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systems 947
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interstore AR and AP activity 958
inventory history, overview 244
item history, overview 244
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Lite customer history 111
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work order profit margins 450
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AP easy checks 799
AP payments 797
AR easy checks 801
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Work Order Qty 1030
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deleting 587
enable texting 129
sending text messages 143
updating 586
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adjustment 849
BAR change notification 453
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completing 456
created from estimates 536
creating from appointments 582
creating regular 442
deleting 454
designing 40
down-arrow lookup 9
generating from quotes 533
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government support 844
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multi-store systems 948
national account 836
oil change 446
retrieving 451
service calls 449
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trade-ins 486
updating 451
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writing
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